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Cherwell-provided mApp Solutions
A mApp® Solution is a bundle of CSM system definitions (Business Objects, fields, forms, grids,
Relationships, Actions/One-Step™ Actions, Saved Searches) that allows definitions to be transferred
between databases.

mApp Solutions can come from a number of sources: Cherwell partners, community members, and from
Cherwell itself. This section includes information for both Cherwell Labs and fully supported mApp
Solutions.
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CSMe mApp Solutions
A CSMe mApp® Solution is part of the enterprise service management strategy, which drives the ability to
manage processes across numerous lines of business from a single application. This can include IT, Human
Resources, Facilities, Information Security, Case Management, and Project Management.
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Apply the CSMe mApp Solutions
When you apply the CSMe mApp® Solutions, use these considerations for the order of application and
best practices.

Good to Know

• We recommend that you do not apply all four CSMe mApp Solutions immediately unless there is an
urgent need for them. Apply each mApp Solution as needed because there may be a newer version
released with additional functionality that you can take advantage of during implementation. You
should never apply a mApp Solution to a database that already has an installation of the same
mApp Solution, including previous versions. See Considerations for Applying mApp Solutions .

• When you apply the CSMe mApp Solutions, choose the Open a Blueprint so I can preview the
changes option and publish the Blueprint prior to publishing the mApp Solution changes.

• The HR Service Management and Project and Portfolio Management (PPM) mApp Solutions share
the same Role Business Object.

• The PPM mApp Solution publishes with no warnings or errors.

• We recommend applying the CSMe mApp Solutions in the following order:
1. HR Service Management

2. Project and Portfolio Management

3. Information Security Management System

4. Facilities Management

HR Service Management, Information Security Management System, and Facilities
Management mApp Solutions
Before the publish process begins, you will see the Blueprint Security Changes window with a warning
message that shows security changes.

1. Select OK to close the window.
During the publish process you will see a pop-up window with a warning message about errors. This
cancels the publish.

2. Select Close to see the scan results.
The scan results are warnings regarding changes to roles and security settings contained within the
mApp Solution. This is an expected result.

3. Select Ignore warnings and continue and then select OK to close the window.
You will see a pop-up window with information that the scan was successful and no errors were
found.

4. Select OK.
The changes from the mApp Solution will finish publishing to your system.

Related concepts
Apply a mApp Solution
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Publish a Blueprint
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Facilities Service Management mApp Solution 1.5
Use the Facilities Service Management mApp® Solution to incorporate facilities functionality into their
existing CSM systems.

Platform version requirements: Tested on CSM 10.0.0—10.2.0.

Content version requirements: Tested on CSM 10.0.0—10.2.0. This mApp Solution may also be
compatible on content versions older than CSM 10.0.0, but as with all mApp Solutions, be sure to test
them on your customized system.

This mApp Solution is designed to work with the ITSMStarter.czar and ITSMDemo.czar.

Prerequisites: None.

Available languages: English.

The Facilities Service Management mApp Solution includes the following items for downloading:

• Facilities and Property Management.mApp

Overview
The Facilities Service Management mApp Solution enables an organization to manage and automate the
requests for services, project planning, work assignment, and execution. The mApp Solution allows end
users, department members, and project teams to initiate work items, including those items that have
recurring schedules.

Key Features
Key features include:

• Facility-specific reports for buildings, technician workload, and most common issues.

• Ability to track time and materials and roll up costs to projects and work orders.

• A clean and uncluttered theme throughout the user interface.

• Custom dashboards for facilities managers and their teams.

• Ability to track equipment and building-specific information in facilities-based categories.

• Automated work orders for recurring scheduled maintenance, such as replacing air filters, wear
components, and annual checks.

• Integrated CSM Portal design that allows customers to see the status of their requests across all
departments.

• Ability to create multiple work orders assigned to different teams from a single request or project.

• Ability to receive and update work orders via mobile devices.

• Mobile device users can access and take action on work orders and queries through One-Step™
Actions.
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• A new Work Order Business Object.

• Dashboards by role.

• A CSM Portal page.

• New hardware items in the Configuration Management Database.

• One-Step Actions/Automation (example: Scheduled recurring maintenance).

Apply the mApp Solution
Follow these steps to download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM. Do not
select Finish yet.

4. Still in the Apply mApp Wizard, when you reach the Final Options window, select Open a Blueprint
so that I can preview the changes, and then select Finish.

5. When the Blueprint opens, select File > Blueprint changes.

6. In the list of Business Objects, expand Work Order so you can see the associated forms.

7. Select the following forms, and then select Remove.

Note: To avoid breaking functionality, do not delete the forms through the Forms menu.

◦ WorkOrder Edit-existing New – added
◦ WorkOrder View-only New – added

8. Save the Blueprint.

Important: If you're running CSM 10.2.0 for both platform and content, you must reset the
Category limit value in both the default and Portal default views.
To reset the Category limit value:

1. In CSM Administrator, create a new Blueprint.

2. Select the Work Order from the Business Object list.

3. Select Edit Business Object.
4. Edit the Category field.

5. Select the Validation/Auto-populate page.

6. Expand the Validate from Table field.

7. Delete the Limit Values entry, and then select OK.

8. Select Add to create a new limit value.
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9. Edit the constraint:
a. For Field, enter Incident Category.Service.

b. For Operator, choose Equals.

c. For Value, enter Facilities Management.

10. Select OK.

11. Publish the Blueprint.

Revision History

Version Platform Version
Requirements

Content Version
Requirements Prerequisites

1.0 8.2.1 8.2.0_08.11.16_016-en None

1.5 10.0.0—10.2.0 10.0.0—10.2.0 None

Related information
Apply a mApp Solution
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Facilities CSM Portal Self-Service Pages
A facilities-specific CSM Browser Client allows users to quickly request services or report problems in the
physical environment. The CSM Portal delivers easy-to-find facilities management requests and
information for faster resolutions.

The CSM Portal displays facilities-specific discussions to alert employees of maintenance and building-
related issues. The solution also provides access to frequently used selections, and a formatted, dynamic
facilities catalog with work order forms with auto-assignment to the facilities fulfillment teams.

Note: Work orders can also be opened in more traditional ways, including inbound email and
phone or manual entry.

Organizations can also incorporate facilities and other services into an enterprise CSM Portal, making it
convenient for users to request services from a single corporate site to any line of business. Such lines of
business can include IT, Human Resources, Business Operations, Printing and Imaging, Marketing, and
Accounting.

The home page of the CSM Portal provides access to frequently requested items, open work orders, and
a view of the service catalog.

Figure 1. Facilities Management Home Page
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Work Orders
Teams and individuals can receive work orders assigned to them through a browser, personal computer,
tablet, or smart phone. They can update work orders and indicate when activities are completed from any
of these devices.

The work order is its own Business Object, allowing facilities-based processes to follow their own
workflow and not impact or limit the ability of IT to configure Incident Management to their requirements.

In addition:

• Work orders capture critical information, including building, facilities specific categorization, etc.

• Assignment to facilities and property management teams automatically track time, labor, and
material costs that are associated with the work effort.

• You can attach invoices or other documentation directly to work orders.

• Links to the project, building, and equipment provide a complete view of the costs and impact of the
work performed.

• Includes the ability to include proposal information from the supplier for work and materials that are
contracted out.

• Recurring work orders can be automated for pre-scheduled work based on selected frequency and
start date.

• Specifics Forms include:
◦ Facilities - Contract - Lease

◦ Facilities - Contract - Standard

◦ Facilities - Copy Service

◦ Facilities - ID Badge

◦ Facilities - Mail Room Service

◦ Facilities - Research

◦ Facilities - Scanning Service

◦ Facilities - Storage

Recurring Work Orders
Recurring work orders are scheduled during the work order process. When the Recurring Maintenance
subcategory is selected on the master work order, users can automatically schedule future work orders.
After selecting a schedule (frequency, start date, and number of recurring work orders), related work
orders that will be processed in the future are automatically generated, with the Owned by Team and
other key fields brought over from the master work order. Future work orders are presented in a
Dashboard Grid based on their proposed start dates.

Figure 1. Recurring Work Orders
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Building Business Object
The Facilities Management mApp® Solution integrates with the default CSM Building Business Object,
providing the ability for key relationships and powerful workflow.

Key fields include facilities management elements (example: owned/leased, construction date, etc.) and
provide multiple statuses to represent the condition of the building.

Relationships with other supporting objects provide a full view of areas such as work orders, suppliers,
equipment, and projects that are associated with the building.
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Add Work Orders to Building
When you add work order information to the Building form as a supporting object, you can see information
about work orders, suppliers, equipment, and projects that are associated with the building.

To add work orders to the Building Business Object:

1. In CSM Administrator, select Blueprints > Create a new Blueprint.
2. In the list of major Business Objects, select Building, and then select Edit form arrangement in

the main pane.
3. Drag Facilities Building Links Work Orders from the left pane to the main tab area of the New

Building form.
4. Save and publish your blueprint.

The Work Orders tab is now available in the Form Arrangement for the Building Business Object.
Figure 1. Building Form Arrangement
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ITPT Project for Facilities Management
Project functionality is delivered as an optional mApp® Solution called IT Project Tracking (ITPT) Project
for Facilities Management. This optional mApp Solution does not interfere with or overlay the default ITPT
forms or associated functionality.

Note: The ITPT Project for Facilities Management mApp Solution is optional and installed
separately.

The ITPT Project for Facilities Management mApp Solution modifies ITPT projects to facilitate facility
management areas. Project types include Capital Improvement Project, Renew/Refresh and Ongoing
Maintenance. You can also link projects directly to work orders.
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Service Catalog for Facilities
The Facilities Services Management mApp® Solution includes a full set of catalog items. An additional
level of categorization through a supporting table called Work Order Type is available to capture the
details of the work order.

Figure 1. Table Management View

Figure 2. Service Catalog in Customer Portal
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Proposals, Reports, Notifications, and Hardware
Types

The Facilities Service Management mApp® Solution supports proposals, reports and saved searches,
automation processes for email notifications, and configuration items for hardware storage.

Proposals
Many facilities management organizations require multiple bids for materials prior to purchasing materials.
The new Proposal supporting object allows you to track multiple proposals for each work order and
identify which bid is approved.

Reports
The Facilities Service Management mApp Solution includes the following reports and saved searches:

• Work Orders by Building

• Work Orders Total Cost

• Work Orders Total Time

Notifications
The Facilities Service Management mApp Solution includes the following automation processes for email
notifications:

• Notify Owned By Team Changed - Work Order

• Notify Owner Changed - Work Order

• WorkOrder - Confirmation Email on Close

• WorkOrder - Confirmation Email on Create

Hardware Types
The Facilities Service Management mApp Solution includes the following new Configuration Item (CI)
types that support facilities management hardware data storage for work orders.

• HVAC

• Electrical
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Security Groups, Roles, and Teams
The Facilities Service Management mApp® Solution provides default security groups and teams to help
you get started. Sample roles are also available.

Security Groups
The Facilities Service Management mApp Solution uses security groups to provide access and workflow
rights (example: Only users with the Facilities - Dispatch role can close a ticket). Security groups are
configured after applying the mApp Solution.

Security groups include:

• Facilities: Used by managers or other team members who are not dispatch or technician users.

• Facilities – Dispatch: Receives inbound calls and requests and dispatches work orders to
technicians.

• Facilities – Tech: Fulfills work orders.

Roles
Roles determine which default Dashboards appear when users log in to the Facilities Service
Management mApp Solution. Specific roles are not included in the mApp Solution, but sample roles are
provided in the installation package.

Sample roles include:

• Dispatch: Receives and sorts work orders

• Facilities Management: Oversees work orders and projects from a manager perspective

• Facilities Supervisor: Supervises team and technicians

• Facilities Tech: Fulfills work orders

Teams
The Facilities Service Management mApp Solution provides the following teams, which are available
during the team selection process:

• Facilities Building

• Facilities Construction

• Facilities Dispatch

• Facilities Grounds

• Facilities Records Management

Related tasks
Update Security Rights for CSM Portal Users
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Dashboards and Reports
Managers, supervisors, and field services teams can see the status of work that is assigned to them or
members of their team without the clutter of other lines of business. Dashboards provide real-time
information on work orders, property status, scheduled maintenance, and more.

Global Facilities Dashboard
Figure 1. Global Facilities Dashboard

Facilities Technician Dashboard
Figure 2. Facilities Technician Dashboard
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Facilities Team Manager Dashboard
Figure 3. Facilities Team Manager Dashboard

Facilities Dispatch Dashboard
Figure 4. Facilities Dispatch Dashboard
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Configure the Facilities Service Management mApp
Solution

Configure the Facilities Service Management mApp Solution by updating Security Rights for Portal
Customers, assigning users to Teams and Security Groups, and updating email notifications.
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Update Security Rights for CSM Portal Users
Use the Security Group Manager in CSM Administrator to update Security Groups.

This functionality is only available after you apply the mApp Solution.

To define security rights for CSM Portal users:

1. In CSM Administrator, select Security > Edit security groups.
2. In the Security Groups window, select Portal Customer in the Group drop-down list.
3. Select the Business Objects tab.
4. In the Business Object drop-down list, select Work Order.

a. In the General section, select View, Add, and Edit.
b. In the File Attachments section, select View, Add, Edit, and Delete.
c. Select New Field, and then select View and Edit in the General section.

5. Repeat the previous step and substeps with the following Business Objects:
◦ Facilities - Contract - Lease
◦ Facilities - Contract - Standard
◦ Facilities - Copy Service
◦ Facilities - ID Badge
◦ Facilities - Mail Room Service
◦ Facilities - Research
◦ Facilities - Scanning Service
◦ Facilities - Storage

6. In the Business Object drop-down list, select Work Order Type.
a. In the General and File Attachments sections, select View.
b. Select New Field, and then select View in the General section.

7. In the Business Object drop-down list, select Facilities Building.
a. In the General and File Attachments sections, select View.
b. Select New Field, and then select View in the General section.

8. Select Save.
9. In the Security Group window, select Facilities in the Group drop-down list.

10. Select the Business Object tab.
11. In the Business Object drop-down list, select Work Order.
12. In the General and File Attachments sections, select Delete.
13. Select Save, and then close the application.
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Assign Users to Teams and Security Groups
Use the User Manager in the Security section of CSM Administrator to assign users to teams and
security groups.

This functionality is only available after you apply the mApp Solution.

To add users to Facilities Teams:

1. To open the Users Manager in CSM Administrator, select Security > Edit Users.
2. Select a user.
3. Select the User tab, and then select the appropriate security group for this user in the Security

group drop-down list.
4. Select the Team tab, and follow these steps:

a. Select Add.
b. Select one or more teams in the Add User to Team window.
c. Select OK.
d. To set a default team, select the team and then select Default Team.

5. Save the user profile.

Related tasks
Create a User Profile
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Update Email Notifications
Use the One-Step Action Manager in the CSM Desktop Client to update email notifications.

To update email actions:

1. In the Desktop Client, select One-Step in the menu bar and then select One-Step Manager.
2. Change the association to Work Order.
3. Right-click Email Customer on Create, and select Edit. In the editor:

a. Select Create E-mail Action, and add your organization's email account to the Send via field.
b. Select OK.

4. Repeat the previous step and substeps for the Email Customer on Close and Email Work Order
Assignee actions.

5. Select Close.
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Create Work Orders
You can create work orders manually on a CSM Dashboard, through the CSM Portal, or by creating an
email.

Good to Know

• In Dashboards (except Management). you can select a button to create a new work order or select
New > New Work Order from the CSM menu bar.

• All new work orders are automatically assigned to the Facilities Dispatch team except for scheduled
recurring work orders. By default, the owning team for scheduled recurring work orders is the team
of the user who opened the work order.

• Journals track what occurs during the record's lifecycle, including notes to track progress or
comments, history to track important field changes, email correspondence, etc. View or manually
add journals by selecting the Journal tab in the record's arrangement.

• Attachments supplement records by providing additional details in the form of linked/imported files
(.pdf, .doc, etc.), images, web pages, and document repositories. View and manage attachments
using the Attachment button and Attachments bar.

• The main pane displays work order information (Requestor Work Order ID, Title, Description,
Building Code, Building Name, Location, Cost Code, Proposed Start Date, Target Completion,
Priority, Category, Subcategory, and Work Order type).

• The arrangement dynamically displays linked records that are related to the work order record
(Facilities Building, Supplier, Equipment, Proposals, Project, Work Orders, Tasks for time and cost
tracking, and Journals).

• Required fields are often conditional, meaning some are required to save a record, others to change
the status of a record, others to close the record, etc. You are reminded when fields are required,
either by an asterisk beside the field or a reminder message.

• Use rich text fields to use formatting and image/screenshots to complement the text. To format the
text or embed an image, select the Zoom button .

• In fields, press F3 to open a Selector window, where you can select a legal value or create a new
value.
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Create a Work Order (User)
Users can open a work order directly from the CSM Portal. Frequently requested items are available for
easy categorization.

To create a work order (users):

1. Log in to the CSM Portal.

Note: The URL is unique to your organization.

2. Select a frequently requested item (example: Replace/Fix Lighting, Plumbing Issue,
Temperature Control, etc.), or select Browse All Services to select the appropriate category of
the issue or request.
In the following example, the user selected Temperature Control, and a new page opened with
fields for entering additional details about the issue. Note that the categorization HVAC-Repair has
been applied to the issue.
Figure 1. User Work Order
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3. Enter information in the fields. Fields with an asterisk are required.
4. Select Save to complete the work order.

The new work order displays. As it processes, the phases are updated, and the assignee is provided.
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Create a Work Order (Dispatch)
A dispatch employee can open a non-recurring work order from either the CSM Desktop Client or the
CSM Browser Client. The procedure in this topic covers the Browser Client.

To create a work order (dispatch or supervisor):

1. Log in to the Browser Client to access your Dashboard.
2. Select Create New Work Order and provide the work order information in the fields. By default, the

requestor is the current user, but you can modify this value, if needed (example: The user may be
someone who called the help desk to make a request).

3. Change the Owned by Team value to the team that will handle the work order. By default, the value
is Facilities Dispatch.

4. Select Save, and select Home to return to the Dashboard.
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Create a Recurring Work Order (Supervisor)
Create a recurring work order from either the CSM Desktop Client or the CSM Browser Client. The steps
below are based on the Browser Client.

To create a recurring work order (supervisor):

1. Log in to the Browser Client to access your Dashboard.
2. Select New > > New Work Order and enter the work order information in the fields (details, title,

description, building code, and cost code). By default, the requestor is the current user, but you can
modify this value, if needed (example: The user may be someone who called the help desk to make
a request).

3. Change the Owned by Team value to the team that will handle the work order. By default, the value
is Facilities Dispatch.

4. Select the Equipment tab, and add equipment to the work order. Then select the Link Existing
button.

5. To define the classification structure, specify Recurring Maintenance as the subcategory. All
categories must be associated with the Recurring Maintenance subcategory.

6. Select Schedule Recurring Future Work Orders, and specify schedule frequency, start date for
the schedule, and the number of recurring work orders. The appropriate number of linked future
work orders is generated.

7. Select Save to generate the recurring work orders.
8. After the automation runs, the top of the work order indicates that the work order generation is

complete. A new field is checked to indicate this is the master work order, and the work order tab
shows the linked future work orders.

9. Select the Home button to go back to the Dashboard. Recurring work orders for your team will show
in the grid if they have a proposed start date less than 30 days from today. This provides planning
information without cluttering up the Dashboard with work orders with future dates.
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Process Work Orders
Dispatch functions include reviewing, assigning, and completing work orders. While processing work orders,
dispatch determines whether the customer needs to be contacted again or if any fiscal activities need to occur
before the work order is closed.
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Review and Assign Work Orders (Dispatch)
When tickets are created from the CSM Portal or through inbound email, a team typically reviews the
work order, updates it with additional information, determines if approvals are required, reviews cost
center information, and more.

After an initial review, work orders are assigned to a Facilities Management team and can be located in
the Work Orders grid.

To review and assign a work order (dispatch):

1. Log in to the CSM Browser Client.
2. Select an unassigned work order.
3. Assign a new Owned By team, such as Facilities Building, Facilites Grounds, etc. Provide the

cost center, if needed, and specify the priority.
4. Save the work order.

The work order is now in Assigned state and appears in the Dashboard of the supervisor of the
assigned team.
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Review Completed Work Orders
When reviewing completed work orders, dispatch determines whether the customer needs to be
contacted again and/or fiscal activities need to occur before closing the work order.

To review a completed work order (dispatch):

1. Log in to the CSM Browser Client.
2. Select a completed work order.
3. Review payment and billing for attachments such as invoices, screen captures, and other

documents.
4. Review items that are related to time and cost for tracking and invoicing needs.
5. After the review is completed, select Closed in the status box to close the work order.
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Assign Work Orders (Supervisor)
Supervisors see all work orders and associated work loads that are assigned to their team. Supervisors
can assign work orders as needed to manage and track these work loads.

To assign a work order (supervisor):

1. Log in to the CSM Browser Client.
2. Select an unassigned work order.
3. Select Owned By, and then assign the work order to an employee. Add journal notes and track time

and costs.

The newly assigned work order now appears in the employee's Dashboard.
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Facilities Service Management mApp Solution
Items

The Items table provides a list of Business Objects and associated items that are included when applying
the Facilities Service Management mApp Solution.

Table 1. mApp Solution Items

Item Category Item Typical Merge Action

Major Business Objects

Contract Links Facilities Building,
Contract Links Specifics, Tab (Facilities
Building), Specifics Type ID, Work
Order, Facilities Building, Facilities,
Configuration Item Links Facilities
Building, Configuration Item Links Work
Order, Configuration Item Links
Facilities Building, Configuration Item
Links Work Order, Expiration Date, and
(HR, FM, IT) Multi-Tennant Fields,
Default, Site1, Site2, Site3, Site4,
Supplier Service, Supplier Account#,
Supplier Rank, Supplier Links Facilities
Buildings, Supplier Links Work Orders,
Supplier Owns Proposals

Overwrite or Import (if not found)

Supporting Business Objects

Change Order, Proposal, Facilities -
Contract - Lease, Facilities - Contract -
Standard, Facilities - Copy Service,
Facilities - ID Badge, Facilities - Mail
Room Service, Facilities - Research,
Facilities - Scanning Service, Facilities -
Storage

Overwrite or Import (if not found)

Lookup Tables

Contract Category, Department
Oversight, Facilities Pending Reason,
Facilities Status, Facilities COS, Work
order type, WorkOrder Priority,
WorkOrder Status, CI Light Fixtures,
Cost Item

Overwrite

Automation Processes

Create Scheduled Maint Tasks, Create
Scheduled Maint Work Orders, Not
Scheduled, Notify Owned By Team
Changed - Work Order, Notify Owner
Changed - Work Order, WorkOrder -
Confirmation Email on Create,
WorkOrder-AutoClose

Overwrite

Counters Work order ID Overwrite
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Item Category Item Typical Merge Action

Dashboards

Facilities Dispatch, Facilities
Management, Facilities Team Manager,
Facilities Tech, Facilities-Service-
Catalog, Facilities-V2, Facilities-V2-My
Items, Home, IT-V2, Accounting-V2

Overwrite or Import (if not found)

Widgets Numerous Overwrite

Expressions

30 Days, AdminOnly, Fiscal Closed,
Greater Than 4 days, Recurring,
Resolve by, Respond by, Set Scheduled
Status Field, Set ScheduledTasksStatus
Field, Total Pending Time, Total Task
Cost WO, Total Task Time WO, Total
Time, Within 4 days, Work Order Phase,
WorkOrderID, PortalLink

Overwrite

Group Maps Specifics for Facilities Overwrite

Images Numerous Overwrite

One-Step™ Actions Create Work Order, etc. Overwrite

Search Numerous Overwrite

Site Facilities Overwrite

Stored Values WO-Link to CI - Recurring, Work Order -
Link CI Overwrite

Teams
PMD Records Management, PMD
Grounds, PMD Facilities, PMD Dispatch,
PMD Construction

Overwrite

Theme Facilities Overwrite

Related information
Configure Merge Actions for Business Object Definitions
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HR Service Management 1.6
Cherwell HR Service Management mApp® Solution (Cherwell HRSM) combines HR Case Management
and HR Employee Administration. Designed around HR workflow processes and Centers of Excellence
(COE), Cherwell HRSM is an ideal solution for organizations needing to mature their HR operations and
employee experience.

Requirements
Platform version requirements: CSM 10.2.0.

Content version requirements: Tested on CSM 10.2.0.

Note: This mApp Solution contains specific updates based on 10.2.0 OOTB content related to our
enhanced Approval Engine feature. If you have an older content version, you may choose to use
HRSM 1.5 instead.

This mApp Solution is designed to work with the ITSMStarter.czar and ITSMDemo.czar.

Prerequisites
If you are working with content from CSM 10.0.0 - 10.0.2, you might notice an incorrect German
translation for Location ID in both the Default and Portal Views for the Customer - Internal form. This issue
produces a scan error when attempting to apply the HRSM mApp Solution.

To fix the issue before publishing the mApp Solution:

1. At the end of the Apply mApp Wizard, select the option to open the Blueprint to review changes.

2. Switch to German, and then select Kunde - Intern > Business Objekt bearbeiten.

3. Locate and double-click the Positions-ID text field with size 20. Now the field is in edit mode.

4. Set the Name field to Lage-ID, and select OK to save your changes.

5. Repeat the previous steps for the Portal View.

6. Publish your Blueprint.

Available Languages
English, German, Spanish, French, and Portuguese

Overview
Cherwell HRSM is designed to provide a consumer‑like service experience and increase HR productivity
and employee satisfaction. This is made possible through a combination of the following elements:

• A powerfully intuitive Cherwell HRSM Portal.

• The persona-specific HR knowledge base.
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• Shared services capabilities with pre-built automated workflows designed specifically for HR service
delivery.

Cherwell HRSM combines ITSM and HR into a single solution to help customers address a technology
and information gap in HR systems that support request, knowledge, and fulfillment workflows. Your
company can resolve the majority of employee requests through the Cherwell HRSM Portal.

This solution focuses on a set of best practice processes based on the Society for Human Resource
Management standards.

How the mApp SolutionWorks
Cherwell HRSM is designed to be applied to your development CSM system, where you can view and
publish the solution. After evaluating and testing the solution against the development system, you can
apply it to your production environment.

Revision History

mApp Version Platform Version
Requirements

Content Version
Requirements Prerequisites

1.0 9.5.0

Tested on 9.2.0. Globalized
for a clean scan, however
Cherwell HR Service
Management can be
installed with other content
versions.1

None

1.2 9.6.1 Tested on 9.6.1 and 9.5.3. 2 None

1.3 10.0.0 Tested on 10.0.0 3 None

1.5 10.0.0 Tested on 10.0.04 None

1.6 10.2.0 Tested on 10.2.05 None

1 Service Catalog Templates are used in this solution, so minimally the content version needs to be 7.x.
Additionally, a little extra care and adjusting will be needed for non-Globalized systems. The Task Business
Object was promoted to a Group Business Object type in CSM 9.4.0. If you are running CSM 9.4.0 or 9.5.0,
you need to import two CED files to update the Onboarding and Offboarding One-Step Actions and use the
updated Task Business Object. If you have already installed HR Case Management (versions 2 or 3), loading
this new solution will not impact form and workflow modifications you have made locally. However, if you apply
the optional HR Service Management Starter Data.mApp, your catalog and workflows will be impacted due to
the shared catalog object data (Service Catalog Template, Work Unit, Case Category, and Case Subcategory).
No data is lost when applying the HR Service Management.mApp file, only configuration modifications.
2 For content versions earlier than those listed, review the documentation and carefully test against a copy of
the current installation to determine suitability for your environment. Additional manual work may be required
based on current system configurations.
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3 For content versions earlier than those listed, review the documentation and carefully test against a copy of
the current installation to determine suitability for your environment. Additional manual work may be required
based on current system configurations.
4 For content versions earlier than those listed, review the documentation and carefully test against a copy of
the current installation to determine suitability for your environment. Additional manual work may be required
based on current system configurations.
5 For content versions earlier than those listed, review the documentation and carefully test against a copy of
the current installation to determine suitability for your environment. Additional manual work may be required
based on current system configurations.
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Apply Cherwell HR Service Management
When applying the mApp Solution, be sure to follow the recommendations and steps that are outlined in
this topic.

Download the Cherwell HR Service Management.zip file, which includes the following:

• Cherwell HR Service Management v1_6.mApp

• Offboarding 9.4 & 9.5 Content.ced

• Onboarding 9.4 & 9.5 Content.ced

• HRSM Reports.ced

• HRServiceManagementv1_6(en-US).tsv

To apply the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.
3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more

information, see Apply a mApp Solution. Select the topic that matches your version of CSM.
4. When you reach the Overwrite Portal Security Groups window, consider the following:

a. If you have customized the Portal Customer or Portal Workgroup Manager Security Groups,
your custom data will be overwritten if you leave the Enabled check box selected and apply
the Cherwell HR Service Management v1_6.mApp file. If you want to keep your custom data in
these Portal Security Groups, clear the Enabled check box and instead manually configure
the HRSM Portal Security Groups.

b. If you have not customized the Portal Customer or Portal Workgroup Manager Security
Groups, verify that the Enabled check box is selected. The HRSM Portal Security Groups are
applied with the Cherwell HR Service Management v1_6.mApp file.
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Apply Cherwell HRSM to Non-Localized Content
You can apply the Cherwell HRSM mApp® Solution to non-localized content versions of CSM.

When the Blueprint is published, you may encounter this scan error on the following fields:

The constraint references a non-existent field. Field is missing from the
Service Catalog Template business object

• Case Service Business Object (Default View) > Task Template Name

• Case Service Business Object (Portal Default View) > Task Template Name

• Role Business Object > Existing Employee Access Template Name

• Role Business Object > Existing Position Equip Template Name

• Role Business Object > New Hire Access Template Name

• Role Business Object > New Position Equip Template Name

To avoid these errors, edit the limiting value constraints (no update is required) for each of the impacted
fields.
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Considerations for Installing HR Service
Management with HR Case Management

HRSM Case is the primary Business Object for HR Service Management. HR Case Management has a
distinct Business Object called HR Case. The two share some supporting Business Objects and Lookup
Tables, and you must avoid overwriting data configured in HR Case when you apply HRSM.

Shared Lookup Tables include:

• Case Category

• Case Subcategory

• Case Priority

• HR Case Pending Reason

• HR Case Resolution Code

• HR Case Status

To avoid overwriting HR Case Management data, perform the following steps prior to publishing the
Blueprint created while applying the Cherwell HRSM mApp Solution:

1. Select the HR Case Status object and select Edit Data.

2. Highlight all records listed and select File > Restore.

3. Select the Case Priority object and select Edit Data.

4. Highlight all records listed and select File > Restore.

5. Select the HR Case Pending Reason object and select Edit Data.

6. Highlight all records listed and select File > Restore.

7. Select the HR Case Resolution Code object and select Edit Data.

8. Highlight all records listed and select File > Restore.

9. Do not apply the Cherwell HR Service Management Starter Data mApp Solution file. It will overwrite
the Case Catalog and Case Subcategory data and potentially overlay any Task Templates (Service
Catalog Templates) that have been configured for HR Case Management.

HR Service Management and HR Case Management cannot function in the same environment as
configured after the Cherwell HRSM mApp Solution is applied. The primary reason is the HR Case Status
record contains commands to execute when moving to the next status. To configure this Business Object
for HR Service Management, review each of the HR Case Status records and select the appropriate One-
Step Action in the Next Status Command field that is associated with the HRSM Case Business Object.

To configure HR Service Management and HR Case Management to function in parallel:

1. Modify the HR Case Status Business Object to include an additional command field to store the
HRSM Case One-Step Action.

2. Modify the Next Status from Relationship One-Step Action to use the new command field.
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Configure Cherwell HRSM
The configuration requirements for Cherwell HRSM vary depending on your existing environment. Review
each topic in this section to determine which areas need to be manually configured.

Complete the following procedures to configure Cherwell HRSM. Configuration procedures are completed
in the CSM Desktop Client and CSM Administrator.

HRSM Roles, Security Groups, and Portal Security Groups
HRSM Roles, Security Groups, and Portal Security Groups are automatically applied with the mApp
Solution to align with the Dashboards.

Exception: When applying the mApp Solution, you can clear the Enabled check box on the Overwrite
Portal Security Groups screen and instead manually configure the HRSM Portal Security Groups.

Verify HR Case Automatic Actions
In cases where the HRSM Case Automatic Actions are not created by Cherwell HRSM, they must be
added manually.

Related concepts
Cherwell HRSM Security Groups
Related information
Configure Merge Actions for Business Object Definitions
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Cherwell HRSM Roles
Several HRSM Roles are implemented with the Cherwell HRSM mApp® Solution. These roles align with
CSM Dashboards.

Roles determine the user's default HR Dashboard, but they can also be used with Security Groups to
allow users to log in using a different Role.

Table 1. Roles, Objects, and Dashboards

Role Primary Object Dashboard

HR Executive HRSM Case HRSM Executive

HR Knowledge Manager Knowledge - HR HRSM-Knowledge-Base-Articles

HR Manager HRSM Case HRSM Manager

HR Tier 1 HRSM Case HRSM Tier 1

HR Tier 2 HRSM Case HRSM Tier 2
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Cherwell HRSM Security Groups
The following Cherwell® HRSM Security Groups are implemented with Cherwell® HR Service
Management mApp Solution. These Security Groups align with the CSM Dashboards.

Security Groups include:

• HR Executive

• HR Knowledge Manager

• HR Manager

• HR Tier 1

• HR Tier 2
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Configure Cherwell HRSM Portal Security Groups
If enabled when running the Apply mApp Wizard, the following HRSM Portal Security Groups are
implemented with the Cherwell HRSM mApp® Solution.

If you have customized any of the Portal Customer or Portal Workgroup Manager Security Groups, you
should manually configure the HRSM Portal Security Groups rather than applying them with the mApp
Solution because your custom data will be overwritten by the new data applied.
To manually configure HRSM Portal Security Groups:

1. Open CSM Administrator and select Security > Edit Security Groups.
2. In the Group list, select Portal Customer. (Repeat these steps for Portal Workgroup Manager and

any additional Portal Security Groups.)
3. Select the Business Objects tab.
4. In the Business Object list, select the following Business Objects and settings:

Business Object Setting

HRSM Case

◦ General: View, Add, Edit
◦ Limit Records (select one option or the other):

◦ Customer Display Name = CurrentUserDisplayName()
◦ All of the following:

◦ Submit on behalf of Name = CurrentUserDisplayName()
◦ Send Notifications to On Behalf of equals true

◦ File Attachments: View, Add, Delete
◦ New Field: View, Edit

HR Task

◦ General: View, Edit
◦ File Attachments: View, Add, Delete
◦ New Field: View, Edit

Knowledge - HR

◦ General: View, Edit
◦ Limit Records: Status = Published, Visible in Portal = True
◦ File Attachments: View
◦ New Field: View, Edit

Checklist Item

◦ General: View, Add
◦ File Attachments: View
◦ New Field: View, Edit

Case Type, Case
Category, Case
Priority, Case
Subcategory, Case
Service, Case Service
List

◦ General: View
◦ New Field: View
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Business Object Setting

HR Specifics - All
group members

◦ General: View, Add, Edit
◦ File Attachments: View
◦ New Field: View, Edit

◦ AdditionalDetails
◦ Benefit Change
◦ Direct Deposit
◦ Disciplinary Action
◦ Employee Information Change
◦ Employee Offboarding
◦ Employee Transfer
◦ Employment Verification
◦ FMLA
◦ General Leave
◦ HR System Access
◦ I9
◦ Modify W4
◦ Retirement
◦ SF-256
◦ SF-85
◦ Tuition Reimbursement Pre-Approval
◦ Tuition Reimbursement Request
◦ Visa Assistance
◦ Visa Question
◦ W4 Modify
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Configure Cherwell HRSM Teams
The Team Info table in the CSM Desktop Client has been expanded to allow HR Knowledge Teams that
are separate from HR Teams that handle HRSM Cases. HR Knowledge Teams handle the HR Knowledge
workflow.

HR Teams handle HR Cases. If the Team is also an HR Knowledge Team, members can also perform
technical approvals for HR Knowledge Articles.

HR Teams are the default owners of specific services (HR Cases). Based on the service that the
customer requests, it will be assigned to a specific HR team. In the Case Service table, you can set the
Default Shared Services team and the Default Escalation Team for a specific HR Case Service. This
default team will be the automatic assignee for that service. Review the services and adjust to suit your
organization's structure and teams.

If the Team is also an HR Knowledge Team, members can also perform technical approvals for HR
Knowledge Articles.

HR Teams
For Teams to be available in HR Service Management and HR Knowledge, the Team Info records must
be modified in Table Management to reflect their use.

1. Open the Desktop Client and select Tools > Table Management.
2. In the Type drop-down list, select Team Info.

3. Double-click the HR team and select the appropriate check boxes (example: HR Team and HR
Knowledge Team).

The HR Teams listed in the table below are provided by default if you apply the Cherwell HR Service
Management Starter Data mApp file.

Name HR Knowledge Team

T1-NA

T1-EMEA

T1-APAC

T2-Benefits-US TRUE

T2-Benefits-CND

T2-Benefits-EMEA

T2-Benefits-APAC

T2-Benefits-LATM

T2-Payroll-US TRUE

T2-Payroll-CND
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T2-Payroll-EMEA

T2-Payroll-APAC

T2-Payroll-LATM

T2-Global-Recruiting

T2-HRIS-NA/LATM TRUE

T2-HRIS-EMEA/APAC TRUE

BPartner-US

BPartner-CND

BPartner-EMEA

BPartner-APAC

BPartner-LATM

COE-Total Rewards TRUE

COE-Employee Relations TRUE

COE-Workforce Admin TRUE

COE-Payroll TRUE

COE-HRIS Operations TRUE

HR Knowledge-Only Teams
HR Knowledge Teams can perform technical approvals and publish HR Knowledge Articles.

Name HR Knowledge Team

HRKM - Publisher TRUE

HRKM - Benefits TRUE

HRKM - Payroll TRUE

HRKM - Operations TRUE

66

CSM mApp Solutions

CSM mApp Solutions



Configure User Persona Filtering
To take advantage of the user persona filtering for HR Knowledge and HRSM Case categories, add data
to all existing Customer-Internal records.

Pay particular attention to the following fields, which are critical for the Cherwell HRSM mApp® Solution
features to work correctly:

• Country Code: When customers enter the HR Portal site, the Country Code defined as part of their
user record is used to filter the available resources based on the individual's country policies. You
can find valid country codes listed in the Cherwell content.

• Exemption Status: (Exempt or Non-Exempt - Default: NULL) Employee's Exempt or Non-Exempt
status affects which HR Articles apply to the individual. By default, this field has a NULL value,
meaning that it will need to be set before the employee can see HR Articles.

• IsAManager: (Checkbox - Default: N) Employee's status as a manager allows employee to view HR
Articles listed as relevant to managers.

Related concepts
Configure Existing Forms to Include HRSM Fields
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Configure HR Knowledge Mapping
To allow HR Knowledge to help HRSM Case resolve issues, the HR Knowledge must be mapped to the
HRSM Case Business Object.

To create the mapping:

1. In CSM Administrator, select Create a New Blueprint.
2. Select Managers > Knowledge > Knowledge Mapping.
3. Select HRSM Case in the Search From drop-down list.
4. Select Allow Knowledge Search.
5. Add the following Knowledge Sources:

◦ HR Knowledge - Guideline
◦ HR Knowledge - How To
◦ HR Knowledge - Policy
◦ HR Knowledge - Q&A

6. Highlight each of the Knowledge Sources above and fill out the Solution Goes To options:
a. Select the Field check box, and select HRSM Case > Close Description in the drop-down

list.
b. Select the Relationship check box, and select HR Case Links HR Knowledge Solution in

the drop-down list.
7. Save your changes.
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Configure HRSM Service Catalog Templates
The Cherwell HR Service Management mApp® Solution includes several HRSM Service Catalog
Templates.

Table 1. HRSM Service Catalog Templates

SCT ID Title Description IT Service IT Category IT SubCategory

76 Access Request for
Executive Transfer

Access Request
for Executive
Transfer

Employee
Support Add/Change Update Employee

73
Access Request for
New Employee -
Standard

Access Request
for New Employee

Employee
Support Add/Change New Employee

Setup

66 Benefit Changes Benefit Changes Employee
Support Add/Change Update Employee

39 New Employee Setup

Create all
necessary items
for a new
employee setup

Employee
Support Add/Change New Employee

Setup

60 Direct Deposit Direct Deposit Employee
Support Add/Change Update Employee

55 Employee Information
Change

Employee
Information
Change

Employee
Support Add/Change Update Employee

64 Employee Transfer Employee Transfer Employee
Support Add/Change Update Employee

54 Employment Verification Employment
Verification

Employee
Support Add/Change Update Employee

75
Access Request for
New Employee -
Executive

Executive Access
Request for New
Employee

Employee
Support Add/Change New Employee

Setup

53 FMLA Procedures and
Resources

FMLA Procedures
and Resources

Employee
Support Add/Change Update Employee

68 HR Case Offboarding HR Case
Offboarding

Employee
Support Add/Change Employee

Separation

69 HR IT Termination HR IT Termination Employee
Support Add/Change HR Termination

59 HR Systems Access HR Systems
Access

Employee
Support Add/Change Update Employee

71 Initiate Retirement Initiate Retirement Employee
Support Add/Change Update Employee

65 Modify W4 Modify W4 Employee
Support Add/Change Update Employee
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62 HR Case Onboarding Onboarding Employee
Support Add/Change Update Employee

70 Leave of Absence
Procedures (General)

Procedure for
Leave of Absence

Employee
Support Add/Change Update Employee

77
Review equipment
needs for existing
employee

Review equipment
needs for existing
employee

Employee
Support Add/Change Update Employee

74 Access Request for
Transfer - Standard

Standard Transfer
Access

Employee
Support Add/Change Update Employee

58 Tuition Reimbursement -
Class Authorization

Tuition
Reimbursement -
Class Authorization

Employee
Support Add/Change Update Employee

57 Tuition Reimbursement -
Course Completion

Tuition
Reimbursement -
Course Completion

Employee
Support Add/Change Update Employee

72 Grievance/Disciplinary/
Harassment Incident

Verify information
and determine if
additional actions
are needed

Employee
Support Add/Change Update Employee

Related information
Create a Service Catalog Template
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About HRSM Service Catalog Templates
The HR Service Catalog Templates specify a set of Tasks that are created when an HR Case enters the
in-progress phase. The HR Tasks are generated in a series of One-Step™ Actions.

Most HRSM Service Catalog Templates create HR Tasks, but some also generate IT requests and
associated Tasks.

Service Catalog Templates are associated with HR Case Service and with Role. In the Case Service
table, certain services (example: Tuition Reimbursement) have associated tasks. Some Roles have
associated tasks that are initiated by Service Catalog Templates.

SCT Initiation from HR Case Service Table
The HR Case Service table stores the SCT that is called to create HR Tasks.

When the HR Case Service field is populated in an HR Case, the Task Template Rec ID is captured from
the associated Case Service record.

An Automation Process (Generate HR Tasks from Template) then calls the One-Step Action (Generate
HR Case Tasks from Template), which creates the HR Tasks identified in the SCT.

The following SCTs are initiated in the method outlined above:

• Benefit Changes

• Direct Deposit

• Employee Information Change

• Employee Transfer

• Employment Verification

• FMLA Procedures and Resources

• Grievance/Disciplinary/Harassment Incident

• HR Case Onboarding

• HR Case Offboarding

• HR System Access

• Initiate Retirement

• Leave of Absence Procedures

• Modify W4

• Tuition Reimbursement - Class Authorization

• Tuition Reimbursement - Course Completion

Onboarding Flow
After a case is submitted, the HR person reviews the case and selects the Start Onboarding button.
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1. A Service Request (One-Step Action for Start Onboarding) is created so that IT can create an Active
Directory (AD) account.

2. After the AD account is created, IT enters the account in the specific form and resolves the request.
An Automation Process kicks off and assigns the new employee as the On Behalf Of on the HR
Case.

3. Two Service Requests also kick off for Access and Equipment along with the necessary tasks based
on the SCTs found in the Role.

4. HR Tasks are also created based on the SCT tied to the Service in the categorization.

A role is created and marked as an HR role (it will be used in the HR Case side). On each role, SCTs are
set to determine which tasks get created during onboarding for both Equipment and Access Requests.
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Modify SCT after Installing Cherwell HRSM
The Service Classification field in SCTs is a required field. However, this field does not display any HR
Classifications. We recommend you update the field properties so the Service Classification is not
required if the SCT will be used for an HR Process.

To update the Service Classification field in SCTs:

1. In CSM Administrator, create a new Blueprint.
2. In the Manage objects screen, select Service Catalog Template.
3. Select Edit Business Object.
4. Right-click Smart Classify Search String and then select Edit Smart Classify Search String

field.
5. Select the Properties page and expand the Required for Save section.
6. Select Expression and then select the Custom Expression button.
7. Set the expression:

a. Value: Service Catalog Template SCT Category
b. Operator: Not Equal
c. Value: HR Process

8. Publish the Blueprint.
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Configure HRSM Case Service Table
The Case Service table allows you to select a Case Service and define availability to customers, default
shared services, escalation teams, and more.

You can define:

• Availability to customers and/or HR technicians

• Default Shared Services and Escalation Teams

• Availability to employees based on limiting factors (example: manager status, country)

• Associated templates and/or checklists

The following HR Case Services are defined by default:

• Initiate Onboarding

• Initiate Offboarding

• Start Transfer

To configure additional HRSM Case Services:

1. In the CSM Desktop Client, select Tools > Table Management.
2. In the Type list, select Case Service.

3. Double-click the specific Case Service.

4. Select or clear the check boxes, depending on your preferences.

5. Link the following fields to the applicable HRSM-specific elements. See HRSM Case to understand
how the One-Step™ Actions handle these configurations:

◦ HR Specifics Name

◦ Task Template Name

◦ Default Shared Services Team

◦ Default Escalation Team

◦ First Checklist Name

◦ Second Checklist Name

◦ Valid Countries

Related concepts
HRSM Case
Configure HRSM Service Catalog Templates
Configure Cherwell HRSM Teams
Cherwell HRSM Checklists
Configure User Persona Filtering
Related tasks
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Configure Cherwell HRSM Portal Security Groups
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Configure HR Work Units
You can configure several HR Work Units that are provided by default in Cherwell HR Service
Management.

Work Unit ID Name WU Category Description

42 Provide Email Account Request Service Provide an email account

45 Deliver Equipment Perform a Task Deliver the equipment to the customer

46 Create AD account Perform a Task Create an AD account for the specified user

61 Review documentation for
completeness General Task

Review documentation for completeness. If
incomplete create an ad-hoc task for
customer to provide additional information

62 Update Workday General Task Update Workday

63 Manager Authorization Authorization Manager Authorization

64 Update information as
needed General Task Update information as needed

65 Review Access Request form General Task Review Access Request form

66 View Access Compliance
(role/title) General Task View Access Compliance (role/title)

67 Complete access General Task Complete access

68 Provide Eligibility Notice General Task Provide Eligibility Notice

69 Complete and return
Certification form (if required) General Task Complete and return Certification form (if

required)

70 Provide designation notice to
employee General Task Provide designation notice to employee

71 Transmit Verification General Task Transmit Verification depending on the
method in the verification request

72 Complete Verification form General Task Complete Verification form

73 Complete Reimbursement General Task Complete Reimbursement

74 Execute Direct Deposit General Task Execute Direct Deposit

78 New Hire Activities Checklist Complete the New Hire activities in the
checklist.

79 Complete Training Complete Training Complete Training

80 Welcome Letter General Task Welcome Letter

81 Set up Payroll General Task Set up Payroll

82 Set up Benefits General Task Set up Benefits

83 Payroll Activities General Task Last check and discontinuation in system
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84 Benefit Activities General Task Benefit Activities

85 Remove access to HR
System General Task Remove access to HR System

86 Paperwork Activities General Task Cobra Severance info

87 Review Application Access Perform a Task Review Application Access and remove if
necessary.

89 Request for Documentation/
Proof HR Work Request for Documentation/Proof

90 Review Documentation and
confirm valid change event HR Work Review Documentation and confirm valid

change event

91 Make requested changes in
HRIS HR Work Make requested changes in HRIS

92 Make changes as needed in
provider systems HR Work Make changes as needed in provider

systems

94 Complete the following form:
W4 Provide Document

• Follow the link and instructions below

• Employee Withholding Allowance
Certificate - W4

• Click on the link below and save the
rendered document

• Save the form and edit with your
information

• Attach the form to this task when
complete

• Mark the Task as Complete when you
are comfortable

95 Complete the following form:
I9 Provide Document

• Employment Eligibility Verification - I9

• Use the link below for an overview of
the I9 purpose and additional
information

• Navigate to the "Form I-9 (PDF,
551KB)" link

• Save the form and edit with your
information

• Attach the form to this task when
complete
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96 Complete the following form:
SF-256 Provide Document

• Voluntary Self-Identification of
Disability - SF-256

• Use the link below

• Save the form and edit with your
information

• Attach the form to this task when
complete

• Mark the Task as Complete when you
are finished with this activity

• Note: completion of this form is
voluntary

97 Complete the following form:
SF-85 Provide Document

• Background Investigation
Questionnaire - SF-85

• Use the link below and save the
rendered document

• Save the form and edit with your
information

• Attach the form to this task when
complete

• Mark the Task as Complete when you
are finished with this activity

98 Initiate Retirement Process in
HRIS General Task Initiate Retirement Process in HRIS

99 Contact Requestor HR Work Verify information and determine if additional
actions are needed

100 Badge Access Updates Perform access updates on employee badge

101 Create employee badge Configure facilities access

102 Review equipment needs Perform a Task Review equipment needs

104 SAP Access Perform a Task Provide access to SAP

105 SAP Security Setup Perform a Task Configure SAP Security

106 SalesForce Security Setup Perform a Task Configure SalesForce Security

107 SalesForce Access Perform a Task Provide Access to SalesForce
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Configure the New Hire Portal
Using the New Hire Portal, new hires can complete HR tasks before their first day on the job.

To give a new hire access to the New Hire Portal:

1. Set up a Security Profile for pre-hire candidates. This may be a copy of the Portal Customer security
group with only the New Hire portal available as a Site.

2. Set up your common HR Request links.
3. Provide the appropriate comma-separated keywords to the HR Knowledge Article. At a minimum,

add the exact category and subcategory terms (example: Benefits, Beneficiaries) so the article
appears in the proper location in the Portal.
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Configure Existing Forms to Include HRSM Fields
Cherwell HRSM adds several new fields to existing Business Objects. To ensure customer configuration
is not overwritten on the forms, new forms were created to contain these fields. The fields on these forms
must be copied to the Default forms to be viewed in CSM.

The following forms require modification:

• Customer-Internal Default form: Additional fields can be copied from the HR Supplemental section
of the HRSM Fields form.

Note: Manually copy (drag and drop) the Country Code field to the Overview form. This
field must be populated for filtering the available resources for an individual's country
policies. Unlike the other fields for persona filtering, the Country Code field is not
automatically copied over from the HR Supplemental section of the HRSM Fields form.

• Announcements Default form: The additional Announcements field can be copied from the HRSM
Discussion Fields form.

• Work Unit Default form: The additional Work Unit field can be copied from the Work Units Fields
form.

Related concepts
Configure User Persona Filtering
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Import HRSM Sample Reports
Import HRSM Sample Reports using the HRSM Reports.ced file provided with the mApp® Solution.

To import HRSM Sample Reports:

1. In CSM Administrator, create a new Blueprint.
2. Select Managers > Reports.
3. In the Association drop-down list, select HRSM Case.
4. Navigate to the Global folder.
5. Select File > Import.
6. Select the HRSM Reports.ced file and select Open.
7. Select Close.
8. Publish the Blueprint.
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Configure HRSM One-Step Actions for CSM 9.4.0
and CSM 9.5.0 Support of the Task Business
Object

If you are using CSM 9.4 or 9.5 content (your system has a Task Group Object with Work Items) then you
will need to load the Onboarding 9.4 & 9.5 Content.ced and Offboarding 9.4 & 9.5 Content.ced files.

These files replace the IT Access and IT Equipment One-Step™ Actions for onboarding, offboarding, and
transfer so they are compatible with 9.4 and 9.5 content.

To update the One-Step Actions:

1. In CSM Administrator, create a new Blueprint.

2. Select Managers > One-Step.

3. In the Association drop-down list, select HRSM Case.

4. Navigate to the Onboarding folder.

5. Select File > Import.
6. Select the Onboarding 9.4 & 9.5 Content.ced file and select Open.

7. Navigate to the Offboarding folder.

8. Select File > Import.
9. Select the Offboarding 9.4 & 9.5 Content.ced file and select Open.

10. Publish the Blueprint.
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Using Cherwell HRSM
You can use Cherwell HRSM to help HR Case Agents, customers, and new hires perform common tasks.

Use Cherwell HRSM to:

• Allow HR Case Agents to easily organize and track their work.

• Handle onboarding, offboarding, and employee transfer activities.

• Let your customers access the HR knowledge base.

• Allow new hires to complete pre-employment tasks via the New Hire Portal.
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HRSM Case
Use HRSM Cases to track and manage HR-related work items. Each HRSM case can have multiple HR
Tasks associated with it. You can also use HR Checklists to simplify the work.

See the following workflow diagram.
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Employees' assigned countries drive many behaviors in Cherwell® HRSM. Depending on the country,
CSM renders different specifics forms, task templates, and checklist assignments. The country also drives
default service and escalation teams.

With HR Case Management, you can:

• Optimize the HR caseload:
◦ Resolve redundant cases.

◦ Split and duplicate cases.

◦ Open an IT request from an HR Case.

◦ Set an HR Case to Pending status while waiting for external input.

◦ Nominate the resolution of an HR Case for the HR Knowledge Base.

• Securely view HR Cases.

• Submit an HR Case on behalf of another employee.

• Use HR SLAs (based on HR Case priority).

• Take advantage of many HR Reports.

Good to Know:

• The Employment Verification link appears in the Actions list in the specific form for Employment
verification. It triggers an email with the requester name and a template to be filled out by the HR
Case Agent.

• The Update Customer link appears in the Actions list on several specifics forms. It triggers a One-
Step Action to update a customer record. As HR Cases progress, you may want to update customer
records with the information you collect. You might also choose to configure the One-Step Action to
trigger an API call if you are running an integration with HRIS applications such as WorkDay or ADP.
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Create a Cherwell HRSM Case
HR professionals can use the HR Case Object to open a Cherwell® HRSM Case for a customer
(example: Create an Onboarding Case for a new employee in the company).

To create an HR Case:

1. In the CSM Browser Client, select New > New HRSM Case.
2. Customer: Select a name.
3. On Behalf Of: Select the button to the right of the Customer field to request a service for someone

else. It can be used for onboarding and offboarding, or an administrator can make a request on
behalf of a manager. Select True if both the customer and requester should receive communications
regarding the status.

4. Description: Enter a case description.
5. (Optional) Effective Date.
6. (Optional) Follow-up Date: Set a follow-up date.
7. Category: Select a category from the drop-down list.
8. Subcategory: Select a subcategory from the drop-down list. The customer profile, including the

customer's resident country, drives the choices available.
9. Case Service: Select a Case Service from the drop-down list. The customer profile drives the

choices available.
10. Priority: Select a priority.
11. Assigned Team: This field is auto-populated from the Table Service table. The only way you can

assign it to another team is by selecting Assign to Escalation Team under Actions. This assigns
the HR Case to the escalation team, but you can change it from the Assigned Team field.

12. Assigned To: Select an owner prior to beginning work on the case.
13. Fill out the HRSM Specifics tab as needed. This tab has specifics forms that are determined by the

category and subcategory choices.
14. Save the HR Case.

The Pending status allows you to put the HR Case on hold temporarily until you can move forward.
The HRSM Specifics tab has additional information. Tasks are created from Service Catalog Templates
(SCTs). SCTs create HR Tasks as well as Incidents.

The Potential Solutions tab shows HR Knowledge Articles whose keywords match the HRSM case's
category and subcategory.
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HR Case Actions
Use the Actions list to quickly initiate actions such as resolving duplications, assigning the case to an
escalation team, limiting access to the case, and more.

To initiate actions:

• Generate Tasks from Template: Select a Task Template. The Tasks will show up in the Tasks tab
after you save the HR Case.

• Assign to Escalation Team: The default escalation team is set in the Case Service table.

• Assign to Me: Use this link to assign yourself the HRSM Case. Your name will now appear in the
Assigned To field.

• Resolve Redundant: Use this function when a customer opens duplicate cases.

• Split/Duplicate Case: Generates a new HR Case with duplicated Customer and Description
fields. You will need to manually add categorization information.

• Create an IT Incident: If an HRSM Case needs to be addressed via an IT Incident, use this link to
convert the HRSM Case.

• Refer to Another Service Desk: Generates an email message containing HRSM Case details.

• Nominate for Knowledge Base: If the case resolution would be helpful for other HR Agents, use
this link to create an HR Knowledge Article. The article will appear in draft status.

• Add a Checklist: Add a pre-built Checklist to the HRSM Case.

• Set a Follow-Up Date Reminder: Creates a calendar reminder (CSM Desktop Client).

• Limit Access to this Case: Sets the current assignee as the only individual with access to this
case.

• Set to Pending: You can place an HRSM Case in the Pending status to put the Case on hold.

• Cancel: Cancel the HRSM Case; the status will be set to Closed.
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Work an HR Case
When working an HR Case, you can manage multiple related tasks, streamline workflow, or escalate the
Case to another team.

1. You can escalate an HR Case to another team. Selecting the Assign to Escalation Team link will
re-assign the Case to the default escalation team (identified in the Case Service table). You can
assign it to a different team if necessary, but you must use the Assign to Escalation Team link first.

2. Use the Tasks tab to manage associated tasks.
3. Use the Skip Task and Quick Complete Task Actions to streamline the workflow.
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Cherwell HRSM Tasks
To help organize your Cherwell® HRSM work, you can assign Tasks to HRSM Cases. Some HRSM Tasks
are automatically generated via Service Catalog Templates as part of an HR Case.

You can also manually add HR Tasks to HR Cases. The HR Tasks can be assigned to HR team
members, or to end users. When you assign HR Tasks to users, they will appear in the Portal.

The default Task Template is identified in the HR Case Service record. These can be owned by an HR
Case agent and, if applicable, can identify actions for users. SCTs are used for Task Templates.

Note: Even though you can attach files to a Task, the attachment appears on the parent HR Case.
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Cherwell HRSM Task Actions
Use the Actions list to quickly initiate actions such as adding a checklist, assigning the task, and more.

Actions include:

• Assign to Me: Puts your name in the Assigned To field.

• Add a Downstream Task: Select to open a new Task Form. This adds an additional dependancy to
the parent record. The Downstream Task must be completed after the parent HR Task.

• Link to an Upstream Task: Select to link an Upstream Task to the HR Task. The Upstream Task
must be completed prior to completing the current HR Task.

• Add a Checklist: Select Form or Tab.

• Quick Complete
• Skip Task: Sets the status to Closed, and notes the HR Task was skipped.

• Assign To: Select a user to assign the HR Task to.
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Cherwell HRSM Batch Case
Use the HRSM Batch Case function to create the same HR Case for multiple employees. Each individual
will have a Case on record and get notifications from the workflow.

After completing the details of the Batch Case, before you create new Cases, you must link employees to
the Batch Case from the Employees tab.

Note: The list of employees are tied directly to the country code that you selected on the
Overview tab. For example, if you selected US in the Country Code field, only employees who
have a US country code are available for linking.

After employees are linked to the Batch Case, when you initiate the Start Cases task, you will see a list of
individual cases for each employee in the HR Cases tab. Details that you provided in the Batch Case are
automatically moved to the individual employee Cases. You can also continue to add more individual
employee cases, as needed.

You can close the parent Batch Case and all of the individual Cases that are linked to it at one time.
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Cherwell HRSM Onboarding Process
HR Cases for Onboarding can be created automatically (via an HRIS system like ADP, Workday, UltiPro,
etc.) or manually through CSM.

Once the Onboarding HR Case is submitted, the HR Case Agent reviews the Case and initiates the
onboarding process by selecting Start Onboarding. An IT ticket with associated Tasks is created with the
HR Case Tasks.

To access the Onboarding process:

1. Open a new HR Case.

2. For the Category, select Employee Lifecycle.

3. For the Subcategory, select Onboarding.

4. For the Case Service, select Initiate Onboarding.

When an HR Case for Onboarding is initiated, an HR worker will review the Case, then select the Start
Onboarding button. This action opens an Incident for the service desk to perform required tasks
(example: Setting up an Active Directory account).

HR Onboarding Tasks (determined by the persona information) include:

• Complete Training

• Welcome Letter

• Set Up Payroll

• Set up Benefits

• Complete the following form: W4

• Complete the following form: SF-256

• Complete the following form: I9

• Complete the following form: SF-85

Good to Know:

• An IT Service Request is triggered to create an Active Directory account.

• After the Active Directory account is created, IT enters the account in the Specific Form to resolve
the Request. An Automation Process enters the new employee in the On Behalf Of field of the HR
Case.

• Two more IT Service Requests are triggered for Access and Equipment along with the necessary
Tasks based on the Service Catalog Templates associated with the new employee's Role.

• HR Tasks are also created based on the Service Catalog Template tied to the Service Category.
Some HR Tasks are handled by HR Case Agents, and some are assigned to the new employee
(accessible through the HR New Hire Portal).
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Cherwell HRSM Offboarding Process
After the Offboarding HR Case is submitted, the HR Case Agent reviews the Case and initiates the
offboarding process by selecting Start Offboarding. An IT ticket with associated Tasks is created with the
HR Case Tasks.

Offboarding Tasks include:

• Last check and discontinuation is in the system

• Benefit Activities

• Remove access to HR system

• Cobra severance info, etc.

To access the Offboarding process:

1. Open a new HR Case.

2. For the Category, select Employee Lifecycle.

3. For the Subcategory, select Offboarding.

4. For the Case Service, select Initiate Offboarding.

You can also access and complete the HR Offboarding Checklist.
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Cherwell HRSM Employee Transfer Process
After an Employee Transfer HR Case is submitted, the HR Case Agent reviews the Case and selects the
Start Transfer button. The IT Tickets with Tasks and the HR Tasks are created in parallel.

To access the Employee Transfer process:

1. Open a new HR Case.

2. For the Category, select Employee Lifecycle.

3. For the Subcategory, select Employee Transfer.
4. For the Case Service, select Initiate Transfer.

Employee Transfer Tasks include:

• Update Workday

• Complete access

• Complete training
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Update Customer Function
The Update Customer button appears on several specifics forms, and it triggers a One-Step™ Action to
update a customer record. As HR Cases progress, you may want to update customer records with the
information you collect.

You might also choose to configure the One-Step Action to trigger an API call if you are running an
integration with HRIS applications such as WorkDay or ADP.

Below is a list of Case Services and the customer record fields they can modify.

• Case Service: Onboarding Customer Updates
◦ Building

◦ Country Code

◦ Department

◦ Employee Status

◦ First Date of Work

◦ First Name

◦ Home Phone

◦ Last Name

◦ Management Level

◦ Middle Initial

◦ Middle Name

◦ Personal Email

◦ Position Time Type

◦ Title

◦ Worker Type

• Case Service: Offboarding Customer Updates
◦ Not Eligible for Rehire

◦ Position Time Type

◦ Resignation Date

◦ Resigned

◦ Retired

◦ Retirement Date

◦ Terminated

◦ Termination Date

• Case Service: Employee Transfer Customer Updates
◦ Building
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◦ Department

◦ Employee Status

◦ Exemption Status

◦ Management Level

◦ Position Time Type

◦ Title

◦ Worker Type

• Case Service: Change Information
◦ Country Code

◦ Emergency Contact Name

◦ Emergency Contact Phone

◦ First Name

◦ Home Address 1

◦ Home Address 2

◦ Home City

◦ Home Country

◦ Home Phone

◦ Home Postal Code

◦ Home Province/State

◦ Last Name

◦ Marital Status

◦ Middle Initial

◦ Middle Name

◦ Mobile

◦ Personal Email
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Cherwell HRSM Knowledge Articles
You can create new Knowledge Articles and make them available for HR staff to use when working
Cases.

The Knowledge Article workflow consists of four phases:

1. Create a new HR Knowledge Article.

2. The Technical Review Team reviews and modifies the technical content.

3. The Format Review team ensures the Knowledge Article renders correctly in the Portals. The
Format Review is only required if the HR Knowledge Article is intended to be visible in the Portals.

4. Retire an article, if needed.

Good to know:

• When searching for HR Knowledge Articles in the CSM Browser Client, you must select which
article type you want to search for.

• Use the Article and Details buttons to toggle views.

• Searches for HR Knowledge Article only query the keywords that are associated with an HR
Knowledge Article, such as the category and subcategory (example: Benefits, Beneficiaries).

• In HR Cases, a Potential Solutions tab lists HR Knowledge Articles that match the Case
Subcategory against HR Knowledge Article keywords.
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Create an HR Knowledge Article
The first step in the HR Knowledge Article workflow is to create the Knowledge Article itself. Then, you
can move to the next step, which is the Technical Review.

To create an HR Knowledge Article:

1. In the CSM Desktop Client, select New > New Knowledge - HR.
A new HR Knowledge Article form opens.

2. Select a Category.
3. Subcategory choices are driven by the Category selection.

The Teams and Publishers are populated in the left panel.
◦ The teams for technical review, format review, and Publishing approval are stored in the HR

Category table.
◦ All articles have a technical review. Format review is only initiated if the article is marked

Visible in the Portal. All have a Publishing approval.
4. Service: Service choices are driven by the Category and Subcategory selections.
5. Publish Date: You can queue up articles and set a publish date. Approvals can be performed ahead

of time, but the HR Knowledge Article will not publish until the date you set.
6. Knowledge Type: Each Knowledge Type has a different article format.
7. Assigned Team: Automatically populated based on the Category choice.
8. Assigned To
9. Format Review Team: Automatically populated based on the Category choice.

10. Visible on Customer Portal: You may have some articles that are for internal use only; if you want
this KA viewable by end users, check the Visible in Portal box.

11. Make FAQ on Customer Portal: Select this option if you want the KA to appear in the FAQ grid on
the HR Portal.

12. Set Review Date. Sets a timeframe for review of the article. The article won't be removed from the
Published state, but a Ready for Review alert will appear on the Knowledge Dashboard.

13. Keywords: Keywords are used to determine which Knowledge Articles appear as solution
suggestions in HR Cases. At a minimum, add the exact category and subcategory terms separated
by commas (example: Benefits, Beneficiaries) so the article appears in the proper location in the
Portal. Consider including informal language and misspellings.

Fill out the Customer Persona Details. This information is used to determine which HR Knowledge Articles
are available on the Portal for end users. These can be extended to include any other core customer
attributes (union membership, campus, etc.). These fields are not required.

14. Exemption Status: Choose exempt or non-exempt.
15. Employee Status: Choose a status.
16. Select the Manager check box if the Knowledge Article should be visible only to users who are

designated as managers.
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17. Country Code: Use the Add a Country and Remove a Country links to select which employees
can access the HR Knowledge Article.

18. States/Provinces: Use the Add a State/Province and Remove a State/Province links to select
which employees can access the HR Knowledge Article.

19. Select the Article button to add Article information; fields are driven by the Knowledge Type.
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HR Knowledge Article Actions
Use the Actions list to quickly initiate actions, including a technical review, adding attachments, emailing
the customer, and more.

Actions include:

• Technical Review: Changes the status to Technical Review.

• Add Attachments: Add files to the HR Knowledge Article.

• Technical Review: Sends the HR Knowledge Article to the Technical Review team. Once completed,
this option is no longer enabled.

• Format Review: Sends the HR Knowledge Article to the Format Review team. Once completed, this
option is no longer enabled.

• Email Customer: Generates an email with a link to the Knowledge Article.

• Review Completed: Review process complete.
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Cherwell HRSM Checklists
HR Checklist is a feature designed specifically for HR. HR organizations track many different action items
and documents based on employee requests.

Most HR organizations choose the lighter 'checklist' functionality over the default Tasks. Checklists are
selected in the HRSM Case Service records and track specific items required for each of these individual
areas (example: FMLA requests).

HR Checklists can take the place of HR Tasks in an HR Case, or you can use them with Tasks.

102

CSM mApp Solutions

CSM mApp Solutions



Cherwell HRSM Self-Service Portal
The HRSM Portal provides access to HR Knowledge Articles as well as a form so users can submit an
HRSM Case.

Increase employee self-sufficiency and reduce ticket volume using the HRSM Self-Service Portal. The
HRSM Self-Service Portal filters HR Knowledge, FAQs, and announcements based on the employee's
profile information. Employees can see their open HR Cases and assigned HR Tasks.

As employees navigate through the HR Service Catalog, they can see related HR Knowledge Articles.
With a well planned collection of HR Knowledge Articles, your customers will need to open fewer HR
Cases.

Note: When creating Knowledge Articles, add comma-separated keywords that exactly match the
category and subcategory names (example: Benefits, Beneficiaries). When employees select
Make a HR Request and select a relevant category, only the Knowledge Articles that are tagged
with that exact category name appear on the page. Likewise, Knowledge Articles on the
subsequent page appear only when they are tagged with the exact subcategory name.

The HRSM Portal provides:

• HR Knowledge Articles based on the user's profile attributes (example: employment type, country,
state, etc.).

• Commonly-requested links.

• FAQs.

• Multi-language support.

• Targeted announcements relevant to the user's profile

• Separate landing pages for each of the key areas of HR to provide additional information specific to
the area (example: Benefits, Talent Acquisition, Payroll, etc.).

• Forms for submitting a new HR Case.

Note: When accessing the HRSM Self-Service Portal, users must log in and then select an
additional Enter button. Selecting this button captures user persona information used for filtering
the Knowledge and Services available.

103

CSM mApp Solutions

CSM mApp Solutions



New Hire Portal
New hires can use the HRSM New Hire Portal to complete pre-employment HR Tasks (EEO documents,
I-9, training, etc.).

When HR initiates an Onboarding HR Case, Tasks for the new hire are generated. Those HR Tasks will
appear in the New Hire Portal. The Journal Notes in the HR Case is used for notes to and from HR and
the new hire.
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Cherwell HR Service Management mApp Solution
Items

The Cherwell HRSM mApp Solution includes the following items:

Item
Category Item

Typical
Merge
Action

Major
Business
Objects

HRSM Batch Case, HRSM Case, Knowledge Management (Group),
Knowledge - HR Import

Customer Internal - Additional fields to support HR, Work Unit - Extended to
assign HR Tasks to Requestor Merge

Supporting
Business
Objects

Checklist Item, HR Task, HR Case Limited Access List, HRSpecifics
(Group), AdditionalDetails, Benefit Change, Direct Deposit, Disciplinary
Action, Employee Information Change, Employee Offboarding, Employee
Onboarding, Employee Transfer, Employment Verification, FMLA, General
Leave, HR System Access, I9, Modify W4, SF-256, SF-85, Tuition
Reimbursement Pre-Approval, Tuition Reimbursement Request, Visa
Assistance, Visa Question, W4, W4 Modify, Role, Specifics (Group), HR IT
New Hire

Import

Approval - Added relationships to HRSM, Journal - Additional functionality
to reply to Notes, SLA Target Time - added a Parent Type of HR Case Merge

Lookup
Tables

Case Category, Case Priority, Case Service, Case Service List, Case
Subcategory, Case Type, Checklist, HR Case Pending Reason, HR Case
Resolution Code, HR Case Status, HR KB Page Display, HR Specifics
Lookup Field, HR Benefits Lookup Value, HR Task Close Code, HR Task
Status, HR Task Type, Knowledge Management Article Type, Knowledge
Management Review Period, Knowledge Management Status, Knowledge
Management Status List

Import

Country - Added 3-character abbreviation support, SCT WU Category Merge

Dashboard

Reporting Dashboards, HRSM Tier 1, HRSM Tier 2, HRSM Knowledge
Base Articles, HRSM Manager, HRSM Executive, Portal, HRSM Benefits
Payroll, HRSM Home, HRSM Jobs, HRSM My HR Requests, HRSM
Policies, HRSM Service Catalog, HRSM Service Catalog Service, HRSM
Service Catalog Subcategory, HRSM Training, HRSM Welcome, New Hire
Portal, New Hire Home, New Hire Logged In, New Hire Messages, New
Hire Tasks

Import

Team Import

Related concepts
Cherwell HRSM Security Groups
Related information
Configure Merge Actions for Business Object Definitions
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Information Security Management System (ISMS)
2.4

As a comprehensive solution for managing risk, compliance, and security operations, the Cherwell ISMS
mApp® Solution leverages Cherwell's Configuration Management Database (CMDB), Information
Technology Service Management (ITSM) framework, and lifecycle processes to marry the capabilities of
typical Governance, Risk, Compliance (GRC) tools with real-time operational benefits for Security Incident
handling.

Platform Version Requirements: Tested on CSM version 10.2.0.

Content Version Requirements: Tested on CSM 10.2.0; ISMS 2.4 contains specific changes to work
with the enhanced Event Management Business Objects within 10.2.0 OOTB content. If you have an
older content version, you should download the ISMS 2.3 mApp Solution, available in the Customer
Support Portal.

Prerequisites: None.

Available languages: English.

Note: This functionality is only available after you apply the mApp Solution.

Overview
Cherwell Software's Information Security Management System (ISMS) mApp Solution serves as a:

• Governance, Risk, Compliance (GRC) Tool: Cherwell ISMS provides a centralized platform for
organizations to assess risk and manage compliance against numerous authoritative sources.

• Security Operations Tool: Cherwell ISMS serves as an aggregation point where security analysts
can assess security alerts and events of interest from multiple sources and take appropriate actions
when necessary.

Cherwell ISMS can align security controls and policies across multiple industry standards such as
International Organization for Standardization (ISO) 27001:2013, Health Insurance Portability and
Accountability Act of 1996 (HIPAA), Payment Card Industry (PCI), and more. Downloading Cherwell ISMS
is not a requirement for security industry standards and does not automatically make an organization
compliant with security standards.

Cherwell ISMS provides the following benefits:

• Centralized tracking of and adherence to security and compliance policies.

• Analysis and mitigation of risks and employment of applicable controls.

• Streamlined audits, findings reports, and process for appropriate actions.

• Important data related to security events in a single platform for assessment.
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• Rapid containment of any breaches and documentation of steps taken in a secure, need-to-know
process.

• Integrated hand-offs between IS and IT.

Key Business Objects
The following are the key Business Objects associated with Cherwell ISMS:

• Audit

• Security Incident

• Compliance (Corrective and Preventative Actions)

• Authority Documents

• Citations

• Controls

• Policies

• Risk Assessment

Authority Documents, Citations, Controls, and Policies
Authority Documents: External contractual obligations, standards, regulations, or statutes containing
security measures your company is required to comply with.

Citations: Detailed statements of compliance requirements from the Authority Documents.

Controls: Actions required to comply with Citations. Controls may be associated with multiple Citations or
Policies.

Policies: How your company intends to comply with Controls (example: password complexity, password
expiration interval).

How Cherwell ISMS Works
CSM provides Cherwell ISMS as a mApp Solution so you can effectively manage your security
processes. Use the Apply mApp Wizard to apply the mApp Solution to your development CSM system,
where the solution can then be viewed and published. After evaluating and testing the solution against the
development system, apply it to your production environment.

For a list of items included in the mApp Solution, see ISMS mApp Solution Items.

Apply the mApp Solution

1. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

2. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.
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Note: While you publish the Blueprint, you may see a set of warnings in the Scan Results page
concerning Security Groups and Roles. Select the Ignore Warnings and Continue check box
and select OK to publish the Blueprint.

Revision History

mApp Version Platform Version
Requirements

Content Version
Requirements Prerequisites

1.0 8.2.1 8.2.1 None

1.1 8.2.1 8.2.1 None

2.0a 9.3.1 - 9.4.0

9.1 - 9.4.0; depending on
your configurations, versions
back to 8.2.1 may also be
compatible.

If you have ISMS 1.1
installed, install the
ISMSv2-prequisite mApp
Solution first. This will
change the name of the
Control Object to Citations
to prepare the system for
ISMS 2.0 Business Objects.

2.1 Tested on 9.7.0

Tested on 9.7.0; ISMS 2.1
may not be compatible on
content versions older than
9.7.0, but as with all mApp
Solutions, it should be tested
on your customized system.

If you have ISMS 1.1
installed, install the
ISMSv2-prequisite mApp
Solution first. This will
change the name of the
Control Object to Citations
to prepare the system for
ISMS 2.0 Business Objects.

2.2 Tested on 10.0.0

Tested on 10.0.0; ISMS 2.2
may not be compatible on
content versions older than
CSM 9.7.0, but as with all
mApp Solutions, it should be
tested on your customized
system.

None

2.3 Tested on 10.0.0

Tested on 10.0.0; ISMS 2.3
may not be compatible on
content versions older than
CSM 9.7.0, but as with all
mApp Solutions, it should be
tested on your customized
system.

None
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mApp Version Platform Version
Requirements

Content Version
Requirements Prerequisites

2.4 Tested on 10.2.0

Tested on 10.2.0; ISMS 2.4
contains specific changes to
work with the enhanced Event
Management Business
Objects within 10.2.0 OOTB
content. If you have an older
content version, you should
download the ISMS 2.3 mApp
Solution, available in the
Customer Support Portal.

None

Related concepts
About mApp Solutions
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Set the Dashboard for the Security Analyst Role
Edit security roles to set dashboard rights for the Security Analyst.

Cherwell ISMS and its workflows are based off Security Analyst and Security Manager roles. Depending
on the size and security needs of your company, additional roles may be required.

To set the dashboard for the Security Analyst role:

1. In CSM Administrator, select > Security > Edit roles.
2. Select Security Analyst from the list of roles.

a. In the Dashboard section, select the Dashboard option.
b. Select the Dashboard Manager button.
c. Select the ISMS Dashboards folder (Global > mApp Factory).
d. Select Operations, and then select OK.

3. Select Save to save the Security role.
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Set the Dashboard for the Security Manager Role
Edit security roles to give dashboard manager rights to the Security Manager.

To set the dashboard for the Security Manager role:

1. In CSM Administrator, select Security > Edit roles.
2. Select Security Manager from the list of roles.

a. In the Dashboard section, select the Dashboard option.
b. Select the Dashboard Manager button.
c. Select the ISMS Dashboards folder (Global > mApp Factory).
d. Select Posture, and then select OK.

3. Select Save to save the Security role.
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Provide Object Data in Table Management
Limited sample data is included with Cherwell ISMS as an example only. Users must provide their own
values to existing Lookup Tables.

Data can be added, edited, and customized through Table Management. Additionally, .csv files can be
used to upload data to the tables.

New Business Object values display in the Table Management interface. Use the Type drop-down list to
switch between ISMS Lookup Objects.

ISMS Control Group Object
Create Control Groups that align with current industry standards such as FedRAMP:2014, ISO
27001:2013, and ISO 9001:2015. Specified Controls are later added to each Control Group. XXX Control
Group is now a Lookup Table object, and populating this table is optional. You can use this to help group
your controls for organizational purposes. This table is populated with a few examples from HIPAA and
ISO 27001.

To provide Object data for the ISMS Control Group Object:

1. On the CSM Desktop Client or Browser Client menu bar, select Tools > Table Management.
2. In the Type drop-down list, select ISMS Control Group.

3. Create a new Control Group or edit an existing Control Group.
Create a new Control Group:

a. Right-click and select New.

b. Provide a name for the control group. This can be the same as the name of one of the
Authority Documents (example: ISO 27001:2013).

c. (Optional) Provide a control group number.

d. Provide a control group name.

4. Edit an existing Control Group:
a. Double-click any example control.

b. Edit desired fields, and then select the Save button.

ISMS Risk Mitigation Questions Object
You must create Questions and assign Risk Values, Question Weight, and Question Sequence to use the
Risk Assessment form. ISMS Risk Mitigation Questions and Threat Analysis Questions populate the Risk
Assessment. It is recommended to align Risk Assessment Questions with current industry standards such
as FedRAMP:2014, ISO 27001:2013, or ISO 9001:2015.

To provide Object data for the ISMS Risk Mitigation Questions Object:

1. On the CSM Desktop Client or Browser Client menu bar, select Tools > Table Management.
2. In the Type drop-down list, select ISMS Risk Mitigation Questions.
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3. Create a new Risk Mitigation Question or edit an existing question.
Create a new Risk Mitigation Question:

a. Right-click and select New.

b. Provide an industry standard question title and question details.

c. Specify the question type.

d. Provide a numeric risk value and sequence number based on industry standards.

e. Select a value from the ISMS Risk Assessment Type drop-down list.

4. Edit an example question:
a. Double-click any example risk mitigation question.

b. Edit desired fields, and then select the Save button.

5. Repeat steps 1-4 above for ISMS Threat Analysis Questions.
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Cherwell ISMS Portal Event Configuration
You can submit a Security Event via a CSM Portal form, but ensure the feature is enabled and configured.

Update the Portal Customer Security Group
To update the Portal Customer security group:

1. Open the Security Group Manager

2. Select Portal Customer from the Group drop-down list.

3. In the Business Objects tab, select Security Event from the Business Object drop-down list.

4. In the General section, select the View, Add, and Edit check boxes.

5. In the New Business Object Rights pane (under the Security Event Business Object), select New
Field, and then select the View and Edit check boxes.

6. Select Save, and then close the Security Group Manager.

Update the Portal Dashboard with Security Event Link
To update the Portal dashboard with a Security Event link:

1. In CSM Administrator, select Browser and Mobile > Site Manager.
2. Right-click on the portal site, and select Edit.
3. On the Display page, select the Dashboard link (under the Startup section, in the Show on login

field).

4. In the Dashboard Editor (under the Shapes, etc. widgets), drag a Link Action on to the dashboard.

5. Update the Link Label and font.

6. Right-click the link and select Widget properties.

7. On the Choose Action page, select the ellipsis to access the Action Manager page.

8. Select the Commands page, and then select System > Other.
9. Double-click Create Business Object.

a. Select Event - Security in the Business Object drop-down list.
The Display Text field autofills with Create Event - Security.

b. Select the Use One-Step for Creation check box.

10. Select OK, and then select OK again.

11. Close the Site Editor properties window, and then close the Site Manager.

Create Recurring Audit Scheduler
To create a recurring Audit Scheduler:
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1. In CSM Administrator, select Scheduling > Edit Schedule.

2. Select Add.
a. On the General page, give the Scheduled Item a name.

b. On the Schedule page, select the Recurring option.

c. Set a start time, recurrence, and range of recurrences. Recommended settings are:
◦ Start Time: 12:00 AM

◦ Recurrence: Daily

◦ Range of Recurrences: No end Date

d. On the Action page, select One-Step from the Action drop-down list.

e. Next to the One-Step field, select the ellipsis. In the One-Step™ Action Manager, select ISMS
Audit from the Association drop-down list.

f. Under the Blueprint folder, select Create a new Audit.
3. Select OK, and then select OK again

4. Select Exit.

Related concepts
Managing Security Groups
Dashboard Editor
Define and Format Widget Text
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Security Event Supplemental Form
Use the Event - Security Supplemental form to add links and fields to the Security Overview form.

Use the links and fields to add One-Step™ Actions and fields that are pre-configured and formatted for
the Security Event form.

1. In CSM Administrator, edit the Event - Security form.
2. Open the Event - Security Supplemental form.
3. Copy any of the following links and paste them onto the Event - Security Overview form, under the

Actions list.
◦ Escalate to Security Incident
◦ Create Preventative Action
◦ Create Corrective Action

4. Copy any of the following fields and labels (and controls) and paste them onto the Event - Security
Overview form.

◦ Config Item
◦ CI Risk
◦ Supporting Service Config Item
◦ Supporting Service Risk
◦ Runbook Name

5. Publish the Blueprint.

Related concepts
Open the Form Editor
Publish a Blueprint
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Use Cherwell ISMS
Use Cherwell ISMS to manage records such as Security Events, Risk Assessments, and Audits.

You can use Cherwell ISMS functionality to create and manage the following:

• Security Events

• Security Incidents

• Risk Assessments

• Authority Documents

• Citations

• Controls

• Policies

• Audits

• Corrective Actions

• Preventative Actions
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Cherwell ISMS Dashboards
Cherwell ISMS provides six security-oriented dashboards.

ISMS Home Dashboard
The Cherwell ISMS home dashboard launches each of the security-oriented dashboards.

GRC Dashboard
The Governance, Risk & Compliance (GRC) dashboard is focused on providing information dealing with
an organization's overall compliance and risk posture, as well as ongoing audit activities. This dashboard
is primarily built for Compliance Managers or Governance department members.
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Security Posture Dashboard
The Security Posture dashboard aims to provide a Security Manager or Chief Information Security Officer
(CISO) with an overall view of the organization's current security status. The dashboard delivers real-time
information on Security Incident and Events by Risk as well as a Really Simple Syndication (RSS) feed of
all recently posted cyber threats from the United States Computer Emergency Readiness Team (US-
CERT) website.
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Security Operations Dashboard
The Security Operations dashboard is intended to be an aggregator of key operational security
information and allow Security Analysts to quickly analyze potential security threats. Events of interest
from Security Information and Event Management (SIEM), point security solutions, and network
monitoring solutions are presented on the Security Operations dashboard. Security analysts can quickly
review these events in one place, compare them to active security feeds from outside sources, and
manage Security Event and Security Incident handling processes.
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GDPR Citations Dashboard
The GDPR CItations dashboard provides an overview of GDPR-related Citations, Risk Assessments, and
Security Incidents.
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ISMS Audit Calendar Dashboard
The ISMS Audit Calendar dashboard shows actual and proposed audits in a calendar view.

ISMS Statement of Applicability (SoA) Dashboard
The SoA is a useful dashboard for everyday operational use because it displays comprehensive coverage
of your organization's information security measures. The list of controls implemented provides
understanding into risks accepted as well as risks avoided. A SoA can also be used to justify your
organization's position during an audit.
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Create a Security Event
Security Events are generated from multiple sources.

You can create Security Events from:

• IT Incident

• Integration with a Security Information and Event Management (SIEM) and/or network monitoring
systems

• Manually

Related concepts
Security Events
Related tasks
Create a Network or Security Event
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Manually Create a Security Event
Manually create a Security Event to track and manage security-specific events.

To manually create a Security Event:

1. CSM Desktop Client or Browser Client toolbar, select New > New Event > New Event - Security.
2. Provide a name (optional) and details of the event (example: Laptop stolen; Laptop stolen from

rental car).
3. Select an event type (example: Loss or Theft of Equipment).

The type displays on the top of the form.
4. Select a priority and event severity.
5. Select a reported date time and who reported the event (optional).
6. Select a source and external source ID (optional).
7. The Assigned Team field is auto populated.
8. Assign an owner (Assigned To field).

When an owner is selected, the Security Event automatically enters the In Progress phase.
9. A Runbook will be populated if there is one associated to the selected type.

10. Enter a Config Item if it is not automatically populated from an integration source.
If there is an active Risk Assessment associated with the Config Item, the Mitigated CI Risk field
will also be populated.

11. Enter a supporting service, if known. The Mitigated Service Risk field will be populated if there is
an active Risk Assessment for the supporting service.

12. (Optional) Add notes to the Event Response Notes field.
These fields are audited; Journal entries track modifications.

13. (Optional) Select a cause code and add resolution details.
14. (Optional) Initiate other Actions using the appropriate links in the Actions list, in response to a new

Security Event.
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Create a Security Event via an IT Incident
Create a Security Event from an IT Incident to link the Event to the Incident.

Cherwell ISMS contains the following Create ISMS Security Event capabilities:

• One-Step™ Action to open a Security Event.

• Relationship between Incident and Security Event.

• Summary forms for a Security Event.

To configure the Incident form:

1. Add a link to the Incident form to initiate this One-Step Action.
2. Add the Security Event tab to the Incident form.

Related tasks
Add a Link Label Control to a Form
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Create a Security Incident
A Security Incident is defined as a violation or imminent threat of violation of computer security policies,
acceptable use policies, or standard security practices. Security Incidents can only be opened through a
Security Event.

Security Incidents have the following specific security rules against them:

• The Default Owner team is Security Incident.

• The user who opened the Security Incident is added to the Granted Users list (and associated tab).
Only users who are in the Security Manager security group and/or are on the Granted Users list can
view/modify a Security Incident (once security groups are set up as outlined in Configuring Cherwell
ISMS.

To create a Security Incident:
Open the Security Event.

a. Select the Escalate to Security Incident link in the Actions list.
A prompt opens for a Security Incident description.

b. Enter key details in the Security Incident Description field, and then select OK.

c. Fields in the Detection and Analysis sections are populated from the Security Incident. Fill in any
additional information in this area, as appropriate.

d. Select a Security Incident owner from the Assigned To drop-down list.

e. Select the Next: In Progress link under Status.

You are now ready to begin work on the Security Incident.
Related concepts
Create a Security Event
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Work a Security Incident
Work a Security Incident to determine the cause of the violation and resolve it.

To work a Security Incident (one that is already in the In Progress phase):

1. Open the Security Incident.
2. Complete the Incident Containment field and select a reviewer.
3. Use the form arrangement tabs to view information associated with the Security Incident or to add

Tasks for addressing the Incident.
◦ Overview
◦ Journals
◦ Runbook
◦ Security Events
◦ Granted Access
◦ Tasks
◦ Security Incident Timeline

4. (Optional) Create supporting tickets from the Actions list or initiate supporting actions. These can
be initiated at any stage prior to Resolved. A few are highlighted below.

a. Security Incident Notification: Provides an email template that can be modified to send out
notifications to interested parties, such as Legal or HR.

b. Grant Access to Users: Allows you to add users that will now have rights to view and edit this
Security Incident.

c. Create a Preventative Action and Create Corrective Action: Opens a Preventative or
Correction Action form.

d. Create an IT Incident and Create Change Request: Opens an Incident or Change form.
5. Complete the Eradication and Recovery Actions fields.
6. Select an Incident resolution code.
7. When appropriate, a Post Review can be completed on the Security Incident. Select the Post

Review link (under Stage) and complete the fields on the Post Review form. You can go back to the
other information by selecting the Stage: Eradication and Recovery link. Select the Stage: Post
Review link to move to the Post Review stage and complete the relevant Post Review fields.
The Security Incident can be resolved prior to Post Review being completed.

8. Select the Next: Resolved link to change the status to Resolved. There is no Closed status.
Security Incident tickets can be resolved if there are open Compliance Records. This can be
modified by the customer based on business requirements.

Related tasks
Create a Security Incident
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Create an ISMS Exemption
ISMS Exemptions are entered to document and get approval for non compliance with an Audit, Risk, or
Policy.

To create an Exemption:

1. On the CSM Desktop Client or Browser Client toolbar, select New > New ISMS Exemption.
2. Select the requester and exemption type.
3. Depending on the exemption type you choose, a field to link the associated audit, policy, or risk

assessment appears.
A tab for the association will also display in the form arrangement.

4. Select the assigned team and owner.
The assigned team will drive the options available in the Assigned To drop-down list.

5. Select a value in the Exemption Term in Months drop-down list and add details to the Current
Use field.

6. (Optional) Select the date approved and expiration date.
7. Add details for the justification for the exemption in the Reason for Exemption field.
8. (Optional) Select the device type.

Depending on the device type selection, there may be additional fields to complete (example:
Asset, Device Name, Location).

9. (Optional) Provide details in the Mitigation field.
10. Select Save if you need to come back to the form later to submit it.
11. When the Exemption form is complete, select the Next: Submitted link under Status.

While in the Submitted phase, the assigned team reviews the request and determines if more
information is required.

12. When the Exemption is ready for approval, select the Next: Approving link under Status.
An Approvals tab appears in the form arrangement.

13. The Approver can vote to Approve, Deny, or Abstain, as well as provide comments. Add additional
Approvers, if necessary. If there are multiple Approvers, each will need to provide approval before
the Exemption can move to the next step.
The Approver for the Exemption is determined by the Exemption Type:

Exemption Type Approver

Risk Risk Owner

Audit Lead Auditor

Policy Business Owner

14. Once the Exemption is approved, the status changes to Active.
If the Exemption is approved and the status is not Active, select the green refresh button.

15. Close the Exemption when it is no longer applicable.
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Create a Risk Assessment
Information security risk assessment is an on-going process of discovering, correcting, and preventing
security problems.

To create a Risk Assessment:

1. On the CSM Desktop Client or Browser Client toolbar, select New > New ISMS Risk Assessment.
2. Provide general information.

a. Provide a name and description.
b. Provide details (example: Evaluate laptops for potential security risks).
c. Select the assigned team and owner.

This choice will drive the users available in the Asset Owner drop-down list.
d. Select a risk assessment type.

This choice drives the set of assessment questions you will answer.
e. Select a risk owner.

The risk owner is the stakeholder that is responsible for any risks identified as part of the Risk
Assessment.

f. Select an asset owner.
The asset custodian is the stakeholder that owns the related Business Service or
Configuration Item (example: Desktop Management).

3. Depending on the Risk Assessment type you choose, an associated tab or tabs will appear in the
form arrangement. In the tab, associate an object with the Risk Assessment. You must make this
association before you can begin the assessment.

4. Assess the Risk.
a. Select the Begin Assessment link in the Actions list to start the Risk Assessment activities.

The status changes to In Progress, and a Complete Risk Assessment window appears.

This tells you which assessment areas you will need to complete.

b. Depending on which Risk Assessment type you choose, two tabs will appear in the form
arrangement for each set of applicable risk assessment questions: Threat Analysis and Risk
Mitigation. Unanswered questions appear in red; answered questions are green.

c. If you are unable to answer all the assessment questions, you can return to the Overview form
and select Update Percentage Complete. You cannot move forward to the findings activities
until each assessment area is 100%.

d. Select Calculate Risk when all areas are 100%. The left panel shows the Classification,
Unmitigated Risk Score, and Mitigated Risk Score.

5. (Optional) Select the Create Preventative Action or Create Correction Action links from the
Actions list.

6. (Optional) Complete the Findings area of the Risk Assessment. These fields are not visible until all
questions are completed.

◦ Accept the Risk: No additional steps are required.
◦ Avoid the Risk: No additional steps are required.

130

CSM mApp Solutions

CSM mApp Solutions



◦ Transfer the Risk: No additional steps are required.
◦ Mitigate Risk with Controls: A Controls tab appears in the form arrangement.

7. Select the Update Assessment icon in the middle of the Overview form. Modify answers to the
analysis or mitigation questions or other information as appropriate.
Calculate Risk and select Submit to return the record to Active status with any new values.

8. Select the Retire a Risk Assessment link from the Actions list to retire the Risk Assessment.
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Create/Update a Policy
A Policy is the written guidelines your company communicates to its employees about how they execute
security strategy.

To create a Policy:

1. On the CSM Desktop Client or CSM Browser Client toolbar, select New > New ISMS Policy.
2. Provide a description and details.
3. Select the assigned team, owner, and business owner.
4. Select the Next: Assigned link under Status.
5. When the assignees are ready to begin work on the Policy, select the Next: In Progress link under

Status.
6. Select the projected start and end dates.

Follow these steps to continue creating a Policy, or to update an existing Policy:

7. (Optional) Use the ISMS Participants tab in the form arrangement to add additional participants.
8. Link to applicable Controls in the ISMS Controls tab. You can also link a Policy to a Control from

the Control record.
9. Link any other record types that are applicable in their respective tabs.

10. In the Overview tab, provide the following Policy details:
a. Select the document type and provide a document ID.
b. Select the review frequency and provide a document title.
c. Provide a document version and select a publish date.

The publish date is the date the Policy document became effective. Revision Date and
Review Date fields now display with a date that is based on the review frequency. Dashboards
or email notifications can be set up as desired to notify appropriate people of the review date.
There are different options when review is initiated:

i. Select the Reviewed - No Action Needed button to change the review date to the date
that maps to the review frequency. A Journal entry is added identifying the date/time and
user who did the review.

ii. Select the Revise this Policy link under the Actions list. Use this option when a Policy
needs to be modified. A new Policy record is created and the current Policy is put into a
Retired status and is referenced in a tab.

d. Provide a document purpose and document scope.
e. Use the ISMS Policy Documents tab to add any additional information about the Policy.

11. Once all fields are completed, select the Next: Active link under Status.
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Create/Update a Control
Controls are security mechanisms used to ensure adherence to Policies and assist with compliance to
laws, regulations, and other authoritative standards.

To create a Control:

1. On the CSM Desktop Client or CSM Browser Client toolbar, select Tools > Table Management.
2. In the Type drop-down list, select ISMS Control.
3. From the toolbar, select New.
4. Provide a title and description.
5. (Optional) Select a control group and type.
6. In the form arrangement tabs, link ISMS Authority Documents, Citations, and Policies as

appropriate.
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Create Citations and Link to Controls
Citations are the individual records that represent the statement, articles, and laws associated with an
Authority Document. Controls state how the organization will comply with the Citations that require
evidence.

Citations can be created manually or through a .csv import. It is recommended that the import be utilized
for consistency and ease of entry.

To create a Citation manually:

1. On the CSM Desktop Client or CSM Browser Client toolbar, select Tools > Table Management.
2. Select ISMS Citation from the Type drop-down list.
3. From the toolbar, select New.
4. Provide a title and select an existing authority.

Authority ID field will automatically populate.
5. Provide the reference group and reference ID.

These values are determined by the strategy in your organization.
6. For Status, select one of the following options:

a. Evidence Required
i.

◦ Select the Control Implemented check box when at least one Control is linked in
the Controls tab in the form arrangement.

◦ Select the Policy defined check box if the Control has at least one associated
linked Policy.

ii. In the Justification section, select the following:
◦ Legal Requirements
◦ Result of Risk Assessment
◦ Business Process
◦ Contract Requirement

iii. Use the Controls tab to link Controls. Edit the Control itself to link Policies.
b. Evidence Not Required

i. In the Justification section, provide an exclusion justification.
7. (Optional) Provide a description.
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Import ISMS Citations and Controls
Prior to creating Authority Documents, import Citations and Controls via the Data Import Wizard in CSM
Administrator.

Citations can be imported via a .csv file (template provided). If Controls already exist in the system, they
can be automatically linked (1:1) with the associated Citation in the spreadsheet. Additional Controls can
be linked to Citations manually once the Citations are created.

1. In CSM Administrator, select Database > Run a one-off data import (CSV files).
2. In the Import Data Wizard, navigate to the .csv file you wish to import. From the Primary business

object drop-down list, select ISMS Citation.
3. To map records, follow the spreadsheet template.
4. Select the Import into field option and select Authority Document from the drop-down list.

When the Citations are imported, they will be shown in green, red, or black font depending on their state.
Red means that the organization has determined that it will comply and provide evidence of this
compliance through Control(s). Green means that the organization will comply and there is at least one
Control and one Policy linked to the Citation.

Related tasks
Run a One-time Import of Business Object Data
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Create an Authority Document
After an Authority Document is created, Citations with associated Controls and Policies can be uploaded
and linked to the Authority Document.

Authority Documents consist of Citations. Citations are linked to Controls, and Controls are linked to
Policies. External Controls are most likely driven by an Authority Document such as International
Organization for Standardization (ISO), while internal Controls may not have an Authority Document
unless your organization chooses to create one. Policies are business driven (example: How your
organization will handle the Controls and how the Controls will be met).

To create an Authority Document:

1. From the CSM Desktop Client or CSM Browser Client toolbar, select New > New ISMS Authority
Document.

2. Provide a name and description.
3. Select the assigned team and owner.
4. Select a sponsor team and executive sponsor.
5. Provide an originator.
6. Choose an effective date.

The Active Date field is populated automatically when the Authority Document is activated. Retired
date will be populated automatically when the Authority Document is retired.

7. Choose a type.
8. Select the Activate Authority Document link in the Actions list.
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Add Citations and link those to Controls until all Citations have a status of Evidence Not Required or
Evidence Required and display in green.

Related tasks
Import ISMS Citations and Controls
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Conduct an Audit
Conduct an audit for review of compliance related to an industry standard or key Configuration Items.

To conduct an audit:

1. On the CSM Desktop Client or the CSM Browser Client toolbar, select New > New ISMS Audit.
2. Record the following details:

a. Provide a description and details.
b. Select a source and type.
c. Select a priority and level of effort. The priority is displayed in the priority alert bar.

3. Select a lead auditor.
a. Select the Next: Assigned link under Status.
b. In the Audit Participants tab of the form arrangement, define stakeholders for the audit. Use

Table Management to populate this table or select New ISMS Participant.

Note: You need to have at least one participant with a role of Approver to move the
audit to the Approving phase.

4. In the Audit Scope and Schedule section, (in the Overview tab of the form arrangement), provide
audit scope and audit criteria.
For the audit scope, provide information related to the extent and boundaries of the audit (example:
Audit affects all laptops, but focuses on remote employee laptops). The audit criteria will be used as
a reference for analyzing evidence found during the audit.

a. Select the proposed start and end dates. These dates are populated and represented on the
audit calendar.

b. Select the Recurring Audit check box, if appropriate. If selected, choose the following:
◦ Review Frequency
◦ Future Start Date
◦ Future End Date

5. Under Status, select the Next: Approving link.
a. The audit automatically enters the Approving phase. An Approval record displays in the

Approvals tab of the form arrangement. The Approver reviews the audit record details and
validates the dates, scope, and criteria.

b. After the audit is approved, the status changes to Active. During this phase, the Audit
Description, Audit Scope, and Schedule fields are locked.

6. (Optional) On the Security Incidents tab, select the Link button.
The ISMS Security Incident Selector window opens.

a. Select one or more Security Incidents from the list, and then select OK.
7. (Optional) On the Risk Assessments tab, select the Link button.

The ISMS Risk Assessment Selector window opens.
a. Select one or more Risk Assessments from the list, and then select OK.

8. (Optional) On the Controls tab, select the Link button.
The ISMS Control Selector window opens.
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a. Select one or more controls from the list, and then select OK .
9. Select an audit response (example: Corrective Actions Created).

10. Select the actual start and end dates.
11. Provide objective evidence.

This information is related to evidence found during the course of the audit (example: Discovered
that two employees downloaded unauthorized programs on their computers).

12. Provide an overall conclusion (example: Provided two employees with additional security training).
13. Under Status, select the Next: Complete link.

The status changes to Completed. This indicates that the core auditor activities have been
completed. Active compliance activities may still occur.

14. Under Status, select the Next: Closed link to close the audit once all activities are completed.

(Optional) Select the Create Preventative Action or Create Corrective Action link in the Actions list
and complete the form.
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Audit Calendar
The Audit calendar provides a calendar view of proposed start/end dates and actual start/end dates for
audits.

To open the Audit calendar:

1. From a dashboard: Open the Governance, Risk and Compliance dashboard and select the Audit
Calendar. Entries in blue are planned audits and entries in green are completed audits.

2. From the CSM Desktop Client or CSM Browser Client: Select Tools > Calendars > Calendar
Manager > Audit Calendar.
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Create Compliance Records
Use Compliance Records in conjunction with other ISMS Business Objects to track proactive actions or
ensure compliance with security policies and Citations.

Compliance Records are tools to align company security programs with industry standards. Downloading
Cherwell ISMS is not a requirement for security industry standards and does not automatically make an
organization compliant with security standards

Users can:

• Create a Corrective Action

• Create a Preventative Action
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Create a Corrective or Preventative Action
Create a Corrective or Preventative Action manually or from a Security Event, Security Incident, Audit, or
Risk Assessment.

To create a Corrective or Preventative Action:

1. Select the Create a Corrective Action or Create a Preventative Action link from the Actions list
of an active Security Event, Audit, or Risk Assessment form.

2. Provide a description and details.
Examples include: A noncompliance was discovered while conducting a Risk Assessment on the
Sales team's laptops; and, additional security training should be provided to the Sales team, and the
noncompliance should be removed from all laptops.

3. The Source and Type fields automatically populate.
4. Select the asset and priority.

The asset is the Configuration Item that is the focus of the action (optional).
5. Select a projected start and end date.
6. Select the assigned team and owner.

The Assigned To options are driven by the Assigned Team selection.
7. Select the business owned by team and business owner.

The Business Owner options are driven by the Business Owned By Team selection.

After owners have been assigned, select the Next: Assigned link (under Status) to move the Corrective
or Preventative Action to the Assigned phase.
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Work a Corrective or Preventative Action
After creating a Corrective or Preventative Action, move it to In Progress to start work on it.

To work a Corrective or Preventative Action:

1. Under Status, select the Next: In Progress link to move it to the In Progress phase.
2. Provide root cause and action plan information.
3. Select a completion date.
4. Under Status, select the Next Status: Complete link to close the Corrective or Preventative Action

record.
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Network Event
Create a Network Event to track and manage network-specific events.

Network Events will generally be opened via automation but can also be opened manually.

To manually create a Network Event:

1. CSM Desktop Client or Browser Client toolbar, select New > New Event > New Event - Network.
2. Provide a name and details of the event (optional).
3. (Optional) Select an event type and service.

The type displays on the top of the form.
4. Select a priority and event severity.
5. Select a reported date time and who reported the event (optional).
6. Select a source and external source ID (optional).
7. (Optional) Select the assigned team and owner (Assigned to field). You can also select the Assign

to Me link in the Actions list.
8. (Optional) Add notes to the Response Notes field.

These fields are audited; Journal entries track modifications.
9. (Optional) Select a cause code and add resolution details.

10. (Optional) Initiate other Actions using the appropriate links in the Actions list, in response to a new
Network Event.
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Cherwell ISMS Workflow Diagrams
These workflows demonstrate the various features offered by the Cherwell ISMS mApp® Solution.

ISMS Audit
An audit is a scheduled review of compliance related to an industry standard, such as ISO 20071:2013 or
key Configuration Items (infrastructure, supporting services, and/or collateral). Audits can be scheduled
on a recurring basis and Actions such as Preventative and Corrective can be associated with audit
activities.

1 Required fields include: Description, Operating Unit, Source, Type, Priority, Level of Effort.

2 When an Approval is Denied or Approved, the Approval Block ID is cleared. This removes the
Approval tab so Approval History is not tracked.

3 This is an Enhancement Request and does not currently exist in the functionality.

Security Event
Security Events are used to track and manage security-specific events using an independent process and
lifecycle. Security Events provide the means for analysts to quickly analyze possible security threats and
take necessary action. The following graphic shows a Security Event workflow.
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1 These fields may be automatically completed by integration or when opened from Incidents or
Network Events.

2 Complete the Analysis and Event Actions information ongoing throughout the analysis activities.

3 A Security Event can be closed or remain open independent of the state of the Security Incident.

Security Incident
If a Security Event results in a breach or loss of any type, the event can be escalated to a Security
Incident. ISMS Security Incidents are specific to security breaches, and differ from the CSM Incident
Business Object. Security Incidents follow the NIST guidelines for Security Incident handling and allow
strict privacy throughout the process to recovery. The following graphic shows a Security Incident
workflow.
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1

You must always open a Security Incident through a Security Event.

The Security Incident Detection and Analysis fields are copied from the Security Event. The
Containment, Eradication and Recovery areas of the Security Incident are all displayed on the
Overview tab.

To view the Post Review form, select the Post Review link under Stage.

2 Security Incidents can be Resolved without a completed Post Review.

Policy
Policies are used to create policy documents and track related Controls. The following graphic shows a
Policy workflow.
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1 Review Date field modified.

2 Current information is copied to the new record.

Authorization Document
Use an Authorization Document to define a set of Controls (individual requirements for specific areas of
security) that align to industry standards, such as ISO 20071:2013. The following graphic shows an
Authorization Document workflow.
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Compliance Corrective and Preventative Actions
A Compliance Corrective Action is used to record and track reactive actions taken to ensure compliance
of a policy or Control. You can create a Corrective Action directly from a Security Event or audit. A
Compliance Preventative Action is used to record and track proactive actions taken to ensure compliance
of a policy or Control. You can create a Preventative Action directly from a Security Event or audit. The
following graphic shows a Corrective/Preventative Action workflow:

ISMS Risk Assessment
A Risk Assessment is completed by answering a set of questions that are weighted using a classification
scale driven by Table Management. The following graphic shows a Risk Assessment record workflow:
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Related concepts
Create a Security Event
Related tasks
Conduct an Audit
Create a Security Incident
Create/Update a Policy
Create an Authority Document
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ISMS mApp Solution Items
The Items table provides a list of items included when applying the mApp Solution and the typical merge
action.

These are the items included in this mApp Solution:

Item
Category Item

Typical
Merge
Action

Business
Objects

Config - Supporting Service, Event Operation, EventOpsSecurityLinksCI,
Exemption term, Facilities Building, ISMS Audit, ISMS Authority Document,
ISMS Business Impact Classes, ISMS Category, ISMS Citation, ISMS
Compliance, ISMS Control, ISMS Control Group, ISMS Control Source,
ISMS Data Classes, ISMS Data Classification, ISMS Data Classification
Questions, ISMS Exemption, ISMS Groups, ISMS Operating Unit, ISMS
Participant, ISMS Pending or Withdraw Cause, ISMS Policy, ISMS Priority
Matrix, ISMS RACI Definition, ISMS Risk Assessment, ISMS Risk
Assessment Type, ISMS Risk Mitigation, ISMS Risk Mitigation Questions,
ISMS Risk Response, ISMS Roles, ISMS Root Cause Codes, ISMS Root
Cause Deficiency Category, ISMS Root Cause Factors, ISMS Root Cause
Types, ISMS Security Cause Code, ISMS Security Incident, ISMS Source,
ISMS Specification Lookup, ISMS Status, ISMS Status List, ISMS Status
Phases, ISMS Support Service Format, ISMS Threat Analysis, ISMS Threat
Analysis Classes, ISMS Threat Analysis Questions, ISMS Threat Analysis
Type, ISMS Threat Likelihood Classes, ISMS Type, ISMSAuditLinksControl,
ISMSAuditLinkstoCI, ISMSAuthortyDocument_to_CommonControl,
ISMSCitationlinkstoControl, ISMSComplianceLinksCI,
ISMSComplianceLinksControl, ISMSRiskAssessmentLinksAgreements,
ISMSRiskAssessmentLinksCI, ISMSRiskAssessmentLinksService,
ISMSRiskAssessmentLinksSupplier, ISMSRiskAssessmentsLinksBuilding,
ISMSRiskAssessmentsLinksSite, ISMSRiskEventLinksCI, Journal - Security
Event, Network Event, Network Event Source, Network Event Status,
Network Event Type, Recovery Objective, Security Event Status, Security
Event Type, Security Runbook, SecurityEventLinksISMSAssessmentCI,
SecurityEventLinksISMSRiskAssessmentSS,
SecurityIncidentLinksISMSRiskAssessment,
SecurityIncidentLinksISMSRiskAssessmentSS, Site, State/Province/
Territory, Supervisory Authority

Import

Agreement, Change Request, Configuration Item, Customer Journal,
Supplier, Task

Don't
Change

Change Request, Incident, Service Merge

Secret Question Overwrite

Stored
Values

CI Rec Link, CI Risk Assessment, ISMS Authority Document Current, ISMS
Compliance RecID, Linked False, Linked True, Network Event Ops ID,
Security Operations Tab Links, Selected Compliance Policy, SS Risk
Assessment, Temp Affected User, Temp Control, Temp Grant Access

Import
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Teams Security, Security Incident Import

Themes ISMS Dashboard, ISMS Theme Import

Widgets

Active Assessments, Active Authority Document Count, Active Events by
Risk, Active Events by SS, Active Events by Support Service, Active Evnets
by CI, Active Security Incident List, Active Security Incidents, All Active
Security Incidents, Audits By Status, Audits Starting in the Next Week,
Authority Document Citations, Authority Document Filter, Corrective Actions
by Source, ISC Sans, ISMS Main Filer, missing justification deatils, My
Pending Approvals - Number, My Security Events, My Security Incidents,
Open Corrective Actions, Open Network Events, Open Network Events -
Total, Open Preventative Actions, Overdue Audit, Policies missing
relationships, Policy by Stage, Preventative Actions by Source, Risk
Assessment by Stage, Risk Assessment Mitigation Score, Security Events
by Priority, Security Events Owned by Me, Security Incident by Level,
Security Twitter, Todays Security Events, US-Cert

Import

Discussions, Knowledge Article Search, Knowledge Articles with Like
Counts, Known Errors, My Active Discussions Count, My Devices Count,
My Open Incidents, My Open Incidents and Requests, My Open Incidents
Count, My Open Requests, My Open Requests Count, My Recently Closed
Incidents and Requests, Problems with a Work Around, Problems with no
Work Around, Subscribed, Top Issues Count

Overwrite
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One-Step™
Actions

Add Activity, Add Affected User, Add Role, Add SOP to Current Control,
Add Staff Responsibility, Add Supervisory Authority, Add user, Advance
Page Forward, Advance Status, Advance Status, Approval Accepted,
Approval Denied, Approve, Assign Asset Custodian Team, Assign Asset
Owner, Assign Lead Auditor Team, Assign Location, Assign Owner, Assign
Owner Team, Assign Risk Owner, Assign Risk Owner Team, Assign
Source, Assign to, Assign to a Team, Assign to an Owner, Assign to Any
Asset Custodian, Assign to Any Auditor, Assign to ANY Business Owner,
Assign to ANY Individual, Assign to ANY Individual for Owner, Assign to
ANY Individual for Sponsor, Assign to ANY Owner, Assign to ANY
Reviewer, Assign to Any Risk Owner, Assign to Business Owner, Assign to
BusinessTeam, Assign to Individual, Assign to Individual for Sponsor,
Assign to Lead Auditor, Assign to Owner, Assign to Policy Author, Assign to
Reviewer, Assign to Team, Assign to Team and Owner, Assign to Team for
Owner, Assign to Team for Sponsor, Assign Type, Attach SOP, Begin
Assessment, Calculate Abbr, Calculate Risk, Check for Related Policy,
Check Values, Close Security Event, Complete Specification Definition,
Compliance Records Open, Copy of Complete Specification Definition,
Copy of Iterate Questions Backward, Copy of Iterate Questions Forward,
Copy Policy Control Group Relationship to Join, Create a Boundary
Definition, Create a Control, Create a Control Audit, Create a Corrective
Action, Create a new Audit, Create a Preventative Action, Create a
Preventative Record, Create a Related Record, Create a Risk Assessment,
Create a Root Cause, Create a Security Event from an RSS Feed, Create
All Controls, Create Audit, Create Change, Create Change Request, Create
Compliance, Create Compliance Action, Create Compliance Policy, Create
Compliance Record, Create Corrective Action, Create Event from Twitter,
Create Gap Supporting Records, Create Incident, Create IT Incident,
Create Preventative Action, Create Related Compliance Records, Create
Related Compliance Records (Backup), Create Related Records, Create
Revise Policy, Create Security Event, Create Security Event from Portal,
Create Security Incident, Create Supporting Records-old, Create Task,
Create Task for supervisory authority., Create Threat Supporting Questions,
Customer Follow-up E-mail, Delete Denied Approval Rec ID, Denied,
Denied Review, Email Asset Owner, Email Owned by - Network Event,
Email Owner, Email Reported by - Network Event, Email Reported by -
Security Event, Email Security Incident, Email Security Incident Team,
Follow-up Email to Asset Custodian, Follow-up Email to Owner, Follow-up
Email to Risk Owner, Goto Service, Grant Access to User, Iterate Questions
Backward, Iterate Questions Forward, Link Citation to Control, Link
Controls, Link Primary CI Item, Link to an Audit, Memo Style - Security
Incident with Events, Move Back Control Pages, New Security Event, Next
Stage In Incident, Next Status, Notify Granted Access Users, Notify Owner,
Notify Owner of Approval, Notify Owner of Assignment, Notify Owner of
Denial, Notify Owner of Risk Assessment, Notify Owner of Security Event,
Notify Participant of Audit, Notify Risk Owner, Notify Team of Security
Event, Owner Follow-up E-mail, Populate Control Questions, Previous
Stage In Incident, Print Boundary Def, Recalculate, Recalculate All Scores,
Recalculate Percent Complete, Recurring Audit, Re-Enable Editing,
Remove from Pending, Remove Record Lock - Approved, Report
Anonymously, Reset All, Retire Risk Assessment, Review and Create
Journal, Reviewer Follow-up E-mail, Risk Analysis Completion, Risk
Analysis Completion (Data Classification), Risk Analysis Completion
(Mitigated Risk Score), Risk Analysis Completion (Risk Mitigation), Risk
Analysis Completion (Threat Analysis), Risk Analysis Completion Next
Steps, Risk Review Denied, Save n Back to Home, Save Selected Controls
01-23, Save Selected Controls 24-45, Save Selected Controls_SAVE,
Security Operations - Infosec-Tab, Security Operations - Twitter Tab, Select
and Link Policy or Unlink Policy, Select CI, Select Owner, Select Requestor,
Select Supporting Service, Set Alt Status, Set Next Question Number for
Risk Midigation, Set Next Question Number for Security Class, Set Next
Question Number for Threat Analysis, Set Next Status, Set Pending, Set
Record Type, Set Risk Assessment to Withdrawn, Set Risk to Active, Set
Status, Set Status to Active, Set Status to Closed, Set Status to Definition,
Set Status to Post Assessment, Set Status to Resolved, Set Status to
Retired, Set the Next Status, Set to Active, Set to In Progress, Set to
Pending, Setup Specification Definition, Setup Specification Definition for
All, Show Dates, Show Timeline, Show Timeline, Submit and Return Home,
Take Ownership, Unlink Primary CI Item, update, Update Business Object,
Update Citation Links, Update Citations, Update Controls, Update Links,
Update Related Controls to set Related Policy Exists Flag, Update Security
Classification, Update Status, Update Status Order, User access list,
Validate CONTROL Status, View Deails, View Timeline

Import
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Expressions

Asset owner, Asset owner ID, Business Impact Answer Percentage,
Business Owner, Business Owner Team, Calc End Dates, Calc Start Dates,
Calculate Answer Value, Calculate Answer Value, Calculate Answer Value,
Calculated Risk Midigation Score, Calculated Total Business Impact
Question Value, Calculated Total Risk Midigation Answer Value, Calculated
Total Risk Midigation Question Value, Calculated Total Security Class
Question Value, Calculated Total Threat Analysis Answer Value, Calculated
Total Threat Analysis Question Value, Calculated Total Threat Likelihood
Question Value, Control Defined, Control Display of Completetion Button,
Control ID, Controls Requiring Action is False, Count of Audit Approvers,
Count of Closed Compliance Actions, Create Supporting Records Run if -
Data Class, Create Supporting Records Run if - Goto Action, Create
Supporting Records Run if - Risk Mitigation, Create Supporting Records
Run if - Threat Analysis, Current User RecID, Data Classification Answer
Percentage, Data Protection Officer, Data Protection Officer ID, Determine
the Security Class, Evaluate which Assessment is Active, Existing
Specifications, Finance Asset Value, Finance High, Finance Low, Finance
Med, Future End Date Calculation, Future Start Date Calculation, Hyperlink
to Approval, Increment Control Question, Iterate Backwards Run if - Data
Class, Iterate Backwards Run if - Risk Mitigation, Iterate Backwards Run if -
Threat Analysis, Legal and Regulatory Asset Value, Legal High, Legal Low,
Legal Med, Lessons Leared Validation Date, Lock Active Status - CA/PA,
Lock Active Status - Policy, Lock Active Status - Policy, Lock Closed Status,
Lock Common Fields, Lock Field, Lock Fields, Lock Record, Market Cost
Asset Value, Market Cost High, Market Cost Low, Market Cost Med, New-
Control Display of Completetion Button, New-Evaluate which Assessment is
Active, No Change - Set Review Date, No Change - Set Review Date,
Number Of Controls, Old_Set Review Dates, Older than 30days, One Week
From Today, Overall Risk Calculation, Percent Complete Data Class,
Percent Complete Risk Mitigation, Percent Complete Threat Analysis,
Policy Defined, Policy ID Counter, Policy Linked, Policy Publish Prev 2
Weeks, Populate Answer Value, Populate Answer Value, Populate Answer
Value, Primary Control Count, Primary Control Score, Required Fields,
Required for both, Required For Final Corrective, Required For Final
Preventive, Return ISMS Group from Type, Secondary Control Count,
Secondary Control Score, Select All Choice 01, Set Closed Date, Set
Review Date, Set Review Date, Show Fields Locked, Simular Risk
Assessments, Status Read Only, Status Read-Only, Threat Analysis
Answer Percentage, Threat Likelihood Answer Percentage, Total Data
Classification Questions, Total Risk Mitigation Questions, Total Threat
Questions, Two weeks out, Unlock Record, Unmitigated Risk Percentage,
Validate if Run - Data Classification, Validate if Run - Risk Mitigation,
Validate if Run - Threat Analysis, Validate Policy Fields before Active,
Validate Status Phases

Import

Automation
Processes

Create Link to Controls Upon Citation Imports, mApp Factory - Copy Group
Control Relationship to Join, mApp Factory - Notification of Assignment,
mApp Factory - Notify Asset Owner on Risk Assessment, mApp Factory -
Notify Audit Participant, mApp Factory - Notify Granted Access Users,
mApp Factory - Notify Owned By on Assignment, mApp Factory - Notify
Owned By on Risk, mApp Factory - Notify Owned By on Security Incident,
mApp Factory - Notify Owner on Assignment, mApp Factory - Notify Risk
Owner on Risk Assessment, mApp Factory - Notify Security Incident Team,
mApp Factory - Notify Team on Assignment or High Priority

Import
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Dashboards Compliance, ISMS Portal Home, ISMS Portal Knowledge, ISMS Portal My
Items, Operations, Posture, Statement-of-Applicability Import

Searches

Acrive Authority Document, Active Audits, Active Audits Starting in the Next
Week, Active Audits with Major NonCompliances, Active Authority
Documents propt, Active Boundary Definitions, Active Events by CI Risks,
Active Risk Assessments, Active Security Incidents 2, Active Security
Incidents by Type, Active Specification Controls, Active Support Service
Risk, All Audits, All Audits - No None Preventative Actions, All Audits with
Major NonCompliances, All Authority Documents, All Citations, All
Compliance Records, All Corrective Actions, All Events, All Exclusion
Controls, All Inclusion Controls, All Open Compliance Records, All
Participants, All Policies, All Preventative Actions, All Risk Assessments, All
Security Incidents, Audit Corrective Actions, Audit Preventative Actions,
Audits, Audits Awaiting Approval, Audits Completed, Audits Ending in the
Next Week, Audits with Open Resolution Actions, Confidential, Critical
Mitigation Risk, Current Authority Document, High Mitigated Risk
Assessments, High Mitigation, In Progress Risk Assessments, Internal Use,
Low Risk Mitigation, Medium Mitigation Risk, Missing Justification Details,
Missing Policy Relationship, My Active Audits, My Security Incidents, Open
Corrective Actions, Open Events for Today, Open Network Events, Open
Network Events, Open Preventative Actions, Open Security Events, Open
Security Events by CI Risk, Open Security Events by priority, Overdue
Audits, Policies missing relationships, Print Boundary Def, Public Data,
Report Active Specification Controls, Restricted Data, Risk Assessments
Owned by Me, Security Events Owned by Me, Security Incident by Priority,
Security Incident Corrective Actions, Security Incidents Older than 30days,
Two weeks out, Very Low Risk Mitigation

Import

Counters

Event-Ops Network Event ID, Event-Ops Security Event ID, ISMS Audit ID,
ISMS Boundary ID, ISMS CAPA ID, ISMS Citation ID, ISMS Compliance ID,
ISMS Exemption, ISMS Policy ID, ISMS Risk Assessment, ISMS Security
Incident ID

Import

Supplier ID Overwrite

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related concepts
Apply a mApp Solution
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Project & Portfolio Management mApp Solution 1.6
The Cherwell PPM mApp® Solution allows executives, Portfolio, Program, Project, and Demand
Managers to review the submission of Demands, manage staffing and tasking for Projects, and track
Projects to completion.

Platform Version Requirements: Tested on CSM 10.0.x — 10.2.0.

Content Version Requirements: Tested on CSM 10.0.x — 10.2.0; this mApp Solution may or may not be
compatible on content versions earlier than CSM 9.6.0, but as with all mApp Solutions, be sure to test it
on your customized system.

Prerequisites: If you import from Microsoft Project or Microsoft Excel (.csv files), full user names cannot
contain commas or special characters. For example, a full user name listed as "Smith, John" will not be
allowed in the Resource field of MS Project. MS Excel (.csv) will read the comma as a delimiter and fail to
process imports correctly.

Available languages: English.

Overview
Project & Portfolio Management (PPM) is the continuous process of selecting and managing the optimum
set of project-oriented initiatives that deliver the maximum in business value or return on investment. It is
a dynamic decision-making process, enabling management to reach consensus on the best use of
resources to focus on projects that are achievable and strategically aligned with their business goals and
objectives. (Source: PMI)

The Ideas are evaluated by a Demand Manager for acceptance as a Demand. Once a Demand is
reviewed and accepted, it becomes a Project. The Project will be part of a Portfolio and potentially a
Program and can also be linked to Strategic Objectives.
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Note: For content versions earlier than those listed above, please review the documentation and
carefully test against a copy of the current installation to determine fit for your environment.
Additional manual work may be required based on current system configurations.

Apply the mApp Solution
Follow these steps to download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.
The contents of the .zip file includes the following:

◦ PPM Foundations 1.6.mApp file

◦ MS Project Template:
◦ MS Project Template example.mpp file

◦ MS Project Template example.xml file

◦ MS Excel Template:
◦ PPM Excel Template for CSV Project Task Import.csv file

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

4. On the How automatic should the merge process be? screen of the Apply mApp Wizard, choose
either Ask me about every decision or Make reasonable decisions, but ask me if unsure.
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Note: In certain areas, functionality is not guaranteed unless you use the CSM Desktop Client.

For a list of items included in the mApp Solution, see PPM mApp Solution Items.

Revision History

mApp Version Platform Version
Requirements

Content Version
Requirements Prerequisites Version/Release Notes

1.0 9.2.1, 9.3.0, 9.3.2,
9.4.0

8.3.2, 9.1.0, 9.2.1
globalized, 9.2.1
non-globalized,
9.3.0, 9.3.2, 9.4.0

Known Issue: When
the mApp Solution is
created on a version
earlier than 9.4.0 or
is installed on a 9.4.0
system, the widgets
are disassociated
with the dashboards
or the dashboards
cannot be edited
(anticipated fix in
version 9.5.0).

1.1 9.3.0, 9.3.2, 9.4.0 9.3.0, 9.3.2, 9.4.0 None. Contains several bug
fixes.

1.2 9.6.1 9.5.3 and 9.6.1

If you import from
Microsoft Project or
Microsoft Excel (.csv
files), full user names
cannot contain
commas or special
characters.

Contains bug fixes
specific to 9.6.0 content.

1.3 9.6.x - 9.7.0 9.5.3 and 9.6.x -
9.7.0

If you import from
Microsoft Project or
Microsoft Excel (.csv
files), full user names
cannot contain
commas or special
characters.

1.5 10.0.x

10.0.x; PPM 1.5 may
or may not be
compatible on
content versions
earlier than 9.6.0, but
as with all mApp
Solutions, be sure to
test it on your
customized system.

If you import from
Microsoft Project or
Microsoft Excel (.csv
files), full user names
cannot contain
commas or special
characters.

Contains UI update.
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mApp Version Platform Version
Requirements

Content Version
Requirements Prerequisites Version/Release Notes

1.6 10.0.x — 10.2.0

10.0.x — 10.2.0;
PPM 1.5 may or may
not be compatible on
content versions
earlier than 9.6.0, but
as with all mApp
Solutions, be sure to
test it on your
customized system.

If you import from
Microsoft Project or
Microsoft Excel (.csv
files), full user names
cannot contain
commas or special
characters.

Contains bug fix for
missed Item in PPM 1.5
mApp Solution creation.

Related concepts
About mApp Solutions
Apply a mApp Solution
Create/Edit a Field
Publish a Blueprint
Open the mApp Editor
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PPM Key Terms
Key terms for understanding PPM.

Portfolio
A collection of projects or programs or other work grouped together to
facilitate effective management of work to meet strategic business
objectives.

Project Portfolio Management

The centralized management of one or more portfolios. This involves
identifying, prioritizing, authorizing, managing, and controlling projects,
programs, and other related work, to achieve specific strategic business
objectives.

Strategic Objective
Organizational goals that help to convert a mission statement from a
broad vision into more specific plans and projects. They set the major
benchmarks for success.

Demand
Demand management is the process an organization puts in place to
internally collect new ideas, projects, and needs during the creation of a
portfolio.

Program

A program is a group of related projects managed in a coordinated
manner to obtain benefits not available from managing them individually.
Program management is the application of knowledge, skills, tools and
techniques to meet program requirements.

Stakeholder Those who can affect or are affected by a new demand and are key
success factors for the management of project portfolios.

T-shirt Size A way of making rough estimates for projects that is relative and less
prone to errors than estimation of effort, in real days.

Demand Scoring
A set of weighted criteria and corresponding key indicators to measure
and score specific (and potential) components for comparison and
prioritization purposes.

Source: PMI
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Configure Cherwell Project & Portfolio
Management

Configure PPM to set up Roles, Resources, and other key areas.

Complete the following procedures to configure Cherwell PPM:

• Create PPM Roles

• Create PPM Resources

• Create PPM Areas

• Create PPM Strategic Objectives

• Create PPM Programs

• Create PPM Portfolios

• Create PPM Stakeholders

• Create PPM Scheduled Items
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Items to Consider Prior to Configuring Cherwell
Project & Portfolio Management

Important considerations prior to configuring Cherwell PPM.

Note: This functionality is only available after you apply the mApp Solution.

You will need to identify and document areas such as Roles, Resources, Areas, Stakeholders, Strategic
Objectives, Portfolios, and Programs.

• Roles and Resources are used for time reporting, availability, and Project Tasks.

• Areas and Stakeholders are used for Demands.

• Foundations are Strategic Objective, Portfolio, and Program.

1. Roles: These are used in conjunction with Resources and help provide key availability information
for Demand and Project Management planning activities. Roles can be identified for different areas
(example: Project, HR, Facilities, Security).

2. Resource: Work Week hours and Operational Percentage are very important. When you look at
graphs showing Role or Resource availability, the Work Week hours and Operational Percentage
help determine that availability.

3. Area: Area is used throughout Demands and Project Management to identify the associated
business area (example: HR, IT, Facilities).

4. Stakeholders: These are a key part of the approval process in Demands. Stakeholders are
populated in the Stakeholder table and can be designated as Approvers and Executive Approvers.
Stakeholders are associated with a Demand based on the Demand Area.

5. Strategic Objectives: These are documented executive-level business objectives that should help
guide the approved initiatives/projects. They are referenced in Portfolios, Programs, Demands, and
Projects as appropriate.

6. Portfolios: Portfolios are collections of Projects, Programs, or other work grouped together to
facilitate effective management of work to meet strategic business objectives.

7. Programs: Programs are groups of related projects managed in a coordinated manner to obtain
benefits not available from managing them individually. Program management is the application of
knowledge, skills, tools and techniques to meet program requirements.

Globalization Considerations

Use the information below to prepare the environment to be localized.

The following tables should be globalized in Cherwell PPM:

• Operational Task Status

• Operational Task Type
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• PPM Area

• PPM Focus Area

• PPM Predecessory Type

• PPM Scope

• PPM Health Type

• PPM Status Group

The following tables are dependent on PPM Status Group and PPM Health Type being globalized:

• PPM Status

• PPM Type

The following PPM Status Fields should have foreign keys enabled:

• PPM Group

• Next Status

• Alt 1 Status

• Alt 2 Status

The following PPM Type Fields should have foreign keys enabled:

• Group Name

• Health Type
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Create PPM Security Groups
Security Groups establish the rights for users and Roles.

Note: This functionality is only available after you apply the mApp Solution.

When creating a Security Group, in the Rights tab, select the One-Step Category. Select the One-Steps
can access values for fields for which the security group doesn't have rights? parameter.

You must include this parameter in any Security Group that will be importing and updating Projects from
MS Excel (.csv files). This parameter allows the staging table to be updated, which is a key action in the
Update Project from Excel One-Step™ Action. Updates will not apply without this right.

Related concepts
Create a Security Group
One-Step Security Rights
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Create PPM Roles
Create Roles to use for high-level Resource planning.

Note: This functionality is only available after you apply the mApp Solution.

Each Resource is assigned a PPM Role. Some Roles are included in Cherwell PPM. You can modify,
delete, or add new Roles as needed.

The following Roles are included:

• Architect - Infrastructure

• Asset Manager

• Business Engagement Manager

• DBA - SQL

• DBA - Unix

• Developer

• Facilities

• HR

• Legal

• Network Administrator

• Process Engineer

• Procurement

• Project Manager

• Security Analyst

• Sr. Developer

• Technical Writer

• Tester/UAT

• Trainer - Content Developer

• Trainer - Delivery

• UI/UX Designer

• Web Specialist

To create a new Role:

1. In the CSM Desktop Client or CSM Browser Client, select Tools > Table Management.
2. Select Role from the Type drop-down list, then select the New button.
3. Provide the Role name and select Area(s) the Role may be associated with.
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The PPM functionality for Resource and Role availability and Project Task assignment looks for
Resources where the associated Role and the Project Area checked.

If you choose to batch import Resources, Role creation is automatic.

Related tasks
Import PPM Resources
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Create PPM Scheduled Items
Create Scheduled Items to automatically run defined actions.

Note: This functionality is only available after you apply the mApp Solution.

Create the following PPM Scheduled Items:

• Weekly Timesheet Reports

• Delete Unused Timesheets

• Update Resource Time Bookings

• Resource Time Cleanup

Weekly Timesheet Reports
To create weekly timesheet reports:

1. Open the Scheduled Items Manager and select the Add button.

2. On the General page, enter the name and description.

3. On the Schedule page, select the Recurring option.

4. Set Scheduled Time and Recurrence.
We recommend running this Scheduled Item during the earliest time slot available at the beginning
of the work week.

5. On the Action page, select One-Step from the Action drop-down list.

6. Next to the One-Step drop-down list, select the ellipsis to open the One-Step™ Action Manager.

7. Select PPM Resource from the Association drop-down list.

8. Select the Create Weekly Timesheets One-Step Action and select OK.

9. (Optional) Configure any necessary settings on the Error Handling page and select Save.

Delete Unused Timesheets
To delete unused timesheets:

1. Follow Steps 1 - 3 above.

2. Set Scheduled Time and Recurrence.
We recommend running this Scheduled Item monthly

3. On the Action page, select One-Step under the Action drop-down list.

4. Next to the One-Step drop-down list, select the ellipsis to open the One-Step Action Manager.

5. Select PPM Timesheet from the Association drop-down list.

167

CSM mApp Solutions

CSM mApp Solutions



6. Select the Blueprint folder under the One-Step Actions file tree.

7. Select the Delete Old Timesheets One-Step Action and select OK.

8. (Optional) Configure any necessary settings on the Error Handling page and select Save.

Update Resource Time Bookings
To update resource time bookings:

1. Follow Steps 1 - 3 under Weekly Timesheet Reports above.

2. Set Scheduled Time and Recurrence.
We recommend running this Scheduled Item as frequently as needed or every hour.

3. On the Action page, select One-Step under the Action drop-down list.

4. Next to the One-Step drop-down list, select the ellipsis to open the One-Step Action Manager.

5. Select PPM Resource Time from the Association drop-down list.

6. Select the Blueprint folder under the One-Step Actions file tree.

7. Select the Update Resource Time Bookings One-Step Action and select OK.

8. (Optional) Configure any necessary settings on the Error Handling page and select Save.

Resource Time Cleanup
To perform resource time cleanup:

1. Follow Steps 1 - 3 under Weekly Timesheet Reports above.

2. Set Scheduled Time and Recurrence.
We recommend running this Scheduled Item weekly or bi-weekly.

3. On the Action page, select One-Step under the Action drop-down list.

4. Next to the One-Step drop-down list, select the ellipsis to open the One-Step Action Manager.

5. Select PPM Resource Time from the Association drop-down list.

6. Select the Blueprint folder under the One-Step Actions file tree

7. Select the Resource Time Cleanup One-Step Action.

8. (Optional) Configure any necessary settings on the Error Handling page and select Save.

Related concepts
Open the Scheduled Items Manager
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Create PPM Resources
PPM Resource is a major Business Object that tracks Resources available to be assigned to Project
Tasks and their associated information to provide availability and allocated time views for Demand and
Project Managers.

Note: This functionality is only available after you apply the mApp Solution.

A Resource record is required for each person who will be assigned Project Tasks. All PPM Resources
must be in your User Info Table, but not all users have to be a PPM Resource. The Name field within PPM
Resource is validated to the Full Name field in User Info.

You can also import a batch of Resources.

To create an individual resource:

1. From the CSM Desktop Client or CSM Browser Client menu bar, select New > New PPM
Resource.

2. Select the full name and department from the drop-down lists.
3. Select a role and employment type from the drop-down lists.
4. (Optional) Enter any skills.
5. Enter the standard work week hours.
6. Operational Percent: Enter a number from 0 to 100 to indicate the percent of work week hours

spent on day-to-day operational and administrative (non-project) tasks. The Available Project Hours
Field automatically calculates using the Operational Percent and Work Week Hours values.
For example, with 40 Work Week Hours and an Operational Percent of 10, the Resource will have
36 Available Project Hours.

Work Week Hours and Operational Percent plus PTO numbers are used during the creation of
Resource Time records.

7. (Optional) Enter an hourly cost for the resource.
8. Select Save, and then select the Create Resource Time Records link (under Actions). This

creates a time record for each day of the rest of the calendar year and the following year, which will
be used to determine availability at the role and resource level.

Important:
A One-Step™ Action (Create Weekly Timesheets) is provided in the solution to create a weekly
Timesheet for each Resource in the Resource table. This One-Step Action should be set up as a
scheduled process as part of the initial configuration activities.

Related tasks
Import PPM Resources
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Import PPM Resources
Import a batch of Resources instead of creating them individually.

Note: This functionality is only available after you apply the mApp Solution.

At initial set up of Cherwell PPM, most Administrators will choose to import a batch of Resources. An
Automation Process will create daily resource time records through the end of the current calendar year
and next year.

Important:
Importing a batch of Resources in bulk requires significant processor speed and memory to run
concurrent Automation Processes and cache queued automation requests (when a Resource is
added, an Automation Process creates time summary records for each remaining day in the
current calendar year and all of the following calendar year). Run this bulk import using server
resources. If Cherwell Services are running on a laptop instead of a server, we recommend adding
Resources one at a time and waiting three minutes between each addition to allow the automation
processes to complete.

In benchmark testing, importing 300 Resources took 4.5 hours.

To import resources:

1. Enter your Resource information in a CSV that will be imported.
2. Open CSM Administrator.
3. Select the Database option under Categories.
4. Select the Run a one-off data import (CSV files) link.
5. Follow the prompts in the Import Data Wizard.
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Create PPM Areas
Use an Area appended by a sequential number to create project identification numbers.

Note: This functionality is only available after you apply the mApp Solution.

The following PPM Areas are included:

• IT

• Facilities

• HR

• Finance

• Sales

To add a new PPM Area:

1. In the CSM Desktop Client or CSM Browser Client, select Tools > Table Management.
2. Select PPM Area from the Type drop-down list, and then select the New button.
3. Provide the area name and save the record.
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Create PPM Strategic Objectives
Strategic Objectives are generally corporate-level, senior leadership-driven initiatives used to group
Portfolios, Programs, and Projects.

Note: This functionality is only available after you apply the mApp Solution.

While Strategic Objectives have a simple workflow with statuses of New, Review, Active, and Closed,
there is no formal approval process. The statuses let you decide how to manage review and
implementation of the Strategic Objectives. Once a Strategic Objective is Closed, it will no longer appear
as an option in Portfolio, Program, and Demand creation.

To create a new Strategic Objective:

1. From the CSM Desktop Client or CSM Browser Client menu bar, select New > New PPM Strategic
Objective.

2. Provide an Objective and select a Focus Area from the drop-down list.
3. (Optional) Provide a Driver (example: Compliance) and Weighting (example: 10%).
4. (Optional) Add a Description.
5. (Optional) Choose a Target Date from the calendar selector.

When a Strategic Objective is in the active phase, you can use the tabs to track the child Programs and
Portfolios.
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Create PPM Portfolios
A Portfolio is a collection of projects or programs or other work grouped together to facilitate effective
management of work to meet strategic business objectives.

Note: This functionality is only available after you apply the mApp Solution.

While Portfolios have a simple workflow with statuses of New, Assessing, Active, Closed, and Review,
there is no formal approval process. The statuses let you decide how to manage review and
implementation of the Portfolios. Once a Portfolio is Closed, it will no longer appear as an option in
Demand and Program creation. You can use the Review phase to perform analysis of the success of
completed Portfolios.

To create a PPM Portfolio:

1. From the CSM Desktop Client or CSM Browser Client menu bar, select New > New PPM Portfolio.
2. Complete the Portfolio Details:

a. Provide a name and description.
b. (Optional) Select a Portfolio Manager and Primary Strategic Objective from the Related Item

Picker.
The Primary Strategic Objective choice will autofill the Strategic Objective Field.

c. (Optional) Choose the Assigned Team and Assigned To from the drop-down lists.
3. Complete the Portfolio Budget:

a. (Optional) Set a Portfolio Budget, and select Term Start and End Dates.
◦ Once the Portfolio is active, the Total Budget Committed Field will reflect a sum of the

budgets of accepted Projects.
◦ Total Budget Remaining is the Program Budget minus Total Budget Committed.

4. Select Save.

When a Portfolio is in the active phase, you can use the Form Arrangement to track the child Demands,
Programs, and Projects. The Issues, and Risks are Portfolio-level. There is also a tab for the parent
Strategic Objective.

To see the most comprehensive numbers for the Portfolio, use the My Portfolio Dashboard. You can also
use the My Portfolio Dashboard to see whether a proposed Demand can fit into the Portfolio budget.

Related concepts
PPM Dashboards
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Create PPM Programs
A Program is a group of related projects managed in a coordinated manner to obtain benefits not
available from managing them individually.

Note: This functionality is only available after you apply the mApp Solution.

While Programs have a simple workflow with statuses of New, Assessing, Active, Closed, and Review,
there is no formal approval process. The statuses let you decide how to manage, review, and implement
the Program. Once a Program is Closed, it will no longer appear as an option in Demand creation. You
can use the Review phase to perform analysis of the success of completed Programs.

To create a PPM Program:

1. From the CSM Desktop Client or CSM Browser Client menu bar, select New > New PPM Program.
2. Complete the Program Details:

a. Provide a Name and select a Program Manager. The Program Manager will be reflected in
Projects opened under the Program. .

b. Choose a Portfolio Name from the drop-down list. That choice will autofill the Strategic
Objective Field.

c. (Optional) Add Details and select the person the Program is assigned to.
3. Complete the Program Budget:

a. Set a Program budget and select Budget Start and End Dates (optional).
◦ Once the Program is active, the Total Budget Committed Field will reflect a sum of the

budgets of accepted Projects.
◦ Total Budget Remaining is the Program Budget minus Total Budget Committed.

4. Select Save.

When a Program is in the active phase, you can use the tabs to track the child Demands and Projects.
The Issues are Program-level. There is also a tab for the parent Strategic Objective.

174

CSM mApp Solutions

CSM mApp Solutions



Create PPM Stakeholders
Stakeholders can affect or are affected by a new demand and are key success factors for the
management of project portfolios.

Note: This functionality is only available after you apply the mApp Solution.

Stakeholders are populated from the Stakeholder table. Stakeholders for each Demand are based on the
Demand's Area.

If a Demand's Estimated Cost is less than $1 million, the Demand's Area Stakeholders marked as
Approvers are Approvers for the Demand. If the Demand Estimated Cost is greater than $1 million,
Stakeholders (regardless of Area) marked as Executive Committee are Approvers.

To create a new Stakeholder:

1. In the CSM Desktop Client or CSM Browser Client, select Tools > Table Management.
2. Select PPM Stakeholder from the Type drop-down list and select the New button.
3. Choose a Stakeholder from the drop-down list.

The Email Field automatically populates.
4. (Optional) Enter a Phone number and select a Department from the drop-down list.
5. Select a Process, Area, and Role from the drop-down lists.

The Role is based on a RACI matrix model.
6. Select the Approver and/or Executive Approval Committee check boxes, if appropriate.
7. Save and publish the Blueprint.
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Use Cherwell Project & Portfolio Management
Use PPM from the CSM Desktop Client, the CSM Browser Client, or the CSM Portal.

Note: This functionality is only available after you apply the mApp Solution.

The following sections describe the ways you can use Cherwell PPM:
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PPM Demands
Demand management is the process an organization puts in place to internally collect new ideas,
projects, and needs during the creation of a portfolio.

Note: This functionality is only available after you apply the mApp Solution.

Demands are called Ideas during the initial stages of Demand Management. Ideas can be created by
Demand Managers, Project Managers, Executives, customers, and other CSM users. The Ideas are
reviewed and either put into workflow for further detailed evaluation, approval, and consideration for
inclusion in a portfolio, or rejected by the Demand Manager. During the detailed Evaluation activities, key
areas of the Demand are scored (using information in Resource Plans, Financial Scores) to help
normalize a summary of the information for the Approval and Portfolio Review activities.
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Create a PPM Demand
Create a PPM Demand to add an Idea for approval.

Note: This functionality is only available after you apply the mApp Solution.

PPM Demands begin as Ideas and anyone with CSM credentials can submit an Idea. Customers can also
add Ideas with additional expansion of the configuration to include submission from the Portal.

To create a PPM Demand:

1. From the CSM Desktop Client or CSM Browser Client menu bar, select New > New PPM Demand.
2. Provide a title and description of the Idea.
3. The rest of the fields on the form are not required to move the Idea to the Review Idea phase, but

users such as managers will likely have more information and can add to more fields in the Idea.
4. Select Save.

The Idea is now available for Demand Managers to evaluate and approve.
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Review a PPM Demand
Demand Managers can access and review Ideas in the Demand Management Dashboard.

Note: This functionality is only available after you apply the mApp Solution.

To review a PPM Demand:

1. Open the PPM Demand that is in the Idea status and select the Review Idea link under Actions.
2. Enter the Requested Start Date and Requested Completion Date (both are required fields), as well

as any missing information in the Proposed Initiative section.
3. Enter applicable information in the Assessment section:

a. Select a T-shirt Size and Area from the drop-down lists.
b. Enter the Estimated Total Cost and Estimated Revenue.

These are very high-level estimates of costs and revenue associated with the Demand.
c. (Optional) Choose a Portfolio and Program from the drop-down lists (this may not be required,

depending on the Portfolio and Program relationships you have set up).
d. Choose a Type from the drop-down list.

Note: If you choose Strategic Objective from the Type drop-down list, you will need
to choose the specific Strategic Objective.

4. If necessary, select the Need More Information link under Actions to send an email to the
requester. This action will revert the Demand back to the Idea phase.

5. When the Assessment section is completed, the Accept Idea link under Actions becomes active.
Accepting the Idea will move the Demand into the Evaluate phase.

6. You may also choose to reject the Idea by selecting the Reject Idea link under Actions.

If you decide a PPM Demand can be addressed as a Service Request, you can select the Convert to
Service Request link under Actions. A dialog box asking for confirmation to open a Service Request and
close the Demand will appear. The Demand will be closed and you will be taken to the Incident to
populate additional fields. This becomes a Service Request based on the category/subcategory selected.
The information from the Demand is populated into the newly-created Service Request.
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Evaluate a PPM Demand
After a Demand is accepted, it moves to the Evaluate phase.

Note: This functionality is only available after you apply the mApp Solution.

During the Evaluate phase, you will enter more detailed information (in the Form Arrangement) to be used
to assess the viability of the Demand.

In the Demand Evaluation phase, you will put together a low-level resource plan, a benefit plan, a budget
plan, and risks. The financial assessment is auto-filled.

In the Evaluation phase, you can create plans to further detail the cost, opportunity, and resource impacts
of the Demand. None of these are required to move to the Approval phase; this is an option you can use if
you wish to evaluate at a less formal level. Controls for the amount of required information can be
configured in CSM Administrator, as appropriate.

To evaluate a PPM Demand:

1. Enter Resources in the Resource Plan tab.
2. Enter Benefit Items in the Benefit Plan tab.
3. Enter Budget Items in the Budget Plan tab.
4. The Financial Assessment tab automatically populates with an aggregate of the numbers in your

Budget and Benefits Plan.
5. Enter Risks in the Risks tab.
6. The Stakeholders tab automatically populates based on area. For more information, see Create

PPM Stakeholders.
7. The Portfolio, Program (if applicable), and Strategic Objective tabs are links to the parent record

information.

When a Demand is ready for the approval phase, select the Submit for Approval link under Actions. For
more information, see PPM Demand Approval.

Related tasks
PPM Resource Plan
PPM Benefit Plan
PPM Budget Plan
PPM Financial Assessment
PPM Risks
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PPM Resource Plan
Create a PPM Resource Plan in the Form Arrangement.

Note: This functionality is only available after you apply the mApp Solution.

During the Demand evaluation phase, you will check roles to see if they are available to execute the
scope of the Demand in the timeframe requested. Individual resources are not assigned until the Staffing
phase of the approved Project.

You can look at the Resource Management Dashboard to see a high-level view of requests and how they
match up with availability.

To create a PPM Resource Plan:

1. In the Resource Plan tab, select New PPM Resource Plan.
2. Select a Role from the drop-down list and enter Hours (optional) the role will require over the course

of the Demand.
3. (Optional) Select a Start and End Dates.
4. Select the Check Available Hours link.

Remaining Availability (number of hours available for that role) and Percent of Overall Demand
Fields are now visible.

The Percent of Overall Demand will change as additional Resources are added.

5. Select a Score from the drop-down list.
The Score and the Percent of Overall Demand will feed the Demand Scoring Widget.

Ensure you assign a score for each new Resource item. Resource Items that are not scored will
appear in red in the Resource Plan tab list view.

Related concepts
PPM Demand Scoring
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PPM Benefit Plan
Create a PPM Benefit Plan in the Form Arrangement.

Note: This functionality is only available after you apply the mApp Solution.

During the Demand Evaluation, you will create Benefit Items. Benefit Items are broken into up to 12
quarters. Cost Savings, Revenue, and Cost Avoidance will be rolled up in the Benefit Years buckets in the
Financial Assessment tab.

To create a PPM Benefit Item:

1. In the Benefit Plan tab, select New Benefit Item.
2. Select a Type from the drop-down list. The Type chosen determines the form displayed. If you

accidentally pick the wrong Type, you must delete the record and create a new one with the correct
Type.
If you choose Business Value, the value information feeds into the Business Value Score, and does
not have a quarterly benefit view.

a. (Optional) Provide a Description and select a Focus Area from the drop-down list.
b. (Optional) Provide a number (1-5) for Benefit If Done and Impact If Deferred.

3. If you choose any other Type from the drop-down list, the form displays the Benefit Breakdown
section and the Totals section.

4. (Optional) Provide a Description.
5. The Total Field (under the Total section) automatically populates with the sum of the Benefit

Breakdown section.
6. In the Benefit Breakdown section, enter costs for up to 12 quarters. The yearly totals are

automatically calculated.
You can see the Totals by Year in the Benefit Fields of the Financial Assessment tab.

Related concepts
PPM Demand Scoring
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PPM Budget Plan
Budget Items capture anticipated costs for this Demand.

Note: This functionality is only available after you apply the mApp Solution.

If a Demand is accepted into a Portfolio, the Budget Items transfer to that Project. Project Costs can be
tracked to these Budget Items based on the Type and Expense categories. The budget numbers you
enter will also show up in the Cost Fields in the Financial Assessment tab.

To create a new Budget Item:

1. In the Budget Plan tab, select New Budget Item.
2. Enter the Budget Item name in the Details Field.
3. Choose a Cost Type from the drop-down list.
4. The Total Cost Field automatically populates with the sum of the quarterly numbers.
5. Select the Capital Expense or Operational Expense option.
6. In the Budget Breakdown section, enter costs for up to 12 quarters. The yearly totals automatically

calculate.

Note: If you exceed the Demand's Estimated Total Cost when adding Budget Items, the
Estimated Total Cost will not increase. This lets you compare the estimated cost and the
Demand cost after it has been evaluated.
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PPM Financial Assessment
Use the Financial Assessment tab for an overview of items such as costs, benefits, and expenses.

Note: This functionality is only available after you apply the mApp Solution.

The Financial Assessment tab is in the Form Arrangement.
During the Demand Evaluation, you will review the Financial Assessment. The Financial Assessment is
populated with:

• Yearly Costs (the sum of Yearly Costs from the Budget Plans).

• Yearly Benefits (the sum of the Yearly Benefits from the Benefit Plans).

• Capital Expenses and Operating Expense (figures come from the Budget Plans).

• Effort (a total of the Resource Plans).

The ROI is based on these numbers.
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PPM Risks
PPM Risks include budget uncertainty, potential resource problems, or aging technology.

Note: This functionality is only available after you apply the mApp Solution.

During the Demand Evaluation, you will create Risks.

To create a PPM Risk:

1. In the Risks tab, select New PPM Risk.
2. Enter a name in the Risk Field.
3. (Optional) Select a Type from the drop-down list.
4. (Optional) Assign an Impact (0 to -5) and Probability (10 to 90%) from the drop-down lists.

This will feed the Demand Scoring Widget.
5. (Optional) Provide a Description and select Save.

Related concepts
PPM Demand Scoring

185

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/bundle/csm_mapps_integrations_help_only/page/content%2Fesm_solutions%2Fppm%2F..%2F..%2F..%2Fcontent%2Fesm_solutions%2Fppm%2Fppm_demand_scoring.html


PPM Demand Scoring
The numbers in the Demand Scoring section are driven by values entered during the evaluation phase.

Note: This functionality is only available after you apply the mApp Solution.

The Demand Scoring numbers are valuable as decision-making tools when compared against other
Demands. Demand Scoring is comprised of the following four scored areas:

• Business Value Score: Business Value items from the Benefit Plan.

• Financial Score: ROI from the Financial Assessment.

• Resource Score: The scores of the Resource Plan Items.

• Risk Score: The impact and probability of Demand risks.

The overall Demand score is calculated based on the four areas.

The objective of the scoring grid is to normalize all critical areas when making decisions about Demands
and their inclusion in Portfolios. This normalization allows you to do a true comparison across multiple
Demands.

Business Value Score
Benefit Items have a Benefit if Done (1-5) Field with a score of 1 to 5; this drives the Business Value
Score. The Focus Area, Impact if Deferred (1-5), and Description Fields and are used to determine the
Benefit. The Impact if Deferred (1-5) Field is not used in calculating score.

Financial Score
The Financial Score is calculated based off the ROI% from the Financial Assessment.

• ROI: Automatically populates using the following equation: (Return / Total Cost * 100).

• Total Return: Automatically calculates using Total Revenue minus Total Cost.

• Total Cost: The sum of all the Demand Budget Items (Year 1, Year 2, and Year 3 Costs).

• Total Revenue: The sum of the Benefit Plans (Year 1, Year 2, and Year 3 Benefits) with a type of
Revenue, Cost Savings, and Cost Avoidance.

Resource Score
Each Resource Item receives a score from -2 to 2. Users manually enter a Score based on the following
information:

• Available hours for that Role during that period.

• The overall percent of the Demand's work that this resource is responsible for.
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When a Score is assigned, a weighted score is applied to a Score Calculated Field; this field is used in
the overall Demand Score.

Risk Score
Each PPM Risk is assigned an Impact from 0 to -5, and a Probability from 10% to 90%. The Impact and
Probability Fields are manually entered on each Risk, and negatively affect the overall Demand score. A
weighted score is applied to a Risk Score Weight Field; the calculation used is (Probability * Impact).

Scoring of Demand Score Quadrants and Overall Demand Score
Business Value Score Quadrant
The Business Value Score is an average of all the Benefit Items' Benefit if Done Fields.

Financial Score Quadrant
Financial Score is based on ROI% and is assigned a score from 0 to 5, calculated as follows:

• Equal or less than 19% = 0

• Between 20% and 39% = 1

• Between 40% and 69% = 2

• Between 70% and 89% = 3

• Between 90% and 124% = 4

• Equal or Above 125% = 5

Resource Score Quadrant
Resource Score is a total of all the Score Calculated Fields from all Resource Items. The range is -2 to 2.

Risk Score Quadrant
Risk Score is a total of the Risk Score Weight Fields.

Overall Demand Score
The overall Demand Score is shown in the center of the Demand Scoring. The score is calculated using
the sum of all four quadrants.

Related tasks
PPM Resource Plan
PPM Benefit Plan
PPM Budget Plan
PPM Financial Assessment
PPM Risks
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PPM Demand Approval
When the information for the Evaluation phase has been completed, the Demand is ready for approval by
the identified Stakeholders.

Note: This functionality is only available after you apply the mApp Solution.

The Approvers for Demands are determined by the Demand area and the Approvers for each Demand
are displayed in the Stakeholder tab of the Form Arrangement. Approvers can choose to Approve the
Demand, Deny it, or Abstain. Approvers can also choose to Defer the Demand if it has merit but is not
appropriate for Portfolio inclusion at the time. Approvers receive an email with the Demand information
and the email contains a link to complete the approval. If any of the Stakeholders deny the Demand, the
Demand returns to the Evaluate phase and a Journal entry tracks the denied approval.
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PPM Portfolio Review
Use the Portfolio Review phase to perform analysis of the success of completed Portfolios.

Note: This functionality is only available after you apply the mApp Solution.

When a Demand is approved (all Stakeholders approve) it moves to Portfolio Review. When the Demand
enters the Portfolio Review phase, a placeholder Project is created and put in the Assessing phase. The
information from the Demand is brought into the placeholder Project so Approvers can compare it against
projects in progress.

In the Portfolio Review phase, you can use the My Portfolio Dashboard to evaluate current status of your
Portfolios.

To view Demands awaiting approval:

1. Right-click the Demand in the Demand for Consideration section of the Dashboard.
2. Select Actions.
3. Select Add to Portfolio. You can now see the updated values for Portfolio budgets and revenue.

In Portfolio Review phase, you can adjust the cost and budget of the Demand to better fit into the
available Portfolio figures.

4. Right-click the moved Project; under Actions you can select to move it back to the Demands for
Consideration section, or select Commit to Portfolio.

5. If you chose to commit the Project to the Portfolio, refresh the Dashboard to see updated numbers.
6. At this point, a Project Manager can begin work on the Project. The Demand moves to a Closed

status and the Project is in New status.

When the Demand is in Closed status, the status change options are: Defer the Demand, Modify the
Demand, or Accept the Demand. If the Demand is deferred, the status is set to Deferred. The One-Step™
Action Set to Portfolio Review will return the status to Portfolio Review. Modifying the Demand returns the
Demand to the Evaluation phase.
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PPM Projects
Projects can be created independent of an associated Demand depending on customer business
processes.

Note: This functionality is only available after you apply the mApp Solution.

Once a PPM Demand is accepted into a Portfolio, the Project created during the Portfolio Review phase
changes status from Assessing to New. The Project Form is used to track status through the lifecycle of
the PPM Project. Information from the associated Demand (Planned effort, budget items, resource plan,
benefit plan, risks) rolls into the Project.

Project Phases
There are no controls or requirements for moving from phase to phase within a PPM Project; the statuses
let you track the Project through its lifecycle. The following are Project statuses:

• Assessing: When the associated Demand is in Portfolio Review, the Project is in the Assessing
phase. It allows for side-by-side review with other Projects in the Portfolio.

• New: The Demand has been added to a Portfolio.

• Staffing: Adding individual Resources to the Project.

• Scheduled: Staffed but not yet active.

• Executing: Project is in progress.

• Closed: Project completed.
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Create a PPM Project
Create a new Project to add supporting information and plan the staffing and resources necessary to
complete the Project. You can do this during the New and Staffing phases.

Note: This functionality is only available after you apply the mApp Solution.

Create a Project from the CSM Desktop Client or CSM Browser Client (New > New PPM Project).

1. Provide a name and select an Area from the drop-down list.
2. Add a description (optional) and select a Requester.
3. Select an Assigned Team and an Assigned To from the drop-down lists.
4. Select a Site from the drop-down list.
5. Select a Portfolio and Program Name, if applicable.

The Portfolio, Program (if applicable), and Demand tabs are links to the parent record information.
6. The Planned Start and Planned End Date Fields are initially populated from the associated fields in

the Demand. Going forward, these dates are populated based on the dates in the '0' Outline Task
once Project Tasks are imported. These will change with each import update as appropriate.

7. Select Actual Start and End Dates.
8. The Planned Effort Field is initially populated based on the Resource Plans created in the Demand.

As Project Tasks are created, the '0' Outline Task provides the overall Planned Effort number (Effort
Field in that Summary Task).

9. The Projected Remaining Effort Field is the Planned Effort minus Actual Effort.
10. The Actual Effort Field is based on the sum of Task Summary times in the weekly Timesheets.

Provide supporting information in the Form Arrangement.

11. The Resource Plan tab contains Resource Items populated from the Demand. You can add more
Resource Items here, but it will not affect the Demand baseline. Individual Resources are assigned
in PPM Project Tasks.

12. The Benefit Plans tab contains Benefit Items populated from the Demand. You can add more
Benefit Items here, but it will not affect the Demand baseline.

13. Enter additional Budget Items in the Budget Items tab.
Once Budget Items transfer into a Project, fields labeled Remaining below the quarterly budget

breakdown figures show the budget remaining after Cost Items have been applied. An alert icon 
will identify any Budget Items with Cost Items that exceed the budgeted amount.

14. Enter Cost Items in the Cost Items tab. Cost items that do not have an associated Budget Item are
identified with an alert icon. For more information, see PPM Cost Items.

15. Enter Project Tasks in the Project Tasks tab. It is recommended that Project Tasks be created and
updated with MS Project or Excel.

16. Enter Issues in the Issues tab. The Open Issues area of Project Health will reflect the number of
open Issues for each health area based on the Issue Type. For more information, see PPM Issues.
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17. The Risks tab contains Risks rolled over from the Demand. You can add more Risks here, but it will
not affect the Demand baseline.

18. Enter Action Items in the Action Items tab. For more information, see Create PPM Action Items.
19. Use the Change Orders tab to accommodate Project needs that will affect scope, budget, or

schedule.
20. Use the Change Requests tab to track associated IT changes associated with the Project (example:

Install a new Server).
21. Use the Project Task Import tab to import information exported from Microsoft Project or Excel. For

more information, see Import Project Info.
This tab is only available on the CSM Browser Client.

22. Select Save.

The Project Health Widget provides a view from the Project Manager perspective of the three key areas
that are indicators of overall project health: Budget, schedule, and scope. You must manually change this
Widget.

Related concepts
PPM Project Health
Related tasks
Evaluate a PPM Demand
PPM Project Tasks
PPM Risks
PPM Change Order
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PPM Cost Items
Cost Items are tracked costs related to ongoing project expenses.

Note: This functionality is only available after you apply the mApp Solution.

Cost Items may or may not directly tie to a Budget Item. If a Cost Item does match a Budget Item (Type
and Cost Type) the cost will be tracked against that Budget Item. Once you enter the Cost Items, you can
refresh the Budget Items to see the changes. You can apply costs to a certain quarter of a budget so you
can see run rates. All the Cost Items populate to the Cost section of the Project pane.

To create a PPM Cost Item:

1. In the Cost Items tab, select New Cost Entry.
2. Enter Details (example: Server) and choose a Type from the drop-down list.
3. Choose a Cost Type option.
4. Choose a Budget from the drop-down list.

This drop-down list is populated with Budget Items that match the Type and Expense for the Cost
Entry. If Budget is empty, the Type and Capital Expense/Operational Expense do not match an
existing Budget Item. You can add a new Budget Item or Change Order, or the Cost can be tracked
without a Budget Item.

5. Enter a Total Cost and select a Quarter from the drop-down list.
6. Select Save.

Impact of Cost Items on Budget Items
If the Cost exceeds the Budgeted amount for the year, an alert appears by the Budget Item.

Cost Items with No Matching Budget Item
If a Cost Item does not have a matching Budget Item, it will be highlighted with the hazard marking for
potential Project Management attention. A possible solution is to initiate a Change Order requesting
additional budget.
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PPM Issues
PPM Issues have a simple workflow of New, In Progress, and Closed.

Note: This functionality is only available after you apply the mApp Solution.

The Type Field populates into the Project Health numbers.

To create a PPM Issue:

1. In the Issues tab, select New PPM Issue.
a. Enter a Title and Description (optional).
b. Select a Type from the drop-down list.

The Type you choose will reflect in the Project Health Widget.
c. (Optional) Select an Assigned Team and an Assigned To from the drop-down lists.
d. Select an Open Date and Expected Resolution Date.
e. Select the Impact To Scope and/or Identified as a Risk check boxes, if necessary.
f. Select a Priority from the drop-down list.

2. (Optional) Select a Date Completed and Disposition.
3. (Optional) Provide an Action Plan.

Related concepts
PPM Project Health
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PPM Action Items
PPM Action Items have a simple workflow of New, In Progress, and Closed; although there are no
controls for moving from phase to phase.

Note: This functionality is only available after you apply the mApp Solution.

Project and Project Manager are automatically populated with the parent Project information.

To create an Action Item:

1. In the Action Items tab, select New PPM Action Item.
2. Enter a Title and Description (optional).
3. (Optional) Assign a Priority.
4. (Optional) Enter a Date Opened and Target Date.
5. (Optional) Select an Assigned Team and an Assigned To from the drop-down lists.
6. (Optional) Enter a Closed Date and provide Resolution Details.
7. Select Save.
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PPM Change Order
Use Change Orders for changes in Project duration, effort, or budget.

Note: This functionality is only available after you apply the mApp Solution.

Change Orders have a simple workflow of Initial, Evaluation, Review, and Closed; although there are no
controls for moving from phase to phase.

To create a PPM Change Order:

1. In the Change Orders tab, select New PPM Change Order.
2. Select a Sponsor and provide a Change Order Title.
3. The Project Field is automatically populated based on the parent object.
4. (Optional) Select a Required By date and the Estimated Additional Effort (in hours).
5. (Optional) Enter a Description.
6. (Optional) For each section (Scope, Budget, and Schedule), select the Yes or No check box and

provide details for impacts for the Change Order.
7. (Optional) Enter any necessary Comments.
8. Provide an Action and any Comments and then select Save.
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PPM Project Tasks
Individual Resources are assigned at a PPM Project Task level.

Note: This functionality is only available after you apply the mApp Solution.

You can import Project information from Microsoft Project or Excel to create or update Project Task plans.

Note: Cherwell PPM does not support a bi-directional relationship and associated date updates to
Project Tasks like MS Project can. For example, if you update a Project Task date or effort, CSM
does not modify the associated successor tasks with new information based on the Project Task
update.
If Project Tasks (example: change assignment, effort, start/end dates) are updated in CSM, these
updates will only reside in CSM and will be overlaid if there is an update activity initiated from MS
Project.

We recommend you use one of the two following methods for creating and maintaining your Project
Tasks:

• Use MS Project/Excel for new and update activities for CSM Project Tasks.

• Use MS Project/Excel to create the new CSM Project Tasks and then all updates are done in CSM.

To manually create a PPM Project Task:

1. In the Project Tasks tab, select New Project Task.
2. Enter a Title.
3. Project automatically populates.
4. Select an owner (Assigned To).

The Role Field automatically populates based on the Assigned To Field.
5. (Optional) Select a Task Type and add a Description.

Use the Rich Text editor if necessary.
6. The Duration automatically calculates after entering the Scheduled Start and End Dates.
7. Enter an Outline Number.

Remember: There must be a "0" Outline Task. The information from this task will populate
the Project start date, end date, and effort Fields in the Project. For other Project Tasks,
provide an Outline number that is unique, sequential, and represents the relationship to
other tasks (example: Task 1 is a parent task and it can have child tasks with outline
numbers such as 1.1, 1.2, 1.3)

If you are manually creating Project Tasks, we recommend they be at a high level (not many levels
deep with predecessors), because CSM will not modify the downstream impacted fields based on
changed parent information.
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8. (Optional) Enter the Effort hours and a Resource Percentage (this is informational only and does not
impact the Effort Field).

9. Select Scheduled Start and End Dates.
10. (Optional) Select Actual Start and End Dates.
11. Hours Worked is automatically populated from the Time Entry process.

The Hours Worked Field populates up to parent tasks.
12. % Complete automatically populates from the Time Entry process, but can be changed.
13. Planned Remaining Effort automatically populates by calculated Effort minus Hours Worked.

The Planned Remaining Effort Field populates to parent tasks.
14. Est. Remaining Effort automatically populates from the Time Entry process (this is the resource's

estimate of what effort is remaining, regardless of the planned effort or hours worked).
The Est. Remaining Effort Field populates to parent tasks.

15. Total Effort automatically populates by calculating Hours Worked plus Estimated Remaining Effort.
16. You can set up three Predecessors Tasks, if necessary. Enter information for the following:

a. Predecessor Task name and Task Type.
b. Predecessor Name automatically populates. The Predecessor tab shows the Predecessor

Tasks.

Related concepts
Import Project Info
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PPM Decision
Use Decisions for Project Managers' reference and as a historical record.

Note: This functionality is only available after you apply the mApp Solution.

To create a Decision:

1. In the Decisions tab, select New PPM Decision.
2. Provide a Title and Details (optional).
3. Select an Owner and the date the Decision was made.
4. Select Save.
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Import Project Info
Import an .xml file from Microsoft Project or .csv file from Microsoft Excel to populate information into
Cherwell PPM.

This is an ideal solution for project managers to build and manage the WBS in Project or Excel, but
manage Resources and Demands in CSM. Project managers can continue to maintain the WBS in
Project and periodically import the updated files into CSM.

Note: You may need to import large projects as a Scheduled Item due to time limit constraints.
See Create a Scheduled Item.

Maintain Project Task Information
Typically, you modify items that impact schedule or resources in Microsoft Project and re-import. If you
make updates in Cherwell PPM, it will not be reflected in Microsoft Project. Modifications made in PPM do
not flow down to dependencies (example: Resource changes).

Important: Imports from Microsoft Project and Microsoft Excel (.csv) cannot successfully process
PPM Resources (created from users) that have commas or special characters as part of the
string. For example, a User Full Name of Smith, Joseph will not be allowed in the Resource field
of Microsoft Project. Microsoft Excel (.csv) reads the comma as a delimiter and fails to process
imports correctly.
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Use Microsoft Project with Cherwell PPM
Use Microsoft Project to create and update your CSM Project Tasks and harness the power of Microsoft
Project to automatically adjust dates, effort, and duration for the creation of new plans or updating existing
project tasks.

Note: This functionality is only available after you apply the mApp Solution.

CSM does not have the ability in this version to cascade appropriate updates across dependent project
tasks.

A sample Microsoft Project template is provided with the Cherwell PPM .zip file.

Good to Know

• Integration between CSM and Microsoft Project is single direction (Microsoft Project to CSM).

• The import activities are initiated from within an existing CSM Project.

• Microsoft Project plans are saved as .xml documents for import into CSM.

• If Project Tasks are updated in CSM (example: change assignment, effort, start/end dates) these
updates will only reside in CSM and will be overlaid if there is an update activity initiated from
Microsoft Project.

Overview
Create a New Task Plan for a CSM Project:

1. Create a Microsoft Project plan following the instructions below for key areas (example: Outline
Number).

2. Save the plan in .xml format.

3. Select the Import Project link in the PPM Project.

Update existing Project Tasks:

1. In Microsoft Project, apply the updates required. These can include adding new tasks, deleting
existing tasks, modifying predecessors, and changing effort.

2. Save the plan in .xml format.

3. Select the Update Project link in the PPM Project.

Key Concepts

1. A '0' Outline Summary task is required to be the first Project plan line. This can be enabled by
selecting Project Summary Task in the Format tab of Microsoft Project. The Duration, Effort, and
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Dates are populated from this line and provide the totals and start/end information for the overall
project.

2. There can only be one Resource per Task. If two Resources will be working on the same activities,
two different tasks are required, with one resource each.

3. Up to three prerequisites can be captured and included with the Project Task. These will be seen in
CSM in the associated Project Task Fields and in linked tabs.

4. Resource Names must match the Resource Names in the PPM solution. In the example, the
Resource table was exported from CSM, and the Resource names were pasted into the Microsoft
Project Resource sheet to ensure a match. If you wait to add resources to Project Tasks in CSM,
you will need to manually populate the Effort Field since this is not a calculated field. It is assumed
that Effort will populate from Microsoft Project. Task Effort is not populated in Microsoft Project
unless a Resource is assigned, so the Effort Field in the CSM Project Task will also be 0.
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Create a New Project Task Plan from Microsoft
Project in the CSM Desktop Client

Use the Desktop Client to import a new Project Task Plan (to create new Project Tasks). Assignment,
Dates, Predecessors, Duration, Effort, and Title fields are populated in the Project Task based on the
Microsoft Project Plan task information.

Note: This functionality is only available after you apply the mApp Solution.

Use the Import Project link in the CSM Desktop Client.

To import a new Project Task plan from Microsoft Project:

1. Save the Microsoft Project file in .xml format.
2. Open CSM and access the Project you want to update.
3. Select the Import Project link (under Actions).
4. When prompted, browse for the .xml file and select OK.

When the import is complete, the Project Task tab will show the newly created Project Tasks. The
Import Project link is replaced with an Update Project link.
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Update Task Plan from Microsoft Project in the
CSM Desktop Client

Use the Desktop Client to update an existing Project Task Plan. After you modify the Project Plan in
Microsoft Project, you can update the Project Tasks in CSM using the Update Project link.

Note: This functionality is only available after you apply the mApp Solution.

CSM uses the Unique ID Field from Microsoft Project to update, create, and delete Project Tasks.

To update a Task Plan from Microsoft Project using the CSM Desktop Client:

1. Modify the MS Project plan with the updates for the Project Tasks.
2. Save the Microsoft Project file in .xml format.
3. Open CSM and open the Project you want to update.
4. Select the Update Project link (under Actions).
5. When prompted, browse for the .xml file and select OK.
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Create a New Project Task Plan from Microsoft
Project in the CSM Browser Client

Use the Browser Client to import a new Project Task Plan. This creates new Project Tasks and populates
certain fields based on the Microsoft Project Plan task information.

Note: This functionality is only available after you apply the mApp Solution.

Use the Import Project link in the CSM Browser Client.

To import a new Project Task plan from Microsoft Project:

1. Save the Microsoft Project file in .xml format.
2. Open CSM and access the Project you want to update.
3. Open the .xml file in a text editor program (example: Notepad) and copy the data.
4. In the Project Task Import tab, paste the data into the Full Text for Import Field.
5. Select the Import Project link (under Actions).

When the import is completed, the Project Task tab will show the newly created Project Tasks. The
Import Project link is replaced with an Update Project link.
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Update Task Plan from Microsoft Project in the
CSM Browser Client

Use the Browser Client to update an existing Project Task Plan. After you modify the Project Plan in
Microsoft Project, you can update the Project Tasks in CSM using the Update Project link.

Note: This functionality is only available after you apply the mApp Solution.

CSM uses the Unique ID Field from the MS Project to update, create, and delete Project Tasks.

To update a Task Plan from Microsoft Project using the CSM Browser Client:

1. Modify the Microsoft Project plan with the updates for the Project Tasks.
2. Save the Microsoft Project file in .xml format.
3. Open CSM and open the Project you want to update.
4. Copy and paste the xml code into the Project Task Import tab.
5. Select the Update Project link (under Actions).
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Use Microsoft Excel with Cherwell PPM
Use Microsoft Excel to create and update your CSM Project Tasks and use the template provided with the
Cherwell PPM .zip to lay out your project plan in a spreadsheet format.

Note: This functionality is only available after you apply the mApp Solution.

Unlike Microsoft Project, project task line items will not automatically update based on dependencies.

Good to Know

• Integration between CSM and Microsoft Excel is single direction (Microsoft Excel to CSM).

• The import activities are initiated from within an existing CSM Project.

• Microsoft Excel plans are saved as .csv documents for import into CSM.

• If Project Tasks are updated in CSM (example: change assignment, effort, start/end dates), these
updates will only reside in CSM and will be overlaid if there is an update activity initiated from
Microsoft Excel.

• Important: Values in cells cannot have a trailing space (whitespace at the end of a value).
Ensure you remove any trailing spaces in the .csv values prior to import, or the import
process will fail.

Overview
Create a New Task Plan for a CSM Project:

1. Create a Microsoft Excel plan following the instructions below for key areas (example: Outline
Number).

2. Save the plan in .csv format.

3. Select the Import Project from Excel (CSV) link in the PPM Project (under Actions).

To update existing Project Tasks:

1. In Microsoft Excel, apply the updates required. These can include adding new tasks, deleting
existing tasks, modifying predecessors, and changing effort.

2. Save the plan in .csv format.

3. Select the Update Project from Excel (CSV) link in the PPM Project (under Actions).

Key Concepts
For Microsoft Excel project plans, all of the fields need to be manually populated.
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1. The Project ID is the existing PPM Project ID.

2. The Project Task UID must be a unique number because it is used during updates (add, modify,
delete) and is the relational field between Cherwell PPM and Microsoft Excel.

3. Outline Number:
◦ A '0' Outline Summary task is required to be the first project plan line. The Duration, Effort, and

Dates are populated from this line and provide the totals and start/end information for the
overall project on the PPM Project record.

◦ Other Outline numbers indicate Task Types (example: 1 is a Parent, 1.1 is a Child)

4. Duration, Effort, Scheduled Start Date, and Scheduled End Date are used by the associated fields in
the CSM Project Task.

5. The Resource must match the Resource Name in CSM.

6. Enter a Utilization Percent.

7. Up to three Predecessors can be captured and included with the Project Task. The values in these
fields are the appropriate Project Task UIDs. These will be populated in CSM in the associated
Project Task Fields and in linked tabs.

8. Save as a .csv file (for the import into CSM).
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Create a New Project Task Plan from Microsoft
Excel in the CSM Desktop Client

Use the Desktop Client to import a new Task Plan. This creates new Project Tasks and populates certain
fields based on the Microsoft Excel Task information.

Note: This functionality is only available after you apply the mApp Solution.

Use the Import Project from Excel (CSV) link in the CSM Desktop Client.

To create a new Task Plan from Microsoft Excel:

1. Save the Microsoft Excel file in .csv format.
2. Open CSM and access the Project you want to update.
3. Select the Import Project from Excel (CSV) link (under Actions).
4. Browse for the .csv file and select OK.

The .csv file cannot be open during this process, or the import will fail.
When the import is complete, the Project Task tab will show the newly created Project Tasks. The
Import Project link is replaced with the Update Project from Excel (CSV) link.

Note: The most common error occurs when the Excel template is not modified to reflect the
accurate CSM Project ID. If the Project ID in the CSV does not match the CSM Project ID that
initiates the import, the following message will occur:

If you get an error on the import, delete any Project Tasks that were created prior to retrying. You
will know this is the case if the import link says Update instead of Import.
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Update Task Plan from Microsoft Excel in the CSM
Desktop Client

CSM uses the Unique ID Field from the Microsoft Excel spreadsheet to update, create or delete Project
Tasks.

Note: This functionality is only available after you apply the mApp Solution.

If Project Tasks are updated in CSM (example: change assignment, effort, start/end dates) these updates
will only reside in CSM and will be overlaid if there is an update activity initiated from Microsoft Excel. We
recommend one fo the following:

1. Microsoft Excel is used for new and updated activities for CSM Project Tasks

2. Microsoft Excel is used to create the new CSM Project Tasks and then all updates are done in CSM.

To update a Task Plan from Microsoft Excel in CSM Desktop Client:

1. In Microsoft Excel, apply the updates required. These can include adding new tasks, deleting
existing tasks, modifying predecessors, and changing effort.

2. Save the Microsoft Excel file in .csv format.
3. Open CSM and access the Project you want to update.
4. Select the Update Project from Excel (CSV) link (under Actions).
5. When prompted, browse for the .csv file and select OK.
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Create a New Project Task Plan from Microsoft
Excel in the CSM Browser Client

Use the Browser Client to import a new Project Task Plan. This creates new Project Tasks and populates
certain fields based on the Microsoft Excel task information.

Note: This functionality is only available after you apply the mApp Solution.

Use the Import Project from Excel (CSV) link in the CSM Browser Client.

To create a new Task Plan from Microsoft Excel:

1. Save the Microsoft Excel file in .csv format.
2. Open CSM and access the Project you want to update.
3. Open the .csv file in a text editor program (example: Notepad) and copy the data.
4. In the Project Task Import tab, paste the data into the Full Text for Import Field.
5. Select the Import Project from Excel (CSV) link (under Actions).

When the import is complete, the Project Task tab will show the newly created Project Tasks. The
Import Project link is replaced with an Update Project from Excel (CSV) link.

Note: The most common error occurs when the Excel template is not modified to reflect the
accurate CSM Project ID. If the Project ID in the CSV does not match the CSM Project ID that
initiates the import, the following message will occur:

If you get an error on the import, delete any Project Tasks that were created prior to retrying. You
will know this is the case if the import link says Update instead of Import .
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Update Task Plan from Microsoft Excel in the CSM
Browser Client

Use the Browser Client to update an existing Project Task Plan. After you modify the Project Plan in
Microsoft Excel, you can update the Project Tasks in CSM using the Update Project link.

Note: This functionality is only available after you apply the mApp Solution.

Use the Update Project link in the CSM Browser Client.

If Project Tasks are updated in CSM (example: change assignment, effort, start/end dates) these updates
will only reside in CSM and will be overlaid if there is an update activity initiated from Microsoft Excel. We
recommend one of the following:

1. Microsoft Excel is used for new and updated activities for CSM Project Tasks

2. Microsoft Excel is used to create the new CSM Project Tasks and then all updates are done in CSM.

To update a Task Plan from Microsoft Excel in CSM Browser Client:

1. In Microsoft Excel, apply the updates required. These can include adding new tasks, deleting
existing tasks, modifying predecessors, and changing effort.

2. Save the Microsoft Excel file in .csv format.
3. Open CSM and access the Project you want to update.
4. Select the Update Project from Excel (CSV) link (under Actions).

212

CSM mApp Solutions

CSM mApp Solutions



PPM Project Health
Use the Project Health Widget (in the Project Details Dashboard) to track the overall project status.

Note: This functionality is only available after you apply the mApp Solution.

Select the link to change the color/status, depending on your organization's perception of the project
health:

• Green: On Track

• Orange: At Risk

• Red: Off Track

When Issues associated with a Project have a Type selected, the selected Type is mapped to Health
areas. The open Issues listed in the Widget are a quick reference for the Project Manager. It is still up to
the Project Manager's to decide if the Issues are a significant enough impact to move the health sliders to
yellow or red.

The slider categories are driven by the classifications of PPM Issues:

• Budget Health is driven by PPM Issues classified as budget/cost and projected benefit.

• Schedule Health is driven by PPM Issues classified as resources and schedule.

• Scope Health is driven by PPM Issues classified as change management, design, external,
integration, organizational, quality, and resistance.
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Use PPM Tasks
Add the Project Task and Timesheet Widgets into your existing My Work Dashboard (or any Dashboard
you have created to track your work).

Note: This functionality is only available after you apply the mApp Solution.

As a PPM Resource, use the My Work Dashboard to view your Project-related work.

When performing Project-related work, use the Project Tasks and My Project Timesheet objects on the
Dashboard. Select Tasks to work on from the My Project Tasks section. Open the Task to see detailed
information, such as expected effort and predecessors.

After you perform Project Task work, you need to update the Task.

To update the Task:

1. Double-click the Task to open it.
2. Add appropriate information in the Description Field about the Project Task work performed.
3. Populate Actual Start and Actual End information during the Project Task lifecycle.
4. When finished with the Task, move it to Closed status.
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Use PPM Timesheets
Use Timesheets to log time for Project Tasks.

Note: This functionality is only available after you apply the mApp Solution.

In a given week, you may have several different Tasks you're working on, but you can account for all Task
in one Timesheet. However, the Timesheet is only for Project-related work, not Incidents and Service
Requests.

Only the Task owner can enter hours against the Task. Timesheets are generated weekly for all
Resources, but they are automatically deleted after a month if they do not have any time entered.

To fill out a PPM Timesheet:

1. From the My Work Dashboard, open the Timesheet for the Task you want to log time against.
2. In the Task Summary tab, select New Task Summary. Add additional summaries for each Project

Task that requires time logged against it.
3. Select Task Search.

The Project Task Selector displays. This list contains all the Project Tasks owned by the logged-in
Resource.

4. Select the Project Task you want to log time against.
a. Select New Task Summary in the Task Summary tab. The Task ID, Project Name, Project

Manager, Estimated Remaining Effort, and Percent Complete automatically populate.
b. Enter time for each day as appropriate.

Enter time reporting in a way most convenient for you; day by day or end of week. Time will
not be applied to the Timesheet until you select Submit Hours. You can return to this screen
to edit the hours as needed until you submit the Timesheet (not the Task Summary record).

c. The Est Remaining Effort (Hours) will default to the Remaining Effort within the Project Task
record. This field should be updated by the Resource entering time to reflect the new
estimated remaining effort for the Task. Percent Complete should also be populated. If the Est
Remaining Effort (Hours) plus the hours entered are greater than the original task estimate, an
alert icon appears by the Task to alert the Project Manager.

d. Select Submit Hours when hours have been entered for the Task Summary. If there are
multiple Task Summaries, each must be submitted individually. The time from the summary
record will be added to the Timesheet.

Next, the Project Manager for the associated projects is reviewed and committed and the reported time is
posted to the Task (along with the Estimated Remaining Effort and Percent Complete).
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PPM Dashboards
Cherwell PPM offers several OOTB Dashboards.

Note: This functionality is only available after you apply the mApp Solution.

When viewing a PPM Dashboard, PPM-related Dashboards appear in a sidebar for easy access.

PPM provides the following OOTB Dashboards:

• PPM Overview

• Demand Management

• Resource Management - Role

• Resource Management - Individual

• Program Details

• Project Details

• My Portfolio Details

• My Projects

• My Work

PPM Overview
The PPM Overview Dashboard provides a snapshot into the organization's overall PPM scope. The rollup
includes Budget, Cost, and Revenue for all active Portfolios, as well as, potential Revenue and Cost of all
in-flight Demands. The Dashboard allows you to easily drill-down into the details for more information on
specific Portfolios or Demands.
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Demand Management
The Demand Management Dashboard provides a high-level overview of all Demands in flight. Compare
the total projected Demand Costs against projected potential Revenue. Monitor Demands pending
approval to follow up or take action as needed.

Resource Management - Role

1. Select Select/Change Role and select a Role from the PPM Role Selector window.
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2. Select OK.

3. Enter a Start and End date.
The resulting graph will show a high-level view of available and allocated project hours for the
selected role. Toggle between the weekly and daily view as needed.

Resource Management - Individual

1. Select Select/Change Individual and select a Resource from the PPM Resource Selector window.

2. Select OK.

3. Enter a Start and End date.
The Work Week Hours and Operational Percent information for the Resource determine the hours
available in the graph. Toggle between the weekly and daily view as needed.
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Program Details

1. Select Select/Change Program and select a Program from the window to see a detailed view.

Project Details

1. Select Select/change project and select a Project from the window to see a detailed view.
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Note: If you open a Project record and make changes, when you return to the Dashboard,
you must reselect the Project to refresh the Widgets.

My Portfolio Details

1. Select Select/change portfolio and select a Portfolio from the window to see a detailed view.
Use the Demands for Consideration section to move candidate Projects in and out of the Portfolio
to see budget impacts.
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My Projects
This Dashboard shows all the Projects for the logged-in Project Manager.
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My Work Dashboard
My Work shows the logged-in user's Timesheets and Project Tasks, in addition to non-PPM work
assigned via CSM.

222

CSM mApp Solutions

CSM mApp Solutions



223

CSM mApp Solutions

CSM mApp Solutions



Managing Cherwell Project & Portfolio
Management

Project Managers can use Cherwell PPM to track progress on Projects and Portfolios, manage
Resources, and work with Resource Timesheets.

Note: This functionality is only available after you apply the mApp Solution.

Use Cherwell PPM to:

• Manage PPM Projects

• Manage PPM Resources

• Manage PPM Timesheets
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Manage PPM Projects
As Projects progress, you may need to add new Costs, Risks, Action Items, Issues, and Change Orders.

Note: This functionality is only available after you apply the mApp Solution.

If you are tracking the Project in Microsoft Project or Excel, you may choose to import and update Project
Tasks.

• Project Managers will primarily use the My Projects and Project Details Dashboards. You can use
these Dashboards to view Project Health, cost, and effort; identify Project Tasks that need attention;
and review and commit Timesheets.

• The My Projects Dashboard provides an overview of all projects assigned to the logged in user. It
provides a high-level view of Project status, costs, health, and Timesheets awaiting approval.

• An alert icon by a Project means that at least one of the Health indicators is red.

• The Project Details Dashboard provides more details on the individual Projects.

• In the Project Tasks pane, Tasks at risk are flagged with an alert icon. Double-click the Task to go to
the Project Task record. If the Est Remaining Effort is greater than the Estimated Effort, the Total
Effort has a red box.

• An alert icon also appears by Tasks that have more hours recorded against them than estimated. As
a Project Manager, you can choose to update the Project plan, re-allocate the work, or create a new
Task for another Resource.

• If a Budget Item yearly total is exceeded, an alert icon appears by the Budget item in the Project
record.

• Use the Update Project Task Hours link to populate the Project Task hours to the parent Tasks.
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Manage PPM Resources
View a Resource record from a Project or from the Resource Management - Individual Dashboard.

Note: This functionality is only available after you apply the mApp Solution.

Use the PTO tab in the Form Arrangement to set PTO for each Resource.

View a Resource's Time Record
Access a PPM Resource Time record by double-clicking on a Resource record from the Resource
Management - Individual Dashboard. These records hold all reportable information for Resources and are
used for the Resource Management Dashboards. Information includes Date, Role, Name, Weekly Hours,
Daily Hours, Allocated Hours, Available Project Hours, PTO Hours, and Operation Percent. Allocated
Hours is a sum of the hours per day for any Project Tasks that the Resource is assigned on that date.
PTO Hours are populated when Scheduled PTO is added for that Resource.

Update Resources
To update a Resource record (Role, Hours available, or Operational time), in the record, select the
Update Resource link (under Actions) and a set of prompts will collect the necessary information and all
associated records.

Delete Resources
Use the Delete Resource One-Step™ Action (the Delete Resource link under Actions) on the record to
ensure the Resource record and all linked entries are deleted.
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Manage PPM Timesheets
PPM Timesheets are a tool for Project Managers to track hours logged against Projects and evaluate any
adjustments needed to the Project plan.

Note: This functionality is only available after you apply the mApp Solution.

• Use the information recorded in Timesheets to update Hours Worked, Percent Complete, and
Remaining Effort on the Project Tasks Business Object. A One-Step™ Action is provided in the
solution to create a weekly Timesheet for each Resource in the Resource table. This One-Step
Action should be set up as a scheduled process during the initial configuration activities.

• Task Summaries with submitted time are visible to the assigned Project Manager of the associated
Project. Each must be Committed (accepted) for the time to post to the Task (along with the Est
Remaining Effort and Percent Complete). One Timesheet can accommodate multiple Project Tasks.

• In the My Projects Dashboard, use the Timesheets Awaiting Approval section.

Commit Hours
To commits the hours:

• In the Task Summaries tab, right-click the task summary and select Commit.

Project managers can also choose to view individual timesheets for a more granular look at the work
performed on a task. If necessary, they can edit the time entries.

To view the Task Summary record:

• Select the Commit hours to task link.

When the Estimated Total Task Effort exceeds the Planned Effort minus the Hours Worked, an alert icon

 appears on the grid showing the project tasks. The committed hours populate to the Hours Worked on
the Project Task.
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Project & Portfolio Management mApp Solution
Items

The Items tables provides a list of items included when applying the mApp® Solution and the typical
merge action.

Item
Category Item

Typical
Merge
Action

Automation
Process
Definitions

Additional Resource Time Entries, Create Project From Demand, Create
Resource Time Entries, Delete Resource, Delete Staging table, Delete
Task From Project Import, Edit Via Browser, mApp Factory - Link
Predecessor, mApp Factory - Link Predecessors 2 & 3, mApp Factory -
Link to Parent, Set Baseline Date - Project, Set Task Status to In Progress
- Timesheet, Set to Assigned, Submit Via Browser, Update Budgets

Overwrite

Business
Objects

Benefit Item, Budget Item, Cost Entry, Operational Task, Operational Task
Status, Operational Task Type, Plans, PPM Action Item, PPM Area, PPM
Change Order, PPM Decision, PPM Demand, PPM Focus Area, PPM
Health Type, PPM Issue, PPM Portfolio, PPM Predecessor Type, PPM
Program, PPM Project, PPM Resource, PPM Resource Plan, PPM
Resource Time, PPM Risk, PPM Scheduled PTO, PPM Scope, PPM
Stakeholder, PPM Status, PPM Status Group, PPM Strategic Objectives,
PPM Timesheet, PPM Type, PredecessorLinksSuccessor, Project Task,
Project Task Staging Table, Task Summary, WatchListLinkTable

Overwrite

Cost Item Don't
Change

Role Import

Calendar My Project Tasks Overwrite

Counters
Action Item ID, Benefit Item ID, Budget Item ID, Demand, Issue,
Operational ID, Portfolio, PPM Project Calendar, Program, Project,
Resource Plan ID, Risk, Strategic Objective

Overwrite

Dashboards
Demand Management, My Portfolio Details, My Projects, My Work - Alt IT,
Overview PPM, Program Details, Project Details, Resource Management -
Individual, Resource Management - Role

Overwrite
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Item
Category Item

Typical
Merge
Action

Fields

1st Quarter, 1st Quarter Remaining, 2nd Quarter, 2nd Quarter Remaining,
3rd Quarter, 3rd Quarter Remaining, 4th Quarter, 4th Quarter Remaining,
5th Quarter, 5th Quarter Remaining, 6th Quarter, 6th Quarter Remaining,
7th Quarter, 7th Quarter Remaining, 8th Quarter, 8th Quarter Remaining,
9th Quarter, 9th Quarter Remaining, 10th Quarter, 10th Quarter
Remaining, 11th Quarter, 11th Quarter Remaining, 12th Quarter, 12th
Quarter Remaining, Action, Action Comments, Action Plan, Actual Effort,
Actual End Date, Actual Hours, Actual Start Date, Allocated Hours Per
Day, Alt 1 Command, Alt 1 Command Name, Alt 1 Next Status, Alt 1 Next
Status Text, Alt 1 Status, Alt 1 Status Text, Alt 2 Command, Alt 2
Command Name, Alt 2 Status, Alt 2 Status Text, Alt Status, Approval
Block ID, Approved, Area, Asset Management, Assigned Role,
Assignments, Available Hours, Available Project Hours, Baseline End
Date, Baseline Start Date, Benefit If Done, Benefit Item ID, Booking Type,
Budget, Budget Cost, Budget End Date, Budget Health, Budget Health
Score, Budget Item ID, Budget Start Date, Budget Term End Date, Budget
Term Start Date, BudgetChangeDetails, BudgetChangeNo,
BudgetChangeYes, Business Driver, Business Objective, Business
Reason, Business Value Score, CapEx Budget, Capital Expenses, Capital
items, Change Order Title, ChildID, ChildJoinReason, ChildType, Closed
Date, Committee Approval Required, Completed Projects, Cost, Cost Item
Type ID, Cost Item Type Name, Cost Type, Counter, Create New Records,
Created By, Created By ID, Created Culture, Created Date Time,
Customer Accepted, Customer Display Name, Customer ID, Customer
Type ID, Daily Hours, Date, Date Completed, Date Of Decision, Date
Opened, Delete record, Delete Resource, Demand Estimated Revenue,
Demand ID, Demand ROI, Demand Score, Demand Size, Demand
Sponsor, Demand Sponsor Email, Department, Dependencies,
Description, Details, Disposition, Driver, Duration, Duration (Hours),
Duration (In Days), Edit Via Browser, Effort, Effort (hours), Effort at Risk,
Email, Employment Type, End Date, End Date Changed, Estimated
Additional Effort, Estimated Capital Expenses, Estimated Cost, Estimated
Effort, Estimated Operating Expenses, Estimated Remaining Effort,
Estimated Revenue, Estimated Total Cost, Executive Approval, Expected
Resolution Date, Facilities, File to Import, Financial Plan, Financial Score,
Financial Score New, Focus Area, Friday, Full Name, Group Name, Health
Issue, Health Type, Hours, Hours Per Day, Hours Per Week, Hours
Worked, HR, Identified as a Risk, Impact, Impact Comments, Impact If
Deferred, Impact on other initiatives, Impact To Scope, Initiated By, Issue
Description, Issue ID, Issue Name, Issues, IT, ITPT Project ID,
JoinReason, Last Mod Time Stamp, Last Modified By, Last Modified By ID,
Last Modified Date Time, LastModTimeStamp, Linked Budget Item ID,
Lock Summary, Locked, Manager, Monday, MS Project Milestone, MS
Project Outline Number, MS Project Parent Outline Number, MS Project
UID, MSProject Milestone, Name, New Projects, Next Status, Next Status
Command, Next Status Command Name, Next Status One-Step, Next
Status Text, No One Step, Notes, Objective, Old End Date, Old Start Date,
Open Date, Operating Expense items, Operating Expenses, Operational
Hours, Operational Hours per Day, Operational Hours per Week,
Operational Percent, Operational Task, Operational Task ID, Operational
Task Name, Operational Task RecID, Operational Tasks, OperationalTask
Type ID, OperationalTask Type Name, OpEx Budget, Original Total, Other,
Overall Score, Owned By, Owned By Email, Owned By ID, Owned By
Manager, Owned By Manager Email, Owned By Manager ID, Owned By
Manager Phone, Owned By Phone, Owned By Team, Owned By Team ID,
Parent ID, Parent RecID, ParentID, ParentType, ParentType, Percent
Complete, Percent of Demand, Percent of demand Unshown, Percentage,
Phone, Planned Effort, Planned End Date, Planned Remaining Effort,
Planned Start Date, Plans Type ID, Plans Type Name, Portfolio, Portfolio
Approved, Portfolio Budget, Portfolio Flag, Portfolio ID, Portfolio Manager,
Portfolio Manager Email, Portfolio Manager ID, Portfolio Name, Portfolio
ROI, PPM Action Item ID, PPM Decision ID, PPM Group, PPM Health
Type ID, PPM Portfolio ID, PPM Program ID, PPM Project ID, PPM
Project RecID, PPM Resource ID, PPM Resource Plan ID, PPM Resource
Time ID, PPM Risk ID, PPM Scope ID, PPM Stakeholder ID, PPM Status
Groups ID, PPM Status ID, PPM Strategic Objectives ID, PPM Timesheet
ID, Pred Task Type 1, Pred Task Type 2, Pred Task Type 3, Predecessor
1, Predecessor 1 Name, Predecessor 1 RecID, Predecessor 2,
Predecessor 2 Name, Predecessor 2 RecID, Predecessor 3, Predecessor
3 Name, Predecessor 3 RecID, , Predecessor UID 1, Predecessor UID 2,
Predecessor UID 3, Predecessor XML Parsing, Predecessor XML Parsing
2, Predecessor XML Parsing 3, Primary Stakeholder, Primary Strategic
Objective, Priority, Probability, Probability score, Probability Weight,
Process, Program, Program Budget, Program ID, Program Manager,
Program Manager Email, Program Manager ID, Program Name, Project,
Project Approval, Project Estimated Hours, Project Health Update, Project
ID, Project Manager, Project Task ID, Project Task Records for Import,
Project Tasks, PTO, PTO Hours, Quarter, RecID, Record Saved, Rejected,
Remaining Availability, Remaining budget, Remaining Effort, Requested
By, Requested By Team, Requested Completion Date, Requested Start
Date, Required By, Resolution, Resource, Resource ID, Resource
Percentage, Resource Plan ID, Resource Score, Resources, Risk, Risk
Score, Risk Score Weight, Risks, ROI, Role, Role ID, Saturday, Schedule
Health, Schedule Health Score, ScheduleChangeDetails,
ScheduleChangeNo, ScheduleChangeYes, Scheduled End Date,
Scheduled Start Date, Scope, Scope Change Yes, Scope Health, Scope
Health Score, ScopeChangeDetails, ScopeChangeNo, Score, Score
Calculated, Score Resource, Security, Selected Status, Site, Skill(s),
Softbook Hours Per Day, Softbooked Resources, Sponsor, Sponsor ID,
Stakeholder, Start Date, Start Date Changed, Status, Status Order,
Strategic Objective, Strategic Objectives ID, Subject, Submitted,
Submitted Via Browser, Sunday, Target Date, Task, Task Number, Task
Title, Task Type, temp_status_set, Thursday, Timesheet ID, Title, Total,
Total Budget, Total Budget Committed, Total Budget Remaining, Total
Closed Budgets, Total Cost, Total Effort, Total Hours, Total hours for
Demand, Total Open Budgets, Total Return, Total Revenue, T-Shirt Size,
Tuesday, Type, Update Ran, Updated Via Import, Updated via Parent,
Updating Tasks, Updating Tasks Completed, User Info RecId, Valid, Valid
Approver, Value Description, Wednesday, Week Of, Weekly Hours,
Weekly Total, Weighting, Work Week Hours, Year 1, Year 1 Benefit, Year 1
Budget, Year 1 Cost, Year 1 Remaining, Year 2, Year 2 Benefit, Year 2
Budget, Year 2 Cost, Year 2 Remaining, Year 3, Year 3 Benefit, Year 3
Budget, Year 3 Cost, Year 3 Remaining

Overwrite
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Item
Category Item

Typical
Merge
Action

Forms

ActionItem, BenefitPlan, BudgetItem-ProjectForm, CostEntry,
CostItemEntry, Demand, Demand Financial Assessment, Demand
Overview, Issue, ITPTArea, OperationalTaskStatus, OperationalTaskType,
Portfolio, Portfolio Overview, PPM Program Overview, PPM ProjectTask
Overview, PPMChangeOrder, PPMDecision, PPMDemand Risk,
PPMDemand Summary, PPMFocusArea, PPMHealthType, PPMPortfolio
Summary, PPMPredecessorType, PPMProgram Summary, PPMProject,
PPMResourceTime, PPMScope, PPMStakeholder, PPMStatus,
PPMStatusGroup, PPMStrategicObjectives Summary, PPMTasks,
PPMTimesheet Overview, PPMType, Program, Project Header,
ProjectSummary, ProjectTaskSupportingTable

Overwrite

Form
Arrangements

PPMDemand, PPMPortfolio, PPMProgram, PPMResourcePlan,
PPMResourceTime, PPMStrategicObjectives, PPMTask, PPMTimesheet,
Project, ProjectTaskStagingTable, Resource, TaskSummary

Overwrite

Grids

ActionItem, BenefitPlan, CostEntry-Grid, CostItemEntry, Demand, Issue,
ITPTArea, ITPTDemandRisk, ITPTFocusArea, ITPTPredecessorType,
ITPTStakeholder, ITPTType, OperationalTask, OperationalTaskStatus,
OperationalTaskType, Plans, Portfolio, PPMActionItem1,
PPMChangeOrderGrid, PPMDecision, PPMDemand Dashboard,
PPMHealthType, PPMPortfolio Dashboard, PPMProject Dashboard,
PPMProject-Simple, PPMResourceTime, PPMRisk1, PPMScope,
PPMStakeholder-2, PPMStatus, PPMStatusGroup,
PPMStrategicObjectives-Grid, PPMStrategicObjectives-Portfolio,
PPMTasks, Program, Proj Details Dashboard Grid, Project, ProjectTask for
Project, ProjectTaskSupportingTable, Resource, ResourcePlan, Role,
ScheduledPTO, StrategicObjectives, TaskSummary, Timesheet,
Timesheet Dashboard, WatchListLinkTable

Overwrite

Image
Definitions

Demand100x100, Demand-Icon, DemandNew100x100, Exec-Icon, Home-
Icon, Milestone100x100, My-Portfolio-Icon, My-Projects-Icon, My-Work-
Icon, Operational Task Icon100x100, Portfolio100x100, PPM-Double-
Arrows, Program100x100, Program-Details-Icon, Project Task100x100,
Project100x100, Project-Details-Icon, PTO100x100, Resource
Plan100x100, Resource100x100, Resources-Icon, Role100x100, Role-
Icon, Role-Icon-100x100, Strategic Objectives100x100, Task
Summary100x100, Timesheet100x100, White Arrow

Overwrite
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Item
Category Item

Typical
Merge
Action

Indexes

BenefitItem_BenefitItemID, Demand_DemandID, Issue_IssueID,
OperationalTask_OperationalTaskID, PK_ActionItem, PK_CostItem,
PK_Demand, PK_Issue, PK_ITPTArea, PK_ITPTFocusArea,
PK_ITPTPredecessorType, PK_ITPTType, PK_OperationalTask,
PK_OperationalTaskStatus, PK_OperationalTaskType, PK_Plans,
PK_Portfolio, PK_PPMDecision, PK_PPMHealthType,
PK_PPMResourceTime, PK_PPMScope, PK_PPMStakeholder,
PK_PPMStatus, PK_PPMStatusGroup, PK_PredecessorLinksSuccessor,
PK_Program, PK_ProjectTaskSupportingTable, PK_Resource,
PK_ResourcePlan, PK_Role, PK_ScheduledPTO,
PK_StrategicObjectives, PK_Timesheet, PK_WatchListLinkTable,
Portfolio_PortfolioID, PPMActionItem_PPMActionItemID,
PPMChangeOrderIdx0, PPMDecision_PPMDecisionID,
PPMHealthType_PPMHealthTypeID, PPMProgram_PPMProgramID,
PPMProjectIdx0, PPMProjectIdx1,
PPMResourceTime_PPMResourceTimeID, PPMRiskIdx0,
PPMScope_PPMScopeID, PPMStakeholder_PPMStakeholderID,
PPMStatus_PPMStatusID, PPMStatusGroup_PPMStatusGroupsID,
PredecessorLinksSuccessorIdx0, ProjectTaskStagingTable_Title,
Resource_FullName, ResourcePlan_ResourcePlanID, Role_Role,
RoleIdx0, StrategicObjectives_StrategicObjectivesID,
Timesheet_TimesheetID

Overwrite

Mergeable
Area

Budget Item Actions, Cost Entry Actions, ITPT Project Actions, PPM
Demand Actions, PPM Demand Approvals, PPM Resource Actions, PPM
Resource Item Actions, PPM Resource Time Actions, PPM Timesheet
Actions, Project Task Actions, Task Summary Actions

Overwrite
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Item
Category Item

Typical
Merge
Action

One-Step™
Actions

Accept Idea, Accept In Portfolio, Add Budget Items to Project, Add To
Portfolio, Alt Step 1 from Relationship, Alt Step 2 from Relationship,
Approval, Approval Denied, Approve, Assign a Project Manager, Assign a
Role, Assign a Team, Assign an Individual, Assign an Initiator, Assign ID -
delete me, Assign to a Project Manager, Assign to Individual, Assign to
Me, Assign to Team, Automation - Update Successors Start Date change,
Change Requester, Check Available Hours, Commit, Commit Hours to
Task, Committee Approval, Committee Denied, Convert Demand to
Service Request, Create Change, Create Committee Approval, Create
Project from Demand, Create Project When Demand Approved, Create
Weekly Timesheets, Date Time Information, Delete Old TimeSheets,
Delete Resource, Delete Staging Table, Delete Tasks, Demand Approved,
Edit, Edit entries, Edit Via Browser, Email Assigned To, Email Portfolio
Manager, Email Program Manager, Email Project Requester, Export XML,
Flag for Delete, Go to Calendar, Go to portfolio record, Go to Program
record, Go to Project Record, Go to Record, Go to the Task, Import CSV
Update to Staging Table, Import into staging table, Import New Project
CSV, Import New Project XML, Import Project, Import Project from CSV,
Import Project Tasks into Staging Table, Import Update to Staging Table,
Link MS Project Predecessor, Link parent, Modify Demand, My Portfolio
Dashboard Button, My Program Dashboard Button, My Project Dashboard
Button, Need More Information, Next Status, Next Status Step, Next Step
from Relationship, Open Task, Owner Email, Portfolio Approved, Portfolio
Approved From Demand, Portfolio Approved From Project, Portfolio follow
Up Email, Portfolio Manager Email, Predecessor 1, Predecessor 2,
Predecessor 3, Project Approved, Refresh, Refresh Cost, Refresh Cost on
Save, Reject Idea, Remove from Deferred, Remove From Portfolio,
Requester Email, Requester Follow Up Email, Resource Daily Time
Entries, Resource Management Individual Selector, Resource
Management Individual Set View - Per Day, Resource Management
Individual Set View - Per Week, Resource Management Individual Update
Dates, Resource Management Update End Date, Resource Management
Update Start Date, Resource Time Cleanup, Save, Select a task, Select a
Team, Select an Individual, Select an Owner, Select Customer, Select
Department, Select Employment Type, Select Name, Select Portfolio
Manager, Select Requester, Select Resource Manager, Select Role, Send
Project Health Update, Set Associated Task to In Progress, Set
BaselineDates, Set Budget Health, Set Flag To Create New Records, Set
Parent Outline Number, Set Planned Dates, Set Predecessor 2&3, Set
Schedule Health, Set Scope Health, Set Status To Deferred, Set to
Assigned, Set to Committed, Set View - Per Day, Set View - Per Week,
Submit, Submit for approval, Submit For Review, Submit Hours to Weekly
Time Sheet, Submit Via Browser, Take Ownership, uncheck, update,
Update Available Hours, Update Budget, Update Budgets, Update
Dashboard, Update Estimated Hours, Update Health, Update Hours,
Update Parent Successor/Child End date, Update Parent Successor/Child
Start Date, Update Parent Time Reporting, Update Percent, Update
Project, Update Project from CSV, Update Project Tasks, Update Project
Tasks Hours, Update pt, Update Resource, Update Resource Time
Bookings, Update Resource Time Entries, Update Start/End Dates,
Update Successor Start Date Change (Finish to Start Process), View Date
Time Information

Overwrite
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Item
Category Item

Typical
Merge
Action

Relationships

Budget Item Owned By PPM Project, Budgets Links to Cost Entries, Cost
Entry Links to Budgets, Cost Entry Owned By PPM Project, Demand Links
Operational Tasks, Demand Links Program, Demand Owns Journals,
Operational Task Links Demand, Operational Task Links Task Summaries,
Operational Tasks Link Resources (PPM Softbook), PPM Action Item
Owned By PPM Project, PPM Change Order Links Users, PPM Change
Order Owned By PPM Project, PPM Decision Owned By PPM Project,
PPM Demand Links Customer, PPM Demand Links PPM Portfolio, PPM
Demand Links PPM Project, PPM Demand Links PPM Resource Plans,
PPM Demand Links PPM Status, PPM Demand Links PPM Strategic
Objectives, PPM Demand Links UserInfo, PPM Demand Owns Approvals,
PPM Demand Owns Benefit Plans, PPM Demand Owns Budget Item,
PPM Demand Owns PPM Demand Risks, PPM Demand Owns
Stakeholders, PPM Demand Owns Stakeholders Committee Approval,
PPM Issue Links UserInfo, PPM Portfolio Links Owned By, PPM Portfolio
Links PPM Demands, PPM Portfolio Links PPM Projects, PPM Portfolio
Links PPM Strategic Objectives-ManyToMany, PPM Portfolio Links User,
PPM Portfolio Owns PPM Issues, PPM Portfolio Owns PPM Programs,
PPM Portfolio Owns PPM Risks, PPM Program Links PPM Projects, PPM
Program Links PPM Strategic Objectives, PPM Program Owned By PPM
Portfolio, PPM Program Owns Journals, PPM Program Owns PPM Issues,
PPM Program Owns UserInfo - Owned By, PPM Program Owns UserInfo -
Program Manager, PPM Project Links Change Requests, PPM Project
Links CustomerPPM Project Links Operational Tasks, PPM Project Links
PPM Demand, PPM Project Links PPM Portfolio, PPM Project Links PPM
Program, PPM Project Links PPM Resource Plans, PPM Project Links
Project Tasks, PPM Project Links to Status, PPM Project Links to
UserInfo, PPM Project Owns Benefit Plans, PPM Project Owns Budget
Items, PPM Project Owns Cost Entry, PPM Project Owns Journals, PPM
Project Owns PPM Action Items, PPM Project Owns PPM Change Orders,
PPM Project Owns PPM Decisions, PPM Project Owns PPM Issues, PPM
Project Owns Risks, PPM Resource Owns PPM Scheduled PTOs, PPM
Resource Plan Links PPM Demand, PPM Resource Plan Links PPM
Project, PPM Resource Time Owned By Resource, PPM Scheduled PTO
Owned By PPM Resource, PPM Strategic Objectives Links PPM
Portfolios, PPM Strategic Objectives Links PPM Programs, PPM
Timesheet Links Task Summaries, Predecessor links Successor, Program
Owned By Demands, Project Task Links PPM Project, Project Task Links
Project Task - Parent, Project Task Links Project Tasks - Children, Project
Task Links Resource Time, Project Task Links Task Summaries, Project
Tasks owns Staging tasks, Resource Links PPM Tasks (Softbooking),
Resource Owns Operational Tasks, Resource Owns PPM Resource
Times, Resource Plan Links Project Tasks, Resource Plan Links Resource
Plans, Resource Plans Links Resource Time, Resource Time Links
Project Task - Allocated, Resource Time Links Project Task Softbook, Role
Links Resource, Staging task owned by project tasks, Stakeholder Links
UserInfo, Sucessor Links Predecessor, Task Summary Links Operational
Task, Task Summary Links PPM Project, Task Summary Links PPM
Timesheet, Task Summary Links ProjectTask, TimeSheet Links PTO

Overwrite

PPM Demand Links Phase Set, PPM Portfolio Links Phases, PPM Project
Links Milestones, PPM Project links Phase Set Import
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Item
Category Item

Typical
Merge
Action

Reports Demand vs Project, Demand vs Project Execution, PPM Project
Snapshot, Weekly Resource Availability by Role Overwrite

Searches

Active Projects, Active within Date Range for Report, All, All Demands, All
Portfolios, All Programs, ALL Project Tasks, All Projects, All Projects
Closed Calendar Year, ALL Resource Plans, All Resources, All staging
records, All Task Summaries, Approved Demands, Awaiting Approval
Demands, Calendar - Child Project Tasks, Calendar - Milestone Project
Tasks, Calendar - Parent Project Tasks, Calendar - Project Tasks,
Committed Projects within Program, Date Range and Role, Deferred
Demands, Demand Matrix, Issues Type is Budget, Issues Type is
Schedule, Issues Type is Scope, My Open Project Tasks, My Open
Projects, My Project Tasks, My Resources, My Task Summaries, My
Timesheets, New Demands, Open Demands, Open Portfolios, Owner
Resource Times, Portfolio Budget Issues, Portfolio Schedule Issues,
Portfolio Scope Issues, Program Issues Type is Schedule, Program Issues
Type is Scope, Program Rec ID equals Stored Value, Project ID equals
Stored ID, Project Task, Project Tasks Owned by My Team, Projects Not In
Portfolio, Projects Open Portfolio, Projects Within Portfolio, Projects within
Program, Resource Allocation Report, Resource Entries Greater Than
Today, Resource Time aged 2 Weeks, Resource Time by Date Range,
Resource Time by Role Dates, Resource Time Dashboard - Individual,
Resource Time Dashboard - Role, Resource Time Owned By, Resources
by Role, Selected Closed Project for Report, Selected Portfolio, Selected
Project for Report, Submitted Timesheets, Task Summaries By Project,
Tasks at Risk

Overwrite
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Item
Category Item

Typical
Merge
Action

Stored
Expressions

# High Impact Open Risks, # of Open Issues, 1st Quarter, 2 Weeks Ago,
2nd Quarter, 2nd Quarter Remaining, 3rd Quarter, 3rd Quarter Remaining,
4th Quarter, 4th Quarter Remaining, 5th Quarter, 6th Quarter, 7th Quarter,
8th Quarter, 9th Quarter, 10th Quarter, 10th Quarter Remaining, 11th
Quarter, 11th Quarter Remaining, 12th Quarter, Actions Visible Only in
Assessing Status, Actual Start Date, All Open Projects, All Task
Summaries, Automation Finish to Start, Budget Health Color Link, Budget
Item ID, Budget Remaining, Business Value, CapEx Budget, Clear
Approver, Clear Executive Approver, Copy of Hours per day, Cost Year 1,
Cost Year 2, Date is Valid, Days per Task, Demand Score, Effort, End of
the Week, Estimated Hours For Project, Financial, Finish to Start, High
Impact Open Risks/Issues Trigger, Hours per Day, Hours per Week,
Logical Field Projects at Risk, Next End of Year, OpEx Budget, Portfolio
Budget Health, Portfolio Budget Remaining, Portfolio Schedule Score
Value, Project ID, Project Name, Project Status, Read Only Background,
Remaining Availability, Remaining Effort For Project, Remove Actions
Visible Only in Assessing Status, Required Fields Review Idea, Resource
Plan ID, risk score, Risk Total, Schedule Health Color Link, Scope Health
Color Link, Set budget Health, Set Schedule Health, Set Scope Health,
Softbooked Resource, Start Date, Start of the Week, Submitted Task
Summaries, System State Email, System State E-mail, Tasks at Risk, test,
Time, Total Budget, Total Budget Committed, Total Cap Expenses rollup,
Total Closed Project Budgets, Total Cost, Total Hours, Total Labor, Total
Op Expenses rollup, Total Open Project Budgets, Total Portfolio Budget
Spent, Total Value, true, Weekly Total, Weeks Per Task, Year 3 Cost

Overwrite

Stored Values

Answer, Budget Health, Budget Issues, Calendar Project ID, Demand
Approval Size, MS Project Outline ID, MS Project Pred UID, Parent End
Date, Portfolio Budget Health, Portfolio Description, Portfolio ID, Portfolio
RecID, Portfolio Schedule Health, Portfolio Scope Health, Portfolio Status,
Portfolio Title, PPM Rec ID, Predecessor 1, Predecessor 2, Predecessor
3, Predecessor End Date, Predecessor RecID, Program Budget Health,
Program Description, Program RecID, Program Schedule Health, Program
Scope Health, Program Status, Program Title, Project Budget Health,
Project Cost Score, Project Description, Project ID, Project RecID, Project
Schedule Health, Project Scope Health, Project Status, Project Title, PTO
End Date, PTO Start Date, Resource, Resource Dashboard - Chart View,
Resource Dashboard End Date, Resource Dashboard Individual,
Resource Dashboard Role, Resource Dashboard Start Date, Resource
RecID, Resource Time Date, Role, Schedule Health, Schedule Issues,
Scope Health, Scope Issues, Start Date Difference, Successor Count,
Successor Count Child, Task RecID, Test First Of Year, Test Iterator,
Working Hours

Overwrite
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Item
Category Item

Typical
Merge
Action

Tabs

Approvals, Action Items, Allocated, Benefit Plan, Benefit Plans, Budget
Items, Budget Plan, Change Orders, Change Requests, Children Task(s),
Cost Items, Decisions, Demand, Demands, Financial Assessment, Issues,
Journals, Operational Tasks, Overview, Parent Task, Portfolio, PPM
Demand, PPM Project, PPM Resource Plans, PPM Resource Time, PPM
Resource Times, PPM Timesheet, Predecessor(s), Program, Programs,
Project, Project Task, Project Task Import, Project Tasks, Projects, PTO,
Resource Plan, Risks, Softbooked, Stakeholders, Strategic Objectives,
Successor(s)

Overwrite

Teams Project Management, Demand Management Overwrite

Widgets

Active Demands - Projected Cost, Active Demands - Projected Revenue,
Actual Project Cost, Actual Project Hours, All Portfolio Budgets, Approved
Projected Revenue - Demand Management, Budget Issues, Budgeted
Project Cost, Committed Project Budget, Committed Project Revenue,
Dashboard Resources, Demand Projects, Demand Requests By Stage,
Demands Awaiting Approval, Incidents and Requests Owned by Me, My
Incident Tickets, My Open Project Tasks, My Open Projects - Details, My
Open Timesheet Count, My Operational Tasks, My Operational Tasks -
Detail, My Priority 1 Incident Tickets, My Priority 1 Service Requests, My
Project Effort, My Project Task Details, My Project Timesheets, My
Projects by Status, My Projects Cost, My Teams Change Requests -
Count, My Teams Open Incidents and Request, My Teams Operational
Tasks, My Teams Problems - Count, My Total Service Requests, My VIP
Incident Tickets, My VIP Service Requests, Number Of Resources, Open
Portfolios, Planned Project Hours, Portfolio Health Matrix, Portfolio Project
Health Matrix, Potential Costs - Demands, Potential Revenue - Demands,
Program Budget Issues, Program Cost by Project, Program IssuesType is
Scope, Program Project Budget, Program Project Health Matrix, Program
Resources by Project, Program Revenue, Program Schedule Issue,
Program Total Budget, Program Total Cost, Project Cost within Portfolio,
Project Effort within Portfolio,Project Health Matrix, Project Issues Total,
Project Risks Total, Project Tasks, Projected Remaining Project Hours,
Projected Revenue - Demand Management, Projects for Consideration
Budget, Projects for Consideration Revenue, Projects Not In Portfolio,
Projects Within Portfolio, Projects within Program, Remaining Budget,
Resource Bar - Daily (Individual), Resource Bar - Daily (Role), Resource
Bar - Weekly (Individual), Resource Bar - Weekly (Role), Schedule Issues,
Scope Issues, Scoring Matrix - Demand Management, Tasks at Risk -
Total, Tasks Behind Schedule, Tasks Starting This Week, Timesheets
Awaiting Approval - Grid, Total Budget of Portfolio, Total Committed
Budgets, Total Cost of All Portfolios, Total Cost of Portfolio, Total Expected
Revenue, Total Revenue

Overwrite
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Item
Category Item

Typical
Merge
Action

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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Integration mApp Solutions
An Integration mApp® Solution integrates with CSM to provide additional functionality or an interface with
other applications or solutions. These integrations can incorporate solutions, platforms, or applications into
CSM.
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AWS mApp Solution 1.0
Use the Amazon Web Services (AWS) mApp Solution to add AWS provisioning scenarios to your Portal
service catalog.

Platform version requirements: Tested on CSM 10.1.0 — 10.2.0.

Content version requirements: Tested on CSM 10.1.0 — 10.2.0. This mApp Solution may or may not be
compatible with content versions earlier than CSM 10.1.0, but as with all mApp Solutions, be sure to test it
on your customized system.

Prerequisites: You must have an AWS account in which you have configured services. Additionally, your
CSM instance must be on a publically accessible server, with an SSL certificate installed.

Available languages: English.

The AWS mApp Solution includes the following item for downloading:

• AWS 1.0.mApp

After the file is downloaded, you can apply the mApp Solution using the Apply mApp wizard in CSM
Administrator.

Overview
The AWS mApp Solution allows Portal users and licensed CSM users to provision an AWS product from
your organization's AWS Service Catalog, such as an EC2 instance, LAMP Stack, RDS instance, or S3
bucket.

Portal users can make an AWS request by choosing Desktop Management > Computer > New CFT in
the Service Catalog.

The Service Request form gathers requester information along with AWS-specific information like
Account, Portfolio, and Region data. The customer then chooses an AWS product and fills out additional
fields based on the product choice. Once the service request is approved, the AWS product is provisioned
via the AWS API. A new Configuration Item (CI) is created for the provisioned product and added to the
CMDB, and the service request is closed. When the instance is no longer needed, customers terminate
the AWS product directly from the CI in CMDB.

Key Features
Use the AWS mApp Solution to:

• Provision an AWS product directly from Cherwell (via the CSM Portal for customers or via the
Desktop Client or Browser Client for users).

• Automatically add provisioned AWS products directly to the Cherwell CMDB, including relevant
details for each.

• Terminate an AWS product directly from CSM.
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• Automatically create Incidents for existing AWS resources in the Cherwell CMDB if a CloudWatch
Alarm goes into alarm state.

This mApp Solution includes multiple features, including direct access to select AWS products in a given
portfolio and secure encryption for AWS access keys. This mApp Solution uses Action Blocks, webhooks,
and direct calls to the AWS API so you don't need to download or synchronize your AWS Products into
the service catalog.

Apply the mApp Solution
Follow these steps to download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

Note: This mApp Solution is not intended to be applied over a previous AWS mApp Solution
version. It is not an upgrade to the previous version.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM. Do not
select Finish yet.

4. Still in the Apply mApp Solution Wizard, when you reach the Final Options window, select Open a
Blueprint so that I can preview the changes, and then select Finish.

5. When the Blueprint opens, select File > Blueprint changes.

6. Save the Blueprint.

Revision History

mApp Solution Version Platform Version
Requirements

Content Version
Requirements Prerequisites

1.0 Tested on 10.1.0 —
10.2.0.

Tested on 10.1.0 —
10.2.0. This mApp
Solution may or may not
be compatible with
content versions earlier
than 10.1.0, but as with all
mApp Solutions, be sure
to test it on your
customized system.

None

Related concepts
AWS mApp Solution Items
Considerations for Applying mApp Solutions

240

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/csh?topicname=apply_a_mapp_considerations
https://help.cherwell.com/csh?topicname=apply_a_mapp
https://help.cherwell.com/bundle/csm_mapps_integrations_help_only/page/content%2Fmapps_and_integrations%2Fmapp_tech_notes%2Faws_mapp%2F..%2F..%2F..%2F..%2Fcontent%2Fmapps_and_integrations%2Fmapp_tech_notes%2Faws_mapp%2Faws_mapp_items.html
https://help.cherwell.com/csh?topicname=apply_a_mapp_considerations


How the AWS mApp Solution Works
The AWS mApp Solution integrates with AWS Service Catalog so CSM Portal customers and CSM users
can directly query the AWS API to provision and terminate the AWS products which their organization has
defined and made available in the AWS Service Catalog Portfolio.

This mApp Solution covers these primary use cases:

• Allow a CSM Portal customer or CSM user to make an AWS request by choosing Desktop
Management > Computer > New CFT in the Service Catalog. When the request is approved, the
resource is provisioned in AWS and added to the Cherwell CMDB.

• Allow a CSM Portal customer or CSM user to terminate AWS resources directly from the Cherwell
CMDB. Portal users can access their AWS CIs by going to My Items.

• Allow a user to manually add existing AWS resources directly to the Cherwell CMDB.

• Create an Incident in CSM for AWS resources that have CloudWatch Alarms in Alarm state, and
associate the Incident to a related CSM configuration item.
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For more details about each of these cases, see:

• Provision an AWS Product from the CSM Portal

• Provision an AWS Product from the Desktop Client or Browser Client

• Manually Add an Existing AWS Configuration Item

• Manage an AWS Configuration Item

• Terminate an AWS Configuration Item from the CSM Portal

• Terminate an AWS Configuration Item from the Desktop Client or Browser Client

CSM Features Leveraged in this mApp Solution
This mApp Solution leverages several features of CSM which are either relatively new or more advanced
topics. This section serves as an overview of those features.

Action Blocks
Action Blocks are similar to One-Step™ Actions, but can be reused across objects by passing in
appropriate object-specific data through parameters.

The provision and terminate use cases in this mApp Solution leverage Action Blocks to make API calls
directly to the AWS API, bypassing the need to import the AWS Service Catalog into CSM.

For more details on the use of Action Blocks in this mApp Solution, see AWS Action Blocks.

Encryption
Every AWS account has a public (Access Key ID) and private key (Secret Key). Keys are stored in the
AWS Account table, with the Secret Key properly encrypted. This key appears as a hashed until
decrypted when needed.

For more details on the use of encryption in this mApp Solution, see AWS Key Encryption or Add AWS
Access Keys to CSM .

Webhooks
This mApp Solution contains webhooks, which enable the automatic creation of CIs and Incidents for
AWS resources.

For more details on the use of webhooks in this mApp Solution, see Configure CSM to Add Incidents for
AWS Product Events and Configure CSM to Add AWS Product Configuration Items to your CMDB
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AWS Action Blocks
This mApp® Solution leverages Action Blocks for the API calls made to AWS. This allows reusable
components, such as the Generate Amazon Signature Action Block to be called multiple times without the
need to recreate the block steps where they need to be used.

Overview
Action Blocks are reusable sets of Actions that are not associated with a Business Object. Instead, they
inherit both specific details (through Parameters) and object context from a One-Step™ Action, where
they are called. This allows actions that need to be repeated to be defined and maintained in a single
block, but used in many places.

This topic covers the Action Blocks used in this mApp Solution and how they can be modified to suit your
organization's needs, if desired. You can also use these Action Blocks as-is to cover the use cases
described in How the AWS mApp Solution Works .

Secure Authentication to AWS
To facilitate authenticated AWS requests, there are two Action Blocks used by CSM to provide secure,
encrypted authentication.

Set Encryption Key
The Set Encryption Key Action Block is called by the Store Secret Key One-Step Action to set the
Encryption Key stored value, if it is empty.

The Set Encryption Key Action Block then checks to see whether the encryption key is currently
populated. If it is, the Action Block cancels, but does not stop running the rest of the Store Secret Key
One-Step Action. Although there is no need to set the encryption key if the value exists for the system, we
do want to continue storing the secret key.
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Generate Amazon Signature
The Generate Amazon Signature Action Block follows the standard Signature Version 4 signing process
from Amazon. See Signature 4. This Action Block is the only one stored in the Blueprint scope as it is
delicate and should not be changed, unless the signing process itself changes. Its reusability means that
each call doesn’t need to add in these authentication steps (which can be difficult to troubleshoot), only
call the Action Block and pass it the correct parameters for the specific API call.

Example: In the SearchProductsAsAdmin call, the Get Products As Admin Action Block calls the
Generate Amazon Signature Action Block in step 2. See Search Products as Admin.
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It then passes header information for the SearchProductAsAdmin call, which will be used by the Generate
Amazon Signature Action Block to authenticate that specific call.
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Request AWS Products
The series of API calls to request an AWS product for a particular customer uses four Action Blocks, one
for each call made. It may use a fifth block if the product contains parameters, but this block does not
correspond to an AWS API call.

1. SearchProductsAsAdmin: The Get Products As Admin Action Block makes this call to obtain a list of
products available for the portfolio that the Service Request customer can access.

2. ListProvisioningArtifacts: The List Provisioning Artifacts Action Block makes this call to obtain the
available provisioining artifacts, needed for the ListLaunchPaths call. It returns the currently active
artifact details.

3. ListLaunchPaths: The List Launch Paths Action Block retrieves the Launch Paths for a product to be
provisioned.

4. DescribeProvisioningParameters: The Describe Provisioning Parameters Action Block queries the
AWS API for the parameters needed by a particular product to make the provisioning call.

a. (Optional) If the AWS product contains required parameters, CSM will run the Set Provisioning
Parameters Action Block to populate the details needed on the Service Request specifics
form.

Note: The required parameters are different for any given product, and are set in the CFT of
the product in the AWS Service Catalog.

Provision AWS Product
Once you have completed the request workflow above, you can submit your request for approval. Once
approved, this request automatically fires the ProvisionProduct API call, stored in an Action Block of the
same name. See Provision Product.

When the Service Request was created, all the details necessary for the provisioning are passed to this
Action Block. If the AWS product contained required parameters, CSM will run the Update Provisioning
Parameters Action Block as the first step in the Provision Product call, to gather any details that were
entered by the user on the request.

Terminate AWS Product
The Terminate Provisioned Product Action Block makes the TerminateProvisionedProduct API call. See
Terminate Provisioned Product. Again, this Action Block receives all specific details from the One-Step™
Action which calls it. This call terminates any resources associated to a given product. Once they are
terminated in AWS, they cannot be retrieved.
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AWS Key Encryption
This mApp® Solution uses AWS Access keys to make direct API calls to AWS. These keys are securely
encrypted and used in the Generate Amazon Signature Action Block to generate a signature according to
Amazon's sig4 signing process.

This topic covers the encryption process in this mApp Solution as well as some CSM encryption best
practices. For details about how to authenticate with keys after applying this mApp Solution, see
Configure AWS IAM for CSM and Add AWS Access Keys to CSM .

Encrypt Sensitive Data
To use this mApp Solution, your system is required to store private API keys in the database. You should
rotate these keys as per AWS recommendation. For more details, see Best practices for managing AWS
access keys.

Note: While there is field-level encryption available in CSM, it is not designed to be used for
values required in expressions and One-Step™ Actions. Instead, use the encryption modifier for
these values.

There are three components needed for encryption with a modifier:

• Encryption Key: The Encryption Key is designed to be a global key unique to your CSM instance.
When you apply the mApp Solution, this value will be blank. It will be set the first time you enter an
encrypted value for your system, using the Set Encryption Key Action Block.

• Nonce: The nonce changes per encrypted value. A nonce is generated automatically for every
record in the AWS Account table, where key values are stored.

• Value to be encrypted: In this case the secret key part of the AWS Access key

Important: The encryption modifier uses both the Encryption key and the nonce values to encrypt
and decrypt the AWS secret key value. Once a value has been encrypted using the key and
nonce values, you will need those same values to decrypt it. Ensure that your nonce and
encryption key values are not overwritten or accidentally changed as this would leave you unable
to decrypt these values and make authenticated calls to the AWS API.

Secure Authentication to AWS
To facilitate authenticated AWS requests, there are two Action Blocks used by CSM to provide secure,
encrypted authentication.

Set Encryption Key
The Set Encryption Key Action Block is called by the Store Secret Key One-Step Action to set the
Encryption Key stored value, if it is empty.
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The Set Encryption Key Action Block then checks to see whether the encryption key is currently
populated. If it is, the Action Block cancels, but does not stop running the rest of the Store Secret Key
One-Step Action. Although there is no need to set the encryption key if the value exists for the system, we
do want to continue storing the secret key.

Generate Amazon Signature
The Generate Amazon Signature Action Block follows the standard Signature Version 4 signing process
from Amazon. See Signature 4. This Action Block is the only one stored in the Blueprint scope as it is
delicate and should not be changed, unless the signing process itself changes. Its reusability means that
each call doesn’t need to add in these authentication steps (which can be difficult to troubleshoot), only
call the Action Block and pass it the correct parameters for the specific API call.

Example: In the SearchProductsAsAdmin call, the Get Products As Admin Action Block calls the
Generate Amazon Signature Action Block in step 2. See Search Products as Admin.
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It then passes header information for the SearchProductAsAdmin call, which will be used by the Generate
Amazon Signature Action Block to authenticate that specific call.
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Decryption and Use of the AWS Secret Key
This mApp Solution implements the AWS Signature Version 4 (sig4) signing process within the Generate
Amazon Signature Action Block. This block handles key decryption at the point where the key is used, to
ensure that it is decrypted at the last possible moment. At no point is the secret key value stored or output
to plain text.
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Grant AWS Account Access to CSM Users
This mApp® Solution has been configured to expect AWS Access keys at the organizational level. You
may have a single or multiple keys; however, you do not need a key for every CSM user who will need
access to AWS products. Rather, this access is granted by linking departments in CSM to portfolios in
AWS.

This topic covers the method by which this access has been granted. Use the approach as-is, or modify it
to suit your organizational needs.

Design Requirements for AWS Account Access
When designing the AWS Account access for customers in this mApp Solution, there are three
requirements:

1. Customers should inherit their portfolio permissions from their department.

2. Customers could have access to multiple portfolios within a single account, or even multiple
accounts. Therefore, access should be granted via AWS portfolios, rather than directly to accounts.
Granting access via portfolios provided flexibility to offer multi-account access, while still limiting said
access only to the portfolios deemed appropriate within any accounts.

3. Design should be as simple to edit as possible, while still meeting the first two requirements.

To meet these requirements, we implemented a multi-layered approach, outlined in detail below.

Inherit Portfolio Access from Departments
When a customer makes a request for an AWS product, their department information has been auto-
populated on the Service Request by default, in Incident.Department. CSM then compares the
department stored on the Service Request with a comma-separated list of departments on the AWS
Account table to check whether the customer's department has access to this account.

CSM limits the accounts in the drop-down menu on the Specifics - AWS Provision form to only those
where it can confirm a department match.
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Link Departments to AWS Account Records
Because departments are linked only to portfolios, but portfolios can only exist in the context of an AWS
account, we established some automated updating of the AWS Account table, using Automatic Actions on
the AWS Portfolio Business Object. When an AWS Portfolio record is saved, any departments linked that
portfolio will update on the related AWS account record as well.

The Update Valid Departments on the Account One-Step™ Action happens on save of any portfolio
record. It first navigates to the related AWS Account record, and then checks all portfolios tied to this AWS
Account. From that check, it then builds a single list of valid departments and updates that list on the AWS
Account record. By checking all related portfolios in addition to the one being saved, we can avoid
duplication of departments in the valid departments list.
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Change Portfolio Access
If you want to change portfolio access to another approach, you could modify the related expressions and
One-Step™ Action to use different criteria.

You can also provide access to every CSM user via a personal AWS Access Key, and remove these
account restrictions altogether. Consider your organization's security policies and needs for your
implementation.
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Apply the AWS mApp Solution
Prior to installing the AWS mApp Solution, you must have an established AWS instance, including
products (defined by CloudFormation Templates [CFTs]) located inside portfolios in AWS Service Catalog.
The approval process included in the mApp Solution will need to be customized to your organization's
requirements. You will also need to update security rights for the Specifics - AWS Provision form so it can
be viewed on the CSM Portal.

To apply the mApp Solution:

1. Download the mApp Solution.
2. Apply the mApp Solution using the Apply mApp Wizard in CSM Administrator.
3. You can choose Make reasonable decisions, but ask me if unsure, and then select Next until

you get to the Summary of Selected mApp Changes to Apply window.
4. Review the summary of changes and ensure everything looks good for your implementation. Save

to file if you wish. Select Next.
5. Select Open a Blueprint so that I can preview the changes.
6. Select Finish.

The Blueprint builds and opens.
7. We recommend saving and scanning the Blueprint prior to publishing. If you are using a Globalized

environment, choose Update validation foreign keys. Select Publish.
The Blueprint should publish without error and the changes will apply to your database.
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Configure the AWS mApp Solution
This topic covers the steps to configure the AWS mApp Solution using CSM Administrator and AWS
Console. There are global configuration items, which need to be completed for any mApp Solution
functionality to work, and use-case specific configuration items.

The configuration requirements for mApp Solutions vary depending on your existing environment and the
setup in your AWS account. Review each topic in this section to determine which areas need to be
manually configured.

Configuration by AWS Service
These services need to be enabled and configured for the AWS mApp Solution to work.

1. Identity and Access Management (IAM).

2. Service Catalog.

3. Simple Notification Service (SNS).

Configuration for CSM
Complete the following procedures to configure this mApp Solution. Configuration procedures are
completed in the Desktop Client and CSM Administrator.

Complete these steps for the AWS mApp Solution to work.

1. Configure Security Groups.

2. Add AWS Access Keys to CSM.

3. Add Departments to the AWS Portfolio Supporting Object.

Configure these steps to support specific mApp Solution use cases.

• Configure CSM to Add AWS Product Configuration Items to your CMDB.

• Configure CSM to Add Incidents for AWS Product Events.
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Required AWS Services
This mApp® Solution relies on these AWS Services to be enabled in your account: AWS Identity and
Access Management (IAM), AWS Service Catalog, AWS Simple Notification Service (SNS), AWS Config,
AWS CloudWatch and, optionally, AWS EventBridge. If your organization does not use these services,
you may need to modify core functionality in the mApp Solution for proper integration.

For more details on specific setup steps for each service and how the mApp Solution uses each, see the
related topics for each service.
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Configure AWS IAM for CSM
Before you can connect to the AWS API, you will need to set up a pair of access keys in your AWS
account.

Your specific AWS account should be set up according to your organization's security policies and AWS
best practices. For CSM to connect via the AWS API, you must create access keys for use by the
application. This can be done using a single key pair to connect for the organization, or it can be done on
a user level. This mApp® Solution assumes the organization will use a single key pair for the entire
organization, and rotate that key on an appropriate schedule.

Note: Make sure that the Identity and Access Management (IAM) user for which you generate
these keys has the following permissions:

• AWSServiceCatalogAdminReadOnlyAccess

• AmazonS3ReadOnlyAccess

• AmazonEC2ReadOnlyAccess

Access to individual CSM users is granted through CSM. Individual customers should belong to a
department, and departments should be granted access to an AWS Portfolio. For more information, see
Grant AWS Account Access to CSM Users or Add Departments to the AWS Portfolio Supporting Object.

Note: Make sure that the Identity and Access Management (IAM) user for which you generated
the key also has access to any portfolios in your AWS account.

To set up AWS IAM for CSM:

1. In the AWS console, navigate to AWS Identity and Access Management.
2. Follow the steps outlined in Managing Access Keys for IAM Users to generate a key pair for use

with this integration. Save these access keys prior to completing Add AWS Access Keys to CSM.
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Configure AWS Service Catalog for CSM
This mApp® Solution expects that your AWS products will be stored inside a portfolio in AWS Service
Catalog. The integration also supports multiple portfolios, but this is not required.

To configure the AWS Service Catalog:

1. Log into the AWS console and navigate to Service Catalog.
2. Follow the steps outlined in the Getting Started section of AWS Service Catalog documentation (see

Getting Started). Complete these steps prior to setting up Add Departments to the AWS Portfolio
Supporting Object. Ensure that you have at least one portfolio here and your products are stored
inside it.

3. Select AWS Service catalog. This mApp Solution assumes that Service Catalog and portfolio are
used, even if you have only one.

Service Catalog End User Baseline Permissions

4. If you have not already done so, you will need to make sure the CFTs in the Service Catalog have
the correct IAM roles and security to run.

5. Add the following permissions (policies) to the user whose keys you will use to call the API:
a. AWSServiceCatalogAdminReadOnlyAccess (AWS managed policy)
b. AmazonS3ReadOnlyAccess (AWS managed policy)
c. AmazonEC2ReadOnlyAccess (AWS managed policy)
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Sample CFT for an EC2 Instance
This is the sample CloudFormation Template (CFT) used to create RDS instances for testing this mApp®
Solution. Because this mApp Solution pulls information dynamically via the AWS API, request details for
provisioning the RDS samples in this integration come directly from this CFT.

            AWSTemplateFormatVersion: '2010-09-09'
Description: >-
  AWS CloudFormation Sample Template EC2InstanceWithSecurityGroupSample: Cr
eate an Amazon EC2 instance running the Amazon Linux AMI. The AMI is chose
n based on the region in which the stack is run. This example creates an EC
2 security group for the instance to give you SSH access. **WARNING** This 
template creates an Amazon EC2 instance. You will be billed for the AWS res
ources used if you create a stack from this template.
Parameters:
  Environment:
    Description: Can be test or prod
    Type: String
    AllowedValues:
      - test
      - prod
    Default: test
  KeyName:
    Description: Name of an existing EC2 KeyPair to enable SSH access to th
e instance
    Type: 'AWS::EC2::KeyPair::KeyName'
    Default: aws-bastion
    ConstraintDescription: must be the name of an existing EC2 KeyPair.
  InstanceType:
    Description: WebServer EC2 instance type
    Type: String
    Default: t2.small
    AllowedValues:
      - t1.micro
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      - t2.nano
      - t2.micro
      - t2.small
      - t2.medium
      - t2.large
      - m1.small
      - m1.medium
      - m1.large
      - m1.xlarge
      - m2.xlarge
      - m2.2xlarge
      - m2.4xlarge
      - m3.medium
      - m3.large
      - m3.xlarge
      - m3.2xlarge
      - m4.large
      - m4.xlarge
      - m4.2xlarge
      - m4.4xlarge
      - m4.10xlarge
      - c1.medium
      - c1.xlarge
      - c3.large
      - c3.xlarge
      - c3.2xlarge
      - c3.4xlarge
      - c3.8xlarge
      - c4.large
      - c4.xlarge
      - c4.2xlarge
      - c4.4xlarge
      - c4.8xlarge
      - g2.2xlarge
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      - g2.8xlarge
      - r3.large
      - r3.xlarge
      - r3.2xlarge
      - r3.4xlarge
      - r3.8xlarge
      - i2.xlarge
      - i2.2xlarge
      - i2.4xlarge
      - i2.8xlarge
      - d2.xlarge
      - d2.2xlarge
      - d2.4xlarge
      - d2.8xlarge
      - hi1.4xlarge
      - hs1.8xlarge
      - cr1.8xlarge
      - cc2.8xlarge
      - cg1.4xlarge
    ConstraintDescription: must be a valid EC2 instance type.
  SSHLocation:
    Description: The IP address range that can be used to SSH to the EC2 in
stances
    Type: String
    MinLength: '9'
    MaxLength: '18'
    Default: 0.0.0.0/0
    AllowedPattern: '(\d{1,3})\.(\d{1,3})\.(\d{1,3})\.(\d{1,3})/(\d{1,2})'
    ConstraintDescription: must be a valid IP CIDR range of the form x.x.x.
x/x.
Mappings:
  AWSInstanceType2Arch:
    t1.micro:
      Arch: PV64
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    t2.nano:
      Arch: HVM64
    t2.micro:
      Arch: HVM64
    t2.small:
      Arch: HVM64
    t2.medium:
      Arch: HVM64
    t2.large:
      Arch: HVM64
    m1.small:
      Arch: PV64
    m1.medium:
      Arch: PV64
    m1.large:
      Arch: PV64
    m1.xlarge:
      Arch: PV64
    m2.xlarge:
      Arch: PV64
    m2.2xlarge:
      Arch: PV64
    m2.4xlarge:
      Arch: PV64
    m3.medium:
      Arch: HVM64
    m3.large:
      Arch: HVM64
    m3.xlarge:
      Arch: HVM64
    m3.2xlarge:
      Arch: HVM64
    m4.large:
      Arch: HVM64
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    m4.xlarge:
      Arch: HVM64
    m4.2xlarge:
      Arch: HVM64
    m4.4xlarge:
      Arch: HVM64
    m4.10xlarge:
      Arch: HVM64
    c1.medium:
      Arch: PV64
    c1.xlarge:
      Arch: PV64
    c3.large:
      Arch: HVM64
    c3.xlarge:
      Arch: HVM64
    c3.2xlarge:
      Arch: HVM64
    c3.4xlarge:
      Arch: HVM64
    c3.8xlarge:
      Arch: HVM64
    c4.large:
      Arch: HVM64
    c4.xlarge:
      Arch: HVM64
    c4.2xlarge:
      Arch: HVM64
    c4.4xlarge:
      Arch: HVM64
    c4.8xlarge:
      Arch: HVM64
    g2.2xlarge:
      Arch: HVMG2
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    g2.8xlarge:
      Arch: HVMG2
    r3.large:
      Arch: HVM64
    r3.xlarge:
      Arch: HVM64
    r3.2xlarge:
      Arch: HVM64
    r3.4xlarge:
      Arch: HVM64
    r3.8xlarge:
      Arch: HVM64
    i2.xlarge:
      Arch: HVM64
    i2.2xlarge:
      Arch: HVM64
    i2.4xlarge:
      Arch: HVM64
    i2.8xlarge:
      Arch: HVM64
    d2.xlarge:
      Arch: HVM64
    d2.2xlarge:
      Arch: HVM64
    d2.4xlarge:
      Arch: HVM64
    d2.8xlarge:
      Arch: HVM64
    hi1.4xlarge:
      Arch: HVM64
    hs1.8xlarge:
      Arch: HVM64
    cr1.8xlarge:
      Arch: HVM64
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    cc2.8xlarge:
      Arch: HVM64
  AWSInstanceType2NATArch:
    t1.micro:
      Arch: NATPV64
    t2.nano:
      Arch: NATHVM64
    t2.micro:
      Arch: NATHVM64
    t2.small:
      Arch: NATHVM64
    t2.medium:
      Arch: NATHVM64
    t2.large:
      Arch: NATHVM64
    m1.small:
      Arch: NATPV64
    m1.medium:
      Arch: NATPV64
    m1.large:
      Arch: NATPV64
    m1.xlarge:
      Arch: NATPV64
    m2.xlarge:
      Arch: NATPV64
    m2.2xlarge:
      Arch: NATPV64
    m2.4xlarge:
      Arch: NATPV64
    m3.medium:
      Arch: NATHVM64
    m3.large:
      Arch: NATHVM64
    m3.xlarge:
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      Arch: NATHVM64
    m3.2xlarge:
      Arch: NATHVM64
    m4.large:
      Arch: NATHVM64
    m4.xlarge:
      Arch: NATHVM64
    m4.2xlarge:
      Arch: NATHVM64
    m4.4xlarge:
      Arch: NATHVM64
    m4.10xlarge:
      Arch: NATHVM64
    c1.medium:
      Arch: NATPV64
    c1.xlarge:
      Arch: NATPV64
    c3.large:
      Arch: NATHVM64
    c3.xlarge:
      Arch: NATHVM64
    c3.2xlarge:
      Arch: NATHVM64
    c3.4xlarge:
      Arch: NATHVM64
    c3.8xlarge:
      Arch: NATHVM64
    c4.large:
      Arch: NATHVM64
    c4.xlarge:
      Arch: NATHVM64
    c4.2xlarge:
      Arch: NATHVM64
    c4.4xlarge:
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      Arch: NATHVM64
    c4.8xlarge:
      Arch: NATHVM64
    g2.2xlarge:
      Arch: NATHVMG2
    g2.8xlarge:
      Arch: NATHVMG2
    r3.large:
      Arch: NATHVM64
    r3.xlarge:
      Arch: NATHVM64
    r3.2xlarge:
      Arch: NATHVM64
    r3.4xlarge:
      Arch: NATHVM64
    r3.8xlarge:
      Arch: NATHVM64
    i2.xlarge:
      Arch: NATHVM64
    i2.2xlarge:
      Arch: NATHVM64
    i2.4xlarge:
      Arch: NATHVM64
    i2.8xlarge:
      Arch: NATHVM64
    d2.xlarge:
      Arch: NATHVM64
    d2.2xlarge:
      Arch: NATHVM64
    d2.4xlarge:
      Arch: NATHVM64
    d2.8xlarge:
      Arch: NATHVM64
    hi1.4xlarge:

270

CSM mApp Solutions

CSM mApp Solutions



      Arch: NATHVM64
    hs1.8xlarge:
      Arch: NATHVM64
    cr1.8xlarge:
      Arch: NATHVM64
    cc2.8xlarge:
      Arch: NATHVM64
  AWSRegionArch2AMI:
    us-east-1:
      PV64: ami-2a69aa47
      HVM64: ami-6869aa05
      HVMG2: ami-22b68b59
    us-west-2:
      PV64: ami-7f77b31f
      HVM64: ami-7172b611
      HVMG2: ami-be4ea3c6
    us-west-1:
      PV64: ami-a2490dc2
      HVM64: ami-31490d51
      HVMG2: ami-cfe5cfaf
    eu-west-1:
      PV64: ami-4cdd453f
      HVM64: ami-f9dd458a
      HVMG2: ami-aedb26d7
    eu-west-2:
      PV64: NOT_SUPPORTED
      HVM64: ami-886369ec
      HVMG2: NOT_SUPPORTED
    eu-central-1:
      PV64: ami-6527cf0a
      HVM64: ami-ea26ce85
      HVMG2: ami-40b8102f
    ap-northeast-1:
      PV64: ami-3e42b65f
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      HVM64: ami-374db956
      HVMG2: ami-d95aabbf
    ap-northeast-2:
      PV64: NOT_SUPPORTED
      HVM64: ami-2b408b45
      HVMG2: NOT_SUPPORTED
    ap-southeast-1:
      PV64: ami-df9e4cbc
      HVM64: ami-a59b49c6
      HVMG2: ami-15660276
    ap-southeast-2:
      PV64: ami-63351d00
      HVM64: ami-dc361ebf
      HVMG2: ami-0b5a4168
    ap-south-1:
      PV64: NOT_SUPPORTED
      HVM64: ami-ffbdd790
      HVMG2: ami-f4cdb79b
    us-east-2:
      PV64: NOT_SUPPORTED
      HVM64: ami-f6035893
      HVMG2: NOT_SUPPORTED
    ca-central-1:
      PV64: NOT_SUPPORTED
      HVM64: ami-730ebd17
      HVMG2: NOT_SUPPORTED
    sa-east-1:
      PV64: ami-1ad34676
      HVM64: ami-6dd04501
      HVMG2: NOT_SUPPORTED
    cn-north-1:
      PV64: ami-77559f1a
      HVM64: ami-8e6aa0e3
      HVMG2: NOT_SUPPORTED

272

CSM mApp Solutions

CSM mApp Solutions



Resources:
  EC2Instance:
    Type: 'AWS::EC2::Instance'
    Properties:
      InstanceType:
        Ref: InstanceType
      SecurityGroups:
        - Ref: InstanceSecurityGroup
      KeyName:
        Ref: KeyName
      ImageId:
        'Fn::FindInMap':
          - AWSRegionArch2AMI
          - Ref: 'AWS::Region'
          - 'Fn::FindInMap':
              - AWSInstanceType2Arch
              - Ref: InstanceType
              - Arch
  InstanceSecurityGroup:
    Type: 'AWS::EC2::SecurityGroup'
    Properties:
      GroupDescription: Enable SSH access via port 22
      SecurityGroupIngress:
        - IpProtocol: tcp
          FromPort: '22'
          ToPort: '22'
          CidrIp:
            Ref: SSHLocation
Outputs:
  InstanceId:
    Description: InstanceId of the newly created EC2 instance
    Value:
      Ref: EC2Instance
  AZ:
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    Description: Availability Zone of the newly created EC2 instance
    Value:
      'Fn::GetAtt':
        - EC2Instance
        - AvailabilityZone
  PublicDNS:
    Description: Public DNSName of the newly created EC2 instance
    Value:
      'Fn::GetAtt':
        - EC2Instance
        - PublicDnsName
  PublicIP:
    Description: Public IP address of the newly created EC2 instance
    Value:
      'Fn::GetAtt':
        - EC2Instance
        - PublicIp
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Sample CFT for an RDS Instance
This is the sample CloudFormation Template (CFT) used to create RDS instances for testing this mApp®
Solution. Because this mApp Solution pulls information dynamically via the AWS API, request details for
provisioning the RDS samples in this integration come directly from this CFT.

            {
   "AWSTemplateFormatVersion":"2010-09-09",
   "Description":"AWS CloudFormation Sample Template RDS_with_DBParameterGr
oup: Sample template showing how to create an Amazon RDS Database Instance 
with a DBParameterGroup.**WARNING** This template creates an Amazon Relatio
nal Database Service database instance. You will be billed for the AWS reso
urces used if you create a stack from this template.",
   "Parameters":{
      "DBName":{
         "Default":"MyDatabase",
         "Description":"The database name",
         "Type":"String",
         "MinLength":"1",
         "MaxLength":"64",
         "AllowedPattern":"[a-zA-Z][a-zA-Z0-9]*",
         "ConstraintDescription":"must begin with a letter and contain onl
y alphanumeric characters."
      },
      "DBUser":{
         "NoEcho":"true",
         "Description":"The database admin account username",
         "Type":"String",
         "MinLength":"1",
         "MaxLength":"16",
         "AllowedPattern":"[a-zA-Z][a-zA-Z0-9]*",
         "ConstraintDescription":"must begin with a letter and contain onl
y alphanumeric characters."
      },
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      "DBPassword":{
         "NoEcho":"true",
         "Description":"The database admin account password",
         "Type":"String",
         "MinLength":"8",
         "MaxLength":"41",
         "AllowedPattern":"[a-zA-Z0-9]*",
         "ConstraintDescription":"must contain only alphanumeric characters
."
      }
   },
   "Resources":{
      "MyDB":{
         "Type":"AWS::RDS::DBInstance",
         "Properties":{
            "DBName":{
               "Ref":"DBName"
            },
            "AllocatedStorage":"5",
            "DBInstanceClass":"db.t2.small",
            "Engine":"MySQL",
            "EngineVersion":"5.7.22",
            "MasterUsername":{
               "Ref":"DBUser"
            },
            "MasterUserPassword":{
               "Ref":"DBPassword"
            }
         }
      }
   },
   "Outputs":{
      "JDBCConnectionString":{
         "Description":"JDBC connection string for the database",
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         "Value":{
            "Fn::Join":[
               "",
               [
                  "jdbc:mysql://",
                  {
                     "Fn::GetAtt":[
                        "MyDB",
                        "Endpoint.Address"
                     ]
                  },
                  ":",
                  {
                     "Fn::GetAtt":[
                        "MyDB",
                        "Endpoint.Port"
                     ]
                  },
                  "/",
                  {
                     "Ref":"DBName"
                  }
               ]
            ]
         }
      }
   }
}
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Sample CFT for an S3 Bucket
This is the sample CloudFormation Template (CFT) used to create the S3 Buckets for testing this mApp®
Solution. Because this mApp Solution pulls information dynamically via the AWS API, request details for
provisioning the S3 Bucket samples in this integration come directly from this CFT.

            AWSTemplateFormatVersion: '2010-09-09'
Description: >-
  AWS CloudFormation Sample Template S3 Bucket: Create an Amazon S3 Bucket
. 
  **WARNING** This template creates an Amazon S3 Bucket. You will be bille
d for
  the AWS resources used if you create a stack from this template.
Resources:
  Bucket:
    Type: 'AWS::S3::Bucket'
Outputs:
  InstanceId:
    Description: Name of the newly S3 Bucket Name
    Value:
      Ref: Bucket
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Sample CFT for a LAMP Stack
This is the sample CloudFormation Template (CFT) used to create RDS and EC2 instances that form a
LAMP Stack for testing this mApp® Solution. Because this mApp Solution pulls information dynamically
via the AWS API, request details for provisioning the LAMP Stack samples in this integration come
directly from this CFT.

            {
  "AWSTemplateFormatVersion": "2010-09-09",

  "Description": "AWS CloudFormation Sample Template LAMP_Multi_AZ: Create 
a highly available, scalable LAMP stack with an Amazon RDS database instanc
e for the backend data store. This template demonstrates using the AWS Clou
dFormation bootstrap scripts to install the packages and files necessary t
o deploy the Apache web server and PHP at instance launch time. **WARNING*
* This template creates one or more Amazon EC2 instances, an Application Lo
ad Balancer and an Amazon RDS DB instance. You will be billed for the AWS r
esources used if you create a stack from this template.",

  "Parameters": {
    "VpcId": {
      "Type": "AWS::EC2::VPC::Id",
      "Description": "VpcId of your existing Virtual Private Cloud (VPC)",
      "ConstraintDescription": "must be the VPC Id of an existing Virtual P
rivate Cloud."
    },

    "Subnets": {
      "Type": "List<AWS::EC2::Subnet::Id>",
      "Description": "The list of SubnetIds in your Virtual Private Cloud (
VPC)",
      "ConstraintDescription": "must be a list of at least two existing sub
nets associated with at least two different availability zones. They shoul
d be residing in the selected Virtual Private Cloud."
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    },

    "KeyName": {
      "Description": "Name of an existing EC2 KeyPair to enable SSH access 
to the instances",
      "Type": "AWS::EC2::KeyPair::KeyName",
      "ConstraintDescription": "must be the name of an existing EC2 KeyPair
."
    },

    "DBName": {
      "Default": "myDatabase",
      "Description": "MySQL database name",
      "Type": "String",
      "MinLength": "1",
      "MaxLength": "64",
      "AllowedPattern": "[a-zA-Z][a-zA-Z0-9]*",
      "ConstraintDescription": "must begin with a letter and contain only a
lphanumeric characters."
    },

    "DBUser": {
      "NoEcho": "true",
      "Description": "Username for MySQL database access",
      "Type": "String",
      "MinLength": "1",
      "MaxLength": "16",
      "AllowedPattern": "[a-zA-Z][a-zA-Z0-9]*",
      "ConstraintDescription": "must begin with a letter and contain only a
lphanumeric characters."
    },

    "DBPassword": {
      "NoEcho": "true",
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      "Description": "Password for MySQL database access",
      "Type": "String",
      "MinLength": "8",
      "MaxLength": "41",
      "AllowedPattern": "[a-zA-Z0-9]*",
      "ConstraintDescription": "must contain only alphanumeric characters."
    },

    "DBAllocatedStorage": {
      "Default": "5",
      "Description": "The size of the database (Gb)",
      "Type": "Number",
      "MinValue": "5",
      "MaxValue": "1024",
      "ConstraintDescription": "must be between 5 and 1024Gb."
    },

    "DBInstanceClass": {
      "Description": "The database instance type",
      "Type": "String",
      "Default": "db.t2.small",
      "AllowedValues": ["db.t1.micro", "db.m1.small", "db.m1.medium", "db.m
1.large", "db.m1.xlarge", "db.m2.xlarge", "db.m2.2xlarge", "db.m2.4xlarge"
, "db.m3.medium", "db.m3.large", "db.m3.xlarge", "db.m3.2xlarge", "db.m4.la
rge", "db.m4.xlarge", "db.m4.2xlarge", "db.m4.4xlarge", "db.m4.10xlarge", "
db.r3.large", "db.r3.xlarge", "db.r3.2xlarge", "db.r3.4xlarge", "db.r3.8xla
rge", "db.m2.xlarge", "db.m2.2xlarge", "db.m2.4xlarge", "db.cr1.8xlarge", "
db.t2.micro", "db.t2.small", "db.t2.medium", "db.t2.large"],
      "ConstraintDescription": "must select a valid database instance type.
"
    },

    "MultiAZDatabase": {
      "Default": "true",
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      "Description": "Create a Multi-AZ MySQL Amazon RDS database instance"
,
      "Type": "String",
      "AllowedValues": ["true", "false"],
      "ConstraintDescription": "must be either true or false."
    },

    "WebServerCapacity": {
      "Default": "2",
      "Description": "The initial number of WebServer instances",
      "Type": "Number",
      "MinValue": "1",
      "MaxValue": "5",
      "ConstraintDescription": "must be between 1 and 5 EC2 instances."
    },

    "InstanceType": {
      "Description": "WebServer EC2 instance type",
      "Type": "String",
      "Default": "t2.small",
      "AllowedValues": ["t1.micro", "t2.nano", "t2.micro", "t2.small", "t2.
medium", "t2.large", "m1.small", "m1.medium", "m1.large", "m1.xlarge", "m2.
xlarge", "m2.2xlarge", "m2.4xlarge", "m3.medium", "m3.large", "m3.xlarge", 
"m3.2xlarge", "m4.large", "m4.xlarge", "m4.2xlarge", "m4.4xlarge", "m4.10xl
arge", "c1.medium", "c1.xlarge", "c3.large", "c3.xlarge", "c3.2xlarge", "c3
.4xlarge", "c3.8xlarge", "c4.large", "c4.xlarge", "c4.2xlarge", "c4.4xlarge
", "c4.8xlarge", "g2.2xlarge", "g2.8xlarge", "r3.large", "r3.xlarge", "r3.2
xlarge", "r3.4xlarge", "r3.8xlarge", "i2.xlarge", "i2.2xlarge", "i2.4xlarge
", "i2.8xlarge", "d2.xlarge", "d2.2xlarge", "d2.4xlarge", "d2.8xlarge", "hi
1.4xlarge", "hs1.8xlarge", "cr1.8xlarge", "cc2.8xlarge", "cg1.4xlarge"],
      "ConstraintDescription": "must be a valid EC2 instance type."
    },
    "SSHLocation": {
      "Description": " The IP address range that can be used to SSH to the 
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EC2 instances",
      "Type": "String",
      "MinLength": "9",
      "MaxLength": "18",
      "Default": "0.0.0.0/0",
      "AllowedPattern": "(\\d{1,3})\\.(\\d{1,3})\\.(\\d{1,3})\\.(\\d{1,3})/
(\\d{1,2})",
      "ConstraintDescription": "must be a valid IP CIDR range of the form x
.x.x.x/x."
    }
  },

  "Mappings": {
    "AWSInstanceType2Arch": {
      "t1.micro": {
        "Arch": "HVM64"
      },
      "t2.nano": {
        "Arch": "HVM64"
      },
      "t2.micro": {
        "Arch": "HVM64"
      },
      "t2.small": {
        "Arch": "HVM64"
      },
      "t2.medium": {
        "Arch": "HVM64"
      },
      "t2.large": {
        "Arch": "HVM64"
      },
      "m1.small": {
        "Arch": "HVM64"
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      },
      "m1.medium": {
        "Arch": "HVM64"
      },
      "m1.large": {
        "Arch": "HVM64"
      },
      "m1.xlarge": {
        "Arch": "HVM64"
      },
      "m2.xlarge": {
        "Arch": "HVM64"
      },
      "m2.2xlarge": {
        "Arch": "HVM64"
      },
      "m2.4xlarge": {
        "Arch": "HVM64"
      },
      "m3.medium": {
        "Arch": "HVM64"
      },
      "m3.large": {
        "Arch": "HVM64"
      },
      "m3.xlarge": {
        "Arch": "HVM64"
      },
      "m3.2xlarge": {
        "Arch": "HVM64"
      },
      "m4.large": {
        "Arch": "HVM64"
      },
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      "m4.xlarge": {
        "Arch": "HVM64"
      },
      "m4.2xlarge": {
        "Arch": "HVM64"
      },
      "m4.4xlarge": {
        "Arch": "HVM64"
      },
      "m4.10xlarge": {
        "Arch": "HVM64"
      },
      "c1.medium": {
        "Arch": "HVM64"
      },
      "c1.xlarge": {
        "Arch": "HVM64"
      },
      "c3.large": {
        "Arch": "HVM64"
      },
      "c3.xlarge": {
        "Arch": "HVM64"
      },
      "c3.2xlarge": {
        "Arch": "HVM64"
      },
      "c3.4xlarge": {
        "Arch": "HVM64"
      },
      "c3.8xlarge": {
        "Arch": "HVM64"
      },
      "c4.large": {
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        "Arch": "HVM64"
      },
      "c4.xlarge": {
        "Arch": "HVM64"
      },
      "c4.2xlarge": {
        "Arch": "HVM64"
      },
      "c4.4xlarge": {
        "Arch": "HVM64"
      },
      "c4.8xlarge": {
        "Arch": "HVM64"
      },
      "g2.2xlarge": {
        "Arch": "HVMG2"
      },
      "g2.8xlarge": {
        "Arch": "HVMG2"
      },
      "r3.large": {
        "Arch": "HVM64"
      },
      "r3.xlarge": {
        "Arch": "HVM64"
      },
      "r3.2xlarge": {
        "Arch": "HVM64"
      },
      "r3.4xlarge": {
        "Arch": "HVM64"
      },
      "r3.8xlarge": {
        "Arch": "HVM64"
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      },
      "i2.xlarge": {
        "Arch": "HVM64"
      },
      "i2.2xlarge": {
        "Arch": "HVM64"
      },
      "i2.4xlarge": {
        "Arch": "HVM64"
      },
      "i2.8xlarge": {
        "Arch": "HVM64"
      },
      "d2.xlarge": {
        "Arch": "HVM64"
      },
      "d2.2xlarge": {
        "Arch": "HVM64"
      },
      "d2.4xlarge": {
        "Arch": "HVM64"
      },
      "d2.8xlarge": {
        "Arch": "HVM64"
      },
      "hi1.4xlarge": {
        "Arch": "HVM64"
      },
      "hs1.8xlarge": {
        "Arch": "HVM64"
      },
      "cr1.8xlarge": {
        "Arch": "HVM64"
      },
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      "cc2.8xlarge": {
        "Arch": "HVM64"
      }
    },

    "AWSInstanceType2NATArch": {
      "t1.micro": {
        "Arch": "NATHVM64"
      },
      "t2.nano": {
        "Arch": "NATHVM64"
      },
      "t2.micro": {
        "Arch": "NATHVM64"
      },
      "t2.small": {
        "Arch": "NATHVM64"
      },
      "t2.medium": {
        "Arch": "NATHVM64"
      },
      "t2.large": {
        "Arch": "NATHVM64"
      },
      "m1.small": {
        "Arch": "NATHVM64"
      },
      "m1.medium": {
        "Arch": "NATHVM64"
      },
      "m1.large": {
        "Arch": "NATHVM64"
      },
      "m1.xlarge": {
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        "Arch": "NATHVM64"
      },
      "m2.xlarge": {
        "Arch": "NATHVM64"
      },
      "m2.2xlarge": {
        "Arch": "NATHVM64"
      },
      "m2.4xlarge": {
        "Arch": "NATHVM64"
      },
      "m3.medium": {
        "Arch": "NATHVM64"
      },
      "m3.large": {
        "Arch": "NATHVM64"
      },
      "m3.xlarge": {
        "Arch": "NATHVM64"
      },
      "m3.2xlarge": {
        "Arch": "NATHVM64"
      },
      "m4.large": {
        "Arch": "NATHVM64"
      },
      "m4.xlarge": {
        "Arch": "NATHVM64"
      },
      "m4.2xlarge": {
        "Arch": "NATHVM64"
      },
      "m4.4xlarge": {
        "Arch": "NATHVM64"
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      },
      "m4.10xlarge": {
        "Arch": "NATHVM64"
      },
      "c1.medium": {
        "Arch": "NATHVM64"
      },
      "c1.xlarge": {
        "Arch": "NATHVM64"
      },
      "c3.large": {
        "Arch": "NATHVM64"
      },
      "c3.xlarge": {
        "Arch": "NATHVM64"
      },
      "c3.2xlarge": {
        "Arch": "NATHVM64"
      },
      "c3.4xlarge": {
        "Arch": "NATHVM64"
      },
      "c3.8xlarge": {
        "Arch": "NATHVM64"
      },
      "c4.large": {
        "Arch": "NATHVM64"
      },
      "c4.xlarge": {
        "Arch": "NATHVM64"
      },
      "c4.2xlarge": {
        "Arch": "NATHVM64"
      },
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      "c4.4xlarge": {
        "Arch": "NATHVM64"
      },
      "c4.8xlarge": {
        "Arch": "NATHVM64"
      },
      "g2.2xlarge": {
        "Arch": "NATHVMG2"
      },
      "g2.8xlarge": {
        "Arch": "NATHVMG2"
      },
      "r3.large": {
        "Arch": "NATHVM64"
      },
      "r3.xlarge": {
        "Arch": "NATHVM64"
      },
      "r3.2xlarge": {
        "Arch": "NATHVM64"
      },
      "r3.4xlarge": {
        "Arch": "NATHVM64"
      },
      "r3.8xlarge": {
        "Arch": "NATHVM64"
      },
      "i2.xlarge": {
        "Arch": "NATHVM64"
      },
      "i2.2xlarge": {
        "Arch": "NATHVM64"
      },
      "i2.4xlarge": {
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        "Arch": "NATHVM64"
      },
      "i2.8xlarge": {
        "Arch": "NATHVM64"
      },
      "d2.xlarge": {
        "Arch": "NATHVM64"
      },
      "d2.2xlarge": {
        "Arch": "NATHVM64"
      },
      "d2.4xlarge": {
        "Arch": "NATHVM64"
      },
      "d2.8xlarge": {
        "Arch": "NATHVM64"
      },
      "hi1.4xlarge": {
        "Arch": "NATHVM64"
      },
      "hs1.8xlarge": {
        "Arch": "NATHVM64"
      },
      "cr1.8xlarge": {
        "Arch": "NATHVM64"
      },
      "cc2.8xlarge": {
        "Arch": "NATHVM64"
      }
    },
    "AWSRegionArch2AMI": {
      "us-east-1": {
        "HVM64": "ami-0080e4c5bc078760e",
        "HVMG2": "ami-0aeb704d503081ea6"
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      },
      "us-west-2": {
        "HVM64": "ami-01e24be29428c15b2",
        "HVMG2": "ami-0fe84a5b4563d8f27"
      },
      "us-west-1": {
        "HVM64": "ami-0ec6517f6edbf8044",
        "HVMG2": "ami-0a7fc72dc0e51aa77"
      },
      "eu-west-1": {
        "HVM64": "ami-08935252a36e25f85",
        "HVMG2": "ami-0d5299b1c6112c3c7"
      },
      "eu-west-2": {
        "HVM64": "ami-01419b804382064e4",
        "HVMG2": "NOT_SUPPORTED"
      },
      "eu-west-3": {
        "HVM64": "ami-0dd7e7ed60da8fb83",
        "HVMG2": "NOT_SUPPORTED"
      },
      "eu-central-1": {
        "HVM64": "ami-0cfbf4f6db41068ac",
        "HVMG2": "ami-0aa1822e3eb913a11"
      },
      "eu-north-1": {
        "HVM64": "ami-86fe70f8",
        "HVMG2": "ami-32d55b4c"
      },
      "ap-northeast-1": {
        "HVM64": "ami-00a5245b4816c38e6",
        "HVMG2": "ami-09d0e0e099ecabba2"
      },
      "ap-northeast-2": {
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        "HVM64": "ami-00dc207f8ba6dc919",
        "HVMG2": "NOT_SUPPORTED"
      },
      "ap-northeast-3": {
        "HVM64": "ami-0b65f69a5c11f3522",
        "HVMG2": "NOT_SUPPORTED"
      },
      "ap-southeast-1": {
        "HVM64": "ami-05b3bcf7f311194b3",
        "HVMG2": "ami-0e46ce0d6a87dc979"
      },
      "ap-southeast-2": {
        "HVM64": "ami-02fd0b06f06d93dfc",
        "HVMG2": "ami-0c0ab057a101d8ff2"
      },
      "ap-south-1": {
        "HVM64": "ami-0ad42f4f66f6c1cc9",
        "HVMG2": "ami-0244c1d42815af84a"
      },
      "us-east-2": {
        "HVM64": "ami-0cd3dfa4e37921605",
        "HVMG2": "NOT_SUPPORTED"
      },
      "ca-central-1": {
        "HVM64": "ami-07423fb63ea0a0930",
        "HVMG2": "NOT_SUPPORTED"
      },
      "sa-east-1": {
        "HVM64": "ami-05145e0b28ad8e0b2",
        "HVMG2": "NOT_SUPPORTED"
      },
      "cn-north-1": {
        "HVM64": "ami-053617c9d818c1189",
        "HVMG2": "NOT_SUPPORTED"
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      },
      "cn-northwest-1": {
        "HVM64": "ami-0f7937761741dc640",
        "HVMG2": "NOT_SUPPORTED"
      }
    }

  },

  "Resources": {

    "ApplicationLoadBalancer": {
      "Type": "AWS::ElasticLoadBalancingV2::LoadBalancer",
      "Properties": {
        "Subnets": {
          "Ref": "Subnets"
        }
      }
    },

    "ALBListener": {
      "Type": "AWS::ElasticLoadBalancingV2::Listener",
      "Properties": {
        "DefaultActions": [{
          "Type": "forward",
          "TargetGroupArn": {
            "Ref": "ALBTargetGroup"
          }
        }],
        "LoadBalancerArn": {
          "Ref": "ApplicationLoadBalancer"
        },
        "Port": "80",
        "Protocol": "HTTP"
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      }
    },

    "ALBTargetGroup": {
      "Type": "AWS::ElasticLoadBalancingV2::TargetGroup",
      "Properties": {
        "HealthCheckIntervalSeconds": 10,
        "HealthCheckTimeoutSeconds": 5,
        "HealthyThresholdCount": 2,
        "Port": 80,
        "Protocol": "HTTP",
        "UnhealthyThresholdCount": 5,
        "VpcId": {
          "Ref": "VpcId"
        },
        "TargetGroupAttributes": [{
            "Key": "stickiness.enabled",
            "Value": "true"
          },
          {
            "Key": "stickiness.type",
            "Value": "lb_cookie"
          },
          {
            "Key": "stickiness.lb_cookie.duration_seconds",
            "Value": "30"
          }
        ]
      }
    },

    "WebServerGroup": {
      "Type": "AWS::AutoScaling::AutoScalingGroup",
      "Properties": {
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        "VPCZoneIdentifier": {
          "Ref": "Subnets"
        },
        "LaunchConfigurationName": {
          "Ref": "LaunchConfig"
        },
        "MinSize": "1",
        "MaxSize": "5",
        "DesiredCapacity": {
          "Ref": "WebServerCapacity"
        },
        "TargetGroupARNs": [{
          "Ref": "ALBTargetGroup"
        }]
      },
      "CreationPolicy": {
        "ResourceSignal": {
          "Timeout": "PT5M",
          "Count": {
            "Ref": "WebServerCapacity"
          }
        }
      },
      "UpdatePolicy": {
        "AutoScalingRollingUpdate": {
          "MinInstancesInService": "1",
          "MaxBatchSize": "1",
          "PauseTime": "PT15M",
          "WaitOnResourceSignals": "true"
        }
      }
    },

    "LaunchConfig": {
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      "Type": "AWS::AutoScaling::LaunchConfiguration",
      "Metadata": {
        "Comment1": "Configure the bootstrap helpers to install the Apache 
Web Server and PHP",
        "Comment2": "The website content is downloaded from the CloudFormat
ionPHPSample.zip file",

        "AWS::CloudFormation::Init": {
          "config": {
            "packages": {
              "yum": {
                "httpd": [],
                "php": [],
                "php-mysql": []
              }
            },

            "files": {
              "/var/www/html/index.php": {
                "content": {
                  "Fn::Join": ["", [
                    "<html>\n",
                    "  <head>\n",
                    "    <title>AWS CloudFormation PHP Sample</title>\n",
                    "    <meta http-equiv=\"Content-Type\" content=\"text/h
tml; charset=ISO-8859-1\">\n",
                    "  </head>\n",
                    "  <body>\n",
                    "    <h1>Welcome to the AWS CloudFormation PHP Sample</
h1>\n",
                    "    <p/>\n",
                    "    <?php\n",
                    "      // Print out the current data and tie\n",
                    "      print \"The Current Date and Time is: <br/>\";\n
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",
                    "      print date(\"g:i A l, F j Y.\");\n",
                    "    ?>\n",
                    "    <p/>\n",
                    "    <?php\n",
                    "      // Setup a handle for CURL\n",
                    "      $curl_handle=curl_init();\n",
                    "      curl_setopt($curl_handle,CURLOPT_CONNECTTIMEOUT,
2);\n",
                    "      curl_setopt($curl_handle,CURLOPT_RETURNTRANSFER,
1);\n",
                    "      // Get the hostname of the instance from the ins
tance metadata\n",
                    "      curl_setopt($curl_handle,CURLOPT_URL,'http://169
.254.169.254/latest/meta-data/public-hostname');\n",
                    "      $hostname = curl_exec($curl_handle);\n",
                    "      if (empty($hostname))\n",
                    "      {\n",
                    "        print \"Sorry, for some reason, we got no host
name back <br />\";\n",
                    "      }\n",
                    "      else\n",
                    "      {\n",
                    "        print \"Server = \" . $hostname . \"<br />\";\
n",
                    "      }\n",
                    "      // Get the instance-id of the instance from the 
instance metadata\n",
                    "      curl_setopt($curl_handle,CURLOPT_URL,'http://169
.254.169.254/latest/meta-data/instance-id');\n",
                    "      $instanceid = curl_exec($curl_handle);\n",
                    "      if (empty($instanceid))\n",
                    "      {\n",
                    "        print \"Sorry, for some reason, we got no inst
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ance id back <br />\";\n",
                    "      }\n",
                    "      else\n",
                    "      {\n",
                    "        print \"EC2 instance-id = \" . $instanceid . \
"<br />\";\n",
                    "      }\n",
                    "      $Database   = \"", {
                      "Fn::GetAtt": ["MySQLDatabase", "Endpoint.Address"]
                    }, "\";\n",
                    "      $DBUser     = \"", {
                      "Ref": "DBUser"
                    }, "\";\n",
                    "      $DBPassword = \"", {
                      "Ref": "DBPassword"
                    }, "\";\n",
                    "      print \"Database = \" . $Database . \"<br />\";\
n",
                    "      $dbconnection = mysql_connect($Database, $DBUser
, $DBPassword)\n",
                    "                      or die(\"Could not connect: \" 
. mysql_error());\n",
                    "      print (\"Connected to $Database successfully\");
\n",
                    "      mysql_close($dbconnection);\n",
                    "    ?>\n",
                    "    <h2>PHP Information</h2>\n",
                    "    <p/>\n",
                    "    <?php\n",
                    "      phpinfo();\n",
                    "    ?>\n",
                    "  </body>\n",
                    "</html>\n"
                  ]]
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                },
                "mode": "000600",
                "owner": "apache",
                "group": "apache"
              },
              "/etc/cfn/cfn-hup.conf": {
                "content": {
                  "Fn::Join": ["", [
                    "[main]\n",
                    "stack=", {
                      "Ref": "AWS::StackId"
                    }, "\n",
                    "region=", {
                      "Ref": "AWS::Region"
                    }, "\n"
                  ]]
                },
                "mode": "000400",
                "owner": "root",
                "group": "root"
              },

              "/etc/cfn/hooks.d/cfn-auto-reloader.conf": {
                "content": {
                  "Fn::Join": ["", [
                    "[cfn-auto-reloader-hook]\n",
                    "triggers=post.update\n",
                    "path=Resources.LaunchConfig.Metadata.AWS::CloudFormati
on::Init\n",
                    "action=/opt/aws/bin/cfn-init -v ",
                    "         --stack ", {
                      "Ref": "AWS::StackName"
                    },
                    "         --resource LaunchConfig ",
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                    "         --region ", {
                      "Ref": "AWS::Region"
                    }, "\n",
                    "runas=root\n"
                  ]]
                },
                "mode": "000400",
                "owner": "root",
                "group": "root"
              }
            },

            "services": {
              "sysvinit": {
                "httpd": {
                  "enabled": "true",
                  "ensureRunning": "true"
                },
                "cfn-hup": {
                  "enabled": "true",
                  "ensureRunning": "true",
                  "files": ["/etc/cfn/cfn-hup.conf", "/etc/cfn/hooks.d/cfn-
auto-reloader.conf"]
                }
              }
            }
          }
        }
      },
      "Properties": {
        "ImageId": {
          "Fn::FindInMap": ["AWSRegionArch2AMI", {
              "Ref": "AWS::Region"
            },
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            {
              "Fn::FindInMap": ["AWSInstanceType2Arch", {
                "Ref": "InstanceType"
              }, "Arch"]
            }
          ]
        },
        "InstanceType": {
          "Ref": "InstanceType"
        },
        "SecurityGroups": [{
          "Ref": "WebServerSecurityGroup"
        }],
        "KeyName": {
          "Ref": "KeyName"
        },
        "UserData": {
          "Fn::Base64": {
            "Fn::Join": ["", [
              "#!/bin/bash -xe\n",
              "yum update -y aws-cfn-bootstrap\n",

              "# Install the files and packages from the metadata\n",
              "/opt/aws/bin/cfn-init -v ",
              "         --stack ", {
                "Ref": "AWS::StackName"
              },
              "         --resource LaunchConfig ",
              "         --region ", {
                "Ref": "AWS::Region"
              }, "\n",

              "# Signal the status from cfn-init\n",
              "/opt/aws/bin/cfn-signal -e $? ",
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              "         --stack ", {
                "Ref": "AWS::StackName"
              },
              "         --resource WebServerGroup ",
              "         --region ", {
                "Ref": "AWS::Region"
              }, "\n"
            ]]
          }
        }
      }
    },

    "WebServerSecurityGroup": {
      "Type": "AWS::EC2::SecurityGroup",
      "Properties": {
        "GroupDescription": "Enable HTTP access via port 80 locked down to 
the ELB and SSH access",
        "SecurityGroupIngress": [{
            "IpProtocol": "tcp",
            "FromPort": "80",
            "ToPort": "80",
            "SourceSecurityGroupId": {
              "Fn::Select": [0, {
                "Fn::GetAtt": ["ApplicationLoadBalancer", "SecurityGroups"]
              }]
            }
          },
          {
            "IpProtocol": "tcp",
            "FromPort": "22",
            "ToPort": "22",
            "CidrIp": {
              "Ref": "SSHLocation"
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            }
          }
        ],
        "VpcId": {
          "Ref": "VpcId"
        }
      }
    },

    "DBEC2SecurityGroup": {
      "Type": "AWS::EC2::SecurityGroup",
      "Properties": {
        "GroupDescription": "Open database for access",
        "SecurityGroupIngress": [{
          "IpProtocol": "tcp",
          "FromPort": "3306",
          "ToPort": "3306",
          "SourceSecurityGroupId": {
            "Ref": "WebServerSecurityGroup"
          }
        }],
        "VpcId": {
          "Ref": "VpcId"
        }
      }
    },

    "MySQLDatabase": {
      "Type": "AWS::RDS::DBInstance",
      "Properties": {
        "Engine": "MySQL",
        "DBName": {
          "Ref": "DBName"
        },
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        "MultiAZ": {
          "Ref": "MultiAZDatabase"
        },
        "MasterUsername": {
          "Ref": "DBUser"
        },
        "MasterUserPassword": {
          "Ref": "DBPassword"
        },
        "DBInstanceClass": {
          "Ref": "DBInstanceClass"
        },
        "AllocatedStorage": {
          "Ref": "DBAllocatedStorage"
        },
        "VPCSecurityGroups": [{
          "Fn::GetAtt": ["DBEC2SecurityGroup", "GroupId"]
        }]
      }
    }
  },

  "Outputs": {
    "WebsiteURL": {
      "Description": "URL for newly created LAMP stack",
      "Value": {
        "Fn::Join": ["", ["http://", {
          "Fn::GetAtt": ["ApplicationLoadBalancer", "DNSName"]
        }]]
      }
    }
  }
}
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Configure AWS SNS for CSM
Simple Notification Service (SNS) sends messages to CSM webhooks to enable key features in the AWS
mApp® Solution.

You need a minimum of two topics for this mApp Solution, one for each webhook in the system.

To configure AWS SNS for CSM:

1. In the AWS console, navigate to https://console.aws.amazon.com/sns/.

Update the Cherwell CMDB

2. Note: Webhook passwords should not correspond to any CSM logins. Instead, they are
arbitrary and used for the webhook only to enhance security.

If you have not already done so, in CSM Administrator, go to Managers > Webhook Manager and
set a custom webhook username and password for the AWS webhooks that were provided with the
mApp Solution.

a. Copy the Full Endpoint from the General page of the Webhook Manager. Using the new
username and password you just set for the webhook, modify the copied URL to fit the
following format (replace the sample information for webhook username and password, as well
as the external URL of your CSM server): https://
webhookUsername:webhookPassword@yourserverurl.com/CherwellAPI/api/
Webhooks/createawsconfigstaging

3. To create a topic for the AWS Create Config Staging webhook, see Creating an Amazon SNS Topic.
You do not need to complete any of the optional steps for the mApp Solution to work properly. In our
examples, the topic was named 'update-cherwell-cmdb' and will use that for our guide.

4. To create a subscription for the AWS Create Config Staging webhook, see Subscribing to an
Amazon SNS Topic. Use the following information:

a. Topic ARN: Select update-cherwell-cmdb.
b. Protocol: HTTPS
c. Endpoint: Enter the modified URL from your database.

5. Check to make sure that your subscription has been confirmed. This should happen automatically
through CSM, provided your URL and credentials are accurate.

Add Events as Incidents for AWS Configuration Items

6. Note: Webhook passwords should not correspond to any CSM logins. Instead, they are
arbitrary and used for the webhook only to enhance security.

If you have not already done so, in CSM Administrator, go to Managers > Webhook Manager and
set a custom webhook username and password for the AWS webhooks that were provided with the
mApp Solution.

a. Copy the Full Endpoint from the General page of the Webhook Manager. Using the new
username and password you just set for the webhook, modify the copied URL to fit the
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following format; replace the sample information for webhook username and password, as well
as the external URL of your CSM server. https://
webhookUsername:webhookPassword@yourserverurl.com/CherwellAPI/api/
Webhooks/createawsevent

7. To create a topic for the AWS Event webhook, repeat the steps in Creating an Amazon SNS Topic.
You do not need to complete any of the optional steps for the mApp Solution to work properly. In our
examples, the topic was named 'cherwell-ci-event-incident' and we will use that for our guide.

8. To create a subscription for the AWS Create Config Staging webhook, see Subscribing to an
Amazon SNS Topic. Use the following information:

a. Topic ARN: Select cherwell-ci-event-incident.
b. Protocol: HTTPS.
c. Endpoint: Enter the URL from your database.

9. Check to make sure that your subscription has been confirmed. This should happen automatically
through CSM, provided your URL and credentials are accurate.

309

CSM mApp Solutions

CSM mApp Solutions

https://docs.aws.amazon.com/sns/latest/dg/sns-create-topic.html
https://docs.aws.amazon.com/sns/latest/dg/sns-create-subscribe-endpoint-to-topic.html
https://docs.aws.amazon.com/sns/latest/dg/sns-create-subscribe-endpoint-to-topic.html


Configure AWS Config for CSM
This mApp® Solution uses AWS Config to monitor when new AWS products are provisioned. AWS Config
needs to be enabled, and set to send messages via AWS Simple Notification Service (SNS) to CSM.
Optionally, you may also configure notifications for AWS Config rules which are not compliant to create
Incidents in CSM.

The overall workflow for the automatic creation of AWS Product CIs in your CMDB is depicted here:

This webhook triggers the Create AWS Config Staging One-Step™ Action, which creates an AWS Config
Staging Business Object. This object stores incoming AWS Config notifications from Amazon SNS in a
new AWS Config Staging object. An automation process (AWS Config Staging - Create CI) then reads
this staging record, parses the stored JSON message, and from it creates the CI in your CMDB.
Optionally, a separate automation process (AWS Config Staging - Delete Staging Record) can be enabled
to follow up and delete the processed AWS Config Staging record.

1. In the AWS console, navigate to https://console.aws.amazon.com/config/.
2. Set up recording for your AWS Account (see Setting Up AWS Config with the Console). When you

get to the setup step for SNS, make sure to choose the topic you created previously in Configure
AWS SNS for CSM .
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Configure AWS CloudWatch Alarms for CSM
This mApp® Solution allows you to automatically create Incidents in CSM, based on CloudWatch Alarms.
These Incidents are linked to existing AWS Configuration Item records.

Before you begin configuring your CloudWatch alarms, ensure that you have appropriate topics and
subscriptions to which you can publish CloudWatch Alarm messages from AWS. Refer to Configure AWS
SNS for CSM.

You can connect CloudWatch alarms so that when they go into alarm state, an Incident is created in CSM
and tied to the appropriate AWS Configuration Item in your CMDB. Depending on your usage of AWS,
you may already have configured AWS CloudWatch Alarms for your AWS resources. You can connect
these existing alarms, or you can create new ones.

Note: For our example, we will create a CloudWatch Alarm for CPU Usage on a specific EC2
instance. However, the principles are the same and the setup is similar for alarms of other types.
You may need to modify some of the JSON parsing in the workflow of One-Step™ Actions
connected to the Create AWS Event webhook.

The overall workflow for the automatic creation of Incidents for your AWS Product configuration items is
shown below:

A webhook triggers the Create AWS Event One-Step Action. This webhook was designed as a sample to
demonstrate how you might automatically create Incidents for your AWS resources when they go into
alarm state or violate an established rule. This sample expects a CloudWatch Alarm notification from
Amazon SNS, such as an EC2 instance which has exceeded its CPU utilization threshold, and stores the
JSON from that alarm notification in an AWS Event object record. Then, an automation process (AWS
Event) creates an Incident linked to the associated CI in your CMDB. You may wish to configure
additional, similar event types using either AWS CloudWatch or AWS Config. To facilitate this process, we
have included sample JSON for these event types, as well as configured the (None) Create AWS Event
One-Step Action with a decision tree that covers two possible paths: a notification from AWS Config that a
CloudWatch Alarm has changed from OK to ALARM state, and a CloudWatch alarm which sends the
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SNS notification directly with details about the affected resource. There is a sample of what kind of JSON
is expected for the event. It's very particular, so we provide relevant sample code.

To configure AWS CloudWatch Alarms for CSM:

1. In the AWS console, navigate to https://console.aws.amazon.com/cloudwatch/.
2. Create a new alarm for use with this integration (see https://docs.aws.amazon.com/

AmazonCloudWatch/latest/monitoring/US_AlarmAtThresholdEC2.html). You can modify existing
alarms for use with this mApp Solution by simply adding a notification for these alarms to the
'cherwell-ci-create-incident' topic created in Configure AWS SNS for CSM .
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Configure AWS EventBridge for CSM
This mApp® Solution allows you to automatically create Incidents in CSM, based on multiple event
sources. These Incidents are linked to existing AWS Configuration Item records.

Before you begin configuring your EventBridge rules, ensure that you have a CloudWatch alarm
configured, and appropriate topics and subscriptions to which you can publish EventBridge messages
from AWS. Refer to Configure AWS SNS for CSM and Configure AWS CloudWatch Alarms for CSM .

To set up your system to accept events from multiple event sources, use the AWS EventBridge service.
This provides a standard notification format for all event types, which can be parsed when creating
incidents in CSM.

Note: For our example, we will create a CloudWatch Alarm for CPU Usage on a specific EC2
instance. However, the principles are the same and the setup is similar for alarms of other types.
You will need to update the One-Step™ Actions for the Create AWS Event webhook described in
Configure CSM to Add Incidents for AWS Product Events .

The overall workflow for the automatic creation of Incidents for your AWS Product configuration items is
shown below:

A webhook triggers the Create AWS Event One-Step Action. This webhook was designed as a sample to
demonstrate how you might automatically create Incidents for your AWS resources when they go into
alarm state or violate an established rule. This sample expects a CloudWatch Alarm notification from
Amazon SNS (example: An EC2 instance which has exceeded its CPU utilization threshold) and stores
the JSON from that alarm notification in an AWS Event object record. Then, an automation process (AWS
Event) creates an Incident linked to the associated CI in your CMDB. You may wish to configure
additional, similar event types using either AWS CloudWatch or AWS Config. To facilitate this process, we
have included sample JSON for these event types, as well as configured the (None) Create AWS Event
One-Step Action with a decision tree that covers two possible paths:

• A notification from AWS Config that a CloudWatch Alarm has changed from OK to ALARM state.
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• A CloudWatch alarm which sends the SNS notification directly with details about the affected
resource.

There is a sample of what kind of JSON is expected for the event. It's very particular, so we provide
relevant sample code.

To configure AWS CloudWatch Alarms for CSM:

1. In the AWS console, navigate to https://console.aws.amazon.com/eventbridge/.
2. Create a new rule for use with this integration (see https://docs.aws.amazon.com/eventbridge/latest/

userguide/create-eventbridge-rule.html). You can modify existing alarms for use with this mApp
Solution by simply adding a notification for these alarms to the 'cherwell-ci-create-incident' topic
created in Configure AWS SNS for CSM .
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Configure CSM for AWS
These steps will prepare your CSM instance for making AWS API calls, as well as support essential
mApp Solution features.

Complete the global configuration steps:

1. Configure your CSM security groups as outlined in Configure Security Groups for the AWS mApp
Solution .

2. Add access key information to the AWS Account table as outlined in Add AWS Access Keys to
CSM.

3. Add portfolios and departments to the AWS Portfolio table as outlined in Add Departments to the
AWS Portfolio Supporting Object.

4. Complete steps 1-3 for webhook setup.
5. Enable the System Event Processing service.

The next two configuration topics cover specific use cases for this mApp Solution.

6. Configure CSM to Add AWS Product Configuration Items to your CMDB
7. Configure CSM to Add Incidents for AWS Product Events

Related concepts
Webhooks Process
Enable the System Event Processing Service
Related tasks
Configure Security Groups for the AWS mApp Solution
Add AWS Access Keys to CSM
Add Departments to the AWS Portfolio Supporting Object
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Use the Cherwell Encryption Modifier with AWS
When your organization needs access to Amazon Web Services (AWS) resources through CSM,
Cherwell has a unique Amazon key that must be used in each request.

Amazon Key
The Amazon key (secret) is a string of characters that must be sent to Amazon every time a CSM user
interacts with AWS (example: when a support agent logs a ticket requesting an Amazon EC2 resource).
The Amazon key is sent through the HTTP header of every CSM request. This key is unique to Cherwell
and does not change.

Encryption Key and Nonce (Cherwell-Generated)
Because of its sensitive nature, the Amazon key is encrypted and stored in CSM in the Business Object
field. With every request to AWS, the key must be decrypted and passed through the HTTP header of the
request. The encryption and decryption actions require both a Cherwell-generated encryption key and a
nonce.

The Cherwell-generated encryption key is generated and stored only one time, and the value of the key
remains constant. This key is stored globally and should be protected so that it's never overwritten. One
option is to wrap the global value into an Action Block that makes sure that it's only populated if it doesn't
already have a value. You can also add other protection measures such as scoping so that only a
designated set of people are allowed to write to the storage location.

The Cherwell-generated nonce is an arbitrary value that is unique to each Business Object. The nonce
value is stored with the Amazon key in the Business Object field and is used together with the Cherwell-
generated encryption key during the encryption and decryption processes.

Security and Scope
All configuration to the Amazon key and the Cherwell-generated encryption key and nonce is performed
in CSM Administrator within a Blueprint. As a precaution to protect sensitive data, the encryption key
stored value, nonce field, and the encrypted Amazon key should be scoped so that only appropriate users
can read and modify the values.

Note: If the Amazon key is modified erroneously, you cannot decrypt the value on the Business
Object, which means you will have to request a new key from Amazon.

Recommendations for Configuring AWS Encryption
You can build CSM resources to ensure successful communication with AWS while maintaining an
encrypted version of the Amazon key. Suggested configuration includes storing the Amazon key and
nonce in Business Object fields, creating an Action Block that checks for the Cherwell-generated
encryption key stored value, and creating a One-Step™ Action and form button for submitting the AWS
request.

Creating Fields for Storing the Amazon Key and Nonce
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As a best practice, store the Amazon key and nonce inside text fields in the Business Object that is used
for the AWS request. Once the fields are available, you can run the One-Step Action that stores the
Amazon key and Cherwell-generated nonce directly inside text fields.

To create the text fields:

1. In CSM Administrator, open the Business Object in edit mode.

2. Add a text field for the Amazon key. The key is populated through the One-Step Action that you
create below.

3. Create a text field for the Cherwell-generated nonce. This field is populated by setting its default
value as the output of the GenerateEncryptionNonce system function in the Field Properties
window.

4. Change the default character length of the text field that you created in the previous step to 24
characters. The default length is 15 characters.

5. Save and publish your changes.

Creating an Action Block to Populate the Encryption Key Stored Value
Create an Action Block that populates a stored value containing the Cherwell-generated encryption key.
This Action Block is used in a One-Step Action that decrypts the Amazon key and passes it to AWS
through the HTTP request header.

The Action Block first uses an expression to check for the stored value. If it does not exist, a system
function is called to generate the encryption key and store it on the Business Object field. The encryption
key is generated and stored only one time. From that point forward, when the Action Block is triggered in
the One-Step Action, the expression confirms that the stored value exists and moves to the next step.

Note: Before creating the Action Block, create a stored value for the Cherwell-generated
encryption key.

To create the Action Block:

1. In CSM Administrator, select Managers > Action Blocks to open the Action Block Manager.

2. In the General tab, in the Name field, provide an intuitive name (example: Encryption Key).

3. Drag the Decide Between Multiple Cases action from the Advanced Actions section in the
designer toolbox on to the editor as the first step.

4. Configure Case 1 with a custom expression:
a. In the Value field, select the stored value that you created for the Cherwell-generated

encryption key. This key is used with the Cherwell-generated nonce to encrypt and save the
Amazon key on the Business Object Form.

b. In the Operator field, select Empty.

5. Configure the first decision step to take action when the stored value is empty:
a. Drag the Update Variables and Stored Values action from the Advanced Actions section in

the designer toolbox on to the step.

b. In the General tab, in the Stored Value field, select the stored value that you created for the
Cherwell-generated encryption key.
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c. In the Value field, select the GenerateEncryptionKey system function.

Creating a One-Step Action for the AWS Request
Use a One-Step Action to populate the header of the HTTP request with the Amazon key so that CSM
can successfully interact with the AWS resource. Individual steps include confirming that the Cherwell-
generated encryption key exists in the Business Object, updating the Business Object with updated
variables, decrypting the Amazon key, and passing the decrypted Amazon key to AWS through the
header of the HTTP request.

To create the One-Step Action:

1. Create a new One-Step Action.

2. From the designer toolbox, drag the Action Block that you created above as the first step in the One-
Step Action.

3. Add a second step that prompts the user for the Amazon key, which is then encrypted through the
Cherwell-generated encryption key and nonce. To configure the step:

a. Open the Modify/Format Value window.

b. Add an Encryption Key modifier.

c. Update the Key field with the value of the encryption key.

d. Update the Nonce field with the AWS Resource Nonce value.

e. Select OK.

4. Add a third step and set the value to Encrypted Secret.
5. Add a final action step that decrypts the Amazon key and submits an HTTP request to AWS with the

Amazon key in the header of the request.
a. Add the HTTP Request action type to the One-Step Action.

b. In the General tab, select GET.

c. In the URL field, add the URL to the Amazon site.

d. In the Headers tab, select the green plus sign.

e. In the Key field, select the Amazon key. In the Value field, select the AWS Resource Amazon
Key and then select to modify the value.

f. Select the green plus sign again to open the Modify/Format Value window.

g. Select Encryption in the Modifier field.

h. Select the nonce and the Cherwell-generated encryption key.

i. Select Decrypt.
j. Select OK.

6. Save your changes to the One-Step Action.

After running the One-Step Action from the form, CSM completes the request to AWS.

Creating the Form Button that Launches the One-Step Action
In the Business Object form, add a button that launches the One-Step Action that you configured above.
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To add the button:

1. Open the form in edit mode.

2. Drag a button to the form.

3. Right-click the button and select Control properties.

4. Configure the button with the One-Step Action.

5. Save the form.
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Configure Security Groups for the AWS mApp
Solution

Update Security Groups associated with the AWS mApp Solution Webhooks, Specifics Business Object,
and new Configuration Items.

To configure Security Groups for AWS:

1. Open CSM Administrator and select Security > Edit Security Groups.
2. Select the Rights tab, then select Webhooks.
3. Select the Anonymous Browser security group and enable View rights. (Repeat this step for any

security group which may need to manage these webhooks.)
4. Select any additional security groups that may need to manage these webhooks and enable View

and Edit rights for these groups.
5. Select the Business Objects tab.
6. In the Group list, select Portal Customer. (Repeat these steps for Portal Workgroup Manager and

any additional Portal Security Groups.)
7. In the Business Object list, select the following Business Objects and settings:

Business Object Setting

Specifics - AWS Provision
◦ General: View, Add, Edit
◦ New Field: View, Edit

Config - Cloud Services Storage
◦ General: View, Add, Edit
◦ New Field: View, Edit

Config - Cloud Services Database
◦ General: View, Add, Edit
◦ New Field: View, Edit

Config - Cloud Services Virtual Machine
◦ General: View, Add, Edit
◦ New Field: View, Edit

Related concepts
About Security Groups
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Add AWS Access Keys to CSM
Before you can make API calls to AWS, you must add access keys to CSM.

You will need to first add keys to your AWS account. See Configure AWS IAM for CSM.

1. In the CSM Desktop Client or Browser Client, navigate to Tools > Table Management. Go to the
AWS Account table and create a new record.

2. In your new record, enter these details:
a. Account ID: You can use either the numerical ID of your AWS account or the alias. For

information on where to find this number, see Your AWS Account ID and Its Alias.
b. Access Key ID: This is the public key from your AWS Key Pair.
c. Valid Departments: This field is read-only and can only be edited by adding a portfolio and

attaching departments to it.
d. Select Actions > Add Secret Key. In the prompt, enter the secret key from your AWS Key

Pair and select OK. Your key pair has now been securely stored in this table using encryption
to protect your private key.
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Add Departments to the AWS Portfolio Supporting
Object

Create a record for each portfolio in your organization's AWS account. When a CSM user makes a
request to provision an AWS product, the available products they can select will be determined by the
portfolio(s) available to their department.

Add department(s) to each Portfolio. Every user must have at least one Portfolio. When you update the
AWS portfolio, it updates the account table. Adding departments to Portfolios is required.

1. In the CSM Desktop Client or Browser Client, select Tools > Table Management. Go to the AWS
Portfolio table.

2. Create a record for each portfolio. Make sure the name of the Portfolio in AWS matches exactly to
what you put into CSM.

a. Account Name: Select an account.
b. Account ID: This information will populate automatically when you select the account.
c. Portfolio ID: Enter a valid AWS portfolio ID here. You can find this information by logging in to

the AWS console and viewing the https://console.aws.amazon.com/servicecatalog/..
d. Portfolio Name: Enter a user-friendly name for your portfolio here, such as the same portfolio

name used in AWS.
e. In the portfolio record, link the existing departments to this portfolio to grant access.

3. Select Save to save the record and link departments to the associated AWS Account.
You can verify the AWS Portfolio record by navigating to Tools > Table Management in the
Desktop Client or Browser Client. Select AWS Account, then open the corresponding account
record. You should see the departments you linked now listed in the Valid Departments field.
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Configure CSM to Add AWS Product Configuration
Items to your CMDB

Prepare your CSM instance for adding new AWS products to your CMDB automatically, based on SNS
messages.

Before you begin, complete the global steps outlined in Configure CSM for AWS. To support this use
case, you will also need to complete Configure AWS Config for CSM.

The overall workflow for the automatic creation of AWS Product CIs in your CMDB is depicted here:

This webhook triggers the Create AWS Config Staging One-Step™ Action, which creates an AWS Config
Staging Business Object. This object stores incoming AWS Config notifications from Amazon SNS in a
new AWS Config Staging object. An automation process (AWS Config Staging - Create CI) then reads
this staging record, parses the stored JSON message, and from it creates the CI in your CMDB.
Optionally, a separate automation process (AWS Config Staging - Delete Staging Record) can be enabled
to follow up and delete the processed AWS Config Staging record.

1. Note: Webhook passwords should not correspond to any CSM logins. Instead, they are
arbitrary and used for the webhook only to enhance security.

If you have not already done so, in CSM Administrator, go to Managers > Webhook Manager and
set a custom webhook username and password for the AWS webhooks that were provided with the
mApp® Solution.

a. Copy the Full Endpoint from the General page of the Webhook Manager. Using the new
username and password you just set for the webhook, modify the copied URL to the fit the
following format; replace the sample information for webhook username and password, as well
as the external URL of your CSM server. https://
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webhookUsername:webhookPassword@yourserverurl.com/CherwellAPI/api/
Webhooks/createawsconfigstaging

Configure any One-Step™ Actions that parse incoming messages from AWS specific to your Amazon
CFTs. Specifically, check these:

2. Note: If you are not using AWS Config for your notifications of new devices, you may need
to adjust both this One-Step Action and the Automation Process (AWS Config Staging) AWS
Config Staging - Create CI. This process expects specific JSON parsing of incoming SNS
messages to create CIs properly, so if your JSON is different you may get different results
and need to adjust this.

(None) Create AWS Config Staging: This One-Step Action splits up the SNS JSON and stores the
message body for the newly-created item in the message field to be parsed later. The AWS Config
Staging Record will contain JSON specific to your particular CFTs and to the services that you have
enabled in Amazon.

3. (AWS Config Staging) Create CI from Incident: This One-Step Action is the action for the
Automation Process (AWS Config Staging) AWS Config Staging - Create CI. It connects the AWS
Config Staging object to the Incident, in case you wish to keep these.

4. (Incident) Create Config Item: This One-Step Action will create a CI in your CMDB from an AWS
Config Staging Record. Change this One-Step Action in order for your CIs to be added correctly to
your CMDB. Set up one branch in the decision tree for each CI type that your CFTs reflect. For our
example, we set up branches as follows:

a. EC2: Creates a Config - Cloud Services Virtual Machine configuration item.
b. RDS: Creates a Config - Cloud Services Database configuration item.
c. S3 Bucket: Creates a Config - Cloud Services Storage configuration item.
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Sample SNS message for an EC2 Instance
This is a sample JSON response from AWS Config, sent via SNS. This message will be stored in an AWS
Config Staging record before being processed by the Create CI automation process to add a Cloud
Services - Virtual Machine record to your CMDB. You can use this sample JSON to test the Create AWS
Config Staging webhook.

            {
   "recordVersion":"1.3",
   "messageType":"ConfigurationItemChangeNotification",
   "configurationItemDiff":{
      "changedProperties":{

      },
      "changeType":"CREATE"
   },
   "notificationCreationTime":"2020-06-29T02:44:07.192Z",
   "configurationItem":{
      "relatedEvents":[

      ],
      "relationships":[
         {
            "resourceId":"eni-0123456789",
            "resourceType":"AWS::EC2::NetworkInterface",
            "name":"Contains NetworkInterface"
         },
         {
            "resourceId":"sg-01123456789",
            "resourceType":"AWS::EC2::SecurityGroup",
            "name":"Is associated with SecurityGroup"
         },
         {
            "resourceId":"subnet-a0ccc19e",
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            "resourceType":"AWS::EC2::Subnet",
            "name":"Is contained in Subnet"
         },
         {
            "resourceId":"vol-069736e00b70a0948",
            "resourceType":"AWS::EC2::Volume",
            "name":"Is attached to Volume"
         },
         {
            "resourceId":"vpc-ba848ec0",
            "resourceType":"AWS::EC2::VPC",
            "name":"Is contained in Vpc"
         }
      ],
      "configuration":{
         "amiLaunchIndex":0,
         "imageId":"ami-6869aa05",
         "instanceId":"i-01123456789",
         "instanceType":"t2.small",
         "keyName":"aws-stuff",
         "launchTime":"2020-06-29T02:41:54.000Z",
         "monitoring":{
            "state":"disabled"
         },
         "placement":{
            "availabilityZone":"us-east-1e",
            "groupName":"",
            "tenancy":"default"
         },
         "privateDnsName":"ip-172-0-0-0.ec2.internal",
         "privateIpAddress":"172.0.0.0",
         "productCodes":[

         ],
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         "publicDnsName":"ec2-35-153-79-147.compute-1.amazonaws.com",
         "publicIpAddress":"35.0.0.0",
         "state":{
            "code":16,
            "name":"running"
         },
         "stateTransitionReason":"",
         "subnetId":"subnet-a0ccc19e",
         "vpcId":"vpc-ba848ec0",
         "architecture":"x86_64",
         "blockDeviceMappings":[
            {
               "deviceName":"/dev/xvda",
               "ebs":{
                  "attachTime":"2020-06-29T02:41:55.000Z",
                  "deleteOnTermination":true,
                  "status":"attached",
                  "volumeId":"vol-069736e00b70a0948"
               }
            }
         ],
         "clientToken":"SC-49-EC2In-GIQR0XO1Y3GI",
         "ebsOptimized":false,
         "enaSupport":true,
         "hypervisor":"xen",
         "elasticGpuAssociations":[

         ],
         "elasticInferenceAcceleratorAssociations":[

         ],
         "networkInterfaces":[
            {
               "association":{
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                  "ipOwnerId":"amazon",
                  "publicDnsName":"ec2-35-153-79-147.compute-1.amazonaws.co
m",
                  "publicIp":"35.0.0.0"
               },
               "attachment":{
                  "attachTime":"2020-06-29T02:41:54.000Z",
                  "attachmentId":"eni-attach-0658d3e3e45501bf5",
                  "deleteOnTermination":true,
                  "deviceIndex":0,
                  "status":"attached"
               },
               "description":"",
               "groups":[
                  {
                     "groupName":"SC-49123456789-pp-k123456789-InstanceSecu
rityGroup-17123456789",
                     "groupId":"sg-01123456789"
                  }
               ],
               "ipv6Addresses":[

               ],
               "macAddress":"06:2b:75:7a:34:97",
               "networkInterfaceId":"eni-0123456789",
               "ownerId":"49123456789",
               "privateDnsName":"ip-172-0-0-0.ec2.internal",
               "privateIpAddress":"172.0.0.0",
               "privateIpAddresses":[
                  {
                     "association":{
                        "ipOwnerId":"amazon",
                        "publicDnsName":"ec2-35-153-79-147.compute-1.amazon
aws.com",

328

CSM mApp Solutions

CSM mApp Solutions



                        "publicIp":"35.0.0.0"
                     },
                     "primary":true,
                     "privateDnsName":"ip-172-0-0-0.ec2.internal",
                     "privateIpAddress":"172.0.0.0"
                  }
               ],
               "sourceDestCheck":true,
               "status":"in-use",
               "subnetId":"subnet-a0ccc19e",
               "vpcId":"vpc-ba848ec0",
               "interfaceType":"interface"
            }
         ],
         "rootDeviceName":"/dev/xvda",
         "rootDeviceType":"ebs",
         "securityGroups":[
            {
               "groupName":"SC-49123456789-pp-k123456789-InstanceSecurityGr
oup-17123456789",
               "groupId":"sg-01123456789"
            }
         ],
         "sourceDestCheck":true,
         "tags":[
            {
               "key":"aws:cloudformation:logical-id",
               "value":"EC2Instance"
            },
            {
               "key":"aws:cloudformation:stack-name",
               "value":"SC-49123456789-pp-k123456789"
            },
            {
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               "key":"aws:servicecatalog:portfolioArn",
               "value":"arn:aws:catalog:us-east-1:49123456789:portfolio/por
t-cfy123456789"
            },
            {
               "key":"aws:servicecatalog:provisioningArtifactIdentifier",
               "value":"pa-abjk1234567498"
            },
            {
               "key":"aws:servicecatalog:provisionedProductArn",
               "value":"arn:aws:servicecatalog:us-east-1:49123456789:stack/
grey-salamander/pp-k123456789"
            },
            {
               "key":"aws:servicecatalog:provisioningPrincipalArn",
               "value":"arn:aws:iam::49123456789:user/Henri.bryce"
            },
            {
               "key":"aws:servicecatalog:productArn",
               "value":"arn:aws:catalog:us-east-1:49123456789:product/prod-
qy123465789"
            },
            {
               "key":"instance-purpose",
               "value":"autoscaling"
            },
            {
               "key":"aws:cloudformation:stack-id",
               "value":"arn:aws:cloudformation:us-east-1:49123456789:stack/
SC-49123456789-pp-k123456789/0f26f4f0-b9b2-11ea-a346-12c1d85cca19"
            }
         ],
         "virtualizationType":"hvm",
         "cpuOptions":{
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            "coreCount":1,
            "threadsPerCore":1
         },
         "capacityReservationSpecification":{
            "capacityReservationPreference":"open"
         },
         "hibernationOptions":{
            "configured":false
         },
         "licenses":[

         ],
         "metadataOptions":{
            "state":"applied",
            "httpTokens":"optional",
            "httpPutResponseHopLimit":1,
            "httpEndpoint":"enabled"
         }
      },
      "supplementaryConfiguration":{

      },
      "tags":{
         "aws:servicecatalog:productArn":"arn:aws:catalog:us-east-1:4912345
6789:product/prod-qy123465789",
         "aws:cloudformation:stack-name":"SC-49123456789-pp-k123456789",
         "aws:servicecatalog:provisioningPrincipalArn":"arn:aws:iam::491234
56789:user/Henri.bryce",
         "aws:cloudformation:stack-id":"arn:aws:cloudformation:us-east-1:49
123456789:stack/SC-49123456789-pp-k123456789/0f26f4f0-b9b2-11ea-a346-12c1d8
5cca19",
         "aws:cloudformation:logical-id":"EC2Instance",
         "aws:servicecatalog:provisioningArtifactIdentifier":"pa-abjk123456
7498",
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         "aws:servicecatalog:portfolioArn":"arn:aws:catalog:us-east-1:49123
456789:portfolio/port-cfy123456789",
         "instance-purpose":"autoscaling",
         "aws:servicecatalog:provisionedProductArn":"arn:aws:servicecatalog
:us-east-1:49123456789:stack/grey-salamander/pp-k123456789"
      },
      "configurationItemVersion":"1.3",
      "configurationItemCaptureTime":"2020-06-29T02:44:06.023Z",
      "configurationStateId":1593398646023,
      "awsAccountId":"49123456789",
      "configurationItemStatus":"ResourceDiscovered",
      "resourceType":"AWS::EC2::Instance",
      "resourceId":"i-01123456789",
      "ARN":"arn:aws:ec2:us-east-1:49123456789:instance/i-01123456789",
      "awsRegion":"us-east-1",
      "availabilityZone":"us-east-1e",
      "configurationStateMd5Hash":"",
      "resourceCreationTime":"2020-06-29T02:41:54.000Z"
   }
}
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Sample SNS message for an RDS Instance
This is a sample JSON response from AWS Config, sent via SNS. This message will be stored in an AWS
Config Staging record before being processed by the Create CI automation process to add a Cloud
Services - Database record to your CMDB. You can use this sample JSON to test the Create AWS Config
Staging webhook.

            {
  "recordVersion": "1.3",
  "messageType": "ConfigurationItemChangeNotification",
  "configurationItemDiff": {
    "changedProperties": {},
    "changeType": "CREATE"
  },
  "notificationCreationTime": "2020-06-28T21:51:31.599Z",
  "configurationItem": {
    "relatedEvents": [],
    "relationships": [{
        "resourceId": "default",
        "resourceType": "AWS::RDS::DBSubnetGroup",
        "name": "Is associated with DBSubnetGroup"
      },
      {
        "resourceId": "sg-70712345",
        "resourceType": "AWS::EC2::SecurityGroup",
        "name": "Is associated with SecurityGroup"
      }
    ],
    "configuration": {
      "dBInstanceIdentifier": "sm1231456",
      "dBInstanceClass": "db.t2.small",
      "engine": "mysql",
      "dBInstanceStatus": "creating",
      "masterUsername": "myfavusername",
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      "dBName": "MyDatabase",
      "allocatedStorage": 5,
      "preferredBackupWindow": "03:49-04:19",
      "backupRetentionPeriod": 1,
      "dBSecurityGroups": [],
      "vpcSecurityGroups": [{
        "vpcSecurityGroupId": "sg-70712345",
        "status": "active"
      }],
      "dBParameterGroups": [{
        "dBParameterGroupName": "default.mysql5.7",
        "parameterApplyStatus": "in-sync"
      }],
      "availabilityZone": "us-east-1c",
      "dBSubnetGroup": {
        "dBSubnetGroupName": "default",
        "dBSubnetGroupDescription": "default",
        "vpcId": "vpc-ba123456",
        "subnetGroupStatus": "Complete",
        "subnets": [{
            "subnetIdentifier": "subnet-89123456",
            "subnetAvailabilityZone": {
              "name": "us-east-1f"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-a0ccc19e",
            "subnetAvailabilityZone": {
              "name": "us-east-1e"
            },
            "subnetStatus": "Active"
          },
          {
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            "subnetIdentifier": "subnet-91758bf7",
            "subnetAvailabilityZone": {
              "name": "us-east-1b"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-119b125c",
            "subnetAvailabilityZone": {
              "name": "us-east-1d"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-76f20829",
            "subnetAvailabilityZone": {
              "name": "us-east-1a"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-e9f83cc8",
            "subnetAvailabilityZone": {
              "name": "us-east-1c"
            },
            "subnetStatus": "Active"
          }
        ]
      },
      "preferredMaintenanceWindow": "sat:04:41-sat:05:11",
      "pendingModifiedValues": {
        "masterUserPassword": "****",
        "processorFeatures": []
      },

335

CSM mApp Solutions

CSM mApp Solutions



      "multiAZ": false,
      "engineVersion": "5.7.22",
      "autoMinorVersionUpgrade": true,
      "readReplicaDBInstanceIdentifiers": [],
      "readReplicaDBClusterIdentifiers": [],
      "licenseModel": "general-public-license",
      "optionGroupMemberships": [{
        "optionGroupName": "default:mysql-5-7",
        "status": "in-sync"
      }],
      "publiclyAccessible": true,
      "statusInfos": [],
      "storageType": "standard",
      "dbInstancePort": 0,
      "storageEncrypted": false,
      "dbiResourceId": "db-TNILOCYT4B123456789",
      "cACertificateIdentifier": "rds-ca-2019",
      "domainMemberships": [],
      "copyTagsToSnapshot": false,
      "monitoringInterval": 0,
      "dBInstanceArn": "arn:aws:rds:us-east-1:123456789:db:sm1231456",
      "iAMDatabaseAuthenticationEnabled": false,
      "performanceInsightsEnabled": false,
      "enabledCloudwatchLogsExports": [],
      "processorFeatures": [],
      "deletionProtection": false,
      "associatedRoles": []
    },
    "supplementaryConfiguration": {
      "Tags": [{
          "key": "aws:servicecatalog:productArn",
          "value": "arn:aws:catalog:us-east-1:123456789:product/prod-gcm123
456789"
        },
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        {
          "key": "aws:cloudformation:stack-name",
          "value": "SC-123456789-pp-mv2123456789"
        },
        {
          "key": "aws:servicecatalog:provisioningPrincipalArn",
          "value": "arn:aws:iam::123456789:user/Henri.Bryce"
        },
        {
          "key": "aws:cloudformation:stack-id",
          "value": "arn:aws:cloudformation:us-east-1:123456789:stack/SC-123
456789-pp-mv2123456789/314735f0-b989-11ea-84d2-12d8771823f5"
        },
        {
          "key": "aws:cloudformation:logical-id",
          "value": "MyDB"
        },
        {
          "key": "aws:servicecatalog:provisioningArtifactIdentifier",
          "value": "pa-re123456789"
        },
        {
          "key": "aws:servicecatalog:portfolioArn",
          "value": "arn:aws:catalog:us-east-1:123456789:portfolio/port-cfyx
123456789"
        },
        {
          "key": "aws:servicecatalog:provisionedProductArn",
          "value": "arn:aws:servicecatalog:us-east-1:123456789:stack/fuchsi
a-cheetah/pp-mv2123456789"
        }
      ]
    },
    "tags": {
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      "aws:servicecatalog:productArn": "arn:aws:catalog:us-east-1:123456789
:product/prod-gcm123456789",
      "aws:cloudformation:stack-name": "SC-123456789-pp-mv2123456789",
      "aws:servicecatalog:provisioningPrincipalArn": "arn:aws:iam::12345678
9:user/Henri.Bryce",
      "aws:cloudformation:stack-id": "arn:aws:cloudformation:us-east-1:1234
56789:stack/SC-123456789-pp-mv2123456789/314735f0-b989-11ea-84d2-12d8771823
f5",
      "aws:cloudformation:logical-id": "MyDB",
      "aws:servicecatalog:provisioningArtifactIdentifier": "pa-re123456789"
,
      "aws:servicecatalog:portfolioArn": "arn:aws:catalog:us-east-1:1234567
89:portfolio/port-cfyx123456789",
      "aws:servicecatalog:provisionedProductArn": "arn:aws:servicecatalog:u
s-east-1:123456789:stack/fuchsia-cheetah/pp-mv2123456789"
    },
    "configurationItemVersion": "1.3",
    "configurationItemCaptureTime": "2020-06-28T21:51:31.064Z",
    "configurationStateId": 1593381091064,
    "awsAccountId": "123456789",
    "configurationItemStatus": "ResourceDiscovered",
    "resourceType": "AWS::RDS::DBInstance",
    "resourceId": "db-TNILOCYT4B123456789",
    "resourceName": "sm1231456",
    "ARN": "arn:aws:rds:us-east-1:123456789:db:sm1231456",
    "awsRegion": "us-east-1",
    "availabilityZone": "us-east-1c",
    "configurationStateMd5Hash": "",
    "resourceCreationTime": "2020-06-28T21:51:31.183Z"
  }
}
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Sample SNS message for an S3 Instance
This is a sample JSON response from AWS Config, sent via SNS. This message will be stored in an AWS
Config Staging record before being processed by the Create CI automation process to add a Cloud
Services - Storage record to your CMDB. You can use this sample JSON to test the Create AWS Config
Staging webhook.

            {
  "recordVersion": "1.3",
  "messageType": "ConfigurationItemChangeNotification",
  "configurationItemDiff": {
    "changedProperties": {},
    "changeType": "CREATE"
  },
  "notificationCreationTime": "2020-06-28T21:20:41.065Z",
  "configurationItem": {
    "relatedEvents": [],
    "relationships": [],
    "configuration": {
      "name": "sc-123456789-pp-z7123456-bucket-p3qxc9174zfa",
      "owner": {
        "id": "8a95ee125c3ea8f3b300e97daaf77effb5c5dcf427ff164bc3fb5abc3e8f
528e"
      },
      "creationDate": "2020-06-28T21:18:36.000Z"
    },
    "supplementaryConfiguration": {
      "AccessControlList": "{\"grantSet\":null,\"grantList\":[{\"grantee\":
{\"id\":\"8a95ee125c3ea8f3b300e97daaf77effb5c5dcf427ff164bc3fb5abc3e8f528e\
",\"displayName\":null},\"permission\":\"FullControl\"}],\"owner\":{\"displ
ayName\":null,\"id\":\"8a95ee125c3ea8f3b300e97daaf77effb5c5dcf427ff164bc3fb
5abc3e8f528e\"},\"isRequesterCharged\":false}",
      "BucketAccelerateConfiguration": {},
      "BucketLoggingConfiguration": {},
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      "BucketNotificationConfiguration": {
        "configurations": {}
      },
      "BucketPolicy": {},
      "BucketTaggingConfiguration": {
        "tagSets": [{
          "tags": {
            "aws:servicecatalog:productArn": "arn:aws:catalog:us-east-1:123
456789:product/prod-kr1234567",
            "aws:cloudformation:stack-name": "SC-123456789-pp-z7123456",
            "aws:servicecatalog:provisioningPrincipalArn": "arn:aws:iam::12
3456789:user/Henri.bryce",
            "aws:cloudformation:stack-id": "arn:aws:cloudformation:us-east-
1:123456789:stack/SC-123456789-pp-z7123456/e931d440-b984-11ea-b140-0e167b72
6915",
            "aws:cloudformation:logical-id": "Bucket",
            "aws:servicecatalog:provisioningArtifactIdentifier": "pa-6p1234
56",
            "aws:servicecatalog:portfolioArn": "arn:aws:catalog:us-east-1:1
23456789:portfolio/port-cf1234567",
            "aws:servicecatalog:provisionedProductArn": "arn:aws:servicecat
alog:us-east-1:123456789:stack/teal-marmot/pp-z7123456"
          }
        }]
      },
      "BucketVersioningConfiguration": {
        "status": "Off"
      },
      "IsRequesterPaysEnabled": false
    },
    "tags": {
      "aws:servicecatalog:productArn": "arn:aws:catalog:us-east-1:123456789
:product/prod-kr1234567",
      "aws:cloudformation:stack-name": "SC-123456789-pp-z7123456",
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      "aws:servicecatalog:provisioningPrincipalArn": "arn:aws:iam::12345678
9:user/Henri.bryce",
      "aws:cloudformation:stack-id": "arn:aws:cloudformation:us-east-1:1234
56789:stack/SC-123456789-pp-z7123456/e931d440-b984-11ea-b140-0e167b726915",
      "aws:cloudformation:logical-id": "Bucket",
      "aws:servicecatalog:provisioningArtifactIdentifier": "pa-6p123456",
      "aws:servicecatalog:portfolioArn": "arn:aws:catalog:us-east-1:1234567
89:portfolio/port-cf1234567",
      "aws:servicecatalog:provisionedProductArn": "arn:aws:servicecatalog:u
s-east-1:123456789:stack/teal-marmot/pp-z7123456"
    },
    "configurationItemVersion": "1.3",
    "configurationItemCaptureTime": "2020-06-28T21:20:41.003Z",
    "configurationStateId": 1593379241003,
    "awsAccountId": "123456789",
    "configurationItemStatus": "ResourceDiscovered",
    "resourceType": "AWS::S3::Bucket",
    "resourceId": "sc-123456789-pp-z7123456-bucket-p3qxc9174zfa",
    "resourceName": "sc-123456789-pp-z7123456-bucket-p3qxc9174zfa",
    "ARN": "arn:aws:s3:::sc-123456789-pp-z7123456-bucket-p3qxc9174zfa",
    "awsRegion": "us-east-1",
    "availabilityZone": "Regional",
    "configurationStateMd5Hash": "",
    "resourceCreationTime": "2020-06-28T21:18:36.000Z"
  }
}
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Sample SNS message for a LAMP Stack EC2
Instance

This is a sample JSON response from AWS Config, sent via SNS. This message will be stored in an AWS
Config Staging record before being processed by the Create CI automation process to add a Cloud
Services - Virtual Machine record to your CMDB. This record would be one of three for a sample LAMP
stack. You can use this sample JSON to test the Create AWS Config Staging webhook.

            {
  "recordVersion": "1.3",
  "messageType": "ConfigurationItemChangeNotification",
  "configurationItemDiff": {
    "changedProperties": {},
    "changeType": "CREATE"
  },
  "notificationCreationTime": "2020-06-28T21:53:59.121Z",
  "configurationItem": {
    "relatedEvents": [],
    "relationships": [{
        "resourceId": "default",
        "resourceType": "AWS::RDS::DBSubnetGroup",
        "name": "Is associated with DBSubnetGroup"
      },
      {
        "resourceId": "sg-0766c123456789",
        "resourceType": "AWS::EC2::SecurityGroup",
        "name": "Is associated with SecurityGroup"
      }
    ],
    "configuration": {
      "dBInstanceIdentifier": "smfg123456798",
      "dBInstanceClass": "db.t2.small",
      "engine": "mysql",
      "dBInstanceStatus": "creating",
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      "masterUsername": "myfavusername",
      "dBName": "myDatabase",
      "allocatedStorage": 5,
      "preferredBackupWindow": "04:01-04:31",
      "backupRetentionPeriod": 1,
      "dBSecurityGroups": [],
      "vpcSecurityGroups": [{
        "vpcSecurityGroupId": "sg-0766c123456789",
        "status": "active"
      }],
      "dBParameterGroups": [{
        "dBParameterGroupName": "default.mysql5.7",
        "parameterApplyStatus": "in-sync"
      }],
      "availabilityZone": "us-east-1c",
      "dBSubnetGroup": {
        "dBSubnetGroupName": "default",
        "dBSubnetGroupDescription": "default",
        "vpcId": "vpc-ba848ec0",
        "subnetGroupStatus": "Complete",
        "subnets": [{
            "subnetIdentifier": "subnet-89d76487",
            "subnetAvailabilityZone": {
              "name": "us-east-1f"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-a0ccc19e",
            "subnetAvailabilityZone": {
              "name": "us-east-1e"
            },
            "subnetStatus": "Active"
          },
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          {
            "subnetIdentifier": "subnet-91758bf7",
            "subnetAvailabilityZone": {
              "name": "us-east-1b"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-119b125c",
            "subnetAvailabilityZone": {
              "name": "us-east-1d"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-76f20829",
            "subnetAvailabilityZone": {
              "name": "us-east-1a"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-e9f83cc8",
            "subnetAvailabilityZone": {
              "name": "us-east-1c"
            },
            "subnetStatus": "Active"
          }
        ]
      },
      "preferredMaintenanceWindow": "fri:05:22-fri:05:52",
      "pendingModifiedValues": {
        "masterUserPassword": "****",
        "processorFeatures": []
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      },
      "multiAZ": true,
      "engineVersion": "5.7.22",
      "autoMinorVersionUpgrade": true,
      "readReplicaDBInstanceIdentifiers": [],
      "readReplicaDBClusterIdentifiers": [],
      "licenseModel": "general-public-license",
      "optionGroupMemberships": [{
        "optionGroupName": "default:mysql-5-7",
        "status": "in-sync"
      }],
      "publiclyAccessible": true,
      "statusInfos": [],
      "storageType": "standard",
      "dbInstancePort": 0,
      "storageEncrypted": false,
      "dbiResourceId": "db-NRZ123456789",
      "cACertificateIdentifier": "rds-ca-2019",
      "domainMemberships": [],
      "copyTagsToSnapshot": false,
      "monitoringInterval": 0,
      "dBInstanceArn": "arn:aws:rds:us-east-1:123456789:db:smfg123456798",
      "iAMDatabaseAuthenticationEnabled": false,
      "performanceInsightsEnabled": false,
      "enabledCloudwatchLogsExports": [],
      "processorFeatures": [],
      "deletionProtection": false,
      "associatedRoles": []
    },
    "supplementaryConfiguration": {
      "Tags": [{
          "key": "aws:servicecatalog:productArn",
          "value": "arn:aws:catalog:us-east-1:123456789:product/prod-mv1234
56789"
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        },
        {
          "key": "aws:cloudformation:stack-name",
          "value": "SC-123456789-pp-yqf123456789"
        },
        {
          "key": "aws:servicecatalog:provisioningPrincipalArn",
          "value": "arn:aws:iam::123456789:user/Henri.Bryce"
        },
        {
          "key": "aws:cloudformation:stack-id",
          "value": "arn:aws:cloudformation:us-east-1:123456789:stack/SC-123
456789-pp-yqf123456789/0d913660-b989-11ea-abae-0a029b5a039d"
        },
        {
          "key": "aws:cloudformation:logical-id",
          "value": "MySQLDatabase"
        },
        {
          "key": "aws:servicecatalog:provisioningArtifactIdentifier",
          "value": "pa-z123456789"
        },
        {
          "key": "aws:servicecatalog:portfolioArn",
          "value": "arn:aws:catalog:us-east-1:123456789:portfolio/port-cfy1
23456789+"
        },
        {
          "key": "aws:servicecatalog:provisionedProductArn",
          "value": "arn:aws:servicecatalog:us-east-1:123456789:stack/plum-b
umblebee/pp-yqf123456789"
        }
      ]
    },
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    "tags": {
      "aws:servicecatalog:productArn": "arn:aws:catalog:us-east-1:123456789
:product/prod-mv123456789",
      "aws:cloudformation:stack-name": "SC-123456789-pp-yqf123456789",
      "aws:servicecatalog:provisioningPrincipalArn": "arn:aws:iam::12345678
9:user/Henri.Bryce",
      "aws:cloudformation:stack-id": "arn:aws:cloudformation:us-east-1:1234
56789:stack/SC-123456789-pp-yqf123456789/0d913660-b989-11ea-abae-0a029b5a03
9d",
      "aws:cloudformation:logical-id": "MySQLDatabase",
      "aws:servicecatalog:provisioningArtifactIdentifier": "pa-z123456789",
      "aws:servicecatalog:portfolioArn": "arn:aws:catalog:us-east-1:1234567
89:portfolio/port-cfy123456789+",
      "aws:servicecatalog:provisionedProductArn": "arn:aws:servicecatalog:u
s-east-1:123456789:stack/plum-bumblebee/pp-yqf123456789"
    },
    "configurationItemVersion": "1.3",
    "configurationItemCaptureTime": "2020-06-28T21:53:58.555Z",
    "configurationStateId": 1593381238555,
    "awsAccountId": "123456789",
    "configurationItemStatus": "ResourceDiscovered",
    "resourceType": "AWS::RDS::DBInstance",
    "resourceId": "db-NRZ123456789",
    "resourceName": "smfg123456798",
    "ARN": "arn:aws:rds:us-east-1:123456789:db:smfg123456798",
    "awsRegion": "us-east-1",
    "availabilityZone": "Multiple Availability Zones",
    "configurationStateMd5Hash": "",
    "resourceCreationTime": "2020-06-28T21:53:58.707Z"
  }
}
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Sample SNS message for a LAMP Stack RDS
Instance

This is a sample JSON response from AWS Config, sent via SNS. This message will be stored in an AWS
Config Staging record before being processed by the Create CI automation process to add a Cloud
Services - Database record to your CMDB. This record would be one of three for a sample LAMP stack.
You can use this sample JSON to test the Create AWS Config Staging webhook.

            {
  "recordVersion": "1.3",
  "messageType": "ConfigurationItemChangeNotification",
  "configurationItemDiff": {
    "changedProperties": {},
    "changeType": "CREATE"
  },
  "notificationCreationTime": "2020-06-28T21:53:59.121Z",
  "configurationItem": {
    "relatedEvents": [],
    "relationships": [{
        "resourceId": "default",
        "resourceType": "AWS::RDS::DBSubnetGroup",
        "name": "Is associated with DBSubnetGroup"
      },
      {
        "resourceId": "sg-0766c123456789",
        "resourceType": "AWS::EC2::SecurityGroup",
        "name": "Is associated with SecurityGroup"
      }
    ],
    "configuration": {
      "dBInstanceIdentifier": "smfg123456798",
      "dBInstanceClass": "db.t2.small",
      "engine": "mysql",
      "dBInstanceStatus": "creating",

348

CSM mApp Solutions

CSM mApp Solutions



      "masterUsername": "myfavusername",
      "dBName": "myDatabase",
      "allocatedStorage": 5,
      "preferredBackupWindow": "04:01-04:31",
      "backupRetentionPeriod": 1,
      "dBSecurityGroups": [],
      "vpcSecurityGroups": [{
        "vpcSecurityGroupId": "sg-0766c123456789",
        "status": "active"
      }],
      "dBParameterGroups": [{
        "dBParameterGroupName": "default.mysql5.7",
        "parameterApplyStatus": "in-sync"
      }],
      "availabilityZone": "us-east-1c",
      "dBSubnetGroup": {
        "dBSubnetGroupName": "default",
        "dBSubnetGroupDescription": "default",
        "vpcId": "vpc-ba848ec0",
        "subnetGroupStatus": "Complete",
        "subnets": [{
            "subnetIdentifier": "subnet-89d76487",
            "subnetAvailabilityZone": {
              "name": "us-east-1f"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-a0ccc19e",
            "subnetAvailabilityZone": {
              "name": "us-east-1e"
            },
            "subnetStatus": "Active"
          },
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          {
            "subnetIdentifier": "subnet-91758bf7",
            "subnetAvailabilityZone": {
              "name": "us-east-1b"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-119b125c",
            "subnetAvailabilityZone": {
              "name": "us-east-1d"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-76f20829",
            "subnetAvailabilityZone": {
              "name": "us-east-1a"
            },
            "subnetStatus": "Active"
          },
          {
            "subnetIdentifier": "subnet-e9f83cc8",
            "subnetAvailabilityZone": {
              "name": "us-east-1c"
            },
            "subnetStatus": "Active"
          }
        ]
      },
      "preferredMaintenanceWindow": "fri:05:22-fri:05:52",
      "pendingModifiedValues": {
        "masterUserPassword": "****",
        "processorFeatures": []
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      },
      "multiAZ": true,
      "engineVersion": "5.7.22",
      "autoMinorVersionUpgrade": true,
      "readReplicaDBInstanceIdentifiers": [],
      "readReplicaDBClusterIdentifiers": [],
      "licenseModel": "general-public-license",
      "optionGroupMemberships": [{
        "optionGroupName": "default:mysql-5-7",
        "status": "in-sync"
      }],
      "publiclyAccessible": true,
      "statusInfos": [],
      "storageType": "standard",
      "dbInstancePort": 0,
      "storageEncrypted": false,
      "dbiResourceId": "db-NRZ123456789",
      "cACertificateIdentifier": "rds-ca-2019",
      "domainMemberships": [],
      "copyTagsToSnapshot": false,
      "monitoringInterval": 0,
      "dBInstanceArn": "arn:aws:rds:us-east-1:123456789:db:smfg123456798",
      "iAMDatabaseAuthenticationEnabled": false,
      "performanceInsightsEnabled": false,
      "enabledCloudwatchLogsExports": [],
      "processorFeatures": [],
      "deletionProtection": false,
      "associatedRoles": []
    },
    "supplementaryConfiguration": {
      "Tags": [{
          "key": "aws:servicecatalog:productArn",
          "value": "arn:aws:catalog:us-east-1:123456789:product/prod-mv1234
56789"
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        },
        {
          "key": "aws:cloudformation:stack-name",
          "value": "SC-123456789-pp-yqf123456789"
        },
        {
          "key": "aws:servicecatalog:provisioningPrincipalArn",
          "value": "arn:aws:iam::123456789:user/Henri.Bryce"
        },
        {
          "key": "aws:cloudformation:stack-id",
          "value": "arn:aws:cloudformation:us-east-1:123456789:stack/SC-123
456789-pp-yqf123456789/0d913660-b989-11ea-abae-0a029b5a039d"
        },
        {
          "key": "aws:cloudformation:logical-id",
          "value": "MySQLDatabase"
        },
        {
          "key": "aws:servicecatalog:provisioningArtifactIdentifier",
          "value": "pa-z123456789"
        },
        {
          "key": "aws:servicecatalog:portfolioArn",
          "value": "arn:aws:catalog:us-east-1:123456789:portfolio/port-cfy1
23456789+"
        },
        {
          "key": "aws:servicecatalog:provisionedProductArn",
          "value": "arn:aws:servicecatalog:us-east-1:123456789:stack/plum-b
umblebee/pp-yqf123456789"
        }
      ]
    },
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    "tags": {
      "aws:servicecatalog:productArn": "arn:aws:catalog:us-east-1:123456789
:product/prod-mv123456789",
      "aws:cloudformation:stack-name": "SC-123456789-pp-yqf123456789",
      "aws:servicecatalog:provisioningPrincipalArn": "arn:aws:iam::12345678
9:user/Henri.Bryce",
      "aws:cloudformation:stack-id": "arn:aws:cloudformation:us-east-1:1234
56789:stack/SC-123456789-pp-yqf123456789/0d913660-b989-11ea-abae-0a029b5a03
9d",
      "aws:cloudformation:logical-id": "MySQLDatabase",
      "aws:servicecatalog:provisioningArtifactIdentifier": "pa-z123456789",
      "aws:servicecatalog:portfolioArn": "arn:aws:catalog:us-east-1:1234567
89:portfolio/port-cfy123456789+",
      "aws:servicecatalog:provisionedProductArn": "arn:aws:servicecatalog:u
s-east-1:123456789:stack/plum-bumblebee/pp-yqf123456789"
    },
    "configurationItemVersion": "1.3",
    "configurationItemCaptureTime": "2020-06-28T21:53:58.555Z",
    "configurationStateId": 1593381238555,
    "awsAccountId": "123456789",
    "configurationItemStatus": "ResourceDiscovered",
    "resourceType": "AWS::RDS::DBInstance",
    "resourceId": "db-NRZ123456789",
    "resourceName": "smfg123456798",
    "ARN": "arn:aws:rds:us-east-1:123456789:db:smfg123456798",
    "awsRegion": "us-east-1",
    "availabilityZone": "Multiple Availability Zones",
    "configurationStateMd5Hash": "",
    "resourceCreationTime": "2020-06-28T21:53:58.707Z"
  }
}
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Configure CSM to Add Incidents for AWS Product
Events

Prepare your CSM instance for creating new Incidents when your AWS resources go into Alarm state,
based on SNS messages.

Before you begin, complete the global steps outlined in Configure CSM for AWS. To support this use
case, you will also need to complete Configure AWS CloudWatch Alarms for CSM.

You can connect CloudWatch alarms so that when they go into alarm state, an Incident is created in CSM
and tied to the appropriate AWS Configuration Item in your CMDB. Depending on your usage of AWS,
you may already have configured AWS CloudWatch Alarms for your AWS resources. You can connect
these existing alarms, or you can create new ones.

Note: For our example, we will create a CloudWatch Alarm for CPU Usage on a specific EC2
instance. However, the principles are the same and the setup is similar for alarms of other types.
You may need to modify some of the JSON parsing in the workflow of One-Step™ Actions
connected to the Create AWS Event webhook.

The overall workflow for the automatic creation of Incidents for your AWS Product configuration items is
shown below:

A webhook triggers the Create AWS Event One-Step Action. This webhook was designed as a sample to
demonstrate how you might automatically create Incidents for your AWS resources when they go into
alarm state or violate an established rule. This sample expects a CloudWatch Alarm notification from
Amazon SNS, such as an EC2 instance which has exceeded its CPU utilization threshold, and stores the
JSON from that alarm notification in an AWS Event object record. Then, an automation process (AWS
Event) creates an Incident linked to the associated CI in your CMDB. You may wish to configure
additional, similar event types using either AWS CloudWatch or AWS Config. To facilitate this process, we
have included sample JSON for these event types, as well as configured the (None) Create AWS Event
One-Step Action with a decision tree that covers two possible paths: a notification from AWS Config that a
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CloudWatch Alarm has changed from OK to ALARM state, and a CloudWatch alarm which sends the
SNS notification directly with details about the affected resource. There is a sample of what kind of JSON
is expected for the event. It's very particular, so we provide relevant sample code.

To configure AWS CloudWatch Alarms for CSM:

1. In CSM Administrator, go to Managers > One-Step Action Managers, and then to Global >
Integrations > AWS.

2. Import the supplemental Create AWS Event from EventBridge mApp Solution from the mApp
Exchange.

3. In CSM Administrator, go to Managers > Webhook Managers, and then to Global > Integrations
> AWS. Update the Create AWS Event webhook to use the new One-Step Action imported in the
prior step.

4. Note: Webhook passwords should not correspond to any CSM logins. Instead, they are
arbitrary and used for the webhook only to enhance security.

If you have not already done so, in CSM Administrator, go to Managers > Webhook Manager and
set a custom webhook username and password for the AWS webhooks that were provided with the
mApp® Solution.

a. Copy the Full Endpoint from the General page of the Webhook Manager. Using the new
username and password you just set for the webhook, modify the copied URL to the fit the
following format; replace the sample information for webhook username and password, as well
as the external URL of your CSM server. https://
webhookUsername:webhookPassword@yourserverurl.com/CherwellAPI/api/
Webhooks/createawsevent

Configure any One-Step Action that parse incoming messages from AWS specific to your CloudWatch
Alarms. Specifically, check these:

5. Note: If you are not using AWS CloudWatch or AWS Config for your event source, you may
need to modify this One-Step Action to accommodate additional decision tree branches.

(None) Create AWS Event: Creates an AWS Event record from an incoming SNS notification.
Parses the incoming JSON based on whether stored values are set to enable AWS Config, AWS
CloudWatch, and the event source, as described above.

6. (AWS Event) Create Incident from Event: This creates the Incident and links it to the affected CI.
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Sample SNS message for a CloudWatch Alarm
State Change from AWS CloudWatch

This is a sample JSON response from AWS Config, sent via SNS. This message will be stored in an AWS
Event record before being processed by the (AWS Event) AWS Event automation process to an Incident
to your database and link the Incident to the affected CI in your CMDB. You can use this sample JSON to
test the Create AWS Event webhook.

            {
  "Type": "Notification",
  "MessageId": "836fe1ec-79e0-56b8-827f-b66569e37e11",
  "TopicArn": "arn:aws:sns:us-east-1:498849832712:update-cherwell-cmdb",
  "Message": "{\r\n   \"AlarmName\":\"Saffron-Octopus-RDS\",\r\n   \"AlarmD
escription\":null,\r\n   \"AWSAccountId\":\"498849832712\",\r\n   \"NewStat
eValue\":\"ALARM\",\r\n   \"NewStateReason\":\"Threshold Crossed: 1 datapoi
nt [2.1533759377604764 (20\/07\/20 21:07:00)] was greater than or equal to 
the threshold (0.0175).\",\r\n   \"StateChangeTime\":\"2020-07-20T21:12:01.
544+0000\",\r\n   \"Region\":\"US East (N. Virginia)\",\r\n   \"AlarmArn\":
\"arn:aws:cloudwatch:us-east-1:498849832712:alarm:Saffron-Octopus-RDS\",\r\
n   \"OldStateValue\":\"INSUFFICIENT_DATA\",\r\n   \"Trigger\":{\r\n      \
"MetricName\":\"CPUUtilization\",\r\n      \"Namespace\":\"AWS\/RDS\",\r\
n      \"StatisticType\":\"Statistic\",\r\n      \"Statistic\":\"AVERAGE\",
\r\n      \"Unit\":null,\r\n      \"Dimensions\":[\r\n         {\r\
n            \"value\":\"sm16lm1jrrjf0rk\",\r\n            \"name\":\"DBIns
tanceIdentifier\"\r\n         }\r\n      ],\r\n      \"Period\":300,\r\
n      \"EvaluationPeriods\":1,\r\n      \"ComparisonOperator\":\"GreaterTh
anOrEqualToThreshold\",\r\n      \"Threshold\":0.0175,\r\n      \"TreatMiss
ingData\":\"\",\r\n      \"EvaluateLowSampleCountPercentile\":\"\"\r\n   }\
r\n}",
  "Timestamp": "2020-07-15T14:08:03.824Z",
  "SignatureVersion": "1",
  "Signature": "JNdxahPfT0tVsX8+ZVPeA23M09UcCbIQ8uar5AZ4VqscGhzqpMcy4v00mlu
wr3eyJuFsogxhv1RprFIHU0ZH4bNRWxDpzdVnFIGVSnSBZDVi075ynf+oxagTLhSs7aa9Aar38R
cQicaYBc6kHiCg5FHIwwU1OXeehVjHavFKC1ymSegaxtD2pUG4jST30gC2P55I+qyFItPOj+Ih8
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ZqRBXc3H989mwDKU0Qa54/lQ0cFMC8YwZcQzqwSoZQwIvsrCzLjNR7l2IIEq4pk9d2thq9C/tyS
FNlXd4/HP/Vd6I9wuP08c0nspmmWxQY1X7CQOvwKway7V9WmKVpku3avxQ==",
  "SigningCertURL": "https://sns.us-east-1.amazonaws.com/SimpleNotification
Service-a86cb10b4e1f29c941702d737128f7b6.pem",
  "UnsubscribeURL": "https://sns.us-east-1.amazonaws.com/?Action=Unsubscrib
e&SubscriptionArn=arn:aws:sns:us-east-1:498849832712:update-cherwell-cmdb:e
0cff011-7a6a-4425-9c0c-e812474debe5"
}
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Sample SNS Message for an Incident Creation
This is a sample JSON response from AWS Config, sent via SNS. This message will be stored in an AWS
Event record before being processed by the (AWS Event) AWS Event automation process to an Incident
to your database and link the Incident to the affected CI in your CMDB. You can use this sample JSON to
test the Create AWS Event webhook.

            {
  "Type": "Notification",
  "MessageId": "836fe1ec-79e0-56b8-827f-b66569e37e11",
  "TopicArn": "arn:aws:sns:us-east-1:498849832712:update-cherwell-cmdb",
  "Message": "{\r\n  \"version\": \"0\",\r\n  \"id\": \"5f2af47e-43db-7cdb-
ae3b-bcdf0932659d\",\r\n  \"detail-type\": \"CloudWatch Alarm State Change\
",\r\n  \"source\": \"aws.cloudwatch\",\r\n  \"account\": \"498849832712\",
\r\n  \"time\": \"2020-07-09T14:30:01Z\",\r\n  \"region\": \"us-east-1\",\r
\n  \"resources\": [\"arn:aws:cloudwatch:us-east-1:498849832712:alarm:CPU U
sage Alarm\"],\r\n  \"detail\": {\r\n    \"alarmName\": \"CPU Usage Alarm\"
,\r\n    \"state\": {\r\n      \"value\": \"ALARM\",\r\n      \"reason\": \
"Threshold Crossed: 1 out of the last 1 datapoints [0.2706214689265534 (09\
/07\/20 14:20:00)] was greater than the threshold (0.05) (minimum 1 datapoi
nt for OK -> ALARM transition).\",\r\n      \"reasonData\": \"{\\\"version\
\\":\\\"1.0\\\",\\\"queryDate\\\":\\\"2020-07-09T14:30:01.387+0000\\\",\\\"
startDate\\\":\\\"2020-07-09T14:20:00.000+0000\\\",\\\"statistic\\\":\\\"Av
erage\\\",\\\"period\\\":300,\\\"recentDatapoints\\\":[0.2706214689265534],
\\\"threshold\\\":0.05}\",\r\n      \"timestamp\": \"2020-07-09T14:30:01.39
1+0000\"\r\n    },\r\n    \"previousState\": {\r\n      \"value\": \"INSUFF
ICIENT_DATA\",\r\n      \"reason\": \"Unchecked: Initial alarm creation\",\
r\n      \"timestamp\": \"2020-07-09T14:28:40.178+0000\"\r\n    },\r\n    \
"configuration\": {\r\n      \"metrics\": [{\r\n        \"id\": \"7ab999fd-
3d39-6f59-0f6a-47de61d53e46\",\r\n        \"metricStat\": {\r\n          \"
metric\": {\r\n            \"namespace\": \"AWS\/EC2\",\r\n            \"na
me\": \"CPUUtilization\",\r\n            \"dimensions\": {\r\
n              \"InstanceId\": \"i-0ee0478b095c210ba\"\r\n            }\r\
n          },\r\n          \"period\": 300,\r\n          \"stat\": \"Averag
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e\"\r\n        },\r\n        \"returnData\": true\r\n      }]\r\n    }\r\
n  }\r\n}",
  "Timestamp": "2020-07-15T14:08:03.824Z",
  "SignatureVersion": "1",
  "Signature": "JNdxahPfT0tVsX8+ZVPeA23M09UcCbIQ8uar5AZ4VqscGhzqpMcy4v00mlu
wr3eyJuFsogxhv1RprFIHU0ZH4bNRWxDpzdVnFIGVSnSBZDVi075ynf+oxagTLhSs7aa9Aar38R
cQicaYBc6kHiCg5FHIwwU1OXeehVjHavFKC1ymSegaxtD2pUG4jST30gC2P55I+qyFItPOj+Ih8
ZqRBXc3H989mwDKU0Qa54/lQ0cFMC8YwZcQzqwSoZQwIvsrCzLjNR7l2IIEq4pk9d2thq9C/tyS
FNlXd4/HP/Vd6I9wuP08c0nspmmWxQY1X7CQOvwKway7V9WmKVpku3avxQ==",
  "SigningCertURL": "https://sns.us-east-1.amazonaws.com/SimpleNotification
Service-a86cb10b4e1f29c941702d737128f7b6.pem",
  "UnsubscribeURL": "https://sns.us-east-1.amazonaws.com/?Action=Unsubscrib
e&SubscriptionArn=arn:aws:sns:us-east-1:498849832712:update-cherwell-cmdb:e
0cff011-7a6a-4425-9c0c-e812474debe5"
}
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Using the AWS mApp Solution
The AWS mApp Solution allows Portal users and licensed CSM users to provision an AWS product from
your organization's AWS Service Catalog, such as an EC2 instance, LAMP Stack, RDS instance, or S3
bucket.

When you use this mApp Solution to provision a product, this is the overall workflow.

When you request an AWS product, CSM makes a series of API calls behind the scenes, as described in
AWS Action Blocks. Once your request has been approved, the Provision Product call is made.

When you use this mApp Solution to terminate a product, this is the overall workflow.
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Provision an AWS Product from the CSM Portal
Unlicensed CSM users can provision an AWS product directly from the CSM Portal.

To provision an AWS product from the CSM Portal:

1. Log into the CSM Portal and access the service catalog.
2. Select Desktop Management > Computer > New CFT.
3. The AWS products you can choose from depend on the permissions you have.
4. Enter the Account Name, Portfolio, and Region, then select Request AWS Product.
5. In the pop-up dialog, select the AWS product you want.

Additional fields appear in the Additional Questions section based on the product you selected.
6. Complete the fields in the Additional Questions section. The fields vary depending on the AWS

product you request. Some fields are auto-populated.
7. Select Submit for Approval.

Once the Incident is approved, an automation process to provision the product begins. After the
product is provisioned, the Incident will reflect the new Configuration Item, and the Incident is
marked as closed.

The newly-provisioned AWS product is assigned a configuration item record and added to the CMDB.
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Provision an AWS Product from the Desktop Client
or Browser Client

Licensed CSM users can provision an AWS product directly from the Desktop Client or Browser Client.

To provision an AWS product from the Desktop Client or Browser Client:

1. Select New > New Incident.
2. In the Service Classification menu, select New CFT.

Enter required fields. You must enter a customer.
3. Under the Additional Questions section, enter the Account Name, Portfolio, and Region, then

select Request AWS Product.
4. In the pop-up dialog, select the AWS product you want.
5. Complete the fields in the Additional Questions section. The fields vary depending on the AWS

product you request. Some fields are auto-populated.
6. Select Submit for Approval.

Once the Service Request is approved, an automation process to provision the product begins. After
the product is provisioned, the Service Request will reflect the new Configuration Item, and the
Service Request is marked as closed.

Note: The Service request closes after provisioning initiates, but the CI may not be available
immediately. AWS products take varying amounts of time to provision; be aware that the
process is not instant. LAMP stacks, in particular, can take up to several hours to build.
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Manually Add an Existing AWS Configuration Item
You can add configuration items to the Cherwell CMDB for resources that have already been provisioned
in AWS.

While this mApp® Solution can be configured to automatically add configuration items to your CMDB
based on SNS messages from AWS Config, if you have existing AWS resources you may wish to add
those in as well.

1. In the Desktop Client or Browser Client, select New > New Configuration Item, then choose the
correct config type for your AWS Product:

a. Config - Cloud Services Database: for RDS instances
b. Config - Cloud Services Storage: for S3 buckets
c. Config - Cloud Services Virtual Machine: for EC2 instances

2. Complete the fields for the configuration item.
a.

Config - Cloud Services Database

Business Object
Field AWS element Message Config JSON Path

ARN Amazon Resource
Name (ARN) $.configurationItem.ARN

AWS Account AWS account ID n/a

Database Name Instance Identifier $.configurationItem.configuration.instanceId

Friendly Name
Provisioned
Product Name -
Instance Identifier

Provisioned Product Name:

$.configurationItem.tags.aws:servicecatalog:provisionedProductArn

Text After /

Text Before /pp-

Database Instance Identifier:

$.configurationItem.resourceName

Instance Class Instance Type $.configurationItem.configuration.dBInstanceClass

364

CSM mApp Solutions

CSM mApp Solutions



Business Object
Field AWS element Message Config JSON Path

Instance Name

Important:
This ID is
used in a
variety of
subsequent
mApp
Solution
features. It
is
particularly
important
to complete
this field
correctly.

DB Instance
Identifier $.configurationItem.configuration.dBInstanceIdentifier

Provisioned
Product ID

Provisioned
Product ID for the
instance

Important:
This ID is
used in a
variety of
subsequent
mApp
Solution
features. It
is
particularly
important
to complete
this field
correctly.

Provisioned Product Name:

$.configurationItem.tags.aws:servicecatalog:provisionedProductArn

Text After /

Text After /

Region Region where the
instance is located $.configurationItem.awsRegion

Size Size (GB) of
database $.configurationItem.configuration.allocatedStorage

Username Login name for DB
Owner $.configurationItem.configuration.masterUsername

Version Database Engine $.configurationItem.configuration.engine

b.
Config - Cloud Services Storage
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Business
Object
Field

AWS element Message Config JSON Path

ARN Amazon Resource
Names (ARNs) $.configurationItem.ARN

AWS
Account AWS account ID n/a

Friendly
Name

Provisioned
Product Name -
Instance Identifier

Provisioned Product Name:

$.configurationItem.tags.aws:servicecatalog:provisionedProductArn

Text After /

Text Before /pp-

Bucket:

$.configurationItem.resourceName

Text After Next word bucket-

Name

Bucket Name

Important:
This name
is used in a
variety of
subsequent
mApp
Solution
features. It
is
particularly
important
to complete
this field
correctly.

$.configurationItem.configuration.name
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Business
Object
Field

AWS element Message Config JSON Path

Provisioned
Product ID

Provisioned
Product ID for the
instance

Important:
This ID is
used in a
variety of
subsequent
mApp
Solution
features. It
is
particularly
important
to complete
this field
correctly.

Provisioned Product Name:

$.configurationItem.tags.aws:servicecatalog:provisionedProductArn

Text After /

Text After /

Region Region where the
instance is located $.configurationItem.awsRegion

c.
Config - Cloud Services Virtual Machine

Business Object
Field AWS element Message Config JSON Path

ARN Amazon Resource
Names (ARNs) $.configurationItem.ARN

AWS Account AWS account ID n/a

Client Token AWS Client Token $.configurationItem.configuration

Friendly Name
Provisioned
Product Name -
Instance Identifier

Provisioned Product Name:

$.configurationItem.tags.aws:servicecatalog:provisionedProductArn

Text After /

Text Before /pp-

Instance Identifier:

$.configurationItem.resourceId
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Business Object
Field AWS element Message Config JSON Path

Host Name

Important:
This ID is
used in a
variety of
subsequent
mApp
Solution
features. It
is
particularly
important
to complete
this field
correctly.

Instance Identifier $.configurationItem.configuration.instanceId

Instance Type Instance Type $.configurationItem.configuration.instanceType

Launch Time Launch Time of the
instance $.configurationItem.configuration.launchTime

MACAddress MAC Address of
the instance $.configurationItem.configuration.networkInterfaces[0].macAddress

Private DNS Name Private DNS name
of the instance $.configurationItem.configuration.privateDnsName

Private IP Address Private IP address
of the instance $.configurationItem.configuration.privateIpAddress

Provisioned
Product ID

Provisioned
Product ID for the
instance

Important:
This ID is
used in a
variety of
subsequent
mApp
Solution
features. It
is
particularly
important
to complete
this field
correctly.

Provisioned Product Name:

$.configurationItem.tags.aws:servicecatalog:provisionedProductArn

Text After /

Text After /

Public DNS Name Public DNS name
of the instance $.configurationItem.configuration.publicDnsName
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Business Object
Field AWS element Message Config JSON Path

Public IP Address Public IP address of
the instance $.configurationItem.configuration.publicIpAddress

Region Region where the
instance is located $.configurationItem.awsRegion
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Manage an AWS Configuration Item
Customers can access their own AWS CIs in the CMDB.

Customers can access their provisioned products in the CSM Portal. However, it is important to note that
changes to record details on the CIs do not update AWS. The only action that will affect resources in AWS
is the Terminate Provisioned Product link under the Actions menu.

In the CSM Portal, select My Items > Devices Assigned to Me. From this dashboard, a customer can
open a CI record for which they are the primary customer. This CI record will contain basic details about
the AWS resource, depending on what was configured in your CloudFormation Templates (CFTs), and in
the Create Config Item One-Step™ Action. Customers can also choose the Open in AWS Console link
under the Actions menu to open the AWS console in a browser window. In this case, they will need a
direct login to AWS in order to see details there.
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Terminate an AWS Configuration Item from the
CSM Portal

Unlicensed CSM users can provision an AWS product directly from the CSM Portal.

To terminate an AWS product:

1. In the CSM Portal, select My Items > Devices Assigned to Me.
2. Open the AWS CI and select Terminate Provisioned Product.

Confirm you want to terminate the product. Once you terminate an AWS product, it is marked as
retired in the CMDB. The AWS resource will be permanently deleted, and you cannot recover this.
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Terminate an AWS Configuration Item from the
Desktop Client or Browser Client

Licensed CSM users can terminate an AWS product directly from the Desktop Client or Browser Client.

To terminate an AWS product:

1. In the Desktop Client or Browser Client, open the CMDB.
2. Open the AWS CI and select Terminate Provisioned Product.

Confirm you want to terminate the product. Once you terminate an AWS product, it is marked as
retired in the CMDB. The AWS resource will be permanently deleted, and you cannot recover this.
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Troubleshooting the AWS mApp Solution
Troubleshooting solutions for the AWS mApp Solution.

• Why do I see an error that says "List Provisioning Artifacts execution halted, action block
parameter ProductID is required"?

You may see this message when one of your Action Blocks has failed, and did not generate the
required parameter for the next Action Block in the chain. Make sure that you are passing in exactly
the values that match AWS, such as with the PortfolioID. Check that the PortfolioID is valid for AWS,
and ensure there are no leading or trailing spaces for values pasted into the AWS Portfolio record in
CSM.

• I need to change or update a One-Step™ Action.

There are several pop-up Actions in this One-Step Action that are set up for troubleshooting
purposes; they are set to display only if Debug equals true. If you must change a One-Step Action,
set this value to true so the action will display debug pop-ups.

• I loaded a .czar on my system, and now the webhooks aren't processing.
◦ Ensure you have created AWS Accounts with secret keys and AWS Portfolios.

◦ Ensure you have added departments to the AWS Portfolios.

◦ Set the encryption key in the Cherwell Encryption Key stored value.

◦ Give the Anonymous Browser security group view permissions for webhooks.

◦ Give the Portal Customer and Portal Workgroup Manager security groups view, add, and edit
permissions on the Specifics - AWS Provision Supporting Business Object.

• Configuration Items are being terminated, but not marked as Retired

The Terminate Provisioned Product One-Step Action is set to update the status and create journals
if the Return Result of the preceding Terminate Provisioned Product Action block is "OK OK".
However, sometimes the return from AWS is "OKOK" (without the space). You may need to adjust
accordingly for your specific AWS-side configuration.
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Cannot Complete AWS Provision Form
If users cannot successfully complete the form, this topic aims to help you troubleshoot potential issues.

You can make a request to provision an AWS product from either the CSM Portal or the Browser Client.
Once you make the request, it must be submitted for approval. After it's approved, the provision product
call is made to the AWS API using the key credentials you added to the AWS Account table, and provided
access to via the AWS Portfolio table.

CSM Portal

• Problem: Cannot see field drop-down menus to select the AWS Account.

Solution: If you see something like the image here, you likely need to set appropriate permissions
for your portal customer security groups, as described in this topic: Configure Security Groups for
the AWS mApp Solution .

CSM Portal or Browser Client

• Problem: Cannot see available accounts in the AWS Account drop-down menu.
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Solution: To resolve the issue shown here, check through these configuration steps:

◦ Ensure that there are valid portfolios in the AWS Portfolio table, as described in Add
Departments to the AWS Portfolio Supporting Object. The Portfolio ID and Portfolio Name
should exactly match the Portfolio ID and Name in your AWS account.

◦ Confirm that the user who is attempting the request in the CSM Portal belongs to a department
that is linked to a valid portfolio within the account. For more information on this configuration,
see: Grant AWS Account Access to CSM Users.

• Problem: Nothing happens after selecting Request AWS Products.
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Solution: If your API call to request products is successful, you will see a prompt like this one:

If you select Request AWS Products and nothing appears to happen, likely one of your calls to the
AWS API has failed. There are several common reasons for this failure; check the following
configuration steps:

◦ Ensure that the account whose AWS keypair you are using for the calls has appropriate
permissions to see items in the AWS Portfolio, as described in Configure AWS IAM for CSM.

◦ Each of the API call Action Blocks has a Debug parameter. When enabled, these turn on a
series of pop-up windows that give you more information about the API call responses. To get
more insight into this problem, turn on debugging for the Request Product One-Step Action,
located at (Incident)Global > Integrations > AWS.

◦ To turn on One-Step Action debugging in the CSM Desktop Client or Browser Client,
open the One-Step Action.

◦ Select the One-Step Action and select Parameters. Select the Debug parameter and
enter a value of TRUE.

◦ Save the One-Step Action and try your request again. You should now see additional
pop-up windows that indicate the response to your API call, similar to the one shown
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here:
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AWS Product Not Provisioned
If you have completed the request to provision form, but you do not see any items provisioned in your
AWS account, follow these steps to troubleshoot.

Before you begin these steps, you should have worked through any issues in Cannot Complete AWS
Provision Form and be able to successfully complete the form requesting the AWS product.

1. Problem: No product provision in AWS Console

Solution: If you log into the AWS Console and you cannot see at least an attempt to provision a
product, there are two possibilities. Either your call was not made, or it failed. The ProvisionProduct
API call is not actually made until after the request has been approved, so it is important to ensure
that the approval process has successfully completed before moving on to other troubleshooting
steps.

To check that the call was made, open the CSM Desktop Client and navigate to the request, then:
a. From your current record, select Tools > Current Record Automation Processes.
b. There should be two Automation Processes that run against this request. The first, Incident

Approval Process, should show as successfully completed. This indicates that the provision
product request has been attempted.

If you do not see anything in this tool:

◦ Open Cherwell Server Manager and confirm that your Cherwell Service Host is turned
on and pointed to the database connection on which you are currently making the
request.

◦ Confirm that the approval tied to your Service Request has been approved. Confirm that
your Service Request has also been saved.

If you confirm that your Incident Approval Process has a status of completed and shows
Executed Approval actions for an AWS Request block, then you know that the
ProvisionProduct API call was made and the failure may have occurred at that point. Proceed
to the next steps.

If you have confirmed that the API call has been made, you can turn on debugging for your
Provision Product One-Step™ Action, located at (Incident) > Global > Integrations > AWS.

a. To turn on One-Step Action debugging in the CSM Desktop Client or Browser Client, open the
One-Step Action.

b. Select the One-Step Action and select Parameters. Select the Debug parameter and enter a
value of TRUE.
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c. Save the One-Step Action and try your request again. You should now see additional pop-up
windows that indicate the response to your API call, similar to the one shown here:

Once you have enabled debugging, you can try the One-Step Action again manually against your
service request to see additional details.

2. Problem: AWS user associated with stored account key does not have provisioning permissions

It's also possible that your provisioning issue is related to the permissions that the user to whom
your authentication key is tied does not have permission to provision the specific product you
requested.

Solution: To test that your AWS key has appropriate permissions to provision the product, try
launching it directly from the AWS console.
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Configuration Item Not Created in CMDB
If your product has provisioned in your AWS account, but you do not see the automatic creation of a
Configuration Item in the CMDB, follow these steps to troubleshoot.

Before you begin these steps, you should have worked through any issues described in AWS Product Not
Provisioned and be able to successfully complete the provision of an AWS product.

After you can see a successfully provisioned product in your AWS account, your incident should close
and show that the provisioned CFT has a status of 'Active.' You should see a new CI connected to it and
in your CMDB after a short period of time, from 5-10 minutes. If you do not, here are the steps to check.

1. Problem: Server not open to the public.

Solution: If your server does not have an external-facing address, you will not be able to hit any of
the webhooks. You can confirm that this is set up correctly by accessing the Browser Client from a
machine other than your CSM server.

2. Problem: SNS subscription cannot confirm.

Solution: Your SNS subscription should be able to confirm automatically. If it doesn't, check to
make sure your password is correctly entered in the webhook and in SNS.

Note: If you have complex characters in your password, make sure they are properly
encoded for URL transmission. For more information, see: HTML URL Encoding Reference.

3. Problem: SNS message not sent.

Solution: Once you are confident that your SNS subscription for the CSM webhook is correct,
ensure the message has been sent by SNS.

You can set up a Hookbin subscription for your SNS topic (see https://hookbin.com/), or another
service to receive the JSON sent by SNS. This will serve the dual purpose of allowing you to see
precisely what SNS has sent your webhook, but also confirm that the message has been sent.

Note: Make sure you leave the tab with your Hookbin URL open or you won't be able to get
back to the results. If you accidentally close the tab, you will need to recreate the Hookbin
endpoint and recreate your SNS subscription.

4. Problem: Message stuck in RabbitMQ.

When SNS hits the webhook successfully, you will see a log message in the CSM Web API log as
follows:

{"Level":"STATS","Message":"Execution of Post took 477
            Milliseconds.","TimeStamp":"2020-12-04T21:27:47.5775259+00:
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00","ThreadName":"Thread_14","Domain":null,"pid":"11908","DebugCategory
":"InfoLogMessage","Host":"EC2AMAZ-KBCFCVH","Object[]":"[\"ActionName\"
,\"Post\",\"RequestUri\",\"https://awsmapp.cherwelltest.com/CherwellAPI
/api/Webhooks/createawsevent\",\"ElapsedTime\",477,\"RequestContentSize
\",2108,\"ResponseContentSize\",null,\"ResponseStatusCode\",200]"}

Solution: If you see this message in the logs, but you do not see your object in the staging table,
you can check RabbitMQ to confirm that it has not gotten stuck in queue. If it has, try restarting the
Cherwell Service Host and testing your provision again.

5. Problem: Staging table object is created, but corresponding CI or Incident is not created.

Solution: If the object created by your webhook (either AWS Event or AWS Config Staging) has
been created but you do not see a corresponding Incident or Configuration Item, you can check
these things:

◦ Ensure your Cherwell Service Host is turned on and pointed to the correct database.
◦ To navigate to the staging object, select Searching > Quick Search Builder. Select the

staging object (either AWS Event for Incidents or AWS Config Staging for Configuration
Items).

◦ From your current record, select Tools > Current Record Automation Processes.
◦ If any of your automation processes have failed, double-click that item to get additional details

on what caused the failure.
◦ Confirm the JSON parsing in any associated One-Step™ Actions is configured to the specific

response you are receiving. You may find these tools useful in assessing what kind of parsing
is required:

◦ JSON Formatter and Validator: Useful for evaluating whether the test JSON you are
using in the link below is valid.

◦ JSONPath Online Evaluator: Useful for evaluating whether the parsing currently used
gives you the expected value.
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Incident Not Created for a CI with an Alarm
If your CI alarms have been triggered but you see no Incident, follow these steps to troubleshoot.

Before you begin these steps, you should be able to successfully complete the form requesting the AWS
product, as described in Cannot Complete AWS Provision Form, including getting specific CFT details for
the AWS products in your Service Catalog portfolio.

After you can see a successfully provisioned product in your AWS account and received the CI in your
CMDB, you may wish to automatically create incidents for your CI if it has an event. If you follow the
configuration steps for this case but cannot see your incident, follow these troubleshooting steps.

1. Problem: Event alarm not in alarm state.

Solution: Before you begin troubleshooting the Incident, confirm that your alarm is in alarm state. If
it has gone into alarm state and your system was not yet configured, you may need to move it out of
alarm state and back in again to get the proper notification to create the Incident.

2. Problem: SNS subscription cannot confirm.

Solution: Your SNS subscription should be able to confirm automatically. If it doesn't, check to
make sure your password is correctly entered in the webhook and in SNS.

Note: If you have complex characters in your password, make sure they are properly
encoded for URL transmission. For more information, see: HTML URL Encoding Reference.

3. Problem: SNS message not sent.

Solution: Once you are confident that your SNS subscription for the CSM webhook is correct,
ensure the message has been sent by SNS.

You can set up a Hookbin subscription for your SNS topic (see https://hookbin.com/), or another
service to receive the JSON sent by SNS. This will serve the dual purpose of allowing you to see
precisely what SNS has sent your webhook, but also confirm that the message has been sent.

Note: Make sure you leave the tab with your Hookbin URL open or you won't be able to get
back to the results. If you accidentally close the tab, you will need to recreate the Hookbin
endpoint and recreate your SNS subscription.

4. Problem: Message stuck in RabbitMQ.

When SNS hits the webhook successfully, you will see a log message in the CSM Web API log as
follows:

{"Level":"STATS","Message":"Execution of Post took 477
            Milliseconds.","TimeStamp":"2020-12-04T21:27:47.5775259+00:
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00","ThreadName":"Thread_14","Domain":null,"pid":"11908","DebugCategory
":"InfoLogMessage","Host":"EC2AMAZ-KBCFCVH","Object[]":"[\"ActionName\"
,\"Post\",\"RequestUri\",\"https://awsmapp.cherwelltest.com/CherwellAPI
/api/Webhooks/createawsevent\",\"ElapsedTime\",477,\"RequestContentSize
\",2108,\"ResponseContentSize\",null,\"ResponseStatusCode\",200]"}

Solution: If you see this message in the logs, but you do not see your object in the staging table,
you can check RabbitMQ to confirm that it has not gotten stuck in queue. If it has, try restarting the
Cherwell Service Host and testing your provision again.

5. Problem: Staging table object is created, but corresponding CI or Incident is not created.

Solution: If the object created by your webhook (either AWS Event or AWS Config Staging) has
been created but you do not see a corresponding Incident or Configuration Item, you can check
these things:

◦ Ensure your Cherwell Service Host is turned on and pointed to the correct database.
◦ To navigate to the staging object, select Searching > Quick Search Builder. Select the

staging object (either AWS Event for Incidents or AWS Config Staging for Configuration
Items).

◦ From your current record, select Tools > Current Record Automation Processes.
◦ If any of your automation processes have failed, double-click that item to get additional details

on what caused the failure.
◦ Confirm the JSON parsing in any associated One-Step™ Actions is configured to the specific

response you are receiving. You may find these tools useful in assessing what kind of parsing
is required:

◦ JSON Formatter and Validator: Useful for evaluating whether the test JSON you are
using in the link below is valid.

◦ JSONPath Online Evaluator: Useful for evaluating whether the parsing currently used
gives you the expected value.
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Troubleshooting AWS mApp Solution Webhooks
You can use an external service such as Hookbin to collect and view SNS messages to ensure that you
are receiving the message you expect. If you are receiving the proper message but do not see it being
processed, check RabbitMQ. CSM uses RabbitMQ for processing webhook requests.

SNS Message Troubleshooting

1. Visit the URL to confirm your subscription after you request confirmation.
2. Make sure you leave this tab open or you won't be able to get back to the results. If you accidentally

close the tab, you will need to recreate the Hookbin endpoint and recreate your SNS subscription.

Testing Your JSON Parsing

3. You can use the Test Webhook feature in the mApp Solution to ensure that the JSON you are
receiving from SNS is being parsed as expected.

4. In CSM Administrator, go to Browser and Mobile > Webhook Manager and edit the webhook you
are troubleshooting.

5. Under the Action tab, select Test Webhook and paste in the JSON you received to your Hookbin
subscription.

6. Select Run and check to see if an appropriate object was created in CSM.

RabbitMQ Troubleshooting

7. Before trying the steps below, try restarting the Cherwell Service Host, as it may resolve any
RabbitMQ issues. If it does not, proceed to the next steps.

8. Stop the Cherwell Service Host.

9. Important: Deleting these queues will delete anything in progress in a production system,
so take care with the steps below to ensure you do not inadvertently purge additional data.

Delete any duplicate Exchanges and Queues. These will be recreated on Cherwell Service Host
start.

a. Delete all CSM Exchanges.
b. Delete all CSM-related queues.

10. Start the Cherwell Service Host.
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AWS mApp Solution Items
This is a high-level list of items included when applying the AWS mApp Solution.

Business Objects

• Major
◦ AWS Config Staging

◦ AWS Event

◦ Config - Cloud Services Database

◦ Config - Cloud Services Storage

◦ Config - Cloud Services Virtual Machine

• Supporting
◦ AWS Account

◦ AWS Portfolio

◦ Specifics - AWS Provision

• Lookup Tables
◦ AWS Deployment Status

◦ AWS Region

◦ Cloud Services - Providers

Automation Processes
AWS Event: Create an event based on AWS event details. This is set up to work with the specific JSON
scenarios included with this mApp Solution. It triggers the Create Incident from Event One-Step™ Action.

One-Step™ Actions

• Create Config Item

• Provision Product

• Provisioning Status

• Request Product

Webhooks
The AWS mApp Solution includes two webhooks:

• Create AWS Event: Includes four expressions
◦ AWS Cloudwatch Only

◦ AWS Config and AWS Cloudwatch
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◦ AWS Config Only

◦ AWS Enabled Services

• Create AWS Config Staging Record: this triggers the Create AWS Config Staging One-Step™
Action.
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BeyondTrust (Formerly Bomgar) Remote Support
mApp Solution 3.1

Use the BeyondTrust Remote Support mApp® Solution to launch real-time remote support sessions
directly from CSM.

Cherwell version requirements: Tested on CSM 9.6.x — 10.2.0.

Content version requirements: Tested on CSM 9.6.0 — 10.2.0; this mApp Solution may or may not be
compatible on content versions earlier than CSM 9.6.0, but as with all mApp Solutions, be sure to test it
on your customized system.

BeyondTrust version requirements: 18.2.3; may be compatible with earlier versions, but functionality is
not guaranteed

Prerequisites:

• BeyondTrust URL

• BeyondTrust Account Username

• BeyondTrust Account Password

• BeyondTrust API Client ID

• BeyondTrust API Client Secret

• Target path to BeyondTrust.exe (or bomgar-rep.exe)*

• Incident Business Object ID** (if applicable)

• Journal Remote Session History Business Object ID** (if applicable)

*The easiest way to get the target path for your local BeyondTrust.exe is to create a shortcut to your
BeyondTrust Representation Console on your desktop. On the shortcut, right-click and select Properties.
Select the Shortcut tab and copy the path in the Target field.

**To find the Business Object ID, see Step 5 in Define Advanced Properties for a Business Object.

Overview
The BeyondTrust Remote Support mApp Solution provides functionality that enables secure, real-time
remote support sessions. CSM technicians and customers can launch remote support sessions directly
from CSM to encourage real-time collaboration and fast resolution of IT issues. Session details (example:
Chat conversation history) can then be stored in an applicable Business Object.

CSM integrates with BeyondTrust's remote support services using the BeyondTrust Application
Programming Interface (API). BeyondTrust remote support service commands are configured in CSM so
technicians can launch remote support sessions directly from any CSM Business Object. Technicians and
customers can initiate these sessions through the CSM Desktop Client or CSM Portal. At the end of a
session, CSM Business Objects (example: Incidents and Change Requests) are created or updated to
store the session's details in the Business Object's Journal.
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The CSM remote support integration allows customers to request immediate assistance with IT issues
and to communicate real-time with technicians through a chat window in the Portal. Technicians provide
remote support to customers through the BeyondTrust Representative Console. The Console is the
interface that BeyondTrust provides for technicians to chat with customers, remotely control their
computers and share files, to resolve the customer's issues.

Note: To use BeyondTrust remote support capabilities in CSM, a BeyondTrust Appliance must be
purchased, installed, and configured. Refer to the BeyondTrust website for more details
(www.beyondtrust.com). In addition, customers must have at least one BeyondTrust account that
CSM can use to make API requests to BeyondTrust. Technicians that use the BeyondTrust
Representative Console to conduct remote support sessions with customers also need individual
BeyondTrust accounts to download and use the Console.

Apply the mApp Solution
Follow these steps to download and apply the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

4. When prompted, enter the Business Object IDs, BeyondTrust/Bomgar URL, API Client ID, and API
Client Secret. Select the Open a Blueprint so that I can preview the changes option. Before you
publish the Blueprint, you need to configure the mApp Solution.

For a list of items included in the mApp Solution, see BeyondTrust mApp Solution Items.

Configure Settings in BeyondTrust
Follow these steps to configure the settings in BeyondTrust:

1. Configure the Outbound Event in BeyondTrust.

2. Configure the BeyondTrust API.

3. Configure the API Fields in BeyondTrust.

Configure the mApp Solution
Follow these steps to configure the mApp Solution:

1. Define CSM remote support.

2. Update the URL in the Web Service Object.

3. Set the Journal - Remote Support History as the default Form.

4. Add BeyondTrust Form elements to Incident Forms.
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5. Add BeyondTrust Form elements to the view-only Portal Incident Form.

6. Add BeyondTrust Form elements to the Portal Configuration Item Form.

7. Define BeyondTrust menu bar option.

8. Define security rights for Portal Customers and Workgroup Managers.

9. Define the automation process for Business Hours.

10. Define the Configure BeyondTrust Path One-Step Action.

11. Configure the Outbound Event in BeyondTrust.

12. Configure the BeyondTrust API.

13. Configure the API Fields in BeyondTrust.

For more details on these steps, see Configuring the BeyondTrust Remote Support mApp Solution.

Use the mApp Solution
Follow these steps to use the mApp Solution:

1. Test the BeyondTrust Integration.

2. Conduct a Remote Support Session using the BeyondTrust Representative Console.

3. Launch a Remote Support Session from the CSM Desktop Client (CSM technicians).

4. Launch a Remote Support Session from the CSM Portal (customers).

For more details on these steps, see Using the BeyondTrust mApp Solution.

Revision History

mApp Version Platform Version
Requirements

Content Version
Requirements Prerequisites

3.1 Tested on 9.6.x — 10.2.0.

Tested on 9.6.0 — 10.2.0;
this mApp Solution may or
may not be compatible on
content versions earlier
than 9.6.0, but as with all
mApp Solutions, be sure
to test it on your
customized system.

BeyondTrust URL,
BeyondTrust Account
Username, BeyondTrust
Account Password,
BeyondTrust API Client
ID, BeyondTrust API
Client Secret, Target path
to BeyondTrust.exe (or
bomgar-rep.exe), Incident
Business Object ID,
Journal Remote Session
History Business Object
ID

Related concepts
Go to the Cherwell Marketplace (formerly the mApp Exchange)
Apply a mApp Solution
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Configure the BeyondTrust API
About mApp Solutions
Related tasks
Configure the Outbound Event in BeyondTrust
Configure the API Fields in BeyondTrust
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Define BeyondTrust Stored Values
Define BeyondTrust Stored Values for One-Step Actions that control buttons and links.

During the installation of the BeyondTrust Remote Support mApp Solution, you are prompted to define
several Stored Values. The values are used by One-Step Actions that control BeyondTrust buttons and
links on the Incident and Configuration Item forms (Generate Session Key, Initiate Remote Control, Chat
with Support Representative, and Chat with Support).

For additional information, see About Stored Values.

To define the BeyondTrust Stored Values, provide a value for each of the following Stored Values:

• BeyondTrust Client ID: Provide the BeyondTrust Client ID in the Value Field.

• BeyondTrust Client Secret: Provide the BeyondTrust Client Secret in the Value Field.

• BeyondTrust URL: Provide the URL for the BeyondTrust server in the Value Field.

• Incident Object ID: Provide the Incident ID in the Value Field. The value can be found in the
Business Objects Properties window (Advanced page).

• Journal Object ID: Provide the Journal ID in the Value Field. The value can be found in the Business
Objects Properties window (Advanced page).
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Configuring the BeyondTrust Remote Support
mApp Solution

Configure the BeyondTrust Remote Support mApp Solution using CSM Administrator.

Complete the following procedures to configure the BeyondTrust Remote Support mApp Solution:

1. Define CSM remote support.

2. Update the URL in the Web Service Object.

3. Set the Journal - Remote Support History as the default Form.

4. Add BeyondTrust Form Elements to Incident Form.

5. Add BeyondTrust Form Elements to the View-Only Portal Incident Form.

6. Add BeyondTrust Form Elements to the Portal Configuration Item Form.

7. Define BeyondTrust menu bar options.

8. Set security rights for Portal Customers and Workgroup Managers.

9. Define the Automation Process for Business Hours.

10. Define the Configure BeyondTrust Path One-Step.

11. Configure the Outbound Event in BeyondTrust.

12. Configure the BeyondTrust API.

13. Configure the API Fields in BeyondTrust.
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Define CSM Remote Support Settings for the
BeyondTrust Remote Support mApp Solution

Define CSM remote support settings in CSM Administrator.

Use the Chat and Remote Support Connector Settings window to configure how CSM accesses and
initiates BeyondTrust remote support, how CSM identifies Customers requesting remote support, and
which Business Objects are linked to remote support sessions.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp® Solution. For more information, refer to the mApp Solution Tech Notes documentation.

To define CSM remote support settings:

1. In CSM Administrator, select Settings, and then select Edit Chat and Remote Support Connector
Settings.
The Chat and Remote Support Connector Settings window opens.

2. Define the General page options for remote support:

Setting Description

Enable Chat and Remote Control
Services Verify this check box is cleared.

Service URL Provide the base URL for the remote support service API.
Security Warning: Use HTTPS for this URL to ensure security.

Chat Server IP Address Leave default settings.

Chat Service Credentials Provide the User Name and Password for a remote support
service user authorized to perform API requests.

Cherwell Credentials for Processing
Chat Service Events

Select the Use Specific CSM User radio button.

Use a CSM User login (internal or Windows user). Provide the
User name and Password of the CSM User that is used for logging
in to process remote support events. This User must have the
proper security rights to process events, run CSM, and create or
modify Business Objects and Customer Records.
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Setting Description

Chat Service Technician Queue

These options (only supported in CSM) allow CSM technicians to
have remote support sessions placed in their personal queues in
the BeyondTrust Representative Console.

Select Technician Queue Using Current User Login: Match the
user name for the currently logged-in CSM technician against the
usernames of all CSM technicians who are currently logged into
the BeyondTrust Representative Console. If a match is found, the
remote support session is created within that technician’s queue.

Select Technician Queue Using Login Stored In Current User
Business Object: Match the user name stored in a Field in the
User Business Object (UserInfo) for the currently logged-in
technician against the user names of all technicians who are
currently logged into the BeyondTrust Representative Console. If a
match is found, the remote support session is created within that
technician’s queue. To indicate which Field contains the
technician's User name, add an attribute with the name
ChatUserName to the Field. For more information about Field
attributes, see Define Advanced Properties for a Field.

Note: If both options are selected, the first option is tried first and if
no match can be found, the second option is tried. If still no match
can be found, the BeyondTrust team queue is determined by the
selected or specified support issue.

Chat Service Support Issue Queue

These options determine whether a Customer can select from a
list of support issues when launching a remote support session, or
whether all remote support sessions launched by Customers are
categorized under a specified support issue.

Prompt for Support Issue: Select this option to have a pop-up
open for the Customer to select from a list of issues downloaded
from the BeyondTrust configuration website.

Always Use a Specific Support Issue: Automatically use a
specified issue. Default indicates that the request should be placed
in the general queue in the BeyondTrust Representative Console.

Select Issue: Select a specific issue to use, which determines the
queue the request is placed in.

Note: If issues are changed in the BeyondTrust configuration
website, it might be necessary to reset the Specific Support Issue
in CSM.

Note: If the Technician queue options described above are
enabled and a Technician match is found, the support issue queue
options are ignored and the remote support session is created in
the technician’s personal queue.

Chat Invitation E-mail
(Optional) Create a remote support session invitation e-mail
template that CSM technicians can use to invite Customers to
remote support sessions.

3. Select OK.
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Update the URL in the Web Service Object
Update the URL in the Web Service Object with your BeyondTrust URL.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp Solution.

To update the URL in the Web Service Object:

1. In CSM Administrator, select Browser and Mobile Settings and select Web Services Manager.
2. In the Web Services Manager, right-click BeyondTrust > Edit.
3. In the Web Service Options window, fill out the information on the General page as follows:

Option Description

Name BeyondTrust

Description Leave with default description

URL Provide your BeyondTrust URL

Service Type REST

Security Type None

Always call web services from Cherwell
Server check box

Select

Log calls to this web service (depending
on system settings, might happen
anyway) check box

Select

4. Select OK and then select Close.
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Set the Journal - Remote Support History Form as
the Default

Set the Journal - Remote Support History Form as the default Form for easier access to information on
remote sessions.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp Solution. For more information, refer to the mApp Tech Notes documentation.

To set the Journal - Remote Support History Form as the default:

1. Use the Form Editor (accessed from within a Blueprint in CSM Administrator) and filter the Business
Objects by clicking the Supporting option.

2. From the Form drop-down list, select BeyondTrust Report.
3. From the menu bar, select Form > Make this the default standard form.

4. Select Yes.

5. From the Form drop-down list, select Default Form.

6. From the menu bar, select Form > Form properties. Rename the Form to something that will label
it as the old Form (example: Old Default Form).
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Add BeyondTrust Form Elements to the Incident
Form

Use the Form Editor to add BeyondTrust Form Controls to Incident Forms.

The Form Controls provide two buttons: one generates a session key and the other allows remote control
for a technician.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp Solution. For more information, refer to the mApp Solution Tech Notes documentation.

To add Form Controls to the Incident Form:

1. In the Business Object tree, select Incident.

2. Select the Form button .

Tip: You can also select View>View Form (from the Object Manager menu bar) or select the Edit
Form link (under the Appearance area).

3. From the Form drop-down list, select the BeyondTrust Controls Form.
a. Select the Generate Session Key and Initiate Remote Session Form Controls

simultaneously.

Note: If the Primary CI field does not contain a Computer-CI on the Incident, the
Initiate Remote Control button is disabled and does not show on the Form.

398

CSM mApp Solutions

CSM mApp Solutions



b. From the menu bar, select Edit>Copy.

4. From the Form drop-down list, select Default Form (for CSM OOTB content versions earlier than
9.6.0). For CSM OOTB content version 9.6.x or later, select Incident Overview (If a pop-up displays
that says Apply changes to Incident form back to the Blueprint, select Yes.).

a. From the menu bar, select Edit>Paste.

The Form Controls display on the Form.

Note: The BeyondTrust Form Controls are pasted in a defined location for the default
Incident Form. If you have a custom Form, move the Form Controls to a location that
fits your Form design. If you have multiple Adaptive Layouts, paste and move the Form
Controls on to each one. If you are using multiple languages, adjust the location of the
Form Controls on those layouts.

5. Select the Update Blueprint button , and then select the Home button .
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Add BeyondTrust Form Elements to the View-Only
Portal Incident Form

Use the Form Editor to add a BeyondTrust Form Control to the view-only Portal Incident Forms.

The Form Control is a link that allows Users to initiate a remote chat session with a representative.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp Solution.

To add the Form Control to the Form:

1. From the Current View drop-down list, select Portal Default.
2. In the Business Object tree, select Incident.

3. Select the Form button .

Tip: You can also select View>View Form (from the Object Manager menu bar) or select the Edit
Form link (under the Appearance area).

4. From the Form drop-down list, select the BeyondTrust Controls Form.
a. Select the BeyondTrust icon and the Chat with Support link Form Controls simultaneously.

Note: You must define the CSM Remote Support Settings and the BeyondTrust Stored
Values for the Control function to work.

b. From the menu bar, select Edit>Copy.

c. Select the Home button .

5. Select the Edit view-only form task in the Appearance section.
a. From the menu bar, select Edit>Paste.

The Form Controls displays on the Form.

Note: The BeyondTrust Form Controls are pasted in a defined location for the default
Form. If you have a custom Form, move the Form Controls to a location that fits your
Form design. If you have multiple Adaptive Layouts, paste and move the Form
Controls on to each one. If you are using multiple languages, adjust the location of the
Form Controls on those layouts.

If the font is too large when you paste the link, change the font to (Theme) Form
Control Font.
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6. Select Update Blueprint .

7. Select and copy the BeyondTrust icon and the Chat With Support control.

8. Select the Home button (If a pop-up message displays that says Apply changes to Incident form
back to the Blueprint, select Yes.).

9. Select the Edit "existing" form task in the Appearance section.

10. From the menu bar, select Edit>Paste.

The Form Control shows on the Form.

Note: The BeyondTrust Form Controls are pasted in a defined location for the default form.
If you have a custom Form, move the Form Controls to a location that fits your form design.
See the Note above for multiple Adaptive Layouts and multiple languages.

11. Select the Update Blueprint button, and then select the Home button .

Related concepts
Form Editor
Cherwell-provided mApp Solutions
Define CSM Remote Support Settings for the BeyondTrust Remote Support mApp Solution
Define BeyondTrust Stored Values
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Related tasks
Define and Format Control Text
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Add BeyondTrust Form Elements to the Portal
Configuration Item Form

Use the Form Editor to add a BeyondTrust Form Control to applicable Portal Configuration Item (CI)
Forms.

The Form Control allows Users to initiate a remote chat session with a representative. The mApp Solution
provides the option of using a button Form Control or link Form Control, based on your Form design.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp Solution.

To add the Form Control to the Form:

1. From the Current View drop-down list, select Portal Default.
2. In the Business Object tree, select a CI Business Object (example: Config - Computer).

3. Select the Form button .

Tip: You can also select View>View Form (from the Object Manager menu bar) or select
the Edit Form link (under the Appearance area).

4. From the Form drop-down list, select the BeyondTrust CI Controls Form.
a. Select either the Chat with a Support Representative Form Control or the Chat With

Support text link.

Note: You must define the CSM Remote Support Settings and the BeyondTrust Stored
Values for the Form Control functionality to work.
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b. From the menu bar, select Edit>Copy.

c. Select the Home button  (If a pop-up displays that says Apply changes to Config -
Computer form back to the Blueprint, select Yes.).

5. Under Appearance, select Edit view-only form .
a. From the menu bar, select Edit>Paste.

The Form Control shows on the Form.

Note: The BeyondTrust Form Control is pasted in a defined location for the default CI
form. If you have a custom Form, move the Form Control to a location that fits your
form design. If you have multiple Adaptive Layouts, paste and move the Form Control
on to each one. If you are using multiple languages, adjust the location of the Form
Control on those layouts.

If the font is too large when you paste the link, change the font to (Theme) Form
Control Font.
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6. (Optional) Add the Form Control to additional CI forms or add it to other Business Object forms, if
necessary.

7. Save the changes to the Blueprint and publish the Blueprint.

Related concepts
Form Editor
Cherwell-provided mApp Solutions
Define CSM Remote Support Settings for the BeyondTrust Remote Support mApp Solution
Define BeyondTrust Stored Values
Save a Blueprint
Publish a Blueprint
Related tasks
Define and Format Control Text
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Define the BeyondTrust Menu Bar Options
Use CSM Administrator to define the BeyondTrust menu bar options.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp® Solution. For more information, refer to the mApp Solution Tech Notes documentation.

To define the BeyondTrust menu bar options:

1. In CSM Administrator, select Browser and Mobile, and then select Site Manager.
2. Select the Portal site and select Edit (Typically, portal is the IT site).

3. In the Properties window, select the Menu page.

4. In the menu tree, select BeyondTrust Chat Request.
5. Action: Select Ellipses.

a. In the Choose Action window, select One-Steps.

b. From the Association drop-down list, select (None).
c. Expand the Blueprint folder in the menu tree and select BeyondTrust.
d. Select the Portal Create Session One-Step Action.

e. Select OK.
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6. Display text: BeyondTrust Chat Request. If BeyondTrust is not listed in the menu tree, you can
create a One-Step Action by selecting Add action > Add One-Step action.

a. In the One-Step Action Manager, select Association > (None).
b. Select any One-Step Action as a placeholder.

c. Display text: BeyondTrust Chat Request.

7. Help text: Requests a BeyondTrust chat session with a Service Desk Technician.

8. Expressions:
a. Clear the Visible check box.

b. Select the Enabled check box.

c. Select Ellipses.

d. In the Expression Manager, select Service Desk Open.

e. Select OK.

9. Security Options:
a. Visible: From the drop-down list, select Logged-In only.

b. Right: From the drop-down list, select (None).
c. Enabled: From the drop-down list, select Logged-In only.

d. Right: From the drop-down list, select (None).
10. Select OK and then select Close.
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Define Security Rights and Chat Settings for Portal
Customers and Workgroup Managers

Use CSM Administrator to define security rights and chat settings.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp® Solution. For more information, refer to the mApp Solution Tech Notes documentation.

To define security rights for Portal Customers and Workgroup Managers:

1. In CSM Administrator, select Security and then select Edit security groups.
2. In the Security Groups window, from the Group drop-down list, select Portal Customer.
3. Select the Business Objects tab.

Option Description

Business Object drop-down list Select Journal History.

General Select the Add check box.
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4. Select the New Field Business Object.

Option Description

General Select the Edit check box.

5. From the Business Object drop-down list, select the Journal - Integrations Audit.

Option Description

Business Object Select Journal-Integrations Audit.

General Select the Add check box.
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6. Select the New Field Business Object.

Option Description

General Select the Edit check box.

7. Select the Rights tab.
8. From the Category drop-down list, select Chat Service Integration Features.

Verify the Chat rights for the Portal Customer are available.

9. Select Save .
10. From the Group drop-down list, select Portal Workgroup Manager. Repeat steps 1-9 for Portal

Workgroup Managers.
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Define the Automation Process for Business Hours
Use CSM Administrator to define the Automation Process for Business Hours.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp® Solution. For more information, refer to the mApp Solution Tech Notes documentation.

To define the automation process for Business Hours:

1. In CSM Administrator, select Automation Processes and then select Business Hours.
2. In the Business Hours Manager, right-click Service Desk Hours > Edit.

Verify the time zone and default hours are correct.
3. Select OK and then select Close.
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Define the Configure BeyondTrust Path One-Step
Action

Use the CSM Desktop Client to define the One-Step Action.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp Solution. For more information, refer to the mApp Solution Tech Notes documentation.

To define the Configure BeyondTrust Path One-Step Action:

1. In the CSM Desktop Client, open the One-Step Action Manager.
2. From the Association drop-down list, select (None).
3. Right-click Configure BeyondTrust Path > Run.

A Prompt window opens.
4. Enter the target path to the BeyondTrust.exe (or bomgar-rep.exe) in the Prompt window. To find the

target path see the Prerequisites in BeyondTrust (Formerly Bomgar) Remote Support mApp
Solutions V3.1.

5. Select OK.
A BeyondTrust Configuration window opens to verify the path.

6. Select OK.
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Configure the Outbound Event in BeyondTrust
Configure the Outbound Event in the BeyondTrust console.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp® Solution. For more information, refer to the mApp Solution Tech Notes documentation.
The menu options may vary slightly depending on your BeyondTrust version. Refer to
BeyondTrust documentation for further information.

To configure the Outbound Event in BeyondTrust:

1. Log in to your company's instance of the BeyondTrust console (example:
yourcompany@beyondtrust.com).

2. Select the Management menu option.
3. Select Outbound Events on the lower menu bar.
4. Select Add New HTTP Recipient.

a. Provide a name.
b. Provide the URL (example: https://YOURCHERWLLSERVER/CherwellAPI/api/V1/

savebomgarsessionid)
c. In the Events to Send section, select the Support Session Ends check box.
d. Select Add Recipient.

The newly created HTTP recipient displays on the Outbound Events page.
You will also need to import the base -64 x.509 Public Certificate from the customer-hosted server
(that BeyondTrust points to). This needs to be added to the Security/Certificates section.

Note: The logged in user account to BeyondTrust must have security rights to see the
security menus.

For customers hosted in the BeyondTrust cloud, the settings are in a different location. Please
contact your cloud provider for more information.
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Configure the BeyondTrust API
Configure the API in the BeyondTrust console.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp® Solution. For more information, refer to the mApp Solution Tech Notes documentation.

The menu options may vary slightly depending on your BeyondTrust version. Refer to
BeyondTrust documentation for further information.

To configure the BeyondTrust API:

1. Log in to the BeyondTrust console.

2. Select the Management menu option.

3. Select API Configuration on the lower menu bar.

4. Select Create New API Account.
a. Provide a Name (example: Cherwell Service Management).

b. Select the Enabled check box.

c. Under Command API, select the Full Access option.

d. Under Reporting API, select all of the check boxes.

e. Under the following options, select the Allow Access check box:
i. Backup API

ii. Real-time State API

iii. Endpoint Credential Manager API

5. Leave Network Restrictions blank.

6. Copy the OAuth Client ID and save it for future use (this is the API Client ID).

7. Select Generate New Client Secret.
8. Copy the OAuth Client Secret and save it for future use (this is the API Client Secret).

9. Select Save.
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Configure the API Fields in BeyondTrust
Configure the API Fields in the BeyondTrust console.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp® Solution. For more information, refer to the mApp Solution Tech Notes documentation.
The menu options may vary slightly depending on your BeyondTrust version. Refer to
BeyondTrust documentation for further information.

To configure the API Fields in BeyondTrust:

1. Log in to the BeyondTrust console.

2. Select the Configuration menu option.

3. Select Custom Fields on the lower menu bar.

4. Under API :: Custom Fields, select Create New Field.
The following Custom Fields must be created:

Display Name Code Name Show in Rep Console

External Key external_key Yes

Type issue issue Yes

5. Select Add Custom Field.
The new fields show in the API : Custom Fields grid.

The BeyondTrust setup is complete.
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Using the BeyondTrust Remote Support mApp
Solution

Users can test the BeyondTrust integration and conduct or launch a remote support session.

When working with the BeyondTrust Remote Support mApp® Solution, you have the following options:

• Test the BeyondTrust Integration.

• Conduct a Remote Support Session Using the BeyondTrust Console.

• Launch a Remote Support Session from the CSM Desktop Client(CSM Technicians).

• Launch a Remote Support Session from the CSM Portal (Customers).

417

CSM mApp Solutions

CSM mApp Solutions



Test the BeyondTrust Integration
Test the BeyondTrust integration from an Incident, Service Request, Computer CI, CSM Portal, CSM
Desktop Client, and CSM Browser Client.

Follow the steps below to test the BeyondTrust integration with CSM. You must have an agent logged into
BeyondTrust for the following tests to work.

From an Incident or Service Request
To test the BeyondTrust integration from an Incident or Service Request:

1. Log into the CSM Portal.

2. Open an existing Incident or Service Request. If you do not have one, submit a new Incident or
Service Request and then open it as if you were going to check the status.

3. Select the Chat with Support link. A dialog opens with instructions.

4. Select OK. The BeyondTrust window opens.

5. Follow the BeyondTrust prompts to initiate the remote session.

6. If an error occurs, an Incident is created and logged with error details.

7. If no support representatives are currently logged into BeyondTrust, a pop-up displays asking the
Customer to check back later.

From a Computer Configuration Item (CI)
To test the BeyondTrust integration from a Computer CI:

1. Log into the CSM Portal.

2. Open an existing computer/device record that is assigned to you. Do this by selecting My Devices
in the OOTB Portal menu bar. If you do not have any devices assigned to you, log into the CSM
Desktop Client and assign a CI - Computer to yourself.

3. Select the Chat with Support link. A dialog opens with instructions.

4. Select OK. The BeyondTrust window opens.

5. Follow the BeyondTrust prompts to initiate the remote session.

6. If the session is unsuccessful or it is outside of service desk hours, an Incident is created for the CI.

From the CSM Portal Toolbar
To test the BeyondTrust integration from the Portal toolbar:

1. Log into the CSM Portal.

2. On the menu bar, select the Chat with Support link. A dialog opens with instructions.

3. Select OK. The BeyondTrust window opens.
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4. Follow the BeyondTrust prompts to initiate the remote session.

5. If the session is unsuccessful or it is outside of service desk hours, an Incident is created in the
CSM Desktop Client with details from the chat session.

From the CSM Desktop Client or CSM Browser Client — Incident Form
To test the BeyondTrust integration from the Desktop Client or Browser Client:

1. Log into the Desktop or Browser Client.

2. Open an existing Incident.

3. Select Generate Session Key.

4. Select the Send an email options and then select OK. An email message opens with instructions
for the Customer to join you in the remote session.

5. Select Send.

6. A Journal - History is created with details from the chat and is attached to the Incident.

7. If an error occurs during the operation, a Journal - Integration Audit will be attached to the Incident.

From the CSM Desktop Client Task Pane
To test the BeyondTrust integration from the Desktop Client Task Pane:

1. Log into the CSM Desktop Client.

2. Open an existing Incident.

3. In the Task Pane, select the Create BeyondTrust Chat Session link.

4. Select the Send an email option and then select OK. An email message opens with instructions for
the Customer to join you in the remote session.

5. Select Send.

6. If the session is unsuccessful, an Incident is created with details from the chat session.
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Conduct a Remote Support Session Using the
BeyondTrust Console

Conduct a remote support session from the BeyondTrust Console by logging in to the console.

The application can be opened directly from the technician's computer.

Note: This functionality is only available if you have applied the BeyondTrust Remote Support
mApp® Solution. For more information, refer to the mApp Solution Tech Notes documentation.

Using the BeyondTrust Representative Console, technicians can chat with Customers, remotely control a
Customer's computer, and securely transfer files during a remote support session. For more information
about the features of the BeyondTrust Representative Console and how to use it, refer to the BeyondTrust
documentation.

To conduct a remote support session using the BeyondTrust console:

Technician

1. In CSM, select Generate Session Key.

A window opens with the session key and asks if you would like to send an email.

2. In the CSM window, select Send an email and then select OK.

An email message opens with the Incident number and a session link to begin a chat session.

3. Select Send.

An email Journal is generated.

Customer

1. In the received email, select the link to populate a BeyondTrust download window.

After you download the BeyondTrust application, a Chat window opens so the technician can initiate a
chat session.

Technician

1. Type a message in the chat window.

2. Select Send.

Note: Select Share Screen to view the Customer's computer screen.
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To end the remote support session:

1. Select the End Session button in the BeyondTrust Representative Console. A window opens with
the following options:

◦ Close Session: Disconnects the Customer and ends the remote support session.

◦ Hold Session: Closes the chat window, but keeps the session in the technician's queue so it
can be transferred to another representative. The Customer receives a message in her chat
window that the session has ended.

Note: Remote support sessions are typically ended by technicians (preferred method).
Customers can also end remote support sessions by selecting the x that closes the chat
window in their Browser. The Customer is disconnected and the technician receives a
message in the chat window of the BeyondTrust Representative Console that the Customer
has left the conversation.

After a session ends a Remote Support History appears under Journal. Once CSM and BeyondTrust
sync, the banner of the Journal changes to orange signifying the Incident is linked with a BeyondTrust
session. A link for a transcript of the chat window and a video of the screen sharing is available. For more
information about the Journal entry, see Journal - Remote Support History Form.
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Launch a Remote Support Session from the CSM
Desktop Client (CSM Technicians)

Technicians can use the CSM Desktop Client to request remote support sessions with Customers.

After a technician requests a remote support session with a Customer, the Customer receives an email
with a link to join the session.

To launch a remote support session from the CSM Desktop Client:

1. Select the Chat Request control on a Business Object Form (example: Incident) or select
Tools>Chat>New Chat Session from the menu bar.

Note: By default, the BeyondTrust Chat Session control is located on the CSM Desktop
Client Task Pane under Common Tasks, as well as under Incident Actions on an Incident
Form. Additional controls that initiate remote support service commands from Business
Object Forms must be configured in CSM Administrator. The name and appearance of these
additional controls is determined by how it is configured.

2. Select a support issue, if necessary, and then select OK.

Note: The option to select a support issue is only available if it was configured in the Chat
and Remote Support Connector Settings (General page) or in the options for the New Chat
Session command in CSM Administrator.

Note: This is the email template that was designed in the Chat and Remote Support
Connector Settings (General page) in CSM Administrator.

3. Edit the email as necessary and select Send.

4. When the Customer receives the email invitation, they select the link contained in the email and are
prompted to download a temporary client chat application, which is used to join the remote support
session.

Related concepts
CSM Desktop Client Task Pane
Configure CSM Remote Support Settings
Define General Settings
Define Options for the New Chat Session Command
Create the Remote Support Session Invitation E-mail Template
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Launch a Remote Support Session from the CSM
Portal (Customers)

Customers can use the Portal to launch a remote support session with a technician.

Customers who want immediate assistance from the Portal can launch a remote support session, which is
sent to a team queue in the BeyondTrust Representative Console and claimed by a technician. Chat
messages are passed from Customers to technicians using a Browser chat window (if launched from the
Portal) or a temporary client chat application (if launched from a link in a remote support session invitation
email).

To launch a remote support session from the Portal:

1. Sselect the BeyondTrust New Chat Session command.

Note: By default, the BeyondTrust Chat Session control is located on the Portal Menu bar (if
the BeyondTrust Chat Integration Stored Value is set to Active). If this control is not shown in
the Portal, talk to an administrator.

A window opens requesting the information specified in the Customer settings in CSM Administrator
(if any).

2. Provide the information as requested and select OK.
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3. A support technician logged into the BeyondTrust Representative Console receives the Customer
remote support session by double-clicking it in the appropriate team queue.

Note: The Team queue in which the remote support session appears in the BeyondTrust
Representative Console is based on either the support issue selected in the Chat and
Remote Support Connector Settings (General page) or New Chat Session command options
for technician queues.

a. The Customer receives a message in her chat window that the session has been transferred
to a technician.

b. If no technicians are currently available, the Customer receives the warning specified in the
New Chat Session command options.

◦ Select Yes to continue with the remote support session request and wait for the next
available technician.

◦ Select No to abort the remote support session request.

Related concepts
Define BeyondTrust Stored Values
Define Identify Customer Settings
Define General Settings
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Define Options for the New Chat Session Command
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BeyondTrust mApp Solution Items
The Items table provides a list of items included when applying the mApp Solution and the typical merge
action.

These are the items included in this mApp Solution:

Item Category Item Typical Merge
Action

Automation
Process BeyondTrust Update Session Record Import

Business Hours Service Desk Hours Don't Change

Business Object

Journal - Integrations Audit Import

Config - Computer, Configuration Item, Incident, Journal -
Comment, Journal - Customer Request, Journal - History,
Journal - Mail History, Journal - Note, Journal - Queue History,
Journal - SLM History

Don't Change

Journal - Remote Support History Overwrite

Journal Merge

Custom View Portal Default Don't Change

Expression

400, 401, 403, 404, 405, 500, 503, json, xml, BeyondTrust
Client ID and Secret, Chat Availability, Is WorkingHours, Server
Date plus 1 hour

Import

Service Desk Open Overwrite

Field

Journal Type Name, Chat Conversation, Chat Event Details,
Chat Start Time, Created By, Created By ID, Created Culture,
Created Date Time, Details, Journal Type Name, Journal
TypeID, Last Modified By, Last Modified By ID, Last Modified
Date Time, LastModTimeStamp, Marked as Read, Owned By,
Owned By ID, Owned By Team, Owned By Team ID, Parent
RecID, Parent TypeID, RecID, Show In Self Service, Sub Parent
ID

Overwrite

Caller, Collection Name, Created By, Created By ID, Created
Culture, Created Date Time, Details, Direction, Journal Type
Name, Journal TypeID, Last Modified By, Last Modified By ID,
Last Modified Date Time, LastModTimeStamp, Marked as
Read, Parent RecID, Parent TypeID, RecID, Request,
Response Code Show In Self Service, Sub Parent ID, Success,
Version, Web Service, Attempts, Chat End Time, Chat
Recording URL, Chat Session ID, Chat Session Key, Chat
Session Report ID, Customer Full Name, Customer Survey
Complete, Representative, Representative Survey Complete,
Service Name, Success

Import
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Form

BeyondTrust CI Controls, BeyondTrust Controls,
JournalIntegrationsAudit, BeyondTrust Report Import

ConfigComputer View-only, Incident Edit-existing, Incident
View-only Don't Change

Grid JournalServices Import

Image beyondTrust 16x16, beyondTrust 32x32, Create Chat Session Import

Index
History_HistoryType, Journal_ParentRecordID,
Journal_ParentTypeID, JournalComment_CommentID,
JournalNote_JournalTypeName, PK_Journal

Import,
Overwrite

Mergeable Area Computer Actions, Configuration Item Actions, Incident Actions Overwrite

One-Step Action

Configure BeyondTrust Path, Create Journal from Email,
OpenSessionRecording, Portal Create CI BeyondTrustSession,
Portal Create New Session, Portal Create Session, Remote
Control, Tech Start Chat Session, Update Remote Session Info

Import

Go Home Don't Change

Save Overwrite

Search Orphaned Journals, Remote Support Errors Import

Stored Value

BeyondTrust Client ID, BeyondTrust Client Secret, BeyondTrust
Path, BeyondTrust Token, BeyondTrust Token Date,
BeyondTrust URL, BeyondTrust Version, Incident Object ID,
IsAvailable, Journal Object ID, SessionKey

Import

Theme Prussian Blue Overwrite

Web Service BeyondTrust Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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Cherwell Asset Management mApp Solution 2.8
The Cherwell Asset Management (CAM) mApp® Solution provides an interface between Cherwell Asset
Management and Cherwell Service Management. The mApp Solution provides maximum visibility and
control over your network IT inventory software, license entitlements, and purchasing data.

Platform Version Requirements: Tested on CSM 10.2.0.

Content Version Requirements: Tested on CSM 10.2.0; CAM mApp Solution 2.8 contains specific
changes to work with 10.2.0 OOTB content. If you have an older content version, you should download
the CAM mApp Solution 2.7 instead, available in the Customer Support Portal.

Prerequisites: CAM 15.0, 15.1, and 15.2. These versions require a patch to be applied to the CAM
system, available from Customer Support.

Available languages:

• German

• English

• Spanish

• French

• Portuguese

Note: For content versions earlier than those listed above, review the documentation and carefully
test against a copy of the current installation to determine suitability for your environment.
Additional manual work may be required based on current system configurations.

Overview
When you incorporate CAM into CSM, you can share with and use inventory data (example:
Workstations, installed programs and software, installed services, disks) within the CSM Configuration
Management Database (CMDB) as Configuration Item records.

This mApp Solution includes multiple features, including Business Objects (example: Config - Not
Inventoried), One-Step™ Actions (example: Update Config - Not Inventoried), and saved searches
(example: CAM Computer).

The mApp Solution is compatible with Trusted Agents. See Trusted Agents.

How the mApp Solution Works
Use the CAM mApp Solution to easily discover all of your devices on the network and choose to view
additional information about those devices. If a device is imported and the system cannot identify what it
is, then the new Business Object holds the information.
For a list of items included in the mApp Solution, see CAM mApp Solution Items.
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Apply the mApp Solution
To apply the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

4. Review the language packs included with the mApp Solution, then select Next.

Note: Refer to Apply a Language Pack for the procedure to apply translated strings to your
system. English is the default language for the CAM mApp Solution.

5. Select the Edit External Connection option to open the External Connection Wizard. Use the
External Connection Wizard to create an External Connection with the CAM Database. The
selections for each page of the External Connection Wizard are:

a. Data Source: Select SQL Server.
b. Database Location: Select Specific Server and provide the database name.

c. Select Database: Provide the database name or select Browse to locate and select the
database.

d. Login Options: Select Windows authentication or type the ID and password for the
database.

e. Database Owner or Schema: Select a database owner or schema in the drop-down list, if
implemented. If the schema is not implemented, provide the owner name. If unsure, provide
the default dbo.

f. Pooling Options: Use the default pooling options, which are usually acceptable for most
scenarios. Optional: Customize your caching options by setting your own pool sizes.

g. Connection Name: Pre-populated with the name of the database provided from step b above.
Optional: Provide a description for the connection.

h. Connection String: Select Test Connection to verify the connection string used. Text
appears next to the button, confirming the connection is successful. If the test connection is
not successful, contact your system administrator or Cherwell administrator.

6. Select Finish.

The External Connection Wizard closes.

Note: If you're using the 10.2.0 ESM czar, you'll encounter the following Blueprint scan error:
"Table validation expression references a non-existent field." The referenced table was deleted, so
to avoid this error, turn validation off.
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Steps to Configure the mApp Solution

1. Configure Security Roles.

2. Schedule Configuration Items.

3. Schedule One-Step Actions.

How to Use the mApp Solution in the CSM Desktop Client

1. Access Secondary Forms with Imported Fields.

2. View Imported Data for Configuration Items.

3. Optionally Assign Configuration Items to Customers.

4. Replace License Fields in the Config - Software License Business Object Form.

For more details on these steps, see Use the CAM mApp Solution.

This functionality is only available after you apply the mApp Solution.

Revision History

mApp Version Platform Version
Requirements

Content Version
Requirements Prerequisites

2.8 Tested on 10.2.0

Tested on 10.2.0; CAM
mApp Solution 2.8
contains specific changes
to work with 10.2.0 OOTB
content. If you have an
older content version, you
should download the CAM
mApp Solution 2.7
instead, available in the
Customer Support Portal.

CAM 15.0, 15.1, and 15.2.
These versions require a
patch to be applied to the
CAM system, available
from Customer Support.

2.7 Tested on 10.1.0 Tested on 10.1.0 CAM 14.2

2.6 10.1.0 10.1.0 CAM 14.2

2.5 9.6.0 9.6.0 CAM

2.1 9.3.1 9.2.0 CAM

2.0 9.3.1 9.2.0 CAM

1.5.1 5.0.0 8.1.0 to 9.2.0 CAM

1.0 5.0.0 8.0.2 or earlier CAM

Related concepts
Go to the Cherwell Marketplace (formerly the mApp Exchange)
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About CSM Data and Databases
Related tasks
Configure Security Roles
Schedule Configuration Items
Schedule One-Step Actions
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Upgrade CAM mApp Solution 2.5 to a Newer
Version

If you have the CAM mApp® Solution 2.5 and want to upgrade to a newer version (2.6, 2.7, or 2.8), you
must make modifications for the mApp Solution to work correctly. Newer versions of the mApp Solution
have been upgraded to be compatible with Trusted Agent.

Due to new hosting constraints, CSM uses Trusted Agent to connect and import data. The CAM mApp
Solution 2.5 has 11 Supporting Business Objects that are directly linked to the CAM database. The linked
tables can't be edited or modified, so you must overwrite the CAM external mappings. The following
Supporting Business Objects need to be re-mapped:

• CAM Drives

• CAM License Purchases

• CAM License Unit Machines

• CAM Login History

• CAM Machine Purchasing

• CAM Network Adapter

• CAM Services

• CAM Software

• CAM Software Purchase Agreement

• CAM Virtual Machine

• CAM Web Console URLs

Note: These steps were tested on a demo database. If your CAM tables (and their relationships)
are customized, ensure that customization is documented so you can recreate it. In addition, the
steps for overwrite may include more Business Objects than specified here. As with all mApp
Solutions, be sure to test this process on your customized system first.
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Overwrite CAM External Data Mappings
Create a Blueprint, and then select the Supporting option under Show object types to overwrite the
CAM external mappings.

See Map an Existing Business Object to External Data.

Note: For all external mapping, pay particular attention to the field that holds the Unique ID. If the
Unique ID is not set correctly, the imported data will not update correctly.

• Select Yes when a dialog box displays the following message: "[Business Object] is already mapped
to external data. Overwrite existing mapping?"

• In the External Data Wizard, on the Fields to Map page, select Map all fields.
◦ Select No when a dialog box displays the following message: "Should new fields be

automatically created when no match is found?"

This example shows the External Data page of the Business Object Properties window for the CAM
Drives Business Object.
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After you finish overwriting all external mappings, scan and publish the Blueprint.
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Overwrite External Mapping to CAM Drives
Use this information to overwrite external mapping to the CAM Drives Business Object.

• Imported External Table: ESM_v_GetMachineDrivesData

• Field that holds unique ID: Unique ID

External Table Field Name Cherwell Field Name

c_drive Drive Name

c_drivesizeinmegabytes Drive Size Bytes

c_drivetype Drive Type

c_path Path

c_percentused Percent Used

drive Drive

filesystem File System

machinedomain Machine Domain

machineid Machine ID

machinename Machine Name

UniqueID Unique ID
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Overwrite External Mapping to CAM License
Purchases

Use this information to add overwrite mapping to the CAM License Purchases Business Object.

• Imported External Table: ESM_v_GetLicenseUnitPurchases

• Field that holds unique ID: UniqueId

External Table Field Name Cherwell Field Name

LicenseType License Type

LicenseUnit License Unit

LicenseUnitId License Unit ID

licenseunitsummaryURL License Unit Summary URL

LineItemId Line Item ID

LineItemName Line Item Name

LineItemType Line Item Type

ManufacturerName Manufacturer Name

OrderDate Order Date

OrderID Order ID

OrderNumber Order Number

OrderType Order Type

Quantity Quantity

UniqueId UniqueId

UnitPrice Unit Price
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Overwrite External Mapping to CAM License Unit
Machine

Use this information to overwrite external mapping to the CAM License Unit Machine Business Object.

• Imported External Table: ESM_v_GetLicenseUnitMachines

• Field that holds unique ID: Unique ID

External Table Field Name Cherwell Field Name

applicationName Application Name

applicationVersion ApplicationVersion

installPath Install Path

licenseUnitId License Unit ID

machineDomain Machine Domain

machineId Machine ID

machineName Machine Name

serialNumber Serial Number

suiteId Suite ID

UniqueId Unique ID
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Overwrite External Mapping to CAM Login History
Use this information to overwrite external mapping to the CAM Login History Business Object.

• Imported External Table: ESM_v_GetLoginHistory

• Field that holds unique ID: Unique ID

External Table Field Name Cherwell Field Name

firstName First Name

lastName Last Name

login Login

logout Logout

machineDomain Machine Domain

machineId Machine ID

machineName Machine Name

serverDomain Server Domain

serverName Server Name

UniqueId Unique ID

userDomain User Domain

userName User Name
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Overwrite External Mapping to CAM Machine
Purchasing

Use this information to overwrite external mapping to the CAM Machine Purchasing Business Object.

• Imported External Table: ESM_v_GetMachinePurchasingData

• Field that holds unique ID: Unique ID

External Table Field Name Cherwell Field Name

AccessProfile Access Profile

AssignedMachineGroup Assigned Machine Group

AssignedUser Assigned User

BiosSerialNumber Bios Serial Number

ContractDescription Contract Description

ContractNumber Contract Number

HardwareType Hardware Type

Invoice Invoice

LineItemDescription Line Item Description

LineItemId Line Item ID

LineItemName Line Item Name

LineItemStatus Line Item Status

MachineDomain Machine Domain

MachineId Machine ID

MachineName Machine Name

MachineSerialNumber Machine Serial Number

ManufacturerName Manufacturer Name

Notes Notes

OrderDate Order Date

OrderDescription Order Description

OrderId Order ID

OrderNumber Order Number

PartNumber Part Number

PONumber PO Number

PurchaseSerialNumber Purchase Serial Number
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External Table Field Name Cherwell Field Name

UniqueId Unique ID

UnitPrice Unit Price

Vendor Vendor
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Overwrite External Mapping to CAM Network
Adapter

Use this information to overwrite external mapping to the CAM Network Adapter Business Object.

• Imported External Table: ESM_v_GetNetworkAdapterInformation

• Field that holds unique ID: Unique ID

External Table Field Name Cherwell Field Name

adapterDescription Adapter Description

adapterName Adapter Name

adapterType Adapter Type

autoconfigureEnabled Autoconfigure Enabled

connectionSpecificDnsSuffix Connection Specific DNS Suffix

dhcpEnabled DHCP Enabled

dhcpleaseexpires DHCP Lease Expires

dhcpleaseobtained DHCP Lease Obtained

dhcpServer DHCP Server

dnsServers DNS Servers

gateways Gateways

ipAddress IP Address

macAddress MAC Address

machineDomain Machine Domain

machineId Machine ID

machineName Machine Name

mediaDisconnected Media Disconnected

networkAdapterId Network Adapter ID

subnetMask Subnet Mask

UniqueId Unique ID

winsPrimary Wins Primary

winsSecondary Wins Secondary
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Overwrite External Mapping to CAM Services
Use this information to overwrite external mapping to the CAM Services Business Object.

• Imported External Table: ESM_v_GetServicesInformation

• Field that holds unique ID: Unique ID

External Table Field Name Cherwell Field Name

instance Instance

machinedomain Machine Domain

machineid Machine ID

machinename Machine Name

ServiceDisplayName Service Display Name

ServiceName Service Name

ServiceStartMode Service Start Mode

ServiceState Service State

UniqueID Unique ID

wmiid WMI ID
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Overwrite External Mapping to CAM Software
Use this information to overwrite external mapping to the CAM Software Business Object.

• Imported External Table: ESM_v_GetMachineSoftwareData

• Field that holds unique ID: Unique ID

External Table Field Name Cherwell Field Name

c_metered Metered

licenseanalyticsURL License Analytics URL

licenseunitid License Unit ID

licenseunitname License Unit Name

licenseunitsummaryURL License Unit Summary URL

machinedomain Machine Domain

machineid Machine ID

machinename Machine Name

name Name

suiteid Suite ID

UniqueID Unique ID

versionstring Version String
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Overwrite External Mapping to CAM Software
Purchase Assignment

Use this information to overwrite external mapping to the CAM Software Purchase Assignment Business
Object.

• Imported External Table: ESM_v_GetSoftwarePurchaseAssignmentInformation

• Field that holds unique ID: Unique ID

External Table Field Name Cherwell Field Name

Assigned Assigned

AssignedGroup Assigned Group

AssignedGroupType Assigned Group Type

AssignedType Assigned Type

AssignmentQuantity Assignment Quantity

LicenseUnitId License Unit ID

LicenseUnitName License Unit Name

SerialNumber Serial Number

UniqueId Unique ID
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Overwrite External Mapping to CAM Virtual
Machine

Use this information to overwrite external mapping to the CAM Virtual Machine Business Object.

• Imported External Table: ESM_v_GetVirtualMachineInformation

• Field that holds unique ID: Guest ID

External Table Field Name Cherwell Field Name

vguestclientinstalled Guest Client Installed

vguestdomain Guest Domain

vguestid Guest ID

vguestipaddress Guest IP Address

vguestipaddresssort Guest IP Address Sort

vguestname Guest Name

vguestos Guest OS

vguestserialnumber Guest Serial Number

vhostdescription Host Description

vhostdomain Host Domain

vhostid Host ID

vhostipaddress Host IP Address

vhostipaddresssort Host IP Address Sort

vhostname Host Name

vhostos Host OS

vhostserialnumber Host Serial Number

vhostvendor Host Vendor
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Overwrite External Mapping to CAM Web Console
URLs

Use this information to overwrite external mapping to the CAM Web Console URLs Business Object.

• Imported External Table: ESM_v_GetWebConsoleURLs

• Field that holds unique ID: CAM Reports URL

External Table Field Name Cherwell Field Name

ESMLicenseAnalyticsConsoleURL CAM License Analytics Console URL

ESMPurchasingConsoleURL CAM Purchasing Console URL

ESMReportsConsoleURL CAM Reports Console URL

ESMReportsURL CAM Reports URL
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CAM mApp Solution Upgrade Workflows
The CAM mApp® Solution upgrade workflows include a remediation workflow for existing CAM mApp
Solution customers and one for new CAM mApp Solution customers.

The remediation workflow is for hosted customers that have a previous version of the CAM mApp Solution
installed and want to upgrade to CAM mApp Solution version 2.6, 2.7, or 2.8.

The upgrade workflow is for new CAM mApp Solution customers.
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Configure Security Roles
Grant permission to the CSM security roles to access the CAM mApp® Solution and its One-Step™
Actions. This enables users to edit the Scheduler or associated CIs, and view the CMDB.

To configure security roles:

1. In CSM Administrator, select the Security category.
2. Select Edit roles, and then select the IT Service Desk role.
3. Select the Role Options menu item, and then select Configure task pane.
4. Ensure the Use default task pane setup option is clear.
5. Select Add, and then in the Task Pane Section window, select Add.

The Action Manager opens.
6. Select the One-Steps category, and then from the Association drop-down list, select Config -

Computer.
7. From the Global folder, select the License Analytics One-Step Action, and then select OK to add

the action.
8. Repeat Steps 5-7 for the remaining two One-Step Actions in the folder: Purchasing and Reports

Console.
9. Select OK in both the Task Pane and the Configure task pane window.

10. Repeat steps 1-9 for the IT Service Desk Manager role.
11. Repeat configuration procedures for any company-specific security roles that also require access to

the CAM mApp Solution. Do not configure any portal security roles.
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Schedule Configuration Items
To import data into the CMDB, add Schedule Items to configure the mApp® Solution. You can import all
CIs in a Business Object category, or apply custom filters. Importing existing CAM data into the CMDB
does not affect data for CIs that were created manually in CSM.

To schedule Configuration Items:

1. In CSM Administrator, select the Scheduling category.
2. Select Edit Schedule, and then select Add to add a Schedule Item.
3. In the General category, provide a schedule group, name, and description.
4. In the Schedule category, select the Recurring option, and then provide the schedule time,

recurrence, and range of recurrence.
We recommend running a scheduled item outside regular business hours and importing items
consecutively, not concurrently. However, all scheduled items must run in the same day for the CAM
mApp Solution to work effectively.

5. In the Action category, select Import from External Data from the drop-down list.
6. Select Setup to open the External Data Import Wizard, and then select Next.

The selections for pages of the External Data Import Wizard are:
◦ Business Object page: From the drop-down list, select a Business Object (example: Config-

Computer).
◦ Existing Records page: Select the Update Existing Records option.
◦ Choose Filter: Select All records, or select Use Filter, and then select the ellipsis.

If using filters, select filters in the Search Manager as follows:

Schedule Item Filter Name

Config-Computer CAM Computers

Config-Network Device No Filter, select Update All Records

Config-Not Inventoried CAM Not Inventoried

Config-Server CAM Server

Config-Software License No Filter, select Update All Records

CAM Drives No Filter, select Update All Records

CAM License Purchases No Filter, select Update All Records

CAM License Unit Machines No Filter, select Update All Records

CAM Login History No Filter, select Update All Records

CAM Machine Purchasing No Filter, select Update All Records

CAM Network Adapter No Filter, select Update All Records

CAM Services No Filter, select Update All Records

CAM Software No Filter, select Update All Records
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Schedule Item Filter Name

CAM Software Purchase Assignment No Filter, select Update All Records

CAM Virtual Machine No Filter, select Update All Records

CAM Web Console URLs No Filter, select Update All Records

7. Select Finish to close the External Data Import Wizard.
8. Repeat steps 2-6 for all Business Objects in the table above.
9. Select OK to see the imported items in the Scheduled Items window.
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Schedule One-Step Actions
The One-Step™ Actions associated with the CAM mApp® Solution analyze inventory data imported by
the Scheduler, and then add it to the CMDB.

To schedule One-Step Actions:

1. In the Schedule Items window, select Add.
2. In the General category, provide the schedule group (default) and name (example: Match Server to

Not Inventoried).
3. In the Schedule category:

a. Select the Recurring options.
Ensure that the import for Config - Not Inventoried and Server are scheduled to run before the
One-Step Actions run. Otherwise, the One-Step Actions do not have correct and
comprehensive data to analyze.

b. Action: Select Run One-Step Action.
4. In the Action category:

a. From the drop-down list, select Run One-Step Action.
The One-Step Action Manager opens.

b. From the Association drop-down list, select Config-Computer .
c. From the Global folder, select the Update Config-Not Inventoried One-Step Action, and

then select OK.
d. From the Association drop-down list, select Config-Server.
e. From the Global folder, select the Update Config-Not Inventoried with Server Data One-

Step Action.

Important: The two One-Step Actions must run after the Scheduled Items for the most
recent CI information to be imported into the CMDB interface.

5. Select OK.
Based on the One-Step Actions, CIs populate in the Scheduler. The scheduled start time varies,
based on when the mApp Solution was configured to import CIs into the CMDB interface.

The CMDB interface automatically populates accordingly. Users can now choose to view CIs from within
the CMDB.
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Use the Cherwell Asset Management mApp
Solution

Use the CAM mApp® Solution to access forms, view imported data, assign CIs, and replace fields.

Access Secondary Forms with Imported Fields
When you apply the mApp Solution secondary forms are added to the following CI Business Objects:

• Config - Computer

• Config - Network Device

• Config - Not Inventoried

Remember: This is a new Business Object that is created when you apply the mApp
Solution.

• Config - Server

• Config - Software License

The secondary form shows the available fields for the selected Business Object, including fields that
already exist on the default form as well as fields that are imported from the CAM database, as part of the
mApp Solution application. You may choose to include some or all of the available fields on your Business
Object forms.

To view the secondary form:

1. In CSM Administrator, open a Blueprint.

2. Select a CI Business Object, then select Edit Form.

3. From the Form drop-down list, select CAM - Imported Fields.
The secondary form appears in the Form Editor.

View Imported Data for Configuration Items
You can view the imported data for a CI from the form arrangement in the CI record. The imported data
comes in through scheduled jobs. Imported data may include:

• Authorized Software

• Installed Services

• Discovered Software

• Installed Drives

• Discovered Drives

• CAM Services
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• Virtual Guests

Optionally Assign Configuration Items to Customers
After importing your CAM data into CSM and running the associated One-Step™ Actions, the status for
each imported CI record becomes in stock, and it is not assigned to a customer. You may choose to
assign the CI record to a customer, or you can use an imported field to display the last user for a CI
record directly on the Business Object form.

Replace License Fields in the Config - Software License Business Object Form
On a default system, the Config - Software License Business Object displays fields for Total Licenses and
Licenses in Use. Equivalent fields are imported with the mApp Solution and are accessible from the CAM
- Imported Fields form for the Business Object. The equivalent fields are Licenses Purchased and Total
Installs. You can replace the default fields with the imported fields, or you can use the imported fields as
comparison data points.
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Cherwell Asset Management mApp Solution Items
The Items table provides a list of items included when applying the mApp® Solution and the typical merge
action.

The mApp Solution includes the following items:

Item Category Item Typical
Merge Action

Business Objects

CI Asset Type, Config-Computer, Config-Network Device, Config-
Server, Config-Software License Overwrite

Config-MobileDevice, Config-Other CI, Config-Printer, Config-
System, Config-Telephony Equipment, Configuration Item,
Customer-Internal, Drive Info

Don't Change

CAM Drives, CAM License Purchases, CAM License Unit
Machines, CAM Login History, CAM Machine Purchasing, CAM
Network Adapter, CAM Services, CAM Software, CAM Software
Purchase Assignment, CAM Virtual Machine, CAM Web Console
URLs, Config-Not Inventoried

Import

Dashboards CMDB Overwrite

External
Connection Cherwell Asset Management Import

Image Definitions
ExpressMetrix, ExpressMetrix16, ExpressMetrix-X16, License-
Analytics_16x16, License-Analytics_32x32, Purchasing_16x16,
Purchasing_32x32, Reporting_16x16, Reporting_32x32

Import

Metric Values License Analytics URL, Purchasing, Reports, Reports Console Import

One-Step™
Actions

License Analytics, Machine Summary, Purchasing, Reports
Console, Update Config-Not Inventoried, Update Config-Not
Inventoried Server, Update Config-Not Inventoried with Server
Data

Import

Stored Expressions CI Details, Discovered, Discovered Items Import

Stored Queries

All Not Inventoried Devices, CAM Computers, CAM Not
Inventoried, CAM Printers, CAM Server, Express Printers,
Express Server, Imported Today, Matched to Other CI, Update
CAM Computer Status, Update CAM Server Status

Import

Theme Prussian Blue Import

Widgets
Not Inventoried in CMDB Import

Varies Overwrite

Merge Actions

• Import: Add new item.
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• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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Slack Integration mApp Solution 1.0
Use the Slack Integration mApp® Solution to integrate Slack with CSM.

Platform version requirements: Tested on CSM 10.0.0 — 10.2.0

Content version requirements: Tested on CSM 10.0.0 — 10.2.0; this mApp Solution may or may not be
compatible with content versions earlier than CSM 10.1.0, but as with all mApp Solutions, be sure to test it
on your customized system.

Prerequisites:

• A publicly accessible web server running a version of CSM that includes the Slack Integration
features. To verify this, launch the Webhooks Manager, create a new webhook, and verify the
Provider Type Slack appears in the drop-down list. For more information, see Configure a Slack
Workspace for Webhooks.

• Administrator rights to a Slack workspace.

• Cherwell Service Host installed and configured to run the System Event Processing Service.

Available languages:

• German

• English

• Spanish

• French

• Portuguese

Overview
Using the Slack Integration mApp Solution, users can integrate Slack with CSM. Slack's bot user
performs a variety of functions in CSM. Some examples include:

• Create Incidents

• Check the status of Incidents

• Close Incidents

Apply the mApp Solution
Follow these steps to download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.
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3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

For a list of items included in the mApp Solution, see Slack Integration mApp Solution Items.

Use the mApp Solution
Follow these steps to use the mApp Solution:

Create, check status, or close an Incident from Slack.

Revision History

mApp Version
Platform
Version
Requirements

Content
Version
Requirements

Prerequisites

1.0 Tested on 10.0.0
— 10.2.0

Tested on 10.0.0
— 10.2.0; this
mApp Solution
may or may not
be compatible
with content
versions earlier
than 10.1.0, but
as with all mApp
Solutions, be
sure to test it on
your customized
system.

• A publicly accessible web server running a
version of CSM that includes the Slack
Integration features. For more information, see
Configure a Slack Workspace for Webhooks.

• Administrator rights to a Slack workspace.

• Cherwell Service Host installed and configured to
run the System Event Processing Service.

Related concepts
About the Cherwell Service Host
About mApp Solutions
Related tasks
Create, Check Status, or Close an Incident from Slack
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Create, Check Status, or Close an Incident from
Slack

Use Slack to create an Incident, check the status, or close the Incident.

Before you make any changes to an Incident, review the following two Actions to ensure the Slack
integration works on your system: Create Incident and Close Incident. These are Actions within the
Slackbot One-Step™ Action.

1. In the One-Step Action Manager, select (None) from the Association drop-down list, and then
select the Global folder.

2. Edit the Slackbot One-Step Action, and on the Designer Board, select the Create Incident Action.

3. Select the Fields page and review the values set in the Incident fields to ensure they are valid for
your database and consider if you have added any new fields to the Incident that are required for
save. See step 6 on Define a Create a New Business Object Action.

4. Follow the previous step for the Close Incident Action.

To create, close, or check the status of an Incident:

1. From the CSM Desktop Client, add yourself as a new customer (Customer > Contact Manager).

Important: The Incident is created based on the user's first and last name, so they must
match what is in Slack.

2. From your Slack workspace, join your Slack bot channel and add your App.
See https://api.slack.com/start/overview#auth.

3. Use the following commands:
a. @[App name] create incident

Any information you type after the word incident will appear in the Description field.
You should receive a response with the new Incident number, the description, and the priority
number.

b. @[App name] status of incident <Incident ID>
You should receive a response with the Incident number, status, who it's assigned to, and the
priority number.

c. @[App name] close incident <Incident ID>
You should receive a response that the Incident was successfully closed.

Related concepts
Slack Integration Troubleshooting
Open the One-Step Action Manager
Create/Edit a One-Step Action
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Slack Integration Troubleshooting
Use these guidelines for troubleshooting issues for Slack Integration and CSM.

Issues with Slack Request URL Verification

1. Verify the Signing Secret is accurate on the CSM webhooks Authentication page.

2. Copy and paste the request URL into a browser window (not on the CSM server) and verify that you
get the following XML error message: The requested resource does not support http method 'GET'.

a. If you don't get the error message, check the URL from the server and if it's not there, there
may be an issue with your browser setup. Check the Cherwell Browser connection and ensure
the database is correct and verify that the browser is installed correctly.

b. If you get the error message, verify that you're using a publicly accessible server.

3. Verify that the Anonymous Browser has rights to view the webhook in the Security Groups settings.

No Response to Commands in Slack

1. Verify that the bot token in Slack and the Bot User OAuth Token Stored Value in CSM match.

2. Verify that Enable Events is turned on in Slack and the app_mention is in the Subscribe to bot
events section.
See https://api.slack.com/bot-users#setup-events-api.

Remember to select Save Changes.

3. Verify that chat:write is included in Slack OAuth permission scope.
See https://api.slack.com/events-api#subscriptions.

4. If you don't received a response to the create incident command, verify that your Slack user has a
customer record in CSM.

5. If you don't receive a response to the status of incident command, verify that your Incident ID is
correct.

All Other Issues - Logging
If you're still experiencing problems with the Slack Integration, you can configure logging for the Cherwell
Service Host to record errors.

Note: Logging is included in the Slackbot One-Step™ Action, but logging must be turned on
before the logs will write.

1. Use the Cherwell Service Manager to configure logging for the Cherwell Service Host.
a. Select Log to file and for the Log Level, select Info and above.

b. For the File Name, select the Ellipses to choose a location and file name for the log file.

2. Restart IIS and the Cherwell Service Host.
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3. Make a note of the time (to track for the Cherwell Service Host to restart). From Slack, use the
create incident command.

4. From the Cherwell Server, check the log file.
It may take a few minutes for the Cherwell Service Host to restart, but if five minutes have elapsed
and there are no logs, the issue is most likely one of the following:

◦ Signing Secret

◦ Event Subscription

◦ Subscribe to bot events

5. The specific log file to look for is <computername>.EventProcessingWorker.<number>.txt. Within
the log file, all Slack messages will start as:
{"Level":"INFO","Message":"One Step Log - [Slackbot - 2020-01-27T16:12:02]:

and will be followed by an informational message. If you don't see any Slack messages, the issue is
most likely one of the items listed in the previous step.

6. If you see Slack messages, but useful information isn't being displayed, you can customize the
information you want displayed.

a. From CSM Administrator, open the Webhook Manager to edit the Slack webhook (Browser
and Mobile > Webhook Manager > Edit Slack webhook).

b. From the Action page, select the Ellipses to edit the Slackbot One-Step Action.

c. Select the Parse Debug Logging Action and in the Contents field, make any necessary
modifications.
The Log Level must be set to Info and above for the logs to write.

Related concepts
Configure Logging for a CSM Service, Web Application, and Cherwell REST API
CSM Services
Create/Edit a One-Step Action
Related tasks
Configure a Slack Workspace for Webhooks
Create, Check Status, or Close an Incident from Slack
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Slack Integration mApp Solution Items
The Items table provides a list of items included when applying the mApp Solution and the typical merge
action.

These are the items included in this mApp Solution:

Item Category Item Typical Merge Action

One-Step™ Action Slackbot Import

Stored Value Bot User OAuth Token Import

Web Service SlackAPI Import

Webhook Slack Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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Standalone mApp Solutions
A Standalone mApp® Solution provides a complete solution. These can include support, managed service
providers, and IT purchasing and project tracking.
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Change Management mApp Solution 1.0
The Change Management mApp® Solution introduces a streamlined Change Request form, ITIL-aligned
Change Request lifecycle, advanced risk assessment, updated Approvals, and an updated Change
Management Dashboard.

Platform Version Requirements: Tested on CSM 9.7.0.

Out-of-the-Box Content Version Requirements: Tested on CSM 9.6.x and 9.7.0. This mApp Solution
may not be compatible on Content versions older than 9.6.0, but as with all mApp Solutions, it should be
tested on your customized system.

How the mApp Solution Works
The Change Management mApp Solution offers an improved ITIL-centered process-oriented Change
workflow. It includes a streamlined interface, consolidated workflow, and introduces a new Change Model
Business Object which makes the creation of similar Change Requests easier.

Download the mApp Solution from the Cherwell mApp Exchange. Use the Apply mApp Wizard to apply
the mApp Solution to your CSM system. The Apply mApp Wizard generates a Blueprint, which can then
be viewed and published to a test or live system to commit the changes.

Note: Apply the mApp Solution and select the Open a Blueprint so that I can preview the
changes radio button. Before publishing the Blueprint, you will need to configure the mApp
Solution.

The following graphic shows a high-level workflow for the different Change Request types.

For a list of items included in the Change Management mApp Solution, see Change Management mApp
Solution Items.
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Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution
After applying the mApp Solution, perform the following high-level steps to configure the mApp Solution:

1. Create Change Models for Standard Change types.

2. Apply a One-Step™ Action against your open Change Requests to set their required fields.

3. Apply a One-Step Action against to your open Change Requests to update them to the new status
values.

Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.0 9.7

Tested on 9.6.x and 9.7.0.
This mApp Solution may
not be compatible on
Content versions older
than 9.6.0, but as with all
mApp Solutions, it should
be tested on your
customized system.

Related reference
Change Management mApp Solution Items
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Configure the Change Management mApp Solution
Configure the Change Management mApp Solution using CSM Administrator and the Desktop Client.

The Change Management mApp Solution introduces a new Business Object called Change Model.
Change Model are required for each Standard Change, so you will have to create enough Change
Models to suit your company's needs.

Applying the Change Management mApp Solution clears out the Change Status Lookup Table and adds
new status values, so you will need to run several One-Step Actions to account for these new values.

After applying the Change Management mApp Solution:

Create Change Models

1. Create Change Models for your organization's Standard Change types.
2. In each of your open Standard Change Requests, select the appropriate Change Model and save

the record.

Update Open Change Requests

3. Update existing open Change Request required fields by running the Set Required Fields One-
Step™ Action.

a. Run a search for all open Change Requests.
b. Select the open Change Requests, then open the One-Step Manager.
c. Run the Set Required Fields One-Step Action.

4. Update existing open Change Request status fields by running the Update to New Status One-Step
Action.

a. Run a search for all open Change Requests.
b. Select the open Change Requests, then open the One-Step Manager.
c. Run the Update to New Status One-Step Action.

Related concepts
Change Management mApp Solution Change Models
Run a One-Step Action
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About Change Management mApp Solution
Change Requests

A Change Request is a record that tracks the addition, removal, or modification of anything that could
affect IT Services. These can include changes to architectures, processes, tools, metrics, documentation,
and other Configuration Items.

The Change mApp® Solution manages three types of Changes:

• A Standard Change is documented, low risk, low cost, occurs frequently, and is thoroughly
understood by the Change Advisory Board (CAB). The change only needs to be approved by the
CAB once before it is added to a list of Standard Changes. After that, Standard Changes do not
need to go through the approval process.

• A Normal Change is undocumented and it is unknown how the Change might affect the system.
Though the CAB must approve the Change before implementation, it is not considered a high
priority, and can be addressed during the regular CAB meeting time.

• An Emergency Change is a break in the system and must be addressed immediately so that the
system can resume operation. Since the change is critical, it requires immediate attention from
either the CAB or Emergency Change Advisory Board (ECAB).

For example:

• A new employee requires a software installation (Normal Change). If this becomes a common
scenario, a Change Request can be submitted to make it a pre-authorized Change (Standard
Change).

• A technician reboots the e-mail server because several employees are unable to access email
(Emergency Change).
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Change Management mApp Solution Change Good
to Know

CSM uses several features to manage the Change workflow. The Change Form helps create, manage,
and track Changes; One-Step Actions help move the Change through its workflow; Automation Processes
notify stakeholders via email; an Approval process enforces Approvals; and a Change Dashboard notifies
stakeholders and tracks metrics.

• Search for one or more Changes that meet a specific criteria by running a Quick Search or Search
Group.

• Create a new Change by selecting New > New Change Request.
• If enabled (via an Automation Process), email notifications are automatically created and sent to

stakeholders. For example:
◦ A Customer to notify her of a status change.

◦ Team owners to notify them of ownership.

◦ The User owner to notify him of the ownership.

◦ Approvers when a Change requires approval.

• When on a record, you can send an email directly to the current Customer (requestor) by selecting
File > E-mail Current Customer in the Desktop Client or by selecting E-mail > E-mail Current
Customer in the Browser Client. You can also select the Customer's email address in the Change
Form.

• Journals track what occurs during the record's lifecycle (example: Notes to track progress or
comments, and History to track important field changes, email correspondence, etc.). View or add
Journals by selecting the Journal tab in the record's Arrangement.

• Fields:
◦ Many fields with drop-down menus are driven by a Lookup Table and can be edited in the

CSM Desktop Client using Table Management. To see what table is providing the data, click
inside the field, and then press F3.

◦ Required fields are often conditional, meaning some are required to save a record, some are
required to change the status of a record, some are required to close the record, etc. Required
fields are marked with an asterisk by the field label.

◦ The Description field is a Rich Text field, so formatting and images/screenshots can be used to
complement the text. To format the text or embed an image, select the Zoom button .

◦ Some validated fields can recognize what you are typing and will suggest a value for you
(example: If you type "P" into the field, CSM will suggest the first item it finds that starts with
the letter P). Use the down arrow button to scroll through other possible values.

◦ Press TAB to move to the next field on the Form.

Note: A full list of Fields is beyond the scope of this document. Export a schema
document from CSM Administrator (Create a Blueprint > Tools > Export Schema) to
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view a full list of fields associated with a particular type of Business Object (example:
Major).

• Saving:

◦ Date, time, and user name information is recorded the first time the form is saved, and each
time the form is modified.

◦ Clicking Save triggers an audit of fields that are being tracked for modification (example:
Status). If a modification is detected in a tracked field, a Journal-History record is created to
track the modification. View the modifications in the Journals tab (Arrangement area).

Related concepts
Change Management mApp Solution Journals
Lookup Business Objects
About Table Management
About Rich Text
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Change Management mApp Solution Change
Advisory Boards (CABs)

Normal and Emergency Change Requests require at least one approval by a Change Advisory Board.

The Change Management mApp® Solution uses two boards:

• Change Advisory Board: The Change Advisory Board (CAB) is a group of people that support the
assessment, prioritization, authorization and scheduling of Changes.

• Emergency Change Advisory Board: The Emergency Change Advisory Board (ECAB) is a subgroup
of the Change Advisory Board that makes decisions about Emergency Changes.

By default, Standard Changes do not require the approval of the CAB, but you can define an Approval
Process in CSM Administrator (Create a Blueprint>[Business Object]>Edit Approvals), if necessary.

Tip: Use the Change Advisory Board Worksheet to organize information relating to CAB and
ECAB members. You will need this information when defining the approval boards.

470

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/bundle/csm_mapps_integrations_help_only/page/content%2Fmapps_and_integrations%2Fmapp_tech_notes%2Fchange_management_mapp%2F..%2F..%2F..%2Fshared%2Fchange_advisory_board_worksheet.html


Creating a Change Management mApp Solution
Change Advisory Board

Select CAB members and assign basic Approval rights.

Use the Change Advisory Board worksheet to help you organize information relating to CAB members.
CSM Administrator.

Note: CSM provides three OOTB Approvals for Change, including Emergency Change
Implementation Requests, and Normal Change Implementation Approval. Add, edit, or delete
Approvals for Change in CSM Administrator.

To define a CAB member:

1. Select Tools > Table Management.

Note: By default, you must be a Service Desk Level 2 or higher to view Table Management.

2. In the Type drop-down menu, select Standing CAB Member.

The Standing CAB Member grid opens.

3. In the Select Actions > New in the Browser Client or New in the Desktop Client.

The Standing CAB Member form opens.

Note: The following fields are driven by a Lookup Table. If you have security rights, use Table
Management (Tools>Table Management) to add, edit, or delete field values.

a. Click the Change Type drop-down menu, and then select a Change type (example: Normal).

b. Click the Member Name drop-down menu, and then select a User (example: Andrew).

c. Click the Role drop-down menu, and then select a role for the User (example: Change
Manager).

4. Click Save.

Related concepts
About Approvals
Security Features Security Rights
Change Management mApp Solution Change Request Forms
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Change Management mApp Solution Change
Advisory Board Worksheet

Use the Change Advisory Board worksheet to organize information relating to CAB members.

A subset of the CAB are members of the Emergency Change Advisory Board (ECAB), who approve
Emergency Change Requests.

Table 1. Change Advisory Board

Table Selections Comments

CAB Member
Name:  Member names come from a UserInfo table that is set

up when identifying CSM users.

Change Type

• Emergency

• Normal

• Standard

Defined using the Change Type Lookup Table in
Table Management.

Role

• Business Analyst

• Change Manager

• Developer

• End-User

• Financial Analyst

• Project Manager

• Project Team Member

• Sponsor

• Stakeholder

• Technical Analyst

• Tester

Defined using the CAB Role Lookup Table in Table
Management.

Approval Phase
• Assessment Phase

• Implementation Phase
By default, Standard Changes do not require an
Approval.

Related concepts
Table Management
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Change Management mApp Solution Approvals
The Change Management mApp® Solution includes Approvals for the CAB and ECAB members.

Change Requests include a Current Approvals page, which is populated with the CAB members
associated with the Change Type.

You can add additional Approvals by selecting the New Approval button. On the Approval Record form,
you can enter the Approver Name, Approval Team, Deadline, Details, and Comments.

When the Change Request enters the Approval/ECAB Approval status (or when a new Approval Record
is created), an email is sent to all approvers.

Note: Emergency Changes with a Service Restoration subtype do not require approval.

When Normal Change Requests are rejected by the CAB, the status changes to Rejected. You can
choose to rework the change or close it. The Rework Change button moves the Change Request back to
Draft status. All previous approvals move to the Approval History page. The Close Change button moves
the Change Request to Closed status. Any open Tasks are cancelled and closed.

When an Emergency Change is rejected by the ECAB, the status changes to Closed and the Close Code
is set to Rejected. Any open Tasks are cancelled and closed.

Related concepts
About Approvals
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Change Management mApp Solution Workflows
CSM offers three workflows based on Change types.

Change Types

• Standard - Does not require review.

• Normal - Requires review but is not urgent.

• Emergency - Requires review and is urgent.

Contributors
A Change typically has several contributors. Depending on your workflow and the size of your company,
many of these contributors may have combined roles:

• Creator: User who first logs the Change. This is typically a technician.

• Requestor: User who requests the Change. This is typically an IT manager.

• Owner: User who manages the Change. This is typically a change manager.

• Approver: User who ensures that the Change should be implemented. This is typically one or more
members of the CAB Team. Standard Changes do not require an approval.

Which Workflow Should I Use?
Use the following flowchart to determine which type of Change workflow to follow.

Standard Change Workflow
This is a high-level workflow for Standard Changes. See Create a Standard Change Request for more
detail.
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Normal Change Workflow
This is a high-level workflow for Normal Changes. See Create a Normal Change Request for more detail.

Emergency Change Workflow
This is a high-level workflow for Emergency Changes. See Create an Emergency Change Request for
more detail.
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Change Management mApp Solution Change
Request Forms

Normal Changes and Emergency Changes require steps to create a plan and gain approval from a
Change Advisory Board (CAB). Standard Changes consist of pre-approved procedures and Tasks.

Normal, Emergency, and Standard Change Requests each have slightly different forms, but share many
fields. This topic provides an overview of the Change Request form. Refer to Create a Standard Change
Request, Create a Normal Change Request, and Create an Emergency Change Request for details on
the workflow for each Change Type.

The diagrams below show high-level workflows for each Change Type.

High-Level Standard Change Workflow

High-Level Normal Change Workflow

High-Level Emergency Change Workflow
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Create and Classify the Change
On the CSM toolbar, click New > New Change Request .
A new Change record is created with a unique Change ID.

Field Description

Requester

In the Requestor field, specify the name of the person who initiated the Change, and
then press Enter or Tab to search for the Customer Record.
If an exact match is found, the Requested by fields in the Default Form are auto-
populated with the Customer’s name and e-mail. If multiple matches are found, the
Contact Manager opens so that you can select the appropriate Customer. To browse
Customers, select the Related Item Picker.

Title Specify a title for the Change.

Description Specify a description of the Change.

Change Type Select Normal, Standard, or Emergency. The fields that are show on the rest of the
form depend on this selection.

Change Model Click the Related Item Picker button  to choose a Change Model (required for
Standard Changes, optional for Normal and Emergency Changes). The Change Model
will pre-populate several fields, depending upon how the Change Model was set up.

Emergency Subtype Select a subtype (Service Restoration or Outage Avoidance) from the drop-down
menu (Emergency Change only).

Primary Configuration
Item Click the Related Item Picker button  to launch the CMDB window, and then

select a CI. This shows CIs for any Customer or for a selected Customer.

Assigned Team Specify the Team Owner of the Change.

Reason Use the drop-down list to select a reason for the Change.

Change Already
Implemented?

Indicates whether the Emergency Change has already been implemented (Emergency
Change only).
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Field Description

Assigned To

Specify the member of the Team who will be the User Owner of the change.

Note: The Creator can take ownership of the Change by selecting Assign to
Me in the Actions List.

Proposed Start Date Click the Calendar Date Selector button to select a start date for the Change
(Standard and Normal Change only).

Proposed End Date

Click the Calendar Date Selector button to select an end date for the Change
(Standard and Normal Change only).
Note: If a Stop icon appears next to the Proposed Start Date and/or the Proposed End
Date, you are outside of the maintenance window, and you must select an acceptable
date.

Impact Select the scope of the Change from the Impact drop-down menu.

Urgency Select the service level from the Urgency drop-down menu. The Impact and Urgency
scores are used to calculate the Priority.

Priority The Impact and Urgency scores are used to calculate the Priority.

Service Affected Click the Related Item Picker button  to select the affected Service .

View Change Calendar Click the View Change Calendar link to open the Change Calendar.

View Collision Detection Click the View Collision Detection link to open a Configuration Map of the Primary CI.

Review Date Enter a date to review the change (Normal Change only).

Assess Risk and Plan the Change
The procedures in this section are for Normal Changes and Emergency Changes but do not apply to
Standard Changes. These types of changes require approval from a Change Advisory Board (CAB).

Field Description

Implementation Plan Specify the process required to implement the change.

Justification Enter a justification for the Change Request.

Acceptance Criteria Specify the functionality and quality requirements.

Validation Plan Provide a validation plan (Normal Change only).

Implementation Notes Enter notes for the implementation.

Back Out Plan Specify a plan to back the change out if implementation fails.

Outage Required Select this check box if the CI will experience an outage while the change is
implemented (Normal Change only).

Impact Assessment Provide an impact assessment.
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Field Description

Outage Start Date Click the Calendar Date Selector button to select a start date for the outage
(Normal Change only).

Outage End Date Click the Calendar Date Selector button to select a start date for the outage
(Normal Change only).

Complete Risk
Assessment Select this link to open the Risk Assessment questionnaire.

Validate and Review the Change

Note: Emergency Changes are time sensitive and do not require all of the review procedures
listed in this section. Steps that are used only for Normal Changes are marked (Normal Change
only).

1. Owner assesses the Change:

Field Description

Impact Assessment Specify the impact assessment (consequences of the Change).

Back Out Plan Specify a back out plan or attach information that details what actions to
perform if the Change implementation does not work.

2. A peer review task must be assigned and completed.

3. (Normal Change only) Owner submits the Change for authorization:
a. In the Status bar, click the Next: Submit for Approval button.

The status changes to Approval.

b. If a Peer Review task is incomplete, the change cannot be submitted for approval.

4. (Normal Change only) Approver approves the Change:
a. In the Approval grid, double-click an Approval Record.

The Approval Form opens. The Approver Name and Details Fields are auto-populated per the
defined Approval process rules.

b. (Optional) In the Comments Field, provide your feedback.

c. Click Approve.
The Approval Status icons indicate the number of pending Approvals and their status
(Pending, Approved, Denied, or Abstained).

The Change status changes to Pre-Implement and the Change enters the Implement phase.

5. (Normal Change only) If the Change is approved, it moves to the Scheduled status. The scheduled
start and end times for an approved Change can only be modified by CAB members or Change
Managers:

a. In the Status section of the Default Form, click the Next: Scheduled link.

6. When you are ready to implement the Change, select the Next: Begin Work link.

7. After deployment of the change, the owner completes the Validation and Review section.
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Field Description

Actual Start Date Click the Calendar Date Selector button to select the date
that the Change actually started.

Close Code Select a close code from the drop-down menu.

Actual End Date Click the Calendar Date Selector button to select the date
that the Change actually ended.

Close Notes Specify additional information related to implementation of
the Change.

PIR Select the PIR drop-down menu to select the Post
Implementation Review status.

CMDB Update Complete Select this check box when the CMDB update is finished.

Email Change Review Select this link to the user assigned to this Change.

Complete the Change
Close the change.

Related concepts
Creating a Change Management mApp Solution Change Advisory Board
Change Management mApp Solution Change Models
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Create a Standard Change Request with the
Change Management mApp Solution

Standard Change Requests do not require approval.

Standard Changes have four stages: Classify, Implementation, Review, and Closed.

To create a Standard Change:

1. Create a Change Request and select Standard from the Change Type drop-down menu.
A new Change Request is created in Draft status.

2. Select a Change Model. The Requestor, Change Type, and Reason fields are required.
When you enter the Change Model, the Title, Description, and Service Affected fields are
automatically populated.

3. Add any Tasks associated with the Change Request.
4. Once all the change information is entered, select Scheduled.

The status changes to Scheduled.
5. Select Next: Begin Work when you are ready to begin implementation tasks.

The Stage moves to In Progress. You can also place the Change Request on hold.
6. The Implementation Notes, Actual Start Date, Actual End Date, Close Code, and Close Notes

fields are required. Complete all associated Tasks.
7. After the change is deployed, Select Next: Validate Change.

The status changes to Validation.
8. All implementation tasks must be closed before advancing to the next status.
9. Select Next: CMDB Update.

After the Change Owner updates the CMDB, check the CMDB Update Complete. check box.
10. Select Next: Mark as Complete.

The status changes to Closed.
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Create a Normal Change Request with the Change
Management mApp Solution

Normal Change requests require approval.

Normal Change types have six stages: Classify, Assessment, Authorization, Implementation, Review, and
Closed.

To create a Normal Change Request:

1. Create a Change Request and select Normal from the Change Type drop-down menu.
2. Complete the required fields.
3. Select Next: Risk Analysis.
4. Select the Risk Assessment link to fill out the Risk Assessment survey (required).

You can't edit a Risk Assessment after you submit it.
5. Select Next: Plan to change the status to Planning.

CSM automatically generates a peer review task when you enter the Planning status.
6. Complete the implementation, validation, and back out plans.

Optionally, you can provide evidence of testing and add tasks.
7. Select scheduled start and end dates.
8. Assign the peer review.
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9. Select Next: Approval to submit the Change Request for authorization. CSM calculates lead times
and an approval deadline. If the proposed start date doesn't meet the lead time requirement, you'll
have to either reschedule the Change or submit it as an exception.
If the CAB approves the Change Request, the status moves to Scheduled. If it's denied, the status
moves to Rejected.

10. Select Next: Begin Work when you're ready to begin implementation tasks.
The status moves to In Progress. You can also place the Change Request on Hold.

11. Add implementation notes and actual start and end dates.
12. Add the close code, close notes, and complete all tasks.
13. After the Change is deployed, Select Next: Validate Change to change the status to Validation.

You can't advance to the next status until you close all implementation tasks.
14. Select Next: CMDB Update.

After the Change owner updates the CMDB, select the CMDB Update Complete checkbox.
15. Select Next: Mark as Complete to change the status to Closed.
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Create an Emergency Change Request with the
Change Management mApp Solution

Emergency Change Requests are urgent requests that require approval.

Emergency Changes can be classified into sub-types to identify emergency change drivers and adjust
business rules for submission.

• Service Restoration: a change necessary to resolved a service outage or a severe degradation of
service delivery. Approval of actions to restore service is managed by the team working the incident;
approvals are not executed in CSM.

• Outage Avoidance: the change must be executed outside the normal change process to prevent a
service interruption. Approvals must be completed prior to implementation.

Emergency Changes have five Stages: Classify, Authorization, Implementation, Review, and Closed.

To create an Emergency Change Request:

1. Create a Change Request and select Emergency.
2. The Requestor, Change Type, Reason, and Emergency Subtype fields are required.

When you enter the Change Type, the Title, Description, and Service Affected fields are
automatically populated.

3. Add any Tasks associated with the Change Request.
4. Service Restoration changes move to Scheduled status, and Outage Avoidance changes move to

ECAB Approval status.
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5. When an Outage Avoidance is submitted for ECAB approval, formal review and authorization
occurs. Scheduled Start Date and Scheduled End date fields are required, and Approval task(s)
must be approved. If it is rejected, the Change Request is closed.
If it is approved, the Change Request moves to Scheduled status.

6. Select Next: Begin Work when you are ready to begin implementation tasks.
The Stage moves to In Progress. You can also place the Change Request on hold.

7. After the change is deployed, perform validation testing. Implementation Notes, Actual Start Date,
Actual End Date, and Close Code fields are required.

8. Select Next: CMDB Update.
After the Change Owner updates the CMDB, check the CMDB Update Complete. check box. If no
CMDB Update is required, you can move to the next step.

9. Select Next: Mark as Complete.
The status changes to Closed.
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Change mApp Solution Features
The Change mApp Solution includes several tools to help manage Change.
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Change Management mApp Risk Assessment
Use Risk Assessments to assess the risk of Normal and Emergency Change Requests.

Risk Assessments are mandatory for normal changes and optional for emergency changes. The OOTB
Risk Assessment includes ten standard questions, but you can edit those if needed.

• How many users will be impacted by this change?

• Has this change been implemented before?

• Is there an impact to revenue if the change fails?

• How easy would it be to roll back this change if it failed?

• If there is a failure with the change, can services be restored within the proposed start and end
date?

• Is the change fully documented?

• How many resources are required for this change?

• Is the change visible to external customers?

• Has the change been tested?

• Could a business service disruption occur if the change implementation does not go as planned?

A risk score of Low, Moderate, High, or Critical is calculated based on the answers.
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Change Management mApp Solution Change Form
Use the Change Form to create, edit, and track Changes.

The form has five areas:

1. Status Area: Displays information relevant to the Change form, including Change ID, Change type
(Standard, Normal, or Emergency), Status, and Requester.

2. Pages: Displays linked records (child records) that are related to the Change (parent record), such
as Journals (to track notes and history), Problems, and Incidents.

3. Form Area: Displays the main form fields.

4. Stages: A list of the stages associated with the Change Request. Different Change Types have
different stages.

5. Actions List: Dynamically displays a list of actions that are available for the current Change.

The following image shows a Standard Change form with the five sections identified.
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Change Management mApp Solution Journals
The Change Management mApp® Solution provides several Change Journal types.

• Journal - Note: Tracks User notes/comments. For example, a User might chronicle troubleshooting
progress.

• Journal - Customer Request: Tracks Customer requests/comments.

• Journal - History: Tracks important Field changes. Tracked Fields are configurable and are defined
in the Business Object definition.

• Journal - Mail History: Tracks e-mail correspondence. For example, e-mails sent for receipt,
follow-up, resolution, and questions.

• Journal - Queue History: Tracks when records are added to/removed from a Queue.

Note: History Journals are automatically created by CSM. Note and Customer Request
Journals are manually created.

Each Journal Type has its own unique form. Journals are child records, so they are linked to and available
from their parent records (access Journals by clicking the Journals tab in the parent record's
Arrangement).

Note: For detailed information about Journal forms, refer to Journal forms.

Related concepts
Change Management mApp Solution Change Good to Know
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Change Management mApp Solution Dashboard
The Change Management mApp® Solution provides a OOTB Change Dashboard that intuitively
organizes your critical metrics into a single, real-time, at-a-glance Change control panel.

Note: Change metrics are also found on other OOTB Dashboards (example: Global IT).

The following table describes the items on the Dashboard.

Item Description Widget
Type Widget Name Widget Uses:

Open Change
Requests All open Changes. Search

Results List
CDAll Open
Changes

All Open Changes
Saved Search

My Change
Reviews

Number of approved
Changes owned by the
current User.

Search
Results List

CDAll Approved
Changes

My Approved
Changes Saved
Search
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Item Description Widget
Type Widget Name Widget Uses:

Approved
Changes All approved Changes. Text Gauge

CDTotal
Approved
Changes

Approved Changes
Saved Search

Linked
Incidents or
Problems

Open Changes that have
either at least one linked
Incident or one linked
Problem.

Text Gauge
Changes with
Linked Incidents
or Problems

Active Changes with
Linked Incidents and
Problems Saved
Search

Open Past
Scheduled
Close Date

Open Changes (Status does
not = Closed) that are open
past the time they are
scheduled to be closed
(Created Date Time is
greater than Scheduled End
Date.

Text Gauge
CDOpen
Changes Past
Request Date

All Open Past
Scheduled Close
Date Saved Search

Changes
Outside
Window

Open Changes (Status does
not = Closed) that occur
outside of the maintenance
window (Not During
Maintenance Window =
True).

Text Gauge

CDOpen Change
Outside of
Maintenance
Window

Open Changes Not
During Maintenance
Window Saved
Search

High Risk
Changes

Uncompleted Changes
(Status does not =
Complete) with a risk value
that is greater than/equal to
3.

Text Gauge CDHigh Risk
Changes

High Risk Changes
Saved Search

Change
Request Life
Cycle

Number of open Changes
based on status.

Pipeline
Chart

CDChange
Request Lifecycle

All Open Changes
Saved Search

Open Change
Requests by
Type

Percentage of open
Changes based on type.

Doughnut
Chart

CDChanges by
Type

Change Requests
Saved Search
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Change Management mApp Solution One-Step
Actions

The Change Management mApp® Solution provides multiple One-Step Actions associated with Changes.

One-Step
Actions Description/Actions Associations Executed From

Status    

Alt Step from
Relationship Conditionally change the Change status to

next logical status (defined by the Change
Status values in Table Management)
and/or initiate the next appropriate One-
Step Action.

Change Request Change Form:
<Status> link

Alt 2 Step from
Relationship

Next Step from
Relationship

Button Next Step

Conditionally changes the embedded form
to the next logical form (based on
Embedded Form) and/or initiates the next
appropriate One-Step Action.

Change Request Change Form:
Form buttons

Form    

Ownership    

Assign to Anyone
Prompts the User to assign the record to
any CSM User (not limited by Team). Uses
Owned By ID and Owned By Team fields.

Change Request Change Form:
Assign To link

Assign Change to
Owner

Launches the Choose Team window,
where a user can choose an Owned By
Team for the record; then, launches the
Choose User window, where a user can
choose a Primary User from the already-
selected Team.

Change Request Change Form:
Select Owner link

Assign Change to
Team

Launches the Choose Team window,
where a user can choose an Owned By
Team for the record.

Change Request Change Form:
Select Team link

Take Ownership
of Change

Makes the Current User the Primary User
of the record. Change Request

Change Form:
Take Ownership
link

Other    
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Create Change
Review

Creates a new Review Questionnaire
(Supporting Object) and creates an e-mail
containing a link to the review and record
details (Description, Scheduled End Date,
Actual End Date, etc.).

Change Request

Change Form: E-
Mail Change
Review link

Change Request
Actions toolbar
item; Create
Change Review
option

Create New Task Creates a new Task in the Change's Form
Arrangement. Change Request

Change Form:
Create New Task
link

Nominate for
Standard Change Creates a new Normal Change Record. Change Request

Change Form:
Nominate for
Standard Change
link

Rework Change
Request

Changes the Change status to New so that
Users can edit fields and then resubmit the
Change for CAB Approval.

Change Request
Change Form:
Rework Change
link

A full list of One-Step™ Actions is beyond the scope of this document. Export a schema document from
CSM Administrator (Create a Blueprint > Tools > Export Schema) to view a full list of One-Step Actions
associated with a particular type of Business Object.
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Change Management mApp Solution Saved
Searches

The Change Management mApp® Solution provides numerous OOTB Change Saved Searches.

Notable Change Saved Searches include:

Saved Search Returns Association Executed From

Active Changes with
Linked Incidents or
Problems

Open Changes that have either at
least one linked Incident or one
linked Problem.

Change Request Search Manager,
Widgets

All Changes Waiting
Approval

Changes that have a status of
Waiting Approval. Change Request Metrics

Change Requests All Change Requests, regardless of
status. Change Request Search Manager,

Widgets

Emergency Change Changes that are defined as
Emergency Changes. Change Request

Search Manager,
Widgets, Change
Calendar

My Approved Changes Changes approved by me (Current
User). Change Request Search Manager,

Widgets

My Open Change
Requests

Open Changes owned by me
(Current User). Change Request Search Manager,

Widgets

My Teams Open
Change Requests

Open Changes owned by one of my
(Current User) Teams. Change Request Search Manager,

Widgets

My Total Changes Changes owned by me (Current
User). Change Request Search Manager,

Widgets

Normal Change Changes that are defined as Normal
Changes. Change Request Search Manager,

Change Calendar

Standard Change Changes that are defined as
Standard Changes. Change Request Search Manager,

Change Calendar

Related concepts
About Saved Searches
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Change Management mApp Solution Automation
Processes

The Change Management mApp® Solution provides the following OOTB Change Automation Processes.

Name Description

Notify Requestor of
Status Change

When the Status Field of a Change Request changes, the process initiates the
Send Status Change E-mail One-Step™ Action, which sends an e-mail
notification of the status change to the requestor of a Change Request.

Notify Change Team
of Assignment

When the Owned By Team Field of a Change Request changes, the process
initiates the Notify Owned By Team via E-mail One-Step Action, which sends a
notification e-mail to members of the Team that owns the Change Request.

Notify Change Owner
of Assignment

When the Owned By Field of a Change Request is changed, the process
initiates the Notify Owned By via E-mail One-Step Action, which sends a
notification e-mail to the new owner.

Change Approval
Notifications

When an Approval is added to a Change Request, the process initiates the
Send E-Mail One-Step Action, which sends a notification e-mail to members of
the CAB.

Change - Escalate 4
Hours after End Date

Waits four hours after the Scheduled End Date. If the time limit passes, the
process initiates the Escalate Change 4 Hours After End Date One-Step Action,
which sends an e-mail to the Change Request owner requesting that they
update the record.

Change - Notify
Problem Owner

Waits until a Change Request that is linked to a Problem is closed, then
initiates the Notify Problem Owner Change is Closed One-Step Action, which
sends a notification e-mail to the Problem owner.

Related concepts
Automation Processes
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Change Management mApp Solution Reports
The Change Management mApp® Solution provides several Reports.

Report Description Association Saved Search

Planned Changes Lists Normal and Standard Changes within
a User-specified date range.

Change
Request

All Open
Changes

Post Implementation
Review

Lists Changes and their associated
Incidents and/or Problems.

Change
Request

Changes with
Linked Incidents
and Problems

Change Trends
Line chart shows the number of Changes
by the associated Service. Also lists
Change details.

Change
Request

Changes with
Linked CIs

Past Year Change
Trends

Line chart shows the number of Changes
within the past year by the associated
Service. Also lists Change details.

Change
Request

Date Range for
Report

Change Breakdown

Line chart shows the number of Changes
by the reason for the Change (ex: Incident
Resolution) within a User-specified date
range. Also lists Change details.

Change
Request

Date Range for
Report

Past Year Change
Breakdown

Bar chart shows the number of Changes by
the reason for the Change (ex: Incident
Resolution) within a User-specified date
range. Also lists Change details.

Change
Request

Date Range for
Report

CI Change Request
Metrics

Bar chart shows the top five CIs based on
the highest number of associated Change
Requests. Also lists Change details.

Change
Request

Changes with
Linked CIs

Proactive Service -
Changes

Lists Changes based on Service
Categorization within a User-specified date
range.

Change
Request

Date Range for
Report

Related concepts
About Reporting
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Change Management mApp Solution Change
Models

Use Change Models to pre-populate certain fields in Change Request forms.

A Change Model is a pre-defined template you can apply to Change Requests. When you apply a
Change Model to a Change Request, the template information is entered into the Change Request, and
those fields are made read-only.

You can create and propose Change Models or Retire them.

Related concepts
Change Management mApp Solution Change Request Forms
Related tasks
Configure the Change Management mApp Solution
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Create a Change Management mApp Solution
Change Model

Create a Change Model for the most common changes you encounter in your organization.

To create a Change Model:

1. Select New > New Change Model in the Desktop Client or Browser Client.
2. Provide a name for the Change Model.
3. From the Change Type drop-down menu, select Standard, Normal, or Emergency.

Depending on the Change Type you choose, you can include the following fields:

Field Normal Emergency Standard

Owned By Team x x x

Change Title x x x

Justification x x

Description x x x

Service Affected x x x

Risk and Impact x x

Backout Plan x x

Implementation Plan x x x

4. The CAB members associated with the Change Model's Change Type are automatically added to
the Standing Cab Members tab. Those members are also responsible for moving the Change Model
through to activation.
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Change Management mApp Solution Design Ideas
CSM provides an OOTB Change workflow with all the tools you need to successfully create and manage
a Change. You can use this workflow as-is, or tailor it to meet the needs of your organization. Design
ideas include:

• Fields: Change which Fields are required and when, which Fields support Rich Text, etc.

• View Counter: Incrementally track the number of times a record is viewed by a Customer or User in
the Desktop Client, Browser Client, and Portal. View Counter functionality is configured in CSM
Administrator.

• Statuses: Modify Change statuses and/or the One-Step™ Actions that are initiated when a Change
enters each status.

• Form: Change the Form theme (background and text color), tab order, and size. Change the
threshold and/or colors for priority.

• Actions and One-Step Actions: Create Actions/One-Step Actions to automate your workflow (ex:
Add another Approval process), or implement any of the unused sample One-Step Actions that are
shipped with CSM (example: Create and send out a Change Review questionnaire).

• E-mail: Change the templates that are used to create the e-mails sent by Automation Processes.
Or, disable/change when and to whom notifications are sent (example: Notify Change owners by e-
mail of any status updates).

• Field Value Options: Use Table Management to add/edit Lookup Object values for use in drop-
down Fields (ex: CAB Members).

• Approvals: Modify the Approval process rules (example: The number or percentage of approvers
needed to approve a Change).

Note: Detailed step-by-step instructions for the above is beyond the scope of this document.

Related concepts
Rich Text
Counters
Forms
One-Step Actions
Automation Processes
Approvals
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Change Management mApp Solution Items
These are the items included in this Change Management mApp Solution.

Item Category Item Typical Merge Action

Automation Process Definitions

Change - Escalate 4 hours after End Date, Change -
Notify Problem Owner, Change Approval Notifications,
Notify Change Owner of Assignment, Notify Change Team
of Assignment

Overwrite

Change Request Email Confirmation on Create, Notify
Task Owner of In Progress Change Import

Business Objects  

Change Request, Change Status, Change Status List Overwrite

Change Model, Change Model Status, Change Request
Emergency Subtype, Change Request Normal
Classification, Change Request PIR, Change Stage,
Change Stage List, Risk, Risk Answer, Risk
Questionnaire, Risk Value

Import

Change Request Portal Default, Standing CAB Member,
Task Don't Change

Counters Change Model ID, Risk Assessment Import

Dashboard Changes Overwrite
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Fields

Affected Service, Alt 1 Command, Alt 1 Command Name,
Alt 1 Status, Alt 1 Status Text, Alt 1 Status Text_de-DE, Alt
1 Status Text_en-US, Alt 1 Status Text_es-ES, Alt 1 Status
Text_fr-FR, Alt 1 Status Text_pt-BR, Alt 2 Command, Alt 2
Command Name, Alt 2 Status, Alt 2 Status Text, Alt 2
Status Text_de-DE, Alt 2 Status Text_en-US, Alt 2 Status
Text_es-ES, Alt 2 Status Text_fr-FR, Alt 2 Status Text_pt-
BR, Answer, Answer 1, Answer 1 Score, Answer 10,
Answer 10 Score, Answer 2, Answer 2 Score, Answer 3,
Answer 3 Score, Answer 4, Answer 4 Score, Answer 5,
Answer 5 Score, Answer 6, Answer 6 Score, Answer 7,
Answer 7 Score, Answer 8, Answer 8 Score, Answer 9,
Answer 9 Score, Answer_de-DE, Answer_en-US,
Answer_es-ES, Answer_fr-FR, Answer_pt-BR, Assigned
Team, Backout Plan, CAB Approval Group, Change
Already Implemented, Change Model, Change Model ID
(Change Model), Change Model ID (Change Request),
Change Request ID, Change Stage, Change Stage_de-
DE, Change Stage_en-US, Change Stage_es-ES,
Change Stage_fr-FR, Change Stage_pt-BR, Change Title,
Change Type, (Change Model), Change Type (Change
Stage), Classification, Classification_de-DE,
Classification_en-US, Classification_es-ES,
Classification_fr-FR, Classification_pt-BR, Classify Normal
Change, CMDB Update Complete, Created By (Change
Model), Created By (Change Stage), Created By (Change
Stage List), Created By (Change Risk), Created By
(Change Risk Value), Created By ID (Change Model),
Created By ID (Change Stage), Created By ID (Change
Stage List), Created By ID (Change Risk), Created By ID
(Change Risk Value), Created Culture (Change Model),
Created Culture (Change Model Status), Created Culture
(Change Request), Created Culture (Change Request
Emergency Change), Created Culture (Change Request
Normal Change), Created Culture (Change Request PIR),
Created Culture (Change Stage), Created Culture
(Change Stage List), Created Culture (Risk), Created
Culture (Risk Answer), Created Culture (Risk
Questionnaire), Created Culture (Risk Value), Created
Date Time (Change Model), Created Date Time (Change
Stage), Created Date Time (Change Stage List), Created
Date Time (Change Risk), Created Date Time (Change
Risk Value), Date Approved, Description, Description,
Emergency Subtype, Implementation Plan, Initial Status,
Justification, Last Modified By (Change Model), Last
Modified By (Change Stage), Last Modified By (Change
Stage List), Last Modified By (Change Risk), Last Modified
By (Change Risk Value), Last Modified By ID (Change
Model), Last Modified By ID (Change Stage), Last
Modified By ID (Change Stage List), Last Modified By ID
(Change Risk), Last Modified By ID (Change Risk Value),
Last Modified Date Time (Change Request), Last Modified
Date Time (Change Model), Last Modified Date Time
(Change Stage), Last Modified Date Time (Change Stage
List), Last Modified Date Time (Risk), LastModTimeStamp
(Risk Value), LastModTimeStamp (Change Model), Name,
Next Status, Next Status Command, Next Status
Command Name, Next Status Text, Next Status Text_de-
DE, Next Status Text_en-US, Next Status Text_es-ES,
Next Status Text_fr-FR, Next Status Text_pt-BR, Outage
End Date, Outage Start Date, Owned By, Owned By ID,
Owned By Team, Owned By Team ID, PIR (Change
Request), PIR (Change Request PIR), PIR_de-DE,
PIR_en-US, PIR_es-ES, PIR_fr-FR, PIR_pt-BR, Points,
Post Change Approver, Question 1 (Risk,) Question 1
(Risk Questionnaire), Question 10 (Risk), Question 10
(Risk Questionnaire), Question 10_de-DE, Question
10_en-US, Question 10_es-ES, Question 10_fr-FR,
Question 10_pt-BR, Question 2 (Risk), Question 2 (Risk
Questionnaire), Question 2_de-DE, Question 2_en-US,
Question 2_es-ES, Question 2_fr-FR, Question 2_pt-BR,
Question 3 (Risk), Question 3 (Risk Questionnaire,
Question 3_de-DE, Question 3_en-US, Question 3_es-
ES, Question 3_fr-FR, Question 3_pt-BR, Question 4
(Risk), Question 4 (Risk Questionnaire), Question 4_de-
DE, Question 4_en-US, Question 4_es-ES, Question 4_fr-
FR, Question 4_pt-BR, Question 5 (Risk), Question 5
(Risk Questionnaire), Question 5_de-DE, Question 5_en-
US, Question 5_es-ES, Question 5_fr-FR, Question 5_pt-
BR, Question 6 (Risk), Question 6 (Risk Questionnaire),
Question 6_de-DE, Question 6_en-US, Question 6_es-
ES, Question 6_fr-FR, Question 6_pt-BR, Question 7
(Risk), Question 7 (Risk Questionnaire), Question 7_de-
DE, Question 7_en-US, Question 7_es-ES, Question 7_fr-
FR, Question 7_pt-BR, Question 8 (Risk), Question 8
(Risk Questionnaire), Question 8_de-DE, Question 8_en-
US, Question 8_es-ES, Question 8_fr-FR, Question 8_pt-
BR, Question 9 (Risk), Question 9 (Risk Questionnaire),
Question 9_de-DE, Question 9_en-US, Question 9_es-
ES, Question 9_fr-FR, Question 9_pt-BR, Question
Number, Question1_deDE, Question1_enUS,
Question1_esES, Question1_frFR, Question1_ptBR,
RecID (Change Request), RecID (Change Model), RecID
(Change Model Status), RecID (Change Request
Emergency Change), RecID (Change Request Normal
Change), RecID (Change Request PIR), RecID (Change
Stage), RecID (Change Stage List),RecID (Risk),RecID
(Risk Answer), RecID (Risk Questionnaire), RecID (Risk
Value), Risk Completed, Risk ID, Risk Type (Risk), Risk
Type (Risk Answer), Risk Type (Risk Value), Risk Value
(Risk), Risk Value (Risk Value), Risk Value_de-DE, Risk
Value_en-US, Risk Value_es-ES, Risk Value_fr-FR, Risk
Value_pt-BR, Sort Order, Source Change ID, Source
Change Request RecID, Stage (Change Request), Stage
(Change Status), Stage 1, Stage 2, Stage 3, Stage 4,
Stage 5, Stage 6, Stage 7, Status (Change Model), Status
(Change Model Staus), Status ID, Status Order,
Status_de-DE, Status_en-US, Status_es-ES, Status_fr-
FR, Status_pt-BR, Submitted By, Submitted Date,
Subtypes, Subtypes_de-DE, Subtypes_en-US,
Subtypes_es-ES, Subtypes_fr-FR, Subtypes_pt-BR, Total
Risk Score, Validation Plan

Import

_New CI ID, _Set_Dependency, _Status_Set, _Step_Set,
Acceptance Criteria, Actual Cost, Actual End Date, Actual
Start Date, Alt 1 Command, Alt 1 Command Name, Alt 1
Status, Alt 1 Status Tex,t Alt 1 Status Text_de-DE, Alt 1
Status Text_en-US, Alt 1 Status Text_es-ES, Alt 1 Status
Text_fr-FR, Alt 1 Status Text_pt-BR, Alt 2 Command, Alt 2
Command Name, Alt 2 Status, Alt 2 Status Text, Alt 2
Status Text_de-DE, Alt 2 Status Text_en-US, Alt 2 Status
Text_es-ES, Alt 2 Status Text_fr-FR, Alt 2 Status Text_pt-
BR, Alternate One Status, Alternate One Status Text,
Alternate Second Status Text, Approval Block ID,
Approval Lock, Approved By, Approved By ID, Approved
Date and Time, Assessment Approved, Assessment
Denied, Assigned Team, Assigned Team ID, Assigned To,
Assigned To Email, Assigned To ID, Authorization
Description, Authorization Level, Back Out Plan, CAB
Notes, CAB Reviewed by, CAB Reviewed On, Category,
Change ID, Change Status ID, Change Type (Change
Request), Change Type (Change Status), CI Calendar
Name, Close Code, Close Notes, Cost, Cost Benefit
Analysis, Cost Complete, Created By, Created By ID,
Created Culture (Change Status), Created Culture
(Change Status List), Created Date Time, Critical?,
Criticality, Current Step, Current Version, Description
(Change Request), Description (Change Status), Dev/
Implementation Resource, Duration In Days, Embedded
Form Display, Embedded Form Toggle, Emergency
Change, Emergency Change Override, Expanded Form,
Fast Track?, Feasibility Assessment, Financial Reviewer,
Global Issue, Highest Step, Impact, Impact Assessment,
Implementation Approved, Implementation Denied,
Implementation Notes, Implementation Plan, Justification,
Known Error, Last Modified By (Change Request), Last
Modified By (Change Status), Last Modified By ID
(Change Request), Last Modified By ID (Change Status),
Last Modified Date Time, Last Modified Date Time, Last
Modified Time Stamp, Next Status (Change Request),
Next Status (Change Status), Next Status Command,
Next Status Command, Name, Next Status One-Step,
Next Status Text (Change Request), Next Status Text
(Change Status), Next Status Text_de-DE, Next Status
Text_en-US, Next Status Text_es-ES, Next Status Text_fr-
FR, Next Status Text_pt-BR, No One-Step, Nominated for
Standard Change, Not During Maintenance Window,
Order Status, Outage Required?, Parent Public ID, Parent
RecID, Parent Type, Percent Complete, Phone, Primary
CI Display Name, Primary CI ID, Priority, Proposed End
Date, Proposed Start Date, QA Reviewer, Reason, RecID
(Change Request), RecID (Change Status) RecID
(Change Status List), Rejection Reason, Release ID,
Requested Date Time, Requester, Requester Email,
Requester ID, Requester Manager, Requester Manager
Email, Requester Type, Requires Review, Requires User
Testing, Resource Assessment, Review Date, Rework
Change Request, Risk, Risk Completed By, Risk
Completed Date Time, Risk Number, Risk Text, Security
Reviewer, Selected Status, Self Service Emergency,
Service Affected, Service Blackout End Date Time,
Service Blackout Start Date Time, Service Calendar
Name, Service Catalog ID, Service Importance, Short
Description, Show of Hands Approval, Standard Approved
Items, Standard Template, Status, Status ID, Status
Name, Status Name_de-DE, Status Name_en-US, Status
Name_es-ES, Status Name_fr-FR, Status Name_pt-BR,
Status Order, Status Order, Status_de-DE, Status_en-US,
Status_es-ES, Status_fr-FR, Status_pt-BR, Subcategory,
Submitted Assess Approval, Submitted Implementation
Approval, Support Reviewer, Tab Visibility, Technical
Analysis Complete, Technical Reviewer, Tested, Title,
Trigger Next Status, Type, Urgency, Visible to Customer
Portal, Work Around Exists

Overwrite
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Forms

Change Model, Change Model Normal Emergency,
Change Model Overview, Change Model Standard,
Change Stage, ChangeModelStatus,
ChangeRequestEmergencySubtype,
ChangeRequestNormalClassification,
ChangeRequestPIR, ChangeStageList, Emergency
Change, Normal Change, Risk, Risk Answer, Risk
Editable, Risk Questionnaire DE, Risk Questionnaire EN,
Risk Questionnaire ES, Risk Questionnaire FR, Risk
Questionnaire PT, Risk Questions, Risk Read Only, Risk
Value, Standard Change

Import

Change, ChangeStatus, ChangeStatusList,
StandingCABMember, Task Overwrite

Form Arrangements
ChangeModel, RIsk, RiskQuestionnaire Import

Change Overwrite

Grids

ChangeModel, ChangeModelStatus,
ChangeEmergencySubtype,
ChangeRequestNormalClassification,
ChangeRequestPIR, ChangeStage, ChangeStageList,
Risk, RiskAnswer, RiskQuestion, RiskValue

Import

Change, Change-Dashboards-Grids, ChangeStatus,
ChangeStatusList, My-Changes-Dashboard-Grid,
StandingCAB Member

Overwrite

Image Definition right_16_blue_tab Import

Index

ChangeModel_ModelName,
ChangeRequestEmergencySubtype_Subtypes,
PK_ChangeModel, PK_ChangeModelStatus,
PK_ChangeRequestEmergencySubtype,
PK_ChangeRequestNormalClassification,
PK_ChangeRequestPIR, PK_ChangeStage,
PK_ChangeStageList, PK_Risk, PK_RiskAnswer,
PK_RiskQuestions, PK_RiskValue, Risk_RiskID,

Import

Change_ChangeID, ChangeCreatedDT,
ChangeOwnedBy, ChangeStatus,
ChangeStatus_ChangeStatusID, PK_Change,
PK_ChangeStatus, PK_ChangeStatusList,

Overwrite

Mergeable Areas Change Request Actions, Change Request Approvals,
Risk Actions Overwrite
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Relationships

Change Links Change Stage, Change Model Links
Change Model Status, Change Model Links Standing
CAB, Change Request Links Change Model, Change
Request Links Initial Status, Change Request Links
Services, Change Request Owns Risk, Risk Links Risk
Question, Risk Owned By Change Request

Import

[Foreign Key] Change Request Links Change Status,
Change Links Change Embedded Form, Change links
Change Type, Change Links to Status, Change Links to
Steps, Change Request links Assessment CAB Members,
Change Request Links CAB and ECAB Members,
Change Request Links CAB Member, Change Request
Links Configuration Items, Change Request links Incident
Temp Join Table, Change Request Links Incidents,
Change Request Links Problem, Change Request Links
Requester Customer, Change Request links Temp Join
Table, Change Request Links User Testing, Change
Request Links UserInfo, Change Request Owns Approval
History, Change Request Owns Approvals, Change
Request Owns Cost Items, Change Request Owns
Journals, Change Request Owns PIR Questionnaires,
Change Request Owns Tasks, Normal Change links to
Nominated for Standard Chan

Overwrite
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One-Step Actions

Alt 1 Status, Alt 1 Step from Relationship, Alt 2 Status, Alt
2 Step from Relationship, Assign Team, Cancel Change,
Change Request Confirmation, Change Set to In Progress
Notify Task Owners, Complete Risk Assessment, Create a
Change Model, Draft Emergency Change Next Status, Go
to Change Request, Link Service, Link to an Existing
Incident, Link to an Existing Problem, Next Status, Set
Approval, Set Planning, Set Required Fields, Set Risk
Analysis, Standard Change Set to Scheduled, Submit Risk
Assessment, Update to New Status, Withdraw Change
Request

Import

Assign Change to Anyone, Assign to Individual, Assign to
Team, Back a Page, Basic Print, Clear Task Dependency,
Close Show of Hands Form, CLose Tasks before Review,
Complete User Testing, Create Change Review, Create
New Task, Create Normal Change from Standard
Change, Emergency Change Approved, Emergency
Changed Denied, Evaluate Change Request Risk,
Impacted CI's Button Actions, Link to Tab, Mark My
Approval as Abstained, Mark My Approval as Approved,
Mark My Approval as Denied, Next Page, Next Step from
Relationship, Nominate for Standard Change, Normal
Change Approved, Normal Change Denied, Notify
Problem Owner Change is Closed, Notify Owned by Team
via E-Mail, Notify Requester, Refresh Change
Dependency, Re-Open Change Request, Required Fields,
Rework Change Request, Set Approval Lock to True, Set
Request Status to Close, Show CAB Approval, Show CAB
Denied, Show Info, Show Next Step, Show of Hands
CAB, Show Previous Step, Submit Approval, Switch to
Expanded View, Switch to Step View, Take Ownership of
Change, Update Emergency Override to No, Update
Emergency Override to Yes

Overwrite

505

CSM mApp Solutions

CSM mApp Solutions



Search

Active Change Models, All Change Models, All Changes
on Hold, Proposed Change Models, Retired Change
Models

Import

Active Changes with Linked Incidents or Problems, All
Change request Issues, All Changes Being Scheduled, All
Changes in Assessment Stage, All Changes In Progress,
All Changes in Review, All Changes in Risk Analysis, All
Closed Changes, All Denied Changes, All New Changes,
All Open Emergency (Unplanned) Changes, All Open
Normal Changes, All Scheduled Change Requests,
Change Approved Dates, Change Request Date Range
for Report, Change Request Gantt Chart Report, Change
Requests, Change with Linked CIs, Change with Linked
Incidents or Problems, Changes closed on- time
Changes, Changes Complete, Changes created within
last year, Changes Pending Approval, Changes
Requests, Emergency Change, High Risk Changes, My
Approved Changes, My Change Approvals, My Change
Request needing Approval, My Change Requests by
status, My Open Change Requests, My Open Change
Requests 30 days, My Open Change Requests this week,
My Open Portal Change Requests, My Past Due
Changes, My Pending Change approvals, My Teams
Open Change Requests, My Total Changes, Normal
Changes, Open Change Requests, Open Change
Requests Past Scheduled Close Date, Open Changes
Not During Maintenance Window, Open Changes with
Linked Incidents, Open Changes with Linked Problems,
Planned Changes, Portal Completed Change Requests,
Standard Change, Team Change Approval, Tentative
Changes, Unplanned Changes, Unsubmitted Changes

Overwrite

506

CSM mApp Solutions

CSM mApp Solutions



Stored Expressions

Current User Member of CAB, Customer - Assigned To
Email addresses, Field Lock Background Color, Is Normal
Change, Lock Form, Lock Form Color, Next Status Read
Only

Import

1 Month Ago, 1 Month From Now, 1 Week, 30 Day
Window, Approval Lock, Approval Summary Text,
Approval Tab Visibility, Approval Visibility, Assessment
Approval Visibility, Budget Remaining, CapEx Budget,
Change Details Tab Visibility, Change ID, Classify Phase,
Criteria to Nominate for Standard Change, Current Date
time is Before Schedule End Date?, Custom Expression,
Customer E-Mail Ellipse Text, Embedded Form Next
Status Trigger, Emergency Change Override Decision,
Field Color Lock after Close, Field lock after Approval
color change, Field Lock Approval, Field Lock on
Assessment Approval, Form Assessment Status Visibility,
Form Field Disabled Classify, Form Field Disabled
Implement, Form Implementation Status Viability, Hide
Create Emergency Change, High Priority Normal Change,
Highest Embedded Form Step, Hyperlink to Change
Request Cherwell Browser Client, Hyperlink to Change
Request Cherwell Portal, Hyperlink to Change Request
Cherwell Rich Client, Impact Visibility, Implement Phase,
Implementation Approval Viability, Is End date valid
against both calendars?, is End date valid against CI
calendar, is End date valid against service calendar, Is
start date valid against both calendars?, is start date valid
against CI calendar, is start date valid against service
calendar, Linked Items Tab Visibility, Next Button Visibility,
No Approvals Visibility, Normal Tab Visibility, Number 1
Background Color, Number 1 Color, Number 1 Status,
Number 2 Background Color, Number 2 Color, Number 2
Status, Number 3 Background Color, Number 3 Color,
Number 3 Status, Number 4 Background Color, Number 4
Color, Number 4 Status, Number 5 Background Color,
Number 5 Color, Number 5 Status, Number 6 Background
Color, Number 6 Color, Number 6 Status, Number
Approvals Abstained, Number Approvals Approved,
Number Approvals Denied, Number Approvals Waiting,
Number Days Remaining 24x7, Number of Open Tasks,
OpEx Budget, Phase Assess Approval, Phase Assessing,
Phase Classify, Phase Implement, Phase Implement
Approval, Phase Pre Implement, Phase Review, Phase
Type Standard, Post-Implementation Tab Visibility,
Proposed Start Date can't be after Scheduled End Date,
Require PIR, Review Phase, Risk Impact, Risk Text
Calculation, Schedule Phase, Scheduled End Date can't
be before Proposed Start Date, Standard Exception Tab
Visibility, Standard Workflow Identify Primary CI Status,
Total Budget, Total of Attached Items Release Costs, Total
of Cost Items, User E-Mail Ellipse Text, User Testing Tab
Visibility, Workflow Assess Status, Workflow Classify
Status, Workflow Identify Primary CI Status, Workflow
Implement Status, Workflow Review Status, Workflow
Schedule Status

Overwrite
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Stored Values Default Change Type, Incident RecID, Problem RecID,
Service Affected Import

Tab

Activity, Emergency Change, Normal Change, Risk,
Services Affected, Standard Change Import

Approval History, Configuration Items, Current Approvals,
Incidents, Journals, Problem, Related Change, Review
Questionnaires

Overwrite

Widgets

Changes Awaiting Approval, Changes on Hold, Changes
Pending Approval, High Risk Changes, Open Emergency
Changes

Import

All Open Change Requests, CD-All Open Changes, CD-
Change Request LIfecycle, CD-Change Request LIfecycle
Browser, CD-Changes by Category, CD-Open Changes
Past Request Date, Changes by Risk Impact, Changes
Filter

Overwrite

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution includes the definition for
informational purposes only (the definition is not imported into the target system).

Related concepts
Change Management mApp Solution 1.0
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Cherwell Knowledge-Centered Support mApp
Solution 1.1

The Cherwell Knowledge-Centered Support (CKCS) mApp® Solution provides functionality that allows
users to integrate KCS® Management as part of the support process.

Platform version requirements: Tested on CSM 9.7.0 — 10.2.0.

Content version requirements: Tested on 9.7.x — 10.0.0; this mApp Solution may or may not be
compatible with content versions earlier than CSM 9.7.x, but as with all but as with all mApp Solutions, be
sure to test it on your customized system.

Prerequisites: CSM email must be configured for Approval functionality to work properly. See About
CSM Email and Configuring Email Accounts.

If you have 10.2.0 content, ensure you apply the following workarounds to publish the mApp Solution
application successfully:

• Incident Business Object: The IncidentService Index in the Business Object Properties is
missing the Service RecID field from the Columns list. To add the field, reselect the Service
RecID, and then scan and publish your Blueprint.

Overview
The mApp Solution is configured by defining Knowledge Mapping, Incident form controls, Incident form
arrangements, the Portal search, usage and rating calculations, security rights, and the new CKCS
dashboard. After you configure the mApp Solution, users can create, edit, and publish CKCS articles. The
functionality available to users is defined by the roles they are assigned.

This mApp Solution includes multiple features, including Business Objects (example: CKCS Article and
CKCS Role), saved search (example: All Approved CKCS Articles and Draft CKCS Articles), and One-
Step™ Actions (example: Fix it and Publish to Web). See About Business Objects and About One-Step
Actions.
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The following graphic shows the detailed workflow provided with the mApp Solution:

The mApp Solution includes the following items:

Item Category Item Typical Merge
Action

Business Object

 

CKCS AQI Status, CKCS Article, CKCS Article Quality Index,
CKCS Article Status, CKCS Article Type, CKCS Article
Version History, CKCS Role, CKCS Use, IncidentLinksCKCS,
Yes/No

Import

Incident, UserInfo Merge

Counter CKCS Article ID Import

Image

CKCS Icon_CKCS Article, CKCS Icon_CKCS Article Quality
Index, CKCS Icon_CKCS Article Version History, CKCS
Icon_CKCS Lookup Tables, CKCS Icon_Fix It, CKCS Icon_Fix
It Disabled, CKCS Icon_Flag It, CKCS Icon_Flag It Disabled,
CKCS Icon_Portal Banner, CKCS Icon_Publish, CKCS
Icon_Publish Disabled, CKCS Icon_Rework, CKCS
Icon_Rework Disabled, CKCS Icon_Submit to Coach, CKCS
Icon_Submit to Coach Disabled

Import

Knowledge Source CKCS Articles Import
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Dashboard CKCS Overview Import

Widget

Article Distribution, Articles by Creator, Articles Created in the
Last Month, Articles Referenced, Date Filter, Number of
Approved CKCS Articles, Number of Archived CKCS Articles,
Number of Draft CKCS Articles, Number of Published CKCS
Articles, Number of Rework CKCS Articles, Number of
Technical Review CKCS Articles, Number of WIP CKCS
Articles, Scored Articles, Solved Count

Import

CKCS Articles Needing My Approval or Review, CKCS
Articles Referenced at Least 5 Times Overwrite

Automation
Process CKCS Article Approval Process Import

One-Step Numerous Import

Stored Expression

CKCS Reference Count, CKCS Solved Count, Clear Edit
State, Disable Field, Edit States, Edit State Calculation, Form
Selector, Increase Article Version, Increase Referenced
Count, Increase Solved Count

Import

Stored Query Numerous Import

Stored Value
Candidate Name - Flag It, Candidate Name - Set as Dupe,
CKCS Article, CKCS Article ID, Incident, Incident Rec ID,
Select an Analyst, temp_CKCSRelationshipReload

Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Apply the mApp Solution
Follow these steps to download and apply the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution
Follow these steps to configure the mApp Solution:
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1. Define Knowledge Mapping

2. Add Form Controls to the Incident Form

3. Define the Incident Form Arrangements

4. Define Usage and Rating Calculations

5. Define the Portal Search

6. Define Security

7. View the CKCS Dashboard

Use the mApp Solution in the CSM Desktop Client
There are multiple ways to use the mApp Solution functionality, including:

• Create an Article

• Reference an Article

• Approve an Article

• E-mail an Article

Revision History

mApp Version
Platform
Version
Requirements

Content Version
Requirements Prerequisites

1.0 Tested on 9.0.1.

Tested on 8.2.0;
configurations
required for
content versions
9.6.x — 9.7.0.

CSM email must be configured for Approval
functionality to work properly.

1.1 Tested on 9.7.0
— 10.2.0.

Tested on 9.7.x —
10.0.0; this mApp
Solution may or
may not be
compatible with
content versions
earlier than 9.7.x,
but as with all but
as with all mApp
Solutions, be sure
to test it on your
customized
system.

CSM email must be configured for Approval
functionality to work properly.
If you have 10.2.0 content, ensure you apply the
following workarounds:

• Incident Business Object: The IncidentService
Index in the Business Object Properties is
missing the Service RecID field from the
Columns list. To add the field, reselect the
Service RecID, and then scan and publish your
Blueprint.
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Configuring the Cherwell Knowledge-Centered
Support mApp Solution

513

CSM mApp Solutions

CSM mApp Solutions



Define Knowledge Mapping
When you define Knowledge Mapping for Cherwell Knowledge-Centered Support, you add CKCS Article
Search support for general Searches (example: A Search from the main Dashboard), Incident Searches
(example: While on an Incident, a Search using the Quick Search field), and Knowledge Article Searches
(example: While on a Knowledge Article, a Search using the Quick Search pane).

To configure Knowledge mapping:

1. From the Object Manager menu bar, click Managers and then select Knowledge>Knowledge
Mapping.

2. In the Search From drop-down, select General Search.
3. Click Add.
4. Select the CKCS Articles Knowledge Source.
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5. Click OK to add the CKCS Article Business Object to the General Search and return to the
Knowledge Mapping window.

6. Select Incident in the Search From drop-down.
7. Click Add.
8. Select the CKCS Articles Knowledge Source.
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9. Click OK to add the CKCS Article Business Object to the Incident search and return to the
Knowledge Mapping window.

10. In the Knowledge Mapping window, select the Field check box.
11. In the Field drop-down, click Incident fields>CKCS>temp_CKCSSolutionID.
12. Select the Attachment check box.
13. Select the Relationship check box.
14. In the Relationship drop-down, select Incident Links CKCS Articles.
15. In the Search From drop-down, select CKCS Article.
16. Click Add.
17. In the Knowledge Source Manager, select CKCS Articles.
18. Click OK to return to the Knowledge Mapping window.
19. Click Add.
20. In the Knowledge Source Manager, select Knowledge Articles.
21. Click OK to return to the Knowledge Mapping window.
22. Click OK to close the Knowledge Mapping window.
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Add Form Controls to the Incident Form
When you add Form Controls to the Incident form for CKCS, you add two links that allow you to search for
a CKCS solution and a Specifics Form that holds CKCS options (example: E-mail CKCS Article to
Customer, Unlink CKCS Article, etc.).

To add Form Controls to the Incident Form:

1. From the Object Manager, select the Incident Business Object and then Edit form link.
2. In the Form drop-down list, select CKCS Mod - Incident Form.
3. Select the Search CKCS icon and links, the Show CKCS Window link, and Specifics Form Form

Control simultaneously.
4. Click Edit>Copy.
5. In the Form drop-down list, select Default Form.
6. Click Edit>Paste.
7. Drag-and-drop the Form Controls to a desired location on the Incident Form.

Consider the following Specifics Form options:
◦ If your system uses Incident Specifics Forms, paste the new CKCS window control over the

Specifics Form using the exact same size in the exact position and then remove the
embedded Form border.

◦ If your system does not use Incident Specifics Form, place the CKCS Form in a location that
fits your form design.

8. Click the Update Blueprint button.
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Define the Incident Form Arrangements
When you define the Incident Form Arrangements, you add the CKCS Articles tab to the default and
Portal views and then define associated view options.

To configure the Incident Form Arrangements:

1. From the Object Manager, select the Incident Business Object and then the Edit form
arrangement link.

2. Select the Incident Links CKCS Articles Relationship and drag-and-drop it to the tab area on the
Form Arrangement.

3. Right-click the new CKCS Articles tab and click Properties.
4. (Optional) Click the Tab page and rename the tab (ex: Linked Articles) using the Text field in the Tab

Name section.
5. Click the Tab Contents page.
6. Define the tab contents:

Option Description

Default Form Select Linked View.

Show Buttons Select Quick View and deselect New,
Delete, Link, and Unlink.

Supported Views Use default selections.

Default View (Optional) Select Grid and form (horizontal
split).

New Records Select where to add new Records in a Grid.
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7. Click OK.
8. (Optional) To change the view of the Form Arrangement split from horizontal to vertical, right-click

the Form Arrangement and then select Splitter Position>Left-Right.
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9. Click the Update Blueprint button.
10. Click the Home button.
11. In the Current View drop-down, select Portal Default.
12. Select the Incident Business Object and then the Edit form arrangement link.
13. Select the Incident Links CKCS Articles Relationship and drag-and-drop it to the Tab section on

the Form Arrangement.
14. Right-click the new CKCS Articles tab and click Properties.
15. (Optional) Click the Tab page and rename the tab (ex: Linked Articles) using the Text field in the Tab

Name section.
16. Click the Tab Contents page.
17. Define the tab contents:

Option Description

Default Form Select Portal Incident Display.

Show Buttons Deselect New, Delete, Link, Unlink, and
Quick View

Supported Views Deselect all options except Grid. Note: If
you want to use your existing Incident
Summary Form, select the Form check box.

Default Views Select Grid. Deselect Grid and Form
(Horizontal Split), Form, and Grid and
Form (Vertical Split).

New Records Select where to add new Records in a Grid.

18. Click OK.
19. Click the Update Blueprint button.
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Define Usage and Rating Calculations
To define usage and rating calculations:

1. From the Object Manager, select the CKCS Article Business Object and then click Edit Business
Object.

2. Right-click the Self-Service Count field and select Edit Self-Service Count field.

3. Click Advanced to open the Advanced page.
4. In the Attributes section, click the blue arrow next to General Attributes.
5. In the Attributes column in the first row, type KnowledgeSelfServiceUsageCount.

Note: If the Attribute already exists, you do not need to complete this step. If the term null
displays in the Value column, delete the null text.
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6. In the Attributes column in the second row, type Rating.

Note: If the Attribute already exists, you do not need to complete this step. If the term null
displays in the Value column, delete the null text.

7. Click OK.
8. Right-click the Reference Count field and select Edit Reference Count field.
9. Click Advanced to open the Advanced page.

10. In the Attributes section, click the blue arrow next to General Attributes.
11. In the Attributes column in the first row, type KnowledgeSelfServiceUsageCount.

Note: If the Attribute already exists, you do not need to complete this step. If the term null
displays in the Value column, delete the null text.
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12. In the Attributes column in the second row, type Rating.

Note: If the Attribute already exists, you do not need to complete this step. If the term null
displays in the Value column, delete the null text.

13. Click OK.
14. Right-click the Solved Count field and select Edit Solved Count field.
15. Click Advanced to open the Advanced page.
16. In the Attributes section, click the blue arrow next to General Attributes.
17. In the Attributes column in the first row, type KnowledgeSelfServiceUsageCount.

Note: If the Attribute already exists, you do not need to complete this step. If the term null
displays in the Value column, delete the null text.

18. In the Attributes column in the second row, type Rating.

Note: If the Attribute already exists, you do not need to complete this step. If the term null
displays in the Value column, delete the null text.

19. Click OK.
20. Click the Update Blueprint button.
21. Publish the Blueprint (File>Publish Blueprint).
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Define the Portal Search

To define the Portal Knowledge Search:

1. In CSM Administrator, select the Browser and Mobile category and then click Site Manager.
2. Right-click the IT Site and then select Edit.
3. Click the Display page.
4. In the Search section next to the Use Search Widget field, click the ellipses button.

5. Right-click the Self Service Searches with Knowledge Widget and then select Edit.
6. In the Quick Search section, click Add>CKCS Article.
7. Select the Search Attachments check box.
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8. Click OK.
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Define Security
When you define Cherwell Knowledge-Centered Support Security, you assign Roles to CKCS
stakeholders (example: Candidate, Coach, Contributor, Program Manager, Publisher, or Knowledge
Domain Expert) and define Security Groups.

Note: For detailed descriptions of KCS® Roles, visit the Consortium for Service Innovation's
KCS® website.

To define Security:

1. In CSM Administrator, click the Security category.
2. Click the Edit Roles task.
3. In the Roles window menu bar, click Role Options and then select Configure Task Pane.
4. Select the Use Search Widget radio button and then click the ellipses button.

5. Open the Global folder.
6. Right-click the Default Search Menu Widget and select Edit.
7. In the Quick Search section, click Add>CKCS Article.
8. In the Configure CKCS Article Search window, select the Search Attachments check box.
9. Click OK and return to the Roles window.
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10. Repeat steps 3 through 9 for each Role and then close the Role window.
11. In the Security task area, click the Edit Users task.
12. Click the Users tab.
13. Select the User that you want to set as a CKCS Coach.
14. In the User Information section, scroll to CKCS Information.

15. In the CKCS Role drop-down, select CKCS Coach.
16. Click Save.
17. Select a User that is a CKCS stakeholder (example: Candidate, Coach, Contributor, Program

Manager, Publisher, or Knowledge Domain Expert).
18. In the User Information section, scroll to CKCS Information.
19. In the CKCS Role drop-down, select a Role.
20. In the CKCS Coach drop-down, select the defined coach.
21. Click Save.
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22. When all necessary stakeholders have assigned Roles, close the Users window.
23. Click the Edit Security Groups task.
24. In the Group drop-down, select Portal Customer.
25. Click the Business Objects tab.
26. In the Business Object drop-down, select CKCS Article.
27. In the General section, select View and Edit.
28. Select the Limit Records Based on Criteria checkbox.
29. Click the Browse button.
30. Click the first Comparison Clause drop-down and select CKCS Article fields>Internal Only.
31. Click the second Comparison Clause drop-down and select Values>False.

32. From the toolbar, click New>Comparison Clause.
33. Click the first Comparison Clause drop-down and select CKCS Article fields>Status.
34. Click the second Comparison Clause drop-down and select Value>Published.
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35. Click OK.
36. In the File Attachments section, select View, Add, Edit, and Delete.
37. In the CKCS Article Business Object list, select New Field.
38. In the General section, select View.
39. In the CKCS Article Business Object list, select Reference Count.
40. In the General section, select View and Edit.
41. In the CKCS Article Business Object list, select Self-Service Count.
42. In the General section, select View and Edit.
43. Click Save.
44. In the Group drop-down, select Portal Workgroup Manager.
45. Click the Business Objects tab.
46. In the Business Object drop-down, select CKCS Article.
47. In the General section, select View and Edit.
48. Select the Limit Records Based on Criteria checkbox.
49. Click the Browse button.
50. Click the first Comparison Clause drop-down and select CKCS Article fields>Internal Only.
51. Click the second Comparison Clause drop-down and select Values>False.
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52. From the toolbar, click New>Comparison Clause.
53. Click the first Comparison Clause drop-down and select CKCS Article fields>Status.
54. Click the second Comparison Clause drop-down and select Value>Published.

55. Click OK.
56. In the File Attachments section, select View, Add, Edit, and Delete.
57. In the CKCS Article Business Object list, select New Field.
58. In the General section, select View.
59. In the CKCS Article Business Object list, select Reference Count.
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60. In the General section, select View and Edit.
61. In the CKCS Article Business Object list, select Self-Service Count.
62. In the General section, select View and Edit.
63. (Optional) Prevent Portal Workgroup Managers from editing CKCS Articles by clicking the Rights

tab, selecting Security Features from the Category drop-down, clicking the In Portal, can request
a license to edit records owned by other Users, and then deselecting the Allow checkbox.

64. Click Save.
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View the Dashboard
The Dashboard for Cherwell Knowledge-Centered Support allows Users to see:

• Articles by Creator and Articles by Type.

• Articles Created this Month.

• Scored, Resolved, and Referenced Articles.

• If your Role is Coach, you see CKCS Articles Needing Approval or Review that are assigned to you.

To view the Dashboard:

1. In CSM Desktop Client, click Dashboards>Dashboard Manager.
2. Open the Global folder.

3. Click CKCS.

4. Select CKCS Overview and then click OK.

Note: You can set the CKCS Dashboard as the default while viewing it by clicking
Dashboards>Set CKCS Overview dashboard as default.
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Using the Cherwell Knowledge-Centered Support
mApp Solution
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Create an Article
To create an article:

1. Users can create a new CKCS Article two ways:
◦ On the CSM Desktop Client toolbar, click New>CKCS Article.
◦ On the Incident Form, click Show Knowledge Window if it is not open.

The following graphic shows a CKCS Article record created by a Candidate.

2. Provide a Title for the article.
3. Select a Service from the drop-down menu.
4. Select a Category from the drop-down menu.

Note: If you're running a localized version of the CKCS mApp Solution, you will need to
store foreign keys before Category options will be available. For more information on storing
foreign keys, see Storing Foreign Keys for Validated and Auto-populated Fields.

5. Select a Type from the drop-down menu.

Note: When the Title and Type fields are complete, additional fields display (based on type).

6. Provide the additional information (these fields vary based on article type).
7. (Optional) Click Flag Internal Only to keep the article internal.
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8. The next steps differ depending on your Role:
◦ Candidate: Click the Draft link to submit the article to the Coach for approval. If the article is

approved, the status changes to Approved. If the article is denied, the status changes to
Rework.

The article becomes read-only and is submitted to the Coach for review and approval. If you
need to edit the article, click the Rework link.

◦ Coach, Knowledge Domain Expert, Publisher, Contributor: Click Publish to make the article
available to Users. Articles created by these stakeholders do not require approval.
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9. (Optional) Candidates can click the Flag It link to add a comment to the article and send a
notification e-mail to the Coach. When the Coach reviews the comment, they must manually remove
the flag from the record.

10. (Optional) Coaches, Knowledge Domain Experts, Publishers, and Contributors can click the Fix It
link to change the status to Rework and edit the record.
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Reference an Article
The mApp® Solution allows Users to link, or reference, articles to Incidents. Users can also resolve an
Incident using an article.

Search and Reference Articles
Articles can be linked by using Search functionality while viewing an Incident.

To search and reference articles:

1. Open an Incident.

2. Click the Search CKCS link.

3. Provide a search term:
◦ First search: The Incident Short Description auto-populates the Knowledge Pane Search for

field. You can also delete the text and provide your own.

◦ All subsequent searches: Provide a term in the prompt.
4. In the Knowledge Pane, scroll to CKCS Articles.

5. Click the CKCS Article.
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The CKCS Article opens in a new window.

6. Click the Use Solution button.
The CKCS Article displays on an Incident Specifics Form and in the CKCS Articles tab of the Form
Arrangement. The Referenced Count bar on the CKCS Article Form increments based on the
number of times the solution is used.

Reference and Resolve KCS Articles
KCS Articles can be used to resolve an Incident.

To resolve and reference a KCS Article:

1. Open an Incident.

2. Click the KCS Search link.

3. Provide a search term in the prompt or in the Search for field.

4. Scroll down the Search results for KCS Articles.

5. Click the KCS Article, it opens in a new window.

6. Click Use Solution.

7. In the KCS window on the Incident, click Resolve Using Referenced KCS Article.

8. In the Prompt, select a cause code from the drop down.
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Approve an Article
Approval functionality is only available for Users assigned to the Coach role. Contributor, Publisher,
Knowledge Domain Expert, and Program Manager Roles do not need to have the CKCS Articles
approved by a Coach. Candidates must submit their CKCS Articles for approval.

To approve an article:

1. Open the CKCS Article Overview Dashboard.
2. Under the CKCS Articles Needing My Approval or Review section, double-click an article.

Note: You can also click Search>Search Manager>CKCS Association, run the All Draft
CKCS Articles Saved Search, and select a record.

3. In the Form Arrangement, click the Coach Approval tab.

4. (Optional) Provide comments related to the Approval.
5. Click Approve.

The status of the article changes to Approved and the Publish link is enabled.
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E-mail an Article
Referenced articles can be e-mailed to the Requestor on Incidents.

To e-mail an article:

1. Open an Incident.

2. Click the CKCS Search link.

3. Provide a search term in the prompt or in the Search for field.

4. Scroll down the Search results for CKCS Articles.
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5. Click a CKCS Article to open it in a new window.

6. Click Use Solution.

7. In the CKCS window, click Email CKCS Article to Customer.

An e-mail window opens that includes the information from the CKCS Article.

Note: Only the latest referenced CKCS Article can be e-mailed. Articles that are flagged as
Internal Only cannot be e-mailed.

8. Click Send.
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IT Asset Management (ITAM) - Purchase Request
through Receiving mApp Solution 1.2

Use the ITAM mApp® Solution to submit requests for IT goods through the CSM Portal.

Platform version requirements: Tested on CSM 9.6.3 — 10.2.0

Content version requirements: Tested on CSM 9.6.3 — 10.2.0

Prerequisites: If you have 10.2.0 content, ensure you apply the following workarounds to publish the
mApp Solution application successfully:

• Supplier Links Supplier Catalog Item relationship:
1. Under Links, from the Default Link drop-down list, reselect the Supplier ID field.

2. Repeat this step on the reverse relationship for Supplier Catalog Item Links Supplier with
the Supplier Catalog Item ID.

• Underpinning Contract Business Object: The Purchasing - UnderpinningContract form references
a SKU Number field that no longer exists in OOTB content as of 10.2.0. Remove the field from the
form and save the changes.

• Part Business Object:
1. In the field properties for the Supplier ID for Reorder field, open the Validation/Auto-

populate page.

2. Expand the Auto-populate section, and under the Populate with option for Field from
Supplier Catalog Item lookup table, reselect the Supplier ID field.

• SupplierCatalogItem grid: This references a field that no longer exists in 10.2.0 OOTB content. To
automatically delete the field, from the Scan Results window, select Go to Error.

Cherwell Asset Management (CAM) version 13.0 or later and CAM API versions 2.5 or newer:

• CAM Customer Number

• CAM API Version

• CAM Server (if applicable)

• CAM Purchasing Manager email

Available languages:

• German

• English

• Spanish

• French

• Portuguese
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Overview
The IT Asset Management (ITAM) - Purchase Request through Receiving mApp Solution is comprised of
new Business Objects (example: Inventory) and modified SIAM Business Objects. Use the IT Purchasing
solution to request IT goods through the CSM Portal by selecting from a Product Catalog that is tied to the
back end Supplier Catalog Items. IT managers can make decisions about the procurement of the goods,
either from stock or by issuing a Purchase Request. The solution provides for the integration with CAM
(optional) to complete the loop from requesting through receiving.

This mApp Solution utilizes multiple Service Management processes, including:

• Product Catalog (modified)

• Supplier Catalog Item (modified)

• Inventory (new)

• Purchase Request (new)

• Service Request (new specific form and automation)

• Configuration Items

• Supplier

• Underpinning Contracts

Apply the mApp Solution
Follow these steps to download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Apply the mApp Solution and when prompted, enter the CAM Customer Number, CAM API Version, value
for Own CAM, CAM Purchasing Manager email, and CAM Server (if applicable). Select the Open a
Blueprint so that I can preview the changes option. Before publishing the Blueprint, you will need to
configure the mApp Solution.

Note: This mApp Solution includes a Product Subcategory Table that allows customers to assign
specific categorizations to the items found in their Product Catalog. This new table depends on
values found in the out-of-the-box table Product Category. Because customers may have added
additional data to this table, this mApp Solution does not include any new entries for the Product
Category or Product Subcategory table. Customers should add Product Subcategory values
during the implementation of this mApp Solution. Examples of Product Subcategory Items are:
Notebook, Workstation, and Tablet.

For a list of items included in the mApp Solution, see ITAM mApp Solution Items.
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Steps to Configure the mApp Solution
Perform the following high-level steps to configure the mApp Solution:

1. Schedule One-Step Action to Update Purchase Request.

2. Schedule One-Step Action to Update Config - Software License .

3. Configure Security Groups.

4. Update Friendly Name (Only if using the Cherwell Asset Management mApp Solution).

Steps to Use the mApp Solution
Perform the following high-level steps to use the mApp Solution:

1. Initiate a request for purchase from the Portal.

2. Work the Service Request.

3. Work the Purchase Request.

Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.0 9.1.0 8.1
CAM version 13.0 or newer;
CAM API versions 2.5 or
newer

1.1 9.6.x and 9.7.0 9.6.x and 9.7.0
CAM version 13.0 or newer;
CAM API versions 2.5 or
newer
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mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.2 Tested on 9.6.3 — 10.2.0 Tested on 9.6.3 — 10.2.0

For 10.2.0 content, ensure
you apply the following
workarounds:

• Supplier Links Supplier
Catalog Item
relationship: Under
Links, from the Default
Link drop-down list,
reselect the Supplier
ID field. Repeat this
step on the reverse
relationship for
Supplier Catalog Item
Links Supplier with
the Supplier Catalog
Item ID.

• Underpinning Contract
Business Object: The
Purchasing -
UnderpinningContract
form references a SKU
Number field that no
longer exists in OOTB
content as of 10.2.0.
Remove the field from
the form and save the
changes.

• Part Business Object:
In the field properties
for the Supplier ID for
Reorder field, open the
Validation/Auto-
populate page.
Expand the Auto-
populate section, and
under the Populate
with option for Field
from Supplier Catalog
Item lookup table,
reselect the Supplier
ID field.

• SupplierCatalogItem
grid: This references a
field that no longer
exists in 10.2.0 OOTB
content. To
automatically delete the
field, from the Scan
Results window, select
Go to Error.

CAM version 13.0 or newer;
CAM API versions 2.5 or
newer. 545
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Related concepts
About the Configuration Management Database (CMDB)
About mApp Solutions
About Security Groups
Related tasks
Assign Roles to a Security Group
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IT Asset Management (ITAM) - Purchase Request
through Receiving mApp Solution Components

The ITAM mApp Solution contains a Dashboard, Product Catalog, Supplier, and Supplier Catalog Items.

• Dashboard: The Dashboard contains configurable, real-time, at-a-glance information for IT
Purchasing. For example, the Dashboard might contain information regarding Purchase Requests
(status, pending approval, and auto-renew), Low or Surplus Stock, and Inventory Items at Reorder
Level.

• Product Catalog: The Product Catalog contains Fields that are directly related to the Supplier
Catalog Items. These Fields are used to facilitate the Check Stock and Purchasing/Receiving
activities of the IT Purchasing solution (example: Container, Container Type, and Manufacturer).

• Supplier: Use the Supplier Fields for detailed information for the supplier and management
(example: Primary Contact, Address, Supplier Category, and Supplier Type).The Supplier
relationships are displayed in the Form Arrangement. A few examples are Agreements, Supplier
Catalog Items (OOTB relationship, can be removed at your discretion), Underpinning Contracts
(direct relationship to the Supplier Object), and Supplier Catalog Items (relationship used with the
mApp Solution functionality).

• Supplier Catalog Items: The following Supplier Catalog Items support the purchasing request and
receiving processes.

◦ Container and Asset Type: Use the Container drop-down list to identify the Configuration
Item (CI) or Inventory. Use the Asset Type drop-down list for a list of valid CI Asset Types (not
visible if the Container is Inventory). You can use these Fields to check stock against the
appropriate CI or inventory items, or update or create new CIs or inventory during the
receiving process.

◦ Department: Use the drop-down list to choose the owning department.

◦ Preferred Supplier: Select this check box to identify the supplier as preferred. This is visible
during the purchasing decision activities.

◦ Common Information: This section includes standard item information for hardware,
software, and inventory. The Model drop-down list is used in the Product Catalog, CI and
Inventory records, and the Supplier Catalog Items. If the Asset Type is Commercial or other
software related type, the Model label changes to Software Title.

◦ Pricing: Use these Fields for detailed information for CI and Inventory pricing at the item level
by supplier.

◦ Special Properties: Use these Fields for justification for Energy Star, Environmentally
Preferred, and Made in the USA.

◦ Form Arrangement: Use the tabs for adding or revising Supplier Catalog Items relationships
(example: All Agreements, Supplier, and Underpinning Contract). Underpinning Contract has a
direct relationship with Supplier Catalog Items.
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Inventory Parts
Inventory is a Group Business Object that stores and tracks non-CI items. Parts is a group member of
Inventory.

Inventory can include IT or non-IT related items (example: Logitech Mouse, air compressor filters). Parts
are items that are generally not tracked in the CMDB.

As part of the request process, stock is assessed to determine if a purchase is required. Inventory is
reviewed for requested parts. The appropriate CIs are reviewed for those that match the request and are
in stock.

• The unique keys for this object are Model (enter the Model number) and Site (use the Location -
Site drop-down list).

• The status of the part is based on the stock level. Set Surplus and Low Stock levels in the Fields.

• Service Requests that reserve parts are tracked using the Form Arrangement.

• There is a relationship between the Service Request and the Part/Site. The Requests tab in the
Form Arrangement lists the Service Requests.

• Auto-Reorder automatically initiates a new Purchase Request when the Part stock level goes below
the Reorder Threshold. Select the Auto Reorder check box and track the Purchase Request in the
Auto Reorder PR tab of the Form Arrangement.
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Location Information and Configuration Items (CIs)
Use the detailed location information to standardize location information. CMDB CI objects include these
location Fields.

Detailed Location Information

The following areas provide a foundation for standardizing location information across the purchasing and
receiving activities:

• Site - Major Business Object

• State/Providence/Territory - Lookup Table

• Country - Lookup Table

• Building - Major Business Object

Configuration Items

CMDB CI objects include the following Fields:

• Location - Country

• Location - State

• Location - Site

Automation changes the status from In Stock to Planned when a CI is reserved as part of the purchase
request process.

A Service Request that reserves a CI is linked in the Form Arrangement as a related Incident.
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Specifics Form (Portal View) and Service Request
The ITAM Specifics Form is associated with the Purchasing subcategories.

The Select Product and Quantity One-Step™ Action provides catalog items from the Product Catalog
based on the subcategory selected.
Use the Form Editor (accessed from within a Blueprint in CSM Administrator to access the One-Step
Action.

1. From the Current view drop-down list, select Portal Default.
2. Under Show object types, select the Supporting option.
3. In the Business Object tree, select Specifics - ITAL.
4. Under Appearance, select the Edit form link.
5. From the Form drop-down list, select Specifics ITAL.
6. Right-click the Add a Product link to open the Choose Action window.
7. Select the Ellipses to open the Action Manager.

A Service Request (which is opened for the Purchase Request) can be initiated from the CSM Portal or
directly by a user in CSM.
The Specific Form - ITAM is used both in the CSM Portal and the CSM Desktop Client to allow viewing
and selection of products from the Product Catalog for the request.

• Use the Service drop-down list to choose a Service category.

• Use the Category and Subcategory drop-down lists to choose options (based on the Service
category chosen).

• Select Add a Product to initiate a search of the Product Catalog to add products to the request.

• Select Create Purchase Request to create a new Purchase Request record to order any of the
Items for Purchase.

Related concepts
Action Manager
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Form Arrangement
The Form Arrangement displays tabs of child Forms and records such as Items Requested and Purchase
Requests.

The following tabs are in the Form Arrangement:

1. Items Requested: Lists all requested items.
a. Select Check Stock to search for available stock (CMDB or Inventory) that match the Model

number of the product. Select each list item to check stock. Once the check is complete, the
list item will change from red to green.

b. If there is stock available (same Model), the Inventory or CIs display and you can reserve the
item and/or purchase, depending on the fit, location, or other details.

c. If there are no items in stock, you have the option to purchase or cancel. If you select
Purchase, the Supplier Catalog items display that match the Model number for the requested
item. Preferred suppliers are identified with a True value. The Items for Purchase tab will list
the items that are part of the Purchase Request process.

The process of checking stock, reserving from inventory, and purchasing as needed continues until
all items in the Items Requested list are completed (green).

2. Configuration Items: Lists all CIs reserved for this request. The status of the CI will go from In
Stock to Planned. If the request is canceled, the status needs to be manually changed back to In
Stock.

3. Reserved Inventory: Lists all reserved parts by model/site. These reservations will NOT debit from
the available parts - this is a manual process as part of receiving.

Select Remove Inventory if the request is canceled.

4. Items for Purchase: Lists all items that will go on the Purchase Request.

5. Purchase Request: When all items have been checked for stock and Items for Purchase have
been completed, select Create Purchase Request to create a new Purchase Request record.
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Service, Category, and Subcategory
Service, and its associated Categories and Subcategories, are available on the OOTB Portal Catalog
view.

Use these as examples for how products can be requested and enter the purchasing process. Customers
create their own entry point for the purchasing process based on their specific requirements. Enter the
Service Name on the Form and find the associated Category and Subcategory tabs in the Form
Arrangement.
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Schedule One-Step Action to Update Purchase
Request

Scheduling the Update Purchase Request One-Step Action allows CAM Purchase Orders and CSM
Purchase Requests to be automatically reconciled.

Note: This functionality is only available if you have applied the ITAM mApp Solution.
This step is not required if CAM is not being integrated.

1. In CSM Administrator, under Categories, select Scheduling.
2. Select Edit Schedule.

The Scheduled Items window opens.
3. Select Add.

The Schedule Item window opens.
4. Provide a Name and Description.
5. Select the Schedule page.

a. Select the Recurring option.
b. Provide a Start time and Time zone.
c. Set the Recurrence to Hours and prove the desired hourly recurrence.

The recommended setting is Every 1 Hour.
d. Select the No end date option and then select OK.

6. Select the Action page.
a. From the Action drop-down list, select One-Step.
b. Select the Ellipses to open the One-Step Action Manager.
c. From the One-Step Actions folder list, navigate to One-Step Purchase Request > Blueprint

> CAMAPI > Update Individual PR Status.
d. Select OK.

7. Select the Error Handling page.
a. Select the If scheduled item fails run One-Step check box.
b. Select the Ellipses to open the One-Step Action Manager.
c. From the One-Step Actions folder list, navigate to Global > CAMAPI > CAM PO Update

Failure.
d. Select OK.
e. Select the If scheduled item fails, still schedule next run (if recurring) check box.

8. Select OK.
9. (Optional) Select Test to verify that the One-Step Action runs.

10. Select OK and then select Exit.

Related concepts
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One-Step Actions
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Schedule One-Step Action to Update Config -
Software License

Scheduling the Update Config - Software License One-Step Action allows CAM and CSM licenses to be
automatically updated.

Note: This functionality is only available if you have applied the ITAM mApp Solution.

1. In CSM Administrator, under Categories, select Scheduling.
2. Select Edit Schedule.

The Scheduled Items window opens.
3. Select Add.

The Schedule Item window opens.
4. Provide a Name and Description.
5. Select the Schedule page.

a. Select the Recurring option.
b. Provide a Start time and Time zone.
c. Set the Recurrence to Hours and prove the desired hourly recurrence.

The recommended setting is Every 1 Hour.
d. Select the No end date option and then select OK.

6. Select the Action page.
a. From the Action drop-down list, select One-Step.
b. Select the Ellipses to open the One-Step Action Manager.
c. From the One-Step Actions folder list, navigate to One-Step Config - Software License >

Global > Update Licenses.
d. Select OK.

7. Select the Error Handling page.
a. Select the If scheduled item fails, still schedule next run (if recurring) check box.

8. Select OK.
9. (Optional) Select Test to verify that the One-Step Action runs.

10. Select OK and then select Exit.

Related concepts
One-Step Actions
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Update OOTB Portal Customer Security Group
The OOTB Portal Customer Security Group (or your own custom group, if used) must be updated for a
Customer to request items for purchase from the CSM Portal.

1. In CSM Administrator, under Categories, select Security.
2. Select Edit security groups.
3. From the Group drop-down list, select Portal Customer.
4. Select the Business Objects tab.

a. From the Business Object drop-down list, select Product Catalog.
b. Under General, select the View check box.
c. Under the Product Catalog list of fields, select New Field.
d. Under General, select the View check box.
e. From the Business Object drop-down list, select IncidentLinksProductCatalog.
f. Under General, select the following check boxes: View, Add, Edit, and Delete.

g. Under the IncidentLinksProductCatalog list of fields, select New Field.
h. Under General, select the View and Edit check boxes.

5. Save the Security Group.
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Update Friendly Name Field
Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to update the Friendly
Name Field.

Note: You only need to perform this task if you are using the CAM mApp® Solution to populate
the CMDB.

1. From the Current view drop-down list, select Default.
2. Under Show object types, select the Major option.
3. In the Business Object tree, select Config - Software License.
4. Under Appearance, select the Edit form link.
5. Under the Config - Software License fields list, right-click Friendly Name and select Edit

Friendly Name field.
6. Select the Validation/Auto-populate page.

a. Expand the Auto populate section.
b. From the field drop-down list, select License Unit Name.
c. Under the Populate with section, select License Unit Name from the Field drop-down list.

7. Select OK.
8. Publish the Blueprint.

Related concepts
Open the Form Editor
Publish a Blueprint
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Initiate a Request for Purchase From the Portal
Log in to the CSM Portal to submit a Purchase Request.

Note: This functionality is only available if you have applied the ITAM mApp Solution.

1. Log in to the CSM Portal and view the Service Catalog.
2. Based on your request type, select from the Purchasing Categories and Subcategories.

A New Request Specific Form opens.
3. Select Add a Product.

A Prompt for Quantity Requested opens.
4. Enter a Quantity number and select OK.

The selected product displays in the Requested Product view.
5. Continue to add products from the Product Catalog until the request is complete.
6. Select Add to Cart.
7. Select Submit Order to complete the order or select Continue Shopping to add additional

products to your order.

Related concepts
Add Items to the Service Cart
Related tasks
Log in to a CSM Portal
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Work the Service Request
Once a Service Request is assigned to the appropriate team and owner, the process begins to review line
items and information on availability.

Note: This functionality is only available if you have applied the ITAM mApp Solution.

Items will be in red until they have been processed by reserving parts from inventory or available CIs, or
by identifying that a purchase is required.

1. Double-click a product from the Items Request Form view.
2. Select Check Stock.

Note: Select Add a Product to manually select and add from the Product Catalog.

Stock is checked based on information in the Product Catalog. The Container drop-down list
options are Configuration Item or Inventory. If the Container is Configuration Item, the
Container Type drop-down list is available to indicate the CI type. Model is the other key field used
for the stock check.

3. Select the option to Reserve, Purchase, or Cancel.
a. If Reserve was selected, select the CI to reserve.

If the reservation satisfies the total number of items requested, the prompt will indicate that the
quantity has been satisfied.

b. Select OK.
The product line item turns green and the reserved CI now has a status of Planned (changed
from In Stock).

4. Continue the process above for each product in the list.
If reserving multiple items from a specific Site location, a prompt may display asking how much to
reserve from that location. Enter the quantity number and select OK.

a. If reserving a number that does not equal the requested number, you will need to choose from
the following options:

◦ Reserve Remaining Inventory?
◦ Create Purchase Request for Remainder?
◦ Continue at a later time?

The Inventory Parts record shows a reduced total inventory based on debiting the reserved
number from the request. The record also shows the associated Service Requests in the
Requests tab of the Form Arrangement.

5. Select Create Purchase Request.
a. When prompted, select Yes if all products have been added.

You may be prompted with questions regarding the needed by date and location of the Purchase
Request.
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The Purchase Request is now visible in the Purchase Request tab in the Form Arrangement.
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Work the Purchase Request
Once a Purchase Request has been created (from the Service Request), it is reviewed for accuracy,
modified as needed, and approved.

Note: This functionality is only available if you have applied the ITAM mApp Solution.

Only Line Items with a Type of Configuration Item are processed in CAM. Line Item Types of Inventory are
not ordered or managed in CAM. If you have a Purchase Request with only Inventory items requested, a
CAM purchase order will be automatically created after approval of the purchase request; however, the
line items are not part of the purchase order.

1. Open the Purchase Request Form and select Submit for Review to change the status (the initial
status is New).
The Purchase Request is reviewed and modified, and an approval is initiated for the requester's
manager.

2. The Purchase Request is now approved and the status changes to PO Created.
◦ Without CAM Integration: The Purchase Request is Read-Only except for specific order fields

which can be manually populated.
a. Select Next: Ordered to provide information on the Order Date and to change the status to

Ordered.
◦ CAM Integration: The Purchase Request is now Read-Only.

a. The ITAM mApp® Solution automatically sends the Purchase Request's information to CAM
via the CAM API configured during mApp Solution installation.

b. The Purchasing Manager edits the Purchase Order and the Purchase Request is automatically
updated with the CAM Order ID, the CAM Purchase Order number, the Vendor, and asset
order details based on a Scheduled One-Step™ Action.

3. Select Next: Set to Received to change the status to Received.
4. Use the Item Status and Qty to Check In drop-down lists to update both fields.

Item Status can be updated in CSM or CAM.
5. Select Check in and Create Inventory.

The new Configuration Item (CI) is created and displayed on the Configuration Items tab of the Form
Arrangement. The status is Planned and the serial number and any other additional information
needs to be manually recorded.

Note: If the CI is not new (example: Software license that increases in license count instead
of being created) it will not be displayed on the Configuration Items tab.

6. Close the Purchase Request and finish the Service Request by selecting Close.
The Service Request is removed from Pending status and moved to the status when the Purchase
Request was initiated.

Tasks are created for the Items for Purchase line items so the appropriate actions can be taken for
Inventory and CIs.
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Purchase Request through Receiving Workflow
The Purchase Request through Receiving workflow demonstrates the Purchase Process lifecycle.

The workflow in CSM and CAM for Purchase Request through Receiving includes some activities that are
automated via the mApp® Solution functionality and other areas that are manual, such as adding serial
numbers to a new CI.

• Line items are imported from the Service Request. The Line Items tab is in the Form Arrangement.

• The OOTB workflow includes a manager approval.

• Once the Purchase Request is approved, if integration with CAM was selected, the information is
automatically sent to CAM, creating a Purchase Order. The Purchasing Manager then edits the
Purchase Order in CAM.

• Purchase Requests can be used to track and manage the lifecycle of IT Assets by allowing Users to
view Purchase Order details, vendor information, order numbers, invoice numbers, and attached CIs
in one location.
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IT Asset Management (ITAM) - Purchase Request
through Receiving mApp Solution Items

The items tables provides a list of items included when applying the mApp Solution and the typical merge
action.

Item Category Item
Typical
Merge
Action

Automation
Process
Definitions

Create Order, mApp Factory - Close PR create tasks, mApp Factory -
Update Product List, Notify CAM Purchasing Manager When PO
Created, Notify Requestor of PO Created, Send Delivery Notification to
CAM, Set Status to Ordered Status

Import

Business
Objects

Agreement, Building Status, Config - Computer, Config - Mobile
Device, Config - Network Device, Config - Other CI, Config - Printer,
Config - Server, Config - Software License, Config - System, Config -
Telephony Equipment, Configuration Item, Site Status, Specifics,
Specifics - Email, Specifics - Employee New, Specifics - Employee
Separation, Specifics - Employee Update, Specifics - Generic,
Specifics - ITAL, Specifics - New Device, Specifics - Printer

Don't
Change

Building, Purchase Request Status, Site, State Province Territory,
Supplier Catalog Item Overwrite

Config - Computer, Config - Mobile Device, Config - Printer, Config -
Software License, Configuration Item, Incident, Product Catalog,
Supplier, Underpinning Contract

Merge

IncidentLinksInventory, IncidentLinksProductCatalog,
IncidentLinksSupplierCatalog
Item, Inventory, Part, Product Subcategory, Purchase Request,
Purchase Request Line Item, Purchase Request Line Item Status,
Purchase Request Priority, Purchase Request Reason, Specifics -
ITAL

Import

Counters
Inventory, Purchase Request ID Import

Purchase Order #, Purchase Request, PurchaseRequestID, Site Overwrite

Custom View Portal Default, Portal Secondary Don't
Change

Dashboard IT Purchasing Import

Item
Category Item

Typical
Merge
Action
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Fields

ABA Accessibility Flag, Alt, 1 Command, Alt 1 Command Name, Alt 1 Status,
Alt 1 Status One Step, Alt 1 Status Text, Alt 2 Command, Alt 2 Command
Name, Alt 2 Status, Alt 2 Status One Step, Alt 2 Status Text, ANSI Usable,
Approval Block ID, Approved On Date Time, Area, Archive, Asset Type,
Associated Models, Auto Reorder, Auto Reorder Part ID, Auto Reorder
Submitted, Building Code, CAM Access Profile, Canceled, Category, ChildID,
ChildJoinReason, ChildType, CI Asset Type ID, CI Software Rec ID, CI Type,
Class, Closed, Commercial and Government Entity Code, Configuration Item
Type, Construction Date, Container, Container Type, Contract ID, Contract
Type, Country_de-DE, Country_en-US, Country_es-ES, Country_fr-FR,
Country_pt-BR, Created By, Created By ID, Created Culture, Created Date
Time, Date Required, Days ARO, Department, Description, Energy Star, Energy
Star Justification, Environmentally Preferred, Environmentally Preferred
Justification, Expedited Shipment Price, Extended Price, Hardware Model/
Software Name, Hardware Model/Software Title, Hazardous Material, Historical
Status, Impact, Incident ID, Incident Specifics RecID, In Stock CI Name, Is
Complete, Inventory ID, Inventory Item Name, Inventory Type ID, Inventory
TypeName, Invoice Number, Item Name, Item Status, JoinReason, Justification,
Last Modified By, Last Modified By ID, Last Modified Date Time,
LastModTimeStamp, Latitude, Line Item ID, Line Item Type, Location - Building,
Location - Country, Location - Site, Location - State, Location - State/Province,
Low Stock Level, Made in the USA, Made in the USA justification,
Manufacturer, Manufacturer Number, Manufacturer Part Number, Matrix Order,
Model, Name, Next Day Shipment Price, Next Status, Next Status Command,
Next Status Command Name, Next Status One-Step, Next Status Text, Notes,
Number On Hand, OEM CAGE Code, Order Date, Order ID, Order Number,
Order Title, Ordered, Owned By, Owned By Email, Owned By ID, Owned By
Phone, Owned By Team, Owned By Team ID, Owned/Leased, ParentID, Parent
RecID, Parent Request, ParentType, Part ID, Pending, PO Created, PO URI,
Preferred Supplier, Price, Priority, PR Line Item RecID, PR Line Item Type ID,
PR RecID, Product Category, Product Catalog ImageLink Text, Product
Container, Product Cost, Product Name, Product Service Code, Product
Subcategory, Products Requested, Property Type, Purchase Date, Purchase
Order Number, Purchase Price, Purchase Request ID, Purchase Request Line
Item ID, Quantity, Quantity Available, Quantity Checked In, Quantity Per Unity
Pack, Quantity Received, Quantity Requested, Quantity Reserved, Quantity to
Reorder, Reason, Received, RecID, Reconciled Name, Reorder Status,
Requested By, Requested By Email, Requested By ID, Requested By Phone,
Request ID, Reviewed, Sale End Date, Sale Price, Sale Start Date, SCI ID, SCI
Price, Selected Status, Service Cart Item RecID, Short Description, Site, SKU,
Specifics FormRecID, Specific Type ID, Specific Type Name, Standard
Shipment Price, Status, Status ID, Status Order, Subcategory, Supplier,
Supplier Catalog Item ID, Supplier Catalog Item - Manufacturer, Supplier
Catalog Item - Price, Supplier Catalog Item for Reorder, Supplier Catalog Item
ID, Supplier for Reorder, Supplier ID, Supplier ID for Reorder, Supplier Name,
Supplier Name for Reorder, Supplier Part Name, Supplier Part Number, Surplus
Stock Level, Threshold for Reorder, Total Number of Items Received, Total
Number of Items Requested, Total Price, Type, Underpinning Supplier ID, Total
Parking Spaces, Underpinning Contract ID, Underpinning Supplier ID, Unit, Unit
Cost, Unit of Issue, UPC, Urgency, URI, Vendor, Version Stamp

Import

Address, Address 2, Building Address 1, Building Address 2, Building Name,
Building Status ID, Carrier, City, Country, County, Created By, Created By ID,
Created Culture, Created Date Time, Description, Full Address, Item Type, Last
Modified By, Last Modified By ID, Last Modified Date Time,
LastModTimeStamp, Lead Agreement ID, Lead Agreement Name, Lead
Supplier, Lead Supplier ID, Location ID, Model, Name, Notes, Owned By,
Owned By ID, Owned By Team, Owned By Team ID, Postal Code Zip, Rec ID,
Region Code, Site, Site ID, Site Name, State, State Province Territory, Status,
Status ID, Supplier Catalog Item ID, Zip

Overwrite

_Link Type, Accessory 1, Accessory 2, Accessory 3, Accessory 4, Accessory
Cost 1, Accessory Cost 2, Accessory Cost 3, Accessory Cost 4, Accessory_1,
Accessory_2, Accessory_3, Accessory_4, Additional IP Address, Additional
Details, Additional Needs Completed, Any loose cables?, Asset Status, Asset
Tag, Asset Type, Assign CI's, Auto-Created Incident, Auto-Created Incident ID,
Auto-Created Incident Related Event, Barcode, BIOS, BIOS Version, Building,
Building Name, Carrier, Cellular Enabled, Check Print Queue, Check Work
Environment, CI Type, Computer Accessory 1, Computer Accessory 2,
Computer Accessory 3, Computer Accessory 4, Computer Accessory Cost 1,
Computer Accessory Cost 2, Computer Accessory Cost 3, Computer
Accessory Cost 4, Computer Accessory Subtotal, Computer Full Description,
Computer Image Link Text, Computer Price, Computer Product, Computer
Short Description, Computer Subtotal, Computer Type, Computer_Accessory
1, Computer_Accessory 2, Computer_Accessory 3, Computer_Accessory 4,
Configure Office Space, Configure Software, Configuration Item Type ID,
Configuration Item Type Name, Configured Office Space, Connected to
Internet, Connection Type, Contract ID, CPU Speed, CPU Type, Create Key
Card, Create Network Account, Create Phone Extension, Created By, Created
By ID, Created Culture, Created Date Time, Created Network Account, Created
Phone Extension, Critical, Current Alert, Current Alert Wait Time In Minutes,
Departure Date, Departure Time, Description, Downtime Period Start Date
Time, Device Type, Employee Department, Employee Name, Employee Type,
Equipment Type, Escalate, Facility, Free or Open Source, Free Ports, Friendly
Name, Grant Building Access, Granted Building Access, Host Name, IMEI,
Install Desktop Phone, Installed Software, Invoice Attached, Invoice ID, IP
Address, IP Address 6, IP Address v6, IP Range End, IP Range Start, Is it
Online?, Is the power on?, Is the toner low?, Is there a paper jam?, Is there
paper loaded?, Laptop Needed, Last Down Time, Last Modification Time
Stamp, Last Modified By, Last Modified By ID, Last Modified Date Time, Last
Modified Date Stamp, LastModTimeStamp, Latitude, Location ID, Lock
Account, Longitude, MAC Address, Maintenance Amount, Maintenance
Calendar, Maintenance Frequency, Managers Notified, Manufacturer, Mobile
Accessory 1, Mobile Accessory 2, Mobile Accessory Cost 1, Mobile Accessory
Cost 2, Mobile Accessory Subtotal, Mobile Device Type, Mobile Full
Description, Mobile Image Link Text, Mobile Price, Mobile Product, Mobile
Short Description, Mobile Subtotal, Mobile_Accessory 1, Mobile_Accessory 2,
Model, Model Number, Network Access Needed, Network Security Groups,
Non-Standard Product, Notes, Number CPUs, Operating System, Operating
System Family, Operating System Service Pack, Operating System Version,
Order Cell Phone, Ordered Accessory 1, Ordered Accessory 2, Ordered
Accessory 3, Ordered Accessory 4, Ordered Computer, Ordered Computer
Accessory 1, Ordered Computer Accessory 2, Ordered Computer Accessory 3,
Ordered Computer Accessory 4, Ordered Device, Ordered Mobile Accessory 1,
Ordered Mobile Accessory 2, Ordered Mobile Device, Ordered Software,
Owned By, Owned By ID, Owned By Team, Owned By Team ID, Parent Rec ID,
Personally Owned, Phone, Phone Number, Physical Memory, PR Line Item
RecID, PR Line Item Type ID, PR RecID, Primary Use, Primary User Full
Name, Primary User Name, Primary User Rec ID, Primary User VIP, Printer
Error Cause, Printer Error Code, Printer Type, Purchase Date, Purchase Price,
Purchase Type, Ready for Approval, RecID, Reconfigure Workstation, Rekey
Office Door, Remove from LDAP, Return Cell Phone, Return Laptop, Return
Mobile Device, Return PDA, Room, Search Knowledge Base, Selected Status,
Serial Number, Service Cart Item RecID, Set up Screen Reader, Set up Work
Environment, SIM Card, Site, Site ID, Site Name, SLA ID, SLA Name, Software
Image Link Text, Software Price, Software Product, Software Short Description,
Software Subtotal, Software Type, SoftwareID, Specific Type ID, Specific Type
Name, Specifics - Email ID, Specifics - New Computer ID, Start Date, Start
Date for Update, Status, Status ID, Supplier, Terms, Test Email, Total Downtime
This Period, Total Page County, Total Ports, Type of Connection, User Name,
Vendor, Verify Connection using TCP/IP, Video Card, VIP, Virtual Memory,
Wheelchair Access, Workstation Re-configured

Don't
Change
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Item Category Item Typical
Merge Action

Form Arrangements

CatalogItem, FacilitiesBuilding, Incident, Site,
UnderpinningContract, Vendor Overwrite

IncidentLinksProductCatalog, Part, PurchaseRequest,
PurchaseRequestLineItem, SpecificsITAL Import

Forms

IncidentLinksInventory, IncidentLinksProductCatalog,
IncidentLinksSupplierCatalog

Item, Part, ProductSubcategory, PurchaseOrderLineItem,
PurchaseRequest, PurchaseRequestLineItemStatus,
PurchaseRequestPriority, PurchaseRequestReason,
PurchaseRequest - SupplierCatalogItem, Purchasing -
ProductCatalog, Purchasing - UnderpinningContract,
SpecificsITAL

Import

Purchase Request Status, Site, StateProvince Overwrite

Incident Don't Change

Grid Change
Persistence _5JyZpXRggCw Import

Grids

IncidentLinksInventory, IncidentLinksProductCatalog,
IncidentLinksSupplierCatalog

Item, Inventory, Inventory 1 Dashboard, Part,
ProductSubcategory, PurchaseOrderLineItem,
PurchaseRequest, PurchaseRequestLineItemStatus,
PurchaseRequestPriority, PurchaseRequestReason,
SpecificsITAL

Import

FacilitiesBuilding, Site, PurchaseRequestStatus, StateProvince,
SupplierCatalogItem Overwrite

Image Definition ITAM-Add-Icon, ITAM-Add-Icon1, ITAM-Dashboard-Icon, ITAM-
Dashboard-Icon1, ITAM-Inventory-Icon, ITAM-Reorder Import

Item
Category Item

Typical
Merge
Action
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Indexes

Agreement_Name, Config - Software License Actions,
ConfigSoftwareLicenses_

SoftwareID, ConfigurationItem_AssetTag, ConfigurationItem_FriendlyName,
Incident_CustomerID, Incident_IncidentType, Incident_OwnedByID,
Incident_RecID, IncidentCreatedDT, IncidentID,
IncidentIdx_ServiceCartRecID, IncidentIdx_ServiceCatalogTemplateRecID,
IncidentService,IncidentStatus, InstalledSoftware_Product, Latitude,
Longitude, PK_Agreement, PK_ConfigurationItem, PK_ProductCatalog,
PK_PurchaseRequestStatus, PK_Site, PK_StateProvince,
PK_SupplierCatalogItem, PurchaseRequestStatus_Status, Site_SiteID,
Supplier_SupplierID, SupplierCatalogItem_CatalogItemID,
SupplierCatalogItem_Name, SupplierIDx0, SupplierIdx1

Overwrite

ConfigSoftwareLicense_

SoftwareID, ConfigurationItem_AssetTag,
ConfigurationItem_FriendlyName, InstalledSoftware_Product, Latitude,
Longitude, PK_ConfigurationItem, PK_Specifics, PrinterSpecifics_Model,
Specifics_ParentId, Specifics_SpecificTypeName,
SpecificsEMail_SpecificsEMailID,
SpecificsNewComputer_SpecificsNewComputerID

Don't
Change

Inventory_InventoryID, PK_IncidentLinksInventory,
PK_IncidentLinksProductCatalog, PK_IncidentLinksSupplierCatalog

Item, PK_Inventory, PK_ProductSubcategory, PurchaseOrderLineItem,
PK_PurchaseRequest, PK_PurchaseRequestLineItemStatus,
PK_PurchaseRequestPriority, PK_PurchaseRequestReason,
PurchaseRequest_PurchaseRequestID, PK_Specifics,
PrinterSpecifics_Model, Specifics_ParentId, Specifics_SpecificTypeName,
SpecificsEMail_SpecificsEMailID,
SpecificsNewComputer_SpecificsNewComputerID

Import

Item
Category Item

Typical
Merge
Action

Language
Pack
Bundle

DE_2019-09-04, EN-DE_ITAM, EN-ES_ITAM, EN-FR_ITAM, EN-PT_ITAM,
ES_2019-09-04, FR_2019-09-04, PT_2019-09-04 Import

Mergeable
Areas

Config - Software License Actions, Incident Actions,
IncidentLinksProductCatalog Actions, Purchase Request Actions, Purchase
Request Approvals, Purchase RequestLine Item Actions

Overwrite
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One-Step™
Actions

Add Line Item, Add Line Item to CAM Purchase Order, Adjust Inventory, Alt
1 Step from Relationship, Alt 2 Step from Relationship, Approved, Assign to
ANY Individual, Assign to Individual, Assign to Team, Auto Reorder, CAM
PO Update Failure, Check Availability, Check for Existing Parts, Check In,
Choose a Part, Choose an SCI, Create CI, Create Inventory, Create PO,
Create PR, Create Purchase Order in CAM, Create Signature, Create Tasks
in Incident, DEBUG: Notification Scheduled Job Ran, Get Hardware Types,
GMT DateTime, Increment Version Stamp, Increment VersionStamp,
Launch New Inventory Item, Launch New Purchase Request, Modifier
Create Signature, New Inventory Item, New Purchase Request, Next Step
from Relationship, Notify CAM Purchasing Manager of New PO, Notify CAM
Purchasing Manager of Order Received, Notify Requestor of New PO, OLD-
Scheduled Update PR Status, Open Purchase Order in CAM, Portal Select
Product and Quantity, Refresh Item List, Remove an Item, Return to
Inventory, Select a Team, Select Product and Quantity, Set Complete for
Canceled, Set Owned By, Set Status, Set Status to PO Created, Set to
Approved Status, Set to Canceled Status, Set to Closed Status, Set to
Ordered Status, Set to Pending Status, Set to Received Status, Set to
Reviewing Status, Show Date Time, Show Detailed Date Time, Take
Ownership, TEST Dynamic URL in Web Service, TEST Get API Version,
TEST XML Parse, TEST-Get Line Item, TEST-Get Line Item Detail, TEST-
Get Order, TEST-Get Users, TEST-Signed Get Order, TEST-Signed Get
Users, Update CAM Server, Update Individual PR Status, Update Licenses,
Update PR Line Item Status, Update Products, Update Status, URI String
Test

Import

Add to Cart, Assign to a Team, Assign to Individual, Assign to Team, Create
a Catalog Item, New Submit or Add to Cart, Take Ownership Overwrite

Item
Category Item

Typical
Merge
Action
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Relationships

Auto Reorder Links Purchase Requests, Configuration Item Links
Purchase Request Line Item, Existing Part Links Purchase Request Line
Item, Incident Links Inventory, Incident Links Product Catalog, Incident
Links Purchase Request, Incident Links Supplier Catalog Item, Incident
Owns Inventory Join Table, Incident Owns Supplier Catalog Item Join
Table, Incident Owns Product Catalog Join Table, Inventory Links Incident,
Inventory Links Owned By, Inventory Links Supplier Catalog Item,
Inventory Owns Incident Join Table, Part Owns, Product Catalog Join
Links CMDB, Product Catalog Join Links, Part, Product Catalog, Join
Links Specifics, Product Catalog Join Table Owned by Incident, Product
Catalog Link Software, Purchase Request Line Item links CI Type,
Purchase Request Line Item links CIs, Purchase Request Line Item Links
Existing Part, Purchase Request Line Item Owned By Part, Purchase
Request Line Item Owned By Purchase, Purchase Request Line Items,
Purchase Request Links Auto Reorder, Purchase Request Links CI,
Purchase Request Links Customer Internal, Purchase Request Links
Incident, Purchase Request Links OwnedBy, Purchase Request Links,
Phase Set, Purchase Request Links, to Status, Purchase Request Links
UserInfo, Purchase Request Owns Approvals, Purchase Request Owns
Journals, Purchase Request Owns Line Items, Specifics is related to an
Incident, Supplier Catalog Item Links Supplier, Supplier Catalog Item
Links Underpinning Contract, Supplier Links Supplier Catalog Items,
Supplier Links Underpinning Contracts, Underpinning Contract Links
Supplier, Underpinning Contract Links Supplier Catalog Items

Import

[Foreign Key] Configuration Item Links CI Status, CI has auto-created
Incident, CI Links Customers, CI links Downstream CIs, CI links Logical
Services, CI links Problems, CI Links Site, CI links Upstream CIs,
Configuration Item Group Links Change Request, Configuration Item
Group Links Configuration Item Group, Configuration Item Group Links
Customers, Configuration Item Group Links Incidents, Configuration Item
Group Links Journals, Configuration Item Group Links Status,
Configuration Item Links Configuration Items, Configuration Items Links
Purchase Request Line Item, Configuration Item Links SLA, Configuration
Item Links Vendors, Configuration Item Owns CIEvents, Configuration
Item Owns Journal - Notes, Configuration Item Owns Tiered Alerts

Don't
Change

Site Links Buildings, Site Links Status Overwrite

Item Category Item Typical Merge
Action

Searches

All Line Items, All Parts, All Purchase Requests, Auto Reorder
PRs, Auto-Renew Items, Canceled Purchase Requests,
Completed Purchase Request, Desktop, Inventory at Reorder
Level, Laptops in Stock, Low Stock, Mobile Devices in Stock,
Open PR in CAM, Open Purchase Requests, Printers in Stock,
Purchase Requests Under Review, Surplus Stock

Import
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Stored
Expressions

API LineItem Asset Type, API LineItem Category, Approval Lock,
CAM Not Editable, Check-in Fields Disabled, Configuration Item
Type, Delivered or Canceled, Fields Disabled, Line Item Is
Complete, Number of Complete Line Items, Number of Hardware
CIs on Hand, Number of Items Received, Number of Line Items,
Number of Line Items in Ordered Status, Number of Line Items
Not Canceled, Number of Line Items Received, Number of Line
Items Requested, Number of Software CIs for this Line Item,
Owned By Member of Owned By Team, PurchaseRequestID,
Stock Status, Total Cost

Import

Stored Queries

All Line Items, All Parts, All Purchase Requests, Auto Reorder
PRs, Canceled Purchase Requests, Completed Purchase
Requests, Desktop, Inventory at Reorder Level, Laptops in
stock, Low Stock, Mobile Devices in Stock, Open PR in CAM,
Open Purchase Requests, Printers in Stock, Purchase Requests
Under Review, Surplus Stock

Import

Stored Values

CAM API Version, CAM Customer Number, CAM Date, CAM
Default Access Profile, CAM mApp Version, CAM Purchasing E-
Mail, CAM Server, Current Product Join RecID, Current Product
Name, CurrentDateTime, Endpoint, Inventory Joint Table RecID,
IsDebug, Item County Selected, Item Search RecID, New CAM
Server, Own CAM?, Product RecID, PS Options, Secret Key,
Signature, Signature Success, Specifics CI Type, Supplier
RecID, Test Blank

Import

Country, Site, State Overwrite

Tabs

Journals, Overview, Supplier Don't Change

Comments, Items for Purchase, Items Requested, Overview,
Purchase Request, Requested Products, Reserved Inventory,
Supplier, Supplier Catalog Items, Underpinning Contract Catalog
Items (0), Underpinning Contracts

Import

Activity, Additional Information, Agreements (0), All Agreements,
Approvals (0), Building, Comments, Configuration Items,
Customer History (0), FacilitiesBuilding, Journals, Lead
Agreement, Lead Supplier, Linked Incidents (0), Linked to Major
Incident, Overview, Related Device, Related CIs (0), Related
Problem, Resolution Details, 's Open Incidents (0), Scorecards
(0), Service Complaints (0), Service Impact Events (0), Similar
Incidents (0), Site, Supplier Catalog Items (0), Supplier Risk
Assessments (0), Tasks (0), Work Units (0)

Overwrite

Web Services CAM API, Secure CAM API Import

Widgets

Desktop Stock by Model, Inventory at Reorder Level, Laptop
Stock by Model, Low Stock by Item List, Mobile Devices Stock
by Model, Printer Stock by Model, Purchase Request Filter,
Purchase Requests by Status, Purchase Requests from Auto-
Reorder, Purchase Requests Pending Approval, Surplus Stock
by Item List

Import
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• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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IT Project Tracking (ITPT) mApp Solution 1.5
Use the IT Project Tracking (ITPT) mApp® Solution to track project progress through the lifecycle.

Platform version requirements: Tested on CSM 10.0.0 — 10.2.0.

Content version requirements: Tested on CSM 10.0.0 — 10.2.0; this mApp Solution may or may not be
compatible on content versions earlier than CSM 10.0.0, but as with all mApp Solutions, be sure to test it
on your customized system.

Prerequisites: None.

Available languages: English.

Overview
The ITPTmApp Solution provides functionality that allows you to use ITPT features such as One-Step™
Actions, expressions, search groups, widgets, and a dashboard. ITPT is the process of documenting the
progress of a project throughout the defined lifecycle. ITPT is a CSM Business Object that allows Project
Managers to track project components (Deliverables, Cost Items, Project Members, Risks/Issues, Meeting
Minutes, and Tasks) at a high level using a custom workflow (Initiation, Awaiting Approval, Execution,
Closing). CSM integrates with IT Project Tracking so you can incorporate the CSM ITPT Business
Process into your system.

ITPT Form
Use the ITPT form to track the project details as it progresses through the project lifecycle.
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For a list of items included in the mApp Solution, see ITPT mApp Items.

Apply the mApp Solution
Follow these steps to download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. The contents of the .zip file include the following:
◦ ITPTv1.5.mApp

◦ calendar.ced

◦ dashboard.ced

◦ reports.ced

◦ searches.ced

4. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

5. On the How automatic should the merge process be? screen of the Apply mApp Wizard, choose
either Ask me about every decision or Make reasonable decisions, but ask me if unsure.

572

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/csh?topicname=itpt_mapp_items
https://help.cherwell.com/csh?topicname=apply_a_mapp_considerations
https://help.cherwell.com/csh?topicname=apply_a_mapp


After you apply the mApp Solution, you can use ITPT in the same way as other CSM processes. To
access the Project form, select File > New > New ITPT Project, in the CSM Desktop Client; or to
configure the Project Business Object, select Create New Blueprint > ITPT Project > Edit Business
Object, in CSM Administrator.

Import Supplemental Files
After you install the mApp Solution, import the supplemental files included with the .zip file.

To import ITPT sample reports:

1. In CSM Administrator, create a new Blueprint.

2. Select Managers > Reports.

3. In the Association drop-down list, select ITPT Project.
4. Navigate to the Global folder.

5. Select File > Import.
6. Select the reports.ced file and select Open.

7. Select Close.

8. Publish the Blueprint.

To import the ITPT dashboard:

1. In CSM Administrator, create a new Blueprint.

2. Select Managers > Dashboard Manager.
3. Navigate to the Global > Dashboards > Prjoect Dashboards.

4. Delete the existing Project Details dashboard (the Def is broken making it uneditable)

5. Select File > Import.
6. Select the dashboard.ced file and select Open.

7. Select Close.

8. Publish the Blueprint.

To import the ITPT calendar:

1. In CSM Administrator, create a new Blueprint.

2. Select Managers > Calendar Manager.
3. Navigate to the Global folder.

4. Select File > Import.
5. Select the calendar.ced file and select Open.

6. Select Close.

7. Publish the Blueprint.
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To import the ITPT searches:

1. In CSM Administrator, create a new Blueprint.

2. Select Managers > Searches.

3. In the Association drop-down list, select ITPT Project.
4. Navigate to the Global folder.

5. Select File > Import.
6. Select the searches.ced file and select Open.

7. Select Close.

8. Publish the Blueprint.

Related Information

• For additional information, see About mApp Solutions.

• For additional information, see the free Video Learning Library course Demonstrating IT Project
Tracking within Cherwell.

Revision History

mApp Version Platform Version
Requirements

Content Version
Requirements Prerequisites

1.0 5.0.0 5.0.0

OOTB content earlier than
4.6.0a requires the Avatar
Functionality mApp
Solution.

1.0.2 Tested on 5.0.0 - 9.6.x.

Tested on 5.0.0 - 9.6.x
(Configurations may be
required for the Task
Business Object with content
versions 9.5.x and 9.6.x).

OOTB content earlier than
4.6.0a requires the Avatar
Functionality mApp
Solution.

1.1

Tested on 9.6.3 and 9.7.0
(mApp Solution cannot be
applied to a platform
version older than 9.6.3).

Tested on 5.0.0 - 9.7.0 (9.5.x
and 9.6.x may require
changes to Task to work
properly).

OOTB content earlier than
4.6.0a requires the Avatar
Functionality mApp
Solution.

1.5 Tested on 10.0.0 — 10.2.0.

Tested on 10.0.0 — 10.2.0;
this mApp Solution may or
may not be compatible on
content versions earlier than
10.0.0, but as with all mApp
Solutions, be sure to test it on
your customized system.

None.

Related concepts
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About One-Step Actions
Expressions
About Saved Searches
About Widgets
Dashboards
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Create an IT Project
Use the Project form to create a project, assign a project manager, and track the project through the
lifecycle.

Note: This functionality is only available after you apply the mApp Solution.

To create an IT Project:

1. Select File > New > New ITPT Project.

2. Complete the following fields:

Field Description

Project ID Enter a unique identification for the project.

Priority Select the number 1-5 that corresponds with
the priority of the project. The priority is used to
establish timescales and effort to respond to
and complete the project.

Requester Select the Project Requester.
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Field Description

Name Enter a unique name for the project.

Description Enter a short description of the project.

Portfolio ID Select the Portfolio ID from the drop-down list.
Information about the Portfolio is displayed in
the Portfolio tab of the form arrangement.

Location Enter the project location.

Primary CI Select the primary Configuration Item.

Project Manager Team Select the Project Manager Team from the
drop-down list.

Project Manager Select the Project Manager from the drop-down
list.

Estimated Effort Enter the projected number of hours the project
will require.

Actual Effort Once the project is complete, enter the number
of hours spent on the project.

Planned Start Date Select the date the project should start.

Planned End Date Select the date the project should end.

Actual Start Date Once the project has started, enter the date the
project started.

Actual End Date Once the project has ended, enter the date the
project ended.

Related concepts
IT Project Tracking (ITPT) mApp Solution 1.5
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Define a Project Business Case
Use the Business Case tab to articulate your reason for initiating the project.

Note: This functionality is only available after you apply the mApp Solution.

1. On the Business Case tab in the form arrangement, select New ITPT Business Case.
2. Add the following information:

a. Business Reasons: A reason for initiating the project (example: The current Dell Switch in the
Colorado Springs, CO office is antiquated and needs to be replaced).

b. Resource Details: Resource information for the project (example: Clair Wu has been identified
as the person who will install and configure the switch).

c. Cost Details: Cost information for the project (example: The cost of one 5000 Gigabit Switch is
$8,450.00 USD).

The Business Case form automatically saves.

578

CSM mApp Solutions

CSM mApp Solutions



Define Project Deliverables
Use the Deliverables tab to define and track individual products or services that you will provide for the
customer.

Note: This functionality is only available after you apply the mApp Solution.

To define deliverables:

1. On the Deliverables tab in the form arrangement, select New ITPT Deliverable.
2. Add the following information:

a. Deliverable ID: An identification code for the deliverable (example: 1A).
b. Name, description, and any necessary requirements.
c. Select the Customer Accepted check box after the customer approves the deliverable.
d. Start Date and End Date: Select the dates you plan to begin and complete working on the

deliverable.
The Deliverables form automatically saves.
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Define Project Cost Items
Use the Cost Items tab to define individual project costs based on type.

Note: This functionality is only available after you apply the mApp Solution.

To define Cost Items:

1. Add labor costs:
a. On the Cost Item tab in the form arrangement, select New > New - Cost Item - Labor.
b. In the Resource Name drop-down list, select a user.
c. Select a Cost Type option:

◦ CapEx: Capital expense.
◦ OpEx: Operations expense.

d. Provide the Budget Cost (allocated budget).
The defined amount is automatically added to either the CapEx Budget or OpEx Budget form
in the Effort/Cost Info section of the Overview tab.

e. In the Total Cost section, provide the hours and rate (hourly). The Total Cost automatically
calculates (hours multiplied by rate).
The Cost Item form automatically saves.

2. Add other miscellaneous costs:

Note: Other costs are expenses that do not align with Labor, Provisioning, or Tool cost
categories.

a. In the Cost Item tab in the form arrangement, select New > New - Cost Item - Other.
b. Provide Details and select a Cost Type option.
c. Provide the Budget Cost (allocated budget).

The defined amount is automatically added to either the CapEx Budget or OpEx Budget form
in the Effort/Cost Info section of the Overview tab.

d. Provide the Total Cost.
The Cost Item form automatically saves.

3. Add provisioning costs:
a. In the Cost Item tab, select New > New - Cost Item - Provisioning.
b. Select a Status option and provide Details.
c. Select a Cost Type option.
d. Select a Category and Frequency from the drop-down lists.
e. Provide a Budget Cost (allocated budget) and Total Cost.

The defined amount is automatically added to either the CapEx Budget or OpEx Budget form
in the Effort/Cost Info section of the Overview tab.

The Cost Item form automatically saves.
4. Define tool costs.

a. In the Cost Item tab, select New > New - Cost Item - Tool.
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b. Provide an Item Description and Budget Cost.
The defined amount is automatically added to either the CapEx Budget or OpEx Budget form
in the Effort/Cost Info section of the Overview tab.

c. In the Total Cost section, provide the hours and rate (hourly). The Total Cost automatically
calculates (hours multiplied by rate).
The Cost Item form automatically saves.
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Define Project Users and Customers
Use the Project Users and Project Customers tabs to add users and customers to the project and
specify details about them.

Note: This functionality is only available after you apply the mApp Solution.

An ITPT Project User is a licensed CSM user that requires CSM to perform their role in the
project.

To define Project Users:

1. Select the Project Users tab in the form arrangement.

2. Select New ITPT Project User.
3. Complete the Project User form:

a. Select the Project Notification E-mail check box to indicate that the user should receive
project updates via email.

Notification emails are also used for the Project Approval Process, so all members of the
Project Approval Team must have the check box selected to receive approval notification
emails.

b. Select the Approver check box to indicate that the user is a member of the Project Approval
Team.

c. Select the name from the drop-down list or select the Select User link.

d. Select the role from the drop-down list.

e. Provide the email, phone number, and any notes for the user.

To define Project Customers:

1. Select the Project Customers tab in the form arrangement.

2. Select New ITPT Project Customer.
3. Complete the Project Customer form:

a. Select the Project Notification E-mail check box to indicate that the customer should receive
project updates via email.

b. Select the name from the drop-down list or select the Select User link.

c. Select the role from the drop-down list.

d. Provide the email, phone number, and any notes for the customer.

The Project Customer form automatically saves.
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Define Project Risks and Issues
Use the Risks/Issues tab to define risks or issues that might affect the outcome of the project.

Note: This functionality is only available after you apply the mApp Solution.

Risks include complications that exist before the project is initiated, and issues include complications that
occur while the project is being implemented.

To add a risk:

1. On the Risks/Issues tab in the form arrangement, select New ITPT Risk Issue.

2. Complete the Risks/Issues form:
a. Select Risk from the Category drop-down list.

b. Provide a description and effect (outcomes of the risk).

c. Select an Impact and Status from the drop-down lists.

The Impact drop-down list affects the Risk indicator in the default form area.

To add an issue:

1. On the Risks/Issues tab in the form arrangement, select New ITPT Risk Issue.

2. Complete the Risks/Issues form:
a. Select Issue from the Category drop-down list .

3. Follow steps b and c above to complete the form.

The Risks/Issues form automatically saves.
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Define a Configuration Item
Use the Configuration tab to add an item to the project and descriptions for the Configuration Item (CI).

Note: This functionality is only available after you apply the mApp Solution.

To add a Configuration Item:

1. Select the Configuration Items tab. The list of CIs associated with the project opens.
2. Select a CI from the New drop-down list. The New Config dialog box opens.
3. Complete the fields to describe the CI.

Related concepts
Creating Configuration Item (CI) Records
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Define Meeting Minutes
Use the Meeting Minutes tab in to define and track important activities and decisions made during the
progress of the project.

Note: This functionality is only available after you apply the mApp Solution.

To define meeting minutes:

1. On the Meeting Minutes tab in the form arrangement, select New ITPT Meeting Minutes.
2. Complete the meeting minute details:

a. Meeting Minute ID: Provide an identification code for the meeting minute (example: 1A).
b. Add a title, category, and description.
c. Type an explanation of the meeting minute (example: Assess status of deliverables).
d. Select a status and due date.
e. Select a name from the Ball in Court drop-down list or select the Select User link. This is the

person that owns the meeting minute.
f. The Ball in Court E-Mail field is auto-populated based on the customer record of the user

(Ball in Court).
g. Select the Send an Email link to define and send a notification email to the user (Ball in

Court).
The meeting minute form automatically saves.
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Define a Task
Use the Tasks tab to add and describe a task for the project.

Note: This functionality is only available after you apply the mApp Solution.

To create a task:

1. Select the Tasks tab.
The list of tasks associated with the project opens.

2. Select New Work Item.
3. Complete the task fields.

Related concepts
Work Item Task
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Define a Journal
Use the Journals tab to add a note or comment to the project.

Note: This functionality is only available after you apply the mApp Solution.

The Journals tab lists Journal - Notes. Journal - Notes are used to track notes and comments. For
example, a user might chronicle troubleshooting progress.

To create a Journal:

1. Select the Journals tab.
The list of Journals associated with the project opens.

2. Select New Journal - Note.
3. Complete the Journal - Note fields:

◦ Select the Mark as Unread check box to make the Journal appear unread.
◦ Select the Visible in Customer Portal check box if you want the Journal to appear in the

CSM Portal.
◦ Select a Quick Entry from the drop-down list to add pre-defined content to the details field.
◦ Select the priority and enter any details.
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Define a Change Request
Use the Change Request tab to document and provide details for a change for the project.

Note: This functionality is only available after you apply the mApp Solution.

To define a Change Request:

1. Select the Change Request tab.
The list of Change Requests associated with the project opens.

2. Select New Change Request.
3. Complete the Change Request form.

Related concepts
Change Management mApp Solution Change Form
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IT Project Tracking (ITPT) mApp Solution Items
The items tables provides a list of items included when applying the mApp® Solution and the typical
merge action.

Item Category Item
Typical
Merge
Action

Automation
Process
Definition

ITPT Project Approval Process Import

Business
Objects

Cost Item, Cost Item Category, Department, Incident, Task, Work Item Don't
Change

Cost Item - Provisioning Overwrite

Change Request Merge

ITPT Business Case, ITPT Deliverable, ITPT Meeting Minutes, ITPT
Meeting Minutes Category, ITPT Meeting Minutes Status, ITPT Member
Role, ITPT Portfolio, ITPT Project, ITPT Project Customer, ITPT Project
Manager, ITPT Project Team, ITPT Project User, ITPT Risk Issue, ITPT
Status, ITPTLinksCI, Phase Set, Phase Set Object

Import

Dashboard Project Details Import
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Fields

Budget Cost, Category, Cost Item Type ID, Cost Item Type Name, Cost
Type, Created By, Created By ID, Created Culture, Created Date Time,
Details, Frequency, ITPT Project ID, Last Mod Time Stamp, Last
Modified By, Last Modified By ID, Last Modified Date Time, Parent
RecID, RecID, Status, Total Cost

Overwrite

Actual Effort, Actual End Date, Actual Start Date, Alt 1 Command, Alt 1
Command Name, Alt 1 Next Status, Alt 1 Next Status Text, Alt Phase 1
Name, Alt Phase 1 Name_de-DE, Alt Phase 1 Name_en-US, Alt Phase
1 Name_es-ES, Alt Phase 1 Name_fr-FR, Alt Phase 1 Name_pt-BR, Alt
Phase 1 Tooltip, Alt Phase 1 Tooltip_de-DE, Alt Phase 1 Tooltip_en-US,
Alt Phase 1 Tooltip_es-ES, Alt Phase 1 Tooltip_fr-FR, Alt Phase 1
Tooltip_pt-BR, Alt Phase 2 Name, Alt Phase 2 Name_de-DE, Alt Phase
2 Name_en-US, Alt Phase 2 Name_es-ES, Alt Phase 2 Name_fr-FR, Alt
Phase 2 Name_pt-BR, Alt Phase 2 Tooltip, Alt Phase 2 Tooltip_de-DE,
Alt Phase 2 Tooltip_en-US, Alt Phase 2 Tooltip_es-ES, Alt Phase 2
Tooltip_fr-FR, Alt Phase 2 Tooltip_pt-BR, Alt Phase 3 Name, Alt Phase 3
Name_de-DE, Alt Phase 3 Name_en-US, Alt Phase 3 Name_es-ES, Alt
Phase 3 Name_fr-FR, Alt Phase 3 Name_pt-BR, Alt Phase 3 Tooltip, Alt
Phase 3 Tooltip_de-DE, Alt Phase 3 Tooltip_en-US, Alt Phase 3
Tooltip_es-ES, Alt Phase 3 Tooltip_fr-FR, Alt Phase 3 Tooltip_pt-BR, Alt
Phase 4 Name, Alt Phase 4 Name_de-DE, Alt Phase 4 Name_en-US,
Alt Phase 4 Name_es-ES, Alt Phase 4 Name_fr-FR, Alt Phase 4
Name_pt-BR, Alt Phase 4 Tooltip, Alt Phase 4 Tooltip_de-DE, Alt Phase
4 Tooltip_en-US, Alt Phase 4 Tooltip_es-ES, Alt Phase 4 Tooltip_fr-FR,
Alt Phase 4 Tooltip_pt-BR, Alt Phase 5 Name, Alt Phase 5 Name_de-
DE, Alt Phase 5 Name_en-US, Alt Phase 5 Name_es-ES, Alt Phase 5
Name_fr-FR, Alt Phase 5 Name_pt-BR, Alt Phase 5 Tooltip, Alt Phase 5
Tooltip_de-DE, Alt Phase 5 Tooltip_en-US, Alt Phase 5 Tooltip_es-ES,
Alt Phase 5 Tooltip_fr-FR, Alt Phase 5 Tooltip_pt-BR, Alt Phase 6 Name,
Alt Phase 6 Name_de-DE, Alt Phase 6 Name_en-US, Alt Phase 6
Name_es-ES, Alt Phase 6 Name_fr-FR, Alt Phase 6 Name_pt-BR, Alt
Phase 6 Tooltip, Alt Phase 6 Tooltip_de-DE, Alt Phase 6 Tooltip_en-US,
Alt Phase 6 Tooltip_es-ES, Alt Phase 6 Tooltip_fr-FR, Alt Phase 6
Tooltip_pt-BR, Alt Phase 7 Name, Alt Phase 7 Name_de-DE, Alt Phase
7 Name_en-US, Alt Phase 7 Name_es-ES, Alt Phase 7 Name_fr-FR, Alt
Phase 7 Name_pt-BR, Alt Phase 7 Tooltip, Alt Phase 7 Tooltip_de-DE,
Alt Phase 7 Tooltip_en-US, Alt Phase 7 Tooltip_es-ES, Alt Phase 7
Tooltip_fr-FR, Alt Phase 7 Tooltip_pt-BR, Alt Phase 8 Name, Alt Phase 8
Name_de-DE, Alt Phase 8 Name_en-US, Alt Phase 8 Name_es-ES, Alt
Phase 8 Name_fr-FR, Alt Phase 8 Name_pt-BR, Alt Phase 8 Tooltip, Alt
Phase 8 Tooltip_de-DE, Alt Phase 8 Tooltip_en-US, Alt Phase 8
Tooltip_es-ES, Alt Phase 8 Tooltip_fr-FR, Alt Phase 8 Tooltip_pt-BR, Alt
1 Status, Alt 1 Status Text, Alt 2 Command, Alt 2 Command Name, Alt 2
Status, Alt 2 Status, Text Approval Block ID, Approver, Avatar, Ball in
Court, Ball in Court Email, Budget, Budget Health, Business Case ID,
Business Reasons, CapEx Budget, Category, ChildID, ChildType, Cost
Details, Created By, Created By ID, Created Culture, Created Date
Time, Customer Accepted, Customer Display Name, Customer ID,
Customer Type ID, Department, Deliverables Health, Deliverables ID,
Description, Due Date, Effect, Email, End Date, Estimated Effort, First
Name, Impact, Issues, ITPT Member Role ID, ITPT Portfolio ID, ITPT
Project ID, ITPT Project Manager ID, ITPT Project Member ID, ITPT
Project Member User ID, ITPTProjectMemberTypeID,
ITPTProjectMemberTypeName, ITPT Risks Issues ID, ITPT Status ID,
JoinReason, Last Mod Time Stamp, Last Modified By, Last Modified By
ID, Last Modified Date Time, Last Name, LastModTimeStamp, Location,
Meeting Minute ID, Name, Next Status, Next Status Command, Next
Status Command, Name Next Status One-Step, Next Status Text, No
One Step, Notes, Object, Object_de-DE, Object_en-US, Object_es-ES,
Object_fr-FR, Object_pt-BR, OpEx Budget, Owned By, Owned By
Email, Owned By ID, Owned By Team, Owned By Team ID, ParentID,
ParentType, Parent RecID, Phase 1 Name, Phase 1 Name_de-DE,
Phase 1 Name_en-US, Phase 1 Name_es-ES, Phase 1 Name_fr-FR,
Phase 1 Name_pt-BR, Phase 1 Tooltip, Phase 1 Tooltip_de-DE, Phase
1 Tooltip_en-US, Phase 1 Tooltip_es-ES, Phase 1 Tooltip_fr-FR, Phase
1 Tooltip_pt-BR, Phase 2 Name, Phase 2 Name_de-DE, Phase 2
Name_en-US, Phase 2 Name_es-ES, Phase 2 Name_fr-FR, Phase 2
Name_pt-BR, Phase 2 Tooltip, Phase 2 Tooltip_de-DE, Phase 2
Tooltip_en-US, Phase 2 Tooltip_es-ES, Phase 2 Tooltip_fr-FR, Phase 2
Tooltip_pt-BR, Phase 3 Name, Phase 3 Name_de-DE, Phase 3
Name_en-US, Phase 3 Name_es-ES, Phase 3 Name_fr-FR, Phase 3
Name_pt-BR, Phase 3 Tooltip, Phase 3 Tooltip_de-DE, Phase 3
Tooltip_en-US, Phase 3 Tooltip_es-ES, Phase 3 Tooltip_fr-FR, Phase 3
Tooltip_pt-BR, Phase 4 Name, Phase 4 Name_de-DE, Phase 4
Name_en-US, Phase 4 Name_es-ES, Phase 4 Name_fr-FR, Phase 4
Name_pt-BR, Phase 4 Tooltip, Phase 4 Tooltip_de-DE, Phase 4
Tooltip_en-US, Phase 4 Tooltip_es-ES, Phase 4 Tooltip_fr-FR, Phase 4
Tooltip_pt-BR, Phase 5 Name, Phase 5 Name_de-DE, Phase 5
Name_en-US, Phase 5 Name_es-ES, Phase 5 Name_fr-FR, Phase 5
Name_pt-BR, Phase 5 Tooltip, Phase 5 Tooltip_de-DE, Phase 5
Tooltip_en-US, Phase 5 Tooltip_es-ES, Phase 5 Tooltip_fr-FR, Phase 5
Tooltip_pt-BR, Phase 6 Name, Phase 6 Name_de-DE, Phase 6
Name_en-US, Phase 6 Name_es-ES, Phase 6 Name_fr-FR, Phase 6
Name_pt-BR, Phase 6 Tooltip, Phase 6 Tooltip_de-DE, Phase 6
Tooltip_en-US, Phase 6 Tooltip_es-ES, Phase 6 Tooltip_fr-FR, Phase 6
Tooltip_pt-BR, Phase 7 Name, Phase 7 Name_de-DE, Phase 7
Name_en-US, Phase 7 Name_es-ES, Phase 7 Name_fr-FR, Phase 7
Name_pt-BR, Phase 7 Tooltip, Phase 7 Tooltip_de-DE, Phase 7
Tooltip_en-US, Phase 7 Tooltip_es-ES, Phase 7 Tooltip_fr-FR, Phase 7
Tooltip_pt-BR, Phase 8 Name, Phase 8 Name_de-DE, Phase 8
Name_en-US, Phase 8 Name_es-ES, Phase 8 Name_fr-FR, Phase 8
Name_pt-BR, Phase 8 Tooltip, Phase 8 Tooltip_de-DE, Phase 8
Tooltip_en-US, Phase 8 Tooltip_es-ES, Phase 8 Tooltip_fr-FR, Phase 8
Tooltip_pt-BR, Phone Number, Planned End Date, Planned Start Date,
Portfolio ID, Portfolio Manager, Priority, Project Approval, Project Health
Update, Project Manager, Project Notification Email, RecID,
Requirements, Resource Details, Risk Health, Role, Schedule Health,
Selected Status, Start Date, Status, Status Order, temp_status_set,
Title, Type, Type_de-DE, Type_en-US, Type_es-ES, Type_fr-FR,
Type_pt-BR

Import
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Forms

CostItemProvisioning Overwrite

CostItemCategory, Departments Don't
Change

ITPTBusinesCase, ITPTDeliverables, ITPTMeetingMinutes,
ITPTMeetingMinutesCategory, ITPTMeetingMinutesStatus,
ITPTMemberRole, ITPTPortfolio, ITPTPortfolio Summary, ITPTProject,
ITPTProject Overview, ITPTProject Summary,
ITPTProjectMemberCustomer 1, ITPTProjectManager,
ITPTProjectManager Summary, ITPTProjectMemberUser,
ITPTRisksIssues, ITPTStatus, PhaseSet, PhaseSetObject

Import

Form
Arrangement ITPTProject Import

Grids

CostItemProvisioning Overwrite

CostItemCategory, Departments Don't
Change

ITPTBusinesCase, ITPTDeliverables, ITPTMeetingMinutes,
ITPTMeetingMinutesCategory, ITPTMeetingMinutesStatus,
ITPTMemberRole, ITPTPortfolio, ITPTProject,
ITPTProjectMemberCustomer 1, ITPTProjectManager,
ITPTProjectMember, ITPTProjectMemberUser, ITPTRisksIssues,
ITPTStatus, PhaseSet, PhaseSetObject

Import
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Indexes

PK_CostItem Overwrite

Department_DepartmentName, PK_Departments Don't
Change

ITPTBusinesCase_
BusinesCaseID, 
PK_ITPTBusinesCase, 
ITPTDeliverables_DeliverablesID, 
PK_ITPTDeliverables,
ITPTMeetingMinutes_
MeetingMinuteID, 
PK_ITPTMeetingMinutes,
ITPTMeetingMinutesCategory_
Category, 
PK_ITPTMeetingMinutesCategory,
ITPTMeetingMinutesStatus_Status, 
PK_ITPTMeetingMinutesStatus,
ITPTMemberRole_MemberRoleID, 
PK_ITPTMemberRole, 
ITPTPortfolio_PortfolioID,
PK_ITPTPortfolio, 
ITPTProject_ITPTProjectID, 
PK_ITPTProject, PK_RecID,
ITPTRisksIssues_RisksIssuesID, 
PK_ITPTRisksIssues, 
ITPTStatus_StatusID,
PK_ITPTStatus, ITPTLinksCI_RecID, 
PK_ITPTLinksCI, ObjectType, 
PK_PhaseSet, PK_PhaseSetObject

Import

Mergeable
Areas ITPT Project Actions, ITPT Project Approvals Overwrite

One-Step™
Actions

Close and Clear Dependencies Overwrite

Dial Customer Phone Don't
Change

Alt Step 1 from Relationship, Alt Step 2 from Relationship, Approve
Closing, Assign a Task from a Meeting Minute, Assign to a Project
Manager, Assign to ANY Individual, Assign to PM, Assign to Team,
Await ApprovalCreate, Change, E-mail Customer, Execute Project,
Impacted CI's Button Actions, Next Step from Relationship, Notify Task
Owners to Update Tasks, Project Approved, Reopen Project, Request
Approval, Request Project Task Updates, Request Project Updates,
Resume Work, Select a Project Manager (Deprecated), Send a new
Meeting Minute notification E-Mail, Send Project Health Update, Take
Ownership

Import

592

CSM mApp Solutions

CSM mApp Solutions



Relationships

Change Links to Project (ITPT), Business Case Owned By Project,
Deliverables Owned By Project, Meeting Minutes Owned by Project,
Project Links Change, Project Links Configuration Items, Project Links
Customer, Project Links Phase Set, Project Links to Portfolio, Project
Links to Status, Project Links to UserInfo, Project Owns Approvals,
Project Owns Business Case, Project Owns Cost Items, Project Owns
Deliverables, Project Owns Group Project Member, Project owns ITPT
Customer, Project owns ITPT Project Users, Project Owns Journals -
Note, Project Owns Meeting Minutes, Project Owns Project Manager,
Project Owns Risks / Issues, Project Owns Tasks, Risks / Issues Owned
By Project, Task Owned By Project

Import

Search My Open Projects Import

Stored
Expressions

Max Phases Overwrite

System State E-mail Don't
Change

# High Impact Open Risks/Issues, # of Not Accepted Deliverables, # of
Open Issues, # of Open Tasks, # of Project Approvers, # of Project
Notification Email Recipients, Actual Start Date, All Open Projects,
Approval Phase, Budget Health, Budget Remaining, CapEx Budget
Closing Phase Deliverable(s) Health, Deliverables Text for Approve
Closing, Display # of Open Issues, Execute Phase, High Impact Open
Risks/Issues Trigger, Initiation Phase, IT Project Total Budget, IT Project
Total Cost, No Actual Effort Entered for Approve Closing, No Actual
Effort Entered Text, No Actual End Date Entered for Approve Closing,
No Actual End Date Entered Text, Not Accepted Deliverable Text, Not
Accepted Deliverables Text > 1, Open Issue Text, Open Issue(s) Text for
Approve Closing, Open Issues Text > 1, Open Task(s) Text for Approve
Closing, Open Tasks Text Open Tasks Text > 1, OpEx Budget, Project
Actual Start Date, Project Check for Closing, Project Health Journal
Update, Project Health Update Time Stamp, Project ID, Project Manager
Validation, Project Name, Project Planned End Date, Project Status,
Risk Health, Schedule Health, Total Budget, Total Cost, Total Customer
Accepted Deliverables, Total Deliverables

Import

Themes Default Dark, Professional Grey Don't
Change

Visualization Configuration Items Don't
Change

Widgets
CD-Budget Health, CD-Deliverables Health, CD-My Active Projects, CD-
My Assigned Projects, CD-My Open Projects, CD-My Projects Awaiting
Approval, CD-Risk Health, CD-Schedule Health, Open Projects

Overwrite
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• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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Managed Service Provider mApp Solution 1.0
Cherwell Managed Service Provider (MSP) mApp® Solution provides a solution for an MSP organization
to extend the service management and business processes supported within the CSM platform to multiple
contracted companies.

A Managed Service Provider (MSP) is a third-party company that delivers services (example: Application,
infrastructure, and security) through ongoing, regular support and active administration on customers’
premises, in their MSP’s data center (hosting), or on a third-party data center.

The MSP mApp Solution enables people from multiple companies to be included as self-service
customers, organized within their companies, and receive services based on the service contracts with
the MSP.

Platform version requirements: Tested on CSM 9.7.0 — 10.2.0.

Content version requirements: Tested on CSM 9.7.0 — 10.2.0; this mApp Solution may or may not be
compatible on content versions earlier than 9.7.x, but as with all mApp Solutions, be sure to test it on your
customized system.

Prerequisites: None.

Apply the mApp Solution
Follow these steps to download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Good to Know

• In certain areas, functionality is not guaranteed unless you use the CSM Desktop Client.

• In OOTB content versions 10.0.x, 10.1.x, and 10.2.0, the Related Item Navigation feature is enabled
for the Incident and Problem Business Objects. If your MSP mApp Solution was created on a
content version earlier than 10.0.0, and it overwrites or merges with Incident or Problem, review the
Related Item Navigation within these Business Objects before you publish the mApp Solution
Blueprint. Verify that you need all items within the Related Item Navigation and remove any tabs that
are not for reference purposes. Thoroughly test functionality, especially in the CSM Browser Client.
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Revision History

mApp Version
Platform
Version
Requirements

Content
Version
Requirements

Prerequisites

1.0 Tested on 9.7.0
— 10.2.0.

Tested on 9.7.0
— 10.2.0; this
mApp Solution
may or may not
be compatible
on content
versions earlier
than 9.7.x, but
as with all mApp
Solutions, be
sure to test it on
your customized
system.

None.
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MSP Deployment and Configuration Options
A Managed Service Provider can configure Cherwell® Service Management for simple access
deployment or by using segregated tenants. The choices depend on the level of access and
customization required by the tenants weighed against the cost of configuring and maintaining the
system.

Simple Access Deployment
Tenants who do not require technician access can be hosted in a single instance of Cherwell Service
Management. A simple access deployment is the simplest to configure and allows the MSP to rapidly add
more tenants with very little overhead. If desired, individual CSM Portal sites can be configured to give
tenants a branded view to make their experience feel customized.

Configuring this deployment requires adding a common field to all Business Objects (example:
CompanyID) and auto-populating that field from the tenant entering a ticket. MSP technicians can set up
dashboards and queries to filter on specific tenants or view tickets across all tenants.

Simple access deployment has the following advantages:

• Simple security configuration. The simpler the security configuration, the less likely mistakes will
occur. In this model, all tenants to use the same Security Group although this is not required.

• Single CSM database. This requires less overhead for maintenance and backups.

• Management of a single content set. In this model, Business Objects are shared across all tenants,
meaning there is less work to maintain, enhance, and test the content.

This deployment option has the following disadvantages:

• Portal-only access for tenants. Access to the Technician clients isn’t possible, because that would
expose the data from all tenants in this model.

• Similar tenant experience. Since this is a single content set, the experience across tenants will be
almost identical. Some customization can be achieved through individual Portals and Themes.

• Single configured SSO provider. The use of multiple SSO providers can be achieved through a
Federated provider.
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Segregated Tenants
Tenants requiring the highest level of security and data segregation need the MSP to deploy a separate
CSM instance for each tenant. Implementation of this deployment requires an integration from each
tenant instance into the primary MSP instance for management of tickets between the systems. This can
be achieved using one of the following options:

• Linked Objects, if the content between instances is similar

• Cherwell® REST API calls

• Jitterbit, if advanced integration logic is necessary

Configuring segregated tenants has the following advantages:

• Tenant experience can be completely customized. Since each tenant will reside in their own
database, the content can be customized as much or as little as needed.

• Technician and Portal access. Tenants can access the Desktop Client and Browser Client in addition
to the CSM Portal.

• Administrator access. In this model, customers can be provided access to CSM Administrator to
manage their own users, security, and potentially even their own content.

• No potential for data exposure. Nothing from one tenant can be exposed to another.

• Per-tenant SSO provider.

This configuration has the following disadvantages:

• Multiple content sets. Must manage multiple content sets that could diverge over time, making
changes and testing more difficult. This also might require setting up integrations to a common MSP
system to manage tickets flowing between a tenant and the MSP.

• Multiple CSM databases. Each tenant is required to have its own database for segregation,
requiring more overhead and maintenance.

• Increased hardware costs. Each tenant would require its own instance of the CSM Web Applications
and services.
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MSP mApp Solution Workflows
The Managed Service Provider mApp® Solution uses the same forms as CSM. However, the workflows
are sometimes different.

MSP Incident Workflow
The following figure describes a high-level Incident workflow for the MSP mApp Solution.

1
The Classification is limited to only the Services assigned to the Customer - External's Company of
record.

2 The Assigned Team is automatically populated from the Customer External's Company of record.

3 The SLA is automatically populated based on the Customer - External record.

MSP Company Workflow
The following figure describes a high-level Company workflow for the MSP mApp Solution.

599

CSM mApp Solutions

CSM mApp Solutions



1 The required fields are Company name, Company ID, and Primary Contact Name.

2 This includes the Default Support Team and an Account Manager on that team.

3

Add, upload, or link the following details:

• Company CIs

• Company site and building locations

• Services

• Support users

• Assigned SLAs

MSP Customer - External Workflow
The Customer - External form was created to assist with MSP work and to establish separation between
the internal customers and external customers. The following figure describes a high-level Customer -
External workflow for the MSP mApp Solution.
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1

Customer fields include First Name and Last Name fields, which are required, and the following
fields that are not required:

• Title

• Primary Phone

• Email

2

Organization fields include Company. The Site and Building fields are automatically filtered according
to the Company selected.

Note: SLA Subscription is automatically populated based on the Company selected.

MSP Configuration Item Workflow
The following figure describes a high-level Configuration Item (CI) workflow for the MSP mApp Solution.
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1

Choose a CI Owner. This can be any of the following options:

• Employee owned

• Company owned

• MSP owned

2 Assign the Configuration Item to a Company.
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Company Form
The Managed Service Provider mApp® Solution introduces a Company Business Object that is used to
manage records for Individual Companies, Parent Companies, and Child Companies.

Use the Company form to record and manage information about a company. The following sections make
up the Company form:

1. Default form: Displays important at-a-glance information, such as Company name, Company status,
primary contact, support team, and account manager.

2. Pages tabs: Dynamically displays a tabbed collection of related forms and records.

3. Form area: Displays the main form fields.

4. Actions list: Dynamically displays a list of actions that are available for the Company.

The following table describes the fields and other elements that make up the Company form:

Field Description

Default Form Displays important at-a-glance information, such as Company name, Company
status, primary contact, support team, and account manager.
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Field Description

Company Name Populated from the Company Name field on the Overview form.

Company Status

Statuses include:

• New

• Active

• At risk

• Inactive

Primary Contact Populated from the Primary Contact Name field and Primary Contact Email field

Support Populated from the Default Support Team drop-down list

Account Manager The internal Customer responsible for managing the Company's account within
MSP. Populated from the Account Manager related item picker.

Pages Tabs Dynamically displays a tabbed collection of related forms and records.

Overview Form entry view to enter company basics and use Action Menu.

Journals Journal details and tracking.

Tasks Company-specific tasks.

Related CIs Any configuration items that are assigned to this company.

Site Locations specified to this company.

MSP Services The Service Catalog areas that the MSP has contracted with this company to
support.

MSP Support The technicians (users) that are assigned to support this company from the
Service Desk

Assigned SLAs The SLAs associated with this company that the MSP has agreed to.

Form Area Displays the main form fields.

Company Name Name of the Company.

Company ID ID of the Company. Used in filtering several areas, such as MSP Services.

Primary Contact Name
Name of the primary contact at the Company. The related item picker will use the
Customer - External record to complete the information fields for the primary
contact.

Primary Contact Phone Populated from the related item picker for the Company's Primary Contact.

Primary Contact Email Populated from the related item picker for the Company's Primary Contact.

Default SLA Subscription Drop-down list is populated from the options available on the Assigned SLAs
tab.

Company Phone Company phone number.

Company Website Company website.
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Field Description

Company Site
Company's location based on the Site Business Object related item picker.
Address, City, State/Provence, and Postal Code are populated from the Site
record.

Default Support Team This team acts as the 'triage' for all incoming tickets from this Company. Tickets
are auto-routed to this team from the CSM Portal submissions.

Account Manager
The Customer-Internal person who is responsible for managing this Company's
account with the MSP organization (example, who handles their contract,
customer success, and so on.)

Action List Dynamically displays a list of actions that are available for the Company.

Assign to Me Assigns the company Account Manager as the current User.

Create New Contact Creates a new Customer - External record.

Remove a Service Allows the user to individually remove assigned Service Catalog items.

Remove All Services Allows the user to remove all assigned Service Catalog items.

Convert to Parent
Company

Changes the current record to a Parent company and adds a new tab to the
pages for Children Companies.

Link to Parent Company Changes the current record to a Child company and adds a new tab to the pages
for Parent Company.

Flag as At Risk Changes the current company record to the Status of At Risk and allows for entry
of an At Risk Reason.
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Customer - External Form
The MSP mApp® Solution introduces the Customer - External form to store pertinent information about
Customers at companies that are served by an MSP.

Use the Customer - External form to record information about an external customer. The Customer -
External form includes the following areas:

1. Default form: Displays important at-a-glance information, such as customer name, employee status,
Company associated with the customer, and customer contact information.

2. Pages tabs: Dynamically displays a tabbed collection of related forms and records.

3. Form area: Displays the main form fields.

4. Actions list: Dynamically displays a list of actions that are available for the external Customer.

The following table describes the fields and other elements that make up the Customer - External form:
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Field Description

Default Form
Displays important at-a-glance information, such as Customer name, Employee
status, the Company associated with the customer, and customer contact
information.

Employee Displays employee name.

Status

Statuses include:

• New

• Active

• Terminated

Company Company associated with the Customer – External record. Populated from the
Company Name related item picker.

Contact Customer information. Populated from the Primary Phone and E-mail fields.

Pages Tabs Dynamically displays a tabbed collection of related forms and records.

Overview Contact input form.

Journals Records Journal information.

Incidents Any Incidents associated with the external customer.

Assets Any CIs that have the current external customer as the Primary User.

Company Summary form of the Company to which the external customer record is linked.
This comes from the Company Name field on the Overview page.

Customer SLA The Summary form for the SLA that the Customer - External record. This comes
from the SLA Subscription field on the Overview page.

Form Area Displays the main form fields.

First Name Customer's first name.

Middle Customer's middle initial.

Last Name Customer's last name.

Title Customer's title (example: Owner, Technician).

Approver Determines whether this person is allowed to approve service requests that need
approval.

Company Manager Determines whether this person is allowed to see all tickets logged across the
Company through the Company Management Dashboard in the Portal.

Primary Phone and Type Main phone for the customer and a drop-down menu to indicate what type of
phone it is.

Secondary Phone and
Type

Alternate phone for the customer and a drop-down menu to indicate what type of
phone it is.

E-mail Customer's email address.

Secondary E-mail Customer's alternate email address.
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Field Description

Company Name The Company record for the Company that employs this customer.

SLA Subscription Customer's SLA. This is initially populated based on the associated Company
record's default SLA Subscription. This can be changed at the individual level.

Notes Text box for notes about the Customer.

Site Name

Sites in this related item picker are restricted to those that are linked to the
Company record.

Note: Address, City, State/Provence, and Postal Code fields are
populated based on the Site and Building records.

Building Buildings are restricted based on the Site chosen.

Location ID Can be a specific workstation, office number, and so on.

Actions List Dynamically displays a list of actions that are available for the external Customer.

Create an Incident Creates an incident record with the current Customer - External record set as the
Customer.
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Configuring the MSP mApp Solution
Configure the CSM Managed Service Provider (MSP) mApp® Solution for better performance.

Use CSM Administrator and CSM Desktop Client/CSM Browser Client for the configurations.

• Add Service Catalog Items to a Company

• Add Service Level Agreements to a Company

• Add Support Technicians to a Company

• Configure the Security Groups and Roles for a Company
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Add Service Catalog Items
Use the Company form to add Service Catalog items.

The Managed Service Provider (MSP) mApp® Solution allows technicians to log Incidents and Service
Requests for External Customers. After the Service Catalog items are added to the Company, technicians
using the Service Classification related item picker will have access to only the options for that External
Customer.

To add Service Catalog items:

1. Select the MSP Services page.
2. Select the Link records button in the toolbar.

The Incident SubCategory Selector window opens to show the MSP’s entire Service Catalog
availability.

3. Highlight the Service Catalog items to be linked to the Company record.
4. Select OK.

The Service Catalog items are linked to the Company record.
5. Save the Company record.
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Add Service Level Agreements
Use the Company form to add Service Level Agreements (SLAs).

The MSP organization will agree to certain SLAs with each Company with which they have a contract.
Each Company can be assigned multiple SLAs. On the Overview page, you will assign a Default SLA as
the starting point for each Company.

The Default SLA assigned at the Company level has several purposes:

• It is the starting point for all Incidents/Service Requests associated with this Company.

• When set at a Parent Company record, it auto-populates as the Default SLA on all Child Company
records created.

Note: The Default SLA can be changed at each Child Company record, but it auto-populates
as the Default as a starting point.

• The Default SLA set at the Company record also auto-populates as the Default SLA on all Customer
- External records linked to the Company.

Note: The Default SLA can be changed at each Customer - External record, but it auto-
populates as the Default as a starting point.

To add an SLA to the Company and set the default SLA:

Assign an SLA to the Company

1. Select the Assigned SLAs page.
2. Either select New SLA to create a new SLA, or select the Link record button to link an existing

SLA.
If you select Link, the SLA Selector window opens.

3. Choose the SLAs to link to the Company record.
4. Select OK.

The Service Catalog items are linked to the Company record.
5. Save the Company record.

Select a default SLA

6. Select the Overview page.
7. Under Details, select an SLA from the Default SLA Subscription drop-down menu.
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Add Support Technicians
Use the Company form to add Support Technicians to a Company's support team.

The MSP organization will assign a limited number of Support Technicians to each Company. This
practice ensures security across records and does not allow Support Technicians to view or work on
tickets for Companies they are not allowed to support.

To add Support Technicians to a Company's support team:

1. Select the MSP Support page.
2. Select the Link records button in the toolbar.

The User Info Selector window opens to show the MSP’s entire list of Users.
3. Select the individuals to add to the Company's support team.
4. Select OK.

The Users are linked to the Company record.
5. Save the Company record.
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Configure MSP Security Groups and Roles
The Managed Service Provider (MSP) mApp® Solution introduces Security Groups to control permissions
for Service Desks.

The following Security Groups are now included with the MSP mApp Solution:

• Company Service Desk 1

• Company Service Desk Manager

Action Company Service Desk 1 Company Service Desk Manager

Log and work on Incidents and
Service Requests

ONLY companies they have been
assigned to support

ONLY companies they have been
assigned to support

Search for Incidents and Service
Requests

Return results linked to the
Companies that user supports

Return results linked to the
Companies that user supports

Search for Company records Return only results for Companies
that the user has been linked to

Return only the results for
Companies that the user has been
linked to

Available Company record actions View only (Cannot Add, Edit, or
Delete) View, Add, and Edit (Cannot Delete)

Search for Customer – External
records

Return results linked to only the
Companies that user supports

Return results linked to only the
Companies that user supports

Available Customer – External
record actions

View, Add, and Edit (Cannot
Delete) View, Add, and Edit (Cannot Delete)

There are certain roles associated with each of the new Security Groups. The following roles are
associated with the Company Service Desk 1 Security Group:

• Company Service Desk 1

• IT Service Desk Manager

The following roles are associated with the Company Service Desk Manager Security Group:

• Company Service Desk Manager

• IT Service Desk Manager
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Create a Security Group
If an existing Security Group has similar permissions to what is required for a new Security Group, create
the new Security Group by duplicating the existing group and editing its configuration.

The Managed Service Provider (MSP) includes two Security Groups for administering services. There are
situations where additional Security Groups can be beneficial. There may be a person on site at a
Company who needs the ability to resolve open Incidents but does not need all the permissions granted
to the Company Service Desk 1. For situations like this, CSM allows you to create a new Security Group
by copying an existing Security Group, naming the new Group, and configuring the Group's permissions.

To create a Security Group:

1. Select Edit security groups on the Security page of CSM Administrator.
The Security Groups dialog box opens.

2. Select the existing Security Group from the Group drop-down list that is close to the one you are
creating.

3. Select File > Copy Security Group.
4. Enter a name for the new Security Group.

The new Security Group appears as an exact copy of the original Security Group.
5. Edit the Security Group settings for the new Security Group.
6. Select Save.
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Using the MSP mApp Solution
Use the Cherwell Managed Service Provider (MSP) mApp® Solution to manage tickets for external
customers.
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Work with a Ticket in the MSP mApp Solution
The Managed Service Provider (MSP) mApp® Solution allows technicians to manage tickets for their
assigned Companies.

The following procedures describe how a technician would open an Incident and describe the Incident.

To open an Incident and add a description:

1. Select the Customer related item picker.
2. Under Customer type to show, select Customer - External from the drop-down menu.

The search is narrowed to only external customers.
3. Select the Customer - External record for the person calling.
4. Select OK.

When the Customer - External record is selected, the following actions are taken:
◦ The Assigned Team field is auto-populated with the Default Support Team assigned at the

Company record.
◦ The SLA tied to that Customer - External record or Company record sets the starting point for

the Respond/Resolve times.
5. Select the Service Classification related item picker to open the Incident Subcategory Selector

window.
Only the Subcategory items that have been linked to the Company record with which this external
customer is associated show in the options.

6. Choose the Subcategory.
7. Select OK.
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Add Watchers to Incidents and Service Requests
A new link has been added above the Actions list to add yourself (the current logged-in User) as a
Watcher on the current Incident/Service Request record. A Watcher receives all communications
regarding the Incident/Service Request record that an external customer receives. This allows the
Watcher to monitor the situation in case the Incident/Service Request record needs to be escalated. On
the Overview page, the number of Watchers is reflected above the Actions list.

If there are several Internal Customers who want to keep watch on a particular Incident/Service Request,
they can all be linked or unlinked from the Technician Watch List page. Likewise, if a Company Manager
notices from the Company Management dashboard in the CSM Portal that an Incident has breached its
SLA, they can add a comment on the Incident that they want to be added as a watcher to the ticket.

All changes to Technician and Customer Watch Lists are recorded in the Activity Pane along with copies
of all external communications that have been sent to the external customer and Watchers.
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Release Management mApp Solution 1.0.1
The Release Management mApp® Solution provides functionality that allows you to use Release features
such as a default form, Automation Processes, One-Step Actions, Expressions, Saved Searches,
Widgets, and a Dashboard.

Platform Version Requirements: Tested on CSM 6.0.0 - 9.6.x.

Out-of-the-Box Content Version Requirements: Tested on CSM 6.0.0 - 9.6.0. Warnings and workflow
issues may occur with CSM 9.6.0 content.

Prerequisites: None

Overview
CSM Release Management is the process that ensures that builds are created, tested, and deployed
without affecting the stability of existing Services. CSM integrates with Release Management so that you
can incorporate the CSM Release Business Process into your system.
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How the mApp Solution Works
CSM provides Release as a mApp Solution so that Users can easily unify all aspects of the Release
process with their existing CSM system. Download the mApp Solution from the Cherwell mApp Exchange.
Use the Apply mApp Solution wizard to apply the mApp Solution to your CSM system. The Apply mApp
wizard generates a Blueprint, which can then be viewed and published to a test or Live system to commit
the changes.

After the mApp Solution is applied, Users can use Release in the same way as other CSM processes.
Access the Release Form by clicking File>New>New Release in the CSM Desktop Client, or configure
the Release Business Object by clicking Create New Blueprint>Release>Edit Business Object in CSM
Administrator.

The mApp Solution includes the following items:
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Item Category Item Typical Merge Action

Business Object Change Request, Configuration
Item, Service Schedule Merge

Business Object

Release, Release Build Disposition,
Release Disposition, Release
Embedded Form, Release Package
Build, Release Priority, Release
Role, Release Status, Release
Team, Release Team Member Type,
Release Test, ReleaseLinksCI

Import

Business Object
ChangeRequestLinksCI, Customer,
Customer - Internal, Incident, ITPT
Project, Phase Set, Service, Task

Don't Change

Automation Process

Notify Release Owner of
Assignment, Notify Release Team of
Build Test Results, Notify Release
Team of New Build, Notify Release
Team of Ownership

Import

Calendar IT Calendar Don't Change

Counter Release# Import

Custom View Portal Default View of Customer -
Internal Don't Change

Dashboard Release Summary Import

Metric Value Numerous Import

One-Step Action Numerous Import

Stored Expression Numerous Varies

Stored Query Numerous Import

Theme Professional Grey Don't Change

Widget Numerous Varies
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Item Category Item Typical Merge Action

• Import: Add new item.

• Overwrite: Replace target
item.

• Merge: Merge differences.

• Don't Change: Referenced
by the mApp Solution, but not
altered in any way. The
mApp Solution includes the
definition for informational
purposes only (the definition
is not imported into the target
system).

Related Reading

• About mApp Solutions

Apply mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

How to Use the mApp Solution
When working with the Release Management mApp Solution, Users can:

• Create a Release
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Using the Release Management mApp Solution
When working with the Release Management mApp Solution, Users can:
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Create a Release
The following procedure walks you through the typical steps to create a Release, including tips, optional
steps, and behind-the-scenes information. The different contributors are noted in the procedure.

To create a Release:

1. On the CSM Desktop Client toolbar, click New>New Release.

Note: Since a Release can be the implementation of one or more Change Requests, a
Release can also be created from a Change Request by clicking File>New>New Release
from the CSM menu bar or by clicking the Create New Release link in the Change Request
Actions section of the Task Pane. When submitted from a Change Request, the Release
inherits details from it's Parent Business Object.

A new Release Record is created with a unique ID and a status of New. The Release enters the
Plan phase.

2. The creator records the initial details.
a. Requestor (in the Quick Info Tile): Provide the name of the person who initiated the Release

(example: Gina), and then press ENTER or TAB to search for the User Record.
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If an exact match is found, the Requestor fields are autopopulated with the User's name,
avatar, e-mail, and phone. If multiple matches are found (ex: multiple Users named Gina), the
UserInfo Selector opens so that you can select the appropriate User.

Tip: Wildcards (example: "%" or "*") can be used when searching. To browse for a User or add
a new Customer Record, click the User Selector button  to launch the Contact Manager. To

view the selected Requestor's detailed User Record, click the Quick View button .

b. Title: Provide a title (example: Upgrade to SQL Server 2014).

c. Priority: Select a priority for the Release (example: Urgent).
i. Click the Priority drop-down to reveal the Priority Matrix, and then click a priority

number (example: Urgent for a mission-critical, department-wide Release).

The priority is displayed in the Priority alert bar of the Quick Info Tile. The color (red/orange/
green) indicates the level of priority.

d. Risk: In the drop-down, select a risk (example: High).

After you select a risk level, Risk Analysis notification text appears above the Release Details
banner of the Release Form.

e. Category: Select a category from the drop-down (example: Major).
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f. Type: Select a type of deployment:
◦ Delta: Deploy an update for an existing software package.

◦ Full: Deploy a complete software package.

◦ Package: Deploy a set of full and delta Releases together.

g. Version: Provide the version number of the Release (example: 5.0).

h. Primary CI: Select an affected CI:
i. Click the CI Selector button  to launch the CMDB window to select a CI or create a

new CI.

ii. Impact Analysis: Click this button to view a Configuration Map of CIs that are affected by
the Release.

i. Planned Start: Click the Date Selector button to access the Calendar, and then select the day
in which you plan to begin the Release process.

j. Planned End: Click the Date Selector button to access the Calendar, and then select the day
in which you plan to deploy the Release.

k. Release Calendar: Click this button to open the Change/Release Calendar.

l. Due Date: Click the Date Selector button to access the Calendar, and then select the day in
which the Release is due.

m. Description: Provide a description of the Release.

n. Scope: Provide a scope for the Release (example: Affects all Enterprise Apps that use the
SQL Server Database).

o. Justification for Release and any associated risks: Provide a justification and any risks that
may occur during the Release process (example: Development requires access to new SQL
features).

3. Assign an Owner:
a. Click one of the Ownership Links in the Quick Info Tile (Owned By/Release Manager section).

Ownership is required:
◦ Take Ownership: Click this link to make yourself the User owner.

◦ Assign to: Click this link to select a User owner (Release Manager). The Team owner is
populated by the User owner's default Team.

◦ Select Owner (User): Click this link to first select a Team and then a User owner
(Release Manager) (User is limited by Team).

◦ Select Team: Click this link to first select a Team owner.
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CSM automatically sends an e-mail to the owners to notify them of Ownership.

4. Owner builds the Release Package.
a. Click the Define Package button on the Release Details form.

The Release Units form opens and the Release status changes to Planning.

b. Select Release Package Units check boxes to select desired components of the package.

c. Owner adds additional affected CIs (example: SQL Server License):
i. Click the Release CIs tab in the Form Arrangement to open the CI Grid.
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ii. Click the Add a Configuration Item button  to launch the CMDB window, where you
can select a CI or create a new CI.

The selected CI record appears in the Configuration Items tab.

iii. View Impacted CIs: Click the Visualization button  to view affected CIs.

iv. Hyperlinks to Build Documentation: Insert a hyperlink to the documentation associated
with the build, if applicable (ex: http://msdn.microsoft.com/en-us/library/dn237258(v=sql.
120).aspx).

d. Owner adds the Release to the Service Schedule.
i. Click the Schedule Service button on the Release Units form.

The Service Schedule form opens in the Main Pane.

ii. Service: In the drop-down, select the affected Service (example: Enterprise Apps).

iii. Start Date: Click the Date Selector button to access the Calendar, and then select the
first day in which the Service will be affected.

iv. End Date: Click the Date Selector button to access the Calendar, and then select the
last day in which the Service will be affected.

v. Type: Select the type of disruption the Release will have on the Service.

vi. Notes: Provide any additional information about the Service Schedule.

e. Owner defines a Release Plan.
i. Click the Create Release Plans button on the Service Schedule form.

The Release Plans form opens in the Main Pane.
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Notes: View additional form information and helpful tips by clicking the INFO button
located on the title banner of the form. All fields on the Release Plans form are required.

ii. Deployment Plan: Provide the deployment plan such as timelines or Tasks.

iii. Backout Plan: Provide backout plan details in case the deployment is unsuccessful.

f. Owner defines a Release Team.
i. Click the Assign Release Team button on the Release Plans form.

The Release Team form opens in the Main Pane and the Release Team tab appears in
the Arrangement.
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Note: View additional form information and helpful tips by clicking the INFO button
located on the title banner of the form.

ii. Click the New Release Team button in the Release Team tab of the Arrangement.

The Release Team Member form opens.
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iii. Send Notification E-mails: Select this check box to indicate that the User should receive
Release updates via e-mail.

Note: Notification e-mails are used for Release updates. Updates are sent using links in
the I Want To section of the Quick Info Tile. Click the E-mail Release Team link to define
and send an e-mail to Release Team members, and click the Notify Task Owners to
Update Tasks link to send a notification e-mail to Task owners.

iv. Name: Provide the name of a User (example: Henri), and then press ENTER or TAB to
search for the User Record.

If multiple matches are found (example: multiple Users named Henri), the Contact
Manager opens so that you can select the appropriate User.

Tips: Wildcards (example: "%" or "*") can be used when searching. To browse for a
User, click the User Selector button  to launch the Contact Manager. To view the

selected User's detailed Record, click the Quick View button .

Note: After a User is selected, the e-mail address and phone number fields are
autopopulated using information from the User's UserInfo Record.

v. Role: In the drop-down, select the role of the User.
◦ Deployment Manager

◦ Documentation Manager

◦ Knowledge Manager

◦ Stakeholder

◦ Testing Manager

◦ Training Manager

vi. E-mail: Provide the e-mail address of the User.

Note: This field is auto-populated using the e-mail address in the User's Record.
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vii. Phone Number: Provide the phone number of the User.

Note: This field is auto-populated using the phone number in the User's Record.

viii. Notes: Provide any additional information about the User.

g. Owner assigns Tasks to Release Team members.

Note: Use the Task Object to monitor the status of key elements of the deployment process.
You can either assign all of the Tasks in your plans, or assign key Tasks as milestones to verify
that all upstream or downstream Tasks have been completed.

i. Click the Assign Tasks button on the Release Team form.

The Assign Tasks/Set Milestones form opens in the Main Pane and the Tasks/Milestones
tab opens in the Arrangement.

ii. Click the New Task button in the Tasks/Milestones tab of the Arrangement.

The Task form opens in the Arrangement.
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iii. Complete a Task form for each Task.

The priority is displayed in the Priority alert bar of the Quick Info Tile. The color (red/
orange) indicates whether or not there are open Tasks. If there are no open Tasks, the
alert bar is green. If there are one to five open Tasks, the alert bar is orange. If there are
more than five open Tasks, the alert bar is red.

5. Owner defines the Release Package build.

Note: You must define at least one Release Package build before entering the Test phase.

a. Click the Build Package(s) button on the Assign Tasks/Set Milestones form.

The Build Package(s) form opens in the Main Pane, the Release status changes to Building,
the Build Package tab appears in the Arrangement, and the Release enters the Build phase.
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Note:View additional form information and helpful tips by clicking the INFO button located on
the title banner of the form.

CSM automatically sends an e-mail to Release Team members to notify them of the new
Release Package build.

b. Click the New Release Package Build button in the Build Package tab of the Arrangement.

The Build Release Package form opens in the Arrangement.
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c. Short Description: Provide a brief description of the build (example: SQL Server 2014).

d. Build Version (must be unique): Provide the version of the build (example: 20140512-01).

e. Build Location: Provide the location of the build (example: D:\Installers\SQLServer\SQL2014-
x64.exe).

f. Destination: Provide the location where the build will be stored (example: \\appServer
\Program Files\SQL Server).

6. Testing Manager tests the deployment of the build.
a. Click the Create/Run Test Plans button on the Build Package(s) form.

The Test Script(s) form opens in the Main Pane, the Release Test tab appears in the
Arrangement, the Release status changes to Testing, and the Release enters the Test phase.
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Note: View additional form information and helpful tips by clicking the INFO button located on
the title banner of the form.

b. Click the New Release Test button in the Release Test tab of the Arrangement.

The Release Test form opens in the Arrangement.
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c. Test Title: Provide a title for the test (example: SQL Test).

d. Build Version: In the drop-down, select a build version (ex: 20140512-01).

Notes: The Build Version field is populated using data from the Build Version field of the Build
Release Package form. The record must be saved for the build version to be available.

e. Release Location: Provide the location of the test Release (example: Test Server).

f. Test Script: Provide the test script (example: Test SQL installation).

Tip: Use the Test Script field to organize your test information, which might include a high-level
overview of the test or detailed step-by-step instructions.

g. Expected Results: Provide the expected result of the test (example: Install the new SQL
Server without issue).

h. Tester: Provide the name of the tester (ex: Henri), and then press ENTER or TAB to search for
the User Record.

Note: This field is auto-populated with name and contact information of the current User, but
can be changed if necessary.

If multiple matches are found (example: multiple Users named Henri), the Contact Manager
opens so that you can select the appropriate User.

Tips: Wildcards (example: "%" or "*") can be used when searching. To browse for a User, click
the User Selector button  to launch the Contact Manager. To view the selected User's

detailed Record, click the Quick View button .

i. Test Status: Select the status of the test (example: Completed).

Note: The test status reflects the lifecycle of the test, and is set to Pending by default. When
the test is initiated, the tester selects the Started test status, which auto-populates the Test
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Start Date Time field with the current date and time. When the test is completed, the tester
selects the Completed or Cancelled test status, which auto-populates the Test End Date Time
field with the current date and time.

Tip: Build testing varies by organization. Use the Test Status field to track the specific testing
process of your organization.

j. Test Start Date Time: Click the Date Selector button  to access the Calendar, and then
select the day in which you begin the test.

Note: The time is automatically set to 12:00 AM. Use the Test Start Date Time field to
manually define the appropriate time.

k. Test End Date Time: Click the Date Selector button  to access the Calendar, and then
select the day in which you end the test.

Note: The time is automatically set to 12:00 AM. Use the Test Start Date Time field to
manually define the appropriate time.

l. Test Disposition: Select the disposition (outcome) of the test (example: Passed).

CSM automatically sends an e-mail to Release Team members to notify them of the test
outcome.

m. Actual Results: Provide the result of the test (example: Installed the new SQL Server without
issue).

The Testing Status icons indicate the number of Test Events and their status (Passed, Failed,
Not Run).
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Note: If the build fails testing, click the Create New Build link in the Quick Info Tile to return to
the Build phase, or click the Cancel Release link to move to the Review phase.

7. Documentation Manager creates Release Notes.
a. Click the Create Release Notes button on the Test Script(s) form.

The Release Notes form opens in the Main Pane, the Release status changes to
Documenting, and the Release enters the Document phase.

Note: View additional form information and helpful tips by clicking the INFO button located on
the title banner of the form.

b. Author: Provide the name of the tester (example: Henri), and then press ENTER or TAB to
search for the User Record.

If multiple matches are found (example: multiple Users named Henri), the Contact Manager
opens so that you can select the appropriate User.

Tips: Wildcards (example: "%" or "*") can be used when searching. To browse for a User, click
the User Selector button  to launch the Contact Manager. To view the selected User's

detailed Record, click the Quick View button .

c. Release Notes: Provide the Release Notes.

Tip: You can also Insert a hyperlink (Rich Text) or type a system path to the associated
Release Notes.
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8. Owner requests approval for the Release.
a. Click the Obtain Approval button on the Release Notes form.

The Release Approval form opens in the Main Pane, the Approvals tab appears in the
Arrangement, and the Release enters the Approve phase.

9. Approver approves the Release.
a. In the Approval grid, click an Approval Record.

The Approval form opens. The Approver Name and Details fields are auto-populated per the
defined Approval Process rules.

b. (Optional) In the Comments field, provide your feedback.

c. Click Approve.

Release Approval Process Notes:

◦ The Release requires all approvers to provide approval.
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◦ If an approver denies the Release (clicks the Deny button), the Release remains in the
Approval phase with a status of Approving.

◦ If an approver abstains (clicks the Abstain button), the Release remains in the Approval
phase with a status of Approving.

◦ The Release requires approval to enter the Deploy phase.

The Approval Status icons indicate the number of pending Approvals and their status
(Approved, Denied, or Abstained).

10. Deployment Manager deploys the Release.
a. Click the Deploy Package(s) button on the Release Approval form.

The Deployment(s) form opens in the Main Pane, the Deploy Release Package tab opens in
the Arrangement, and the Release enters the Deploy phase.
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Note: View additional form information and helpful tips by clicking the INFO button located on
the title banner of the form.

b. In the Deploy Package grid, click a Release Package record. The Build Version and Short
Description fields are autopopulated based on the selected Build version.

c. Deployment Status: Select a deployment status.

Note: When the deployment is initiated, the Deployment Manager selects the Started status,
which auto-populates the Deployment Started field with the current date and time. When the
deployment is completed, the Deployment Manager selects the Completed status, which auto-
populates the Deployment Finished field with the current date and time.

d. Deployment Started: Click the Date Selector button  to access the Calendar, and then
select the day in which you start the deployment before updating the time.

e. Deployment Finished: Click the Date Selector button  to access the Calendar, and then
select the day in which you end the deployment before updating the time.

f. Disposition: Select the disposition (outcome) of the deployment (ex: Succeeded).
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The Deployment Status icons indicate the number of pending deployments and their status
(succeeded, failed, cancelled).

g. Details: Provide any additional information about the deployment.

Note: If the deployment fails, click the Create New Build link in the Quick Info Tile to return to
the Build phase, or click the Cancel Release link to move to the Review phase.

11. Owner completes the final details reviews the Release.
a. Click the Review Release button on the Deployment(s) form.

The Release Details form opens in the Main Pane and the Release enters the Review phase.

Note: View additional form information and helpful tips by clicking the INFO button located on
the title banner of the form.
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Note: The Planned Start Date and Planned End Date fields are auto-populated. using the
dates defined on the Release Details form in the Plan phase.

b. Actual Start Date: Click the Date Selector button  to access the Calendar, and then select
the date and time in which you actually started the Release process.

c. Click the Date Selector button  to access the Calendar, and then select the date and time
in which you actually ended the Release process.

d. Final Disposition: Select the disposition (outcome) of the Release (ex: Succeeded).

e. Review Notes/Lessons Learned: Provide any additional information about the Release.

12. Owner closes the Release.
a. Click the Close Release button on the Release Details form.

The Release status changes to Closed.
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Resource Management mApp Solution 1.0
Use the Resource Management mApp® Solution to identify and manage dedicated resources within
CSM.

Platform version requirements: Tested on CSM 10.1.0.

Content version requirements: Tested on CSM 10.1.0. This mApp Solution may also be compatible on
content versions that are older than CSM 10.1.0, but as with all mApp Solutions, be sure to test them on
your customized system.

Prerequisites: None.

Available languages:

• German

• English

• Spanish

• French

• Portuguese

Important: This mApp Solution should NOT be installed if you already have the PPM mApp
Solution installed, or if you intend to install the PPM mApp Solution 1.6 or earlier. The
Business Objects in this mApp Solution have been extracted and enhanced from PPM
mApp Solution 1.6. We will release a new version of the PPM mApp Solution that will work
seamlessly with the Resource Management mApp Solution; however, they are not
compatible together at this time.

Overview
The Resource Management mApp Solution provides the ability to identify dedicated resources for role,
rates, and skills assignment; as well as Task assignment with availability, softbooking, and capacity
information. Resources can report time against their Tasks with an associated rate based on their role.
From the Time and Cost dashboard, your organization can assess overall Resource ROI and create
invoices for billing, if needed.

Apply the mApp Solution
To download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.
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For a list of items included in this mApp Solution, see Resource Management mApp Solution Items.

This functionality is only available after you apply the mApp Solution.

Revision History

mApp Solution Version Platform Version
Requirements

Content Version
Requirements Prerequisites

1.0 10.1.0 10.1.0 None

Related concepts
About mApp Solutions
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Use and Create Roles for Resources
Use roles for high-level resource planning.

Each resource is assigned a role and the role helps provide key availability information for managers.
Some roles are included in the Resource Management mApp® Solution. You can modify, delete, or add
new roles as needed.

The following roles are included:

• Architect - Infrastructure

• Asset Manager

• Business Engagement Manager

• DBA - SQL

• DBA - Unix

• Developer

• Facilities

• HR

• Legal

• Network Administrator

• Process Engineer

• Procurement

• Project Manager

• Security Analyst

• Sr. Developer

• Technical Writer

• Tester/UAT

• Trainer - Content Developer

• Trainer - Delivery

• UI/UX Designer

• Web Specialist

To create a new role:

1. In the CSM Desktop Client or CSM Browser Client, select Tools > Table Management.
2. Select Role from the Type drop-down list, then select the New button.
3. Provide the role name and select a status.
4. (Optional) Select the area(s) the role may be associated with (example: The Security Analyst role

would be associated with the Security area).
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The default list of areas is included with the mApp Solution and cannot be modified.

The Resource Management mApp Solution uses the role and area information when looking for
resource and role availability, and when assigning Tasks.

Form Arrangement:
The Primary Resources and Resources tabs display information based on how you set up the
resources. The Skills tab displays information based on the skills that have been set up.

Related tasks
Create Resources to Assign to Tasks
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Link Skills to Incident Categories, Users, Teams,
and Roles

Create skills and link them to users to assist with identification of qualified technicians. Use the skills
assignment to link skills to for dedicated resources.

Use the included All Skills saved search to open the skills list. You can use a pre-loaded skill, or create a
new skill. Use the form arrangement to link the skill.

View or Create New Skills
To view or create a skill:

1. Open the Search Manager.

2. From the Association drop-down list, select Skills.
The All Skills saved search displays.

3. Run the All Skills saved search.
Search results are listed. There are 87 pre-loaded skills included in the mApp Solution.

4. To view a skill record, double-click the skill.
You can also edit the skill by making changes, and then saving the record.

5. To create new skills, select New from the menu bar. This can only be done from the CSM Desktop
Client.

◦ Provide the skill name and description.

Link a Skill to an Incident Category
To assign a skill to an Incident Category:

1. Select the Incident Categories tab, and then select the link button.
The Incident Category Selector window opens.

2. Select OK.

3. To view the Incident Category form, select the category from the list in the Incident Categories tab,
and then select the Goto Incident Category button.

Link a Skill to a User
To assign a skill to a user:

1. Select the Users tab, and then select the link button.

Note: In the Browser Client, if you don't see the form arrangement tabs at the bottom of the
form, find the splitter and drag it up to reveal the tabs.

2. Select a user, and then select OK.
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Link a Team to a Skill
To assign all users from a specific team to a Skill:

1. Select the Teams tab, and then select the link button.
The Team Info Selector window opens.

2. Select a team, and then select OK.
After you save the skill record, the users within the linked team automatically link to the skill and are
visible on the Users tab. You may need to refresh to see the changes.

Link a Role to a Skill
To link a role to a skill:

1. Select the Roles tab, and then select the link button.
The Role Selector window opens.

2. Select a role, and then select OK.

3. Save the record.

View Resources Linked to a Skill
If there are resources linked to the skill, they will be displayed in the Resources tab. To view the
resource, select the Goto Resource button.
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Add Rates to Use for Roles
Add rates to use when you assign roles in a resource. Resources use the associated rate (based on their
role) to report time against their Tasks.

Use rates to evaluate the associated cost of using specific resources and compare total cost to billable
cost. You can also use rates to create an invoice of the completed work for billing. Rates are only required
if you want to track cost against time recorded on Tasks. If you are not interested in tracking costs or ROI
for resources, you don't need to use rates.

Note: You must add rates to the rate table before they are available to choose from when
assigning roles in a resource.

1. In the CSM Desktop Client or CSM Browser Client, select Tools > Table Management.
2. Select Rate from the Type drop-down list, then select the New button.
3. Select the role and provide a rate name.

You can only add one rate per role.
4. Enter the rate amount, and then save the record.

Related tasks
Create Resources to Assign to Tasks
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Create Resources to Assign to Tasks
Resource is a major Business Object that tracks resources (employees) available to be assigned to
Tasks.

A resource's associated information provides availability and allocated time views for managers. A
resource record is required for each person who will be assigned Tasks. The Resource Management
mApp® Solution uses a One-Step™ Action to replace the Track Time One-Step Action on Incident (or
other Business Objects) to use resource. You do not have to use resources on Tasks that are linked to
another Business Object (Incident, Problem, Change).

For example, if an IT manager needs to assign an employee to a specific project that requires full time
employment status and hardware skill, they can review the resource records to determine which
employees meet those requirements.

All resources must be in your User Info Table, but not all users have to be a resource. The Name field
within resource is validated to the Full Name field in User Info.

Tip: Before you create resources, we recommend that you set up roles, skills, and rates (in that
order). Since resources use roles, skills, and rates, it will save time to set them up first.

To create an individual resource:

1. From the CSM Desktop Client or CSM Browser Client menu bar, select New > New Resource.
2. Select the resource name and employment type.

Department autopopulates based on the resource name, but you can choose a different option.
3. Select primary role and enter work week hours.

The Primary Role field will be unavailable until you assign roles in the Role Assignment tab of the
form arrangement.

4. Operational Percent: Enter a number from 0 to 100 to indicate the percent of work week hours
spent on day-to-day operational and administrative (non-project) tasks. The Available Project
Hours field automatically calculates using the Operational Percent and Work Week Hours values.
For example, with 40 Work Week Hours and an Operational Percent of 10, the resource will have 36
Available Project Hours.

Work Week Hours and Operational Percent plus PTO numbers are used during the creation of
Resource Time records.

5. Select Save, and then select the Create Resource Time Records link (under Actions). This
creates a time record for each day of the rest of the calendar year and the following year, which will
be used to determine availability at the role and resource level.
Use the Update Resource Time Records link to update the time records.
Use the Delete Resources link to delete the record.

Use the form arrangement for the remaining steps:

6. Assign roles and skills using the Role Assignment and Skill Assignments tabs.
7. Use the Tasks tab to create Work Items.
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You can create costs using the Cost Item - Labor Business Object.
a. From the menu bar, select Tools > Table Management.
b. Select Cost Item - Labor from the Type drop-down list, then select the New button.
c. Select the resource name.

The Role and Rate Name fields autopopulate based on the resource name, but you can
choose a different option.

d. Select the Billable check box, if applicable.
e. Select the date, start time, end time, and hours.

The rate autopopulates and after the hours are filled in, the total cost is calculated.
8. Add or view scheduled PTO and resource times using the Scheduled PTO and Resource Times

tabs.
Use the Additional Resource Time Entries Automation Process to create resource times.
The record must be in an active status before the Resource Times tab is updated.

You can change the status of the resource by selecting the Change Status link in the default form, but
the Primary Role field must be completed first.

Related concepts
Link Skills to Incident Categories, Users, Teams, and Roles
Automation Process Editor
Related tasks
Use and Create Roles for Resources
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Softbooking
Softbooking places a resource's time on hold for proposed Tasks.

Softbooking accurately represents a resource's available time, so a manager can reserve an employee's
time for future Tasks.

When a resource is assigned a Work Item with a status of New, the resource is softbooked. Once the
status moves beyond New, the resource is no longer softbooked; it has allocated hours.

A Resource Manager can use the Resource Availability by Individual and Resource Availability by Role
dashboards to see available hours per resource or individual (allocated, softbooked, and PTO hours).
They can use that information to schedule Tasks for the month based on who has available hours and
when. Available hours versus allocated hours show if a resource is overallocated or has availability for
other Tasks. Resource Managers can make adjustments to any softbooked hours, and plan ahead to
manage a resource's utilization and adjust their time as needed.

Note: When you create a new Work Item, the following fields must be completed before the
information is displayed on a dashboard: Assigned To, Scheduled Start Date, Due Date, and
Effort (this is what consumes time). You must save the Work Item, and then open it directly to see
the Effort field (in the Resource Fields tab).

Related concepts
Resource Management Dashboards
Work Item Task
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Resource Management Dashboards
Use the Resource Management dashboards to view at-a-glance information on resources, Work Items,
and availability.

Resource Time and Cost
Use the Resource Time and Cost dashboard to understand how much of your resource's time has gone
toward Task work and the associated cost to your organization. At the resource level you'll see a high-
level roll up of total hours and cost compared to billable hours and cost, as well as the individual Tasks/
cost breakdown.

Work Item Time and Cost
From the Resource Time and Cost dashboard you can select the Time and Cost by Resource link to pull
all Cost Item records against a single Work Item. Once you select the appropriate Work Item, you'll see a
high-level view of total hours and cost versus billable hours and cost. From here, you can create an
invoice of the work completed and send to the appropriate organization or department for payment.
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Resource Availability by Role
View each role's availability using the Resource Availability by Role dashboard. After you select a role and
a specific time frame, you'll see a bar chart depicting the available hours, softbooked hours, allocated
hours, and PTO hours for all resources assigned to the role. Easily determine from this high-level view if a
particular role is under or over booked based on capacity. Toggle between the weekly and daily view as
needed.
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Resource Availability by Individual
View each resource's availability using the Resource Availability by Individual dashboard. After you select
a resource and a specific time frame, you'll see a bar chart depicting the available hours, softbooked
hours, allocated hours, and PTO hours. This dashboard allows you to determine if an individual resource
is able to take on additional Task work or if they have been over booked. The resource's work week hours
and operational percent information determine the hours available in the graph. Toggle between the
weekly and daily view as needed.
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My Work - Alt IT
This solution also provides an Alternate My Work dashboard that includes impromptu project-related Task
assignments. You can also use it to replace the My Work dashboard from Cherwell's OOTB czar.
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Resource Management mApp Solution Items
The Items table provides a list of items included when applying the mApp® Solution and the typical merge
action.

These are the items included in this mApp Solution:

Item Category Item Typical Merge Action

Automation Process
Definitions

Additional Resource Time Entries, Create Resource Time Entries,
Delete Resource Import

Business Objects

Cost Item, Cost Item - Labor, Cost Item - Other, Cost Item -
Provisioning, Cost Item - Tool, Cost Item Category, Cost Item
Provisioning Frequency

Overwrite

Employment Type, Rate, Resource, Resource Status, Resource
Time, Role, Role Assignment, Role Status,
RolesLinkSkillsJoinTable, Scheduled PTO, Skill Assignment, Skill
Level, SkillLinksUsers, Skills

Import

Incident, Incident Category, Team Info, User Info, Work Item Merge

Task Don't Change

Cargo Definition Copy of Create Task Invoice Import

Color Palette Resource Dashboards Import

Counter Resource Search Group Number Import

Dashboards
My Work - Alt IT, Resource Management - Individual, Resource
Management - Role, Resource Time and Cost, Skills Management,
User Skills, Work Item Time and Cost

Import
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Item Category Item Typical Merge Action

Fields

Allocated Hours Per Day, Asset Management, Assigned to,
Assigned to RecID, Available Hours, Available Project Hours,
Billable, ChildID, ChildJoinReason, ChildType, Cost, Create New
Records, Created By, Created By ID, Created by RecID, Created
Culture, Created Date Time, Daily Hours, Date, Delete Resource,
Department, Description, Description_de-DE, Description_en-US,
Description_es-ES, Description_fr-FR, Description_pt-BR, Duration,
Effort, Edit Via Browser, Employment Type, Employment Type_de-
DE, Employment Type_en-US, Employment Type_es-ES,
Employment Type_fr-FR, Employment Type_pt-BR, End Date, End
Time, Facilities, Hours Per Day, HR, IT, JoinReason, Last Mod Time
Stamp, Last Modified By, Last Modified by RecID, Last Modified
Date Time, Locked, Manager, Operational Hours, Operational Hours
per Day, Operational Hours per Week, Operational Percent,
ParentID, ParentType, Primary Rate, Primary Role, Project, PTO
Hours, Rate, Rate Name, Rate Name_de-DE, Rate Name_en-US,
Rate Name_es-ES, Rate Name_fr-FR, Rate Name_pt-BR, RecID,
Remaining Project Hours, Required Skill, Resource, Resource
RecID, Role, Role_de-DE, Role_en-US, Role_es-ES, Role_fr-FR,
Role_pt-BR, Roles, Search Group Number, Security, Skill, Skill_de-
DE, Skill_en-US, Skill_es-ES, Skill_fr-FR, Skill_pt-BR, Skill ID, Skill
Level, Skill Level_de-DE, Skill Level_en-US, Skill Level_es-ES, Skill
Level_fr-FR, Skill Level_pt-BR, Skill(s), Skills ID, Softbooked Hours
Per Day, Start Date, Start Time, Status, Status_de-DE, Status_en-
US, Status_es-ES, Status_fr-FR, Status_pt-BR, Submitted,
Submitted Via Browser, Task RecID, Task Title, Total Assignments,
Total Resources, Total Roles, Total Teams, Total Users, TotalSkills,
User Full Name, User Info RecID, Valid, Weekly Hours, Work Week
Hours

Import

Budget Cost, Category, Category_de-DE, Category_en-US,
Category_es-ES, Category_fr-FR, Category_pt-BR, Cost, Cost Item
Type ID, Cost Item Type Name, Cost Item Type RecID, Cost Type,
Created By, Created By ID, Created by RecID, Created Culture,
Created Date Time, Details, Frequency, Frequency_de-DE,
Frequency_en-US, Frequency_es-ES, Frequency_fr-FR,
Frequency_pt-BR, Hours, Item Description, ITPT Project ID, Last
Mod Time Stamp, Last Modified By, Last Modified By ID, Last
Modified Date Time, Parent RecID, Quantity, Rate, RecID,
Resource Name, Status, Time Spent, Total Cost, Unit Price

Overwrite

Forms

CostItemCategory, CostItemFrequency, CostItemProvisioning, Labor
Cost Item, OtherCostItem, ToolCost Overwrite

EmploymentType, Rate, Rate Localization, Resource, Resource
Fields, Resource Overview, ResourceStatus, Resource Time, Role,
Role Assignment, Role Localization, Role Status, Role Status
Localization, Scheduled PTO, Skill Assignment, Skill Level, Skill
Level Localization, Skills, SkillsManagement, Skills Localization

Import

Form Arrangements PPMResourceTime, Rate, Resource, Role, RoleStatus,
SkillAssignment, SkillLevel, Skills Import
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Item Category Item Typical Merge Action

Grids

CostItem, CostItemCategory, CostItemFrequency
CostItemProvisioning, Labor Cost Item, OtherCostItem, ToolCost Overwrite

Dashboard, Employment Type, Rate, Resource, Resource Status,
Resource Time, Role, Role Assignment, Role Assignment
Dashboard Grid, Role Assignment Form Arrangement, Role Status,
Scheduled PTO, Skill Assignment, Skill Assignment Dashboard
Grid, Skill Level, SkillLinksUsers 1, Skills, Skills Top 10 Grid

Import

Image Definitions
resource_16, resource_20, resource_24, resource_time_16,
resource_time_20, resource_time_24, role_16, role_20, role_24,
scheduled_PTO_16, scheduled_PTO_20, scheduled_PTO_24

Import

Indexes

PK_CostItem, CostItemCategory_Category, PK_CostItemCategory,
PK_CostItemFrequency Overwrite

IncidentCategory_IncidentCategory, PK_EmploymentType,
PK_IncidentCategory, PK_PPMResourceTime, PK_Rate,
PK_Resource, PK_ResourceStatus, PK_Role,
PK_RoleAssignment, PK_RolesLinkSkillsJoinTable,
PK_RoleStatus, PK_ScheduledPTO, PK_SkillAssignment,
PK_SkillLevel, PK_SkillLinksUsers, PK_Skills, PK_Task,
PK_TeamInfo, Resource_FullName, Role_Role, RoleIdx0,
TeamInfoName, Task_ParentID, Task_ParentTypeID, TaskStatus,
Task_Subject, Task_TaskID, Task_TaskType

Import

Mergeable Areas PPM Resource Actions, PPM Resource Time Actions, Skills Actions,
Task Actions Overwrite

One-Step™ Action

Change Status, Delete Resource, Edit PTO, Flag for Delete, Get
Role and Rate, Manual -Update Resource Time Bookings,
Recommended Assignee, Refresh Counts, Refresh Individual
Dashboard, Refresh Resource Dashboard, Refresh Role
Dashboard, Resource Daily Time Entries, Resource Management
Individual and Date Selector, Resource Management Individual
Selector, Resource Management Individual Set View - Per Day,
Resource Management Individual Set View - Per Week, Resource
Management Individual Update Dates, Resource Management Role
Selector, Resource Management Update End Date, Resource
Management Update Start Date, Resource Time Cleanup, Select
Department, Select Different Role/Rate, Select Employment Type,
Select Resource, Select Resource Manager, Select Role, Select
Work Item, Set Flag To Create New Records, Set Skills and Roles,
Set View - Per Day, Set View - Per Week, Skills by Resource -
Update Resource, Skills by Role - Update Role, Skills by User -
Update User, Submit PTO, Team Skills, Track Time - Resource,
Track Time and Cost, Update Dashboard, Update Effort, Update
Resource, Update Resource Time Bookings, Update Resource Time
Entries, Update Resource Times Dashboard, Update Start/End
Dates, Update Start/End Dates Time and Cost, Update Total Counts

Import

Update Hours Worked Overwrite

Prompt Select A Resource Import
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Item Category Item Typical Merge Action

Relationships

Resource Links Role, Resource Links Skills, Resource Owns
Resource Times, Resource Owns Role Assignments, Resource
Owns Scheduled PTOs, Resource Owns Skill Assignments,
Resource Owns Tasks, Resource Time Links Scheduled PTO,
Resource Time Links Tasks - Softbooked, Resource Time Links
Work Item - Allocated, Resource Time Owned By Resource, Role
Links Resource, Role Links Skills, Role Links to Resources,
Scheduled PTO Links Resource Times, Scheduled PTO Owned By
Resource, Skills links Incident, Skills links Incident Category, Skills
Links Resources, Skills Links Roles, Skills Links Team, Skills links
Users, Task Links Resource Times, Tasks Owned By Resource,
Team links Skills, Team links Users, Userinfo Links Skills

Import

Cost Item - Labor Links To Resource, Incidents links skills, Task
Links Resource Times, Tasks Owned By Resource, Work Item
Owns Cost Labor

Overwrite

Report Create Task Invoice Import

Scheduled Item
Definitions Update Resource Time Bookings, Update Team Skill Count Import

Searches

All Skills, Create Invoice, My Operational Tasks, My Resources, My
Teams Operational Tasks, Resource Entries Greater Than Today,
Resource Time Aged Two Weeks, Resource Time Dashboard -
Individual, Resource Time Dashboard - Role, Resource Time
Records, Resources, Resources by Primary Role, Resources by
Selected Role, Resources by Selected Skill

Import

Stored Expressions

Cost, Date is Valid, Duration, Hours Per Day, Hours Per Day, Hours
Worked - Resource, Next End of Year, Prompt for Role, Prompt for
Skill, Resource Role, Total Time, Two Weeks Ago, Update Allocated
Hours, Update PTO Hours, Update Remaining Project Hours,
Update Softbooked Hours

Import

Compute Total, TaskDurationInHours Overwrite

Stored Values

Resource Dashboard - Chart View, Resource Dashboard End Date,
Resource Dashboard Individual, Resource Dashboard Role Name,
Resource Dashboard RoleID, Resource Dashboard Start Date,
Resource RecID, Resource Time Date, Scheduled PTO End Date,
Scheduled PTO Start Date, Search Group Number, Skill User, Skills
by Individual Or Role, Skills Dashboard Search Type, Skills RecID,
Work Item Task

Import
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Item Category Item Typical Merge Action

Widgets

All Skills, Available Project Hours - Daily, Available Project Hours -
Weekly, Available Project Hours By Individual (Daily), Available
Project Hours By Individual (Weekly), Cost By Resource, Cost Labor
Search List, Dashboard Resources, Hours By Resource, Incidents
and Requests Owned by Me, My Incident Tickets, My Operational
Tasks, My Operational Tasks - Detail, My Priority 1 Incident Tickets,
My Priority 1 Service Requests, My Project Task Details, My Project
Tasks, My Team's Open Incidents and Request, My Team's
Operational Tasks, My Total Service Requests, My VIP Incident
Tickets, My VIP Service Requests, Number of Resources, Resource
Bar - Daily (Individual), Resource Bar - Daily (Role), Resource Bar -
Weekly (Individual), Resource Bar - Weekly (Role), Resource Time
Total Billable Hours, Resource Time Total Hours, Resource Total
Billable Cost, Resource Total Cost, Skills by Resource All Skills Grid,
Skills by Resource Total Skills, Skills by User All Skills Grid, Skills by
User Total Skills, Task Cost Labor Search List, Task Total Cost, Task
Total Cost Billable, Task Total Hours, Task Total Hours Billable, Top
Skill Assignments, Total Skills, Unassociated Skills

Import

CD - Date Filter - 30 day default Overwrite

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution includes the definition
for informational purposes only (the definition is not imported into the target system).
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Plugin mApp Solutions
A Plugin mApp® Solution is an add-on to CSM that enhances features and capabilities. The add-ons can
include additional tracking, modules, and metrics.
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ITIL 4 Dashboards mApp Solution 1.0
Use the ITIL 4 Dashboards mApp Solution to apply the ITIL 4 Dashboards to CSM.

Cherwell Version Requirements: 10.0.x

Out-of-the-Box Content Version Requirements: 10.0.0

Prerequisites: None

This mApp Solution is available in the following languages:

• German

• English

• Spanish

• French

• Portuguese

Note: This mApp Solution includes some new fields for Incident, Problem, and Change Business
Objects. Some Widgets may not show data after the mApp Solution is applied because existing
records do not include values for these new fields.

Overview
The ITIL 4 Dashboards mApp Solution enables your IT organization to apply Dashboards that use metrics
aligned with the ITIL 4 principles to your CSM system .

The ITIL 4 Dashboards show metrics that focus on outcomes and value over tracking queues and human
efficiency metrics. Users can understand how well they are co-creating value for their customers to be
more ITIL focused. The four Dashboards included with this mApp Solution are:

• Executive/Continuous Service Improvement (CSI) Manager Dashboard

• Incident Manager Dashboard

• Problem Manager Dashboard

• Service Desk (1st-3rd Level Support) Technician Dashboard

How the mApp Solution Works
CSM provides ITIL 4 Dashboards as a mApp Solution so that users can easily incorporate the ITIL 4
Dashboards into their existing system. Download the mApp Solution from the Cherwell mApp Exchange.
Use the Apply mApp wizard to apply the mApp Solution to your CSM system. The Apply mApp Solution
wizard generates a Blueprint, which can then be viewed and published to a test or live system to commit
the changes.

For a list of items included in the mApp Solution, see ITIL 4 Dashboards mApp Solution Items.
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Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.0 10.0.x 10.0.0 None

Related concepts
About mApp Solutions
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ITIL 4 Dashboards
The ITIL 4 Dashboards mApp Solution provides four ITIL Dashboards to apply to CSM.

Note: This functionality is only available after applying the ITIL 4 Dashboards mApp Solution.

Executive/Continuous Service Improvement Manager: Primarily built for members of the IT
Leadership team. The Dashboard provides insights into IT operations and continual improvement efforts.

Incident Manager: Primarily built for Service Desk Managers and/or Incident Managers. The Dashboard
provides KPIs, charts, and metrics to enable IT organizations to proactively monitor and manage their
Incident Management operations.
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Problem Manager: Primarily built for Problem Managers. The Dashboard provides KPIs, charts, and
metrics to enable IT organizations to proactively monitor and manage their IT Problems across the board.
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Service Desk (1st-3rd Level Support) Technician: Primarily built for Service Desk Technicians and
other members of the IT Service Desk department. The Dashboard displays KPIs, charts, and metrics to
enable Service Desk teams to proactively monitor and manage all incoming Incidents, Service Requests,
Problems, Change Requests, and Tasks.
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ITIL 4 Dashboards mApp Solution Items
The Items table provides a list of items included when applying the mApp Solution and the typical merge
action.

These are the items included in this mApp Solution:

Item Category Item Typical Merge Action

Business Objects
Change Request, Incident Merge

Configuration Item, Knowledge - IT, Problem, Task,
Work Item Don't Change

Dashboards Executive/CSI Manager, Incident Manager, Problem
Manager, Service Desk Technician Import

Fields Planned Change, Customer Department, Linked to
Problem, Reopened, Status Order Import

Grids
ITIL4 Change Dashboard, ITIL4 Incident Dashboard,
ITIL4 Dashboard, ITIL4 Problem Dashboard, ITIL4
Task Dashboard

Import

Indexes

Change_ChangeID, ChangeCreatedDT,
ChangeOwnedBy, ChangeStatus, PK_Change,
Incident_CustomerID, Incident_IncidentType,
Incident_OwnedByID, Incident_RecID,
IncidentCreatedDT, IncidentID,
IncidentIdx_ServiceCartRecID,
IncidentIdx_ServiceCatalogTemplateRecID,
IncidentService, IncidentStatus

Overwrite

Metric Values

ITIL4 - All Incidents, ITIL4 - All Resolved + Self-
Service, Resolution, ITIL4 - Closed on First Call,
ITIL4 - KB Portal Usage Total, ITIL4 - Open via
Portal/All Incidents, ITIL4 - Reopened, ITIL4 -
Reopened Incidents

Import

One-Step™ Action Submit Feedback Import
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Searches

All Incident Type = Incident, All Incidents, All New
Problems, All Open Incidents, All Open Incidents,
Overdue Resolution (Breach), All Open Incidents,
Resolution Warning, All Open Service Requests, All
Open Work Items, All Resolved/Closed Incidents
within Resolution SLA, Articles with Usage Count,
CIs Currently Down, High Risk Changes, My Open
Incidents and Requests

Don't Change

All OpenTasks, All Problems, All Resolved/Closed
Incidents, Incidents Linked to Problem, Known Error,
My Teams Open Change Requests, My Teams Open
Problems, No Workaround, Open Incidents and
Requests, Open Problems, SLA Resolve Breach,
Top Issues, Workaround Exists

Overwrite

ITIL4 - Fulfilled via Automation, ITIL4 - New Issues,
ITIL4 - Open P1 Issues, ITIL4 - Planned Changes,
ITIL4 - Reopened Incidents, ITIL4 - Teams Open
Tasks, ITIL4 - Unassigned Issues, ITIL4 - Unplanned
Changes, Workaround Published in Portal

Import

Stored Expressions
2 Days Old, 5 Days Old Import

7 Days Old Overwrite
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Widgets

ITIL4 - Active SLA Breached, ITIL4 - Active SLA
Warnings, ITIL4 - All Open Issues, ITIL4 - All
Problems Grid, ITIL4 - Breached SLAs, ITIL4 - Down
CIs, ITIL4 - High Risk Changes, ITIL4 - Incident
Filter, ITIL4 - Incident Resolved With SLA, ITIL4 -
Incidents By Source, ITIL4 - Incidents by Status/Days
Open, ITIL4 - Incidents Closed on First Call, ITIL4 -
Incidents Closed on First Contact, ITIL4 - Incidents
Linked to Problems, ITIL4 - Incidents Logged via
Portal, ITIL4 - Incidents Reopened After Close, ITIL4
- Incidents Resolved Within SLA, ITIL4 - Issues
Assigned to Me, ITIL4 - Issues In Backlog, ITIL4 -
Known Errors, ITIL4 - Mean Time to Resolve
Incidents by Priority, ITIL4 - Open Incidents, ITIL4 -
Open Incidents By Team Member, ITIL4 - Open
Issues by Service, ITIL4 - Open Issues by Status,
ITIL4 - Open Issues Submitted by Department, ITIL4
- Open P1 Issues, ITIL4 - Open Problems, ITIL4 -
Open Service Requests, ITIL4 - Open Tasks, ITIL4 -
Planned vs Unplanned Changes, ITIL4 - Problems
By Category, ITIL4 - Problems by Priority, ITIL4 -
Problems by Status, ITIL4 - Problems by Team, ITIL4
- Problems in Backlog, ITIL4 - Problems With
Workaround, ITIL4 - Problems Without Workaround,
ITIL4 - Reopened Incidents, ITIL4 - Requests
Fulfilled via Automation, ITIL4 - Self Service
Resolution, ITIL4 - Teams Open Changes, ITIL4 -
Teams Open Problems, ITIL4 - Teams Open Tasks,
ITIL4 - Top Problems Grid, ITIL4 - Total Linked
Incidents, ITIL4 - Unassigned Issues, ITIL4 -
Workarounds Published in Portal, ITIL4 - All Open
Issues Grid

Import

Problems Filter Overwrite

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution includes
the definition for informational purposes only (the definition is not imported into the target system).
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License Usage mApp Solution 1.5
CSM License Usage is a mApp® Solution that allows you to track CSM license data related to the number
of total licenses, used licenses, and remaining licenses.

Platform version requirements: Tested on CSM 9.6.x — 10.2.0.

Content version requirements: Tested on CSM 9.5.x — 10.0.0; this mApp Solution may or may not be
compatible with content versions earlier than CSM 9.5.x, but as with all mApp Solutions, be sure to test it
on your customized system.

Prerequisites: None.

Overview
The CSM License Usage mApp Solution also allows you to track usage counts for features that do not
require a license, such as the Dashboard Viewer.

The mApp Solution includes multiple Business Objects:

• Major
◦ CSM License Usage

• Supporting
◦ CSM License Usage Count

• Lookup tables
◦ CSM License Usage Duration

◦ CSM License Usage Status

◦ CSM License Usage Type

◦ CSM License Usage Type Category

The CSM License Usage form allows users to view, manage, and track usage data.
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The mApp Solution includes the following items:

Item Category Item Typical Merge Action

Business Object

 

CSM License Usage, CSM License Usage Count, CSM
License Usage Duration, CSM License Usage Status,
CSM License Usage Type, CSM License Usage Type
Category

Import

Incident (Business hours definitions) Don't Change

Automation Process License Usage Tracking in Hours, License Usage
Tracking in Minutes Import

Forms CSM License Usage, CSM License Usage Summary Import

Dashboard CSM Hourly License Usage Dashboard, CSM License
Usage, Drill Down Licenses, License Usage Dashboard Import

One-Step™ Action

Activate Tracking, Completed Tracking, CSM License
Usage Duration Search, Deactivate Tracking, Go to
Dashboard, License Usage Count, Manual License
Count

Import

Expression Numerous Varies

Stored Query Numerous Import
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Store Value License Usage Hour Duration, License Usage Minute
Duration Import

Widget

Daily Application Usage, Donut of Used Licenses, Filter,
License Usage Detail, Minimum Users, Non License Lo
gins, Non License Users by Hour, Remaining Licenses,
Search License Usage, Second Layout Chart, Total
Available Licenses, Total Users, Users by the Hour,
Users Logged per Hour

Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• License Consumption • About Dashboards

• About Business Objects • About mApp Solutions

Apply the mApp Solution
Follow these steps to download and apply the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution
Follow these steps to configure the mApp Solution:

1. Define security rights for CSM License Usage Business Objects.

2. Edit the CSM License Usage Automation Process.
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Use the mApp Solution
The following tasks and functions are available with the mApp Solution:

• Create a CSM License Usage record

• CSM License Usage Dashboards

• CSM License Usage Automation Processes

• CSM License Usage Saved Searches

• CSM License Usage Form

677

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/csh?topicname=create_a_csm_license_usage_record
https://help.cherwell.com/csh?topicname=csm_license_usage_mapp_dashboards
https://help.cherwell.com/csh?topicname=csm_license_usage_mapp_automation_processes
https://help.cherwell.com/csh?topicname=csm_license_usage_mapp_search_groups
https://help.cherwell.com/csh?topicname=csm_license_usage_mapp_form


Configuring the CSM License Usage mApp
Solution

Complete the following procedure to configure the CSM License Usage mApp Solution. The configuration
procedure is completed in CSM Administrator.

1. Define security rights for CSM License Usage Business Objects.

2. Edit the CSM License Usage Automation Process.
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Define Security Rights for CSM License Usage
Business Objects

Use CSM Administrator to define security rights for associated Business Objects. Business Objects
associated with this mApp Solution support all rights (example: View, add, edit, delete) by default. We
recommend granting security rights only to Users who require access to CSM licensing information
(example: System administrators, License Managers, Software Asset Managers, and IT Service Desk
Managers).

Note: This functionality is only available if you have applied the CSM License Usage mApp
Solution.

To define security rights:

1. Define Business Object Rights (Access to Data) for the following Business Objects:

• Major
◦ CSM License Usage

• Supporting
◦ CSM License Usage Count

• Lookup tables
◦ CSM License Usage Duration

◦ CSM License Usage Status

◦ CSM License Usage Type

◦ CSM License Usage Type Category
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Edit the CSM License Usage Automation Process
By default, the CSM License Usage Automation Process runs during business hours. You can use the
Automation Process Editor to define different business hours or configure the Automation Process to run
continually.

1. In CSM Administrator, click the Automation Processes category.
2. Select Create a new Automation Process Blueprint.

The Edit Automation Processes dialog opens.
3. Select License Usage Tracking in Minutes and click the Edit (pencil) button.

The Visual Workflow Process Designer opens.
4. Click Work Hours.
5. Click the ellipses button to define new working hours, or select 24 x 7 to make the automation

process run continually.

Note: Refer to Create Business Hours for details about creating new working hours using
the Business Hours Manager.

6. Click OK to close the Visual Workflow Process Designer, then click the Save button in the Edit
Automation Processes dialog to save the Blueprint.

7. Publish the Blueprint.
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Using the CSM License Usage mApp Solution
The following tasks and functions are available with the mApp Solution:

• Create a CSM License Usage record

• CSM License Usage Dashboards

• CSM License Usage Automation Processes

• CSM License Usage Saved Searches

• CSM License Usage Form
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CSM License Usage mApp Solution Good to Know
• Press TAB to move to the next field on the form.

• The Started By section is populated with the name of the creator.

• A time stamp is recorded when the record is created.

• View high-level license counts in CSM License Usage Form Arrangement > CSM License Usage
Summary tab.

• View detailed license counts in CSM License Usage Form Arrangement > CSM License Usage
Count tab.

• Quickly access the License Usage Metrics Dashboard by selecting I Want To > Go to CSM
License Dashboard.

• Obtain a real-time license count by selecting I Want To > Go to License Count.
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Create a CSM License Usage Record
Use the CSM Desktop Client to access the CSM License Usage record to track Cherwell Service
Management® license data related to the number of total licenses, used licenses, and remaining licenses.

To create a CSM License Usage record:

1. On the CSM Desktop Client toolbar, select New > New CSM License Usage.

A new CSM License Usage record is created with a status of Not Tracking. The creator is
automatically assigned as the Started By User.

2. Complete the following Usage Tracking Configuration fields (* for required):
a. *Start Date: Click the Calendar Date Selector button  to select a start date and time for the

license tracking.

b. *End Date: Click the Calendar Date Selector button  to select an end date and time for the
license tracking.

c. *Frequency: Click the Up and Down buttons to select the frequency of the license tracking.

d. *Duration: Click the drop-down, and then select a duration for the license tracking (hours or
minutes).

e. License Count: Select the type of data that you want to track.

f. Licensed Client: Select one or more clients for which you want to track license usage.

g. Non-Licensed Client: Select one or more features for which you want to track usage counts.

3. Click the Activate Automated Tracking button.

The CSM License Usage Status changes to Tracking. When the first instance of license tracking is
recorded, and the number of Available Licenses, Used Licenses, and Remaining Licenses display in
the Quick Info Tile alert bars. When 50% of the licenses are in use, the Used Licenses alert bar
turns orange. When 80% of the licenses are in use, the Used Licenses alert bar turns red.

A summary of the tracked information is displayed in the License Usage Summary tab in the Form
Arrangement.

Tip: For a real-time license count, click the Get License Count link in the I Want To section of the
Quick Info Tile. A record of the current license data displays in the Quick Info Tile alert bars and in
the CSM License Usage tab of the Form Arrangement.

4. Click the Deactivate Automated Tracking button to end tracking.
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CSM License Usage Features
CSM provides the following tools to help manage CSM License Usage records:

• Form

• Dashboard

• Saved Searches

• Automation Processes
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CSM License Usage Form
Use the CSM License Usage Form to log, edit, and track CSM License Usage records. The form is made
up of the following main areas:

1. Quick Info Tile: Displays important at-a-glance information, including Status bar (current and next
status), Total Licenses bar, Used Licenses bar, Remaining Licenses bar, Started By (record
ownership), and other common operations (I Want To section).

2. Main Pane: Displays the main form fields, which allow you to define the data you want to track.

3. Arrangement: Dynamically displays linked records (Child Records) that are in a relationship with the
parent CSM License Usage record.

The following table describes the fields on the form.

Field Description Comments

Quick Info Tile

Important at-a-glance information, including
Status bar (current and next status), Available
Licenses bar, Used Licenses bar, Remaining
Licenses bar, record ownership, and common
operations (I Want To section).
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Field Description Comments

CSM License Usage Record type.  

Status Alert Bar Current and next status of the CSM License
Usage record.  

Available Licenses
Alert Bar

Displays the total number of CSM licenses
available to your organization.  

Used Licenses Alert
Bar

Displays the number of CSM licenses currently
being used.  

Remaining Licenses
Alert Bar

Displays the number of CSM licenses that are
currently available.  

Owned By   

User Owner

-select owner-
Record owner.  

Time stamp The date and time in which the record was
created.  

I Want To   

Get License Count Click the link to access real-time license data
based on the defined criteria.

License Usage Count
One-Step Action: Steps
through a count of each
CSM License type (ex:
Available licenses) and
then saves the record.

Go to CSM License
Usage Dashboard

Click the link to open the License Usage Metrics
Dashboard where you can view and track
license data.

Go to Dashboard One-
Step Action: Opens the
License Usage Metrics
Dashboard in the Main
Pane.
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CSM License Usage Dashboards
CSM License Usage mApp Solution provides the following Dashboards:

• CSM License Usage Dashboard

• License Usage Metrics Dashboard
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CSM License Usage Dashboard
The CSM License Usage Metrics Dashboard intuitively organizes your critical license metrics into a single
control panel.

License Usage Metrics Dashboard Widgets

Item Description Widget
Type Widget Name Widget Uses:

License
Utilization per
Day

Number of used CSM
licenses and available
licenses per day.

Chart Second Layout
Chart

Used Licenses Saved
Search, Available
Licenses Saved
Search

Total Available
Licenses

Total number of CSM
licenses available to the
organization.

Text Gauge Total Available
Licenses

Total Licenses Saved
Search

Remaining
Licenses

Number of CSM licenses
currently available to the
organization.

Text Gauge Available
Licenses

Available Licenses
Saved Search

Licenses Percentage of each CSM
license type being used. Chart License Used License Used Saved

Search
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Item Description Widget
Type Widget Name Widget Uses:

Daily
Application
Usage

Number of each type of CSM
license being used per day. Chart

Daily
Application
Usage

Multiple Saved
Searches (Total
License, Browser
Client, Rich Client,
Mobile Client,
Outlook Plugin, Portal
License, Reserved
License)

Non-License
Number of each type of non-
licensed CSM features being
used

Doughnut Non License
Logins

Non License Logins
Saved Search

Licensed Users
per Hour

Number of used and
available CSM licenses per
hour.

Chart Users Logged
per Hour

Used Licenses Saved
Search, Available
License Saved
Search

Non-Licensed
Users per Hour

Number of users logged into
non-licensed CSM features
per hour.

Chart Non License
Users by Hour

Total Non-License
Login Saved Search,
Non-Licensed Users
Saved Search
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Detail License Usage Metrics Dashboard
The CSM Detail License Usage Metrics Dashboard dynamically displays data for a specific licensed client
or non-licensed feature (ex: Desktop Client). Access the Dashboard by double-clicking a Widget segment.

Detail License Usage Metrics Dashboard Widgets

Item Description Widget
Type Widget Name Widget Uses:

License
Utilization per
Day

Number of used CSM licenses
and available licenses per day. Chart Second

Layout Chart

Used Licenses Saved
Search, Available
Licenses Saved
Search

Maximum # of
Users

Highest number of licenses
used within an hour at any
point during the last quarter.

Text
Gauge Total Users

Created Date Time
field, License Count
field

Minimum # of
Users

Lowest number of licenses
used within an hour at any
point during the last quarter.

Text
Gauge

Minimum
Users

Created Date Time
field, License Count
field
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Item Description Widget
Type Widget Name Widget Uses:

Users on
Average per
Hour

Average number of licenses
used each hour. Chart Users by the

Hour

Created Date Time
field, License Count
field

License Usage
on Average

Average number of licenses
used each day. Chart Usage Detail

Created Date Time
field, License Count
field

Search License
Usage

All license usage counts
organized by the Created Date
Time field.

Search
Results
List

Search
License
Usage

CSM License Usage
Count Business
Object

691

CSM mApp Solutions

CSM mApp Solutions



CSM License Usage Saved Searches
CSM License Usage and CSM License Usage Count include numerous Saved Searches that can be
executed from the Search Manager, Metrics, One-Step Actions, or Widgets. Some of them can
additionally be executed from Metrics or One-Step Actions.

Saved Searches for CSM License Usage

Numerous Saved Searches for CSM License Usage can be executed from the Search Manager, Metrics,
or One-Step Actions.

Saved Search Returns Executed From

All CSM License Usage Records

All CSM License Usage records.

CSM License Usage.RecID Not
Empty.

Search Manager
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Saved Search Returns Executed From

Completed CSM License Usage

CSM License Usage records with
a status of Complete.

CSM License Usage.Status equals
Completed.

Search Manager

Hour Tracking Duration

CSM License Usage record with a
duration in hours and a status of
Tracking. All items in group must
be met.

CSM License Usage.Duration
equals Hours.

And

CSM License Usage.Status equals
Tracking.

Search Manager, Metrics, One-
Step Actions

Metric

CSM License Usage with a
duration in minutes.

CSM License Usage.Duration
equals Minutes.

Search Manager

Minute Tracking

CSM License Usage records with
a duration in minutes.

CSM License Usage.Duration
equals Minutes.

Search Manager

Minute Tracking Duration

CSM License Usage records with
duration in minutes. All items in
group must be met.

CSM License Usage.Duration
equals Minutes.

And

CSM License Usage.Status equals
Tracking.

Search Manager

Not Tracking CSM License Usage

CSM License Usage records with
a status of Not Tracking.

CSM License Usage.Status equals
Not Tracking.

Search Manager
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Saved Search Returns Executed From

Tracking CSM License Usage

CSM License Usage records with
a status of Tracking.

CSM License Usage.Status equals
Tracking.

Search Manager

Saved Searches for CSM License Usage Count

Numerous Saved Searches for CSM License Usage Count can be executed from the Search Manager
or Widgets.

Saved Search Returns Executed From

Available
Licenses

All available licenses for CSM License Usage Count.

CSM License Usage Count.License Type equals Available
Licenses.

Search
Manager,
Widgets

694

CSM mApp Solutions

CSM mApp Solutions



Saved Search Returns Executed From

Browser Client

CSM License Usage Count for the Browser Client.

CSM License Usage Count.License Type equals Browser Client.

Search
Manager,
Widgets

Copy of License
Used

CSM License Usage Count for a group of items. At lease one of
the items in the group must be true.

CSM License Usage Count.License Type equals Browser Client.

OR

CSM License Usage Count.License Type equals Mobile Client.

OR

CSM License Usage Count.License Type equals Outlook Plugin.

OR

CSM License Usage Count.License Type equals Portal License.

OR

CSM License Usage Count.License Type equals Reserved
License.

OR

CSM License Usage Count.License Type equals Rich Client.

Search
Manager,
Widgets

Dashboard
Viewer

CSM License Usage Count for the Dashboard Viewer.

CSM License Usage Count.License Type equals Dashboard
Viewer.

Search
Manager,
Widgets

License Used

CSM License Usage Count for Consumers License.

CSM License Usage Type.Category equals Consumers License.

Search
Manager,
Widgets

Mobile Client

CSM License Usage Count for Mobile Clients.

CSM License Usage Count.License Type equals Mobile Client.

Search
Manager,
Widgets

Non License
Logins

CSM License Usage Count for features that do not require a
license.
CSM License Usage Type.Category equals Non-License.

Search
Manager,
Widgets
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Saved Search Returns Executed From

Outlook Plugin

CSM License Usage Count for Outlook Plugin.

CSM License Usage Count.License Type equals Outlook Plugin.

Search
Manager,
Widgets

Portal License

CSM License Usage Count for the Portal.

CSM License Usage Count.License Type equals Portal Licenses.

Search
Manager,
Widgets

Portal Login

CSM License Usage Count for Portal Login.

CSM License Usage Count.License Type equals Available
Licenses.

Search
Manager,
Widgets

Report Viewer

CSM License Usage Count for Report Viewer.

CSM License Usage Count.License Type equals Available
Licenses.

Search
Manager,
Widgets

Reserved
License

CSM License Usage Count for Reserved Licenses.

CSM License Usage Count.License Type equals Available
Licenses.

Search
Manager,
Widgets

Rich Client

CSM License Usage Count for the CSM Desktop Client.

CSM License Usage Count.License Type equals Rich Client.

Search
Manager,
Widgets

Total Licenses

CSM License Usage Count for the Total Licenses.

CSM License Usage Count.License Type equals Total Licenses.

Search
Manager,
Widgets

Total User
Count

CSM License Usage Count for Total Users.

CSM License Usage Count.License Type equals Total User
Count.

Search
Manager,
Widgets

Used Licenses

CSM License Usage Count for Used Licenses.

CSM License Usage Count.License Type equals Used Licenses.

Search
Manager,
Widgets

Web Service

CSM License Usage Count for the Web Service.

CSM License Usage Count.License Type equals Web Service.

Search
Manager,
Widgets
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CSM License Usage Automation Processes
CSM License Usage includes the following Automation Processes.

Name Description

CSM License Usage
Tracking in Hours

When the status of a CSM License Usage record is Tracking, the process
waits until the defined frequency in hours is reached, and then initiates the
License Usage Count One-Step Action.

CSM License Usage
Tracking in Minutes

When the status of a CSM License Usage record is Tracking, the process
waits until the defined frequency in minutes is reached, and then initiates the
License Usage Count One-Step Action.
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Enterprise CI Types mApp Solution 1.0
The Enterprise CI Types mApp® Solution provides three new Configuration Item Major Business Objects.

Platform version requirements: Tested on CSM 10.1.0.

Content version requirements: Tested on CSM 10.1.0. This mApp Solution may also be compatible on
content versions that are older than CSM 10.1.0, but as with all mApp Solutions, be sure to test them on
your customized system.

Prerequisites: None.

Available languages:

• English

• French

• German

• Portuguese

• Spanish

Overview
The Enterprise CI Types mApp Solution provides three additional Configuration Item objects:

• Config - Application

• Config - Database

• Config - Storage

Key Features
Key features include:

• Three new commonly-requested CI types.

• New and updated CI searches to include the new CI types.

• Updated CMDB dashboard to include the new CI types.

Apply the mApp Solution
Follow these steps to download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.
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3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM. Do not
select Finish yet.

4. Several items are overwritten when applying the Enterprise CI Types mApp Solution:
◦ Dashboards

◦ Global > Dashboards > Default Dashboards >CMDB

◦ Global > Executive Dashboard Pack > Risk

◦ Stored Queries
◦ Configuration Item > Global > Hardware

◦ Configuration Item > Global > Hardware with Manufacturer

◦ Configuration Item > Global > Software

◦ Visualizations
◦ Global >Configuration Items

◦ Widgets
◦ Global > Default Dashboard Widgets > New CIs (name change to All CIs)

◦ Global > Executive Dashboard Widgets > Events and CIs by Time

Choose which items to overwrite.
a. At the Amount of User Interaction wizard screen select Ask me about every decision.

b. Select Next until you reach the Dashboards and Widgets screen. Select Don't change for
any items you don't want to overwrite. Select Next.

c. Perform the same steps in the Miscellaneous Objects screen.

5. Still in the Apply mApp Wizard, when you reach the Final Options window, select Open a Blueprint
so that I can preview the changes, and then select Finish.

6. When the Blueprint opens, select File > Blueprint changes.

7. Save and publish the Blueprint.

Revision History

mApp Solution
Version

Platform Version
Requirements

Content Version
Requirements Prerequisites Version/Release Notes

1.0 10.1.0 10.1.0 None
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Configure Enterprise CI Types
Edit the summary forms and set view permissions for the enterprise CI types before deploying them on
your system.
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Edit Enterprise CI Summary Forms
After you apply the Enterprise CI Types mApp® Solution, edit the summary forms for the Business
Objects that use the new CI types.

Edit the form arrangements for the following objects:

• Incident

• Problem

• Change

• Internal Customer

• Service

• Supplier

• Existing Configuration Items

In the form arrangement for each object, there is a Configuration Items tab or a Related CIs tab. Some
Configuration Item objects also have tabs for Upstream CIs, Downstream CIs, and Other CIs.

To set the summary forms:

1. In CSM Administrator, create a new Blueprint after applying the mApp Solution. For each new CI
object:

2. Edit the form arrangement.
3. Right-click on a CI tab (there can be more than one on some objects) and select Properties.
4. Select the Tab Contents page. In the Default Form field, select Specific Form.
5. Select the ellipsis button next to the Default Form field. Select the summary form for each of the

new Configuration Item objects.
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Set View Permissions for Enterprise CI Types
Set view permissions for each of the enterprise Configuration Item objects for your CSM Portal security
groups (typically Portal Customer and Portal Workgroup Manager).

To set view permissions:

1. In CSM Administrator, select Security > Edit security groups.
2. Select the appropriate security group.
3. Select the Business Objects tab.
4. Select the Config - Application object and select the View check box under General.
5. Select New Field under the object and select View.
6. Repeat steps 4—5 for the Config - Database and Config - Storage objects and save.
7. Repeat steps 2—6 for any other CSM Portal security groups you want to update.
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Enterprise CI Types mApp Solution Items
This table provides a list of Business Objects and associated items that are included when you apply the
Enterprise CI Types mApp Solution.

Table 1. mApp Solution Items

Item Category Item Typical Merge Action

Major Business Objects
Configuration Item, Configuration -
Database, Configuration - Storage,
Configuration - Application

Merge

Lookup Tables
CI Environment, CI Instance Type Merge

CI Asset Type, CI Status, CI Status
List, Configuration Item Type Import data

Dashboards CMDB, Risk Overwrite

Widgets

All CIs, Events and CIS by Time Overwrite

Applications in CMDB, Databases in
CMDB, Storage Devices in CMDB,
New CMDB-Applications in CMDB,
New CMDB-Databases in CMDB,
New CMDB-Storage Devices in
CMDB

Import

Stored Queries

All Config - Applications, All Config -
Database, All Config - Storage Import

Hardware, Hardware with
Manufacturer, Software Overwrite

Visualizations Configuration Items Overwrite
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Machine Learning mApp Solution 1.0
The Machine Learning mApp Solution contains a machine learning demonstration scenario. It uses a
machine learning model to predict an Incident's Service Classification based on its description.

Platform Version Requirements: Tested on CSM 10.2.0.

Out-of-the-Box Content Version Requirements: Tested on CSM 10.2.0.

How the mApp Solution Works
The Machine Learning mApp Solution contains a demonstration of a machine learning model. The
demonstration uses a machine learning model to predict the Service Classification of an Incident based
on the Incident description.

Users (often first-level service technicians) enter an Incident description and let the machine learning
model predict the Service Classification. Machine learning subject matter experts (SMEs) use the
included Machine Learning dashboard to review the predications to verify their accuracy, providing a new
Service Classification if necessary. This information is used to continuously train the machine learning
model.

Download the mApp Solution from the Cherwell mApp Exchange. Use the Apply mApp Wizard to apply
the mApp Solution to your CSM system. The Apply mApp Wizard generates a Blueprint, which can then
be viewed and published to a test or live system to commit the changes.

For a list of items included in the Machine Learning mApp Solution, see Machine Learning mApp Solution
Items.

Apply the mApp Solution
Download file: machine-learning.mApp. If you want a reference system to see how everything works, we
have provided a data .mApp file that will replace all Incident, category, subcategory, and service data with
demo data, which can be used to train a demo system.

To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.
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Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.0 10.2.0

10.2.0. This mApp
Solution may not be
compatible on Content
versions older than
10.2.0, but as with all
mApp Solutions, it should
be tested on your
customized system.
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How the Machine Learning mApp Solution Works
The Machine Learning mApp Solution contains a machine learning model along with supporting
expressions, fields, and a scheduled item designed to predict an Incident's Service Classification based
on its description.

This mApp Solution covers this primary use case:

• Allow organizations to begin automating Incident workflows by having a Service Classification
(Service, Category, and Subcategory) automatically assigned based on keywords entered into the
Incident's description field.

When users or customers enter an Incident description, the machine learning model analyzes the entry
and predicts a service, category, and subcategory, which gives the Service Classification. The prediction
is assigned a confidence level. Machine learning subject matter experts (SMEs) can review the Service
Classification predictions and verify the prediction or provide an updated classification. After a SME
confirms or reclassifies, the prediction confidence is set to 100%. The machine learning model will train on
all Service Classifications with a confidence of 95% or higher.

You may prefer to adjust how the machine learning model trains. Some ideas to consider:

• Exclude Service Classifications that have not been verified.

• Adjust the confidence threshold for training.

This mApp Solution includes:

• A machine learning model.

• A scheduled item that will run at certain intervals to perform the training.

• A supplemental Incident form containing fields for use in the main Incident form.

• One-Step™ Actions associated with the form fields.

• A dashboard the machine learning SMEs will use to verify the Service Classification predictions.

A separate .mApp file with training data is also available (machine-learning-data.mApp). Apply the
data .mApp file after the main Machine Learning mApp Solution. Only install the data .mApp file on a
separate demonstration environment, not your production system. Use your own data to train your
production system.

For a list of items included in the Machine Learning mApp Solution, see Machine Learning mApp Solution
Items.
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Configure the Machine Learning Service
Classification Prediction

The Machine Learning mApp® Solution contains a machine learning model, supplemental Incident form,
expressions, scheduled item, and associated One-Step™ Actions.

To configure the Machine Learning mApp Solution:

1. Determine who in your organization will act as machine learning subject matter experts (SMEs) for
reviewing the service classification predictions. This could be higher-level service technicians or
managers.

2. Place the Verify Incident Confidence, Reclassify Incident for Confidence, and Re-Predict
Classification links on your Incident Overview form. These fields are available in the Machine
Learning Supplemental form included with the mApp Solution file.

3. Set view and execute permissions for the Verify Incident Confidence and Reclassify Incident for
Confidence links on the Incident form.

4. Set view permissions for the Machine Learning dashboard.
5. Publish the .mApp Blueprint.

Create a Scheduled Item to run the machine learning model.

6. Set up the Scheduled Item. For detailed instructions on Scheduled Items, see Create a Scheduled
Item.

a. Provide general and schedule information for the Scheduled Item.
b. On the Action page, select Train Machine Learning from the Action menu.
c. Select the ellipsis button by the Machine Learning Training Configuration field to open the

Machine Learning Manager.
d. In the Association field, select Incident.
e. Double-click the Incident Subcategory machine learning model.
f. For the Training Query, select Total Incidents and Requests with High Confidence

(Global > Machine Learning).

Note: Before you run the first training scenario, review outstanding tickets to classify
them as high confidence or add a condition to the search to include any items you
want in the training group.

The configuration details autopopulate.
7. Allow the included Scheduled Item to run.

Note: Let the Scheduled Item run as scheduled; running it by using the Test button in the
Scheduled Item Manager won't work.
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Use the Machine Learning Service Classification
Prediction

The Service Classification machine learning model uses the first entry in the Description field to predict a
service, category, and subcategory for the Incident.

1. When you create an Incident record, don't select a service category and subcategory. Instead, enter
a concise description in the Description field and press tab.

2. The machine learning model included with this mApp® Solution will generate its best guess at a
Service Classification. If the Service Classification makes sense, move on to the rest of the Incident
record. If it isn't correct, you can:

◦ Change the Service Classification if it's incorrect. You can manually change the Service
Classification or SMEs can use the Reclassify Incident for Confidence link.

◦ Enter more details in the Description field, then select Re-Predict Classification to trigger
the machine learning model to run again.
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Machine Learning Dashboard
The Machine Learning dashboard provides an area for machine learning subject matter experts (SMEs) to
verify predictions, as well as other metrics related to the machine learning model.

The Machine Learning dashboard has an area for tickets with a low confidence categorization and tickets
needing review to help you review predictions.

1. Select Set Confidence Score Thresholds to adjust Tickets with High Confidence and Tickets with
Low Confidence widgets. The values should be between 0 and 1.

2. The low confidence threshold determines which Incidents appear in the Low Confidence
Categorization grid.

3. The Incidents in the Needs Review grid have not had their Service Classification verified.
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Verify the Machine Learning Service Classification
Prediction

SMEs can review the Machine Learning dashboard to verify and update the machine learning model's
Service Classification predictions. This verification process increases the model's future accuracy.

To verify the Service Classification prediction:

1. Access the Machine Learning dashboard.
2. Review the accuracy of the Service Classification for each Incident.

◦ If the Service Classification is correct, right-click the Incident and select Actions > Verify
Incident Confidence.

◦ If the Service Classification is incorrect, select the Incident to open the Incident record.
Choose an new Service Classification.

You can also review Service Classification predictions by accessing each Incident record.

When a SME manually sets the Service Classification, the confidence for that particular Incident is set to
100%. The machine learning model continues to train itself based on these corrections, along with any
other Incidents with a confidence rating of 95% or higher.
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Machine Learning mApp Solution Items
These are the items included in this Machine Learning mApp Solution.

Item Category Item Typical Merge Action

Business Object Incident Merge

Fields

Incident.Subcategory

Overwrite

Incident.Subcategory ID

Incident.Service

Incident.Category

(new) Incident.Confidence

(new) Incident.Reclassified ML

(new) Incident.Confidence Level Verified

(new) Incident.Priority Matrix Element
RecID

(new) Incident.Original Confidence

ML Review Datetime Import

Expressions

(Incident) Global > Machine Learning - ML
Confidence

Overwrite

(Incident) Global > Machine Learning -
ML Prediction

(None) Global > Machine Learning -
Average Incidents and Request
Confidence Level

(None) Global > Machine Learning -
Percent of Reclassified Incidents and
Requests

One-Step™ Actions

Verify Incident Classification

OverwriteReclassify for Confidence

Re-Predict Classification

Forms Supplemental Machine Learning Overwrite

Dashboards Machine Learning Overwrite
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Metrics

Reviewed ML Confidence Average

Overwrite

Unreviewed ML Confidence Average

Total Incidents and Requests Categorized
by ML

Total Incidents and Requests Reclassified

Total Incidents and Requests Reviewed
This Week

Total Incidents and Requests Reviewed
Today

Total Incidents and Requests with High
Confidence

Total Incidents and Requests with Low
Confidence

Widgets

Incidents and Service Requests with Low
Confidence

OverwriteNeeds Review

Reclassified Categories

Machine Learning Model Incident Subcategory (feel free to rename) Overwrite

Searches

Total Incidents and Requests Categorized
by ML

Overwrite

Total Incidents and Requests Needing ML
Review

Total Incidents and Requests Reclassified

Total Incidents and Requests Reviewed

Total Incidents and Requests Reviewed
This Week

Total Incidents and Requests Reviewed
Today

Total Incidents and Requests with High
Confidence

Total Incidents and Requests with Low
Confidence

Actions

Incident - Context Menu - Verify
Classification (Set Confidence to 1 one-
step)

Incident - Context Menu - Reclassify for
Confidence (Reclassify for Confidence )

Grids Machine Learning Overwrite
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• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution includes
the definition for informational purposes only (the definition is not imported into the target system).
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Survey mApp Solution 3.1
Use the Survey mApp® Solution to create customer surveys for an Incident.

Platform version requirements: Tested on CSM 9.5.2 and 10.2.0.

Content version requirements: Tested on CSM 9.5.2 and 10.0.0; this mApp Solution may or may not be
compatible on content versions earlier than 9.5.2, but as with all mApp Solutions, be sure to test it on your
customized system.

Prerequisites: None.

Overview
The surveys consist of five scored questions and two short answer questions. The survey originates after
an Incident is closed. The Incident customer (the survey taker) completes the survey in the CSM Portal.
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Apply the mApp Solution
Follow these steps to download and apply the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

For a list of items included in the mApp Solution, see Survey mApp Solution Items.
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Configure the mApp Solution
Follow these steps to configure the mApp Solution:

1. Update foreign keys.

2. Set up and configure email accounts.

3. Configure URLs for the Cherwell Browser applications.

Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

2.0 5.0.0 or later. None. None.

3.0 9.5.2 and 9.6.x.

Tested on 9.5.2 and 9.6.1.
This mApp Solution may
not be compatible on
Content versions earlier
than 9.2.0, but as with all
mApp Solutions, it should
be tested on your
customized system.

None.

3.1 Tested on 9.5.2 and
10.2.0.

Tested on 9.5.2 and 10.0.0;
this mApp Solution may or
may not be compatible on
content versions earlier
than 9.5.2, but as with all
mApp Solutions, be sure to
test it on your customized
system.

None.

Related concepts
About Forms
About mApp Solutions
Update Foreign Keys
Set Up and Configure Email Accounts
Create a Customer Survey
Take a Customer Survey
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Update Foreign Keys
In CSM OOTB version 9.6.0, foreign keys do not automatically update when you publish a Blueprint. After
applying the Survey mApp Solution, you will need to update foreign keys.

To update foreign keys:

1. Create a new Blueprint.

2. Save the Blueprint and note where you saved it because you will need to reference the file path
when running the command-line argument.

3. Use the command-window to publish the Blueprint, adding in the command option to update foreign
keys (see example below).

Example:

Trebuchet.CommandLineConfigure.exe /publish
/blueprint="C\..." /connection="[Common]Cherwell Browser"
/connectionuserid=User ID /connectionpassword=password /scanblueprint=false
/createrollback=false /updateforeignkeys=true

Related concepts
Publish a Blueprint
Command-Line Configuration (CLC) Options
Related tasks
Create a Blueprint
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Set Up and Configure Email Accounts
In CSM OOTB version 9.5.2 – 9.5.3, the email templates do not work properly with the default User
account. After applying the mApp Solution, you will need to complete the following configurations: set up
and configure the email accounts, configure the URLs for the Cherwell Browser applications, and edit the
One-Step Actions.

Set Up and Configure Email Accounts
To set up and configure the email accounts:

1. Set up a global or personal email account. This email will be used when editing the One-Step
Actions below.

2. Configure the test receiver and sender email accounts. This must be done for all languages.

Configure URLs for Cherwell Browser Applications
To configure the URLs for the Browser applications:

• Set the URLs for the Browser applications (Portal for Customers; Browser Client for Users).

Edit One-Step Actions
To edit the One-Step Actions:

1. Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to edit the Incident
Form.

2. Open the One-Step Actions Manager.
a. From the Association drop-down list, select Incident.
b. From the Manager tree, expand the Global folder and select the Buttons folder.

c. Right-click Create and Send Survey and select Edit.
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The One-Step Editor opens.

d. Select the Send Survey Email Action.

e. From the Send via drop-down list, select the global or personal email that was set up.

f. Select OK to save the One-Step Action.

3. From the Association drop-down list, select Survey Template
a. Right-click Satisfactory Threshold Notification and select Edit. The One-Step Editor opens.

b. Select the Send an e-mail Action.

c. From the Send via drop-down list, select the global or personal email that was set up.

d. Select OK to save the One-Step Action.

e. Right-click Unsatisfactory Threshold Notification and select Edit.
f. Follow steps b — d above.

4. Select Close.

5. Save and publish the Blueprint.

Related concepts
Configure a Personal Email Account
Configure Test and Production Accounts
Open the Object Manager
Save a Blueprint
Related tasks
Configure a Global Email Account
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Create a Customer Survey
Use the Survey Template Form to create a Customer Survey.

Create a Customer Survey
To create a Customer Survey:

1. On the CSM Desktop Client toolbar, select New > New Survey Template.

2. Complete the Design (External) section of the Survey Form:
a. Survey Title: Provide a title (example: Customer Satisfaction Survey).

b. Survey Instructions: Provide instructions.

c. Scaled Questions:
◦ Questions 1 — 5: Provide a scaled question (example: Rate the overall timeliness of the

technician).

d. Short Answer Questions:
◦ Questions 1 — 2: Provide an open-ended question (example: How can we improve our

services?).

3. Complete the Classification (Internal) section of the Survey Form:
a. Survey Type: Select a Survey Type from the drop-down list.
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Note: Customer Satisfaction is the only available survey option. Use Table
Management (CSM>Tools>Table Management) to add additional survey types to the
drop-down list.

b. Description: Provide a description for the Survey Template (example: This survey is intended
to determine technician performance and overall Customer satisfaction).

c. Satisfactory Threshold: Provide a number value that indicates a satisfactory rating (example:
On a scale of 1 to 5 with a score of 5 being the highest, a satisfactory score might be a 4).

d. Warn owner when average score falls below threshold: Select this check box to send an email
notification to the Survey owner if a survey score is less than the defined satisfactory
threshold.

e. Unsatisfactory Threshold: Provide a number value that indicates an unsatisfactory rating
(example: On a scale of 1 to 5 with a score of 5 being the highest, an unsatisfactory score
might be a 2.5).

f. Warn owner when average score falls below threshold: Select this check box to send an email
notification to the Survey owner if a survey score is less than the defined unsatisfactory
threshold.

4. Select the Set as the Default Satisfaction Survey link in the Actions section to make the current
survey the default survey. This must be done for all languages.

5. Select Close.

6. Select the Next: Begin Planning to move the status to publish.

7. Select the Next: Publish to publish the Form.

8. Select Save.
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Take a Customer Survey
The survey consists of five scored questions and two short answer questions. The survey originates after
an Incident is closed. The Incident Customer (the survey taker) completes the survey in the Customer
Portal.

To take a Customer Survey:

1. Select the Take Survey link (the link will be sent via email).

Tip: If you receive an error after selecting the survey link, sign in to the Customer Portal first
and then select the survey link.

2. Answer the questions.

3. Select Submit.
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Survey mApp Solution Items
The mApp Solution includes the following items:

Item Category Item
Typical
Merge
Action

Automated
Processes

Satisfactory Threshold Notification, Send Survey, Unsatisfactory
Threshold, Update Survey Template Average Score Import

Business
Objects  

Survey, Survey (group member of Survey Element), Survey (Portal
Default view), Survey Answer, Survey Element, Survey Template,
Survey Template Status, Survey Type

Import

Customer, Customer - Internal, Incident Merge

Counter Survey Template ID Import

Custom View Portal Default Don't
Change

Dashboard Surveys Import
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Fields

Questions Import/
Overwrite

Allow Anonymous, Alt 1 Command, Alt 1 Command Name, Alt 1
Status, Alt 1 Status Text, Alt 1 Status Text_de-DE, Alt 1 Status
Text_en-US, Alt 1 Status Text_es-ES, Alt 1 Status Text_fr-FR, Alt 1
Status Text_pt-BR, Alt 2 Command, Alt 2 Command Name, Alt 2
Status, Alt 2 Status Text, Alt 2 Status Text_de-DE, Alt 2 Status
Text_en-US, Alt 2 Status Text_es-ES, Alt 2 Status Text_fr-FR, Alt 2
Status Text_pt-BR, Anonymous, Answer, Answer_de-DE,
Answer_en-US, Answer_es-ES, Answer Five, Answer Four,
Answer_fr-FR, Answer One, Answer_pt-BR, Answer Seven, Answer
Six, Answer Three, Answer Two, Average Score, Company Code,
Company ID, Company Name, Completed Date Time, Completion
Action Command, Created By, Created By ID, Created Culture,
Created Date Time, Date Time Completed, Description, Design
Display, Last Completed Survey Date, Last Modified By, Last
Modified By ID, Last Modified Date Time, LastModTimeStamp, Last
Survey Date, Last Survey Score, Next Status, Next Status Command,
Next Status Command Name, Next Status Text, Next Status Text_de-
DE, Next Status Text_en-US, Next Status Text_es-ES, Next Status
Text_fr-FR, Next Status Text_pt-BR, Number of Scored Questions,
Owned By, Owned By Email, Owned By ID, Owned By Team, Parent
RecID, Parent TypeID, Question Five, Question Five Score, Question
Four, Question Four Score, Question One, Question One Score,
Question Seven, Question Six, Question Three, Question Three
Score, Question Two, Question Two Score, RecID, Review Mode,
Satisfactory Threshold, Satisfactory Threshold Notified, Satisfactory
Warning, Score, Status, Status ID, Status order, Status_de-DE,
Status_en-US, Status_es-ES, Status_fr-FR, Status_pt-BR, Survey ID,
Survey Instructions, Survey Taker, Survey Taker ID, Survey Taker
Type ID, Survey Template ID, Survey Title, SurveyElement Type ID,
SurveyElement Type Name, Survey Title, Survey Type, Survey
Type_de-DE, Survey Type_en-US, Survey Type_es-ES, Survey
Type_fr-FR, Survey Type_pt-BR Technician, Technician Avatar,
Technician Email, Technician ID, Technician Phone, Technician Team,
Technician Team ID, temp_status_set, Template Locked,
Unsatisfactory Threshold, Unsatisfactory Threshold Notified,
Unsatisfactory Warning, Welcome Text

Import

Form
Arrangement Survey Template Import

Forms
Survey, Survey Answer, Survey Overview, Survey Summary, Survey
Template, Survey Template Status, Survey Template Summary,
Survey Type

Import

Grids Survey, Survey Answer, Survey Element, Survey Template, Survey
Template Status, Survey Type Import

Image editor_24_blue_form Don't
Change
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Index

Customer_Department, Customer_Email, Customer_Full,
Customer_Phone, Customer_TypeID_SAMAccountName,
Customer_VIP, Incident_IncidentType, Incident_IncidentType,
Incident_OwnedByID, Incident_RecID, IncidentCreatedDT, IncidentID,
IncidentIdx_ServiceCartRecID,
IncidentIdx_ServiceCatalogTemplateRecId, IncidentService,
IncidentStatus, PK_Customer

Overwrite

PK_SurveyAnswer, PK_SurveyElement, PK_SurveyTemplateStatus,
PK_SurveyType, Survey_SurveyTitle, SurveyElementIdx0,
SurveyElementIdx1, SurveyElementIdx2,
SurveyTemplate_SurveyTitle, SurveyTemplateIdx0,
SurveyTemplateIdx1, SurveyTemplateStatusIdx0

Import

Lookup Tables Survey Template Status, Survey Answer, Survey Type Import

Mergeable Area Survey Actions Overwrite

Metric Values Completed Surveys, Completed Surveys Percentage, Total Surveys Import

One-Step
Actions

Assign to Individual, Assign to Team, Create and Send Survey, Delete
Survey, Follow up with Customer, Follow up with Technician, Go To
Incident, Go To Survey, Next Status, Publish, Retire, Satisfactory
Threshold Notification, Set Default, Set Lock, Submit, Take
Ownership, Unsatisfactory Threshold Notification, Update Survey
Template Score

Import

Relationships

Customer Owns Surveys, Incident Owns Surveys, Survey Owned By
Customer, Survey Owned By Incident, Survey Owned By Survey
Template, Survey Template Links to Status, Survey Template Links
UserInfo, Survey Template Owns Survey

Import

Customer Group Links Customer Status, Customer is on CAB,
Customer links SLA, Customer Owns Password Reset Form,
Customers Have History, Customers use CIs, Customers Have
Incidents

Don't
Change

Searches All Surveys, Current Satisfaction Surveys, Customer Satisfaction
Surveys, Unsatisfactory Customer Satisfaction Surveys Import

Stored
Expressions

Average Score, Hyperlink to CSM Browser Client, Hyperlink to CSM
Desktop Client, Last 30 Days, Last 7 Days, Number of Scored
Questions, Question Five Visibility, Question Four Visibility, Question
One Visibility, Question Seven Visibility, Question Six Visibility,
Question Three Visibility, Question Two Visibility, Score, Scored
Questions, Survey Taker, Survey Taker ID, Survey Template ID,
Technician ID, Technician Team

Import

Stored Value Default Survey Template ID Import

Survey Actions Automatic Actions>Save Actions Import/
Overwrite

Theme Prussian Blue Don't
Change
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Widgets

Completed Surveys, Percent Complete, Satisfactory Survey, Survey
Avg Score-Difficulty, Survey Avg Score-Overall Service, Survey Avg
Score-Recommend, Survey Avg Score - Skill Knowledge, Survey Avg
Score-Timeliness, Survey Date Filter, Unsatisfactory Survey, WB-
Average Survey Score

Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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Walk-Up Support mApp Solution 1.0
Use the Walk-Up Support mApp® Solution to offer customers another venue for getting technical
assistance.

Cherwell Version Requirements:10.0.0

Out-of-the-Box Content Version Requirements: Tested on 10.0.0. This mApp Solution may not be
compatible on Content versions older than 10.0.0, but as with all mApp Solutions, it should be tested on
your customized system.

Prerequisites: None

Overview
The Walk-Up Support mApp Solution enables your IT organization to handle customer requests directly
from a physical walk-up support location. Customers can approach your walk-up support locations and
instantly obtain support for basic issues.

Walk-up support is a concierge-style of technical support where a customer can walk up to a desk or
kiosk to get in-person, real-time support. Customers can check in and provide a short description of their
issue. They enter a queue and are called on as support specialists become available. The support
specialist resolves the problem, provides the customer with information on how to resolve, or escalates
the ticket.

How the mApp Solution Works
CSM provides Walk-Up Support as a mApp Solution so that users can easily incorporate real-time remote
support sessions into their existing system. Download the mApp Solution from the Cherwell mApp
Exchange. Use the Apply mApp wizard to apply the mApp Solution to your CSM system. The Apply mApp
Solution wizard generates a Blueprint, which can then be viewed and published to a test or live system to
commit the changes.

For a list of items included in the mApp Solution, see Walk-Up Support mApp Solution Items.

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution
After applying the mApp Solution, perform the following high-level steps to configure the mApp Solution:
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1. Configure Security Groups.

2. Enable a Portal site for Walk-Up Support.

3. Create a Walk-Up Support location.

Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.0 10.0.0

Tested on 10.0.0. This
mApp Solution may not be
compatible on Content
versions older than
10.0.0, but as with all
mApp Solutions, it should
be tested on your
customized system.

None
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Configure the Walk-Up Support
Configure the Walk-Up Support mApp Solution using CSM Desktop Client or CSM Browser Client.

Note: This functionality is only available after applying the Walk-Up Support mApp Solution.

1. In the Business Objects tab of the Security Groups Manager, ensure the Portal Workgroup Manager
Security Group allows edit rights on the Incident Business Object for the following fields:

◦ Customer Display Name
◦ Customer ID
◦ Call Source
◦ Status

2. In the Rights tab of the Security Groups Manager, select Anonymous Browser from the Group
drop-down menu for the following groups:

◦ Anonymous Browser
◦ Portal Customer
◦ Portal Workgroup Manager

3. Choose Sites from the Category drop-down menu.
4. For the WalkUpSupport Site, ensure the View check box is selected and the Use default check box

is cleared.
5. Repeat Steps 2—4 for the Portal Customer and Portal Workgroup Manager Groups.
6. Ensure you have a default team defined for all users.
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Enable a Walk-Up Support Portal Site
Customize a Walk-Up Support Portal site your customers will use to interact with your Walk-Up Support
locations.

Note: This functionality is only available after applying the Walk-Up Support mApp Solution.

The Walk-Up Support mApp Solution includes two Walk-Up Support sites that you can customize, or you
can create your own.

To enable a site for Walk-Up Support:

1. Select the Enable Walk-Up Support check box on a Site record.
2. Save the Site record.
3. Select the Add New Walk-Up Support Location link under Actions.

Note: You can also create a new Walk-Up Support location by selecting New > New Walk-
Up Support Location.

4. Provide a Walk-Up Support Location name and site name.
5. You can associate the Walk-Up Support Location with a Building, add a description, and assign it to

a team and/or individual.
6. In the Status Area, select Next: Active to activate the Walk-Up Support Location.
7. Set up the device (a workstation or tablet) you will use for the Walk-Up location:

a. Log into the IT portal.
b. Switch the Site to Walk-Up Support or Walk-Up Support 1 via the Sites menu.
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Use a Walk-Up Support Portal Site
Customers enter support requests at Walk-Up Support locations, and users manage the tickets using
Dashboards.

Note: This functionality is only available after applying the Walk-Up Support mApp Solution.

To create an Incident on a Walk-Up Support site:

1. Log into the Portal and select Walk-Up Support from the Site Selector.
The Walk-Up Support site displays. A Widget shows the current support queue.

2. Customers who need Walk-Up Support assistance select the Start Here button.
A dialog with issue types appears.

3. The customer selects an issue type from the pop-up dialog.
4. The customer selects their name from the drop-down menu.

An Incident is opened for the customer. A pop-up window appears telling the customer their queue
position and average wait time (automatically calculated by the mApp Solution.

Users can manage tickets through the Walk-Up Support Dashboard.
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Walk-Up Support mApp Solution Items
The Items table provides a list of items included when applying the mApp Solution and the typical merge
action.

These are the items included in this mApp Solution:

Item Category Item Typical Merge Action

Business Object

Building, Incident, Site Merge

Walk-Up Support Hours of Operation, Walk-Up Support
Location, Walk-Up Support Location Away Reason,
Walk-Up Support Location Days, Walk-Up Support
Location Status

Overwrite

Custom View Walk-Up Support Don't Change

Dashboard Home, Walk-Up Queue, Walk-Up Support, Welcome Overwrite

Field

Picked Up Date/Time, Wait Time, Walk-Up Support
Location, Enable Walk Up Support, Close Time, Created
By, Created By ID, Created Culture, Created Date Time,
Day, Last Modified By, Last Modified By ID, Last
Modified Date Time, OpenTime, Order Day, RecID,
Walk-Up Location ID, Away, Away Reason, Building ID,
Building Name, Created By, Created By ID, Created
Culture, Created Date Time, Description, Last Modified
By, Last Modified By ID, Last Modified Date Time,
LastModTimeStamp, Name, Owned By, Owned By ID,
Owned By Team, Owned By Team ID, RecID, Site ID,
Site Name, Status, Status ID, Away Reason, Created
By, Created By ID, Created Culture, Created Date Time,
Last Modified By, Last Modified By ID, Last Modified
Date Time, Order Reason, RecID, Created By, Created
By ID, Created Culture, Created Date Time, Day, Last
Modified By, Last Modified By ID, Last Modified Date
Time, Order Day, RecID, Alt 1 Command, Alt 1
Command Name, Alt 1 Status, Alt 1 Status Text, Alt 2
Command, Alt 2 Command Name, Alt 2 Status, Alt 2
Status Text, Created By, Created By ID, Created
Culture, Created Date Time, Description, Last Modified
By, Last Modified By ID, Last Modified Date Time, Next
Status, Next Status Command, Next Status Command
Name, Next Status Text, RecID, Status, Picked Up Date/
Time, Priority, Smart Classify Search String, Wait Time,
Walk-Up Support Location

Overwrite

Form

Site Overview New, WalkUpLocationHoursOfOperation,
Walk Up Location Overview, WalkUpLocation Summary,
WalkUpSupport, WalkUpSupportAwayReason,
WalkUpLocationDays, WalkUpLocationStatus, Walk Up
Support,

Import

Walk Up Support Fields Don't Change
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Form Arrangement FacilitiesBuilding, Site, WalkUpLocation Overwrite

Grid

WalkUpLocationHoursOfOperation, WalkUpSupport,
WalkUpSupportAwayReason, WalkUpLocationDays,
WalkUpLocationStatus,

Overwite

Walk-Up Support Don't change

Image Definition
blue-purple-gradient-button, Gradient-Blue-Button,
Happy-Girl, Orange-BG, Purple-gradient-upper-right,
walk-up-support-art,

Overwrite

Index

BuildingStatus, FacilitiesBuilding_RegionCode,
PK_FacilitiesBuilding, Incident_CustomerID,
Incident_IncidentType, Incident_OwnedByID,
Incident_RecID, IncidentCreatedDT, IncidentID,
IncidentIdx_ServiceCartRecID,
IncidentIdx_ServiceCatalogTemplateRecID,
IncidentService, IncidentStatus, PK_Site, Site_Name,
Site_SiteID, SiteStatus, Incident_CustomerID,
Incident_IncidentType, Incident_OwnedByID,
Incident_RecID, IncidentCreatedDT, IncidentID,
IncidentIdx_ServiceCartRecID,
IncidentIdx_ServiceCatalogTemplateRecID,
IncidentService, IncidentStatus

Import

PK_WalkUpLocationHoursOfOperation,
WalkUpLocationHoursOfOperationIdx0,
PK_WalkUpSupport, WalkUpSupportLocationIdx0,
PK_WalkUpSupportAwayReason,
PK_WalkUpLocationDays, PK_WalkUpLocationStatus

Overwrite

Meetric Value Available Walk-Up Support Overwrite

One-Step Action

Alt 1 Status from Relationship, Assign to Individual,
Assign to Me, Assign to Team, Create New Walk-Up
Support Location, Next Step from Relationship, Submit
Walk Up Issue, Take Ownership, Walk Up Issue
Abandoned

Overwrite

Relationship

Building Links Walk-Up Support Location, Incident Links
In Progress Walk Up Issues, Incident Links Opened
Walk Up Issues, Site Links Walk-Up Support Location,
WalkUp Location Hours of Operation Owned By Walk-
Up Location, Walk-Up Location Owns Walk-Up Location
Hours of Operations, Walk-Up Support Location Links
Building, Walk-Up Support Location Links Owned By,
Walk-Up Support Location Links Site, Walk-Up Support
Location Links Status

Overwrite

Search All Open Walk Up Support Cases, All Walk-Up Support
Locations Overwrite

Site Walk-Up Support, Walk-Up Support 1 Overwrite
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Tab
Walk-Up Support Location (0), Buildings (0), Building,
Overview, Site Overwrite

Overview, Site Don't Change

Theme Walk-Up Support Overwrite

Widget

Available Walk-Up Support Cases, Average Wait Time
(Minutes), Average Walk-Up Support Resolution Time
(Minutes), Closed Walk-Up Support Cases by Site (Last
30 days), Closed Walk-Up Support Cases Today, Open
Walk-Up Support Cases, Open Walk-Up Support Cases
by Site, Total Cases by Walk-Up Support Location, Walk-
Up Support by Location, Walk-Up Support Cases Closed
in the Last 30 Days, Walk-Up Support Queue

Overwrite

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution includes the
definition for informational purposes only (the definition is not imported into the target system).
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Cherwell Labs mApp Solutions
A Cherwell Labs mApp® Solution is intended to showcase experimental or beta-level content features in CSM.
Functionality, testing, and documentation are limited or incomplete. Cherwell support is not provided for these
mApp Solutions, so install them at your own risk on a test environment before installing on a production
system.
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Automatic Incident Escalation mApp Solution 1.0
The Automatic Incident Escalation mApp® Solution provides functionality that allows you to automatically
assign an Incident to a Team (based on Service Categorization) and to quickly escalate an Incident to
another Team, if necessary.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 5.0.0.

Out-of-the-Box Content Version Requirements: Tested on CSM 5.0.0.

Prerequisite Requirements: None

Overview
CSM integrates with Automatic Incident Escalation so that you can incorporate additional automation into
your system. The mApp Solution uses fields from the Incident Subcategory Lookup Table (Default Team,
Level 2 Escalation Team, Level 3 Escalation Team) to determine which Team the Incident should be
assigned to by default and which Team the Incident should be assigned to if escalated. If the Service has
an OLA, the mApp Solution automatically assigns the OLA Team to the third-level escalation team. After
the mApp Solution is configured, the Team field in the Ownership section populates when the Service,
Category, and Subcategory fields are populated. Users can then escalate the Incident by clicking a button
in the Task Pane, and then notifying the new Team using a Task. For more information, see Service
Categorization.
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This mApp Solution includes multiple features, including One-Step Actions (example: Escalation to Level
2 and 3) and Fields (Level 2 Escalation Complete, Level 3 Escalation Team, etc.).

How the mApp Solution Works
CSM provides Automatic Incident Escalation functionality as a mApp Solution so that Users can easily
incorporate automation into their existing CSM system. Download the mApp Solution from the Cherwell
mApp Exchange. Use the Apply mApp wizard to apply the mApp Solution to your CSM system. The Apply
mApp Solution wizard generates a Blueprint, which can then be viewed and published to a test or Live
system to commit the changes.

The mApp Solution includes the following items:

Item Category Item Typical Merge
Action

Business Object

 

Incident, Incident SubCategory Merge

Service, Task Don't Change

One-Step Action Escalation to Level 2 and 3 Import

Field

 

Default team, Level 2 Escalation Complete, Level 2
Escalation team, Level 3 Escalation Complete,
Level 3 Escalation Team

Import

Owned By Team Overwrite
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Relationship

 

Incident Links Incident Subcategory Overwrite

Incident Owns Tasks Don't Change

Index IncidentSubcategory_Subcategory,
IncidentSubCategoryId, PK_IncidentSubCateory Overwrite

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About Incidents and Service Requests

• About mApp Solutions

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution

1. Define escalation Teams.

How to Use the mApp Solution in the Desktop Client

• Escalate an Incident.
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Configuring the Automatic Incident Escalation
mApp Solution

Complete the following procedure to configure the Automatic Incident Escalation mApp Solution. The
configuration procedure is completed in the CSM Desktop Client.

1. Define escalation Teams.
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Define Escalation Teams
Use Table Management in the CSM Desktop Client to define escalation Teams.

Note: This functionality is only available if you have applied the Automatic Incident Escalation
mApp Solution. For more information, refer to the mApp Solution Tech Notes documentation.

To define escalation Teams:

1. In the CSM Desktop Client, click Tools>Table Management.
2. In the Type drop-down, select Incident Subcategory.

The Incident Subcategory Grid opens.

3. Click a Service Categorization.

4. Click the Show Current Record button  (example: Desktop Management, Computer, Submit
Incident).

The Subcategory Form opens.

a. Complete the Form:

Note: You must complete the Subcategory Form for each Service Categorization.

i. Default Team: Select the default Team for the Incident.

ii. Level 2 Escalation Team: Select the second-level escalation Team.
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iii. Level 3 Escalation Team: Select the third-level escalation Team.

Note: If the Default OLA Team is defined for the Service, the Level 3 Escalation Team
field will autopopulate with the Team name when the Service is selected on the Incident
Subcategory Form.

5. Click Save .
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Using the Automatic Incident Escalation mApp
Solution

When working with the Automatic Incident Escalation mApp Solution, Users can:

• Escalate an Incident.
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Escalate an Incident
Use the Incident Form in the CSM Desktop Client to escalate an Incident.

Note: This functionality is only available if you have applied the Automatic Incident Escalation
mApp Solution. For more information, refer to the mApp Solution Tech Notes documentation.

To escalate an Incident:

1. In the CSM Desktop Client, log a new Incident (New>Incident).

A new Incident record is created.

2. Record the basic details:
a. In the Requestor field, type the name of the Customer who initiated the contact, and then

press ENTER or TAB to search for the Customer Record.

Note: If an exact match is found, the Requestor fields are auto-populated with the Customer’s
name, avatar, e-mail, and phone. If multiple matches are found (ex: Multiple Customers named
Steve), the Contact Manager opens so that you can select the appropriate Customer.

b. Short Description: Type a concise description of the Incident.

c. Description: Type a detailed description for the Incident.

d. Call Source: Select a source for the initiation.

After all required fields are completed, the Incident automatically enters the Classify phase.

3. Classify the Incident:
a. Service: Select the affected Service.

b. Category: Select the affected Service category.

c. Subcategory: Select the affected Service subcategory.

The Ownership Team field auto-populates based on the defined Default Team.
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d. Priority: Click the Priority drop-down to reveal the Priority Matrix (determined by invoked
SLA), and then click a priority number.

e. Major Incident: Select this check box if the Incident/Request is causing serious interruptions of
business activities, and requires shorter timescales and greater urgency to resolve.

f. Primary CI: Click the CI Selector button  to launch the CMDB window, and then select a CI.
4. (Optional) Escalate the Incident to the second-level Team.

Note: All required fields must be complete before you can escalate the Incident.

a. Click the Escalate to Level 2 and 3 button in the Incident Actions section of the Quick Info
Tile.

A window opens prompting you to define a reason for escalating the Incident.

b. Type the reason for escalating the Incident.

c. Select OK.
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A Task Form opens in the Form Arrangement.

Note: The Title, Type, Description, and Owned By Team fields are auto-populated based on
the Incident Subcategory Form.

d. Complete the Task Form.

5. (Optional) Escalate the Incident to the third-level Team.
a. Click the Escalate to Level 2 and 3 button in the Incident Actions section of the Quick Info

Tile.

A window opens prompting you to define a reason for escalating the Incident.

b. Type the reason for escalating the Incident.

c. Select OK.

A Task Form opens in the Form Arrangement.
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d. Complete the Task Form.

6. Complete the Incident logging process.
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Enhanced Password Reset mApp Solution 1.0a
The Enhanced Password Reset mApp® Solution provides functionality that builds upon the current
Password Reset functionality to strengthen security in the CSM Portal.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 5.0.0 - 9.1.x

Out-of-the-Box Content Requirements: Tested on CSM 9.1.x

Prerequisites: None

Overview
The existing Password Reset feature allows Users to reset their password based on security questions
and randomly generated codes that can be sent (via text) to their phone. It also allows Users to combine
security questions and codes for even greater security. The Enhanced Password Reset mApp Solution
offers additional functionality, which creates a randomly generated security code that can be e-mailed to
an alternate e-mail address. The additional strength can be used to assign the characters in the password
a strength value based on the character type, length of password, and combination of characters. As the
User types a desired password, a colored meter shows the strength of the password. CSM integrates with
Enhanced Password Reset so that you can strengthen your password security system. For more
information, see About Customer Portals.

How the mApp Solution Works
CSM provides the Enhanced Password Reset V1.0a functionality as a mApp Solution so that Users can
easily incorporate password strength automation into their existing CSM system. Download the mApp
Solution from the Cherwell mApp Exchange. Use the Apply mApp wizard to apply the mApp Solution to
your CSM system. The Apply mApp wizard generates a Blueprint, which can then be viewed and
published to a test or Live system to commit the changes.

The mApp Solution includes the following items:

Item Category Item Typical Merge Action

Business Object

 

Customer Merge

Incident Don't Change

Mobile Carrier, Password Reset Form,
Secret Question Overwrite

Field, Form, Grid, Index Numerous Varies

Automation Process Self-Service Password Reset Overwrite

747

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/csh?topicname=about_customer_portals
https://help.cherwell.com/csh?topicname=go_to_the_mapp_exchange
https://help.cherwell.com/csh?topicname=apply_a_mapp


One-Step Action

 

Password Requirements Import

Password Reset Failure, Password
Reset Process, Password Reset
Successful, Send Code

Overwrite

Expression Numerous Varies

Stored Value

Current System, Current System DEV E-
Mail Recipient, Current System DEV E-
Mail Sender, Current System Production
E-Mail Sender

Don't Change

Theme Professional Grey Don't Change

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About CSM Customer Portals

• About mApp Solutions

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.
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HR Case Management 3.0
Cherwell HR Case Management is a business solution enabling human resources teams to deliver
employee services quickly and efficiently.

Cherwell HR Case Management includes case management functions as well as employee administration
tools.

This version of HR Case Management combines the proven functionality of HR Case Management
version 2 solution as well as the extended functionality of HR Employee Administration solution. The
overall solution is globalized and localized in English and Spanish and is foundationally ready to be
localized in other languages as well.

Cherwell HR Case Management Overview

Cherwell HR Case Management allows fulfillment teams to streamline and automate common HR
requests and provide focused knowledge to help solve issues before cases need to be created. The
application can be an independent solution or part of a larger enterprise service management strategy,
which drives fulfillment of IT, Facilities, Marketing, Legal and other service requests.

Employee Administration Functions
The Employee Administration functions included in Cherwell HR Case Management facilitate the
automation and structure for onboarding, employee transfer, and offboarding activities. For many
organizations, these employee administration functions are disjointed and span IT and HR teams with no
central coordination or ownership. When detailed tasks to fulfill these functions are not standardized, the
responsibility falls on the hiring manager to coordinate and direct the fulfillment activities. Additionally, the
activities for fulfillment items that take significant time are generally started too late (example: a few days
before the new hire employee is expected to start).

Note: If you have the Facilities Service Management mApp Solution installed, you can take advantage of
having Work Orders automatically generated as part of specific workflows.
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Pre-Installation Considerations
Platform Version Requirements: Tested on Cherwell HR Case Management 9.2.x and 9.3.x

Out-of-the-Box Content Version Requirements: 9.2.0 for a clean scan - however, as noted below,
Cherwell HR Case Management can be installed with other content versions. Service Catalog Templates
are used in this solution, so minimally the content version needs to be 7.x. Additionally, a little extra care
and tweaking will be needed for non-Globalized systems.

There will be a modification available for the create IT Task functionality for content version 9.4. The Task
Business Object will have a different structure, so modifications will be needed to this mApp Solution for
compatibility with CSM 9.4.

If you have already installed HR Case Management (version 2) - loading this new solution could impact
form and workflow modifications you have made locally. If you want to add the HR Employee
Administration functionality to your implementation, there are two options:

1. Install the HR Employee Administration solution - it is not currently localized, so if this is a
requirement, you will need to localize the object.

2. If you have made little to no changes to your HR Case Management (version 2) implementation, you
can load this new solution, review the resulting build, and move your modifications back in.

No data is lost when applying the mApp files, only configuration modifications.

Prerequisites: None.
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Cherwell HR Case Management Client Localization
Cherwell HR Case Management is localized in English and Spanish. This includes all supporting tables,
forms, and Dashboards.
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About Cherwell HR Case Management

Process
Some key features of Cherwell HR Case Management include:

• Integrated Portal design that allows end users to see the status of their requests across all
departments (separate mApp Solution).

• Custom Dashboards for HR teams based on Role.

• HR Checklists for detailed tracking of work for different types of complex HR Requests.

• Delivery of important HR documents (e.g., How-To Instructions and links to other core HR
applications) to employees via the Portal.

• A clean and uncluttered theme throughout.

• HR-specific SLAs to track and proactively notify for Response and Resolution targets.

• Localized in English and Spanish (Dashboards, Portal pages, HR Case, etc.)

• Catalog structure that allows specific country-based subcategories and associated default
assignment groups, checklists, specifics forms, etc.
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Employee Administration
Key features of Cherwell's HR Employee Administration functions include:

• Position: A new Business Object to interface between external HR systems and internal Cherwell
activities. As a position moves through the Approved and Filled phases, activities for IT and HR
teams are initiated. IT Service Requests and HR Cases are created based on the HR Position
record status and detailed information about the jobs and candidates.

• ESM Application: New major object that stores applications and associated information.

• HR Position Role Service Catalog Template: A new supporting business object that ties together
Roles and Service Catalog Templates to create Service Requests with the correct pre-determined
Work Units (Tasks).

• Role-based fulfillment activities: A new Lookup table stores Roles that are used to determine
workflow. The existing functionality of Service Catalog Templates is used with Role to create
appropriate Service Requests for:

◦ Equipment Review/Request

◦ Access Request (example: Active Directory (AD), e-mail, application specific, etc.)

• Reuseable Work Units: This feature is part of the Service Catalog Template functionality. Work
Units can be created and used across multiple templates.

• Just-in-time initiation of fulfillment activities: Because Service Requests are initiated at multiple
points in the overall Position/Hire process, areas that may require extra time to fulfill are scheduled
accordingly. Equipment requests do not need specific new hire information, so those can be initiated
and worked even before a candidate has been selected. Activities requiring specific people
information are initiated once those details are available.

◦ Job/Position approved - Equipment review or procure request created

◦ Candidate hired - Access request created

• Track accesses and equipment for each Customer: Customer records can be updated with
access information as well as linked to equipment items. This information is used during the
Employee Transfer and Termination processes to automate task creation.

This view provides a 'by persona' perspective of the interactions with the processes (IT, HR, Facilities).
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Cherwell HR Case Management mApp File
Attributes

The Cherwell HR Case Management mApp file contains the following items:

Major BO BO - Item
(Form,Grid,etc) BO Item Name Action Settings Notes

HR Case Entire BO HR Case Overwrite High Importance

HR Position Entire BO HR Position Overwrite High Importance

Discussion Form Discussions Overwrite Low Importance

Standard form
with addition of
new fields for
classification and
expiration

Discussion Field

Expiration Date,
FM
Announcement,
HR
Announcement,
IT
Announcement

Merge Low Importance

Knowledge
Article One-Step

Issue Not
Resolved via
Portal - Log
Incident Issue
resolved via
Portal - show
usage

Overwrite Low Importance

Added case
statement for
special handling of
Human Resources
Knowledge
Articles when
customers indicate
Use of the article
in resolving their
issue. Redirects
back to HR Home
Portal.

Supporting BO BO - Item
(Form,Grid,etc) BO Item Name Action Settings Notes

Checklist Item Entire BO Checklist Item Medium
Importance

HR Additional
Details Entire BO HR Additional

Details
Medium
Importance

HR Benefit
Change Entire BO HR Benefit

Change
Medium
Importance

HR Contact Info
Change Entire BO HR Contact Info

Change
Medium
Importance
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HR Off Board Entire BO HR Off Board Medium
Importance

HR Onboard Entire BO HR Onboard Medium
Importance

HR Transfer Entire BO HR Transfer Medium
Importance

SLA Target Time Field Parent Type Overwrite Low Importance

Added a Parent
Type value of
"HR Case" to
valid values

Lookup Tables BO BO - Item
(Form,Grid,etc) BO Item Name Settings Notes

Case Category Entire BO Case Category Medium Importance Include data

Case Priority Entire BO Case Priority Medium Importance Include data

Case Subcategory Entire BO Case Subcategory Medium Importance Include data

Case Type Entire BO Case Type Medium Importance Include data

Checklist Entire BO Checklist Medium Importance Include data

HR Case Resolution
Code Entire BO HR Case Resolution

Code Medium Importance Include data

HR Case Status Entire BO HR Case Status Medium Importance Include data

Managers Item Location
(Association) BO Item Name Action Notes

Automation process
definition Association - HR Case HR Case - Confirmation Email

on Create Import

Automation process
definition Association - HR Case HR Case - Resolve to Closed

Process Import

Automation process
definition Association - HR Case Resolve By Breached - HR

Case Created Import

Automation process
definition Association - HR Case Respond By Breached - HR

Case Created Import

Counter Global HRCaseID Import

Dashboard Global > HR Case HR Case Catalog Import Portal Only

Dashboard Global > HR Case HR Case Home Import Portal Only

Dashboard Global > HR Case HR Case Management Oversite
Dashboard Import

Dashboard Global > HR Case HR Case My Items Import Portal Only
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Dashboard Global > HR Case HR Case Team Manager
Dashboard Import

Dashboard Global > HR Case HR Case Worker Dashboard Import

Widget Global > HR Case All Cases by Category Import

Widget Global > HR Case All Open HR Cases Import

Widget Global > HR Case All SLA Resolve Breaches Import

Widget Global > HR Case All SLA Resolve Warnings Import

Widget Global > HR Case All SLA Response Breaches Import

Widget Global > HR Case All SLA Response Warnings Import

Widget Global > HR Case All Unassigned HR Cases Import

Widget Global > HR Case All VIP HR Cases Import

Widget Global > HR Case HR Case Date Range Filter Import

Widget Global > HR Case HR Case Searches Import

Widget Global > HR Case HR Case Team Workload Import

Widget Global > HR Case HR Case Workload by
SubCategory Import

Widget Global > HR Case HR Case Workload by Team Import

Widget Global > HR Case HR Case Workload by Team
Member Import

Widget Global > HR Case HR Cases Owned by Me Import

Widget Global > HR Case HR Cases Owned by My Teams Import

Widget Global > HR Case HR Cases Recently Closed
Opened by Me Import

Widget Global > HR Case HR Catalog - Other Import

Widget Global > HR Case HR Discussions Import

Widget Global > HR Case HR Full Catalog Import

Widget Global > HR Case HR Knowledge Articles with Like
Counts Import

Widget Global > HR Case HR Knowledge Search Import

Widget Global > HR Case My Follow Ups Import

Widget Global > HR Case My SLA Resolve Breaches Import

Widget Global > HR Case My SLA Resolve Warnings Import

Widget Global > HR Case My SLA Response Breaches Import

Widget Global > HR Case My SLA Response Warnings Import
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Widget Global > HR Case My Team Follow Ups Import

Widget Global > HR Case My Team SLA Resolve
Breaches Import

Widget Global > HR Case My Team SLA Resolve
Warnings Import

Widget Global > HR Case My Team SLA Response
Breaches Import

Widget Global > HR Case My Team SLA Response
Warnings Import

Widget Global > HR Case My Teams Unassigned HR Case
Count Import

Widget Global > HR Case My Teams Unassigned HR
Cases Import

Widget Global > HR Case Unread Email Journals for My
Teams HR Cases Import

One-Step Association - Case
Subcategory Global

Create HR Case and Set
Categorization Import

One-Step Association - Checklist
Item Blueprint

Item 01 Done, Item 02 Done,
Item 03 Done, Item 04 Done,
Item 05 Done, Item 06 Done,
Item 07 Done, Item 08 Done,
Item 09 Done, Item 10 Done,
Item 11 Done, Item 12 Done,
Item 13 Done, Item 14 Done,
Item 15 Done, Item 16 Done,
Item 17 Done, Item 18 Done,
Item 19 Done, Item 20 Done,
Item 21 Done, Item 22 Done,
Item 23 Done, Item 24 Done,
Item 25 Done, Item 26 Done,
Item 27 Done, Item 28 Done,
Item 29 Done, Item 30 Done

Import

One-Step Association - Checklist
Item Blueprint

Item 01 Skip, Item 02 Skip, Item
03 Skip, Item 04 Skip, Item 05
Skip, Item 06 Skip, Item 07 Skip,
Item 08 Skip, Item 09 Skip, Item
10 Skip, Item 11 Skip, Item 12
Skip, Item 13 Skip, Item 14 Skip,
Item 15 Skip, Item 16 Skip, Item
17 Skip, Item 18 Skip, Item 19
Skip, Item 20 Skip, Item 21 Skip,
Item 22 Skip, Item 23 Skip, Item
24 Skip, Item 25 Skip, Item 26
Skip, Item 27 Skip, Item 28 Skip,
Item 29 Skip, Item 30 Skip

Import
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One-Step Association - HR Case
Blueprint Assign to ANY Individual Import

One-Step Association - HR Case
Blueprint Assign to Individual Import

One-Step Association - HR Case
Blueprint Assign to Team Import

One-Step Association - HR Case
Blueprint Auto-Close Record Import

One-Step Association - HR Case
Blueprint Clear Classification Import

One-Step Association - HR Case
Blueprint Create Child Checklists Import

One-Step Association - HR Case
Blueprint DateTime Stamps Popup Import

One-Step Association - HR Case
Blueprint Dial Customer Phone Import

One-Step Association - HR Case
Blueprint Follow-Up Import

One-Step Association - HR Case
Blueprint HR Case Confirmation Import

One-Step Association - HR Case
Blueprint HR Case Resolved Confirmation Import

One-Step Association - HR Case
Blueprint Refer to Another Service Desk Import

One-Step Association - HR Case
Blueprint Resolve By Breached Import

One-Step Association - HR Case
Blueprint Resolve Redundant - HR Case Import

One-Step Association - HR Case
Blueprint Respond By Breached Import

One-Step Association - HR Case
Blueprint Set Already Saved Import

One-Step Association - HR Case
Blueprint SLA Explanation Import

One-Step
Association - HR Case
Blueprint > Status
Actions

Alt 1 Step from Relationship Import

One-Step
Association - HR Case
Blueprint > Status
Actions

Alt 2 Step from Relationship Import
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One-Step
Association - HR Case
Blueprint > Status
Actions

Close Case Import

One-Step
Association - HR Case
Blueprint > Status
Actions

Next Step from Relationship Import

One-Step
Association - HR Case
Blueprint > Status
Actions

Reopen Case Import

One-Step
Association - HR Case
Blueprint > Status
Actions

Resolve Case Import

One-Step
Association - HR Case
Blueprint > Status
Actions

Start In Progress Import

One-Step Association - HR Case
Global Add Comment Import

One-Step Association - HR Case
Global Follow-up E-mail Import

One-Step Association - HR Case
Global Take Ownership Import

One-Step
Association -
Knowledge Article
Blueprint

Issue Not Resolved via Portal -
Log Incident Import

One-Step
Association -
Knowledge Article
Blueprint

Issue resolved via Portal - Show
Usage Import

One-Step Association - None
Global > HR Case Benefits - Catalog Import

One-Step Association - None
Global > HR Case Direct Deposit Authorization Link Import Example links to

external URLs

One-Step Association - None
Global > HR Case Documents External Link Import Example links to

external URLs

One-Step Association - None
Global > HR Case Employee-Changes-Catalog Import

One-Step Association - None
Global > HR Case Fitness Center Waiver Link Import Example links to

external URLs

One-Step Association - None
Global > HR Case Holiday Paid Time Off Link Import Example links to

external URLs

One-Step Association - None
Global > HR Case HSA Application Link Import Example links to

external URLs

One-Step Association - None
Global > HR Case New Employee Contact Case Import
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One-Step Association - None
Global > HR Case New HR Case Import

One-Step Association - None
Global > HR Case Other-Catalog Import

One-Step Association - None
Global > HR Case Payroll External Link Import Example links to

external URLs

One-Step Association - None
Global > HR Case Payroll-Catalog Import

One-Step Association - None
Global > HR Case

Performance-Management-
Catalog Import

One-Step Association - None
Global > HR Case Training-Catalog Import

Stored expression Association - Checklist
Item Global

Due Date 01, Due Date 02, Due
Date 03, Due Date 04, Due Date
05, Due Date 06, Due Date 07,
Due Date 08, Due Date 09, Due
Date 10, Due Date 11, Due Date
12, Due Date 13, Due Date 14,
Due Date 15, Due Date 16, Due
Date 17, Due Date 18, Due Date
19, Due Date 20, Due Date 21,
Due Date 22, Due Date 23, Due
Date 24, Due Date 25, Due Date
26, Due Date 27, Due Date 28,
Due Date 29, Due Date 30

Import

Stored expression Association - Checklist
Item Global Prompt for Checklist Name Import

Stored expression Association - HR Case
Blueprint

Created During What Business
Hours Import

Stored expression Association - HR Case
Blueprint Default Call Source Import

Stored expression Association - HR Case
Blueprint Email Customer Import

Stored expression Association - HR Case
Blueprint Is Member of Team Import

Stored expression Association - HR Case
Blueprint Priority Group Import

Stored expression Association - HR Case
Blueprint Required for In Progress Import

Stored expression Association - HR Case
Blueprint Responded Date Time Import

Stored expression Association - HR Case
Blueprint System State E-mail Import
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Stored expression Association - HR Case
Blueprint > Phase Set wrkflowClassifyStatus Import

Stored expression Association - HR Case
Blueprint > Phase Set wrkflowCloseStatus Import

Stored expression Association - HR Case
Blueprint > Phase Set wrkflowInvestigateStatus Import

Stored expression Association - HR Case
Blueprint > Phase Set wrkflowRecordStatus Import

Stored expression Association - HR Case
Blueprint > Phase Set wrkflowResolveStatus Import

Stored expression Association - HR Case
Blueprint > SLA

Customer Default Resolution
Date/Time Import

Stored expression Association - HR Case
Blueprint > SLA Customer is shortest SLA Import

Stored expression Association - HR Case
Blueprint > SLA Customer Resolution Date/Time Import

Stored expression Association - HR Case
Blueprint > SLA Customer Target Time Present Import

Stored expression Association - HR Case
Blueprint > SLA Missing SLA Target Time Import

Stored expression Association - HR Case
Blueprint > SLA Resolve By Warning WITH STC Import

Stored expression Association - HR Case
Blueprint > SLA

Resolve By Warning WITHOUT
STC Import

Stored expression Association - HR Case
Blueprint > SLA Resolve By WITH STC Import

Stored expression Association - HR Case
Blueprint > SLA Resolve By WITHOUT STC Import

Stored expression Association - HR Case
Blueprint > SLA

Respond By Warning WITH
STC Import

Stored expression Association - HR Case
Blueprint > SLA

Respond By Warning WITHOUT
STC Import

Stored expression Association - HR Case
Blueprint > SLA Respond By WITH STC Import

Stored expression Association - HR Case
Blueprint > SLA Respond By WITHOUT STC Import

Stored expression Association - HR Case
Blueprint > SLA

Service Default Resolution Date/
Time Import

Stored expression Association - HR Case
Blueprint > SLA Service is shortest SLA Import
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Stored expression Association - HR Case
Blueprint > SLA Service Resolution Date/Time Import

Stored expression Association - HR Case
Blueprint > SLA Service Target Time Present Import

Stored expression Association - HR Case
Blueprint > SLA SLA Resolve By Import

Stored expression Association - HR Case
Blueprint > SLA SLA Resolve By Warning Import

Stored expression Association - HR Case
Blueprint > SLA SLA Respond By Import

Stored expression Association - HR Case
Blueprint > SLA SLA Respond By Warning Import

Stored expression Association - HR Case
Blueprint > SLA SLA Selection Import

Stored expression Association - HR Case
Blueprint > SLA SLA Selection - Hierarchy based Import

Stored expression Association - HR Case
Blueprint > SLA SLA Selection - Time based Import

Stored expression Association - HR Case
Blueprint > SLA SLA Target Time Match Import

Stored expression Association - HR Case
Global

HR Case Hyperlink to Customer
Portal Import

Stored expression Association - HR Case
Global

HR Case System State
Customer Email Recipient Import

Stored value Global FALSE Import if Not
Present

Stored value Global HR Case Catalog Services Import

Stored value Global TRUE Import if Not
Present

Stored value Global FALSE Import if Not
Present

Team HR Benefits Import

Team HR Case Management Import

Team HR Payroll Import

Team HR Talent Development Import

Team HRIS Import

Merge Action Key
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• Import: Add new item

• Overwrite: Replace target item

• Merge: Merge differences

• Don't Change: Referenced by the mApp file, but not altered in any way. The mApp file includes the
definition for informational purposes only (the definition is not imported into the target system).
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Installing Cherwell HR Case Management
CSM provides Cherwell HR Case Management as a mergeable application (mApp) so that Users can
easily incorporate HR Case functionality into their existing CSM system. Download the mApp Solution
from the Cherwell mApp Exchange. Use the Apply mApp Wizard to apply the mApp Solution to your CSM
system, where the mApp Solution can be viewed and published. After evaluating and testing the mApp
Solution against the development system, apply it to your production environment.

The Cherwell HR Case Management download includes the following items:

• HR Case Management.mApp

• HR Case Management Category Data.mApp

• HR EE Admin Email Monitor.ced

• HRSM Corporate Portal. mApp

• HR Case Management Portal.mApp

• HRV2-Catalog-CSS.txt

To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.
3. Before applying the mApp Solution, decide if the Internal Customer form should be overwritten to

display the Country Code, or if that modification will be made manually via a Blueprint. The Apply
mApp Wizard will prompt with a choice.

4. Before applying the mApp Solution, decide if the Knowledge Article form should be overwritten to
include optional configuration to allow the categorization of HR Knowledge Articles. Otherwise, if
that functionality is desired the modifications will be made manually via a blueprint. The mApp
wizard will prompt with a choice.

5. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

6. In CSM versions 9.2 or greater, when publishing the mApp Solution Blueprint, be sure to check
Update validation foreign keys in the Publish Options dialog.

7. Apply the HR Case Category Data.mApp in order to populate the Case Subcategory table with
sample values.

Related concepts
ESM and HR Portals
Add Custom CSS for HR Service Catalog
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Configure Cherwell HR Case Management
After applying the mApp® Solution, perform the following high-level steps:

1. Create HR Roles.

2. Create HR Security Groups.

3. Assign Users to Teams and Security Groups.

4. Update Customer - Internal records with valid Country Code.

5. Create Country Specific Catalog Records.

6. Create Country Specific Checklist Records.

7. Configure HR SLA and set default for HR Cases (advanced, optional).

For Employee Administration areas, perform the following high-level steps:

1. Access the HR Administration Dashboard.

2. Rename or replace the mApp Factory Application Business Object.

3. Import and configure the HR Employee Administrator E-mail Monitor.

4. (Optional) Apply additional configuration changes as needed.
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HR Security Groups, Roles, and Teams
Security Groups are used in Cherwell HR Case Management (manually configured per the mApp
instructions) to provide access security and workflow rights (example: HR Supervisor can create new
Knowledge Articles).

• HR Case Agent

• HR Case Supervisor

• HR Management

Roles are utilized to provide default Dashboards at login. These cannot be included in the mApp but
sample Roles are provided in the mApp documentation.

The following Teams were utilized during the build and testing activities of the mApp and are part of the
HR Case Management mApp:

• HR Benefits Americas

• HR Benefits EMEA/APAC

• HR Case Management Americas

• HR Case Management EMEA/APAC

• HR Employee Relations Americas

• HR Employee Relations EMEA/APAC

• HR Payroll Americas

• HR Payroll EMEA/APAC

• HR TA Americas

• HR TA EMEA/APAC

• HRIS Americas

• HRIS EMEA/APAC
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Create HR Roles
Cherwell HR Case Management uses Roles to define User Dashboards. There are three Roles to
configure.

To create a Role, perform the following steps:

1. Open the Role Manager.
2. Click the Create New button.
3. Define general information for each of the roles listed below:

• Name: HR Case Agent
◦ Primary Object: HR Case

◦ Dashboard: HR Case My Work

• Name: HR Case Supervisor
◦ Primary Object: HR Case

◦ Dashboard: HR Case Team My Teams Work

• Name HR Management
◦ Primary Object: HR Case

◦ Dashboard: HR Case Management Oversight
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Create HR Security Groups
Use the Security Group Manager in CSM Administrator to create a Security Group. You will base it on an
existing Security Group.

Note: This functionality is only available if you have applied the Cherwell HR Case Management mApp
Solution.

To copy a Security Group, perform the following steps:

1. Open the Security Group Manager.
2. Select IT Service Desk Level 2 & 3 in the Group drop-down.
3. Click Select File and click Copy Security Group.
4. Update the name for each new Security Group.
5. Update the description for each new Security Group.
6. Select the Roles tab.
7. Add the Roles associated with each HR Group (listed below):

◦ HR Case Agent: Group associated Role - (HR Case Agent)
◦ HR Case Supervisor: Group associated Role - (HR Case Supervisor)
◦ HR Management: Group associated Role - (HR Management)

8. Click Save.
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Assign Users to Teams and Security Groups
Use the User Manager under the Security Category in CSM Administrator to assign Users to desired
Teams and Security Groups.

Note: This functionality is only available if you have applied the Cherwell HR Case Management mApp
Solution.

To add users to HR Teams, perform the following steps:

1. In CSM Administrator, open the User Manager.
2. Select desired User. On the Users tab, choose the appropriate security group in the drop-down.
3. Select the Teams tab.

a. Click the Add button.
b. Click one or more Teams.
c. Click OK.
d. To set a default Team, select the Team and click the Default Team button.

4. Save Profile.
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Update Customer - Internal Records with Valid
Country Code

The country-specific Catalog and Checklists depend upon the country code assigned to the Customer.
Use the CSM Desktop Client to set the customer Country Code.

If the option to replace the Customer - Internal form with a version that exposes the Country Code field
was chosen, the Customer - Internal records can be manually updated with a country code.

To update the country code for an internal Customer, perform the following steps:

1. In the CSM Desktop Client, select Customer > Contact Manager from the menu bar.
2. Select an internal Customer to update.
3. Locate the Country Code field in the Personnel Information section and enter a valid Country Code.
4. Save the record.
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Rename or Replace the ESM Application Business
Object

The Business Object named ESM Application is intended as a table to store an organization's basic
enterprise and desktop application information. It is given a unique name so the Apply mApp Wizard does
not overwrite an organization's existing application Business Object. Prior to publishing the Blueprint (after
applying the Cherwell HR Case Management), you can change this name if desired.

The functionality of this table may be redundant if another application table was created as either stand-
alone or incorporated into the Configuration Item group Business Object. In this situation, we recommend
that configuration changes be made in the following Business Objects and components to utilize the
existing application data source:

• Customer Business Object - Relationships - Modify the Customer Links Application relationship to
link to the child object containing the application information (i.e., Config - Applications).

• Customer - Internal Business Object - Form Arrangement - Update the Applications tab properties to
use the correct default form and grid of the new application object used in the relationship.

• Modify the HR Position One-Step™ Action named IT Access Request by Service Catalog
Template. Find the Get Existing Employee Record Step Through Children Action, then find the
Build List of Employee Applications Action. Verify that the Actions within this portion of the One-
Step Action use the proper fields for the application data source table.

• Modify the HR Case One-Step Action named Initiate IT Offboarding Process. Modify the Step
Through Customer Applications Action to use the new application data source Business Object
and field names.
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Update Security Rights for Portal Customers
Use the Security Group Manager in CSM Administrator to update Security Groups.

Note: This functionality is only available if you have applied the Cherwell HR Case Management mApp
Solution.

To define security rights for Portal Customers (and any additional Portal Security Groups),
perform the following steps:

1. Open the Security Group Manager.
2. In the Security Group window, select Portal Customer in the Group drop-down.
3. Select the Business Object tab.
4. In the Business Object drop-down, select the HR Case Object. In the General and File Attachment

sections, add the following options:

Object Check

General Add

File Attachments View, Add, Delete

Bottom of form Different rights based on requestor

Record Requestor View, Edit

5. Select New Field in the Business Object pane, then check the following options:

Object Check

Record Requestor View, Edit

6. In the Business Object drop-down, select the Checklist Item Object. In the General and File
Attachment sections, select the following options:

Object Check

General View, Add

7. Select New Field and check the following options:

Object Check

General View, Edit

8. In the Business Object drop-down, select the HR Additional Details Object. In the General and File
Attachment sections, select the following options:

Object Check

General View, Add, Edit
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Object Check

File Attachments View

9. Select New Field and check the following options:

Object Check

General View, Edit

10. Repeat steps 8 & 9 with the same options for the following Business Objects:
◦ HR Benefit Change
◦ HR Contact Info Change
◦ HR Off Board
◦ HR On Board
◦ HR Transfer

11. In the Business Object drop-down select the Phase Set Object. In the General and File Attachment
sections, select the following options:

Object Check

General View

12. Select New Field and check the following options:

Object Check

General View

13. Repeat steps 11 & 12 with the same options for the following Business Objects:
◦ Case Type
◦ Case Category
◦ Case Subcategory

14. Click Save.
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Import and Configure the HR Employee
Administration E-mail Monitor

Cherwell HR Case Management includes configurable e-mail integration for external recruitment tools to
initiate Employee Administration workflows in CSM.

An integration with external applications that support a REST API can also be configured, but is outside
the scope of this mApp Solution.

The following steps should be used to import and configure the email integration.

1. In CSM Administrator, select the E-mail and Event Monitoring category.
2. Select the E-mail and Event Monitoring Manager option.
3. Select File > Import... from the taskbar menu and select the HR EE Admin Email Monitor.ced file

that was included in the Cherwell HR Case Management download.
4. Right-click the HR Employee Admin Monitor icon and select Edit.
5. On the General tab, select the e-mail account to the monitored. This will be an e-mail account that

was configured for this instance of CSM as part of initial deployment.
6. Do not modify the Identify Customer tab.
7. On the Monitors tab, modify the HR Position monitors as needed based on integration requirements.

This monitor is designed specifically for the HR Position integration for Cherwell HR Case Management. If
the inbound message is not recognized, an HR Case is created.

If the CSM instance includes other features like Incident, Change, etc., and those modules will be sharing
the same e-mail account with Cherwell HR Case Management, manually merge these monitor entries
with the existing E-mail Monitor.
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Optional Employee Administration Configuration

Edit IT Access Request One-Step™ Action
The HR Position One-Step Action named IT Access Request by Service Catalog Template generates a
final task listing the transferring employee's existing application access. This list is generated from the
items on the Applications tab on the Customer-Internal record.

To change this task's descriptive information, modify the Create Review Existing Employee Application
task.

Edit Initiate IT Offboarding Process One-Step Action
The HR Case One-Step Action named Initiate IT Offboarding Process generates a list of tasks using a
default Service Catalog Template to generate offboarding tasks appropriate for all employees. In addition
to those tasks, a task for each assigned CI and each accessible Application is created.

Change the CI and Application task's descriptive information format by modifying the Step Thru Customer
CIs and Step Thru Customer Applications tasks. These actions build an XML-formatted collection used to
generate tasks in the Step through List of Tasks and Create action.
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Configure HR SLAs and Set Default for HR Cases
The HR Case Business Object includes the capability to configure Service Level and Customer Level
SLAs. This advanced feature requires additional configuration to enable.

To configure SLAs for HR Case records, perform the following steps:

1. Configure SLA Target Times. Refer to the CSM Help Topic named: Define SLA Target Times for an
Existing SLA.

2. Set the HR Case default SLA using the Table Management utility (Tools > Table Management).
3. Select the type Case Type.
4. Select the Human Resources record.
5. Select the Primary SLA to be used for HR Cases.
6. Click Save.
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ESM and HR Portals
An HR-specific Portal and ESM Portal are available for Users to quickly request service or report issues
for HR-related areas. The two HR Portals are provided as a separate mApp Solution which are included in
your Cherwell HR Case Management download.

The Portal delivers HR Case Management-specific requests and information for easy navigation. You can
feature HR Announcements to alert employees about key areas of importance. The solution also provides
access to frequently used selections, and a formatted, dynamic HR Catalog with work-specific forms auto-
assigned to the HR fulfillment teams.

Organizations can also incorporate facilities and other services into an ESM Portal, making it convenient
for Users to request services from a single corporate site to any line of business (e.g., IT, Facilities,
Business Operations, Printing and Imaging, Marketing, Accounting).

The following Portal mApp Solutions are included with the Cherwell HR Case Management:

• HR Case Management Portal

• HR Case Management Corporate Portal
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Install HR Case Management Portals
To install the Cherwell HR Case Management Portals, perform the following steps:

1. Save the HR Case Management_Portal.mApp file somewhere you can easily access it.
2. Create a backup of your database. Cherwell offers a way to do this from the Administrator side or

you are welcome to back up your database however you prefer.
3. Once your backup is complete, Open the Cherwell Administrator and choose mApps on the right-

hand side.
4. Click Apply a mApp.
5. Navigate to and open your saved mApp file.
6. Follow the instructions in the Apply mApp Wizard.
7. After the mApp has successfully installed and merge processes have run and a Blueprint is

generated, open Cherwell Service Management (The Blue Client).
8. Click Help > Reload Definitions.
9. Once definitions are reloaded, click Dashboards > Dashboard Manager.

10. Your new Human Resources Dashboards are located here:
◦ Global/Corporate Portal/Human-Resources-v3/HRV3-Enter
◦ Global/Corporate Portal/Human-Resources-v3/HRV3-Home
◦ Global/Corporate Portal/Human-Resources-v3/HRV3-Catalog

781

CSM mApp Solutions

CSM mApp Solutions



HR Case Management Portal
This HR Case Management Portal mApp® Solution is intended to be used with the Cherwell HR Case
Management. The purpose of this mApp Solution is to simplify how end users interact with Human
Resources organizations from the CSM Self Service Portal.

For a complete Enterprise Management Solution, you can also use the Corporate Portal mApp Solution
which complements the look and feel of this portal and is intended to be a gateway for end users to
access multiple departments across the enterprise.

The HR Case Management Portal is localized to English and Spanish. While Dashboards within this
mApp Solution exist for German, French and Brazilian Portuguese, they have not been translated at this
time and are currently in English.

How the mApp Solution Works
CSM provides this solution as a mergeable application (mApp) so that Users can easily incorporate this
functionality into their existing CSM system. The mApp Solution includes the following items:

Item Category Item
Typical
Merge
Action

Localization
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Dashboards

HRV3-Catalog

HRv3-Home

HRv3-Enter
Import English & Spanish

Themes
HRV3-Portal-Default-Forms

Corporate Portal Theme Import

Images

Employees-Brick-Background-tiny
colorful-stripe1

Office-Work-Team-Graphic

Green Button

Orange Button

Pink Button

Purple Button

Teal Button

Collaboration-Background

Conference-Background

Busy-Office-Background

Empty-Office-Background

Import

Widgets

HR V3 Catalog

HR V3 Catalog-Stored Value

Discussions HR
Import

One-Step Actions

Benefits Link

Policies and Procedures Link

Talent Acquisition Link

Performance Mgmt Link

HR V3 Catalog Link

Employment Verification Link

Direct Deposit Link

Vision Benefits Link

Internal Job Postings Link

W4 Link

Flexible Spending Link

Health Savings Link

Open Enrollment Link

Benefits Summary Link

Set-Customer-Country HR-Home-Link

Import
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Stored Values

Stored Value - HR Catalog Category

Country Code

HR Customer Country

HR Supported Countries

Import

Sites Human Resources Import
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Customize HR Portal Dashboards
Because every Cherwell instance is different, you will need to set up the links to work with your specific
One-Step™ Actions.

To set up the links, perform the following steps:

1. In the CSM Desktop Client, select Dashboards > Dashboard Manager.... Navigate to the HR
Dashboards: Global/Corporate Portal/Human-Resources-v3/.

2. Right-click on the Dashboard you wish to update and select Edit.
3. Most clients will want to add, remove, or update the Common Requests links on the HRV3-Home

Dashboard. You can update the actions behind these links by right-clicking and selecting Widget
Properties…

4. Adjust any text or photos you wish.
5. When you are finished adjusting the Dashboard, click OK to save your changes.
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HR Case Management Corporate Portal
The HR Case Management Corporate Portal compliments the look and feel of the HR Case Management
Portal and is intended to be used as a web portal allowing end users access to manage and submit
service requests across multiple departments within the enterprise.

The HR Case Management Corporate Portal is localized to English and Spanish. While Dashboards
within this mApp exist for German, French and Brazilian Portuguese, they have not been translated at this
time and are currently in English.

How the mApp Solution Works
CSM provides the Corporate Portal as a mergeable application (mApp) so that Users can easily
incorporate this functionality into their existing CSM system.

The mApp includes the following items:

Item Category Item Typical Merge
Action Localization
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Dashboards

Corporate-Portal-Home

Corporate-Portal My Items

Facilities-Management-Home-

HRV3-Home

HRV3-Catalog

Ideation-Home

IT-Service-Desk-Home

IT-Service-Desk-Catalog

IT-Service-Desk-KB

Safety-and-Security-Home

Import English & Spanish

Themes
Corporate Portal Theme

HRV3-Portal-Default-Forms Import

Images

Employees-Brick-Background-tiny

colorful-stripe1

Office-Work-Team-Graphic

Green Button

Orange Button

Pink Button

Purple Button

Teal Button

Collaboration-Background

Conference-Background

Busy-Office-Background

Empty-Office-Background

Import
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Widgets

IT-Service-Desk-Catalog

Knowledge Article Search

My Open Requests Count

My Open Incidents Count

My Active Discussions Count

My Devices Count

Top Issues Count

Problems with a Work Around

Problems with no Work Around

Discussions

Overwrite

Knowledge Articles with Like Counts

HR V3 Catalog

HR V3 Catalog-Stored Value

Discussions HR

Discussions FM

Import

Sites Corporate Portal Import
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One-Step Actions

Benefits Link
Policies and Procedures Link

Talent Acquisition Link

Performance Mgmt Link

HR V3 Catalog Link

Employment Verification Link

Direct Deposit Link

Vision Benefits

Internal Job Postings Link

W4 Link

Flexible Spending Link

Health Savings Link

Open Enrollment Link

Benefits Summary Link

Set-Customer-Country

Email Calendaring Link

Install Configure Software Link

Access Files Folders Drives Link

Wireless Access Link

Printing Issues Link

Password Reset Link

Desk Phone Link

Mobile Device Issues Link

Conference Room Equipment Link

Fixing Issues Link

HR-Home-Link

Import

New Incident

New Service Request Overwrite

Stored Values

Stored Value - HR Catalog Category

Country Code

HR Customer Country

HR Supported Countries

Import

Customizing the Dashboard
To customize the Dashboard, perform the following steps:
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1. In the CSM Desktop Client, select Dashboards > Dashboard Manager...
2. Right click on 2017 ESM Home (Dashboards>Global>HR Case>2017 Portal) and select Edit.
3. Over each of the buttons are transparent Link Layers. Right-click on each of the link layers and

select Widget Properties… (If you don't see an option for Widget Properties when right-clicking,
you are not selecting the correct layer).

4. Navigate to the appropriate Action that needs to initiate for that button and click OK.
a. If you've previously installed our 2017 Global HR Case Portal mApp Solution and you would

like to link the Human Resources GO button to the HR Case Home Dashboard, it can be found
here: Global > HR Case > 2017-Portal > 2017 HR Case Home.

5. If you would like to adjust the text shown on the Dashboard, you can easily do that by clicking on the
text you would like to change and making your text edits in the upper left of your screen.

6. When you are finished adjusting the Dashboard, click OK in the lower right to save your changes.

7. You can edit the 2017 ESM My Items Dashboard just the same way you edited the 2017 ESM Home
Dashboard.

Security Settings
To allow Portal customers and anonymous browser users to access the 2017 ESM Portal, you may need
to update your security settings.

To update the security settings, follow these steps:

1. Log into CSM Administrator and select Security.

2. Select Edit Security Groups.

3. In the Security Groups dialogue, select Anonymous Browser from the Group drop-down.

4. Select the Rights tab and set the Category drop-down to Sites.

5. Select 2017ESMPortal in the Sites list. Select the Use Default and View.

6. Click Save.

7. Select Portal Customer in the Group drop-down.

8. Select the Rights tab and select Sites in the Category drop-down.

9. Select 2017ESMPortal in the Sites list and uncheck Use Default at and Check View.

10. Click Save.

Localization
This self-service Portal is available in English and Spanish.

While Dashboards within this mApp Solution exist for German, French, and Brazilian Portuguese, they
have not been translated at this time and are currently in English.
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Customize HR Case Management Corporate Portal
Dashboards

Because every Cherwell instance is different, you will need to set up the links to work with your specific
One-Step™ Actions.

To customize your HR Case Management Corporate Portal Dashboards, perform the following
steps:

1. In the CSM Desktop Client, select Dashboards > Dashboard Manager.... Navigate to the HR
Dashboards: Global/Corporate Portal.

2. Right-click on the Dashboard you wish to update and select Edit.
3. Most clients will want to add, remove or update the Common Requests links on the Human

Resources, Facilities, IT, and Security Dashboards. To update the link Actions, right-click and select
Widget Properties...

4. Adjust any text or photos you wish.
5. When you are finished adjusting the Dashboard, click OK.
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Add Custom CSS for HR Service Catalog
To create the custom CSS, use the CSM Definition Editor to import Action Catalogs.

Applying the Catalog CSS
You must apply a custom CSS for use with the two Service Catalog widgets included in the mApp®
Solution:

• Global/HR Case/HR V3 Catalog

• Global/HR Case/HR V3 Catalog-Stored Value

Note: You will need HRV3-Catalog-CSS.txt for this process. You can find it in the mApp® Solution
download package.
The following steps are not supported in CSM versions after 9.4.0.

To import the Widget Action Catalogs Styles:

1. Open the CSM Definition Editor (All Programs > Cherwell Service Management > Tools >
Definition Editor).
Administrative access is required.

2. In the Trebuchet Definition Editor window, select the Definition Type:
WidgetActionCatalogStyleDef, and then select New.

3. In the New Definition window, type HR Catalog, and then select OK.

4. In the new definition, find the string <Css /> and select that entire line and everything below that
line. Delete everything from <CSS /> down.
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5. Open HRV3-Catalog-CSS.txt, then select and copy the entire contents of the file.

6. Return to the Trebuchet Definition Editor and paste the contents below the last line.

Set Up Portal Action Catalog Widgets with New Widget Styles
To set up Portal Action Catalog widgets with new widget styles:

1. In the CSM Desktop Client, select Dashboards > Widget Manager.
2. Navigate to Global > Hr Case.

3. Right-click HR V3 Catalog, and then select Edit.
4. In the Widget Properties window, select the Display option.

5. Select the Style drop-down list and choose HR Catalog. (If HR Catalog is not visible in the drop-
down list, you may need to refresh the CSM Desktop Client. To refresh, close the Widget Properties
window and Widget Manager dialog boxes, and then select Help > Reload Definitions.)

6. Select OK.

7. Repeat the steps above for the HR V3 Catalog-Stored Value widget.
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Customizing the HR Case Management Catalog
Dashboard

The HR Case Management Portal includes the following category/subcategory structure for the HR Case
Service Catalog:

Category Subcategory

Benefits 401k

Benefits Benefits Changes

Benefits Benefits Changes

Benefits Dental

Benefits FMLA

Benefits FSA/WageWorks

Benefits Holiday

Benefits HSA/Payflex

Benefits Leave of Absence

Benefits Leave of Absence

Benefits Life Insurance

Benefits Life Insurance

Benefits Medical

Benefits Medical Insurance

Benefits Name/Address Changes

Benefits New Hire Benefits Enrollment

Benefits Open Enrollment

Benefits Other

Benefits Other

Benefits Pension Plan

Benefits PTO

Benefits Sick Pay

Benefits STD & LTD

Benefits Vision

Employee Changes Contractor/Non-Employee Onboarding

Employee Changes Off-Boarding Involuntary
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Employee Changes Off-Boarding Voluntary

Employee Changes Onboarding

Employee Changes Status change (i.e. PT to FT)

Employee Changes Status change (i.e. PT to FT)

Employee Changes Transfer/Promotion

Employee Relations Other

Employee Relations Share a Concern

HR System Access Request ADP

HR System Access Request ADP

HR System Access Request Greenhouse

HR System Access Request Greenhouse

Payroll Direct Deposit

Payroll Direct Deposit

Payroll Other

Payroll Other Payroll

Payroll Verification of Employment

Payroll Verification of Employment

Payroll W4

Performance Mgmt Development Plan

Performance Mgmt OKRs

Performance Mgmt OKRs

Performance Mgmt Other

Performance Mgmt Other

Performance Mgmt Performance Evaluations

Performance Mgmt Performance Review

Policies and Procedures Compliance

Policies and Procedures Forms

Policies and Procedures Other

Policies and Procedures Other

Policies and Procedures Policy Question

Policies and Procedures Quality and Safety

Talent Acquisition Greenhouse

Talent Acquisition Internal Job Posts
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Talent Acquisition Interviewing

Talent Acquisition On-Boarding - Contractors/Non-Employees

Talent Acquisition On-Boarding - Employees

Talent Acquisition Open a New Job/Req

Talent Acquisition Other

Talent Acquisition Other

Talent Acquisition Referral Bonus

Talent Acquisition Requisition Request
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HR Case Management Portals Security Settings
To allow Portal customers and anonymous browser users to access the Human Resources Portals, you
may need to update your security settings.

To update security settings for HR Portals, follow these steps:

1. Log into CSM Administrator and select Security.
2. Under Pick a Task…, select Edit Security Groups
3. In the Security Groups dialog, select Anonymous Browser from the Group drop-down.
4. Select the Rights tab and select Sites from the Category drop-down.
5. Select Human Resources in the Sites list and uncheck Use Default and Check View.
6. Click Save.
7. Change the Group drop-down to select Portal Customer
8. Select the Rights tab and set the Category drop down to Sites
9. Select Human Resources in the Sites list and Use Default and Check View.

10. ClickSave.
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HR Case
An HR Case captures the information from Users that initiate from the Portal, inbound email, or on the
phone. Cases are assigned to HR teams and HR case workers based on the type of HR question/request.
There are several areas noted below that enhance the workflow and tracking activities.

1. Follow-up Date and Notification.

2. County Code: Determines the categorization options and the default assignment team.

3. I Want To: Actions:
◦ Resolve Redundant: Allows user to merge and resolve a redundant ticket.

◦ Refer to Another Service Desk: Provides an e-mail template that can be used to refer a ticket
to another resolution team.

◦ Split/Duplicate Case: Clones the current Case.

◦ Create an IT Incident: Creates an Incident in CSM and provides a link between the two tickets
so HR can review as needed. Security prevents IT from seeing the HR Case.

◦ Nominate for Knowledge Base: Initiates the create of a new HR Knowledge Article
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HR Checklists
HR Checklists is a new feature designed specifically for HR. HR organizations track many different action
items and documents based on employee requests. Most HR organizations choose the lighter 'checklist'
functionality over the OOTB Tasks. Checklists are associated with HR subcategories and track specific
items required for each of these individual areas (example: FMLA requests).

Cherwell HR Case Management has several different example checklists.
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HR Discussion
You can use the HR Discussion function to display messages on the HR Portal. Multi-tenant modifications
allow for different announcements and expiration dates so the discussion will not be displayed after the
date has passed.

1. Multi-tenant to allow for different announcements by organization.

2. Expiration date to allow discussions to 'timed out' of active displays.
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HR Notifications
The following automation processes for e-mail notifications are part of Cherwell HR Case Management:

• HR Case Resolved Confirmation

• HR Case Confirmation
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HR Knowledge Management
Knowledge Management has some new 'foundational' elements that customers can use to expand and
formalize this area. Cherwell is careful not to interfere with existing implementations, and Knowledge
Management is an area where most customers apply some level of customization.

Note: The Knowledge Management area of the mApp® Solution is a 'feature' so it can be
bypassed and not included in your installation.

Cherwell HR Case Management provides the following:

1. Creating a New Knowledge article: If an Article Type of Human Resources is selected, the Service,
Category, and Subcategory fields can be populated with values from the HR Case Category and
Subcategory tables. Searches in HR Cases will search using the Human Resource type and the
Category structure.

2. Nominating for Knowledge Base from an HR Case: The Category and Subcategory of the HR Case
will be populated in the New article and the Article Type will be set to Human Resources.

3. The HR Portal searches the Knowledge Base based on the Article Type of Human Resources and if
the 'Visible in Customer Portal' is checked.
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Cherwell HR Case Management does not introduce any new Knowledge Management workflow or
approvals. Once you determine a process for HR Knowledge Article, you will need to set new approval
and review teams.
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Cherwell HR Case Management Dashboards and
Reports

HR My Home Dashboard

HR My Work Dashboard
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HR Management Oversight Dashboard

806

CSM mApp Solutions

CSM mApp Solutions



HR My Team's Work Dashboard

Team Unassigned Cases provide a count of the tickets that have no owners from the team. This can also
be seen easily in the Cases Owned by My Teams grid and reviewing the column called Owned By. If it is
blank, then an owner has not been assigned and the ticket is not being actively worked.

Team Follow-Ups provide a count of tickets where a case worker has selected a follow-up date and that
date is equal to today or earlier.
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Using Cherwell HR Case Management
The following procedure walks you through detailed step-by-step instructions for creating an HR case,
including tips, optional steps, and behind-the-scenes information. The different contributors are noted in
the procedure.

Good to know:

• HR Cases can be created in several ways: via the End User Portal, inbound e-mail, or created
manually. All the Dashboards (except Management) have a button to create a new HR Case. You
can also create a new HR Case in the CSM Desktop Client by clicking File > New > New HR Case.

• All new HR Cases default to the Owning Team in the Case Subcategory table.

• The main pane displays HR Case information (Requestor, HR Case, Title, Descriptions, Priority,
Category, and Subcategory).
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Create an HR Case (User)
1. Access the ESM or Human Resources Portal page (the URL will differ by customer) and log in.

From here you can view your HR cases, click on links for forms and information, or select a quick
box to be directed to other sites as appropriate.

2. Select Search the HR Knowledge Base for articles or Ask HR to be directed to the HR Service
Catalog (there are no OOTB Knowledge articles in Cherwell HR Case Management).

3. After you select an HR Category and Subcategory, a blank case template will open. Enter the
relevant information and click Submit to open a new HR Case.
As the HR Case gets processed, the Status bar will reflect the HR Case phase.
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Create an HR Case (Case Worker or Team Manager)
1. Log into CSM through the Desktop Client or Browser Client. Access an HR Dashboard.
2. Click the New Case button and populate the fields associated with the request.
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Populate the HR Case
1. Populate the Requestor field.
2. Complete Step 1: Record the Details. Both of the description fields are required. Call Source will

default to Phone for manually opened tickets and Portal or Email if they are opened through inbound
email integration or thru the User Portal.

3. Classify the ticket by selecting the Category and Subcategory.
4. The Owned by Team will pre-populate based on the Category and Subcategory selected.
5. Select a Priority for the ticket (ASAP, Important, Normal).
6. Review the requestor's Active and Resolved Cases in the Form Arrangement.
7. Click Save.
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Working an HR Case
After an HR Case is created, the Team Manager will assign the case to a Case Worker. The Case Worker
will complete the tasks associated with an HR Case.
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Assigning a Case (Team Manager)
The Team Manager reviews the My Team's Work Dashboard to identify areas requiring actions.

To assign an HR Case, perform the following steps:

1. On the My Team's Work Dashboard, select an unassigned case.
2. Select an Owner for the ticket. This owner is a member of the manager's teams.
3. Assign a Priority will be blank if the case is created from the User Portal or e-mail.
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Working an HR Case (Case Worker)
Case Workers should use the My Work Dashboard to track their cases. Select a ticket assigned by your
team manager and begin work.

To work an HR Case, perform the following steps:

1. Status: Click on Start Work - this will set the new Status to In Progress.
2. Click on the e-mail address in the Requestor information area to initiate an outbound e-mail to the

Requestor. A template will pop up and can be modified to enter specific information, additional
recipients, add an attachment, etc. If the Requestor replies to this email, it will be added as a
Journal entry along with the original email event.

3. Follow-up Date: Populate a date in this field if you want to be reminded to continue work on this
case. In the CSM Desktop Client, you will also be given the option of receiving an Outlook calendar
notice for this date.

4. I Want To actions:
a. Resolve Redundant: Click this link if the case is the same as an existing case ticket. This

launches One-Step Action that allows you to append the description from this case the main
case description and resolve the redundant case. Redundancy often occurs when Users send
an e-mail that creates a new case rather than replying to the e-mail they received when they
first opened the case. This One-Step Action allows you to select the main case - then appends
the description from the redundant case into the main case description and resolves the
redundant case.

b. Split/Duplicate: Clones the current HR Case.
c. Refer to Another Service Desk: This One-Step Action opens an e-mail template to refer to

another team. You can put in the e-mail address of the IT Help Desk to create a new IT ticket,
or any e-mail address to send the information over to another referral team. This does NOT
resolve the current ticket - the ticket will remain In Progress until it is manually resolved.

d. Create an Incident Ticket: Creates an Incident ticket which will appear in the HR Case's Form
Arrangement.

5. Checklist: Several Checklists are configured in Cherwell HR Case Management. These will apply to
a case ticket based on the Category and Subcategory of the case. Additional Checklists can be
applied manually in the Additional Checklists tab.
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Using Employee Administration
The employee administration functions of Cherwell HR Case Management include position creation and
approval, position fulfillment (including new hire and transfer processes), and offboarding. Inputs can be
from an HR system (via inbound e-mail or an API integration), or manually by an HR specialist or hiring
manager.
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HR Position
HR Position is a major Business Object that provides the pivot point and key data storage for onboarding,
offboarding, employee transfer, and termination processes.

The record has two main areas: Position Details and Employee Details.

1. Position Details: The key fields driving workflow are 'New' or 'Existing' position and Job Role. The
resulting Service Catalog Template applied are based on these values.

2. Employee Details: The key field driving workflow is the 'New Hire' or 'Existing Employee' selection.

3. IT Requests: A listing of IT Requests for Equipment and Access are associated with the HR Position
record.

4. Work Orders: A listing of Work Orders for environment set up activities assigned to the Facilities
organization.

5. HR Cases: The HR Position record tracks HR Cases generated for the position, the associated job,
and candidates.
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HR Position Role Service Template
The HR Position Role Service Template assigns the appropriate Service Catalog Template to the IT
Service Request for fulfillment.

Equipment Request Templates: Templates that contain the Work Units for the equipment review or
procurement activities based on the Position Record identification of 'new' or 'existing' position.

Access Request Templates: Templates that contain Work Units for required accesses (example: AD, E-
mail, application[s]). Access request fulfillment Work Units are based on the Position Record identification
of 'new' or 'existing' employee.
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Service Catalog Templates
The Service Catalog Template Business Object (SCT) is a component of the OOTB CSM installation. This
functionality is used throughout the Cherwell HR Case Management to provide deliverables for the
fulfillment of position-related activities. The appropriate SCT is identified and applied based on values in
the HR Position record.

SCTs are comprised of related Work Units. Customers access SCTs from the Service Catalog in the
Customer Portal. When an SCT is selected, a Service Request is created and the associated Work Units
transform into Tasks, which are required to close the Service Request. This allows you easily manage the
Tasks required to fulfill common Service Requests.

The following examples highlight the differences between the SCTs based on different types of jobs and
candidates.

SCT for Existing Position
In this example, a position was vacated.

820

CSM mApp Solutions

CSM mApp Solutions



1. Title of the specific SCT: this example identifies this SCT as associated with the equipment
requests.

2. Categorization carried into the Service Request: the structures are unique for this mApp and not part
of the OOTB categorization.

3. Work Units - identifies tasks for this SCT.

SCT for New Position
In this example, a position is new to the organization, so equipment may be needed.

1. Categorization.

2. Work Units for new equipment, space setup, and a mobile phone.
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SCT for Existing Employee
This scenario requires a review of existing accesses and tasks for new accesses.

1. Categorization.

2. Work Units for a review of badge access and the addition of sales-specific applications (SAP and
SalesForce).

A task requesting a review of existing accesses (Application tab in the Customer record) will automatically
be added to the Service Request.

SCT for New Employee
This scenario initiates new access tasks.
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1. Categorization.

2. Work Units for all accesses for a new employee based on role.

SCT for Off-boarding
This scenario initiates a default set of tasks. The initiation of this SCT is generated from a One-Step™
Action that creates an HR Case ticket as well. Additional tasks are created for each access in the
Customer record (Application tab) and equipment (CIs tab).

1. Categorization.

2. Work Units requesting that key accesses be disabled.
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Service Request and Customer Record views: Additional tasks for each access and CI associated with
the employee.
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One-Step Actions Associated with Service Catalog
Templates

Cherwell HR Case Management includes several One-Step™ Actions:

• IT Equipment Request by Service Catalog Template: Initiates the selection and execution of the
appropriate equipment SCT (IT Service Request). This One-Step Action also initiates the creation of
the Work Order ticket for facilities activities if this option is selected on the mApp Solution installation
activities.

• IT Access Request by Service Catalog Template: Initiates the selection and execution of the
appropriate access SCT (IT Service Request) plus additional functionality as identified below:

◦ HR Position Filled - Existing Employee: Action within the One-Step Action to initiate an
additional task in the Service Request with a description that includes a list of the current
accesses (Application tab) on the Customer record.

• Initiate IT Offboarding Process (from within an HR Case): Initiates the appropriate SCT and then
creates a task for each entry in the Customer record representing accesses and equipment
(Application tab and CIs Tab).
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HR Position Approved
Two key Status values trigger workflow - Approved and Filled. This example will follow the Position
Approved process.

A Service Request is created with associated Tasks based on the disposition of the HR Position (new or
existing). Optionally, a Work Order for facilities related activities would be created as well.

When a Position record is created, and given a status of Approved, a Service Request ticket is created to
order new equipment or review existing equipment. A One-Step™ Action determines the appropriate
Service Catalog Template for the Service Request. If the Facilities mApp Solution is also installed, a Work
Order is also created.
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HR Position Creation and "Approved" Status
Inbound E-mail Example

Inbound E-mail Example
Format:
#HiringManagerEmail# Henri.Bryce@RiverTCorp.com (valid customer record email)

#WorkLocation# Corporate HQ (free form)

#Department# Sales and Marketing (free form)

#EERole# Account Manager (from HR Role list)

#EmployeeOrContractor# Employee (or Contractor)

#NewOrExisting# New (or Existing)

#FullOrPartTime# Full Time (or Part Time)

#Supervisor# True (or False)

#JobDetails# Generate and close sales opportunities for the Mid-Atlantic Region (free form)

HR Position Record View
E-mail notifications (indicated in the Journals tab) are created and sent to the Hiring Manager and the HR
system (if initiated automatically with an integration).

An IT Request is created for a New Position Equipment Request. Note: If Existing position type had been
indicated instead of New, an Existing Position Equipment Request is generated, which focuses on review
rather than acquisition of equipment. A Work Order is also created if the Facilities mApp has been
installed.
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IT Request is created: New Hire Access Request

Note: If 'Existing Employee' had been indicated instead of 'New Hire' for the candidate type, the Service
Request generated would be different (Employee Access Request) and focused on a review as well as
new accesses.

HR Case is created: New Hire Case

Note: If 'Existing Employee has been indicated, the HR Case generated would be different (Employee
Transfer Case) and the Checklist applied would be 'Transfer' Checklist instead of an Onboarding
Checklist.

Work Order is created: Workplace configuration

Confirmation E-mails
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Service Request Created (New Position)
When a Service Request is created for a New Position, the tasks included depend on whether the
position is new or existing. The following information outlines the Service Request and associated Task
information.

Categorization: The categorization within Cherwell HR Case Management is unique value set; it will not
interfere with an existing implementation, and can be easily modified.

Requestor: Hiring Manager.

Tasks: Generated by the associated SCT applied by the One-Step Action initiated when the HR Position
was approved. Additional Tasks can be easily added (as Work Units) in the SCTs for related activities.

The Service Request (and associated Tasks) is worked through completion as a normal IT request ticket.
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HR Position Filled
A Position can be moved to a 'Filled' Status manually or by an HR system. A Service Request is created
with the Tasks for the appropriate system and application access activities. An HR Case for Onboarding
or Employee Transfer is also created.
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HR Position Updated and "Filled" Status

Inbound E-mail Example
Format:
#FilledBy# New Hire (this would be 'Employee' if it existing employee)

#FullName# Karen Michelle Purnell

#Address1# 33202 Glendale Blvd.

#Address2#

#City# Silver Spring

#State# MD

#ZIP# 20720

#StartDate# 04/16/2017

#GoesBy# KP

#PrimaryPhone# 123-456-7890

#Email# KP@gmail.com

HR Position Record View
The fields are related at this point to the candidate that has been selected to fill the position.

E-mail notifications (indicated in the Journals tab) are created and sent to the Hiring Manager and the
inbound e-mail initiating system (or other integration system).
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IT Request is created: New Hire Access Request

Note: If 'Existing Employee' had been indicated instead of 'New Hire' for the candidate type, the Service
Request generated would be different (Employee Access Request) and focused on a review as well as
new accesses.

HR Case is created: New Hire Case

Note: If 'Existing Employee has been indicated, the HR Case generated would be different (Employee
Transfer Case) and the Checklist applied would be 'Transfer' Checklist instead of an Onboarding
Checklist.

Work Order is created: Workplace configuration
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Confirmation E-mails
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Service Request Created (New Hire)
When a Service Request is created for a New Hire, the tasks included depend on whether the hire is new
or existing. This section outlines the Service Request and associated Task information. The tasks
included in the Service Request are dependent on if the hired candidate is a new hire or an existing
employee. Below is a set of screen shots outlining the Service Request and associated Task information.

Categorization: The categorization within this Cherwell HR Case Management is unique value set; it will
not interfere with an existing implementation, and can be easily modified.

Requestor: Hiring Manager

Tasks: Generated by the associated SCT applied by the One-Step Action initiated when the HR Position
was approved. Additional Tasks can be easily added (as Work Units) in the SCTs for related activities.

The Service Request (and associated Tasks) is worked through completion as a normal IT request ticket.

Step 3 functionality is initiated after the tasks are completed. The owner of the Service Request must
check the two boxes to Resolve the overall Service Request.

The activities to auto-create a Customer record and link Applications to that record can be automated as
part of the modification of the task activities or prompted One-Step Actions. This is not part of Cherwell
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HR Case Management because it would need to be designed based on each customer's current CSM
implementation.

New Customer Record
This record can be created manually or through automation. The Full Name and SAM Account Name are
the critical fields to populate. These will enable the record to be recognized and updated by the AD
integration.

Links to Applications and CIs can also be done manually or through automation. These links will be used
during the offboarding processes to identify and create tasks for equipment and accesses that need to be
review/removed and/or retrieved.
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Service Request Created (Existing Employee)
When a Service Request is created for an existing employee, a different set of Tasks and details are
generated. Access Tasks are created for general known role-based applications, and a review Task is
created with information about existing application accesses for the Employee. A listing of the existing
accesses is populated in the Task description field based on the linked access records from the Employee
record.
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HR Case Created (New Hire)
A new HR Case is created. The HR Case functionality is part of Cherwell HR Case Management and
detailed documentation is available the provides information on workflow, checklists, fields, Dashboards,
etc. The Checklist included in Cherwell HR Case Management are dependent on if the hired candidate is
a new hire or an existing employee. Below is a set of screen shots outlining the HR Case and associated
information.

Categorization: The categorization within Cherwell HR Case Management is unique value set; it will not
interfere with an existing implementation, and can be easily modified.

Requestor: Hiring Manager.

Checklist: Based on the categorization of the ticket.

Checklists can be easily modified to have the line items appropriate for customer specific processes. The
HR Case is then worked by the HR team through completion.
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HR Case Created (Existing Employee)
The HR Case created for an existing employee has a different classification and linked Checklist.

Note: A Work Order tab will be visible if the Facilities Service Management mApp Solution is
installed.
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Offboarding and Termination
Offboarding and termination processes are generally formally initiated through the HR organization. You
could also configure steps to automatically initiate this as appropriate.

HR Case: Opened manually by an HR specialist.

Service Request (Employee Separation Request): Initiated from within the HR Case; this creates
access- and equipment-related offboarding tasks.
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Service Request (Employee Separation Request)
The Tasks included in the Employee Separation Service Request are based on standard offboarding
tasks from a Service Catalog Template (SCT) as well as added tasks representing known equipment and
accesses. This section outlines the Service Request and associated Task information.

Categorization: The categorization within Cherwell HR Case Management is unique value set; it will not
interfere with an existing implementation, and can be easily modified.

Requestor: Hiring Manager.

Tasks: Generated by the associated SCT, which is applied by selecting the Initiate IT Off-boarding One-
Step™ Action.

The Service Request (and associated Tasks) is worked through completion as a normal IT request ticket.
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IT Training mApp Solution 1.0
The IT Training mApp® Solution provides functionality that allows you to manage Training Course
opportunities for customers.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 5.0.0.

Out-of-the-Box Content Version Requirements: Tested on CSM 5.x and 6.x. Not compatible with
Content versions from CSM 9.3.x or later.

Prerequisite Requirements: None

Overview
Using the mApp Solution, Users (typically, IT Training Managers) define and manage Training Courses in
the CSM Desktop Client, and then Customers view and interact with Training Tasks in the Customer
Portal. The mApp Solution includes three types of courses, including:

• Initial Training Course: Training Course that occurs once and provides new employees with the
knowledge and skills necessary to become effective members of an organization (example: IT
Security Overview). This type of course is assigned to individual Users.

• One-Time Training Course: Training Course that occurs once and does not require subsequent
related courses (example: ITIL Foundation Training). This type of course is assigned to individual
Users or entire Departments.

• Recurring Training Course: Training Course that occurs multiple times based on a defined schedule
and requires subsequent related courses (example: Data Center Procedures). This type of course is
assigned to individual Users or entire Departments.
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The mApp Solution includes features such as new Business Objects (example: Training Courses and
Training Tasks), Automation Processes (example: Send notification e-mails), and a Dashboard (example:
View real-time training data).

How the mApp Solution Works
CSM provides IT Training as a mApp Solution so that Users can easily incorporate IT Training
management functionality into their existing CSM system. Download the mApp Solution from the Cherwell
mApp Exchange. Use the Apply mApp wizard to apply the mApp Solution to your CSM system. The Apply
mApp wizard generates a Blueprint, which can then be viewed and published to a test or Live system to
commit the changes.

The mApp Solution includes a separate .csv file called Sample Courses that includes fourteen defined
example Training Course records. It can be imported after the mApp Solution is applied by running a one-
time data import.

The mApp Solution includes the following items:

Item Category Item Typical Merge
Action

Business Object

 

Customer Training, Training Course, Training Course
Departments, Training Course Frequency, Training
Course Status, Training Task, Training Task On Hold
Reason, Training Task Status`

Import

Customer, Customer - Internal Don't Change

One-Step Action Numerous Import

Automation Process

Auto Retire Course, Cancel Training Tasks, Create
Training Task, Send Cancelled Email, Send Employee
Training Reminder, Send Hold Review Email, Send On-
Hold Email

Import

Counter Training Task ID Import

Custom View

 

Customer - Internal Don't Change

Customer Training, Training Course, Training Task,
Training Task On Hold Reason, Training Task Status Import

Dashboard

 

Portal Default Don't Change

Training Status Import

Metric

Active Courses, Cancelled By Admin, Cancelled
Customer Training, Employees Enrolled, My Current
Training, On-Hold Courses, Training Tasks Cancelled,
Training Tasks Complete, Training Tasks in Progress,
Training Tasks not Acknowledged, Training Tasks On
Hold, Training Tasks Past Due

Import

Expression Numerous Import
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Stored Query

Active Courses, Active Courses by Department,
Cancelled Customer Training, Inactive Courses, Inactive
Courses, Initial Courses, My Active Courses, My Current
Training Tasks, One-Time Courses, Recurring Courses,
Training Tasks with Comments

Import

Widgets Numerous Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About Business Objects • About Dashboards

• About Customer Portals • About Widgets

• About Automation Processes • About mApp Solutions

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution
After applying the mApp Solution, perform the following high-level steps to configure the mApp Solution:

1. Add Training Widgets to the Default Portal Dashboard.
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How to Use the mApp Solution in the CSM Desktop Client

• Create an IT Training record.

How to Use the mApp Solution in the Customer Portal

• Track and complete an IT Training Task.
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Configuring the IT Training mApp Solution
Complete the following procedure to configure the IT Training mApp Solution. The configuration
procedure is completed in CSM Administrator.
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Add Training Widgets to the Default Portal
Dashboard

Use the Default Portal Dashboard Editor to add Widgets to the Dashboard.

Note: This functionality is only available if you have applied the IT Training mApp Solution. For
more information, refer to the mApp Solution Tech Notes documentation.

To add Widgets to the Dashboard:

1. Open the Portal Default Dashboard in the Dashboard Editor.

2. Add a My Current Training Text Widget to the Dashboard (under the My Items section):
a. From the Shapes, etc. Widget tree, click-and-drag a Text Widget to the Dashboard (under the

My Items section).

b. In the Label Text field on the Dashboard Editor toolbar, type My Current Training.

The text displays on the Dashboard.

Tip: Use the Dashboard Editor to define how the Text Widget looks and behaves on the
Dashboard (example: Text properties (font, font size, font style, text wrap), size, color
(background, foreground, and border), background style and gloss, alignment, anchoring,
layering, and visibility).

3. Add the My Current Training Widget to the Dashboard:

Note: My Current Training is a Gauge Widget that allows Customers to access their Training
Tasks via the Customer Portal.

a. From the Training Widget tree, click-and-drag the My Current Training Widget onto the
Dashboard (to the right of the Training Courses Assigned to Me Text Widget).

The Widget displays on the Dashboard.
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Tip: Use the Dashboard Editor to define how the Text Widget looks and behaves on the
Dashboard (example: Text properties (font, font size, font style, text wrap), size, color
(background, foreground, and border), background style and gloss, alignment, anchoring,
layering, and visibility).

4. Select OK.
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Using the IT Training mApp Solution
When working with the IT Training mApp Solution, Users can:
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Create an IT Training Record
Use the Course Form in the CSM Desktop Client to create an IT Training record.

Note: This functionality is only available if you have applied the IT Training mApp Solution. For
more information, refer to the mApp Solution Tech Notes documentation.

To create an IT Training record:

Good to know:

• When a value is provided in the Category field and the record is saved, the new category is saved
as an option in the drop-down for future Course records.

• Frequency and Type fields are populated based on Lookup Table values in Table Management.
Add, edit, or delete field values by selecting the field, and then pressing F3.

• The Frequency field is only required for Recurring Courses.

• The Start Date field is only required for One-Time and Recurring Courses. The start date for Initial
Courses is automatically recorded on the day that the Course is created.

• The Initial Training Period field is only required for Initial Courses, and calculates a deadline for the
Course (number of days after the Course record is created in which the User must complete the
Course).

• Assign Courses using:

• Course record: In the Main Pane, click the Assign to Department button or the Assign to Individual
button.

• Customer record: In the Form Arrangement, click the Training Course tab, and then click the New
Customer Training button.

• You can assign a One-Time or Recurring Course to either an individual User or an entire
Department. You can assign an Initial Course only to an individual User.

• Use the I Want To section of the Quick Info Tile to:

• Take Ownership: Click the link to make yourself the User owner.

• View Detailed Date/Time Information: Click the link to open the Information window, where you can
view current status, created date and time, creator name, and last edited date and time. Time Date/
time format is MM/DD/YYYY HH:MM.

• Place Course on Hold: Click the link to change the Courses status to On Hold.

• Clone Course: Click the link to create a new Course record that includes field values from the
original Course.

• Retire a Course by clicking the Retire Course link in the Status bar when the Course has a status of
Active.

• View real-time training data using the Training Status Dashboard (Dashboards>Dashboard
Manager>Global folder>Dashboards>Training Dashboard>Training Status).
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1. On the CSM Desktop Client toolbar, click New>New Training Course.

A new Course record is created with a status of New.

2. Record the Course details:
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a. Title: Provide a title for the Course (example: IT Security Overview).

b. Course Number: Provide letters and/or numbers that uniquely identify the Course (example:
IT01).

c. Category: Provide a category for the Course (example: IT).

d. Reference (if applicable): Provide a reference for the Course, such as a specific government
regulation or company policy.

e. Type: From the drop-down, select the type of Course (example: Initial).

f. Frequency: From the drop-down, select the frequency of the Course.

g. Start Date: Click the Date Selector button  to select the day in which the Course begins.

h. End Date: Click the Date Selector button  to select the day in which the Course ends
(example: 3/25/2015 8:00 AM).

Note: The Course status automatically changes to Retired when the Course reaches the
defined End Date.

i. Initial Training Period: [number] days from hire/transfer date: Specify the number of days
from the start date that the Customer must complete the Course (example: 14).

j. Initial Notification: [number] days before the due date: Specify the number of days before the
start date that the initial e-mail is sent.

853

CSM mApp Solutions

CSM mApp Solutions



k. Reminder E-mail: [number] days after the due date (if Training is incomplete): Specify the
number of days after the due that that a reminder e-mail is sent (example: 5).

l. Training Location: Provide a location for the Course (example: Gina Mehra's Office).

m. Description: Provide a description for the Course (example: The IT Security Overview
provides new employees with an overview of IT security practices, which includes information
regarding the employee's ID card, system PIN, network access, and safe e-mail practices).

n. Instructions: Provide instructions for the Customer, which will display in the initial e-mail.

3. Activate the Course:
a. In the Status bar, click the Activate link.

The Course is active.

4. Assign the Course to either a User or entire Department:

Note: Assignment options vary based on the type of course. One-Time and Recurring
Courses can be assigned to either an individual User or an entire Department. Initial
Courses can be assigned only to an individual User.
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a. Assign to Department:
i. Click the Assign to Department button.

A prompt opens.

ii. From the drop-down, select a Department.

iii. Select OK.

A Training Course record displays in the Form Arrangement for each User in the
Department, a notification e-mail is sent to Users in the Department and their manager,
and a Training Task is created in the Customer Portal for each User in the Department.

b. Assign to Individual:
i. Click the Assign to Individual button.

A prompt opens.

ii. Click the Ellipses button  to open the Customer Selector.

The Customer Selector opens.

iii. Select a Customer (example: Josh Wilson).
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iv. Select OK.

A Training Course record displays in the Form Arrangement, a notification e-mail is sent
to the User and his manager, and a Training Task is created in the Customer Portal for
the User.
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Track and Complete an IT Training Task
Use the CSM Portal to track and complete an IT Training Task.

Note: This functionality is only available if you have applied the IT Training . For more information,
see the mApp Solution Tech Notes documentation.

To track and complete an IT Training Task:

1. Log into the Customer Portal.
2. In the My Items section, select the My Current Training link.

The My Current Training page opens.
3. Select the Training Task link.

The Training Task opens.
4. From the Portal Task toolbar, select the Edit button.
5. In the Actions section, select the Next: Acknowledge link to acknowledge that you are aware of

the Training Task.

The status changes to Acknowledged.

6. (Optional) Defer the Training Task:
a. In the I Want To section of the Actions section, select the Defer Training link.
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A prompt opens.

b. From the Reason for Deferring Training drop-down list, select a reason.
c. Select OK.

Note: The Customer's manager receives a notification email and the Training Course
enters a status of On Hold. Reactivate the Training Course by selecting the Next:
Remove Hold Status link in the Actions section.

7. Complete the Training Task:
a. In the Actions section, select the Next: Set as In Progress link.

The status changes to In Progress.

b. When the Training Task is complete, select the Next: Certify Complete link in the Actions
section.

A prompt opens.
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c. Provide feedback about the Course.
d. Select OK. The Training Task status changes to Complete.

8. Log out of the CSM Portal.
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JIRA mApp Solution 2.0
The JIRA mApp® Solution provides functionality that allows for JIRA bug tracking, issue tracking, and
project management functions in CSM.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 9.6.x and 9.7.0

Out-of-the-Box Content Version Requirements: Tested on CSM 9.6.1 and 9.7.0. This mApp Solution
may not be compatible on Content versions earlier than 9.6.1, but as with all mApp Solutions, it should be
tested on your customized system.

Prerequisites: None

This mApp Solution is only available in English.

Overview
CSM integrates with JIRA so that Incidents and Problems logged in CSM can be tracked in JIRA as the
applicable issue type and status changes in CSM are recorded in the corresponding JIRA Issue. This
mApp Solution includes functionality to post to JIRA, add comments to JIRA, and update JIRA statuses
via REST Web Service calls. The responses are updated in the CSM Object as applicable and are logged
in the Journal - Integrations Audit log.
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Relating Issues in JIRA
As with CSM, Issues in JIRA can be related to other Issues. When an Incident that has a JIRA Issue Key
is linked to a Major Incident or Problem that also has a JIRA Issue Key, the relationship is automatically
updated on JIRA by means of an Automation Process.

Updating Statuses within JIRA
Entering status details from JIRA Project Workflows into the JIRA Status Table enables the ability to
transition your JIRA Issue Statuses from within corresponding Incident and Problem records.

How the mApp Solution Works
CSM provides the JIRA V2.0 mApp Solution so Users can exchange data between JIRA and CSM using
a web service. Download the mApp Solution from the Cherwell mApp Exchange. Use the Apply mApp
wizard to apply the mApp Solution to your CSM system. The Apply mApp wizard generates a Blueprint,
which can then be viewed and published to a test or live system to commit the changes.

For a list of items included in the mApp Solution, see JIRA mApp Solution Items.
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Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution
After applying the mApp Solution, perform the following high-level steps to configure the mApp Solution:

1. Configuring the JIRA mApp Solution.

2. Finding JIRA Statuses and Transition Numbers.

3. Define JIRA Options in CSM.

Using the JIRA mApp Solution
To use the mApp Solution, see: Using the JIRA mApp Solution.

Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.5 8.2.1 8.0.0 None

2.0 9.6.x and 9.7.0 9.6.x and 9.7.0 None

Related concepts
About mApp Solutions
Go to the Cherwell Marketplace (formerly the mApp Exchange)
Apply a mApp Solution
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JIRA mApp Solution Items
Use the mApp Solution Items table to determine which choices to make when applying the mApp
Solution.

The JIRA mApp Solution includes the following items:

Item Category Item Typical Merge Action

Automation process definition JIRA Add Linked Incident Import

Automation process definition JIRA Link Major Incident Import

Automation process definition JIRA Link Problem Import

Automation process definition JIRA Update Problem Workaround Import

Automation process definition JIRA Update Problem Status Import

Automation process definition JIRA Update Status Import

Business Object JIRA Issue Type Import

Business Object JIRA Project Import

Business Object JIRA Status Import

Business Object Journal - Integrations Audit Import

Business Object Incident Merge

Business Object Problem Merge

Grid JiraIssueType Import

Grid JiraProject Import

Grid JIRAStatus Import

Grid JournalServices Import

Grid Incident Overwrite

Grid Problem Overwrite

Image definition Jira 64x64 Import

Mergeable Area Incident Actions Overwrite

Mergeable Area Problem Actions Overwrite

One-Step Add Related Incident (Problem) Import

One-Step Add Related Incident (Incident) Import

One-Step Add Status Comment Import

One-Step Add Workaround as Comment Import

One-Step Change JIRA Status (Problem) Import
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Item Category Item Typical Merge Action

One-Step Change JIRA Status (Incident) Import

One-Step Get JIRA Status (Problem) Import

One-Step Get JIRA Status (Incident) Import

One-Step Link Related Incidents Import

One-Step Link to Major Incident Import

One-Step Link to Problem Import

One-Step Open Incident in JIRA Import

One-Step Open Problem in JIRA Import

One-Step Post Admin Note to Jira Import

One-Step Post Admin Note to JIRA Import

One-Step Post Comment (Problem) Import

One-Step Post Comment (Incident) Import

One-Step Post to Jira Import

One-Step Post to JIRA Import

One-Step Set JIRA Server Import

One-Step Update Status Import

Relationship Incident Links Default JIRA Issue
Type Import

Relationship Incident Links Specific JIRA Issue
Type Import

Relationship Problem Links Default JIRA Issue
Type Import

Relationship Problem Links Specific JIRA Issue
Type Import

Search JIRA Closed Incidents Import

Search JIRA Closed Problems Import

Search JIRA Closed Service Requests Import

Search JIRA Open Incidents Import

Search JIRA Open Problems Import

Search JIRA Open Service Requests Import

Stored expression 400 Import

Stored expression 401 Import

Stored expression 403 Import
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Item Category Item Typical Merge Action

Stored expression 404 Import

Stored expression 405 Import

Stored expression 500 Import

Stored expression 503 Import

Stored expression ErrorCode Import

Stored expression JIRA Issue Key Visibility Import

Stored expression JIRA Issue Type Import

Stored expression JIRA Issue URL (Problem) Import

Stored expression JIRA Issue URL (Incident) Import

Stored expression JIRA Key Visibility Import

Stored expression JIRA Type Import

Stored expression json Import

Stored value JIRA Integration Version Import

Stored value JIRA URL Import

Stored value JIRA Web Service Import

Theme Prussian Blue Don't Change

Web service JIRA Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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Configuring the JIRA mApp Solution
Configure the JIRA V2.0 mApp Solution using the CSM Desktop Client, CSM Administrator, and JIRA.

To configure the web service:

1. In the CSM Administrator, select Browser and Mobile Settings from Categories and then select
Web Service Manager.

2. Right click on the JIRA Service and select Edit.
3. Select the General page and enter your JIRA URL.

4. Select the Methods page.

Methods should show for Post Issue, Add Note to Issue, Link Issues, Status Transition, and Get
Issue Status. Additional methods can be added as required. For additional information, see the JIRA
online API: https://developer.atlassian.com/jiradev/jira-apis.

5. Select the Accounts page and select Login and then Edit.
6. Enter a User Name for your JIRA account. Ensure the user account has the Administrator role at

the Project level.

7. In the Password field, do NOT enter the password but enter the API token instead. See: https://
id.atlassian.com/manage/api-tokens.
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To configure Stored Values:

1. In the CSM Administrator, select Settings from Categories and then select Open Stored Values
Manager.

2. Go to Global > Integrations in the left-hand pane.
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3. To view the Stored Value properties, select the Stored Value and select Edit.
4. Do not edit the JIRA Integration Version.

5. Ensure that the JIRA URL matches the URL of the Web Service Object.

6. Ensure that the JIRA Web Service matches the name of the Web Service Object.

To enable Automation Processes:

1. In the CSM Administrator, select Automation Processes.

2. Select Individual Automation Process Status.

3. Enable all six of the JIRA Automation Processes.
a. JIRA Add Linked Incident

b. JIRA Link Major Incident

c. JIRA Link Problem

d. JIRA Update Problem Workaround

e. JIRA Update Problem Status

f. JIRA Update Status

To configure the Incident and Problem Forms:

1. In the CSM Administrator, open a Blueprint, then select Edit Form....
2. In the Form drop-down list (top left-hand side), select Incident Issue JIRA Key.
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These forms have a range of optional Elements that you may or may not wish to use. There is a
description of the function and visibility rules next to each Element.

3. Select the Elements that you want to add to your Overview Form.

4. Copy the Elements.

5. In the Form drop-down list, select Incident Overview.

6. Select Yes when prompted to apply Incident Form changes back to the Blueprint.
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7. Paste the JIRA Elements on to the Form.

8. Move your Elements to the desired location on the Overview Form. There are examples shown
below of the JIRA Elements in use on both Incident and Problem Forms to give you some ideas for
placement.
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To configure Actions for Incidents and Problems:

1. In the same Blueprint, open Edit Actions.

2. Select Menu.

3. Create a new folder under Actions named JIRA.

If you would like to add the JIRA logo to the folder, it can be found here: Global/Integrations/
Jira64X64.

4. Add the following One-Step Actions:

Location Display Text Expressions

Blueprint\JIRA\Post to JIRA Post to JIRA Enabled: Incident Jira Issue Key Empty

Blueprint\JIRA\Post Comment Add Comment Enabled: Incident Jira Issue Key not
Empty

Blueprint\JIRA\Get JIRA Status Refresh Status Enabled: Incident Jira Issue Key not
Empty
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5. Select Task Pane on the left and repeat steps 2-4 for Task Pane.

6. Select OK to save.

7. Publish the Blueprint.

Related concepts
Automation Processes
About mApp Solutions
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Define JIRA Options in the CSM Desktop Client
Define a JIRA Project, Statuses and Issue Types to complete implementation of the JIRAmApp Solution.

The following procedures are the second step in configuring the JIRA V2.0 mApp Solution

Note: This functionality is only available if you have applied the JIRA V2.0 mApp Solution.

Steps to Define JIRA Options in CSM
To configure Projects in the mApp Solution using the Desktop Client:

1. In the CSM Desktop Client, open the Table Management Interface (under Tools in the menu bar).

2. In the Type drop-down, select JIRA Project.
3. Select New next to the JIRA icon in the toolbar.

4. Create a new JIRA Project record for each project within JIRA that you want to post Cherwell
Incidents and Projects to.

Note: Ask your JIRA administrator for the JIRA Project Names and Keys for each project
you want to add to CSM.

To define JIRA Statuses:

1. In the CSM Desktop Client, open the Table Management Interface (under Tools in the menu bar).
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2. In the Type drop-down list, select JIRA Status.

3. Select the JIRA icon in the toolbar and then select Add a JIRA Status.

4. Create a new JIRA status record for each status in your JIRA projects.
a. Select the Project Name.

b. Enter the JIRA Status.

c. Enter the JIRA Status Transition Number.

Note: For instructions on how to obtain JIRA Statuses and Transition Numbers, see Finding JIRA
Statuses and Transition Numbers.

Note: This mApp is configured to allow Users to choose any status within the workflow, but if your
Project Workflow in JIRA has constraints on when Users can move from one status to another,
you can use Expressions to limit the status options depending on the current status of your JIRA
issues.

To modify the status options using Expressions:

1. In CSM Administrator, create a new Blueprint.
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2. Select Managers from the menu bar and then select One-Step.

3. Set the Association to Incident.
4. Edit the Change JIRA Status One-Step found in the Blueprint/JIRA folder.

5. Select the second step Validate Stored Values and double-click on the Prompt.

6. In the Constraints sections, add additional Expressions to limit the statuses shown.

7. Repeat steps 3-6 for Problem.

8. Publish the Blueprint.

Note: If you have many complex workflows within your JIRA projects, using the feature to change
the statuses from within CSM may not be possible. This feature is for simple workflows. If you feel
your JIRA Project workflows are too complex or you just don't want to use this feature in CSM,
you can simply disable it by following these instructions:

1. In CSM Administrator, create a new Blueprint.

2. Select the Incident Business Object and select Edit Business Object.
3. Select JIRA Status in the list of fields and then select Field Properties.

4. Select Validation/Auto-populate from the sidebar.

5. Clear the Validate from JIRA Status Table check box.

6. Clear the Auto-populate check box.

7. Select OK to save.

8. Locate the JIRA Status ID field.

9. Repeat steps 1-7.

10. Select the Problem Business Object.

11. Repeat steps 1-9 for the Problem Business Object.

Note: Ensure you do not add the Change JIRA Status buttons or links to your Problem and
Incident Forms if you choose not to use this feature.

Configuring Issue Types
JIRA supports multiple Project types and allows for custom issue types on a per-Project basis. Coordinate
with the JIRA administrator about the types of Issues associated with each Project. The most common
issue types are preloaded as default issue types in the JIRA Issue Type lookup table. If a JIRA Project
uses non-standard issue types, add the issue types to the lookup table.

To configure Issue Type:

1. In the CSM Desktop Client, open the Table Management Interface (under Tools in the menu bar).

2. In the Type drop-down list, select JIRA Issue Type.
A list of default issue types that are mapped to CSM objects shows.
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3. Double-click an issue type to view the properties.

Note: Select the JIRA icon to add a new issue type.

Related concepts
JIRA mApp Solution 2.0
Table Management Interface Behaviors
Related tasks
Finding JIRA Statuses and Transition Numbers
Create an Expression
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Finding JIRA Statuses and Transition Numbers
To define JIRA Statuses in CSM, you need to know the JIRA Statuses and Transition Numbers.

To find JIRA Statuses and Transition Numbers from within your JIRA account:

1. Log in to your JIRA account.
2. Select the Project that you need status details for.
3. Select Project Settings in the sidebar.
4. Select Workflows in the sidebar.
5. Select the pencil icon under Actions.

6. Select Text for the view.
You see a listing of all available statuses within your project. The Transition IDs column has the
Status Names and Transition IDs you need to enter into CSM.

Note: The ID numbers in the first column are not transition IDs, and will cause errors if used.
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Related concepts
Define JIRA Options in the CSM Desktop Client
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Using the JIRA mApp Solution
The JIRA V2.0 mergeable application (mApp) Solution provides functionality that allows for JIRA bug
tracking, issue tracking, and project management functions in CSM.

The following tasks and functions are available with the JIRA mApp Solution:
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Posting an Issue to JIRA
Post issues to JIRA from CSM using the functionality of the JIRA v2.0 mApp Solution.

To post an issue to JIRA:

1. In the CSM Desktop Client, open an existing Incident or Problem or create a new one.
2. Select the Post to JIRA link or button.
3. Select the JIRA Project for that issue.

When the One-Step Action has finished running, if successful, you see a pop-up window showing
your JIRA Issue Number. A Journal Note is created with details of the JIRA interaction, whether
successful or not.

4. Look at your form where you now see a link showing the JIRA Issue Number.
5. Select the JIRA Issue Number to open the issue in JIRA.

Related concepts
Using the JIRA mApp Solution
View Issues in JIRA
Related tasks
Post a Comment in JIRA
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View Issues in JIRA
If you have applied the JIRA v2.0 mApp Solution, you can view issues from CSM in JIRA.

Any Incident or Problem in CSM that has been sent to JIRA has a hyperlink to JIRA.

To view the corresponding Issue in JIRA:

1. Select the hyperlink on the Incident or Problem Form.

2. Log in to JIRA by providing a Username and Password. The login page won't appear if you are
already logged in.
The issue opens in JIRA.

Note: Comments posted manually to JIRA from CSM can only be viewed by JIRA
administrators.
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Related concepts
Using the JIRA mApp Solution
Related tasks
Post a Comment in JIRA
Get or Refresh JIRA Status
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Get or Refresh JIRA Status
You can get or refresh the status of JIRA issues when using the JIRA v2.0 mApp Solution.

To get or refresh JIRA Status:

1. In the CSM Desktop Client, select the Get/Refresh JIRA Status link or button.
On the form, you see a link displayed with the current status of the issue in JIRA.

2. Select the JIRA Status link to refresh the issue.
3. The option to Change JIRA Status is now available if this functionality is enabled.

Related concepts
Using the JIRA mApp Solution
View Issues in JIRA
Related tasks
Post a Comment in JIRA
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Post a Comment in JIRA
Post comments in JIRA directly from CSM using the JIRA v2.0 mApp Solution.

To post a comment in JIRA:

Note: Only available for Incidents and Problems that are posted to JIRA.

1. In the CSM Desktop Client, select the Post Comment or Post Admin Comment link or button.

2. Enter the comment in the pop-up window and select OK.
When the One-Step Action has finished running successfully, you see a confirmation message that
your comment was posted. A Journal note is created with details of the JIRA interaction, successful
or unsuccessful.

3. When you view the issue in JIRA, you see the comments in the Comment section of the issue. If you
posted an Admin comment, only Administrators can see the comment and it is noted in JIRA that it
is an Admin comment.

Related concepts
Using the JIRA mApp Solution
Related tasks
Changing status in JIRA
Changing CSM status
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Changing status in JIRA
Using a One-Step Action in CSM, you can change the status of an Incident or Problem in JIRA.

To change the status of an Incident or Problem in JIRA:

Note: Only available if you are using the Change Status feature.

1. In the CSM Desktop Client, select the Change JIRA Status link or button. If this button is not
available, select Get JIRA Status first.

2. Select the status you want to change the Incident or Problem to.
3. Select OK.

When the One-Step Action has finished running successfully, you see a confirmation message that
the status in JIRA has been changed. A Journal note is created with details of the JIRA interaction,
successful or unsuccessful. The Incident or Problem is updated to show the new JIRA status.

Related concepts
Using the JIRA mApp Solution
Related tasks
Changing CSM status
Linking Incidents to Major Incidents
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Changing CSM status
If you have applied the JIRA v2.0 mApp Solution, you can change the status of an Incident or Problem in
CSM.

To change the status of an Incident or Problem within CSM:

Note: Only available for Incidents and Problems previously posted to JIRA. To use this feature,
Automation Processes must be enabled and configured.

1. In the CSM Desktop Client, open an Incident or Problem that has previously been posted to JIRA.
2. Advance the status of the Object.

An Automation Process runs and adds a comment to the JIRA issue indicating the CSM status
change. This may take a few minutes.

Related concepts
Using the JIRA mApp Solution
Related tasks
Linking Incidents to Major Incidents
Linking Problems and Incidents

886

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/bundle/csm_mapps_integrations_help_only/page/content%2Fmapps_and_integrations%2Fmapp_tech_notes%2F..%2F..%2F..%2Fcontent%2Fmapps_and_integrations%2Fmapp_tech_notes%2Fusing_the_jira_mapp.html
https://help.cherwell.com/bundle/csm_mapps_integrations_help_only/page/content%2Fmapps_and_integrations%2Fmapp_tech_notes%2F..%2F..%2F..%2Fcontent%2Fmapps_and_integrations%2Fmapp_tech_notes%2Flinking_incidents_to_major_incidents.html
https://help.cherwell.com/bundle/csm_mapps_integrations_help_only/page/content%2Fmapps_and_integrations%2Fmapp_tech_notes%2F..%2F..%2F..%2Fcontent%2Fmapps_and_integrations%2Fmapp_tech_notes%2Flinking_problems_and_incidents.html


Linking Incidents to Major Incidents
Use the power of an Automated Process to link an Incident to a Major Incident in JIRA.

To link an Incident to a Major Incident:

Note: Only available if both the Incident and Major Incident have previously been posted to JIRA.
To use this feature, Automation Processes must be enabled and configured.

1. In the CSM Desktop Client, open an Incident that has previously been posted to JIRA.
2. Select Actions > Link to Major Incident.
3. Select a Major Incident from the list that has previously been posted to JIRA.

An Automation Process runs and adds a comment to both JIRA issues indicating that the two
Incidents are now linked. This may take a few minutes.

Related concepts
Using the JIRA mApp Solution
Related tasks
Linking Problems and Incidents
Adding a Workaround to a Problem
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Linking Problems and Incidents
If you have applied the JIRA v2.0 mApp Solution, you can link a Problem to an Incident in JIRA.

To link a Problem to an Incident:

Note: Only available if both the Problem and Incident have previously been posted to JIRA. To
use this feature, Automation Processes must be enabled and configured.

1. In the CSM Desktop Client, open a Problem that has previously been posted to JIRA.
2. Select the Incidents tab.
3. Select the Link icon in the Tab toolbar.
4. Select an Incident from the list that has been previously posted to JIRA.

An Automation Process runs and adds a comment to both JIRA issues indicating that the Problem
and Incident are now linked. This may take a few minutes.

Related concepts
Using the JIRA mApp Solution
Related tasks
Linking Incidents to Major Incidents
Adding a Workaround to a Problem
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Adding a Workaround to a Problem
Use the power of an Automated Process to add a workaround to a JIRA issue from CSM.

To add a workaround to a Problem:

Note: Only available if the Problem has previously been posted to JIRA. To use this feature,
Automation Processes must be enabled and configured.

1. In the CSM Desktop Client, open a Problem that has previously been posted to JIRA.
2. Enter text in the Workaround field.

An Automation Process runs and adds a comment to the JIRA issue showing that the Problem has
a workaround. The text from the Workaround field is added into JIRA. This may take a few minutes.

Related concepts
Using the JIRA mApp Solution
Related tasks
Linking Problems and Incidents
Using Actions in CSM Desktop Client or Browser Client Menu

889

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/bundle/csm_mapps_integrations_help_only/page/content%2Fmapps_and_integrations%2Fmapp_tech_notes%2F..%2F..%2F..%2Fcontent%2Fmapps_and_integrations%2Fmapp_tech_notes%2Fusing_the_jira_mapp.html
https://help.cherwell.com/bundle/csm_mapps_integrations_help_only/page/content%2Fmapps_and_integrations%2Fmapp_tech_notes%2F..%2F..%2F..%2Fcontent%2Fmapps_and_integrations%2Fmapp_tech_notes%2Flinking_problems_and_incidents.html
https://help.cherwell.com/bundle/csm_mapps_integrations_help_only/page/content%2Fmapps_and_integrations%2Fmapp_tech_notes%2F..%2F..%2F..%2Fcontent%2Fmapps_and_integrations%2Fmapp_tech_notes%2Fusing_actions_within_csm_desktop_or_browser.html


Using Actions in CSM Desktop Client or Browser
Client Menu

Use Incident or Problem Actions from withinCSM to make changes to JIRA issues.

To use Actions in the Desktop Client or Browser Client menu:

1. Open an Incident.
2. Select Incident Actions in the menu bar.

You see a JIRA folder with available options.
3. Open a Problem.
4. Select Problem Actions in the menu bar.

You see a JIRA folder with available options.

Related concepts
Using the JIRA mApp Solution
Related tasks
Using Actions in CSM Desktop Client Task Pane
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Using Actions in CSM Desktop Client Task Pane
The JIRA V2.0 mergeable application (mApp) Solution provides functionality that allows for JIRA bug
tracking, issue tracking, and project management functions in CSM.

To use Actions in the Desktop Client Task pane:

1. Open an Incident and look for the Incident Actions in the Task pane.
You see a JIRA folder with available options.

2. Open a Problem and look for the Problem Actions in the Task pane.
You see a JIRA folder with available options.

Related concepts
Using the JIRA mApp Solution
Related tasks
Using Actions in CSM Desktop Client or Browser Client Menu
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Microsoft® Skype for Business® mApp Solution
1.0

The Microsoft® Skype for Business® mApp® Solution provides functionality that allows you to facilitate
real-time online collaboration through conversations (text, voice, video, and presence information),
desktop sharing, and online meetings.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 5.0.0 - 9.4.0a

Out-of-the-Box Content Version Requirements: Tested on CSM 5.0.0 - 9.4.0a

Prerequisite Requirements: None

Overview
When Skype for Business is incorporated into CSM, Users can initiate Skype conversations with
Customers, employees, or teams in their Skype network directly from a CSM record. When CSM is
integrated with Skype, a Start Skype Conference Action displays in the Task Pane. Click the Action to
initiate a conversation with an individual (Customer or User) or a team related to the Business Object.

Notes: Conferences are only available for contacts in your Skype network. Conferences cannot
be saved in CSM, but can be saved in Skype, if configured.

How the mApp Solution Works
CSM provides the Skype functionality as a mApp Solution so that Users can easily incorporate Skype
conversations into their existing CSM system. Download the mApp Solution from the Cherwell mApp
Exchange. Use the Apply mApp wizard to apply the mApp Solution to your CSM system. The Apply mApp
wizard generates a Blueprint, which can then be viewed and published to a test or Live system to commit
the changes.

The mApp Solution includes the following items:

Item Category Item Typical Merge Action

Business Object
Change Request, Configuration
Item, Customer, Incident, ITPT
Project, Release, Task

Don't Change

Variable Validation Overwrite

Image Skype 16x16, Skype 32x32, Skype
498x48 Overwrite

One-Step Action Start Skype Conference Overwrite
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Item Category Item Typical Merge Action

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered
in any way. The mApp Solution includes the definition for
informational purposes only (the definition is not imported into the
target system).

Related Reading

• Configuring mApp Solutions

• About mApp Solutions

Apply mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.
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On Call mApp Solution 1.0
The On Call mApp® Solution provides functionality that allows you to automatically notify defined users
when an urgent Incident (P1, P2, or VIP) is created outside of normal Business Hours.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 5.0.0.

Out-of-the-Box Content Version Requirements: Tested on CSM 5.0.0.

Prerequisite Requirements: None

Overview
Configure the mApp Solution by defining On Call Groups (Users who are responsible for the Incident), On
Call Service Groups (On Call Groups assigned to each Service), and On Call Shifts (timeframe of the On
Call instance).

After the mApp Solution is configured, Users create an On Call record, which schedules an On Call
Service Group (example: Weekend Crew) to an On Call Shift (example: Weekend – First). If an urgent
Incident is created during the selected On Call Shift timeframe, the On Call Group assigned to the
selected Service is displayed in the Form Arrangement and a notification e-mail is sent to the first User in
the On Call Group. If the first User does not take ownership within the defined timeframe, a notification e-
mail is sent to the first and second Users in the group. If the first and second Users do not take ownership
of the Incident within the defined timeframe, a notification e-mail is sent to all Users in the group. If no one
responds within the defined timeframe, a notification e-mail is all Users in the group until one of the
individuals takes ownership.
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This mApp Solution includes features such as new Business Objects (example: On Call, On Call Groups,
etc.), Automation Processes (example: On Call Notification), Calendars (example: On Call, My On Call
Calendar), and Widgets (example: On Call Tier 1 Incidents).

How the mApp Solution Works
CSM provides On Call as a mApp Solution so that Users can easily incorporate on call scheduling and
automation to their existing system. Download the mApp Solution from the Cherwell mApp Exchange.
Use the Apply mApp wizard to apply the mApp Solution to your CSM system. The Apply mApp Solution
wizard generates a Blueprint, which can then be viewed and published to a test or Live system to commit
the changes.

The mApp Solution includes the following items:

Item Category Item Typical Merge Action

Business Object

 

On Call, On Call Groups, On Call Service Profile, On
Call Shifts Import

Incident Merge

UserInfo Don't Change

Automation Process E-Mail On Call Individuals, On Call Notification Import
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One-Step Action

 

Delete Current Calendar Even, Delete On Call Record,
Delete Recurrence, E-Mail On Call Individuals, Escalate
to On Call Individual, Find E-Mail, Get Distribution List,
Make Delete Button Visible, Raise Alert Level, Recur
Daily, Recur Daily Loop, Schedule Notification, Set
Group Stored Values, Set Recurrence to False, Set
Recurrence to True, Set Schedule, Set Schedule Type

Import

Take Ownership Overwrite

Calendar My On Call Calendar, On Call Import

Custom View Portal Default Don't Change

Stored Expression

 

Concatenate Date Time, Current Date Time, Current
Date Minus 2 Weeks, Current Date Plus One Week,
Current Date Plus Two Months, Escalate E-Mail,
Escalate Name, Escalate Wait Time, is Like Current
User Name

Import

System State E-Mail Don't Change

Stored Query All On Calls, Calendar View, Current On Call, Find All
Associated Recurrences, My Calendar View, On Call  

Stored Value Numerous Import

Theme Professional Grey Don't Change

Widget On Call Escalation Comparison, On Call Tier 1 Incidents,
On Call Tier 2 Incidents, On Call Tier 3 Incidents  

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About Services

• Table Management

• Log an Incident

• About mApp Solutions

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

896

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/csh?topicname=about_services_and_service_catalogs
https://help.cherwell.com/csh?topicname=table_management
https://help.cherwell.com/csh?topicname=log_an_incident_-_detailed
https://help.cherwell.com/csh?topicname=about_mapps


1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution

1. Define On Call groups.

2. Define On Call Service profiles.

3. Define On Call shifts.

4. (Optional) Define e-mail settings.

How to Use the mApp Solution

• Create an On Call record.
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Configuring the On Call mApp Solution
Complete the following procedure to configure the On Call mApp Solution. Configuration procedures are
completed in the CSM Desktop Client and in CSM Administrator.
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Define On Call Groups
Use Table Management in the CSM Desktop Client to define On Call groups for the On Call mApp
Solution.

Note: This functionality is only available if you have applied the On Call mApp Solution. For more
information, refer to the mApp Solution Tech Notes documentation.

To define On Call groups:

1. Open the Table Management interface.

2. In the Type drop-down, select On Call Groups.

The On Call Groups Grid opens.

3. On the CSM Desktop Client toolbar, click the New button .

A new On Call Group Form opens.

4. Complete the Form:
a. On Call Group Name: Provide a name for the group (example: Rotation A)
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b. Tier 1 Individual: Select a User from the drop-down (example: Andrew). This User receives the
first notification e-mail when an Incident is created.

c. E-Mail: Auto-populates based on the Tier 1 Individual's User record (example:
andrew.simms@rivertcorp.com).

d. Escalate After [number] minutes: Specify the number of minutes that pass before the
Incident is escalated to the Tier 2 Individual (example: 30).

e. Tier 2 Individual: Select a User from the drop-down (example: Henri). This User receives a
notification e-mail if the Tier 1 Individual does not respond within the defined timeframe.

f. E-Mail: Auto-populates based on the Tier 2 Individual's User record (example:
henri.bryce@rivertcorp.com).

g. Escalate After [number] minutes: Specify the number of minutes that pass before the
Incident is escalated to the Tier 3 Individual (example: 45).

h. Tier 3 Individual: Select a User from the drop-down (example: Sherri). This User receives a
notification e-mail if the Tier 2 Individual does not respond within the defined timeframe.

i. E-Mail: Autopopulates based on the Tier 3 Individual's User record (example:
sherri.williams@rivertcorp.com).

j. Repeat Escalation after [number] minutes: Specify the number of minutes that pass before
the Incident escalation repeats (example: 15).

5. Click Save .
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Define On Call Service Profiles
Use Table Management in the CSM Desktop Client to define On Call Service Profiles for the On Call
mApp Solution.

Note: This functionality is only available if you have applied the On Call mApp Solution. For more
information, refer to the mApp Solution Tech Notes documentation.

To define On Call Service Profiles:

1. Open the Table Management interface.

2. In the Type drop-down, select On Call Service Profile.

The On Call Service Profile Grid opens.

3. On the CSM Desktop Client toolbar, click the New button .

A new On Call Service Profile Form opens.
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4. Complete the Form:
a. Service Profile Name: Provide a name for the profile (example: Weekend Crew).

b. Account Management: Select an On Call Group from the drop-down (example: Rotation A).
When the profile is used, this group is responsible for all Incidents related to Account
Management.

c. Conferencing/Presentation: Select an On Call Group from the drop-down (example: Rotation
A). When the profile is used, this group is responsible for all Incidents related to Conferencing/
Presentation.
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d. Desktop Management: Select an On Call Group from the drop-down (example: Rotation A).
When the profile is used, this group is responsible for all Incidents related to Desktop
Management.

e. E-Mail/Calendaring: Select an On Call Group from the drop-down (example: Rotation A).
When the profile is used, this group is responsible for all Incidents related to E-Mail/
Calendaring.

f. Employee Support: Select an On Call Group from the drop-down (example: Rotation A).
When the profile is used, this group is responsible for all Incidents related to Employee
Support.

g. Enterprise Apps: Select an On Call Group from the drop-down (example: Rotation A). When
the profile is used, this group is responsible for all Incidents related to Enterprise Applications.

h. IT Service Desk: Select an On Call Group from the drop-down (example: Rotation A). When
the profile is used, this group is responsible for all Incidents related to IT Service Desk.

i. Network Service: Select an On Call Group from the drop-down (example: Rotation A). When
the profile is used, this group is responsible for all Incidents related to Network Services.

j. Printing: Select an On Call Group from the drop-down (example: Rotation A). When the
profile is used, this group is responsible for all Incidents related to Printing.

k. Telephony/Fax: Select an On Call Group from the drop-down (example: Rotation A). When
the profile is used, this group is responsible for all Incidents related to Telephony/Fax.

l. Web Services: Select an On Call Group from the drop-down (example: Rotation A). When the
profile is used, this group is responsible for all Incidents related to Web Services.

5. Click Save .
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Define On Call Shifts
Use Table Management in the CSM Desktop Client to define On Call shifts.

Note: This functionality is only available if you have applied the On Call mApp Solution. For more
information, refer to the mApp Solution Tech Notes documentation.

To define On Call shifts:

1. Open the Table Management interface.

2. In the Type drop-down, select On Call Shifts.

The On Call Shifts Grid opens.

3. On the CSM Desktop Client toolbar, click the New button .

A new On Call Shifts Form opens.

4. Complete the Form:
a. Shift Name: Provide a name for the shift (example: Weekend – First).

b. Start Time: Use the Up and Down arrows to select the time in which the shift begins.

c. Shift Length (hrs): Specify the length (number of hours) of the shift.

d. Calculated End Time: Autopopulates by adding the Shift Length to the Start Time.

5. Click Save .
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(Optional) Define E-mail Settings
Use the Stored Values Manager in CSM Administrator to define e-mail settings.

Note: This functionality is only available if you have applied the On Call mApp Solution. For more
information, refer to the mApp Solution Tech Notes documentation.

To define e-mail settings:

1. Open the Stored Value Manager.

2. In the Manager tree, click the Global scope, and then click the On Call subfolder.

The On Call stored values display in the Main Pane.

3. Right-click the Auto-Assign Ownership stored value, and then select Edit.

The stored value window opens.

4. Provide a value:
◦ False: Provided by default in the Value field. When False is provided, Users receive an e-mail

that includes instructions to log into CSM and click the Take Ownership link in the I Want To
section of the Quick Info Tile.

◦ True: Type True in the Value field to allow Users to take ownership by responding to the e-
mail. When the User responds to the e-mail, notification e-mails are no longer sent Users in
the On Call Group.
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Note: To use this e-mail option, Users must create an E-Mail Monitor to handle the e-mail
response.

5. Select OK.
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Using the On Call mApp Solution
When working with the On Call mApp Solution, Users can:

• Create an On Call record.
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Create an On Call Record
Use the On Call Form in the CSM Desktop Client to create an On Call record.

Note: This functionality is only available if you have applied the On Call mApp Solution. For more
information, refer to the mApp Solution Tech Notes documentation.

To create an On Call record:

1. On the CSM Desktop Client toolbar, click New>New On Call.

A new On Call record opens.
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2. Choose a shift:
a. Start Date: Click the Date Selector button  to access the Calendar and select the date in

which the On Call schedule begins (example: 3/28/2015).

Note: To view the Calendar, you must leave the On Call record.

b. View Calendar: Click this button to view the On Call schedule on the Calendar.

c. Shift: Select a defined shift from the drop-down (example: Weekend – First).

Note: When a shift is selected, the Add Shift to Calendar button and E-Mail to groups? check
box display in the Assign Groups to Covered Services section of the Form.

d. Start Time: Autopopulates based on the Start Time of the selected shift.

e. End Time: Autopopulates based on the End Time of the selected shift.

f. (Optional) Show Recurrence Options: Click this link to define a recurring On Call schedule.

3. Assign each On Call Group to a Service:
a. Select an On Call Service Profile from the Group Assignment Profile drop-down (ex:

Weekend Crew).

The Service fields autopopulate with the defined On Call Groups from the On Call Service
Profile.

Note: Change an On Call Group assignment by selecting a different On Call Group (example:
Rotation B) from a Service drop-down (example: Account Management). This does not affect
the On Call Service Profile Lookup Object in Table Management.
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Tip: Click the E-Mail Schedule to Distribution List link in the I Want To section of the Quick
Info Tile to send a notification e-mail to each On Call Group member.

4. Finalize the On Call record:
a. (Optional) Select the E-Mail to groups? check box to send a notification e-mail to each On

Call Group member.

b. Click the Add Shift to Calendar button to add the On Call schedule to the Calendar and save
the On Call record.

5. Click the Home button .

6. On the CSM Desktop Client toolbar, click New>New Incident.

A new Incident Record is created.

7. Record the basic details (Who, What, How):
a. Requestor (in the Quick Info Tile): Provide the name of the Customer who initiated the contact,

and then press ENTER or TAB to search for the Customer Record.

b. Short Description: Provide a concise description of the Incident.

c. Description: Provide a detailed description for the Incident.

d. Call Source: Select a source for the initiation.

8. Classify the Incident:
a. Service: Select the affected Service.

b. Category: Select the affected Service category.

c. Subcategory: Select the affected Service subcategory.

d. Priority: Incident priority:
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i. Click the Priority drop-down to reveal the Priority Matrix (determined by invoked SLA),
and then click a priority number.

The On Call Group tab displays in the Form Arrangement.

9. Click Save .

A notification e-mail is sent to the Tier 1 Individual (example: Andrew Simms).

Note: The On Call process can also be initiated (notification e-mail is sent to the Tier 1
Individual) by clicking the Escalate to On Call Individual button in the Incident Actions
section of the CSM Desktop Client Task Pane.
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Note: 

10. Tier 1 Individual (example: Andrew Simms) takes ownership:
a. In the I Want To section of the Quick Info Tile, click Take Ownership.

b. Click Save .

A notification e-mail is sent to the Tier 1 Individual.

Note: If the first User does not take ownership within the defined timeframe on the On Call
Group Form (example: 30 minutes), a notification e-mail is sent to the first and second Users
in the group (example: Andrew and Henri). If the first and second Users do not take ownership
of the Incident within the defined timeframe (example: 45 minutes), a notification e-mail is sent
to all Users in the group (example: Andrew, Henri, and Sherri). If no one responds within the
defined timeframe (example: 45 minutes), a notification e-mail is all Users in the group until
one of the individuals takes ownership.

11. Complete the Incident logging process.
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Orchestration Packs
A Cherwell Orchestration Pack is a group of software runbooks that are packaged and delivered through
a mApp® Solution to allow users to perform functions on another vendor's software from within CSM.
Each Orchestration Pack focuses on a specific third-party system and contains multiple runbooks that
automate the execution of commands and activities on that system and report the results back to CSM.
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Orchestration Pack for Cisco CloudCenter™ 1.0
Understand the requirements and high-level configuration steps for the Cisco CloudCenter™ mApp®
Solution. Use the mApp Solution to deploy CloudCenter applications and data to a configured data center
or cloud environment using the CSM Service Request process.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 9.3.0

Cisco CloudCenter™ Version Requirements: Tested on Cisco CloudCenter 4.8.X

Out-of-the-Box Content Version Requirements: Tested on CSM 9.3.0

Other Requirements: Verify that your organization has an active instance of Cisco CloudCenter.

Overview
Cisco CloudCenter is a cloud management solution that leverages application-centric technology to
provision infrastructure resources and deploy applications to data center, private cloud, and public cloud
environments. The Cisco CloudCenter Integration mApp Solution allows Users to deploy application
profiles and related components and data to a configured data center or cloud environment using the
Service Request process. Customers can easily request a new application deployment from the Service
Catalog. After the request is submitted, a User fulfills it using the Specifics Form on the Service Request
Form.

How the mApp Solution Works

Item Category Item Typical Merge Action

Automation Process Definitions Check Request Status, Request VM Import

Business Objects

Application Manager, Config - CC
Application, Specifics-VM, VM Blueprint,
VM Cloud, VM CPU, VM Default Size,
VM Request, VM Size, VM Virtual
Memory, VM Volume

Import

Change Request, CI VM Status, Config
- Computer, Configuration Item,
Customer, Customer - Internal, Installed
Software, Journal, Specifics, User Info

Don't change

Incident, Incident SubCategory Merge
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Item Category Item Typical Merge Action

One-Steps

Add Blueprints, Add New Size, Assign
to ANY Individual, Assign to Individual,
Assign to Team, CloudCenter Request
and Submit, Create CI, Date Time Info
Popup, Delete All Records, Focus App
Tab, Focus CI Tab, Focus Cloud Tab,
Get App IDs, Get Available Apps, Get
Cloud Options, Get New Asset Tag, Get
Tier Details, Get VM Details, Import CIs,
Populate Records with Apps, Ready to
Provision, Request Status Update, Run
Action, Set Application Manager ID,
Take Ownership, Update All, Update
Application Status, Update CIs, Update
Clouds, Update Sizes, Update VM
Blueprints

Import

Create an Incident, Email Current
Customer, Get New Asset Tag Overwrite

Dial Customer Phone Don't Change

Stored Expressions

Action Text, Asset Tag, Config Type
Constraint, Constraint Message Max,
Constraint Message Min, Requirements
for Approval, Storage Constraint,
Storage Constraint Background Color,
Team Entitlement, User Entitlement,
User Entitlements, User Entitlements on
Behalf Of

Import

Disabled Specifics Color, Disabled
Specifics Color - Border Overwrite

CMDB Permanent Fields Locked, Count
Open Incidents, Disable Specifics Don't Change

Stored Queries All VR Requests, CloudCenter Manager Import

Stored Values
CloudCenter URL, Debug, Password,
Username, Variable, VM App IDs Import

Lock CMDB Permanent Fields Overwrite

Web Services CloudCenter Import

Merge Action Key:

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.
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• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Steps to Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Steps to Configure the mApp Solution in CSM Administrator

1. Configure Security Rights for the Cisco CloudCenter™ Specifics Form

2. Add the Cisco CloudCenter™ Form Control to the Incident Subcategory Form

3. Define Search Results Image Properties for CloudCenter™ Applications

4. Add Account Credentials to the CloudCenter™ Web Service

5. Configure Approvals for Cisco CloudCenter™ Application Service Requests

Steps to Configure the mApp Solution in the CSM Browser Client

1. Create a Category and Subcategory for Cloud Applications

2. Create a CloudCenter™ Manager Record

3. Import Cisco CloudCenter™ Data

4. Add VM Size Options for CloudCenter™ Applications

5. Activate Imported CloudCenter™ Applications

6. Create a Cloud Record for an Application

7. Import Active Deployments as Configuration Items

How to Use the mApp Solution

1. Request a Cisco CloudCenter™ Application in the Customer Portal

2. Approve a Service Request for an Application

3. Check the Status of a Build

4. Run an Action Against a Deployment
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Configuring the Orchestration Pack for the Cisco
CloudCenter™ mApp Solution in CSM
Administrator

After you apply the mApp® Solution to your system, you must perform a series of actions to configure it in
CSM Administrator.

Important: Before moving on to the configuration actions, we recommend that you first publish
the Blueprint that includes the mApp Solution. Then, create a new Blueprint to perform the
configuration actions in CSM Administrator.
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Configure Security Rights for the Cisco
CloudCenter™ Specifics Form

Provide Customers with permission to see and edit the Cisco CloudCenter™ Specifics Form that is
created with the application of the Cisco CloudCenter mApp® Solution.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint.

1. From the home page in CSM Administrator, click Security > Edit Security Groups .
2. From the Group drop-down list, select the Portal Workgroup Manager Security Group.

Note: The Portal Workgroup Manager Security Group is provided as an Out-of-the-Box
Security Group. Your system may be customized with different Security Groups. Refer to
OOTB Security Design for details about the out-of-the box (OOTB) Security Groups. You can
compare your Security Group settings to the OOTB Security Groups to determine which
group(s) require security rights for the Cisco CloudCenter Specifics Form.

3. Click the Business Objects tab.
4. From the Business Object drop-down, select Config - CC Application.
5. Under General settings, check the boxes for View, Add, and Edit.
6. In the Field tree, select New Field.
7. Under General settings, check the boxes for View and Edit, then click Save.
8. From the Business Object drop-down, select Specifics - VM.
9. Under General settings, check the boxes for View, Add, and Edit.

10. In the Field tree, select New Field.
11. Under General settings, check the boxes for View and Edit, then click Save.
12. From the Business Object drop-down, select VM Size.
13. Under General settings, check the boxes for View, Add, and Edit.
14. In the Field tree, select New Field.
15. Under General settings, check the boxes for View and Edit, then click Save.
16. From the Group drop-down, select the Portal Customer Group.

Note: The Portal Customer Security Group is provided as an Out-of-the-Box Security Group.
Your system may be customized with different Security Groups.

17. Repeat steps 4-15 for the Portal Customer Group.
18. For all Security groups, from the Business Object drop-down, select Application Manager, and

verify that Delete is unchecked.
This prevents a User from inadvertently deleting the CloudCenter Manager record.
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Add the Cisco CloudCenter™ Form Control to the
Incident Subcategory Form

Use the Form Editor to add a Cisco CloudCenter™ Form Control to the Incident SubCategory Form. The
Form Control allows Users to define which Incident classifications require approval.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint.

Complete the steps to Configure Security Rights for the Cisco CloudCenter™ Specifics Form.

1. Open a new Blueprint.
2. In the Lookup Tables Business Object tree, click Incident Subcategory.

3. Click the Form button .

Tip: You can also click View>View Form (from the Object Manager menu bar) or click the
Edit Form link (under the Appearance area).

4. Under Incident SubCategory Fields, select the Approval Required Form Control and drag it to a
location that fits your Form design.

5. Save the Blueprint, then perform additional configuration actions in the same Blueprint.
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Define Search Results Image Properties for
CloudCenter™ Applications

Add a cloud image to the search results image properties for Configuration Items of the virtual machine
asset type so that Users can quickly distinguish virtual machine records from other Configuration Item
records.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint.

Complete the steps to Add the Cisco CloudCenter™ Form Control to the Incident Subcategory Form.

1. Open the Blueprint you created to perform configuration actions.
2. From the Major Business Object tree, click Configuration Item > Edit Group > Bus Ob

Properties.
The Business Object properties dialog opens.

3. Click Search Results.
4. In the Show Result Images section, check the box for Show Result Image, then click the Custom

Expression button .
The Custom Expression dialog opens.

Complete the following steps in the If condition is section:

5. In the Value drop-down, expand Configuration Item Fields, then select Asset Type.
6. In the Operator drop-down, select equals.
7. In the Value drop-down, select virtual machine.

Complete the following steps in the Then assign this section:

8. In the Value drop-down, expand Image, then select Browse.
The Image Manager opens.

9. Navigate to Global > Integrations > CloudCenter, then select the Cloud Logo.
10. Click OK in the Image Manager, then click OK in the Custom Expression dialog, then click OK in the

Business Object Properties dialog.
The search result image property is set for CloudCenter™ applications.
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Add Account Credentials to the CloudCenter™
Web Service

Save your Cisco CloudCenter™ account credentials in the CloudCenter Web Service using the CSM Web
Services Manager so that CSM can access your instance of CloudCenter.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint.

Complete the steps to Define Search Results Image Properties for CloudCenter™ Applications.

1. Open the Blueprint you created to perform configuration actions.
2. Click Managers > Web Services

The Web Services Manager opens.
3. Expand the Blueprint folder, then open the CloudCenter folder. Select theCloudCenter Web

Service.

4. Click the Edit button .
The Web Service Options dialog opens.

5. Click Accounts, and verify that the administrator account is selected.
6. Click Edit.

The Web Service Account dialog opens.
7. Enter the user ID and password for your instance of Cisco CloudCenter™.
8. Click OK on the Web Service Account dialog, then click OK on the Web Service Options dialog,

then click Close on the Web Services Manager.
9. Save the Blueprint, then perform additional configuration actions in the same Blueprint.
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Configure Approvals for Cisco CloudCenter™
Application Service Requests

Configure Approvals in the Default and Portal Default Views so that provisioning a requested CloudCenter
application requires approval by the appropriate party.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint.

Complete the steps to Add Account Credentials to the CloudCenter™ Web Service.

1. Open the Blueprint you created to perform configuration actions.
2. From the Major Business Object tree, click Incident > Edit Approvals.

The Edit Incident Approvals dialog opens.
3. Click Add.

The Edit Approval Block dialog opens.
4. Verify that Trigger Conditions is selected, then click Advanced.

The advanced options appear.
5. In the name field, type Specifics Approval Client.
6. Under the pre-populated Group Expression, add the following trigger conditions:

◦ Incident.Approval Required equals True
◦ Specifics.Approval Required equals True
◦ Incident SubCategory.Approval Required equals True

7. Select the group expression, then choose the option At least one of the items in the group must
be true.

8. Select Approvers.
The Approvers options page appears.

9. Follow the steps to add appropriate approvers for Cisco CloudCenter™ Application Service
Requests. Refer to Define Approver Properties for details.

10. Select Actions.
The Actions options page appears.

11. In the Action to take when approval: Approved section:
◦ Uncheck the box for Executing the action completes the approval process
◦ Check the box for Set a field and select Ready to Provision from the drop-down. Type True

in the value field.
◦ Check the box for Run a One-Step, then click the Ellipses button to open the One-Step

Action Manager, and select Global > CloudCenter > Ready to Provision.
12. Click OK, then repeat steps 2-11 for the Portal Default View, giving the Approval Block a different

name, such as Specifics Approval Portal.
13. Click OK in the Edit Incident Approvals dialog, then save and publish the Blueprint.
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Configuring the Orchestration Pack for the Cisco
CloudCenter™ mApp Solution in the CSM Browser
Client

After you apply the mApp® Solution to your system, you must perform a series of actions to configure it in
the CSM Browser Client.

Important: Before moving on to the configuration actions, we recommend that you first publish
the Blueprint that includes the mApp Solution. Then, create a Blueprint to perform the
configuration actions in CSM Administrator. Finally, perform the configuration actions in the CSM
Browser Client.
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Create a Category and Subcategory for Cloud
Applications

Create a category and subcategory for virtual machines so that Users can specify the type of support
required when Customers make Service Requests for cloud applications.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint, then complete the required configuration procedures in CSM Administrator.

1. From the CSM Browser Client, click the Quick Search control, then select Service.
2. Leave the search box empty, then click the search button.

A list of services appears.
3. Select Cloud Services.

The Service Form opens.
4. In the Form Arrangement, select the Categories tab.
5. Click New Incident Category.
6. Complete the Category fields:

◦ For Incident Category, type Cloud Applications.
◦ For Specifics Name, type Specifics - VM.
◦ Verify that the Visible in Portal checkbox is checked.
◦ For Image, click Choose Image > Global > Integrations > CloudCenter, then select the

Cloud Service Catalog image.
7. In the Form Arrangement, select the Subcategories tab.
8. Click New Incident Subcategory.
9. Complete the Subcategory fields:

◦ For Service, verify that Cloud Services is selected.
◦ For Category, select Cloud Applications.
◦ For Subcategory, type Request an Application.
◦ Optionally provide a description.
◦ For Specifics Name, select Specifics - VM.
◦ Verify that the Visible in Portal checkbox is checked.
◦ Optionally, check the box for Approval Required.

Remember: You can add the Approval Required checkbox during configuration in
CSM Administrator. Refer to Add the Cisco CloudCenter™ Form Control to the
Incident Subcategory Form for details.

10. Click Save.
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Warning: If you plan to use a translated version of the mApp Solution, translate the
Category and Subcategory to the target language before using the mApp Solution in that
language. Refer to Translating Service Catalog Strings for details.
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Create a CloudCenter™ Manager Record
Use the CloudCenter™ Manager record to track and manage your Cisco CloudCenter applications and
clouds within CSM.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint, then complete the required configuration procedures in CSM Administrator.

1. Open the CSM Browser Client.
2. Click Searching > Search Manager.
3. In the Search Manager dialog, change the Association to Application Manager.
4. Select CloudCenter Manager, and then click Run.

The system generates a CloudCenter Manager record. Use this record for all subsequent actions
related to Cisco CloudCenter.
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Import Cisco CloudCenter™ Data
Migrate your existing CloudCenter™ data into CSM so that you can provision new requests using existing
data.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint, then complete the required configuration procedures in CSM Administrator.

1. Open your CloudCenter™ Manager record.
2. Click Import Applications.

The imported applications are visible in the CloudCenter Applications tab. The applications are not
selectable because they have not been activated.

3. Click Update/Import Clouds.
The imported clouds are visible in the Clouds tab.
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Create a Cloud Record for an Application
Specify the environment for a CloudCenter™ application by associating it with a cloud record.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint, then complete the required configuration procedures in CSM Administrator.

1. Open your CloudCenter Manager record.
2. Select the Clouds tab, then do one of the following:

◦ Select a cloud record, then click the Go To button  to view the record details.
◦ Click Create Cloud Record.

3. Click Get Cloud Options.
4. In the Select an Available Cloud dialog, click the cloud name, then click OK.

The Resource ID field is populated.
5. In the VM Application Name drop-down, select the application to associate with the cloud record.

Note: Each application must have its own cloud record.

6. Click Save.

928

CSM mApp Solutions

CSM mApp Solutions



Add VM Size Options for CloudCenter™
Applications

Add size options to the VM Size Lookup Object so that Customers can select from a list of sizes when
completing a Service Request for a cloud application.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint, then complete the required configuration procedures in CSM Administrator.

If you do not know the CloudCenter size options for the application, complete the following steps in your
instance of Cisco CloudCenter to see a list of possible sizes:

1. Select App Profiles, then select the application for which you are adding VM sizes.
2. Complete the required fields, then click Next.
3. In the Tier Settings section, you can view a list of possible sizes for the application. Note the size ID

that you plan to add (example: T2.Micro). If the application is two-tier, note the details for the
database layer.

4. Cancel the deployment.

When you know the size ID to add, complete the following steps in the CSM Browser Client:

5. Click Tools > Table Management.
6. In the type drop-down, select VM Size.

The VM Size table opens.

7. Click the Create New button .
An empty VM Size record opens.

8. Complete the required fields:

Field Description

Application Name Select an active application from the drop-
down.

Size Order Give the record an identifier to indicate the
order in which it should be displayed
(example: 1).

Size Name Give the record a friendly name (example:
X-Small).

Size ID Provide the CloudCenter™ size ID
(example: T2.Micro)

9. Optional: If the application is two-tier, you must also specify the size of the database layer. Check
the box to Show Database Details.
Fields appear for Volume Size and Volume Type.

10. Optional: Complete the database fields with information from Cisco CloudCenter (see steps 1-3).
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11. Click Save.
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Activate Imported CloudCenter™ Applications
Activate CloudCenter™ applications so that Customers can request them through the Service Catalog.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint, then complete the required configuration procedures in CSM Administrator.

1. Open your CloudCenter Manager Record.

2. Select an application, then click the Go To button .
The VM Application record opens.

3. Select a Default Cloud from the drop-down.
4. Provide a description for the application.
5. Specify which groups can request the application.

For example, write IT, HR, Operations.
6. Click Add New VM Size.

The VM Size Lookup Object opens. Follow the steps to Add VM Size Options for CloudCenter™
Applications.

7. Check the box for Application Active.
8. Click Save.

The application is now active and selectable from the CloudCenter Manager Record.
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Import Active Deployments as Configuration Items
Migrate your active application deployments from Cisco CloudCenter™ so that you can manage them as
Configuration Items in CSM.

Apply the Cisco CloudCenter™ mApp® Solution using the Apply mApp Solution wizard and publish the
resulting Blueprint, then complete the required configuration procedures in CSM Administrator.

1. Open your CloudCenter Manager record.
2. Click Import Deployments as CIs.

CSM imports all active deployments from your instance of Cisco CloudCenter as Configuration
Items.

Remember: Only deployments in the active status are imported.

3. The Configuration Item records for imported deployments appear in the Deployments tab.
Imported records appear orange, indicating that they are not assigned to Customers.

4. Select an orange Configuration Item record, then click the Quick View button .
The Quick View dialog opens for the selected record.

5. Under Primary User, click the Customer Selector button .
The Contact Manager opens.

6. Select the Customer to assign, then click OK.
7. Add or edit information about the Configuration Item.
8. Click Save.

The Configuration Item record appears black in the Deployments tab, indicating that it is assigned to
a Customer.
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Using the Orchestration Pack for the Cisco
CloudCenter™ mApp Solution

Use the Cisco CloudCenter™ mApp® Solution to deploy application profiles and related components and
data to a configured data center or cloud environment using the CSM Service Request process.
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Request a Cisco CloudCenter™ Application in the
Customer Portal

Use the Service Catalog to submit a Service Request for a Cisco CloudCenter™ application.

1. Open the Customer Portal.
2. Click Service Catalog > Cloud Services > Applications > Request an Application

The Request an Application page opens.
3. Select the application type.

Remember: Customers can only request applications that are available to their groups.
Specify which groups can request an application in the application record.

4. Select the cloud.
5. Select the instance size.
6. Provide justification for the request.
7. Click Add to Cart.

The My Service Cart page opens.
8. Click Continue Shopping to add additional services to your cart; otherwise, click Submit Order.
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Approve a Service Request for an Application
Approve Service Requests for Cisco CloudCenter™ applications, and trigger automatic actions in CSM to
provide access instructions to Customers.

1. Within the Service Request record, check the box for Deployment Request Ready, then click
Save.

2. If you set up additional Approvals, their statuses appear in the Form Arrangement under the
Approvals tab. Obtain the necessary Approvals to provision the application.

The following steps happen automatically:

3. CSM sends the job request to Cisco CloudCenter™.
4. CloudCenter deploys the application, and CSM creates a new Configuration Item in the

Configuration Management Database (CMDB).
You can open the Configuration Item record to view its details or perform additional actions against
the record.

5. Creating the Configuration Item triggers an e-mail from CSM to the assigned customer with access
instructions for the application.

Tip: You can also manually send the e-mail with access instructions. Within the Service
Request record, click E-mail Access Instructions.
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Check the Status of a Build
View the status of a Cisco CloudCenter™ build to verify whether it is pending or complete.

1. Open the Search Manager.
2. Change the Association to VM Request.

The VM Request searches appear.
3. Select All VR Requests, then click Run.

CSM returns all VR Request records.
4. Double-click on a VR Request record.

The VR Request record opens and shows the status of the build. CSM updates the build status
every three minutes.

936

CSM mApp Solutions

CSM mApp Solutions



Run an Action Against a Deployment
Run actions against a Cisco CloudCenter™ deployment to change its status.

1. Select a deployment from the CloudCenter Manager record, then click the Quick View button .
The Quick View dialog opens for the selected record.

2. In the details section, click the Available Actions drop down.
3. Select from the following actions:

Action Description Notes

Resume
Use this action to resume access
to a deployment that is
suspended.

This action is only available for
deployments that are
suspended.

Suspend Use this action to suspend access
to a deployment that is active.

This action is only available for
deployments that are active.

Terminate Use this action to terminate a
deployment.

This action is available to both
suspended and active
deployments.

4. Click Save.
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Orchestration Pack for Microsoft Active Directory
1.0

The Orchestration Pack for Microsoft Active Directory mApp® Solution allows users to execute activities
and commands in external systems that are typically done manually.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 8.0.0

Out-of-the-Box Content Version Requirements: Tested on CSM 8.0.0

Prerequisite Requirements: None

Overview
The Orchestration Pack for Microsoft Active Directory is only available for the CSM Desktop Client. This
mApp Solution includes multiple features such as automation processes, and One-Step Actions that
support the following commands: Get Account Info, Reset Password, Enable Account, Unlock Account,
Clear Expiration, Set Expiration, Add Account to Group, List Group Members, Set Home Directory, Get
Computer Info, Disable Computer Account, and Enable Computer Account.

Functionality requires initial configuration. The mApp Solution has two lookup tables for configuring the
application:

• Orchestration Pack AD Group: Populated with common Active Directory group names, which can be
modified by the User through table management. This table is used to populate prompts for Add
Account to Groups functionality.

• Orchestration Pack Prompt: Two rows, specifying either 1 or 0 for Prompt for Credentials or Do Not
Prompt for Credentials. This table is not populated through Table Management.

A series of Stored Values are used to pass parameters between Object-associated One-Step Actions and
generic master One-Step Actions that contain PowerShell scripts. The One-Step Actions write the
PowerShell scripts to temporary files, execute the files, and store the results in Stored Values for display
and logging in the Journal – Integrations Audit file.

Note: For SaaS Customers, the provided One-Step Actions do not work with the Automation
Process Service unless the Automation Process Service is installed locally.

The table below shows:

• Runbook: The name of the runbook. This is what the Users see in the menu bar or Task Pane.

• Business Object Associations: These are the CSM Business Objects that the runbooks can be
initiated from.
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• Description: What the runbook does.

Runbook Business Object
Associations Description

Get Account Info Customer, Incident Displays summary of Active Directory Account
settings.

Reset Password Customer, Incident
Prompt user for new password, set password in
account, set account to change password on next
login.

Disable Account Customer, Incident Disables an AD user account

Enable Account Customer, Incident Enables an AD user account

Unlock Account Customer, Incident Unlocks an AD user account

Clear Expiration Customer, Incident Clears the expiration date set on an AD account

Set Expiration Customer, Incident Sets the expiration date of the account

Add Account to Group Customer, Incident Adds the current account to an AD group

List Group Members Customer, Incident Presents a list of all accounts that are members of
the group

Get Computer Info CI, Incident Displays summary of AD Computer account
settings

Disable Computer
Account CI, Incident Disables the Computer account

Enable Computer
Account CI, Incident Enables the Computer account

Note: These runbooks can only be run via the CSM Desktop Client. The commands cannot be run
from the Browser Client.

How the mApp Solution Works
CSM provides the Orchestration Pack for Microsoft Active Directory as a mApp Solution so that Users can
easily incorporate Active Directory runbooks into their existing CSM system. Download the mApp Solution
from the Cherwell mApp Exchange. Use the Apply mApp wizard to apply the mApp Solution to your CSM
system. The Apply mApp wizard generates a Blueprint, which can then be viewed and published to a test
or Live system to commit the changes.

The mApp Solution includes the following items:
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Item Category Item Typical Merge Action

Business Object

Orchestration Pack AD Group,
Orchestration Pack Credential Prompt,
Journal - Integrations Audit

Import

Config - Computer, Config - Server,
Customer, Incident, Journal, Customer,
Customer-Internal

Don't Change

Image Definitions Windows 128x128, Windows 32x32,
Windows 64x64 Import

One-Step Action

Check Prereq, CI-Disable Computer
Account, CI-Enable Computer Account,
CI-Get Computer Info, CI-Server
Disable Server Account, CI-Server
Enable Server Account, CI-Server Get
Server Info, Customer-Add Account to
Group, Customer-Clear Account
Expiration, Customer-Disable Account,
Customer-Enable Account, Customer-
Get Account Info, Customer-List Group
Members, Customer-Reset Password,
Customer-Set Account Expiration,
Customer-Set Home directory,
Customer Unlock Account, Incident-
Clear Account Expiration, Incident-
Disable Account, Incident-Disable
Computer Account, Incident-Enable
Account, Incident-Enable Computer
Account, Incident-Get Account Info,
Incident-Get Computer Info, Incident-
List Group Members, Incident, Reset
Password, Incident-Set Account
Expiration, Incident-Set Home
Directory,Incident-Unlock Account,
Master-Add Account to Group, Master-
Clear Account Expiration, Master-
Disable Account, Master-Disable
Computer Account, Master-Enable
Account, Master-Enable Computer
Account, Master-Get Account Info,
Master-Get Account Info-Short, Master-
Get Computer Info, Master-List Group
Members, Master-Reset Password,
Master-Set Account Expiration, Master-
Set Home Directory, Master-Unlock
Account, Set Credential Prompt

Import

940

CSM mApp Solutions

CSM mApp Solutions



Item Category Item Typical Merge Action

Stored Values

OP Active Directory Credentials, OP
Active Directory Parameter, OP Active
Directory Parameter Options, OP Active
Directory Prereq Check, OP Active
Directory Result Details, OP Active
Directory Run Results, OP Active
Directory Version

Import

Themes Professional Grey Don't Change

Merge Actions

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About Directory Services

• About mApp Solutions

• Microsoft Active Directory Integration

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution

1. Configure the Orchestration Pack for Microsoft Active Directory.
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How to Use the mApp Solution

• Using the Active Directory Runbooks in CSM.
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Configuring the Orchestration Pack for Microsoft
Active Directory

Complete the following procedure to configure the Customer Satisfaction Indicator mApp Solution.

Note: The Orchestration Pack for Microsoft Active Directory is only available for the CSM Desktop
Client.

1. Set the Stored Value.

2. Configure PowerShell.

Note: PowerShell Version 3 or later is required for the mApp Solution functionality to work.

3. Configure Active Directory Groups.

When the configuring steps are complete, refer to Use the Active Directory runbooks.
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Set the Credential Prompt Stored Value
The below procedures are the first steps in configuring the Orchestration Pack for Microsoft Active
Directory. The Credential Prompt stored value determines whether a User is prompted for Active Directory
credentials when a runbook is executed. If it is set to prompt, the User must enter credentials for each
runbook execution. The credentials are used for that execution only and are never stored in CSM. If the
stored value is set to not prompt, then the current User’s session credentials are used to execute the
runbook.

Note: This functionality is only available if you have applied the Orchestration Pack for Microsoft
Active Directory mApp Solution. For more information, see Orchestration Pack for Microsoft Active
Directory.

To set the credential prompt stored value:

1. In CSM Administrator, click the Settings category, and then click the Open Stored Value Manager
task.

a. In the folder tree, select Global>Orchestration Packs.

b. Select OP Active Directory Credentials.

c. Click the Edit icon.
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The Stored Value window opens.

d. In the Default Value filed:
i. Set value to 1: Require Users to log in with their Active Directory credentials every time

an Active Directory runbook is initiated.

ii. Set value to 0: Do NOT require Users to login before initiating an Active Directory
runbook.

2. In the CSM Desktop Client, open the One-Step Manager.

To open the One-Step Manager:

a. The One-Step Manager can be opened several ways:
◦ From the CSM Desktop Client menu bar, click One-Step>One-Step Manager.
◦ From the Browser Client menu bar, click One-Step>One-Step Manager.
◦ From the Blueprint Editor menu bar in CSM Administrator, click Managers>One-Step

Manager.
◦ From One-Step Action selectors throughout CSM (ex: When adding One-Step Actions to

various areas within CSM).

a. In the Association drop-down, select None.

b. Select Global>Orchestration Packs > Active Directory.
c. Select Set Credential Prompt.
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d. Click Run.

e. Use the drop-down to select Do not prompt for credentials or Prompt for credentials in the
Prompt window.

A Credential Values window opens to confirm the selection.

Note: Additional values can be used in the drop-down. Add the options by clicking the ellipsis
button and adding them in the Orchestration Pack Credential Prompt Selector window.
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Configure PowerShell for Active Directory
Orchestration Pack

The below procedure is the second step in configuring the Active Directory Orchestration Pack.

Note: This functionality is only available if you have applied the Active Directory Orchestration
Pack mApp Solution. For more information, refer to the Active Directory Orchestration Pack
documentation.

Note: PowerShell version 3 or later is required for the mApp Solution functionality to work.

Executing the Active Directory runbooks requires the Active Directory PowerShell cmdlets be present on
the system. To install the cmdlets, the Microsoft Remote Server Administration Tools must be installed.
Download links for Windows desktop operating systems are provided below. For Windows Server follow
the instructions in the next section.

• Windows 7: http://www.microsoft.com/en-us/download/details.aspx?id=7887

• Windows 8: http://www.microsoft.com/en-us/download/details.aspx?id=28972

• Windows 8.1: http://www.microsoft.com/en-us/download/details.aspx?id=39296

• Windows 10: https://www.microsoft.com/en-us/download/details.aspx?id=45520

To install the Active Directory PowerShell cmdlets on Windows Server:

Note: If the required PowerShell cmdlet library is not installed, the first time a runbook runs a
dialog opens containing links to Microsoft to download the applicable PowerShell library.

1. Open the Server Manager.

2. Click Add roles and features.

The Add Roles and Features Wizard opens.

3. Click Next until the Features option is highlighted in the left pane.

4. In the features window, go to Remote Server Administration Tools > Roles Administration Tools
> AD DS and AD LDS Tools.

5. Select the Active Directory module for Windows PowerShell checkbox.
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6. Select Next.

Confirmation is highlighted in the left pane.

7. Click Install.

8. Select OK.
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Configuring Active Directory Groups
The below procedure is the final step in configuring the Orchestration Pack for Microsoft Active Directory.

Note: This functionality is only available if you have applied the Orchestration Pack for Microsoft
Active Directory mApp Solution. For more information, see Orchestration Pack for Microsoft Active
Directory.

To view Active Directory Groups:

1. In CSM Desktop, click the Tool menu option, then select Table Management.
2. In the Type drop-down, select Orchestration Pack AD Groups.

Some of the most common groups are pre-loaded.

To add Active Directory Groups:

1. Click New in the toolbar.

2. Provide the Group Name.

3. Click Save.
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Using the Active Directory Runbooks in CSM
When the configuration is complete, the below procedure shows how to use the Orchestration Pack for
Microsoft Active Directory in the CSM Desktop Client. The Active Directory runbooks are accessed from
the Task Pane or from an Action menu bar. Runbooks for User Accounts have a User icon. Runbooks for
computers or servers have a computer icon.

Note: The runbooks in an Incident/Service request associated with CI-Computer are disabled
when there is not an associated computer in the Incident.

Note: This functionality is only available if you have applied the Orchestration Pack for Microsoft
Active Directory mApp Solution. For more information, see Orchestration Pack for Microsoft Active
Directory.

To use the Active Directory Runbooks in the Desktop Client:

1. Open an Incident.

2. View the available runbooks:
a. In the menu bar, click Incident Actions. Select Active Directory.

b. In the Task Pane, click the Active Directory drop-down.
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Orchestration Pack for Microsoft® Azure® 1.0
The Orchestration Pack for Microsoft® Azure® mApp® Solution allows technicians to easily fulfill requests
for Azure® virtual machines (VMs) using the Service Request Model.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 8.2.1

Out-of-the-Box Version Requirements: Tested on CSM 8.1.0

Prerequisites: None

Overview
Microsoft® Azure® is a collection of integrated services that are accessible from the cloud. When the
mApp Solution is applied, Customers can easily request a new Azure® VM from the Service Catalog and
then initiate second day actions for the VM (example: Restart, power off, deallocate, etc.) directly from the
Customer Portal. After the request is submitted, a technician can reference it using the Service Request
record.
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When a VM is requested, an Automation Process initiates a One-Step™ Action to send a request to
Azure® using the Customer's credentials and specifications. If the request is successful, the One-Step
Action e-mails the Customer, updates the Service Request record by creating a Journal entry, and creates
a new Virtual Machine CI for the VM. If the request to Azure® is unsuccessful, the One-Step sends an e-
mail to the Customer and updates the Service Request record by creating a Journal entry that includes an
error message.

Note: To use Microsoft® Azure® virtual machine functionality, you must create an Azure® account
and purchase a virtual machine. Before applying the mApp Solution, have the following
information available for reference: client ID, key, resource group, subscription ID, and tenant ID.
Refer to the Microsoft® Azure® website for more details (https://azure.microsoft.com/en-us/).

How the mApp Solution Works
CSM provides Microsoft® Azure® as a mApp Solution so that Users can fulfill requests for Azure® virtual
machines (VMs) using the Service Request Model.

Download the mApp Solution from the mApp Exchange.
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Use the Apply mApp wizard to apply the mApp Solution to your CSM system. The Apply mApp wizard
generates a Blueprint, which can then be viewed and published to a test or Live system to commit the
changes.

The mApp Solution includes the following items:

Item Category Item
Typical
Merge
Action

Business Object

 

CI VM Status, Config - Virtual Machine, Journal - Integrations Audit,
Specifics - Azure VM, VM Action, VM Default Size, VM OS, VM
Request, VM Size, VM Template

Import

CI Asset Type, Configuration Item, Incident Category, Incident
SubCategory, Journal, Specifics

Don't
Change

Automation
Process getAzure Status, Request VM Import

Counter VM Counter Import

Dashboard My Devices, My Service Cart, My Service Orders Don't
Change

Image Windows 32x32 Import

One-Step Action

Assign to ANY Individual, Assign to Individual, Assign to Team,
Create Change Request for Action, Create CI, Create VM Request,
Date Time Info Popup, Deallocate Virtual Machine, Master Get
Bearer Token, Request Status Update, Reset Access Virtual
Machine, Restart Virtual Machine, Run VM Action, Select Action
Type, Shutdown Virtual Machine, Start Virtual Machine, Take
Ownership

Import

Expression
400, 401, 403, 404, 405, 409, 500, 503, Action Text, Asset Tag,
CMDB Permanent Fields Locked, json, Request VM Criteria, Team
Entitlement, VM User Threshold

Import

Stored Query ALL Requests, Requests Failed, Requests Pending, Requests
Succeeded Import

Stored Value API Version, Azure Integration Version, Bearer Token, Client ID,
Content Type, Key, Resource Group, Subscription ID, Tenant ID Import

Theme Professional Grey Don't
Change

Web Service Azure Login, Azure Management Import

Widget
Devices Assigned to Me, My Open Service Orders, My Service Cart
Total, My Service Order History, Service Availability, Service Cart
Item Grid, Service Order Status

Don't
Change

Merge Action Key:

• Import: Add new item.

• Overwrite: Replace target item.
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• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About mApps

• About Customer Portals

• Logging Incidents

• Create a Group Map

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

Note: Before applying the mApp, have the following information available for reference: client ID,
key, resource group, subscription ID, and tenant ID. You will provide this information using the
Apply mApp wizard.

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution
After applying the mApp Solution, perform the following high-level steps to configure the mApp Solution:

1. Define Security Rights for Azure®

2. Define Subcategory Classification for Azure®

3. Define the Virtual Machine template for Azure®

Note: If you are using the 8.1.0 out-of-the-box (OOTB) content, you must define the new
Specifics Form validation for the Customer Portal before publishing the Blueprint. In the
Portal default view, right-click the Specifics TypeID and select Edit Business Object. Click
the Specifics TypeID and then click the Field Properties button. On the Validation/Auto-
populate page, deselect the Populate Using Map field. On the Properties page, select the
Calculated Value check box, click the arrow button, and then select the ellipses button next
to the Expression field. In the Expression Manager, select the Blueprint folder and then
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select the Specifics Picker Expression. After the Expression is selected, update the
Blueprint.

How to Use the mApp Solution
There are multiple ways to use the mApp Solution functionality, including:

• Request an Azure® virtual machine using the Service Catalog in the Customer Portal

• Request an Azure® virtual machine using the Service Request form in the CSM Desktop Client
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Configuring the Orchestration Pack for Microsoft®
Azure®

Complete the following procedures to configure the Orchestration Pack for Microsoft® Azure®.
Configuration procedures are completed in CSM Administrator and in the CSM Desktop Client.

1. Define Security Rights for Azure®

2. Define Subcategory Classification for Azure®

3. Define the Virtual Machine template for Azure®
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Define Security for Azure®
Use the Business Object Editor and Security Group Manager in CSM Administrator define security for
Azure®. When you define security, you:

• Enable Field encryption for the Admin Password field on the Virtual Machine Configuration Item
Form.

• Define Business Object Security Rights for the Portal Customer Security Group and Portal
Workgroup Manager Security Group. Business Objects associated with this mApp Solution do not
support any rights by default.

Note: This functionality is only available if you have applied the Orchestration Pack for
Microsoft® Azure®. For more information, refer to the mApp Solution Tech Notes
documentation.

Enable Field Encryption
To enable Field encryption for the Admin Password field on the Virtual Machine Configuration Item Form:

1. In the Object Manager, click Config - Virtual Machine in the Object tree, and then click the Edit
Business Object task in the Structure area.
The Business Object Editor opens.

2. Click the Admin Password field, and then click the Field Properties button.

3. Click the Advanced page.

4. Select the Enable Field Encryption check box.

5. In the drop-down, select an encryption key (encryption keys are managed using the Server
Manager).

6. Click OK.

Define Security Rights
To define Business Object security rights for the Portal Customer Security Group and Portal Workgroup
Manager Security Group:

1. In the CSM Administrator main window, click the Security category, and then click the Edit Security
Groups task.

2. Define the following Business Object rights for the Portal Customer Security Group:
◦ Config - Virtual Machine: Select rights to View, Add, and Edit.

◦ New Field: Select rights to View and Edit.

◦ Journal - History: Select the right to Add.
◦ New Field: Select rights to View and Edit.

◦ Journal - Integrations Audit: Select rights to Add and Edit.
◦ New Field: Select rights to View and Edit.
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◦ Specifics - Azure VM: Select rights to View, Add, and Edit.
◦ New Field: Select rights to View and Edit.

3. Define the following Business Object rights for the Portal Workgroup Manager Security Group:
◦ Config - Virtual Machine: Select rights to View, Add, and Edit.

◦ New Field: Select rights to View and Edit.

◦ Journal - History: Select the right to Add.
◦ New Field: Select rights to View and Edit.

◦ Journal - Integrations Audit: Select rights to Add and Edit.
◦ New Field: Select rights to View and Edit.

◦ Specifics - Azure VM: Select rights to View, Add, and Edit.
◦ New Field: Select rights to View and Edit.

4. (Optional) Define Business Object rights for the following Business Objects:
◦ CI VM Status

◦ VM Action

◦ VM Default Size

◦ VM OS

◦ VM Request

◦ VM Size

◦ VM Template

5. Select OK.
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Define Subcategory Classification for Azure®
If you are using CSM 8.1.0 or greater, use Table Management in the CSM Desktop Client to define the
Azure® SubCategory classification. When you define the classification, you select the VM Specifics Form
so that the appropriate form displays when the classification is selected. You can also select a default
Team and the option of using an Approval , if necessary.

Note: If you are using a version of CSM earlier than 8.1.0, use the Group Map Editor to point the
Request Azure VM SubCategory to the Azure VM Specifics Form.

Note: This functionality is only available if you have applied the Orchestration Pack for Microsoft®
Azure®. For more information, refer to the mApp Solution Tech Notes documentation.

To define the SubCategory classification:

1. Open the Table Management interface.

2. In the Type drop-down, select Incident SubCategory.

3. In the Grid, select the Cloud Services/Virtual Machines (VM)/Request Azure VM classification.

The Subcategory form opens.

a. In the Specifics Name field, select Specifics - Azure VM.

b. (Optional) In the Default Team field, select the Team that should be assigned the Incident by
default when the classification is used.

c. (Optional) Select the Approval Required check box to initiate the defined Approval process
when the classification is used.

4. Click Save.

5. Close the Table Management interface.
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Define the Virtual Machine Template for Azure®
Use Table Management in the CSM Desktop Client to define the Azure® virtual machine template, if
necessary. The template is used to communicate parameters and their corresponding values between
CSM and Azure®. CSM provides a standard demo template, but you can use an alternative template, if
necessary. Additional templates are available on GitHub (https://github.com/Azure/azure-quickstart-
templates).

When you create a Service Request for a virtual machine (either in the CSM Desktop Client or via the
Customer Portal) and select the VM Request Ready check box, an Automation Process is initiated; the
Automation process includes a One-Step that replaces the parameters with values specific to the Service
Request and then initiates the virtual machine build process.

Note: This functionality is only available if you have applied the Orchestration Pack for Microsoft®
Azure®. For more information, refer to the mApp Solution Tech Notes documentation.

To define the Azure® virtual machine template:

1. In the CSM Desktop Client, open the Table Management interface (Tools>Table Management).
2. In the Type drop-down, select VM Template.

3. In the Grid, double-click Standard VM.

The Virtual Machine Template form opens.

a. Define the basic details:
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i. Template Name: Do not edit.

ii. Available on Portal: Select whether or not the Standard VM option is available on the
Portal.

Note: At least one template must be available on the Customer Portal.
Customers will not be able to submit the request for a virtual machine if the
template is not selected.

iii. Template Description: Edit the template description by adding additional details.

b. Define the template JSON, if necessary:
i. Download a template. Templates are available on GitHub (https://github.com/Azure/

azure-quickstart-templates).

ii. In the Template JSON field, paste the JSON.

iii. In the Parameters block of the Template JSON field, replace the new parameters with
the generic parameters from the standard demo template.

Note: The generic parameters are required for the Create VM Request One-
Step™ Action to function properly. If the alternative template uses additional
options, the corresponding parameter values must be added to the One-Step
Action (Incident association>Blueprint>Create VM Request).

4. Close the Table Management interface.
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Using the Orchestration Pack for Microsoft®
Azure®

When using the Orchestration Pack for Microsoft® Azure®, Users can:

• Request an Azure® virtual machine using the Service Catalog in the Customer Portal.

• Request an Azure® virtual machine using the Service Request form in the CSM Desktop Client.
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Request an Azure® Virtual Machine in the
Customer Portal

Use the Customer Portal to request an Azure® virtual machine.

Note: This functionality is only available if you have applied the Orchestration Pack for Microsoft®
Azure®. For more information, refer to the mApp Solution Tech Notes documentation.

To request a virtual machine in the Customer Portal:

1. Navigate to http://server/CherwellPortal where server is the location where the CSM Browser
applications are installed.

2. Log in to the Portal:
a. Click the Click to login link to log in to the Portal Site.

b. Provide login credentials (User Name and Password) for a User who has rights to access the
Customer Portal.

c. Click Sign-in.

3. In the Customer Service Portal toolbar, click Service Catalog.

The Service Catalog page opens.

a. In the Cloud Services>Virtual Machines (VM) section, click the Request Azure VM Service.

The Request VM form opens.
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b. Complete the Request Azure VM Specifics Form:
i. Select Virtual Machine Type: Select a predefined template from the drop-down. This

field is required.

The description (read-only) field is auto-populated when the virtual machine type is
selected.

ii. Select Virtual Machine Size: Select a size for the virtual machine.

The following read-only fields are auto-populated when the size is selected: Storage, # of
Disks, Memory, CPU Cores, NICs, and Max IOPS.

Note: The size field is populated using the VM Size Lookup Table in Table
Management.
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iii. Select Operating System: Select the name of the Customer's operating system from the
drop-down.

iv. Justification/Rationale: Provide additional details about the VM request.

c. Click the Add to Cart button.

The Service Request displays on the My Service Orders page in the Services Ordered section.

d. Click the Submit Order button.

e. Click OK to confirm the order.

After the order is confirmed, the Service Request is fulfilled using the CSM Desktop Client.
When the virtual machine is provisioned, an Automation Process initiates a One-Step Action to
send a request to Azure® using the Customer's credentials and specifications. If the request is
successful, the One-Step Action e-mails the Customer, updates the Service Request record by
creating a Journal entry, creates a new Virtual Machine CI for the VM, and changes the
Service Request status to Resolved. If the request to Azure® is unsuccessful, the One-Step
Action sends an e-mail to the Customer and updates the Service Request record by creating a
Journal entry that includes an error message.

4. View the status of the request:
a. In the Customer Service toolbar, click the number next to My Requests (example: 1).

b. Click the Service Request that you want to view.
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Note: When the virtual machine is provisioned, a new Virtual Machine CI Record is
created and an e-mail notification is sent to the requestor.

5. After the VM request is fulfilled, request a second day action:
a. On the Customer Portal home page, click the View My Devices link.

The My Devices page opens.

b. Click the title of the Virtual Machine.

The Virtual Machine page opens.

c. Select a second day action from the Request Action for this VM drop-down:
◦ Power Off

◦ Deallocate VM

◦ Restart VM

◦ Start VM

◦ Reset Access

d. Click the Run Action button.
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Request an Azure® Virtual Machine in the CSM
Desktop

Use the Incident Form to request an Azure® virtual machine in the CSM Desktop Client.

Note: This functionality is only available if you have applied the Orchestration Pack for Microsoft®
Azure®. For more information, refer to the mApp Solution Tech Notes documentation.

To log an Azure® in the CSM Desktop Client:

1. Log into CSM.

2. In the CSM Desktop Client toolbar, click New>New Incident.

A new Incident record opens.

3. Record the basic details (Who, What, How):
a. Requestor (in the Quick Info Tile): Provide the name of the Customer who initiated the contact,

and then press ENTER or TAB to search for the Customer Record.

b. Title: Provide a title for the Incident.

c. Description: Provide a detailed description for the Incident.

d. Call Source: Select a source for the initiation.

4. Classify the Incident:
a. Service: Select Cloud Services from the drop-down.

b. Category: Select Virtual Machines (VM) from the drop-down.

c. Subcategory: Select Request Azure VM from the drop-down.
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The Request Virtual Machine Specifics form displays in the Fullfill the Service Request
section.

d. Priority: Click the Priority drop-down to reveal the Priority Matrix (determined by invoked
SLA), and then click a priority number.

5. Complete the Request Virtual Machine Specifics Form:

Note: The Virtual Machine drop-down values are based on the Standard VM specifications
(Tools>Table Management>VM Template>Standard VM).

a. Virtual Machine Template: Select a predefined template from the drop-down. This field is
required.

b. Size: Select a size for the virtual machine.

The following read-only fields are auto-populated when the size is selected: CPU Cores,
Memory, Disks, Max Disk Size, Max NICs (network interface card), Max IOPS (input/output
operations per second), and Template Description.
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c. OS Name: Select the name of the Customer's operating system from the drop-down.

d. Justification/Rationale: Provide additional details about the VM request.

e. VM Request Ready: Select the check box when the virtual machine is ready to be
provisioned.

6. Complete the Incident logging process

When the virtual machine is provisioned, an Automation Process initiates a c to senOne-Step Action
a request to Azure® using the Customer's credentials and specifications. If the request is
successful, the One-Step Action e-mails the Customer, updates the Service Request record by
creating a Journal entry, creates a new Virtual Machine CI for the VM, and changes the Service
Request status to Resolved. If the request to Azure® is unsuccessful, the One-Step Action sends an
e-mail to the Customer and updates the Service Request record by creating a Journal entry that
includes an error message.

7. After the VM request is fulfilled, request a second day action:
a. In the I Want To section, select a second day action from the Request Action for this VM

drop-down:
◦ Power Off

◦ Deallocate VM

◦ Restart VM

◦ Start VM

◦ Reset Access

971

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/csh?topicname=log_an_incident_-_detailed


b. Click the Run Action button.
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Orchestration Pack for Microsoft Exchange 1.0
The Orchestration Pack for Microsoft Exchange mApp® Solution provides functionality that allows users
and automation processes in CSM to execute activities and commands in external systems that are
typically done manually.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 8.0.0

Out-of-the-Box Content Version Requirements: Tested on CSM 8.0.0

Prerequisites: None

Overview
This mApp Solution includes multiple features including One-Step Actions that support the following
commands: Get Mailbox Info, Get Mailbox Statistics, Get Mail User, Disable Mailbox, Disable Mail User,
and Enable Mail User.

Note: For SaaS Customers, the provided One-Step Actions do not work with the Automation
Process Service unless the Automation Process Service is installed locally.

The table below shows:

• Runbook: The name of the runbook. This is what the Users see in the Menu Bar or Task Pane.

• Business Object Associates: These are the CSM Business Objects that the runbooks can be
initiated from.

Runbook Business Object Associations

Get Mail User Customer, Incident

Get Mailbox Info Customer, Incident

Get Mailbox Statistics Customer, Incident

Disable Mailbox Customer, Incident

Disable Mailbox Customer, Incident

Enable Mailbox Customer, Incident

Disable Mail User Customer, Incident

Enable Mail User Customer, Incident
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Note: Due to the power and potentially damaging results of running some of these PowerShell
runbooks, these runbooks can only be run via the CSM Desktop Client. The commands cannot be
run from the Browser Client because of security restrictions with browser access to the file system
and server scripts.

How the mApp Solution Works
CSM provides the Active Directory Orchestration Pack as a mApp Solution so that Users can easily
incorporate Active Directory runbooks into their existing CSM system. Download the mApp Solution from
the Cherwell mApp Exchange. Use the Apply mApp wizard to apply the mApp Solution to your CSM
system. The Apply mApp wizard generates a Blueprint, which can then be viewed and published to a test
or Live system to commit the changes.

The mApp Solution includes the following items:

Item Category Item Typical Merge Action

Business Object
Journal - Integrations Audit Import

Customer, Customer - Internal,
Incident Don't Change

Image Definitions Windows 128x128, Windows 32x32,
Windows 64x64 Import

One-Step Action

Customer-Disable Mail User,
Customer-Disable Mailbox,
Customer-Enable Mail User,
Customer-Enable Mailbox,
Customer-Get Mail User, Customer
- Get Mailbox Info, Customer - Get
Mailbox Statistics, Incident-Disable
Mailbox, Incident-Disable MailUser,
Incident-Enable Mailbox, Incident-
Enable MailUser, Incident-Get
Mailbox Info, Incident-Get Mailbox
Statistics, Incident-Get User,
Master-Disable Mailbox, Master -
Disable MailUser, Master-Enable
Mailbox, Master-Enable MailUser,
Master-Get Mailbox Info, Master-
Get Mailbox Statistics, Master-Get
User, Set MailServer

Import

Stored Values

OP Exchange Mailserver, OP
Exchange Parameter, OP Exchange
Parameter Options, OP Exchange
Result Details, OP Exchange Run
Results, OP Exchange Version

Import

Stored Expressions EX Ran Successfully Import
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Merge Actions

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About Directory Services

• About mApp Solutions

Steps to Configure the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

4. Configure the Exchange Accelerator Pack.

How to Apply the mApp Solution

• Using the Exchange Runbooks in CSM.
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Configuring the Exchange Orchestration Pack
Complete the following procedure to configure the Customer Satisfaction Indicator mApp Solution.

Note: The Exchange Orchestration Pack is only available for the CSM Desktop Client.

1. Set the Exchange Stored Value.

2. Configure PowerShell for Exchange Orchestration Pack

When the configuring steps are complete, refer to Use the Exchange Runbooks in CSM.
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Set the Exchange Stored Values
The below procedures are the first steps in configuring the Exchange Orchestration Pack. The stored
value determines whether a User is prompted for credentials when a runbook is executed. If it is set to
prompt, the User must enter credentials for each runbook execution. The credentials are used for that
execution only and are never stored in CSM. If the stored value is set to not prompt, then the current
User’s session credentials are used to execute the runbook.

Note: This functionality is only available if you have applied the Exchange Orchestration Pack
mApp Solution. For more information, refer to the Exchange Orchestration Pack documentation.

To set the credential prompt stored value:

1. In CSM Administrator, click the Settings category, and then click the Open Stored Value Manager
task.

a. In the folder tree, select Global>Orchestration Packs.

b. Select OP Exchange Mailserver.

c. Click the Edit icon.

The Stored Value window opens.
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d. In the Value field provide the URL for the mail server.

2. In the CSM Desktop Client, open the One-Step Manager.

To open the One-Step Action Manager:

a. The One-Step Action Manager can be opened several ways:
◦ From the CSM Desktop Client menu bar, click One-Step>One-Step Manager.
◦ From the Browser Client menu bar, click One-Step>One-Step Manager.
◦ From the Blueprint Editor menu bar in CSM Administrator, click Managers>One-Step

Manager.
◦ From One-Step Action selectors throughout CSM (ex: When adding One-Step Actions to

various areas within CSM).

a. In the Association drop-down, select None.

b. Select Global>Orchestration Packs > Exchange.
c. Select Set Mail Server.
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d. Click Run.

A Mail Server Update Confirmation window opens to confirm changing the Mailserver. This is
the same URL provided in CSM Administrator.

e. Click OK

A Prompt window opens to provide the Mailserver URL. The field is auto-populated with the
URL in the previous window.

3. Click OK to change or Cancel to quit.

The Mail Server Updated window opens showing the Mailserver has been updated with the address.
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4. Click Close.
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Configure PowerShell for Exchange Orchestration
Pack

The below procedure is the second step in configuring the Exchange Orchestration Pack. PowerShell
version 3 or later is required for the mApp Solution functionality to work. Executing the Exchange
runbooks requires the following PowerShell cmdlets.

Note: These cmdlets are only available in on-premises Exchange Server 2016.

• Enable-MailUser cmdlet: This command mail-enables existing users by adding the email attributes
that are required by Exchange. Mail users have email addresses and accounts in the Exchange
organization, but they don't have Exchange mailboxes. Email messages sent to mail users are
delivered to the specified external email address. 

• Disable-MailUser cmdlet: This command mail-disables existing mail users by removing the email
attributes that are required by Exchange. Mail users have email addresses and accounts in the
Exchange organization, but they don't have Exchange mailboxes. Disabling a mail user removes the
ability of Exchange to deliver messages to the specified external mail address.

To install the cmdlets, the Microsoft Remote Server Administration Tools must be installed. Download links
for Windows desktop operating systems are provided below. For Windows Server follow the instructions in
the next section.

• Windows 7: http://www.microsoft.com/en-us/download/details.aspx?id=7887

• Windows 8: http://www.microsoft.com/en-us/download/details.aspx?id=28972

• Windows 8.1: http://www.microsoft.com/en-us/download/details.aspx?id=39296

• Windows 10: https://www.microsoft.com/en-us/download/details.aspx?id=45520

To install the Active Directory PowerShell cmdlets on Windows Server:

Note: If the required PowerShell cmdlet library is not installed, the first time a runbook runs a
dialog opens containing links to Microsoft to download the applicable PowerShell library.

1. Open the Server Manager.
2. Click Add roles and features.

The Add Roles and Features Wizard opens.

3. Click Next until the Features option is highlighted in the left pane.

4. In the features window, go to Remote Server Administration Tools > Roles Administration Tools
> AD DS and AD LDS Tools.

5. Select the Active Directory module for Windows PowerShell checkbox.
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6. Select Next.

Confirmation is highlighted in the left pane.

7. Click Install.

8. Select OK.
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Using the Exchange Runbooks in CSM
When the configuration is complete, the below procedure shows how to use the Exchange Orchestration
Pack in the CSM Desktop Client. The Exchange runbooks are accessed from the Task Pane or from an
Action menu bar. Runbooks for User Accounts have a User icon. Runbooks for computers or servers
have a computer icon.

Note: This functionality is only available if you have applied the Exchange Orchestration Pack
mApp Solution. For more information, refer to the Exchange Orchestration Pack documentation.

To use the Exchange Runbooks in the Desktop Client

1. Open an Incident.

2. View the available runbooks by:
a. In the menu bar, click Incident Actions. Select Exchange.

b. In the Task Pane, click the Exchange drop-down.
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Orchestration Pack for VMWare vRealize®
Automation™ 1.0

The Orchestration Pack for VMWare vRealize® Automation™ mApp® Solution allows users to fulfill
requests for virtual machines (VMs) using the Service Request process.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 8.1.0

Out-of-the-Box Content Version Requirements: Tested on CSM 8.1.0

Prerequisite Requirements: The Orchestration Pack for VMWare vRealize® Automation™ V1.0 mApp is
for demonstration and proof-of-concept purposes only and is specifically designed and tested with
vRealize® V7.0. The mApp is not intended to fully support an enterprise-level integration, including all of
the possible business uses. Consult Cherwell Professional Services (PSO) or a certified Implementation
Partner if you intend to deploy this solution within your production environment.

Overview
VMWare vRealize® Automation™ is a cloud-based solution that accelerates the delivery of IT services.
When the mApp Solution is applied and configured, Customers can easily request a new VM from the
Service Catalog and then initiate second day actions for the VM directly from the Customer Portal. After
the request is submitted, a User fulfills it using a Specifics Form on the Service Request form.
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Note: To use VMWare vRealize® Automation™ virtual machine functionality, you must create an
account and purchase a licensing option. Before applying the mApp Solution, have the following
VMWare customer information available for reference: username, password, host ID, and tenant
ID. Refer to the VMWare vRealize® website for more details (www.vmware.com/products/vrealize-
suite/).

How the mApp Solution Works
CSM provides the Orchestration Pack for VMWare vRealize® Automation™ as a mApp Solution so that
Users can easily access and incorporate vRealize® Automation™ functionality into their existing CSM
system. Download the mApp Solution from the Cherwell mApp SolutionExchange. Use the Apply mApp
Solution wizard to apply the mApp Solution to your CSM system. The Apply mApp Solution wizard
generates a Blueprint, which can then be viewed and published to a test or Live system to commit the
changes.

The mApp Solution includes the following items:

Item Category Item
Typical
Merge
Action

986

CSM mApp Solutions

CSM mApp Solutions

https://www.vmware.com/products/vrealize-suite/
https://www.vmware.com/products/vrealize-suite/


Business
Object

CI VM Status, Config-Virtual Machine, Configuration Item, Specifics -
VM, Specifics - VM Action, VM Action, VM Blueprint, VM Business
Group ID, VM CPU, VM Default Size, VM Request, VM Virtual Memory

Import

Incident, Incident SubCategory, Installed Software Merge

Configuration Item, Incident Category, Journal, Journal - Integrations
Audit, Service, Specifics

Don't
Change

Automation
Process

Check Request Status, Notify IT Manager, Request VM, Run VM
Request Action Import

Portal View

Config - Virtual Machine, Specifics - VM, Specifics - VM Action Import

Configuration Item Merge

Incident Don't
Change

Dashboard VM Detail, vRealize Import

Group Map Specifics Overwrite

Image Cloud, vRealize Logo, vRealize Logo 32x32 Import

One-Step
Action

Add Department, Approval One-Step to Run, Assign to ANY Individual,
Assign to Individual, Assign to Team, Clear One-Step, Create Change
Request for Action, Create CI, Create Service Request for Action, Date
Time Info Popup, E-mail IT Management VM Requests, Get New Asset
Tag, Lock Fields, Ready to Provision, Request a Virtual Machine,
Request Action, Request Action - Get Template, Request Action -
Submit Request, Request Action - Update JSON, Request Status
Update, Run VM Action, Select Action Type, Show Template, Take
Ownership, Update Status On vRA Resource, Update vRA Resource
Status, vRA - Get Token, vRA - Import Catalog, vRA - Set Debug, vRA -
Setup, vRA Request Submit

Import

Expression

Action Text, Asset Tag, CMDB Permanent Fields Locked, Config Type
Constraint, Constraint Message Max, Constraint Message Min,
Request VM Criteria, Requirements for Approval, Storage Constraint,
Storage Constraint Background Color, Team Entitlement, User
Entitlement, User Entitlements, User Entitlements On Behalf Of, VRA
Token Expiration Window, VRA Token is Expired

Import

Stored Query
All CIs with Resource ID Populated, ALL Requests, All VM CIs, CI VM
Active, CI VM Failed, Cloud Service VM Request, Requests Failed,
Requests Pending, Requests Succeeded, vRA Awaiting Approvals

Import

Stored Value

Admin Password, Admin Username, CSMPassword, CSMURL,
CSMUser, Identity Endpoint, Tenant Name, vRAActionID,
vRAActionName, vRABusinessGroup, vRACatalogItemID, vRACPU,
vRADebug, vRAHost, vRAJSON, vRANewJSON, vRAPassword,
vRARequestID, vRAResourceID, vRAResourceStatus,
vRAResultCode, vRAesultDetails, vRASuccess, vRATenant, vRAToken,
vRATokenExpiration, vRAUser, vRealize Version, vRealize Template

Import

Web Service vRealize Import
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Widget

Actions Over Time, Active VM CIs, CD - Date Filter - 30 Day Default,
CPUs, Host Name, Open Incidents, Open Request for VM Action, OS
Distribution, Request for VM, Request Waiting Action, Resource, Total
VMs, Virtual Machine Type, VM CI Failed, VM Costs, VM Critical
Machine, VM Host Device, VM Memory, VM Primary Use, VM Service
Requests, VM Storage, VM Total Waiting Approval, VM Waiting
Approval, VMs

Import

CD - Date Filter - 30 Day Default, Supply Search Overwrite

Merge Action Key:

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About mApps

• About Customer Portals

• About Incidents and Service Requests

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution in CSM Administrator
To configure the mApp Solution in CSM Administrator:

1. Add the vRealize® Form Control to the Incident Subcategory Form

2. Define Approval Process for vRealize®

3. Define the Web Service URL for vRealize®

4. Define Security Rights for vRealize®
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Steps to Configure the mApp Solution in the CSM Desktop Client
To configure the mApp Solution in the CSM Desktop Client:

1. Run Setup One-Steps for vRealize®

2. Define vRealize® Blueprints and Actions

3. Define vRealize® SubCategory Classification

How to Use the mApp Solution
There are multiple ways to use the mApp Solution functionality, including:

• Request a vRealize® Virtual Machine in the CSM Desktop Client

• Request a vRealize® Virtual Machine in the Customer Portal
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Configuring Orchestration Pack for VMWare
vRealize® Automation™ mApp Solution

Complete the following procedures to configure the Orchestration Pack for VMWare vRealize®
Automation™ mApp Solution. Configuration procedures are completed in CSM Administrator and the
CSM Desktop Client.

To configure the mApp in CSM Administrator:

1. Add vRealize® Form Control to the Incident SubCategory Form

2. Define Approval Process for vRealize®

3. Define Web Service URL for vRealize®

4. Define Security Rights for vRealize®

To configure the mApp in the CSM Desktop Client:

1. Run Setup One-Step Actions for vRealize®

2. Define vRealize® Blueprints and Actions

3. Define vRealize® SubCategory Classification
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Add the vRealize® Form Control to the Incident
Subcategory Form

Use the Form Editor to add a vRealize® Form Control to the Incident SubCategory Form. The Form
Control allows Users to define which Incident classifications (Service, Category, Subcategory) require
Approval.

Note: This functionality is only available if you have applied the Orchestration Pack for VMWare
vRealize® Automation™. For more information, refer to the mApp Solution Tech Notes
documentation.

To add the Form Control to the Incident SubCategory Form:

1. In the Lookup Tables Business Object tree, click Incident Subcategory.

2. Click the Form button .

Tip: You can also click View>View Form (from the Object Manager menu bar) or click the Edit
Form link (under the Appearance area).

3. In the Form drop-down, select the vRA Integration mApp Form Elements form.
a. Select the Form Control.

b. From the menu bar, click Edit>Copy.

4. From the Form drop-down, select Default Form.
a. From the menu bar, click Edit>Paste.

The Form Control displays on the Form.
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Note: The vRealize® Form Control pastes in a defined location for the default Incident
SubCategory Form. If you have a custom Form, move the Form Control to a location that fits
your form design.

5. Click the Update Blueprint button , and then click the Home button .
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Define Approval Process for vRealize®
Use the Approval Block Editor in CSM Administrator to define the Approval process for vRealize®. The
Approval process is initiated when a User selects the Approval Required check box on the Incident
Subcategory form. When used with the Request VM Subcategory, the request must be approved before
the request is sent to VMWare.

Note: This functionality is only available if you have applied the Orchestration Pack for VMWare
vRealize® Automation™. For more information, refer to the mApp Solution Tech Notes
documentation.

To define the Approval Block:

1. In the Object Manager, click Incident.

Note: The Approval process must be defined in both the Incident Default view and Portal
view.

2. In the Task section, select Edit approvals.

3. In the Approval Block Editor, click the Add button.

4. Provide a display name in the Name field.

5. Define a trigger condition:
a. Click the Trigger Condition page.

b. In the Trigger Condition section, create the following comparison clauses:
◦ Incident.Approval Required equals True

◦ Incident SubCategory.Approval Required equals True

◦ Specifics.Approval Required equals True

c. In the Trigger Condition section, create the following group clause:
◦ At least one of the following must be true
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6. Define approvers.

7. Define an Approval action:
a. Click the Action page.

b. In the Action to take when approval: Approved section, select the Run a One-Step check box.

c. Click the ellipses button to open the One-Step Manager.

d. In the One-Step Action tree, click Blueprint>Approval One-Step to Run.
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8. Select OK.
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Define the Web Service URL for vRealize®
Use the Web Service Manager in CSM Administrator to define the vRealize Web Service URL.

To define the vRealize Web Service URL:

Note: This functionality is only available if you have applied the Orchestration Pack for VMWare
vRealize® Automation™. For more information, refer to the mApp Solution Tech Notes
documentation.

1. Open the Web Service Manager.

2. Right-click the vRealize Web Service, and then select Edit.

The Web Service Options window opens.

3. In the URL field, provide the URL for your vRealize® environment:

4. Select OK.

5. Click Close.
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Define Security Rights for vRealize®
Use CSM Administrator to define security rights for vRealize® Business Objects.

Business Objects associated with this mApp Solution do not support any rights by default. We
recommend granting security rights to members of the Portal Customer and Portal Workgroup Manager
teams.

Note: This functionality is only available if you have applied the Orchestration Pack for VMWare
vRealize® Automation™. For more information, refer to the mApp Solution Tech Notes
documentation.

To define security rights:

1. Define the following Business Object rights for the Portal Customer Security Group:
◦ Config - Virtual Machine: Select rights to View, Add, and Edit.

◦ Specifics - VM: Select rights to View and Edit.

◦ Specifics - VM Action: Selects rights to View and Edit.

2. Define the following Business Object rights for the Portal Workgroup Manager Security Group:
◦ Config - Virtual Machine: Select rights to View, Add, and Edit.

◦ Specifics - VM: Select rights to View and Edit.

◦ Specifics - VM Action: Selects rights to View and Edit.

3. Select OK.
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Run Setup One-Step Actions for vRealize®
Use the One-Step Action Manager in the CSM Desktop Client to run the following One-Step Actions.

• vRA Setup: Prompts the User for vRealize® credentials (host ID, tenant ID, username, and
password) and CSM credentials (URL, username, and password)

• vRA Import Catalog: Uses vRealize® and CSM credentials to import catalog items (blueprints) and
actions from vRealize®.

Note: This functionality is only available if you have applied the Orchestration Pack for VMWare
vRealize® Automation™. For more information, refer to the mApp Solution Tech Notes
documentation.

To run the One-Step Actions:

1. In the CSM Desktop Client, open the One-Step Manager.

2. In the Association drop-down, select (None).
3. In the One-Step Actions tree, click Global>vRealize.

4. Click the vRA Setup One-Step Action and then click Run

A window opens displaying the current settings.

5. Select OK.

6. Provide the prompted vRealize® and CSM information.
A window opens displaying the defined settings.

Note: The information provided in the prompts is held in Stored Values. Edit them using the
Stored Value Manager (Global>vRealize).

7. Click the vRA Import Catalog One-Step Action and then click Run.

Note: The information obtained from vRealize® is stored in Lookup Tables. Catalog items
(blueprints) are located in the VM Blueprint Lookup Table and actions are located in the VM
Action Lookup Table in Table Management.
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Define vRealize® Blueprints and Actions
Use Table Management in the CSM Desktop Client to define imported vRealize® blueprints and actions.
When you define the blueprint, you provide midpoint values and have the option to provide a description.
When you define the actions, you must select the Request Action One-Step for each VM Action record;
the One-Step Action determines the appropriate second day action by using JSON to send the action ID
to vRealize® and then interpreting and executing the JSON when it returns from vRealize®.

Note: This functionality is only available if you have applied the Orchestration Pack for VMWare
vRealize® Automation™. For more information, refer to the mApp Solution Tech Notes
documentation.

To define mApp Solution blueprints and actions:

1. Open the Table Management interface.

2. In the Type drop-down, select VM Blueprint.
3. In the Grid, select a blueprint.

A VM Purpose form opens. The following information is auto-populated based on the imported
vRealize® blueprint: VM Blueprint, Blueprint available to the following Departments, Minimum size
specifications, Mid size specifications, and Maximum size specifications.

a. Provide midpoint values (CPUs, Memory, Storage Capacity).

b. (Optional) Provide a blueprint description.
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c. Click Save.

4. In the Type drop-down, select VM Action.

5. In the Grid, select an action.

A VM Action form opens.

a. Click the Choose One-Step button.

b. In theOne-Step Action Actions tree, click Global>vRealize.

c. Click the Request Action One-Step Action.

d. Click Save.

Note: The Request Action One-Step Action must be selected for each VM Action
record.

6. Close the Table Management interface.
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Define vRealize® Subcategory Classification
If you are using CSM 8.1.0 or greater, use Table Management in the CSM Desktop Client to define the
vRealize® SubCategory classification. When you define the classification, you select the VM Specifics
Form so that the appropriate form displays when the classification is selected. You can also select a
default Team and the option of using an Approval , if necessary.

Note: If you are using a version of CSM earlier than 8.1.0, use the Group Map Editor to point the
Request VM SubCategory to the VM Specifics Form and VM Action Request SubCategory to the
VM Action Specifics Form.

Note: This functionality is only available if you have applied the Orchestration Pack for VMWare
vRealize® Automation™. For more information, refer to the mApp Solution Tech Notes
documentation.

To define the SubCategory classification:

1. Open the Table Management interface.

2. In the Type drop-down, select Incident SubCategory.

3. In the Grid, select the Cloud Services/Virtual Machines (VM)/Request VM classification.

The Subcategory form opens.

a. In the Specifics Name field, select Specifics - VM.

b. (Optional) In the Default Team field, select the Team that should be assigned the Incident by
default when the classification is used.

c. (Optional) Select the Approval Required check box to initiate the defined Approval process
when the classification is used.

4. In the Grid, select the Cloud Services/Virtual Machines (VM)/Request VM classification.
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The Subcategory form opens.

a. In the Specifics Name field, select Specifics - VM Action.

b. (Optional) In the Default Team field, select the Team that should be assigned the Incident by
default when the classification is used.

c. (Optional) Select the Approval Required check box to initiate the defined Approval process
when the classification is used.

Note: For more information, see Add vRealize® Form Control to the Incident
Subcategory Form and Define Approval Process for vRealize®.

5. Close the Table Management interface.
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Using the Orchestration Pack for VMWare
vRealize® Automation™ mApp Solution

When using the Orchestration Pack for VMWare vRealize® Automation™mApp Solution, Users can:

• Request a vRealize® Virtual Machine in the CSM Desktop Client

• Request a vRealize® Virtual Machine in the Customer Portal
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Request a vRealize® Virtual Machine in the CSM
Desktop Client

Use the Incident Form to request a vRealize® virtual machine in the CSM Desktop Client.

Note: This functionality is only available if you have applied the Orchestration Pack for VMWare
vRealize® Automation™. For more information, refer to the mApp Solution Tech Notes
documentation.

To log an External Customer Service Incident in the CSM Desktop Client:

1. Log into CSM.

2. In the CSM Desktop Client toolbar, click New>New Incident.

A new Incident record opens.

3. Record the basic details (Who, What, How):
a. Requestor (in the Quick Info Tile): Provide the name of the Customer who initiated the contact,

and then press ENTER or TAB to search for the Customer Record.

b. Title: Provide a title for the Incident (ex: .

c. Description: Provide a detailed description for the Incident.

d. Call Source: Select a source for the initiation.

4. Classify the Incident:
a. Service: Select Cloud Services from the drop-down.

b. Category: Select Virtual Machines (VM) from the drop-down.

c. Subcategory: Select Request VM from the drop-down.
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d. Priority: Click the Priority drop-down to reveal the Priority Matrix (determined by invoked
SLA), and then click a priority number.

5. Complete the Request Virtual Macine Specifics Form.

Note: The VM Machine Type drop-down values are based on the Security settings on the
VM Purpose form (Blueprint available to the following Departments field). The default values
are automatically imported from vRealize®, but can be manually edited if necessary.

Note: If an Approval is defined, saving the record after completing the Specifics Form
initiates the process. For more information, see Add vRealize® Form Control to the Incident
Subcategory Form and Define Approval Process for vRealize®.

6. Complete the Incident logging process.

7. After the VM request is fulfilled, request a second day action:
a. In the I Want To section, select a second day action from the Request Action for this VM

drop-down.

b. Click the Run Action button.
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Request a vRealize® Virtual Machine in the
Customer Portal

Use the Customer Portal to request a vRealize® virtual machine.

Note: This functionality is only available if you have applied the Orchestration Pack for VMWare
vRealize® Automation™. For more information, refer to the mApp Solution Tech Notes
documentation.

To request a virtual machine in the Customer Portal:

1. Navigate to http://server/CherwellPortal where server is the location where the CSM Browser
applications are installed.

2. Log in to the Portal:
a. Click the Click to login link to log in to the Portal Site.

b. Provide login credentials (User Name and Password) for a User who has rights to access the
Customer Portal.

c. Click Sign-in.

3. In the Customer Service Portal toolbar, click Service Catalog.

The Service Catalog page opens.

a. In the Cloud Services>Virtual Machines (VM) section, click the Request VM Service.

The Request VM form opens.
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b. Complete the Request VM Specifics Form.

c. Click the Add to Cart button.

The Service Request displays on the My Service Orders page in the Services Ordered section.
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d. Click the Submit Order button.

e. Click OK to confirm the order.

Note: After the order is confirmed, the Service Request is assigned to the default
Team (if defined) and fulfilled using the CSM Desktop Client.

4. View the status of the request:
a. In the Customer Service toolbar, click the number next to My Requests (example: 8).

b. Click the Service Request that you want to view.

5. After the VM request is fulfilled, request a second day action:
a. On the Customer Portal home page, click the View My Devices link.

The Virtual Machine page opens.

b. Select a second day action from the Request Action for this VM drop-down.

c. Click the Run Action button.
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Planview Task Integration mApp Solution 1.0
Use the Planview Task Integration mApp® Solution to integrate Tasks into CSM.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform version requirements: Tested on CSM 10.1.0

Content version requirements: Tested on CSM 10.1.0. This mApp Solution may also be compatible on
content versions that are older than CSM 10.1.0, but as with all mApp Solutions, be sure to test them on
your customized system.

Prerequisites: Planview PPM Pro

Available languages: English

Overview
The Planview Task Integration mApp Solution uses the Planview API to integrate Tasks into CSM. The
mApp Solution contains recommended best practice for syncing data between CSM and Planview.
Technicians can see and work on all IT Tasks alongside any Project-related Tasks.

Apply the mApp Solution
To download, apply, and configure the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM. Do not
select Finish yet.

4. Review the Merge Actions to ensure customizations to your CSM instance will not be overwritten.

5. When prompted, enter your Planview URL to use for the API connection.

6. Still in the Apply mApp Wizard, when you reach the Final Options window, select Open a Blueprint
so that I can preview the changes, and then select Finish.

7. When the Blueprint opens, select Managers > Stored Values.
The Stored Value Manager opens.

8. Double-click the Planview folder.
a. Right-click the Planview Username stored value, and then select Edit.
b. In the Value field, enter your Plainview username to be used with your API account, and then

select Save.

c. Right-click the Planview Password stored value, and then select Edit.
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d. In the Value field, enter your Plainview password to be used with your API account, and then
select Save.

9. Publish the Blueprint.

For a list of items included in this mApp Solution, see Planview Task Integration mApp Solution Items.

Revision History

mApp Solution Version Platform Version
Requirements

Content Version
Requirements Prerequisites

1.0 10.1.0 10.1.0 None

Related concepts
Publish a Blueprint
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Create the Planview Filters
To ensure only relevant data is imported into CSM, you need to create filters in your Planview PPM Pro
account.

To create Planview filters:

1. Login to your Planview Pro account.
2. On the menu bar, select Home, and then on the left, select Filters.
3. On the Filter page, select New, and then select New Filter.
4. For the title, enter All Projects.
5. Under Criteria, from the Show drop-down list, select Projects.
6. In the any of the following are true drop-down list, scroll down to Filterable Fields, and then

select the Show all (185) fields.
7. Scroll down the list of fields and select Project: ID.
8. In the next drop-down list, select is greater than.
9. In the next field, enter 0, and then select Save.

10. Select New, and then select New Filter.
11. For the title, enter Tasks Assigned to Resources.
12. Under Criteria, from the Show drop-down list, select Tasks.
13. In the any of the following are true drop-down list, scroll down to Filterable Fields, and then

select the Show all (354) fields.
14. Scroll down the list of fields and select Task: Scheduled Hours.
15. In the next drop-down list, select is greater than.
16. In the next field, enter 0, and then select Save.

Note: Only Tasks that have been assigned to resources and the resources have scheduled hours
to the Task will be imported into CSM. It is important that the names of these filters are exactly as
shown because the API uses these names.
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Assign Task Owner in Planview
Planview can have multiple resources assigned to each Task, while only one resource can be assigned to
a Task in CSM. To ensure the correct resources are assigned to Tasks within CSM the Planview Task
Integration mApp® Solution uses the Task Owner field in Planview to set the assigned resource in CSM.

Ensure the Task Owner field is enabled on your Task form in Planview (if the field is already visible on the
Task form, the following steps are not required).

To assign Task owner in Planview:

1. Login to your Planview Pro account.
2. On the menu bar, select Admin, and then in the left column, select Setup > All Entities.
3. On the Entities page, select Tasks.

The Task Details page displays.
4. In the Available Fields list select Owner, and then select the right arrow to move it to the Details

column.
Use the up and down arrows to move the field to where you want it displayed on the Task form.

◦ Set the Show On New field to Yes, and then set the Show on Edit field to Yes - Editable.
Consider entering a description for this field that explains to users that the resource assigned as the
owner will be the assigned resource in CSM.

5. On the menu bar, select Home, and then select Yes to save the changes.

Note: Only Tasks that meet the following criteria will be imported into CSM:

• Tasks that have an owner assigned.

• Task owner's with a User Info record in CSM.

• Tasks that have time scheduled to resources in Planview.
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Set Up Scheduled Project and Task Imports
The Planview Task Integration mApp® Solution uses two scheduled processes to import project and Task
data from your Planview account daily.

This functionality is only available after you apply the mApp Solution.

To set up scheduled Project and Task imports:

1. In CSM Administrator, select Scheduling > Edit Schedule.
The Scheduled Items window opens.

2. Select Add.

A Schedule Item window opens.

3. On the General page, enter Planview Projects for the name.
4. On the Schedule page, select the Recurring option, and then enter a start time.
5. In the Recurrence section, select the Daily and Every 1 Day options
6. In the Range of recurrence section enter a start date, and then select the No end date option.
7. On the Action page, select One-Step from the Action drop-down list.

a. Next to the One-Step drop-down list, select the ellipsis.
The One-Step Action Manager opens.

b. In the Association drop-down list, select None, and then select the Global folder on the left.
c. Double-click the Planview folder, and then double-click the Scheduled Import Projects One-

Step Action.
d. Select Save.

8. From the Scheduled Items window, select Add.
9. On the General page, enter Planview Tasks for the name.

10. Repeat steps 4-6.

Important: Select a scheduled time that is after the Projects import scheduled time. The
Projects import must run before the Task import.

11. On the Action page, select One-Step from the Action drop-down list.
a. Next to the One-Step drop-down list, select the ellipsis.

The One-Step Action Manager opens.
b. In the Association drop-down list, select None, and then select the Global folder on the left.
c. Double-click the Planview folder, and then double-click the Scheduled Import Tasks One-

Step Action.
d. Select Save.

12. On the Scheduled Items window, select Exit.
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Note: The Planview filters that are set up will ensure that only Projects and Tasks that are new or
have had changes made to them in the last 24 hours, and meet the Plainview filter criteria, will be
imported.

Related concepts
About the Scheduler
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Initial Planview Import
Use One-Step™ Actions to import all Projects and Tasks from Planview. This initial import will add Project
and Task data from your Planview account to CSM, but will not affect the scheduled imports.

This functionality is only available after you apply the mApp Solution.

Remember: Only Tasks that meet the following criteria will be imported into CSM:

• Tasks that have an owner assigned.

• Task owner's with a User Info record in CSM.

• Tasks that have time scheduled to resources in Planview.

For best results, import Projects before Tasks.

To use One-Step Actions to import all Projects and Tasks:

1. From the CSM Desktop Client menu bar, select One-Step > One-Step Manager.
a. In the Association drop-down list, select None, and then double-click the Planview folder.
b. Select the Import Project One-Step Action, and then select Run.
c. When the Prompt displays, select the earliest date for importing Projects from Planview.

If you want to include all Projects in your Planview account, select a date prior to the create
date on your Projects.
The One-Step Action will run, and it may take a few minutes to complete.

2. To view all Projects imported, from the menu bar, select Searching > Search Manager.
a. In the Association drop-down list, select Planview Projects, and then double-click the

Planview folder.
b. Select the All Planview Projects saved search, and then select Run.

A list of all imported Projects will display. If the list is empty, you many need to wait a few minutes
and run the search again.

3. Follow steps 1 - 1a.
a. Select the Import Tasks One-Step Action, and then select Run.
b. When the Prompt displays, select the earliest date for importing Tasks from Planview.

If you want to include all Task in your Planview account, select a date prior to the create date
on your Tasks.
The One-Step Action will run, and it may take a few minutes to complete.

4. To view all Tasks imported, from the menu bar, select Searching > Search Manager.
a. In the Association drop-down list, select Work Item, and then double-click the Planview

folder.
b. Select the All Project Tasks saved search, and then select Run.

A list of all imported Tasks will display. If the list is empty, you many need to wait a few minutes and
run the search again.

Any changes you make to a Task will be exported via the API to Planview after saving.
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Note:

• If you assign the Task to a user who is not part of the Project team for the Task, the Task
owner will not update in Planview.

• Any special characters in the title or description will cause the sync to fail between Planview
and CSM.

Related concepts
About One-Step Actions
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Update Work Items with Planview Fields
The Work Item form in CSM has fields associated with Planview that are not currently displayed on the
form. You can manually add these fields to the form.

This functionality is only available after you apply the mApp Solution.

To add fields associated with Planview to the Work Item form:

1. From CSM Administrator, create a Blueprint.
2. Under Show object types, select the Supporting option.
3. Select the Work Item Business Object, and then under Appearance, select Edit form.
4. Under Work Item forms, double-click Planview Fields.

The Planview Fields form displays and shows all the fields you can add to your Work Item form.
5. Copy and paste any fields you want to add to your Work Item form onto the Task form.
6. Add a Link Label Control to the Work Item form, under Actions.

This link will allow you to check for updates in Planview.
a. Right-click the Link Label Control, and then select Control Properties.
b. In the Choose Action window, under Action, select the ellipses.
c. In the next Choose Action window, on the left, select the One-Step Actions page.
d. In the Association drop-down list, select None, and then select the Global folder on the left.
e. Double-click the Planview folder, and then double-click the Import Tasks One-Step Action.
f. Select OK, and then select OK again.

7. Publish the Blueprint.

Related concepts
Work Item Task
Publish a Blueprint
Related tasks
Create a Blueprint
Add a Field Form Control to a Form
Add a Link Label Control to a Form
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Planview Task Integration mApp Solution Items
The items table provides a list of items included when applying the mApp® Solution and the typcial merge
action.

Item Category Item Typical Merge Action

Action Block Login Import

Automation Process Definitions Project Create or Update, Task Create or
Update, Update Planview Import

Business Objects

Planview Import, Planview Projects Import

Task Don't Change

Work Item Merge

Dashboard My Work with Project Tasks Import

Fields

Created By, Created By ID, Created
Culture, Created Date Time, Description,
End Date, Last Modified By, Last Modified
By ID, Last Modified Date Time, Number,
Outline, Planview Project ID, Planview
Task ID, Predecessors Tasks, Project,
Project Description, Project End Date,
Project Import, Project Start Date, Project
Status, RecID, Start Date, Status,
Successors Tasks, Task, Task Description,
Task Duration, Task End Date, Task Import,
Task Owner, Task Start Date, Task Status,
Title

Import

Close Code, Hold Reason Overwrite

Form arrangements PlanviewImport, PlanviewProjects Import

Forms Planview, PlanviewProjects,
PlanviewTaskImport Import

Grids PlanviewProjects, PlanviewTaskImport,
Project-Task-Grid Import

Indexes

PK_PlanviewProjects,
PK_PlanviewTaskImport Import

PK_Task, Task_ParentID,
Task_ParentTypeID, Task_Subject,
Task_TaskID, Task_TaskType, TaskStatus,
Scheduled Import Tasks, Update Planview
Task

Overwrite
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Item Category Item Typical Merge Action

One-Step™ Actions

Close and Clear Dependencies Overwrite

Create or Update Project, Create or
Update Task, Import Projects, Import
Tasks, Scheduled Import Projects,

Import

Relationships

Planview Import links Planview Projects,
Planview Import Links Users, Planview
Import Links Work Item, Planview Projects
links Work Item

Import

Searches

All Open Project Tasks, All Planview
Projects, All Planview Task Imports, All
Project Tasks, Closed Project Tasks, My
Open Project Tasks, My Project Tasks, My
Teams Open Project Tasks, My Teams
Project Tasks

Import

Stored expression Yesterdays Date Overwrite

Stored values Planview Password, Planview URL,
Planview Username, Text Import

Web service Planview Import

Widgets

CD - Date Filter - 30 day default, CD-All P1
Issues, CD-My Incidents and Requests,
CD-My Open Incidents, CD-My Open
Tasks, CD-My Open Tasks Count, CD-My
Open Tickets, CD-My Teams Open Change
Requests, CD-My Teams Open Tasks, CD-
My Teams Problems, CD-My VIP Issues

Overwrite

My Open Project Tasks, My Open Project
Tasks - Count, My Teams Open Project
Tasks

Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution includes the
definition for informational purposes only (the definition is not imported into the target system).
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Risk for Change mApp Solution 1.0
The Risk for Change mApp® Solution provides functionality that allows you to evaluate the risk level of a
Change Request using a Risk Assessment with defined thresholds.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 5.0.0

Out-of-the-Box Content Version Requirements: Tested on CSM 5.0.0; localized content not supported.

Prerequisite Requirements: None

Overview
In CSM, Risk Assessment is a Supporting Object. The Risk Assessment Form has two sections, including
Risk Questionnaire and Risk Chart.

Users evaluate a Change Request using the Risk Questionnaire by answering questions related to
Service Delivery Risks and Service Disruption Risks. As the User progresses through the questionnaire,
Risk Weight definitions calculate the risk level, and then auto-populate the Risk Chart using low, medium,
high, and extreme risk levels.

Risk Weight is a Lookup Object that allows Users to define Risk Assessment properties (including
categories, subcategories, point allocation, etc.) using Table Management.
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How the mApp Solution Works
CSM provides Risk for Change as a mApp Solution so that Users can easily incorporate risk assessment
functionality into their existing CSM system. Download the mApp Solution from the Cherwell mApp
Exchange. Use the Apply mApp wizard to apply the mApp Solution to your CSM system. The Apply mApp
wizard generates a Blueprint, which can then be viewed and published to a test or Live system to commit
the changes.

The mApp Solution includes the following items:

Item Category Item Typical Merge Action

Business Object

 

BusObID, Risk Assessment, Risk Weight Import

Change Request Merge

One-Step Action

Advanced Decrement, Advanced Increment, Clear Temp
Fields, Create Risk Assessment, Edit Questionnaire, Exit
Questionnaire, Go to Risk Assessment, Lock Assessment,
Set Change Fields, Set Temp Fields

Import

Expression Numerous Import
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Custom View Portal Default Don't Change

Widget Change Risk Levels Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About Change Requests

• About mApp Solutions

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution
After applying the mApp Solution, perform the following high-level steps to configure the mApp Solution:

1. Add Form Controls to Change Request Forms.

2. (Optional) Edit existing Risk Assessment properties.

Steps to Use the mApp Solution in the Desktop Client
To use the mApp Solution in the Desktop Client, perform the following steps:

1. Create a Risk Assessment for a Change Request.
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Configuring the Risk for Change mApp Solution
Complete the following procedures to configure the Risk for Change mApp Solution. The configuration
procedures are completed in the CSM Desktop Client and CSM Administrator.

1. Add Form Controls to Change Request Forms.

2. (Optional) Edit existing Risk Assessment properties
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Add Form Controls to Change Request Forms
Use the Form Editor in CSM Administrator to add Form Controls to Change Request Forms.

Note: This functionality is only available if you have applied the Risk for Change mApp Solution.
For more information, refer to the mApp Solution Tech Notes documentation.

To add Forms Controls to Change Request Forms:

1. Open the Form Editor

2. Add the Create Risk Assessment link to Change Request Forms:
a. In the Form drop-down (upper-left), select Risk for Change Form Elements.

The Risk for Change Form Elements Form opens.

b. Click the Create Risk Assessment Link Label Control.

c. In the CSM Desktop Client menu bar, click Edit>Copy.

d. In the Form drop-down, click Default Form.

The Default Form opens.

i. In the CSM Desktop Client menu bar, click Edit>Paste.

The Link Label Control displays on the Form.

ii. Drag-and-drop the Link Label Control to the I Want To section.

iii. Click the Update Blueprint button .

e. In the Form drop-down, select Assess Normal.

The Assess/Approve Form opens.

i. In the CSM Desktop Client menu bar, click Edit>Paste.
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The Link Label Control displays on the Form.

ii. Drag-and-drop the Link Label Control to a location on the Form (based on your Form
design).

iii. Click the Update Blueprint button .

f. In the Form drop-down, select Assess Emergency.

The Assess Form opens.

i. In the CSM Desktop Client menu bar, click Edit>Paste.

The Link Label Control displays on the Form.

ii. Drag-and-drop the Link Label Control to a location on the Form (based on your Form
design).

iii. Click the Update Blueprint button .

3. Add the Go to Last Risk Assessment link to Change Request Forms:
a. In the Form drop-down (upper-left), select Risk for Change Form Elements.

The Risk for Change Form Elements Form opens.

b. Click the Go to Last Risk Assessment Link Label Control.

c. In the CSM Desktop Client menu bar, click Edit>Copy.

d. In the Form drop-down, click Default Form.

The Default Form opens.

i. In the CSM Desktop Client menu bar, click Edit>Paste.

The Link Label Control displays on the Form.

ii. Drag-and-drop the Link Label Control to the I Want To section.

iii. Click the Update Blueprint button .

e. In the Form drop-down, select Assess Normal.

The Assess Form opens.

i. In the CSM Desktop Client menu bar, click Edit>Paste.

The Link Label Control displays on the Form.

ii. Drag-and-drop the Link Label Control to a location on the Form (based on your Form
design).
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iii. Click the Update Blueprint button .

f. In the Form drop-down, select Assess Emergency.

The Assess Form opens.

i. In the CSM Desktop Client menu bar, click Edit>Paste.

The Link Label Control displays on the Form.

ii. Drag-and-drop the Link Label Control to a location on the Form (based on your Form
design).

iii. Click the Update Blueprint button .

4. Replace Risk Analysis text on all applicable Change Request Forms:
a. In the Form drop-down (upper-left), select Risk for Change Form Elements.

The Risk for Change Form Elements Form opens.

b. Click the Create Risk Assessment Link Label Control.

c. In the CSM Desktop Client menu bar, click Edit>Copy.

d. In the Form drop-down, select [Change Form].

The [Change Form] Form opens.

i. Select the exiting Risk Analysis Text Label Control, and then click Edit>Delete
Selected Controls.

ii. In the CSM Desktop Client menu bar, click Edit>Paste.

The Text Label Control displays on the Form.

iii. Drag-and-drop the Text Label Control to a location on the Form (based on your Form
design).

iv. Click the Update Blueprint button .

5. Click the Home button .

6. Publish the Blueprint to commit the changes (File>Publish Blueprint).
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(Optional) Edit Existing Risk Assessment
Properties

Use Table Management in the CSM Desktop Client to edit existing Risk Assessment properties.

Note: This functionality is only available if you have applied the Risk for Change mApp Solution.
For more information, refer to the mApp Solution Tech Notes documentation.

To edit existing Risk Assessment properties:

1. Open the Table Management interface

2. In the Type drop-down, select Risk Weight.

Risk Weight values display in the Grid.

3. In the Table Management Grid, right-click a value, and then select Go to Record.

The Risk Weight Lookup Object opens.

4. Use the Impact/Likelihood matrix to associate Risk Levels with Risk Scores for a Change Request
or Incident template.

5. Use the Category and Points fields to assign a weight for each category. Weight allotments must
total 100.

6. Use the Subcategory and Points fields to assign a weight for each category. Weight allotments must
total 100.

7. Click Save .
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Using the Risk for Change mApp Solution
When working with the Risk for Change mApp Solution, Users can:

• Create a Risk Assessment for a Change Request.
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Create a Risk Assessment for a Change Request
Use the Change Form in the CSM Desktop Client to create a Risk Assessment for a Change Request.

Note: This functionality is only available if you have applied the Risk for Change mApp Solution.
For more information, refer to the mApp Solution Tech Notes documentation.

To create a Risk Assessment:

1. On the CSM toolbar, click New>New Change Request.

A new Normal Change record is created with a unique Change ID and a status of New.

2. Creator selects a Requestor (if different from the creator):
a. Requestor: Specify the name of the person who initiated the Change, and then press ENTER

or TAB to search for the Customer Record.

If an exact match is found, the Requestor fields are auto-populated with the Customer’s name,
avatar, e-mail, and phone number. If multiple matches are found, the Contact Manager opens
so that you can select the appropriate Customer.

3. In the I Want To section of the Quick Info Tile, click the Create a Risk Assessment link.

Note: Alternatively, you can access the Risk Assessment by clicking the Create a Risk
Assessment link on an applicable Change Request Form.
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The Risk Chart and Risk Questionnaire sections display in the CSM Desktop Client main pane.

4. Complete the Risk Questionnaire:
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Note: As you complete the questionnaire, the Risk Chart fields auto-populate with a risk
level (Low, Medium, High, Extreme).

a. Define the risk of the Change based on the time of day that it is scheduled to take place:
i. What is the impact if there is an issue related to this Risk: Select a radio button that

corresponds with the potential impact to the Change:
◦ Insignificant

◦ Minor

◦ Moderate

◦ Major

◦ Severe

ii. What is the likelihood that the Risk will be an issue: Select a radio button that
corresponds with the likelihood that the risk will take place:

◦ Rare

◦ Unlikely

◦ Possible

◦ Likely

◦ Certain

iii. Risk mitigation plan (if applicable): Provide a mitigation plan to follow if the risk occurs.
Depending on the defined risk, a mitigation plan might be required.

iv. Click the Save and Next button.

b. Define the risk of the Change based on the affected Service:
i. What is the impact if there is an issue related to this Risk: Select a radio button that

corresponds with the potential impact to the Change:
◦ Insignificant

◦ Minor

◦ Moderate

◦ Major

◦ Severe

ii. What is the likelihood that the Risk will be an issue: Select a radio button that
corresponds with the likelihood that the risk will take place:

◦ Rare

◦ Unlikely

◦ Possible

◦ Likely

◦ Certain

iii. Risk mitigation plan (if applicable): Provide a mitigation plan to follow if the risk occurs.
Depending on the defined risk, a mitigation plan might be required.
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iv. Click the Save and Next button.

c. Define the risk of the Change based on the number of affected Users:
i. What is the impact if there is an issue related to this Risk: Select a radio button that

corresponds with the potential impact to the Change:
◦ Insignificant

◦ Minor

◦ Moderate

◦ Major

◦ Severe

ii. What is the likelihood that the Risk will be an issue: Select a radio button that
corresponds with the likelihood that the risk will take place:

◦ Rare

◦ Unlikely

◦ Possible

◦ Likely

◦ Certain

iii. Risk mitigation plan (if applicable): Provide a mitigation plan to follow if the risk occurs.
Depending on the defined risk, a mitigation plan might be required.

iv. Click the Save and Next button.

d. Define the risk of the Change based on the complexity of the back out plan:
i. What is the impact if there is an issue related to this Risk: Select a radio button that

corresponds with the potential impact to the Change:
◦ Insignificant

◦ Minor

◦ Moderate

◦ Major

◦ Severe

ii. What is the likelihood that the Risk will be an issue: Select a radio button that
corresponds with the likelihood that the risk will take place:

◦ Rare

◦ Unlikely

◦ Possible

◦ Likely

◦ Certain

iii. Risk mitigation plan (if applicable): Provide a mitigation plan to follow if the risk occurs.
Depending on the defined risk, a mitigation plan might be required.

iv. Click the Save and Next button.

e. Define the risk of the Change based on the Users who are involved:
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i. What is the impact if there is an issue related to this Risk: Select a radio button that
corresponds with the potential impact to the Change:

◦ Insignificant

◦ Minor

◦ Moderate

◦ Major

◦ Severe

ii. What is the likelihood that the Risk will be an issue: Select a radio button that
corresponds with the likelihood that the risk will take place:

◦ Rare

◦ Unlikely

◦ Possible

◦ Likely

◦ Certain

iii. Risk mitigation plan (if applicable): Provide a mitigation plan to follow if the risk occurs.
Depending on the defined risk, a mitigation plan might be required.

iv. Click the Save and Next button.

f. Define the risk of the Change based on the Users who are involved:
i. What is the impact if there is an issue related to this Risk: Select a radio button that

corresponds with the potential impact to the Change:
◦ Insignificant

◦ Minor

◦ Moderate

◦ Major

◦ Severe

ii. What is the likelihood that the Risk will be an issue: Select a radio button that
corresponds with the likelihood that the risk will take place:

◦ Rare

◦ Unlikely

◦ Possible

◦ Likely

◦ Certain

iii. Risk mitigation plan (if applicable): Provide a mitigation plan to follow if the risk occurs.
Depending on the defined risk, a mitigation plan might be required.

iv. Click the Save and Next button.

g. Define the risk of the Change based on the amount of required testing:
i. What is the impact if there is an issue related to this Risk: Select a radio button that

corresponds with the potential impact to the Change:
◦ Insignificant
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◦ Minor

◦ Moderate

◦ Major

◦ Severe

ii. What is the likelihood that the Risk will be an issue: Select a radio button that
corresponds with the likelihood that the risk will take place:

◦ Rare

◦ Unlikely

◦ Possible

◦ Likely

◦ Certain

iii. Risk mitigation plan (if applicable): Provide a mitigation plan to follow if the risk occurs.
Depending on the defined risk, a mitigation plan might be required.

iv. Select Finish.

Based on questionnaire answers, the Risk Chart displays risk levels (Low, Medium, High,
Extreme) for each type of risk.

Note: Before the Risk Assessment is saved, it can be edited by clicking the Edit
Questionnaire button in the Risk Questionnaire section. After the Risk Assessment is
saved, it cannot be edited.

h. Click Save .

5. In the Risk Assessment's Form Arrangement, click the Go To Record button to return to the
Change Request record.
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Skills Management mApp Solution 1.0
Use the Skills Management mApp® Solution to create skills and link them to users.

Platform Version Requirements: Tested on CSM 10.0.0

Content Version Requirements: Tested on CSM 10.0.0

Prerequisites: None

This mApp Solution is available in the following languages:

• German

• English

• Spanish

• French

• Portuguese

Overview
The Skills Management mApp Solution allows administrators or managers to create skills and link them to
users. Use the Skills module to easily identify skills across an organization to assist with the automatic
identification of qualified technicians for Incidents and Service Requests. Some benefits of using this
mApp Solution include decreased assignment time for new tickets, cross-departmental collaboration, auto
assignment of tickets based on skills, enhanced visibility of Subject Matter Experts (SMEs), and
assistance with internal recruitment processes.

Examples of skills included are:

• Application Development

• Contract Management

• Desktop Support

• Foreign Languages

• Information Security
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Apply the mApp Solution
To apply the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Note: For 10.2.0 content versions and later, before you publish the Blueprint, delete the following
index:

• Index IncidentService on Service

See Define Database Properties for a Business Object.

For a list of items included in the mApp Solution, see Skills Management mApp Solution Items.

Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.0 10.0.0 10.0.0 None
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Related concepts
Go to the Cherwell Marketplace (formerly the mApp Exchange)
Apply a mApp Solution
About mApp Solutions
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Add Skills Management Elements to the Incident
Form

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add mApp Solution
elements to the Incident Form.

Note: This functionality is only available if you have applied the Skills Management mApp
Solution.

To add the Skills Management Elements to the Incident Form:

1. From the Current view drop-down list, select Default.
2. Under Show object types, select the Major option.
3. In the Business Object tree, select Incident.
4. Under Appearance, select the Edit form link.
5. From the Incident forms list, double-click SkillsManagement.

The Skills Management Controls Form opens.
6. Select and copy the button or link from the Skills Management Controls. Depending on your

preference, you can copy both controls.
7. From the Incident forms list, double-click Incident Overview.

The Incident Overview Form opens.
8. Paste the button or link on the Form.
9. Set the coordinates to position the button or link for each Adaptive Layout. With the button or link

selected, right-click and select Position and Size.
The recommended coordinates are as follows:

Base Layout Tablet Form Mobile Default Form

Button Left: 440
Top: 815

Left: 365
Top: 596

Left: 365
Top: 720

Link Left: 1058
Top: 453

Left: 43
Top: 1243

Left: 43
Top: 2277

10. Select OK.
11. Repeat steps 6-10 for each Adaptive Layout.
12. To copy the location to other languages for each Adaptive Layout, select the button or link and right-

click Localization Options > Copy between cultures.
13. Select the Copy values to the following cultures option and select all cultures that apply.
14. Select Apply.
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15. Repeat steps 12-14 for each Adaptive Layout.
16. Save the Blueprint.

Related concepts
Form Editor
Skills Management mApp Solution 1.0
Save a Blueprint
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Add Skills Management Elements to Incident
Category Form

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add mApp Solution
elements to the Incident Category Form.

Note: This functionality is only available if you have applied the Skills Management mApp
Solution.

To add the Skills Management Elements to the Incident Category Form:

1. From the Current view drop-down list, select Default.
2. Under Show object types, select the Lookup tables option.
3. In the Business Object tree, select Incident Category.
4. Under Appearance, select the Edit form link.
5. From the Incident Category forms list, double-click Incident Category.

The Incident Category Form opens.
6. Under the Incident Category Fields list, drag the Required Skill field onto the Form. Depending on

your preference, you can copy both controls.
7. To set the coordinates (and size) to position the label and field, select the label or field, right-click

and select Position and Size.
The recommended coordinates and size are as follows:

Base Layout

Label Left: 528
Top: 118

Field

Left: 530
Top: 150
Width: 400
Height: 30

8. Select OK.
9. To copy the location to other languages, select the label or field and right-click Localization

Options > Copy between cultures.
10. Select the Copy values to the following cultures option and select all cultures that apply.
11. Select Apply.
12. Publish the Blueprint.

Related concepts
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Form Editor
Skills Management mApp Solution 1.0
Publish a Blueprint
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Add Skills and Link to Users
Add skills and link to Users from the mApp® Solution from the CSM Desktop Client or Browser Client.

Note: This functionality is only available if you have applied the Skills Management mApp
Solution.

1. Open the Search Manager.
2. From the Association drop-down list, select Skills.

The All Skills Saved Search displays.
3. Run the All Skills Saved Search.

Search results are listed. There are 87 pre-loaded skills included in the mApp Solution.
4. To create new skills, select New from the menu bar. This can only be done from the CSM Desktop

Client.
5. To view a skill record, select the skill.
6. To assign a skill to a User, from the Form Arrangement, select the Users tab, and then select the

link button.

Note: In the Browser Client, if you do not see the Form Arrangement tabs at the bottom of
the Form, find the Form Splitter Separator and drag it up to reveal the tabs.

The User Info Selector window opens.
7. Select a User and then select OK.
8. To assign all Users from a specific team to a skill, from the Form Arrangement, select the Teams

tab, and then select the link button.
The Team Info Selector window opens.

9. Select a Team and then select OK.
After saving the skill record, the Users within the linked team will automatically be linked to the skill
and will be visible on the Users tab. A refresh may be required to see the changes.

10. To assign a required skill to an Incident Category, from the Form Arrangement, select the Incident
Categories tab, and then select the link button.
The Incident Category Selector window opens.

11. Select an Incident Category and then select OK.
Categories can only have one skill as its Required Skill.

12. To view the Incident Category Form, select the Category from the list in the Incident Categories
tab, and then select the Goto Incident Category button.
The Required Skill on the Incident Category Form is populated with the skill you linked.

13. Save the record.

Related concepts
Open the Search Manager
Run a Saved Search

1042

CSM mApp Solutions

CSM mApp Solutions

https://help.cherwell.com/csh?topicname=open_the_search_group_manager
https://help.cherwell.com/csh?topicname=run_a_search_group


Resize Forms Using Splitters
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Test the Skills Management Functionality
Test the functionality of the Skills Management mApp® Solution from the CSM Desktop Client or Browser
Client.

• When assigning Incidents that have a Service Classification within an Incident Category that has a
Required Skill, the Recommended Assignee button or link should be visible on the Incident Form.

• When selecting the Recommended Assignee button or link, you should see a list of all Users who
are linked to the Required Skill for the Incident Category, along with their default team and Open
Incident count.

Selecting a User from the list will update the Assigned To and Assigned Team on the Incident Form.
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Skills Management Dashboard
Use the Skills Management Dashboard to view at-a-glance information on all skills and links to teams and
Users.

Note: This functionality is only available if you have applied the Skills Management mApp
Solution.

1. Open the Dashboard Manager.
2. To open the Skills Management Dashboard, expand the Global folder and then expand the

Dashboards folder.
3. Select Default Dashboards and then double-click Skills Management.

The Skills Management Dashboard opens displaying the following information:
◦ Total number of skills records in the system.
◦ How many skills are unassociated (do not have Users associated to them).
◦ A bar graph that shows skills linked to teams and Users.
◦ An All Skills Grid with a quick view of each skill and the number of Users and teams

associated with each. Double-click on a skill to go directly to the skill record.

Note: The Team Skills Widget uses calculated values, so it won't display a value until you force it
to calculate. You will need to either run the scheduled job that is in the mApp Solution or open any
TeamInfo record that has been attached to a Skill.

Related concepts
Open the Dashboard Manager
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Skills Management mApp Solution Items
The Items table provides a list of items included when applying the mApp Solution and the typical merge
action.

Item Category Item Typical Merge
Action

Business Objects
Incident, Incident Category, Team Info, UserInfo Merge

SkillLinksUsers, Skills Overwrite

Color Palette Cherwell Dashboards Overwrite

Dashboard Skills Management Overwrite

Fields

ChildID, ChildJoinReason, ChildType, Created By, Created By
ID, Created Culture, Created Date Time, Description,
Description_de-DE, Description_en-US, Description_es-ES,
Description_fr-FR, Description_pt-BR, JoinReason, Last
Modified By, Last Modified By ID, Last Modified Date Time,
ParentID, ParentType, RecID, Required Skill, Skill, Skill ID,
Skill_de-DE, Skill_en-US, Skill_es-ES, Skill_fr-FR, Skill_pt-BR,
Skills ID, TotalSkills, TotalTeams, TotalUsers, User Full Name

Overwrite

Forms SkillsManagement, Skills Overwrite

Form Arrangement Skills Overwrite

Grids Dashboard, Skills Overwrite

Image Definitions

add_16_blue_form, add_20_blue_form, add_24_blue_form,
Add_Image_64, approval_ abstained_20_blue,
approval_approved_20_blue, approval_denied_20_blue,
approval_pending_20_blue, attach_16_blue_form,
attach_20_blue_form, attach_24_blue_form, behalf_16,
behalf_20, behalf_24, calendar_16_blue_form,
calendar_20_blue_form, chart_16_blue_form,
chart_20_blue_form, chart_24_blue_form, clock_20_blue,
clock_24_blue, delete_16_blue_form, delete_20_blue_form,
delete_24_blue_form, duplicate_16_blue_form,
duplicate_20_blue_form, duplicate_24_blue_form,
edit_16_blue_form, edit_20_blue_form, edit_24_blue_form,
editor_16_blue_form, editor_20_blue_form,
editor_24_blue_form, email_20, error_13_status_header,
itempicker_16_blue_form, jumpto_16_blue_form,
jumpto_20_blue_form, jumpto_24_blue_form,
paragraph_16_blue_form, paragraph_20_blue_form,
paragraph_24_blue_form, picker_20_blue_form,
picker_24_blue_form, reply_16_blue_form, reply_20_blue_form,
reply_24_blue_form, thumbs_down_20, thumbs_up_20,
user_16_blue_form, user_20_blue_form, user_24_blue_form,
Warning_24_red

Overwrite
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Indexes

Incident_CustomerID, Incident_IncidentType,
Incident_OwnedByID, Incident_RecID,
IncidentCategory_IncidentCategory, IncidentCreatedDT,
IncidentID, IncidentIdx_ServiceCartRecID,
IncidentIdx_ServiceCatalogTemplateRecID, IncidentService,
IncidentStatus, PK_IncidentCategory, PK_SkillLinksUsers,
PK_Skills, PK_TeamInfo, PK_UserInfo, System_LDAPPathIdx,
TeamInfoName, UserInfo_FullName

Overwrite

Mergeable Area Skills Action Overwrite

One-Step™
Actions

Recommended Assignee, refreshcounts, Skills from Team,
TeamSkills, Update Skills, Update user and team counts,
UpdateSkillsCount

Overwrite

Relationships
Incidents links skills, Skills links Incident, Skills links Incident
Category, Skills Links Team, Skills links Users, Team links Skills,
Team links Users, Userinfo Links Skills, Users links Incidents

Overwrite

Scheduled Item
Definition Update Team Skill Count Overwrite

Searches All Skills, All Teams Overwrite

Stored Values Skill User, Skills RecID Overwrite

Widgets All Skills, CD - Date Filter - 30 day default, Team Skills, Total
Skills, Unassociated, Skills, User Skill Number Overwrite

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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Submit On Behalf Of mApp Solution 2.1
Use the Submit On Behalf Of mApp® Solution to submit an Incident or Service Request on behalf of
another user.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 9.6.x and 9.7.0

Out-of-the-Box Content Version Requirements: Tested on CSM 9.6.x and 9.7.0

Prerequisites: None

This mApp Solution is available in the following languages:

• German

• English

• Spanish

• French

• Portuguese

Overview
The Submit On Behalf Of mApp Solution allows Users to submit an Incident or Service Request on behalf
of another User using the Desktop Client, Browser Client, or Customer Portal. The mApp Solution
includes features such as graphics, email notifications, Search Groups, and Portal Widgets.
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This mApp Solution includes multiple features, including Expressions (example: Submit on Behalf Of E-
Mail Recipient) and Widgets (example: My Open Incidents and Requests [Portal Dashboard], My Recently
Closed Incidents and Requests [Portal Dashboard]).

How the mApp Solution Works
CSM provides Submit On Behalf Of functionality as a mApp Solution so Users can easily incorporate on
behalf of submissions into their existing CSM system. Download the mApp Solution from the Cherwell
mApp Exchange. Use the Apply mApp wizard to apply the mApp Solution to your CSM system. The Apply
mApp wizard generates a Blueprint, which can then be viewed and published to a test or live system to
commit the changes.

Note: Apply the mApp Solution and select the Open a Blueprint so that I can preview the
changes option. Before publishing the Blueprint, configure the mApp Solution.

For a list of items included in the mApp Solution, see Submit On Behalf Of mApp Solution Items.

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.
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Configure the mApp Solution
After applying the mApp Solution, perform the following high-level steps to configure the mApp Solution:

1. Add mApp Solution Elements to the Default Incident Form.

2. Add mApp Solution Elements to Portal Incident Forms.

How to Use the mApp Solution
There are three ways to use the mApp Solution functionality, including:

1. Test the Submit On Behalf Of Functionality.

2. Submit an Incident on Behalf of Another User in the CSM Desktop Client or CSM Browser Client.

3. Submit an Incident on Behalf of Another User in the Customer Portal.

Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.0 8.0.0 or later None None

2.1 9.6.0 or later None None

Related concepts
Go to the Cherwell Marketplace (formerly the mApp Exchange)
Apply a mApp Solution
About Incidents and Service Requests
About mApp Solutions
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Add mApp Solution Elements to the Default
Incident Form

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add mApp Solution
elements to the Default Incident Form.

Note: This functionality is only available if you have applied the Submit on Behalf Of mApp
Solution.

1. From the Current view drop-down list, select Default.
2. In the Business Object tree, select Incident.
3. Under Appearance, select the Edit form link.

There are two options for adding elements of this mApp Solution to the Incident Form:

• Replace the existing Default Incident Form with the pre-configured Form from the mApp Solution.

This option is ideal for Customers that have not customized their Default Incident Form and who are
using the CSM 9.6.0 OOTB Form redesign.

• Add elements to the existing Default Incident Form manually.

This option is ideal for Customers that have customized their Default Incident Form or are using the
CSM 9.5.0 OOTB or earlier Form design.

Replace Existing Incident Form with Pre-Configured Form
To replace the existing Default Incident Form with the pre-configured Form from the mApp
Solution:

1. From the Form drop-down list, select Default Form.

2. From the menu bar, select Form > Form properties. Rename the Form to something that will label
it as the old Form (example: Old Default Form).

3. Select OK.

4. From the Form drop-down list, select On-Behalf-Of-Header.
5. Select Yes when prompted to apply Incident Form changes back to the Blueprint.

6. From the menu bar, select Form > Make this the default standard form.

7. Select Yes.

Add Submit On Behalf Of Selector to Default Incident Form
To add the Submit On Behalf Of Selector to the Default Incident Form:
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1. From the Form drop-down list, select Submit On Behalf Of Selector.

2. Select and copy the Requester button  (under the text below the Request Button heading).

3. From the Form drop-down list, select Incident Overview.

4. Select Yes when prompted to apply Incident Form changes back to the Blueprint.

5. Paste the button on the Form.

6. Drag the button to the right of the Customer field for each Adaptive Layout. You can also set the
coordinates to position the button. With the button still selected, right-click and select Position. The
recommended coordinates are as follows:

Adaptive Layout Left Top

Base Layout - 1340 440 139

Tablet Form - 104 365 36

Mobile Default Form - 414 365 36

7. Select OK.

8. Repeat steps 2-7 for each Adaptive Layout.

9. Select the button and right-click Localization Options > Copy between cultures.

10. Select the Copy values to the following cultures option and select all cultures that apply.

11. Select Apply.

12. Repeat steps 8-11 for each Adaptive Layout.

Note: If you prefer using a text link instead of the Requester button, you can copy and paste
the Add Requester link from the Submit On Behalf Of Selector Form (under the text below
the Requester Text Link heading). The recommended coordinates are as follows:

Adaptive Layout Left Top

Base Layout - 1340 1058 424

Tablet Form - 104 47 1219

Mobile Default Form - 414 43 2250

Manually Add Elements to Existing Incident Form
To manually add elements to the existing Default Incident Form from the mApp Solution:

1. From the Form drop-down list, select Submit On Behalf Of Selector.
2. Copy any appropriate Fields, buttons, and text links from the Form.

3. From the Form drop-down list, select Incident Overview (or the Default Form that you are using).
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4. Paste the Fields, buttons, and text links on the Form.
Modify the settings (location, font, color, size, and borders) to ensure the newly added elements
match your existing layout and styles.

5. Select each element and right-click Localization Options > Copy between cultures.

6. Select the Copy values to the following cultures option and select all cultures that apply.

7. Select Apply.

8. Repeat steps 5-7 for each Adaptive Layout.

Note: The items on the left side on the Submit On Behalf Of Selector Form are intended to
be used on the Default Incident Form (or the technician-facing Forms). Items on the right
side are intended for the Default Portal version of the Incident Form and should only be used
in the Customer Portal.

9. Save the Blueprint.

Remember: If you make changes to the Forms (add or move elements), be sure to apply the
changes to the languages you will be using.

Related concepts
Form Editor
Submit On Behalf Of mApp Solution 2.1
Save a Blueprint
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Add mApp Solution Elements to Portal Incident
Forms

Use the Form Editor (accessed from within a Blueprint in CSM Administrator) to add mApp Solution
elements to the Portal Incident Form.

Note: This functionality is only available if you have applied the Submit on Behalf Of mApp
Solution.

1. From the Current view drop-down list, select Portal Default.
2. In the Business Object tree, select Incident.
3. Under Appearance, select the Edit form link.

There are two options for adding elements of this mApp Solution to the Default Portal Form:

• Replace the existing Default Portal Form with the pre-configured Form from the mApp Solution.

This option is ideal for Customers that have not customized their Default Portal Form.

• Add elements to the existing Default Portal Form manually.

This option is ideal for Customers that have customized their Default Portal Form.

Replace Existing Portal Form with Pre-Configured Form
To replace the existing Default Portal Form with the pre-configured Form from the mApp Solution:

1. From the Form drop-down list, select Default Form.

Note: If there are two Default Form options, select the Default Form with the Portal design.

2. From the menu bar, select Form > Form properties. Rename the Form to something that will label
it as the old Form (example: Old Portal Default Form).

3. Select OK.

4. From the Form drop-down list, select Submit-On-Behalf-Portal.
5. Select Yes when prompted to apply Incident Form changes back to the Blueprint.

6. From the menu bar, select Form > Make this the default standard form.

7. Select Yes.

Add Submit On Behalf Of Text Link to View-Only Portal Form
To add the Submit On Behalf Of text link to the Default Portal Form:
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1. From the Form drop-down list, select Submit On Behalf Of Selector.
2. Select and copy the Submitted by on behalf of text link (under the text below the View Only/Edit

Existing Portal Forms heading).

3. Select Home to open the Object Manager.

4. Select Yes when prompted to apply Incident Form changes back to the Blueprint.

5. Under Appearance, select the Edit view-only form link.

6. Paste the text link on the Form.

7. With the text link still selected, right-click and select Position.
The recommended coordinates are as follows:

Adaptive Layout Left Top

Base Layout - 919 46 442

Small - 414 17 412

8. Select OK.

9. Repeat steps 2-8 for each Adaptive Layout.

10. Select the text link and right-click Localization Options > Copy between cultures.

11. Select the Copy values to the following cultures option and select all cultures that apply.

12. Select Apply.

13. Repeat steps 9-12 for each Adaptive Layout.

14. Save the Blueprint.

Add Submit On Behalf Of Text Link to Edit Existing Portal Form
To add the Submit On Behalf Of text link to the Edit Existing Portal Form:

1. Select Home to open the Object Manager.

2. Under Appearance, select the Edit "edit existing" form link.

3. Repeat steps 2-8 in the section above for each Adaptive Layout.
The recommended coordinates are as follows:

Adaptive Layout Left Top

Base Layout - 936 46 442

Small - 414 17 412

4. Select the text link and right-click Localization Options > Copy between cultures.

5. Select the Copy values to the following cultures option and select all cultures that apply.

6. Select Apply.

7. Repeat steps 4-6 for each Adaptive Layout.
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8. Publish the Blueprint.

Manually Add Elements to Existing Portal Form
To manually add elements to the existing Default Portal Form from the mApp Solution:

1. Follow the steps in Manually Add Elements to Existing Incident Form in Add mApp Solution
Elements to the Default Incident Form.

2. Publish the Blueprint.

Remember: If you make changes to the Forms (add or move elements), be sure to apply the
changes to the languages you will be using.

Related concepts
Form Editor
Submit On Behalf Of mApp Solution 2.1
Save a Blueprint
Add mApp Solution Elements to the Default Incident Form
Publish a Blueprint
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Test the Submit On Behalf Of Functionality
Test the functionality of the Submit On Behalf Of mApp® Solution from the CSM Portal, CSM Desktop
Client, or Browser Client.

From the CSM Portal
To test the Submit On Behalf Of functionality from the Customer Portal:

1. Log in to the Customer Portal.

2. Create a new Incident or Service Request.

3. The Submit on behalf of another user check box should be visible on the Form.
a. If you select the Submit on behalf of another user check box, the text for this Field changes

to Submitted on behalf of. The following Fields become visible and both Fields are required to
save the Incident:

i. Submit on behalf of (Customer)

ii. Email Notifications

b. When the Submit on behalf of (Customer) Field is populated, the text for the check box
changes to: Submitted on behalf of Customer Name (the Customer's name automatically
populates in the text).

4. Fill in the remaining required Fields and submit the Incident or Service Request.

5. The Requester and Customer should now see the following text string (below the Detailed
Description) when viewing or editing the Incident or Service Request:
Submitted by Requester Name on behalf of Customer Name.

From the CSM Desktop Client or Browser Client
To test the Submit On Behalf Of functionality from the CSM Desktop Client or Browser Client:

1. Log in to the CSM Desktop Client or Browser Client.

2. View the Incident or Service Request you just submitted through the Customer Portal.

3. If you set the Email Notifications to Requester or Customer and Requester, you should see the
requester name and email in the Default Form (this is true if you used the Default Form within the
mApp Solution).

a. Select the Requester name to remove or change the requester.

b. Select the Requester email to open a follow-up email to the requester.

4. If you added the Requester Field to your Form manually, you should see the requester in the Field.

5. If you added a text link to the Form, the link should read Remove/Change Requester.

6. If you added a Submit On Behalf Of button, it should be visible at all times on the Form.

7. If you added a text link in addition to the button, selecting the button or the text link adds a requester
(or removes/changes the requester).

a. If a requester is already set for the Incident, the text link reads Remove/Change Requester.
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◦ When selecting the button or text link, you should see a dialog box asking if you would
like to remove or change the requester.

◦ Selecting Change Requester allows you to select a new requester and new email
notification settings.

◦ Selecting Remove Requester removes the requester from the Incident.

b. If a requester is not set for the Incident, the text link will read Add Requester.
◦ Selecting the button or text link allows you to select a requester and set email notification

settings.

8. If Email Notification are enabled, the settings will determine who will receive emails about the
Incident. The email notification options are:

◦ Customer

◦ Customer and Requester

◦ Requester

Note: This is true for the OOTB email notifications for New Incident Confirmation and
Resolved Incident notification.

Related concepts
Create an Incident
Related tasks
Log a CSM Portal Incident
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Submit an Incident on Behalf of Another User in
the CSM Desktop Client or Browser Client

Use the Incident Form in the CSM Desktop Client or Browser Client to submit an Incident on behalf of
another User.

Note: This functionality is only available if you have applied the Submit on Behalf Of mApp
Solution.

To submit an Incident on behalf of another individual in the CSM Desktop Client or Browser Client:

1. Create a new Incident (New>Incident).

2. Select the Customer using the Related Item Picker.

3. Select the Submit On Behalf Of button  (to the right of the Customer Field). You can select
this option again to change or remove the requester.

Note: If there is an Add Requester link under the Actions list, you can also select the link
to submit on behalf of another User.

a. Select the name of the person you are submitting the Incident on behalf of.

b. Use the drop-down list or the ellipses to select who should receive email notifications:
◦ Customer

◦ Customer and Requester

◦ Requester

c. Select OK.

The requester's name and email display on the Default Form. A Journal - Note is created
when a requester is added, removed, or changed.

The requester's information only displays if email notifications were set to Customer and
Requester or Requester.

Tip: You can select the requester's name to change or remove the requester. You can
select the requester's email to initiate a requester follow-up email message.

4. Complete the process to finish creating a new Incident.

Related concepts
Submit On Behalf Of mApp Solution 2.1
Create an Incident
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Submit an Incident on Behalf of Another User in
the Customer Portal

Use the Incident Form in the Customer Portal to submit an Incident on behalf of another User.

Note: This functionality is only available if you have applied the Submit on Behalf Of mApp
Solution.

To submit an Incident on behalf of another User in the Customer Portal:

1. Log in to the Portal.

2. In the Service Catalog, select Submit Incident or Request in the appropriate tile.

3. Select the Submit on behalf of another user check box.
a. From the Submit on behalf of (Customer) Field, use the Related Item Picker to select the

name of the person you are submitting the Incident or Request on behalf of.

b. From the Email Notifications drop-down list, select from the following options:
◦ Customer

◦ Customer and Requester

◦ Requester
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4. Complete the process to finish creating a new Incident.

Related concepts
Submit On Behalf Of mApp Solution 2.1
Related tasks
Log a CSM Portal Incident
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Submit On Behalf Of mApp Solution Items
The Items table provides a list of items included when applying the mApp Solution and the typical merge
action.

Item Category Item Typical Merge
Action

Business Objects

Customer, Customer - Internal, Incident (Portal Secondary) Don't Change

Incident Merge

Incident Email Notifications Import

Color Palette Cherwell Dashboards Overwrite

Custom Views Portal Default Incident View, Portal Secondary Don't Change

Fields

Created By, Created By ID, Created Date Time, Enable Email
Notifications, Enable Email Notifications_de-DE, Enable Email
Notifications_en-US, Enable Email Notifications_es-ES, Enable
Email Notifications_fr-FR, Enable Email Notifications_pt-BR,
Last Modified By, Last Modified By ID, Last Modified Date Time,
Requester, Requester Email, Requester ID, Requester SLA ID,
Submit On Behalf Of Enable Email Notifications, Submit On
Behalf Of

Import

Customer Display Name, Customer ID Overwrite

Forms
Incident Overview Don't Change

Incident Email Notifications, On-Behalf-Of-Header, Submit On
Behalf Of Selector, Submit-On-Behalf-Portal Import

Form Arrangement Incident Overwrite

Grid IncidentEmailNotifications Import

Image Definition behalf_24 Import

Indexes

Incident_CustomerID, Incident_IncidentType,
Incident_OwnedByID, Incident_RecID, IncidentCreatedDT,
IncidentID, IncidentIdx_ServiceCartRecID,
IncidentIdx_ServiceCatalogTemplateRecID, IncidentService,
IncidentStatus

Overwrite

PK_IncidentEmailNotifications Import

Mergeable Area Incident Approvals Overwrite

One-Step™ Actions

Remove or Change Requester, Requester-Follow-up E-mail,
Set or Clear Requester, Submit On Behalf Of Import

Add to Cart, Follow-up E-mail, Incident Confirmation, Resolved
Confirmation, Submit Overwrite

New Submit or Add to Cart Don't Change
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Relationships

Incident Links Portal Requester Import

Customer Group Links Customer Status, Customer is on CAB,
Customer links SLA, Customer Owns Password Reset Form,
Customers have History, Customers use CIs,
CustomersHaveIncidents

Don't Change

Searches My Open Portal Incidents, My Open Portal Incidents and
Service Requests, Open Service Requests Overwrite

Stored Expressions
Submit On Behalf Of E-Mail Recipient Import

Hyperlink to Customer Portal, Hyperlink to Respond via Email Don't Change

Tabs Additional Information, Comments, Problem, Related Device,
Resolution Details Don't Change

Theme Prussian Blue Overwrite

Widgets My Open Incidents and Requests, My Open Incidents Count,
My Open Requests Don't Change

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).
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Survey Monkey mApp Solution 1.0
Use this mApp® Solution to track results from surveys you create using Survey Monkey.

Platform Version Requirements: Tested on CSM 10.2.0.

Out-of-the-Box Content Version Requirements: Tested on CSM 10.2.0.

How the mApp Solution Works
Use the Survey Monkey mApp Solution to track results from Survey Monkey surveys. The included
dashboard makes it easy to view results from active surveys.

Download the mApp Solution from the Cherwell mApp Exchange. Use the Apply mApp Wizard to apply
the mApp Solution to your CSM system. The Apply mApp Wizard generates a Blueprint, which can then
be viewed and published to a test or live system to commit the changes.

For a list of items included in the Survey Monkey mApp Solution, see Survey Monkey mApp Solution
Items.

Create a Survey Monkey App
Before applying mApp Solution, set up an account and app with Survey Monkey.

To set up a Survey Monkey app:

1. Create an account on http://www.surveymonkey.com.

2. Go to https://developer.surveymonkey.com/apps and create a new app. It can be public or private.

3. On the Settings tab, under the Scopes section, select at a minimum:
◦ View Surveys

◦ View Responses

◦ View Response Details

Select Update Scopes.

4. Under the Credentials section, find and copy the Access Token value.

Apply the mApp Solution
Download file: SurveyMonkey.mApp.

To apply the mApp Solution, perform the following high-level steps:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.
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4. On the Specify Value for the Survey Monkey Bearer Token screen, enter the Access Token value
you copied from the Survey Monkey website.

Revision History

mApp Version Platform Version
Requirements

Out-of-the-Box Version
Requirements Prerequisites

1.0 10.2.0

10.2.0. This mApp
Solution may not be
compatible on Content
versions older than
10.2.0, but as with all
mApp Solutions, it should
be tested on your
customized system.
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Use the Survey Monkey mApp Solution
Use this mApp® Solution to track Survey Monkey results.

To track Survey Monkey results:

1. In the CSM Desktop Client, select New Survey Monkey Results.
2. Under the Actions section, select Select a Survey to see the list of surveys in your Survey Monkey

app.
The survey questions and results populate the Survey Monkey Results record.

3. You can paste the survey URL in the Survey Monkey record for reference.
4. Select Update Totals to pull in the most recent survey results.

This is a manual process, but you can set up a Scheduled Item to automate the results retrieval.

Use the included Survey Results dashboard to track Survey Monkey surveys and results.
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Survey Monkey mApp Solution Items
These are the items included in this Survey Monkey mApp® Solution.

Item Category Item Typical Merge Action

Business Object Survey Monkey Results Import

Counter Survey Monkey ID Import
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Fields

Assigned Team

Import

Assigned Team RecID

Assigned to

Assigned to RecID

Created by

Created by RecID

Created Culture

Created Date Time

Current Question ID

Current Question Number

Last Modified by

Last Modified by RecID

Last Modified Date Time

LastModTimeStamp

Previous Question ID

Question 1

Question 1 - Answer A

Question 1 - Answer A Total

Question 1 - Answer B

Question 1 - Answer B Total

Question 1 - Answered

Question 1 ID

Question 2

Question 2 - Answer A

Question 2 - Answer A Total

Question 2 - Answer B

Question 2 - Answer B Total

Question 2 - Answered

Question 2 - ID

RecID

Response Count

Survey ID

Survey Monkey Results ID

Survey Name

Survey URL
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Forms Survey Monkey Results Overview Import

Grid Survey Monkey Results Import

Dashboards Results Import

Index

PK_SurveyMonkeyResults

ImportSurveyMonkeyResults_
SurveyMonkeyResultsID

Relationship Survey Result Links Existing Survey Import

One-Step™ Actions

Get all Question Choices

Import

Get Question 1 Choices

Get Question 2 Choices

Get Questions

Get Totals

Select a Survey

Set Question IDs

Step Through Questions

Update Totals

Widgets

All Survey Results

ImportSurvey Monkey Name Filter

Survey Results Record

Search All Survey Results Import

Stored Value

Data Array

Import
Questions Array

Survey Monkey Bearer Token

Survey Results Record
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Tenable.io Integration mApp Solution
Use the Tenable.io Integration mApp® Solution for a bi-directional integration between Tenable and CSM.

Platform version requirements: CSM 10.2.x

Content version requirements: Tested on CSM 10.2.0

Available languages: English

Overview
Use the Tenable.io Integration mApp Solution to import vulnerabilities discovered in Tenable into CSM,
where you can create Security Events mapped to your Configuration Items (CIs). Track, ignore, or plan a
remediation chain of events for the Security Event. After the vulnerabilities are addressed and CIs are
rescanned, the updated status is sent back to CSM to close the loop. This integration helps increase
coordination between IT and Security teams to ensure organizations have clear visibility regarding
security threats. While Tenable.io will scan and discover vulnerabilities (open ports, insecure
configurations, malware), using this integration with CSM can help enforce the process and policies
around the handling of Security Events through Incident or Change Management.

How the mApp Solution Works
CSM provides Tenable.io Integration as a mApp Solution so you can easily integrate Tenable.io into your
existing system. Download the mApp Solution from the Cherwell mApp Exchange. Use the Apply mApp
wizard to apply the mApp Solution to your CSM system. The Apply mApp Solution wizard generates a
Blueprint, which can then be viewed and published to a test or live system to commit the changes.

For a list of items included in the mApp Solution, see Tenable.io Integration mApp Solution Items.

Apply the mApp Solution
Before you apply the mApp Solution, have your Tenable.io API Access and Secret Keys available.

Note: This mApp Solution changes the properties for Host Name and MAC Address for the
following Business Objects, making these fields required:

• Config - Computer

• Config - Server

• Config - Network Devices

Follow these steps to download and apply the mApp Solution:

1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.
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3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM. Do not
select Finish yet.

4. On the Final Options screen, select Open a Blueprint so that I can preview the changes, and
then select Finish.

5. When the Apply mApp Wizard closes, select the Publish Blueprint link.

6. Select the appropriate publish options, and then select Publish.

7. When the publish finishes, a One-Step™ Action runs automatically and you are prompted for your
Tenable.io API Access Key and Secret Keys. Enter that information into the prompts. For more
information, see the Tenable.io documentation at https://docs.tenable.com/TenableIO.htm.

Revision History

mApp Version
Platform
Version
Requirements

Version
Requirements Prerequisites

1.0 10.2.x Tested on CSM
10.2.0 None

Related concepts
About mApp Solutions
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Create Cherwell Tag Category and Rules in
Tenable.io

The following new CIs sync with your Tenable.io account: Config - Computer, Config - Server, and Config
- Network Devices. During the sync, CSM uses a source attribute that contains the CI type, and Tenable
engages rules to automatically assign the assets with the Cherwell tag.

Create New Cherwell Tag Category and Rules
To create the new Cherwell tag category and rules:

1. Log in to your Tenable.io account, and from the menu select Settings.

2. On the Settings page select Tagging, and then select the + Create Tag button (upper right corner).

3. From the Category drop-down list, type Cherwell in the Add New Category option.
Enter a description, if desired.

4. In the Value field, type Computer.
Enter a description, if desired.

5. Switch the Rules option on, and set the Match option to Match All.
6. From the Category drop-down list, select Source.

7. From the Operator drop-down list, select Contains.

8. In the last field, type Config - Computer, and then select Save.

Add to the Cherwell Tag Category and Rules
To add to the Cherwell tag category and rules:

1. Select the Cherwell tag from the list to open it again.

2. In the upper right corner, select the + Add Value button.
The Category drop-down list autopopulates with Cherwell.

3. In the Create Value field, type Server.
Enter a description, if desired.

4. Repeat steps 5 - 8 above.

5. In the last field, type Config - Server, and then select Save.

6. Repeat steps 10 -13 above, but in the Create Value field, type Network Device.

7. In the last field, type Config - Network Device, and select Save.

1072

CSM mApp Solutions

CSM mApp Solutions



Sync Cherwell Configuration Items with Assets in
Tenable.io

CSM uses Automation Processes to ensure that new Configuration Items (CIs) sync with your Tenable.io
account. These Automation Processes are included with the Tenable.io Integration mApp® Solution.
Ensure your system is configured for Automation Processes to run.

Note: This mApp Solution makes API calls via One-Step™ Actions that use HTTP requests, so
ensure you update security permissions to allow this.

The following new CIs sync with your Tenable.io account: Config - Computer, Config - Server, and Config
- Network Devices.

When it's time to bring vulnerability data into CSM, Tenable uses the Cherwell tag filter to limit the data
imported. Only vulnerability data for assets with the Cherwell tag is imported into CSM.

To sync Cherwell CIs with assets in Tenable.io:

1. In the CSM Desktop Client, open the Search Manager.
2. From the Association drop-down list, select Config - Computer.
3. Select the Global folder, select All Computers, and then select Run.
4. If the results are not in grid view, from the menu bar, select View > Result in Grid.
5. To select the Config - Computers you wish to sync with your Tenable.io account select the check

box next to each row. If you wish to sync all Config - Computer records with Tenable, select the
check box in the header row.

6. Open the One-Step Action Manager, and from the Association drop-down list, select
Configuration Item .

7. Select the Global folder, and then select the Tenable folder.
8. Select Import Asset to Tenable, and then select Run.

The processing time varies depending on how many Config - Computers you are syncing.
9. When the sync process is complete, the fields for Tenable Import ID and Tenable UUID are

autofilled for each record. These field are not visible on the form. To view them, open the record,
and from the menu bar, select Help > System Analyzer.

10. From the System Analyzer toolbar, select the Show Values button  to show values of the field in
the current business object.
The Current Object Values window opens.

11. In the list of fields, select the Tenable folder to expand and view the Tenable Import ID and
Tenable UUID fields.

12. Complete steps 2-11 for the Config - Server and Config - Network Devices you want to sync with
assets in Tenable.

After the sync process completes, the assets in Tenable are tagged with the Cherwell tag and the Server,
Computer, and Network Device values.
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When new Config - Computer, Config - Server, and Config - Network Devices records are created in
CSM, an Automation Process will automatically sync and tag the new records with assets in Tenable.

Related concepts
Open the Search Manager
Open the One-Step Action Manager
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Configure the Tenable Vulnerability Export Settings
You can adjust the default settings of the Vulnerability Export Scheduled Item.

Table 1. Default Settings

Filter Description Default Setting Options

API Keys

API Keys from your
Tenable.io instance. Keys
are encrypted after they
are updated.

Chunk Size

Specifies the number of
assets used to chunk the
vulnerabilities during the
export process.

50 50 minimum; 5000
maxiumum

Tagging

Returns vulnerabilities on
assets with the specified
asset tags. The filter is
defined as "tag", a period
(.), and the tag category
name. The value of the
filter is an array of tag
values.

"tag.Cherwell":
["Computer","NetworkDevice",
"Server"]

Start Date

The start date (in Unix
time) for the range of data
you want to export. After
the initial export, the start
date is set to the date and
time of the last export.

01/01/2021 12:00 AM

Severity
The severity of the
vulnerabilities to include in
the export.

"high", "critical"

Info

Low

Medium

High

Critical

To adjust any of the setting:

1. In the CSM Desktop Client, open the One-Step Action Manager.
2. From the Association drop-down list, select None.
3. Select the Global folder, and then select Update Tenable Settings.
4. Select Run, and then select the option for the filter you want to update.
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Configure the Tenable Vulnerability Export
Schedule

The Vulnerability Export process is set to run on a weekly basis through a Scheduled Item. By default, the
Scheduled Item is set to run at 12:00 AM Eastern Time every Saturday.

Adjust the Scheduled Item
To adjust the Scheduled Item settings:

1. On CSM Administrator home page, select Scheduling > Edit Schedule.
The Scheduled Items window opens.

2. Select the Tenable Export task, and then select Edit.
3. On the Schedule page, edit the settings to meet your needs.

4. Select Save.

Related concepts
Use the Scheduler
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Run a Tenable Vulnerability Export Outside the
Scheduled Item

Use a One-Step™ Action to run an impromptu export.

To run an export outside the Scheduled Item:

1. In the CSM Desktop Client, open the One-Step Action Manager.
2. From the Association drop-down list, select None.
3. Select the Global folder, and then select the Tenable folder.
4. Select Export Vulnerabilities, and select Run.

The processing time varies depending on how many vulnerabilities are being exported.
5. To view details of the export, from the menu bar select Tools > Table Management

a. From the Type drop-down list, select Tenable Export.
6. Open the Tenable export record.

The Export UUID and Request UUID fields are for information purposes and are read-only.
7. The status updates every five minutes after the Tenable export record is created. You may need to

refresh the record to see updates. If you want to bypass the five-minute wait time, select the Update
Export link (under Actions) to update the record status.
When the record updates, the Status, Total Chunks and Chunks Processed fields refresh.

8. When the status record updates to Finished, an Automation Process runs and begins importing the
vulnerability records in chunks. As chunks are imported, the Chunks Processed field updates until
it shows all chunks are complete. For example, if the total number of chunks is 25, the Chunks
Processed starts at 0 of 25 and continues to update until it displays 25 of 25. The vulnerabilities are
initially imported as records within a table called Asset Vulnerability.

After all chunks have been imported, a set of Automation Processes begin for each Asset Vulnerability
record. Security Events are automatically created or updated. A Security Event is created for each unique
Plugin ID. Configuration Items are linked to the Security Events if the Plugin ID is associated with the
synched asset in Tenable. A join table record (Security Event Joins Configuration Items) is also created
which will allow technicians to view the status of the vulnerability on each CI from the Security Event
record via the Configuration Item tab. It may take several minutes to hours for all the vulnerability
records to be processed. After all Asset Vulnerability records have been processed, they are deleted from
the system.

Related concepts
Open the One-Step Action Manager
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View Vulnerabilities from the CSM Desktop Client
or CSM Browser Client

After you run the Tenable Vulnerability Export, view the vulnerabilities for more information.

Note: In rare cases, there may be instances where a vulnerability or Plugin is present on a single
Configuration Item (CI) more than once at the same time via different ports or protocol.
This mApp® Solution limits the relationship between CIs and vulnerabilities based on unique
Plugin ID; therefore, in an instance where a CI has the same vulnerability multiple times, CSM
only reports on one of these instances. As a result, the reporting may show different counts in
CSM versus Tenable.io for vulnerabilities per CI or Asset.

To view vulnerabilities in the Desktop Client or Browser Client:

1. Open the Search Manager.
2. From the Association drop-down list, select Event - Security.
3. Select Open Security Events, and then select Run.
4. Open any records associated with a vulnerability and you will notice the following:

◦ The Source field on the Overview tab is set to Tenable.
◦ The Vulnerability Name is also the Event Name.
◦ The Details and Response Notes fields are details from Tenable regarding the vulnerability.
◦ The External Source ID field is the same as Plugin ID in Tenable.
◦ The Event Type field is set to Common Vulnerabilities and Exposures.
◦ The Event Severity field is the same as the Vulnerability Severity in Tenable.
◦ The Priority field is set to Low.
◦ The Vulnerability tab is visible and contains all details from Tenable regarding the

vulnerability. All fields on this tab are read-only.
◦ The Configuration Item tab shows the Security Event Joins Configuration Item join table

details including the status of the vulnerability on each CI.
◦ Selecting the Jump button takes you to the join record where you can enter resolution

details and mark the vulnerabilities resolved on the CI.
◦ The links under Actions allow you to jump to the Configuration Item record or back to

the Security Event.
◦ On the Security Event record, you can create Incidents, Change Request, or Problems.
◦ On the Configuration Item records, the Security Events can be found on the Event tab.

Related concepts
Open the Search Manager
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Tenable.io Integration mApp Solution Items
The items table provides a list of items included when you apply the mApp® Solution and the typcial
merge action.

Item Category Item Typical Merge Action

Action Block Set Encryption Key Overwrite

Automation Process definitions

Create or Update Security Events, Delete Record,
Import Asset Vulnerabilities, Import Asset
Vulnerability Chunks, Tenable Asset UUID, Update
Export Status

Overwrite

Business Objects

Asset Vulnerability, Security Event Joins
Configuration Items, Tenable Export Overwrite

Config - Computer, Config - Network Device,
Config - Server, Configuration Item, Event -
Security

Merge

Change Request, Config - Computer, Config -
Mobile Device, Config - Network Device, Config -
Other CI, Config - Printer, Config - Server, Config -
Software License, Config - System, Config -
Telephony Equipment, Configuration Item, Event

Don't Change

Fields

Child Join Reason, Chunks Processed, Created
Culture , Created Date Time, CVSS Score,
Description, Event - Security RecID, Event -
Security Type, Event Type, Exploit Available,
Exploit by Malware, Exploitable Ease, Export
Request Date Time, Export UUID, First Seen Date
Time, Has Patch, Hostname, IP Address, Join
Exists Join Reason, Join RecID, Last Modified by,
Last Modified by RecID, Last Modified Date Time,
Last Seen Date Time, MAC Address, Mark as
Resolved, MS Bulletin, MS Bulletin IDs, Output,
Patch Publish Date, Patch Publish Date Time,
Plugin Family, Plugin Family ID, Plugin ID, Plugin
Name, RecID, Request UUID, Resolution Details,
Security Event RecID, Severity, Solution, Status,
Synopsis, Tenable Asset UUID, Tenable Import ID,
Tenable Output, Tenable UUID, VPR Score,
Vulnerability Publish DateTime, Vulnerability Type

Overwrite

Form arrangement EventSecurity Overwrite

Forms
Asset Vulnerability, Security Event Joins
Configuration Items, Tenable Export, Vulnerability
Details

Overwrite

Grids Asset Vulnerability, Security Event Joins
Configuration Items, Tenable Export Overwrite
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Item Category Item Typical Merge Action

Indexes

CIEventIdx0, ConfigurationItem_AssetTag,
ConfigurationItem_FriendlyName,
ConfigSoftwareLicense_SoftwareID,
Event_CIEventNumber, InstalledSoftware_Product,
Latitude, Longitude, PK_CIEvent,
PK_ConfigurationItem, PK_SecurityVulnerability,
PK_Security_Event_Joins_Configuration_Items,
PK_TenableScan

Overwrite

Mergeable areas
Asset Vulnerability Actions, Computer Actions,
Config - Network Device Actions, Config - Server
Actions, Configuration Item Actions

Overwrite

One-Step™ Actions

Create Update Security Event, Create Update
Security Event and CI Join Record, Delete Record,
Export Vulnerabilities, Import Asset to Tenable,
Import Vulnerabilities, Link CI to Security Event,
Process Asset Vulnerabilities, Update Export
Status, Update Tenable Asset ID, View
Configuration Item, View Security Event

Overwrite

Tenable API Key Encryption, Update Tenable
Settings Don't Change

Prompts Chunk Size, Severity, Start Date, Tags Overwrite

Relationships

Asset Vulnerability Links Join Table, Asset
Vulnerability Owned By CI, Asset Vulnerability
Owned By Security Event, Configuration Item links
Asset Vulnerabilities, Configuration Item links
Security Event, Security Event Links Asset
Vulnerabilities, Security Event links CI Join Table,
Security Event links Configuration Items

Overwrite

Event Links Change Request, Event Links
Configuration Items, Event Links Customer, Event
Links Incident, Event Links Similar Event, Event
Links Status, Event Links User Info, Event Owns
Journal, Event Owns Work Items

Don't Change

Scheduled Item definition Tenable Export Overwrite

Searches

All Open Project Tasks, All Planview Projects, All
Planview Task Imports, All Project Tasks, Closed
Project Tasks, My Open Project Tasks, My Project
Tasks, My Teams Open Project Tasks, My Teams
Project Tasks

Import

Stored expressions Unix Timestamp Conversion - Duration in Days,
Unix Timestamp Conversion - Number Overwrite

Stored values

API Key String, Chunk Size, Export Chunks,
Hostname, Last Export Timestamp, New Start Date,
Plugin ID, Security Event RecID, Severity, Tags,
Tenable Nonce

Overwrite
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Item Category Item Typical Merge Action

Tabs

Configuration Item (0), Configuration Items (0),
Vulnerability Details Overwrite

Affected Users (0), Change Request, Incident,
Journals, Network Events (0), Overview, Similar
Events (0), Work Items (0)

Don't Change

Widgets

CD - Date Filter - 30 day default, CD-All P1 Issues,
CD-My Incidents and Requests, CD-My Open
Incidents, CD-My Open Tasks, CD-My Open Tasks
Count, CD-My Open Tickets, CD-My Teams Open
Change Requests, CD-My Teams Open Tasks, CD-
My Teams Problems, CD-My VIP Issues

Overwrite

My Open Project Tasks, My Open Project Tasks -
Count, My Teams Open Project Tasks Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution includes the definition
for informational purposes only (the definition is not imported into the target system).
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Track the Number of Incidents Caused by a Change
Request mApp Solution 1.0

Use the Track the Number of Incidents Caused by a Change Request mApp® Solution to identify and
track the number of Incidents caused by Change Requests.

This is a Cherwell Labs mApp Solution. Functionality, testing, and documentation are limited or
incomplete. Cherwell support is not provided for this mApp Solution, so install it at your own risk on a test
environment before installing it on a production system.

Platform Version Requirements: Tested on CSM 5.0.0.

Out-of-the-Box Content Version Requirements: Tested on CSM 5.x and 6.x

Prerequisite Requirements: None

Overview

This mApp Solution includes features such as a new Business Object (Incident Caused By Change
Request Reason) and new One-Step Actions (example: Caused By Change Request Reason, Caused By
Linked Change Request, etc.), Saved Searches (example: All Incidents Caused By A Change Request,
All Resolved/Closed Incidents Caused By Change, etc.), and Widgets (example: Total Open Incidents
Caused By Change Requests).
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How the mApp Solution Works
Download the mApp Solution from the Cherwell mApp Exchange. Use the Apply mApp wizard to apply
the mApp Solution to your CSM system. The Apply mApp wizard generates a Blueprint, which can then
be viewed and published to a test or Live system to commit the changes.

The mApp Solution includes the following items:

Item Category Item Typical Merge Action

Business Object

 

Change Request, Incident Merge

Incident Caused by Change Request Reason Import

One-Step Action

 

Caused By Change Request ID, Caused By Change
Request Logical Field, Caused By Change Request Reason,
Caused By Linked Change Request, Clear Change Request
ID, Delete Caused By Fields, Incident Caused By A Change
Request

Import

Never Fixed Incident, Recurring Incident Overwrite

Stored Query

All Incidents Caused By A Change Request, All Open
Incidents Caused By A Change Request, All Open Service
Requests Caused By Change, All Resolved/Closed
Incidents Caused By Change, All Resolved/Closed Service
Requests Caused By Change

Import

Widget Total Open Incidents Caused By Change Requests, Total
Open Service Requests Caused By Change Requests Import

• Import: Add new item.

• Overwrite: Replace target item.

• Merge: Merge differences.

• Don't Change: Referenced by the mApp Solution, but not altered in any way. The mApp Solution
includes the definition for informational purposes only (the definition is not imported into the target
system).

Related Reading

• About Incidents and Service Requests

• About Change Requests

• About mApp Solutions

Apply the mApp Solution
To apply the mApp Solution, perform the following high-level steps:
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1. Review the recommendations and considerations for applying mApp Solutions. For more
information, see Considerations for Applying mApp Solutions.

2. Extract the mApp Solution .zip file to a location that can be accessed by CSM.

3. In CSM Administrator, use the Apply mApp Wizard to apply the mApp Solution. For more
information, see Apply a mApp Solution. Select the topic that matches your version of CSM.

Configure the mApp Solution
After applying the mApp Solution, perform the following high-level steps to configure the mApp Solution:

1. (Optional) Add the new Widgets to a Dashboard of your choice.

How to Use the mApp Solution in the Desktop Client
There are two ways to use the mApp Solution functionality, including:

• Track the number of Incidents caused by a Change from an open Incident.

• Track the number of Incidents caused by a Change Request from a closed Incident.
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Configuring the Track the Number of Incidents
Caused by a Change Request mApp Solution

Complete the following procedure to configure the Track the Number of Incidents Caused by a Change
Request mApp Solution. The configuration procedure is completed in CSM Administrator.

1. (Optional) Add the new Widgets to a Dashboard of your choice.

Note: Access mApp Solution Widgets by opening the Widget Manager and selecting Global
scope>Track the Number of Incidents Caused By Change Requests.

To open the Widget Manager:

a. The Widget Manager can be opened several ways:
◦ From the CSM Desktop menu bar, click Dashboards>Widget Manager.
◦ From the Widget Tree in the Dashboard Editor, right-click>Widget Manager.
◦ From the Blueprint Editor menu bar in CSM Administrator, click

Managers>Dashboards>Widget Manager.
◦ From within the Site Manager in CSM Administrator.
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Using the Track the Number of Incidents Caused
by a Change Request mApp Solution

When working with the Track the Number of Incidents Caused by a Change Request mApp Solution,
Users can:

• Track the number of Incidents caused by a Change from an open Incident.

• Track the number of Incidents caused by a Change Request from a closed Incident.

1086

CSM mApp Solutions

CSM mApp Solutions



Track the Number of Incidents Caused by a Change
from an Open Incident

Use the Incident Form in the CSM Desktop Client to track the number of Incidents that are caused by a
Change.

To track the number of Incidents caused by a Change from an open Incident:

1. Link a Change Request to the Incident:
a. In the Form Arrangement, click the Change Request tab.

b. On the Change Request tab toolbar, click the Link button .

The Change Request Selector opens.

i. Click a Change Request.

ii. Select OK.

The Change Request displays in the Form Arrangement.

c. Click Save .

A prompt opens.

i. From the drop-down, select Change Request Caused This Incident.

Note: Use the For Reference option to link Change Requests that are not the cause of
the Incident, but are related in another way (example: If the Change Request applies a
patch to the server, which fixes the Incident). The distinction is used to differentiate the
relationships for Saved Search data.

ii. Select OK.

The Change Request record opens in the Form Arrangement in a new Change Request
Caused This Incident tab.
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Tip: Run a Saved Search to view data related to Incidents and Service Requests caused
by Change Requests (Searching>Search Manager>Global>Track the Number of
Incidents Caused by a Change Request).
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Track the Number of Incidents Caused by a Change
Request from a Closed Incident

Use the Incident Form in the CSM Desktop Client to track the number of Incidents that are caused by a
Change.

To track the number of Incidents caused by a Change from a closed Incident:

1. Do one of the following:
◦ In the Status bar, click the Mark as "Recurring" link.

◦ In the I Want To section of the Quick Info Tile, click the Mark as "Never Fixed" link.

A prompt opens asking if the Incident was caused by a Change Request.

2. From the drop-down, select Yes.

The Which Change Request caused this Incident? window opens.

a. Click a Change Request.

b. Select OK.

The Change Request record opens in the Arrangement in a new Change Request Caused
This Incident tab.

Note: When a User is working with a closed Incident that has a linked Change Request that is
for reference and click either Mark as "Recurring" or Mark as "Never Fixed", a cloneof the
Incident is created and links the Change Request in the Change Request Caused This
Incident tab.

Tip: Run a Saved Search to view data related to Incidents and Service Requests caused by
Change Requests (Searching>Search Manager>Global>Track the Number of Incidents
Caused by a Change Request).
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